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Introduction
This guide provides information necessary to implement and configure 
communications integrations for your Siebel applications.

This book will be useful primarily to people whose title or job description matches 
one of the following:

Communications 
Administrators

Persons responsible for setting up and maintaining 
communications integrations such as those supported by Siebel 
Communications Server, including creating communications 
configurations and communications profiles.

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties include designing and managing elements such as 
SmartScripts or message broadcasts.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department. Duties include designing and managing campaigns, 
product marketing information, and product distribution lists.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 

Database 
Administrators

Persons who administer the database system, including data 
loading; system monitoring, backup, and recovery; space 
allocation and sizing; and user account management.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality. 

Communications 
Developers 

Persons who may implement a third-party communications driver, 
using the Adaptive Communications application programming 
interface.
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Technical users of this guide should possess skills in SQL, RDBMS, network 
connectivity using TCP/IP, and application development or configuration. Expertise 
in computer telephony integration (CTI), email, or other communications systems 
may be necessary for advanced tasks.

Product Modules and Options
This Siebel Bookshelf contains descriptions of modules that are optional and for 
which you may not have purchased a license. Siebel’s Sample Database also 
includes data related to these optional modules. As a result, your software 
implementation may differ from descriptions in this Bookshelf. To find out more 
about the modules your organization has purchased, see your corporate purchasing 
agent or your Siebel sales representative.
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How This Guide Is Organized
This book attempts to present information roughly in the sequence in which you 
are likely to need it for performing the tasks described. The book chapters address:

■ Overview information

■ Basic communications configuration information, including defining 
communications configurations, creating profiles for communications drivers, 
and so on

■ Advanced communications and user interface configuration information, 
including configuring events and commands, configuring the communications 
toolbar, configuring recipient groups for outbound communications, modifying 
List of Values types, and so on

■ Enabling communications and simulation, and operations relating to server 
components, such as configuring and running the server components

■ End user operations for general users or call center users, including setting 
preferences and using the communications toolbar and menu commands

■ End user operations for more advanced users: working with communications 
templates and outbound communication requests

NOTE: End users are not expected to be actual end users of this book, although much 
information presented here is of relevance to them.

Appendixes contain information about supporting specific kinds of 
communications systems, such as CTI middleware, email servers, wireless 
messaging, and so on. For CTI, Siebel Systems provides the module Siebel CTI 
Connect. For wireless messaging, Siebel Systems provides the module Siebel 
Wireless Messaging. This material is followed by information about developing 
custom drivers using the Adaptive Communications API, using Communications 
Server business services, and upgrading from a previous version.
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Additional Resources
For additional information on topics related to those covered in this book, see the 
following books:

■ Siebel Server Installation Guide for the operating system you are using, for 
information about server installation procedures.

■ Siebel Server Administration Guide, for information about configuring and 
running server components, including those for Siebel Communications Server.

■ Siebel eMail Response Administration Guide, for information about configuring 
and using Siebel eMail Response.

■ Siebel Universal Queuing Administration Guide, for information about using 
Siebel Universal Queuing to route inbound communications work items.

■ Siebel Marketing Guide, for information about using Siebel Marketing to send 
email/fax offers.

■ System Requirements and Supported Platforms, for information about platform 
and third-party software issues affecting your Siebel software.
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Revision History
Revision History
Siebel Communications Server Administration Guide

Version 7.5.3
Table 1. Changes Made in Version 7.5.3

Topic Revision

“Process of Configuring Communications 
Server” on page 43

Moved section from former Chapter 2, 
“Configuring Communications.”

Chapter 2, “Configuring Communications 
Drivers and Profiles”

Created new chapter from sections in former 
Chapter 1, “Overview of Siebel 
Communications Server,” and Chapter 2, 
“Configuring Communications.”

“Parameters for Communications 
Configurations” on page 81

Added parameters CommSessionMgr, 
EnterpriseServer, GatewayAddress, and 
RequestServer.

New for version 7.5.3: Added new parameter 
ChannelCleanupTimer.

“Handling an Inbound Call Received by an 
Agent” on page 152

Revised for version 7.5.3: Updated section to 
include call-handling option using new 
EventAnswerCall device event.

“Keywords to Specify Dialing-Filter 
Behavior” on page 206

Added caution against changing the type of 
DTYPE_PHONE fields.

“Using Device Event to Enhance Screen Pop 
Performance” on page 229

New for version 7.5.3: Added section to 
describe usage for new EventAnswerCall 
device event.

“Using Push Keep Alive Driver for Session 
Connections” on page 232

New for version 7.5.3: Added section to 
describe usage for new Push Keep Alive 
communications driver.

“Integrating with Siebel Scripting 
Languages” on page 247

Updated example server and browser 
scripts.

“Displaying Communications Parameter 
Data in SmartScript” on page 255

Updated section and corrected the name of 
the GetParameter function.
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“Integrating with the Customer 
Dashboard” on page 256

Updated example events for populating and 
clearing the customer dashboard.

“Requirement for Defining Fields in Event 
Logs” on page 259

Added section to clarify requirement for 
generating reports.

“About Recipient Groups for Requests and 
Advanced Templates” on page 288

Updated section to add information relevant 
to configuring recipient groups.

“Configuring Recipient Sources Applets” on 
page 295

Procedure was incomplete. Added new 
Step 4.

“Configuring Recipients for Send 
Commands” on page 299

Updated section, included Send Wireless 
Message in joined generic recipient 
configuration.

“Configuring Default Templates for Send 
Email Command” on page 304

Corrected references to the Mail Template 
applet property.

“Parameters for Application Object 
Manager and Dedicated Web Client” on 
page 313

New for version 7.5.3: Added new 
Application Object Manager parameter, 
CommConfigCache.

“Administering Communications 
Configuration Manager” on page 329

Updated note about restarting 
Communications Configuration Manager 
component.

“Activity Attachments Stored for Inbound 
Email” on page 332

New for version 7.5.3: Added section about 
file attachments associated with Email - 
Inbound activities.

“Preference Settings in the 
Communications Tab” on page 340

Added note about Bring to Front behavior on 
Microsoft Windows platforms.

“Using the Send Email Command” on 
page 369

Added note about selecting multiple records 
prior to using Send Email.

“Activity Types for Each Send Command” 
on page 386

Added information about activities 
associated with Send Email and Send Fax 
commands.

Chapter 9, “Configuring Communications 
Templates”

Created new chapter from section in former 
Chapter 8, “Working with Communications 
Templates and Outbound Communication 
Requests.”

Table 1. Changes Made in Version 7.5.3

Topic Revision
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“Creating Simple Templates” on page 400 Communications templates previously 
referred to as “basic templates” are now 
referred to as “simple templates,” a term 
corresponding to the user interface.

“Template Content and Formatting” on 
page 394 and “Fields for Templates” on 
page 410

Added information about using HTML 
Template check box with advanced 
templates.

Chapter 10, “Defining Outbound 
Communication Requests”

Created new chapter from section in former 
Chapter 8, “Working with Communications 
Templates and Outbound Communication 
Requests.”

“Outbound Communication Request 
Restart Capability” on page 441

Added note about restart capability for 
outbound communication requests.

“About Siebel CTI Connect” on page 449 For Siebel CTI Connect, updated Dialogic CT 
Connect middleware references to new 
name, Intel NetMerge. The driver is still 
named Dialogic CTI.

“Siebel CTI Connect Commands” on 
page 465

Revised for version 7.5.3: Updated command 
descriptions for Siebel CTI Connect. 
Parameters ID, AgentId, AgentPin, and 
ACDQueue apply to more commands.

“Siebel CTI Connect Events” on page 472 Revised for version 7.5.3: Updated event 
descriptions for Siebel CTI Connect. Added 
new event, EventAnswerCall.

“About Wireless Messaging” on page 481 Added note about character set limitations 
applicable to wireless messages received on 
mobile devices.

“Driver Parameters for Internet SMTP/
POP3 Server” on page 524

Revised for version 7.5.3: Updated 
description for parameter Incoming Email 
Directory.

New for version 7.5.3: Added new parameter, 
SMTP Backup Server.

“Creating and Configuring the Attachments 
Directory” on page 544

Updated section about defining attachments 
directory for use with Lotus Notes or 
Microsoft Outlook.

Table 1. Changes Made in Version 7.5.3

Topic Revision
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Additional Changes
■ Several chapters and sections were renamed from the previous revision. The 

table above notes where major content has moved.

“About Installing the Siebel Email Form” on 
page 545

Updated section for installing Siebel email 
form for use with Lotus Notes or Microsoft 
Outlook.

“Other Communications Drivers” on 
page 560

New for version 7.5.3: Added information 
about new Push Keep Alive driver.

“Methods of ISC_CLIENT_HANDLE” on 
page 582

Updated syntax for client handle method 
IndicateNewWorkItem.

“Outbound Communications Manager 
Methods” on page 618

Updated method and argument descriptions 
for Outbound Communications Manager 
business service.

Appendix F, “Views for Communications 
Administration”

Created new chapter from section in 
Chapter 2, “Configuring Communications.”

“Using Siebel Scripts from Version 6.x” on 
page 671

Updated Siebel eScript and Siebel VB 
examples.

Table 1. Changes Made in Version 7.5.3

Topic Revision
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About Siebel Communications Server 1
This chapter provides an overview of Siebel Communications Server and:

■ Surveys its relationship with other Siebel modules

■ Provides an overview of Communications Server architecture

■ Provides an overview of communications configuration data

■ Provides an overview of the process of configuring Communications Server

What Is Siebel Communications Server?
Siebel Communications Server provides an infrastructure to support several kinds 
of communications activities for Siebel application users. Custom drivers for third-
party products can be created using the Adaptive Communications API.

■ Session-based/interactive communications. Supports multichannel interactive 
communications for call or contact center agents who use the communications 
toolbar to:

■ Make or receive voice calls through computer telephony integration 
supported by third-party CTI middleware packages.

■ Receive inbound email messages (for Siebel eMail Response).

■ Inbound communications. Supports integrating to third-party email servers and 
processing inbound email (when using Siebel eMail Response) or processing 
inbound wireless messages (when using Siebel Wireless Messaging).

■ Outbound communications. Supports integrating to a variety of third-party 
communications systems such as email servers, or using Siebel Wireless 
Messaging, to send outbound communications.
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■ Supports the Send Email, Send Fax, and Send Wireless Message commands 
for Siebel application users. (Send Page is also available but uses Page 
Manager rather than Communications Server.)

■ Supports agents sending email replies, for Siebel eMail Response.

■ Supports users sending communications content to designated recipients 
using outbound communication requests. Communication requests can be 
created and submitted manually through a user interface described in this 
book, or created and submitted programmatically.

Many Siebel modules invoke business service methods through workflows to 
send outbound communications. For example, Siebel Marketing sends 
outbound communication requests as email/fax offers.

NOTE: Your Siebel implementation may not have all the features described in this 
guide, depending on which software modules you have purchased.

Using Communications Server with Other Siebel Modules
This section provides high-level information about how Siebel Communications 
Server works with closely related product modules. Several Siebel modules use the 
Communications Server infrastructure to support certain functionality for the Siebel 
eBusiness Applications.

Communications Server functionality is not limited to what is described in the 
subsections below. Many specific features of Siebel eBusiness Applications that 
interrelate with Siebel Communications Server are discussed throughout this book.

For example, many customers may choose to implement Communications Server in 
order to support the Send Email, Send Fax, or Send Wireless Message commands. 
In addition, customers using Siebel Call Center may choose to implement Siebel 
CTI, Siebel eMail Response, or Siebel Universal Queuing. The customer dashboard 
feature and Siebel SmartScript can be used with these modules.
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Communications Server and Siebel CTI
Siebel CTI (Computer Telephony Integration) provides voice-channel support for 
call center agents using Siebel eBusiness Applications. CTI capabilities are provided 
through integration with third-party CTI middleware packages, such as Intel 
NetMerge.

Siebel CTI Connect, available from Siebel Systems, Inc., includes Intel NetMerge 
middleware components. These components include Intel NetMerge Call Processing 
Software (formerly Dialogic CT Connect) and Intel NetMerge Call Information 
Manager (formerly Dialogic Call Information Manager.) Siebel CTI Connect also 
includes the Siebel communications driver for Intel NetMerge and sample Siebel 
communications configuration data. 

The sample communications configurations provided by Siebel Systems contain 
events and commands that support CTI functionality, as well as events and 
commands that support email.

The Communications Session Manager handles CTI communications. Agents are 
notified of incoming calls through the communications toolbar and can perform a 
range of call-handling activities using the toolbar and related menu commands.

Telesets are defined and associated with communications agents in the 
Communications Administration screen.

Call routing can be handled by Siebel Universal Queuing, by the ACD (Automatic 
Call Distributor), by the CTI middleware, or by a third-party vendor’s queuing 
engine that has been integrated with Siebel Communications Server.

The Reception screen is a feature of Siebel CTI that provides a user interface for 
agents operating as telephone receptionists. Reception agents can view and 
manipulate multiple inbound voice calls and view detailed information about each 
caller. Agents also use the communications toolbar and related features to handle 
the inbound voice calls.

For more information about Siebel CTI Connect, see Appendix A, “Using Siebel CTI 
Connect.”
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Communications Server and Siebel eMail Response
Siebel eMail Response allows agents to receive and reply to inbound email 
messages.

Inbound email routing can be handled by Siebel Universal Queuing or by Siebel 
Assignment Manager, in conjunction with Siebel Business Process Designer. If 
routing is handled using Siebel Universal Queuing, then communications 
configurations can support email activities for agents, and agents are notified of 
incoming email messages through the communications toolbar. The sample 
communications configurations provided by Siebel Systems contain events and 
commands that support email-handling functionality.

Siebel Systems provides a communications driver that integrates with a variety of 
email servers that support SMTP and POP3 protocols. Communications 
administrators also configure response groups and workflows to determine how to 
process inbound email messages.

The Communications Inbound Manager handles inbound email communications, 
while the Communications Outbound Manager handles outbound email for agent 
replies.

For more information, refer to Siebel eMail Response Administration Guide.

Communications Server and Siebel Universal Queuing
Siebel Universal Queuing is an optional infrastructure module that routes 
communications work items to agents. Agents are notified of the work items 
through the communications toolbar.

Siebel Universal Queuing can route work items of predefined channels such as 
email (for Siebel eMail Response) or voice calls (for Siebel CTI). It can also route 
work items of new channel types that you implement.

For more information, refer to Siebel Universal Queuing Administration Guide.

Communications Server and Siebel Wireless Messaging
Siebel Communications Server can send and receive messages in wireless message 
formats.
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■ Both one-way (outbound) and two-way (inbound and outbound) wireless 
messaging are supported using the module Siebel Wireless Messaging.

■ One-way (outbound) WAP Push wireless messaging using the WAP V1.2 or WAP 
V1.1 communications driver is supported in the base Siebel eBusiness 
Applications.

In a one-way wireless messaging scenario with Siebel Wireless Messaging, you use 
the MobileSys MX wireless messaging engine, which is included with Siebel 
Wireless Messaging. Through MobileSys MX, you can connect directly to network 
operators or connect to the MobileSys Network.

In a two-way wireless messaging scenario, you connect directly to the MobileSys 
Network, without using MobileSys MX.

Siebel Wireless Messaging uses communications drivers that support various 
protocols (message types) provided by SMS (Short Message Service). Siebel 
Wireless Messaging is available as an option for the Siebel Wireless application, or 
as an option for Siebel eBusiness Applications such as Siebel Call Center.

For more information about Siebel Wireless Messaging and WAP Push messaging, 
see Appendix B, “Using Wireless Messaging.”

Siebel Wireless is a separately licensed application that allows access to Siebel data 
and functionality, using wireless browsers on mobile devices. For more information, 
refer to Siebel Wireless Administration Guide.

Communications Server and Siebel Marketing
Siebel Marketing is an application that uses the Communications Outbound 
Manager and workflow processes to send outbound communications, in the form 
of email and fax offers, to potentially large sets of recipients. (Offers of type 
eNewsletter also use the email channel.)

Siebel Marketing sends the offer data, optionally with Siebel data field substitution, 
to recipients associated with one or more business object instances—such as 
contacts associated with an account.

Offers use the database tables for communications templates and outbound 
communication requests, but do not use the user interface for these elements that 
is described in this book.
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Siebel Marketing administrators must work with communications administrators to 
create profiles for the Internet SMTP/POP3 Server communications driver.

For more information, refer to Siebel Marketing Guide.

Communications Server and Siebel Business Process Designer
Siebel Business Process Designer is a module (part of the base applications) that 
works closely with Siebel Communications Server, allowing Communications 
Server business service methods to be invoked from workflow processes to serve a 
variety of purposes.

Many Siebel modules access outbound communications capabilities this way, 
including Siebel Wireless Messaging, Siebel Marketing, Siebel eSales, Siebel 
eAuction, and others. Refer to documentation for such products for more 
information about specific usage contexts.

Administrators for these products must work with communications administrators 
to create profiles for the Internet SMTP/POP3 Server communications driver.

Other Communications Server business service methods, such as those for the 
Communications Client service, can also be accessed from workflow processes.

For more information, see “Using Business Services with Communications Server” 
on page 238 and Appendix E, “Communications Server Business Services,” and 
refer to Siebel Business Process Designer Administration Guide.
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About Communications Server Architecture
Figure 1 illustrates the overall architecture of the communications infrastructure for 
the Siebel eBusiness Applications.

Figure 1. Architecture of Communications Infrastructure
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About Communications Configuration Data
The Communications Administration screen allows administrators to configure 
several kinds of communications data.

Sample communications configuration data is provided in the Siebel database. You 
modify the preconfigured (“out of the box”) data, or create new data, to customize 
Siebel Communications Server and the Siebel eBusiness Applications to support the 
communications channels you are using and to support your business processes.

You can also find the sample communications configuration data in the Siebel 
Sample Database.

Types of Communications Configuration Data
Figure 2 on page 35 shows key kinds of configuration data that you work with in 
the Communications Administration screen. This data enables you to specify 
communications functionality within the Siebel eBusiness Applications.
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One-to-one, one-to-many, and many-to-many relationships between elements are 
represented by the connector lines.

Table 2 on page 36 identifies communications elements that are frequently created 
in the process of configuring Siebel Communications Server, indicating where the 
element is created, configured, or specified. Unless otherwise noted, the application 
views identified are in the Communications Administration screen. Views in other 
screens are also mentioned, where applicable.

Figure 2. Overview of Communications Configuration Elements
Version 7.5.3 Siebel Communications Server Administration Guide 35



About Siebel Communications Server

About Communications Configuration Data
Table 2 is not comprehensive but attempts to show major elements in relation to 
other elements. Also refer to Figure 2 on page 35.

Table 2. Communications Configuration Elements

Configuration Element Description How Related Where Created / Configured

Communications 
configuration

Set of related data for 
communications, used 
for agents working with 
channels such as voice or 
email.

Includes parameters.

Parent of event handler, 
event response, event 
log, command, and 
command data.

Associated with profile 
and agent.

All Configurations

UQ configuration Set of related data 
applicable to Siebel 
Universal Queuing.

For details, refer to Siebel 
Universal Queuing 
Administration Guide.

Associated with 
communications 
configuration by using 
configuration parameter 
UQConfigurationName.

All Configurations 
(Communications 
Administration screen)

Configurations (UQ 
Administration screen)

Communications 
driver

(Drivers are database 
records that reference 
files such as library 
files.)

Usually a library file that 
Communications Server 
uses to interface to a 
communications system, 
such as voice, email, or 
wireless messaging.

Includes parameters.

Parent of profile. Communications Drivers 
and Profiles

Profile Provides access to 
communications driver 
for specific contexts.

Includes overrides for 
driver parameter.

Child of communications 
driver.

Associated with 
configuration, event 
handler, and command.

Also associated with 
response group, 
communications 
template, outbound 
communication request, 
and mobile device.

Administrators 
(Communications 
Administration screen):

■ Communications 
Drivers and Profiles

End users 
(Communications screen):

■ My Profiles
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Agent Contact center agent, 
manager, or other user in 
communications 
configuration.

Can use multiple 
communications 
channels.

Derived from employee.

Associated with 
configuration, teleset 
(for voice agents), and 
ACD queue (for voice 
agents).

All Configurations

Agent General Profile

All Telesets

ACD queue

(agent queue)

A queue on the ACD that 
agents can log into. 
Agents can also log into 
multiple queues.

Agents can log into 
queues automatically, 
from the communications 
toolbar, or from the User 
Preferences screen.

Associated with agent 
(for voice agents).

Administrators:

■ List of Values 
(Applications 
Administration screen)

■ Agent General Profile 
(Communications 
Administration screen)

End users (User 
Preferences screen):

■ Communications

Teleset Physical phone device 
such as used in a call 
center.

Optionally, can specify 
host name for hoteling.

Parent of extension.

Associated with agent 
(for voice agents).

All Telesets

Extension Extension for teleset. Child of teleset. All Telesets

Event handler Means of evaluating 
information received 
from communications 
driver.

Includes parameters.

Child of configuration.

Associated with profile 
and event response.

All Configurations

All Event Handlers

Event response Defines response invoked 
by event handler.

Includes parameters.

Child of configuration.

Associated with event 
handler and event log.

All Event Responses

Table 2. Communications Configuration Elements

Configuration Element Description How Related Where Created / Configured
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Event log Specifies logging 
behavior for event 
response.

Includes parameters.

Child of configuration.

Associated with event 
response.

All Event Logs

Command Means of performing a 
communications action. 
Commands are typically 
sent to communications 
driver.

A command can be 
specified as a 
subcommand of another 
command.

Includes parameters.

Child of configuration.

Associated with profile 
and command data.

All Configurations

All Commands

Command data Provides data applicable 
to command.

Includes parameters.

Child of configuration.

Associated with 
command.

All Command Data

Response group Defines how inbound 
communications such as 
email, routed voice calls, 
or wireless messages are 
processed.

Invokes a workflow 
process that evaluates 
and processes inbound 
communications.

Routing inbound email or 
voice calls requires Siebel 
Universal Queuing or 
another routing solution.

Associated with profile. All Response Groups

Table 2. Communications Configuration Elements

Configuration Element Description How Related Where Created / Configured
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Communications 
template

Provides content or 
structure for outbound 
message using email, fax, 
wireless message, or page 
channels.

Allows Siebel field data 
substitution. Can contain 
text or contain multiple 
template items.

Template items can 
specify text directly or 
reference files or 
literature items.

Associated with profile 
and outbound 
communication request.

Also specified for Send 
Email, Send Fax, Send 
Wireless Message, and 
Send Page commands, 
and for Siebel eMail 
Response replies.

Administrators 
(Communications 
Administration screen):

■ All Templates

End users 
(Communications screen):

■ My Templates

Outbound 
communication 
request

(This is an operational 
element rather than a 
configuration 
element.)

A request to send content 
from communications 
templates (optionally 
with field substitution) to 
recipients associated with 
business object instances 
—such as to contacts 
associated with an 
account.

Requests are sent using 
email, fax, wireless 
message, or page.

Requests can be created 
and submitted directly or 
from modules such as 
Siebel Marketing, using 
workflow processes.

Associated with 
communications 
template.

Administrators 
(Communications 
Administration screen):

■ All Outbound Requests

■ Outbound Request 
Overview

End users 
(Communications screen):

■ My Outbound Requests 

■ My Outbound Request 
Overview

Mobile device A device that can receive 
a wireless message sent 
using an outbound 
communication request 
or using the Send 
Wireless Message 
command.

Associated with profile.

Also associated with 
persons (employees, 
contacts, and so on) and 
with device addresses.

Device addresses are 
associated with profiles.

Administrators 
(Communications 
Administration screen):

■ Mobile Devices 

End users (Mobile screen):

■ Mobile

Table 2. Communications Configuration Elements

Configuration Element Description How Related Where Created / Configured
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NOTE: If Siebel Universal Queuing is deployed, employees and employee skills must 
be specified in configurations defined in the UQ Administration screen in order for 
agents to receive inbound work items for channels routed by Siebel Universal 
Queuing. For more information, refer to Siebel Universal Queuing Administration 
Guide.

Communications Configuration Requirements for Siebel Modules
Much of the communications configuration data that this chapter is concerned with 
involves sets of data organized under a type of record called a communications 
configuration. Used as a noun, this term (sometimes shortened to configuration) 
refers to these records and associated elements such as configuration parameters, 
agents, telesets, profiles, commands, and events. Siebel Systems provides 
predefined communications configurations that support multichannel 
communications environments.

For information about additional kinds of configuration data related to 
communications, see “Types of Communications Configuration Data” on page 34.

Communications drivers and profiles, through which Siebel Communications Server 
can interface to external systems such as CTI middleware, email servers, paging, or 
wireless messaging are part of the communications configuration data.

Communications drivers are usually based on library files, such as DLL (Dynamic 
Link Library) files on Microsoft Windows. Corresponding configuration data in the 
Siebel database, including driver parameters, is defined to work with each driver. 
Communications profiles customize driver behavior for particular purposes by 
allowing driver parameters to be overridden. Communications configurations have 
associated profiles.

Every deployment of Siebel Communications Server uses communications drivers 
and profiles. However, as shown later in this section, some Siebel modules use 
communications drivers and profiles but do not use (or might not use) 
communications configurations.

■ For more information about communications drivers and profiles, see Chapter 2, 
“Configuring Communications Drivers and Profiles.”

■ For more information about communications configurations, see “Creating or 
Modifying a Communications Configuration” on page 76.
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Modules That Use Communications Configurations
If you are using any of the Siebel modules listed below, you must create or use a 
communications configuration, such as a predefined multichannel configuration:

■ Siebel CTI

■ Siebel CTI Connect

For more information about these modules, see “Communications Server and Siebel 
CTI” on page 29.

Modules That May Use Communications Configurations
Siebel eMail Response customers can also use communications configurations. 
Note that:

■ If inbound email messages are routed using Siebel Universal Queuing or another 
integrated package for queueing and routing, you must use configurations.

NOTE: If you choose to use Siebel eMail Response with Siebel Universal Queuing, 
your communications configuration must include profiles for the 
communications driver named “User-interactive Email.” Events and commands 
for handling email work items are supported by this driver.

■ If inbound email messages are routed manually or using Siebel Assignment 
Manager, you cannot use communications configurations.

Using communications configurations enables your agents to use features such as 
the communications toolbar and communications commands in the application-
level menus. It also enables you to use Siebel Universal Queuing or another 
integrated queuing package to route inbound work items and to support 
multichannel communications capabilities.

Features That Do Not Use Communications Configurations
The following outbound communications features generally require 
communications drivers and profiles, but do not employ communications 
configurations:

■ Email, wireless, or other messages sent automatically using workflow policies 
and workflow processes
Version 7.5.3 Siebel Communications Server Administration Guide 41



About Siebel Communications Server

About Communications Configuration Data
■ Email, wireless, or other messages sent using outbound communication 
requests (multiple-recipient, high-volume)

■ Email/fax offers sent using Siebel Marketing

■ Send Email command

■ Send Fax command

■ Send Wireless Message command

■ Send Page command

NOTE: Some uses of wireless messaging require Siebel Wireless Messaging. For more 
information, see Appendix B, “Using Wireless Messaging.”

Send Email, Send Fax, Send Wireless Message, and Send Page Commands
By default, Send Email, Send Fax, Send Wireless Message, and Send Page 
commands are available in the File application-level menu for Siebel eBusiness 
Applications users. 

Apart from Send Page, these commands use communications drivers and profiles 
and are available when the communications infrastructure is in place. (Send Email 
does not use communications drivers and profiles when it is integrated with 
Microsoft Outlook or Lotus Notes.) 

A communications configuration is not needed in order for employees to access 
these menu commands. However, these Send commands are also available through 
the communications toolbar for agents who are enabled to use interactive 
communications session functionality offered by Siebel CTI, or Siebel eMail 
Response (with Siebel Universal Queuing).

For the Send commands to be available through the communications toolbar, 
employees must be specified as agents within a communications configuration, and 
communications must be enabled for the Siebel applications. For more information, 
see “Enabling Session Communications and Simulation” on page 311.

The Send commands can also be made available to employees in other areas of your 
applications by configuring the user interface using Siebel Tools. Such configuration 
does not require the use of communications configurations. For example, some 
customers may want to make these commands available through a different toolbar 
or other parts of the application.
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For more information, see Chapter 6, “Configuring User Interface Elements.” Also 
refer to Siebel Tools Reference and Siebel Tools Online Help.

Process of Configuring Communications Server
To set up Siebel Communications Server, review the process described in this 
section. For some of the steps in the configuration process described here, detailed 
instructions are provided in subsequent chapters. In general, you will perform the 
following tasks:

1 “Determining Your Communications Deployment Needs” on page 43.

2 “Setting Up Your External Communications System” on page 45.

3 “Setting Up Your Siebel Server Software” on page 46.

4 “Defining Communications Server Configuration Data” on page 47.

5 “Putting Siebel Communications Server into Production” on page 51.

For more information about Siebel Communications Server configuration data, see 
“About Communications Configuration Data” on page 34. 

See also Chapter 2, “Configuring Communications Drivers and Profiles,” and 
Chapter 3, “Configuring Session Communications.”

Determining Your Communications Deployment Needs
The multichannel support offered by Siebel Communications Server and its 
architecture requires that you plan your communications deployments carefully and 
thoroughly. You should read all relevant sections of this book before you start the 
configuration process.

NOTE: If you will be using an external communications system (such as CTI 
middleware or email server) that is not supported by an existing communications 
driver, you may need to create your own driver. For details, see Appendix D, 
“Developing a Communications Driver.”
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Consider the following issues as you plan your implementation of Siebel 
Communications Server in support of Siebel eBusiness Applications:

■ Determine the Siebel applications and other products you will be using in your 
implementation. Determine the communications channels and external 
communications systems you will be supporting for your Siebel applications. 
Channels may include voice, email, fax, wireless message, and so on.

Applications or modules may include Siebel Call Center, Siebel Service, Siebel 
Sales, Siebel eMail Response, Siebel Wireless, and so on. Related modules 
include Siebel CTI, Siebel CTI Connect, Siebel Universal Queuing, Siebel 
Wireless Messaging, Siebel Marketing, and so on. (Not all modules are available 
for all applications or parent modules.)

■ Determine which Siebel application features, technologies, or advanced 
configurations you will implement, such as global or distributed deployments, 
application integration, work-item routing, hoteling, multitenancy, Send Email, 
Send Fax, Send Wireless Message, or Send Page commands, workflow-based 
communications, the customer dashboard, and so on.

■ Determine whether the third-party communications products you expect to use 
are supported by Siebel Systems. For information about supported products, 
refer to Siebel System Requirements and Supported Platforms for your Siebel 
applications.

■ For communications activities that make use of communications configurations, 
determine the number of agents for each supported channel. For Siebel CTI, 
Siebel eMail Response, and other modules, you define agents within 
communications configurations. If you are using Siebel Universal Queuing, you 
specify employee skills and other settings to help determine how 
communications work items are routed.

■ Determine data and application visibility issues for your users as they relate to 
communications activities.

■ Determine available resources in your communications systems. For Siebel CTI, 
determine the available telesets and extensions, hoteling workstations, ACD 
queues, and so on. For Siebel eMail Response, determine the email accounts 
(mailboxes) that will be receiving inbound communications.

■ Determine the work model for inbound or outbound communications in your 
call center or contact center: that is, the logic of each customer interaction.
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■ Determine your requirements for performance, scalability, and architecture, and 
determine your deployment plans.

Determine the requirements in the above areas as they relate to Siebel 
Communications Server, other Siebel modules or server components, and the 
Siebel client types you will use. Also consider architectural issues for external 
communications systems such as CTI middleware and email servers. 
Information you gather in this process will help determine how you perform 
later configuration steps.

For more information about planning your system architecture, refer to Siebel 
Server Administration Guide.

■ Before you begin the process described in “Defining Communications Server 
Configuration Data” on page 47, review how communications configurations 
function, and assess your requirements in this area.

Setting Up Your External Communications System
You must perform the following steps before you can configure Siebel 
Communications Server:

■ For Siebel CTI, set up your PBX or ACD (automatic call distribution) switch, and 
install and configure the CTI middleware. Refer to your vendor documentation.

■ For email support, such as for Siebel eMail Response or other features, install 
and configure the email servers and set up mail accounts as appropriate. Refer 
to your vendor documentation. For issues specific to Siebel eMail Response, 
refer to Siebel eMail Response Administration Guide.

■ For Siebel Wireless Messaging, install and configure the MobileSys MX wireless 
messaging engine (for one-way wireless messaging), and establish the necessary 
connections to individual network operators or to the MobileSys Network. Two-
way wireless messaging requires connecting to the MobileSys Network.

Once you have performed these preparatory tasks, you are ready to perform Siebel 
Server setup tasks.
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Setting Up Your Siebel Server Software
Deploying Siebel Communications Server requires that you enable and run the 
following Siebel Server components:

■ Application Object Manager for your application, which supports user sessions 
in the Siebel Web Client. For example, you may be running instances of the 
Application Object Manager for Siebel Call Center.

■ Server Request Broker and Server Request Processor, which coordinate 
communications activities between instances of the Application Object Manager 
and instances of the Siebel Communications Server components. Server Request 
Broker and Server Request Processor are automatically enabled for each Siebel 
Server.

■ Siebel Communications Server components:

■ Communications Session Manager (CommSessionMgr)

■ Communications Configuration Manager (CommConfigMgr)

■ Communications Inbound Manager (CommInboundMgr)

■ Communications Outbound Manager (CommOutboundMgr)

Some minimal configuration of the above components may also be necessary. For 
more information, see Chapter 7, “Administering Siebel Communications Server.” 
Also refer to Siebel Server Administration Guide.

For more information about the architecture of Siebel Communications Server, see 
“About Communications Server Architecture” on page 33.

To set up your Siebel Server software

1 Install or upgrade your Siebel Server software, as described in:

■ Siebel Server Installation Guide for the operating system you are using

■ Upgrade Guide for the operating system you are using

Make sure that you install and enable the Communications Management 
component group.
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2 On each Application Object Manager that is to support users for whom the 
communications toolbar and other interactive session communications 
functionality must be available, set server component parameters described in 
“Enabling Session Communications and Simulation” on page 311.

3 Configure each Siebel Communications Server server component (in the 
Communications Management group) that you require for your implementation.

For more information, see Chapter 7, “Administering Siebel Communications 
Server.”

Defining Communications Server Configuration Data
This section describes in general terms how to define or modify Siebel 
Communications Server configuration data. Do this once all modules have been 
installed and the server components have been configured. Many of the steps can 
be performed in a different sequence than that shown here.

For more information about communications configurations, see “About 
Communications Configuration Data” on page 34. For detailed procedures for 
working with communications configuration data, see applicable sections in 
Chapter 3, “Configuring Session Communications.”

NOTE: When you have finished specifying the communications configuration data, 
you must exit and restart the Siebel application for the settings to take effect. After 
Siebel Communications Server has been deployed, any end users who are currently 
connected must also exit and restart the application for the new or modified 
configuration data to take effect.

To define Siebel Communications Server configuration data

1 Start the Siebel application, such as Siebel Call Center, logging in as the system 
administrator (for example, as the user SADMIN).
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2 Navigate to the Communications Administration screen. To do this, choose 
View > Site Map from the application-level menu, then choose 
Communications Administration in the Site Map.

For information about the views in this screen, where you will perform most of 
the tasks identified here, see Appendix F, “Views for Communications 
Administration.”

3 Configure communications drivers and profiles. As applicable, associate profiles 
with communications configurations you have already created. See Chapter 2, 
“Configuring Communications Drivers and Profiles.”

a For each communications driver you are using, specify default parameter 
values.

b For each communications driver you are using, create profiles. As 
appropriate, specify parameter values to override the driver parameters.

c If you are not using communications configurations, skip to Step 12 on 
page 50.

For more information about modules that use communications 
configurations, see “Communications Configuration Requirements for Siebel 
Modules” on page 40.

4 To support modules such as Siebel CTI and Siebel eMail Response (optional), 
create a communications configuration. See “Creating or Modifying a 
Communications Configuration” on page 76.

You can modify an existing communications configuration, or create a new 
configuration and transfer data into it from an existing configuration.

5 For the current configuration, specify configuration parameter values. See 
“Specifying Parameters for Communications Configurations” on page 80.

6 For the current configuration, associate profiles you created for your CTI driver 
and User-interactive Email driver. See “Creating or Modifying a Communications 
Configuration” on page 76.

7 For the current communications configuration, specify the agents for whom the 
communications configuration will apply. See “Specifying Agents” on page 89.
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a Add each agent to one or more configurations. If you add an agent to more 
than one configuration, specify which configuration is primary for the agent.

b Configure the agents, such as (for voice agents) to specify which ACD queues 
they will use, define ACD agent login and password, and so on.

NOTE: If you are not defining ACD queues, or if the driver parameter 
Service:IsQueueRequired is set to FALSE for the CTI driver or for applicable 
driver profiles associated with the configuration, then the above step is not 
necessary. For more information, see “Siebel CTI Connect Driver Parameters” 
on page 457.

c If telesets have already been defined (as in Step 8), you can specify the 
telesets an agent can use.

You do not need to associate agents with telesets that will be used for 
hoteling, or associate agents with telesets for agents who will not use the 
voice channel.

8 If you are using Siebel CTI (voice channel), specify the telesets for your call 
center. See “Specifying Telesets” on page 94.

a If a teleset will be used for hoteling, specify the host name for the hoteling 
computer.

b For each teleset, specify the extensions for the teleset.

c For each teleset, you can specify agents that can use the teleset. 

In order to associate an agent with a teleset, the agent must have already 
been added to the configuration (as in Step 7). You do not need to associate 
agents with telesets that will be used for hoteling.

9 Specify or verify event handlers and associated event responses and event logs, 
and associate them with the communications configuration. See “Defining 
Communications Events” on page 99.

a Create the event logs you will specify in your event responses, and associate 
them with the configuration.
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b Create the event responses you need, optionally specifying one or more event 
logs for each event response, and associate the event responses with the 
configuration.

c Create the event handlers you need, specifying an event response for each 
event handler, and associate the event handlers with the configuration.

10 Specify or verify commands and associated command data definitions, and 
associate them with the communications configuration. See “Defining 
Communications Commands” on page 106.

a Create the command data definitions that you will specify in your 
commands, and associate them with the configuration.

b Create the commands that you need, specifying a command data definition 
for each command, and associate the commands with the configuration.

11 Optionally, use the Communications Simulator to test your configuration. See 
“Enabling Session Communications and Simulation” on page 311 and 
“Simulating a Communications Environment” on page 233.

12 Complete any other needed configuration, customization, or performance-
tuning tasks for your Siebel implementation, and test the communications 
configurations you are using. For example, you may:

■ Implement Siebel Universal Queuing to help route inbound work items of 
one or more communications channel. For more information, refer to Siebel 
Universal Queuing Administration Guide.

■ Configure response groups for inbound communications. For more 
information, refer to Siebel eMail Response Administration Guide.

■ Create templates for outbound communications. For more information, see 
Chapter 9, “Configuring Communications Templates.”

■ Modify the Online Help for your users.

After you have verified the configuration, you can put Siebel Communications 
Server into production.
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Putting Siebel Communications Server into Production
This section describes how to transfer your communications settings from the test 
environment to the production environment.

To put Siebel Communications Server into production

1 Follow instructions for transferring your Siebel application from the test 
environment to the production environment. Refer to the Siebel Server 
Installation Guide for the operating system you are using.

2 Configure all production instances of Siebel Server components for 
Communications Server, as noted in “Setting Up Your Siebel Server Software” on 
page 46.

3 Verify your communications configuration data in the production environment.

For example, you may need to modify any communications configuration 
parameter values appropriately for a production environment.

4 Provide your end users with instructions for the following activities, as 
appropriate for your implementation and for the particular types of users:

■ Starting the Siebel client. For example, this can include providing the users 
with the URL for a Siebel Call Center Application Object Manager that is 
configured to provide access to communications functionality.

■ Accessing the Online Help.

■ Setting communications preferences in the User Preferences screen.

■ Using user interface controls such as the communications toolbar, 
Communications submenu commands, or the Communications screen to 
perform communications-related tasks.

■ Creating outbound communications templates for personal or public use.

Most templates are created by advanced users, especially those for public 
use.
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■ Creating communications profiles for personal use with the Send Email or 
Send Fax command.

Most profiles are created by administrators. By default, end user 
responsibilities do not include the My Profiles view.

■ Creating and submitting outbound communication requests.

For details on these tasks, see Chapter 8, “Communications Operations for End 
Users,” Chapter 9, “Configuring Communications Templates,” and Chapter 10, 
“Defining Outbound Communication Requests.”

Also refer to documentation for related Siebel products such as Siebel Universal 
Queuing, Siebel eMail Response, Siebel Marketing, and so on.
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This chapter provides an overview of communications drivers and profiles provided 
by Siebel Systems, and describes how to configure drivers and profiles to interface 
with communications software such as CTI middleware or email servers.

For more information:

■ If you are specifying communications configurations, see Chapter 3, 
“Configuring Session Communications,” and related chapters.

■ If you are upgrading from a previous version, see also Appendix G, “Upgrading 
from Version 6.x.” This appendix primarily addresses upgrade issues for 
Siebel CTI and Siebel Communications Server. Also refer to the Upgrade Guide 
for the operating system you are using.

■ For all implementations, also refer to related Siebel documentation for your 
products, such as Siebel eMail Response Administration Guide, Siebel Universal 
Queuing Administration Guide, Siebel Wireless Administration Guide, or Siebel 
Marketing Guide.

About Communications Drivers and Profiles
This section provides background information about communications drivers and 
profiles and the roles they play in supporting Siebel Communications Server.

Siebel Communications Server provides several types of communications drivers:

■ Communications driver that supports interactive voice communications (CTI, or 
computer telephony integration), for Intel NetMerge (formerly Dialogic) 
products, included in Siebel CTI Connect. See Appendix A, “Using Siebel CTI 
Connect.”
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■ Communications drivers that support wireless messaging using certain 
protocols—for example, outbound WAP Push, or inbound or outbound SMS 
(Short Message Service). SMS messaging requires Siebel Wireless Messaging. 
See Appendix B, “Using Wireless Messaging.”

■ Communications driver that supports inbound and outbound communications 
for email servers and fax gateways using SMTP/POP3 protocols. See 
Appendix C, “Using Email, Fax, and Other Systems.”

■ Communications driver that supports interactive communications capabilities 
for the email channel, using the communications toolbar. See Appendix C, 
“Using Email, Fax, and Other Systems.”

■ Communications driver that provides a heartbeat capability to help maintain the 
push connection. See “Using Push Keep Alive Driver for Session Connections” 
on page 232.

■ Communications drivers that support other outbound communications 
protocols—for example, FTP. See Appendix C, “Using Email, Fax, and Other 
Systems.”

In order to work with communications systems that are not supported by the drivers 
provided by Siebel Systems, customers or other vendors can create and support 
custom communications drivers using the Adaptive Communications API.

Or, to support additional or different driver parameters and functionality, you can 
write a driver to extend one of the Siebel-provided communications drivers.

For more information, see “Non-Supported Communications Systems” on page 59. 
See also Appendix D, “Developing a Communications Driver.”

NOTE: For information about upgrade issues that relate to communications drivers 
used in version 6.x, see Appendix G, “Upgrading from Version 6.x.”

Communications Drivers Provided by Siebel Systems
The communications drivers provided by Siebel Systems are described below. For 
more information, see “Communications Drivers and Third-Party Systems” on 
page 57.
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Voice/CTI Driver
The following communications driver supports voice communications for Siebel 
CTI:

■ Dialogic CTI. Supports CTI functionality for Siebel CTI Connect (using Intel 
NetMerge). For more information, see “About Siebel CTI Connect” on page 449.

Push Channel Keep-Alive Driver
The following communications driver provides a heartbeat function for push 
communications using Communications Session Manager:

■ Push Keep Alive. Provides a heartbeat function for push communications using 
Communications Session Manager. For more information, see “Using Push Keep 
Alive Driver for Session Connections” on page 232 and “Other Communications 
Drivers” on page 560.

User-interactive Email Driver
The following communications driver supports email interactivity within the Siebel 
application, enabling agents using Siebel eMail Response to use the 
communications toolbar. For more information, see “Supporting Email 
Interactivity” on page 536.

■ User-interactive Email. Supports agents working with email work items.

Email/Fax Driver
The following communications driver supports email and fax in several Siebel 
application contexts. For more information, see “Interfacing with Email and Fax 
Servers” on page 517.

■ Internet SMTP/POP3 Server. Supports Internet mail servers that support the SMTP 
protocol for outbound email or fax or the POP3 protocol for inbound email. This 
driver supports both plain-text and HTML email. For more information, see 
“Siebel-Validated Email Servers” on page 58.

Wireless Messaging Drivers
The following communications drivers support wireless messaging. For more 
information, see “Communications Server and Siebel Wireless Messaging” on 
page 30 and Appendix B, “Using Wireless Messaging.”
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■ Wireless Messaging 1-Way. Supports outbound wireless messaging using SMS, 
TAP, and SMTP wireless message types. Requires Siebel Wireless Messaging.

■ Wireless Messaging 2-Way. Supports inbound and outbound wireless messaging 
using SMS and other wireless message types. Requires Siebel Wireless 
Messaging.

■ WAP V1.2. Supports WAP Push messaging using the Wireless Application 
Protocol version 1.2.

■ WAP V1.1. Supports WAP V1.1 Push (HDML) messaging to Openwave browsers.

Paging Driver
The following communications driver supports the Telocator Alphanumeric Paging 
(TAP) protocol. For more information, see “Other Communications Drivers” on 
page 560.

■ Modem-based TAP Paging. Supports paging over a modem using TAP, for 
outbound communication requests. This communications driver is a feature of 
Siebel Paging. (The Send Page command does not use this driver.)

NOTE: Siebel Paging is included with all base applications of the Siebel eBusiness 
Applications. The module Siebel Wireless Messaging is available as an 
alternative to Siebel Paging.

FTP Driver
The following communications driver supports File Transfer Protocol (FTP). For 
more information, see “Other Communications Drivers” on page 560.

■ FTP. Supports File Transfer Protocol. This driver is used by Siebel Marketing to 
send contact lists to vendors who are contracted to execute campaigns. It can 
also be used to send outbound communication requests from any Siebel 
application.
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Communications Drivers and Third-Party Systems
By means of communications drivers, Siebel applications can work in conjunction 
with a variety of third-party CTI middleware, email servers, and wireless messaging 
systems. The communications infrastructure from Siebel Systems can work with 
several types of communications systems, in these scenarios:

■ Siebel Systems provides several communications drivers to support Siebel 
communications modules or third-party communications systems. Some Siebel 
modules, such as Siebel CTI Connect or Siebel Wireless Messaging, incorporate 
third-party technologies.

■ Third-party vendors write communications drivers, using the Adaptive 
Communications API, to support communications systems.

For updated information about third-party products supported by Siebel Systems, 
refer to Release Notes and Siebel System Requirements and Supported Platforms for 
your Siebel applications.

For information about third-party communications solutions validated by Siebel 
Alliances, see the Alliances section of the Web site for Siebel Systems.

NOTE: For detailed requirements and procedures for installing and configuring third-
party products, refer to your documentation for the third-party products.

The capabilities of your communications system (such as CTI middleware and 
switch combination) partly determine which functionality you can implement. For 
example, some switches do not support automatic call forwarding. In addition, 
some features supported in the communications system may not be supported in 
the corresponding Siebel communications driver. Consequently, information in this 
guide about certain features may not apply to your implementation. Consult your 
vendor documentation for information about supported functionality and features.

About Error Messages Related to Communications
For agents using session-based communications such as Siebel CTI, the Siebel client 
may sometimes receive error messages relating to communications functionality. 
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Some messages may originate from CTI middleware or from the communications 
driver. Messages are presented without modification, whether they originate from 
external communications systems or from Siebel modules. Such messages are 
prefaced with “Communication:” and appear above the communications toolbar, to 
the right of the application-level menus. 

For more information, see “Menu Commands for Displaying Error Messages” on 
page 364. 

The same error messages may also be logged, if logging is set for the 
Communications Session Manager component. For more information, see 
“Parameters for Communications Session Manager” on page 323.

Siebel-Validated CTI Middleware/Switches
Siebel Systems provides a communications driver and provides communications 
configurations that are validated to work with Intel NetMerge CTI middleware.

Siebel CTI Connect, available from Siebel Systems, Inc., includes Intel NetMerge 
Call Processing Software and Intel NetMerge Call Information Manager. Siebel CTI 
Connect also includes the Siebel communications driver for Intel NetMerge and 
sample Siebel communications configuration data. 

For information about installing and configuring Siebel CTI Connect and about 
configuring Siebel Communications Server to work with this module, including 
applicable driver parameters, events and commands, see Appendix A, “Using Siebel 
CTI Connect.”

For more information about currently supported third-party CTI middleware and 
telephony switches, refer to Siebel System Requirements and Supported Platforms 
for your Siebel applications.

Siebel-Validated Email Servers
Siebel Systems provides the Internet SMTP/POP3 Server communications driver, 
which has been validated to work with several third-party email servers.
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The Internet SMTP/POP3 Server communications driver is compliant with the 
following RFC standards: MIME: 2045 through 2049; SMTP: 2821; POP3: 1939.

NOTE: Configure your email servers appropriately to work with Siebel applications. 
For example, for security reasons, your SMTP server may restrict from which 
originating machines outbound email messages can be relayed. In this case, you 
must configure the SMTP server to allow messages to be relayed from Siebel Server 
machines running the Outbound Communications Manager server component.

For more information about currently supported third-party email servers and 
related products, refer to Siebel System Requirements and Supported Platforms for 
your Siebel applications. Also refer to your third-party vendor documentation.

For information about integrating Siebel Communications Server with email 
servers, particularly about parameters for the Internet SMTP/POP3 Server driver, 
see Appendix C, “Using Email, Fax, and Other Systems.”

Non-Supported Communications Systems
If your existing communications system is not supported by the communications 
drivers provided with Siebel Communications Server, consider the following 
options for custom communications drivers:

■ Use a communications driver developed, using the Siebel Adaptive 
Communications API, by a third party—such as a CTI middleware vendor. For 
information about third-party communications solutions validated by Siebel 
Alliances, see the Alliances section of the Web site for Siebel Systems.

■ Develop your own communications driver, using the Siebel Adaptive 
Communications API, to work with your communications system.

NOTE: Communications drivers developed by customers or third parties are not 
supported by Siebel Systems, Inc., but by their respective developers or providers.
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A Siebel Communications Server implementation using a custom communications 
driver developed using the Siebel Adaptive Communications API can take full 
advantage of standard features such as the communications toolbar, screen pops, 
communications commands, automatic creation of activities and logs, and user 
interface for administration and configuration.

A communications driver can be created that is to be used in conjunction with an 
existing driver. Such a driver, known as an aggregate driver, would extend the 
capabilities of the existing driver, enabling additional functionality.

For more information, see Appendix D, “Developing a Communications Driver.”

Communications Driver Settings
In the Communications Drivers and Profiles view, the Communications Drivers list 
displays settings for each driver. These settings are discussed in general terms later 
in this section.

In most cases, these settings should not be changed for the communications drivers 
provided by Siebel Systems. The settings are informative, however, and should be 
understood by the communications administrator. If you add a custom driver, you 
must specify values for these settings. Driver settings include:

■ Channel Type. For more information, see “Communications Drivers and 
Channels” on page 63.

■ Inbound. For more information, see “Inbound and Outbound Drivers” on 
page 63.

■ Outbound. For more information, see “Inbound and Outbound Drivers” on 
page 63.

■ Interactive. For more information, see “Interactive Drivers” on page 64.

■ Channel String. For more information, see “Communications Drivers and 
Channels” on page 63.

■ Library Name. For more information, see “Communications Driver Files and 
Database Records” on page 61.

■ Icon File. For more information, see “Icon Files for Interactive Communications 
Drivers” on page 65.
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Communications Driver Files and Database Records
Communications drivers are usually based on library files, such as DLL (Dynamic 
Link Library) files on Microsoft Windows, or shared object files on UNIX. Or, they 
may be executable or other types of files. Each driver file must be written to support 
the Siebel Adaptive Communications API.

Communications driver files are located by default in the bin subdirectory of the 
Siebel Server or Siebel Dedicated Web Client installation directory. They can be 
located in another directory, if an absolute path is specified.

Each communications driver file has one or more corresponding database records 
in the Communications Drivers and Profiles view of the Communications 
Administration screen.

NOTE: In this book, in discussions of configuration tasks in the Communications 
Administration screen, the term communications driver or driver usually refers to a 
database record that references a driver file. In discussions of developing drivers, 
however, the term generally refers to the driver file itself, which is the direct product 
of the development process.

Driver File Naming on Microsoft Windows and UNIX Platforms
The names of actual driver files to be loaded are obtained from the Library Name 
field in the Communications Drivers list. In some cases, the value for this field may 
be manipulated to obtain the name of the driver file to load.

Driver File Naming on Microsoft Windows Platforms
On Microsoft Windows platforms, the name of the driver file to load is generally 
obtained by appending “.dll” to the value of the Library Name field. However, if the 
value of the Library Name field includes a period (.), then no manipulation of this 
value is performed to obtain the name of the driver file.

If you add a new custom driver file that has the extension “.dll,” you can provide a 
Library Name value in either of two ways:

■ The value can correspond exactly to the name of the operating system file. For 
example, for a file named “driver.dll,” you can enter “driver.dll” as the Library 
Name value. This approach is recommended.
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■ The value can correspond to the name of the file but without the extension “.dll”. 
For example, for a file named “driver.dll,” you can enter “driver” as the Library 
Name value.

Driver File Naming on UNIX Platforms
On UNIX, the name of the driver file to load is generally obtained by prepending 
“lib” and appending “.so” to the value of the Library Name field. However, if the 
value of the Library Name field includes a period (.), then no manipulation of this 
value is performed to obtain the name of the driver file.

If you add a new custom driver file that starts with “lib” and has the extension “.so,” 
you can provide a Library Name value in either of two ways:

■ The value can correspond exactly to the name of the operating system file. For 
example, for a file named “libdriver.so,” you can enter “libdriver.so” as the 
Library Name value. This approach is recommended.

■ The value can correspond to the name of the file but without the elements “lib” 
and “.so.” For example, for a file named “libdriver.so,” you can enter “driver” as 
the Library Name value.

Additional Considerations for Driver File Naming
Following are additional considerations for specifying driver file names.

■ If you add a new custom driver file with any other naming pattern, then the file 
name must include a dot, and you must provide a Library Name value that 
corresponds exactly to the name of the operating system file.

■ If you install any custom driver file in a nondefault location, then some element 
of the file or path name must include a dot, and you must provide a Library 
Name value that includes the full path where the file can be located by the Siebel 
Server or Siebel Dedicated Web Client that is to load the driver.

■ If you create a custom driver that aggregates an existing driver provided by 
Siebel Systems, reference the operating system file for the Siebel driver by its 
exact name, regardless of what text is displayed for the Siebel driver in the 
Library Name field.
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■ If the file path is not specified, it is assumed that the driver is located in the bin 
subdirectory of the Siebel Server or Siebel Dedicated Web Client installation 
directory. The installation from which the driver file is loaded is the machine on 
which the channel manager runs.

Communications Drivers and Channels
Each communications driver file can be written to support a single communications 
channel type, such as voice, email, wireless messaging, and so on. Or, a driver file 
can be written to support multiple channel types. Most of the communications 
drivers provided by Siebel Systems each support a single channel type. For example, 
the driver Internet SMTP/POP3 Server supports the email channel.

Each communications driver record includes a string, the channel string, that is 
used by the driver to identify its own channel type. The channel string must match 
exactly the channel string as defined in the driver file.

For communications driver files that support multiple communications channel 
types, driver records corresponding to specific channels can reference different 
subsets of channel-specific functionality within the same driver file, by referencing 
different channel strings defined within the driver file.

For more information, see Appendix D, “Developing a Communications Driver.”

Inbound and Outbound Drivers
Each driver record in the Communications Drivers and Profiles view is indicated to 
support, or not support, inbound or outbound communications.

■ CTI drivers, such as that for Siebel CTI Connect (using Intel NetMerge), are for 
both inbound and outbound communications. They also support agent 
interactivity within the Siebel application.

■ The user-interactive driver for email supports agent interactivity within the 
Siebel application. It does not directly support either inbound or outbound 
communications.

■ The Push Keep Alive driver is an interactive driver that provides a service for 
agent communications sessions. It does not directly support either inbound or 
outbound communications.
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■ Communications drivers for email or fax, such as Internet SMTP/POP3 Server, 
support both inbound and outbound communications. Inbound functionality for 
such a driver is applicable only to Siebel eMail Response.

■ Drivers for SMS wireless messaging (for Siebel Wireless Messaging) support 
inbound communications (Wireless Messaging 1-Way) or both inbound and 
outbound communications (Wireless Messaging 2-Way).

■ Drivers for WAP Push, FTP, and paging support outbound communications only.

For more information about interactive drivers, see “Interactive Drivers” on 
page 64.

NOTE: The Inbound and Outbound fields are for informational purposes. Do not 
modify the values for these fields for the drivers provided by Siebel Systems.

Interactive Drivers
Depending on the purpose of the driver, the driver record in the Communications 
Drivers and Profiles view may be indicated as interactive. In particular, the Dialogic 
CTI driver, the user-interactive driver for email, and the Push Keep Alive driver are 
interactive drivers.

Interactive drivers enable communications functionality to be available to end users 
using the communications toolbar and related menu controls. Additional 
capabilities may also be required, such as a Siebel Universal Queuing integration to 
route communications work items to an agent’s communications toolbar. 

The Push Keep Alive driver, unlike other interactive drivers, does not have a user 
interface component.

Communications configurations can reference profiles for interactive drivers only. 
The events and commands defined in the configuration interact with the 
communications system through one of the interactive drivers.

NOTE: The Interactive field is for informational purposes. Do not modify the values 
for this field for the drivers provided by Siebel Systems. Custom drivers developed 
by third parties must be written to be interactive or not, according to their purpose.
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Icon Files for Interactive Communications Drivers
Generally, each interactive driver has a specified icon file, which designates the 
image file that represents the channel for interactive purposes in the 
communications toolbar. The icon file is used for the Channel Type Indicator and 
for blinking behavior, such as when an incoming work item has arrived.

For the interactive communications drivers (driver record) listed below provided by 
Siebel Systems, a default icon file is specified. For each interactive driver created by 
third parties, an icon file must be specified. Other communications drivers do not 
use icon files. (The Push Keep Alive driver, although it is an interactive driver, does 
not use an icon file.)

■ The Dialogic CTI driver (for Siebel CTI Connect), for the voice channel, uses 
voice.gif.

■ The User-interactive Email driver, for the email channel, uses mail.gif.

The image files are in the following locations:

■ eapps\public\language_code\images, in the Siebel Server installation directory

■ public\language_code\images, in the Siebel Dedicated Web Client installation 
directory

where language_code represents the language code for the installed software, such 
as ENU.

To use your own icon file, place your icon file into the directory identified above. 
You can either replace an existing file provided by Siebel Systems with your own, 
or use a new file and specify this filename in the Icon File field for the driver.

If you are using a custom communications driver (interactive driver), you can use 
your own icon file or re-use an icon file provided by Siebel Systems, such as one 
that represents the same communications channel.

To work within the existing toolbar framework, each image file used for a driver 
icon file must be 18 x 18 pixels, and must be of format GIF or JPG.

The driver icon files are not the same physical files as the image files that are 
specified as bitmaps for the toolbar commands in Siebel Tools, although some of 
the actual images may be identical or closely related. If you modify icons used in 
one context (interactive icon file or bitmap specified in Siebel Tools), you should 
modify them in both contexts to maintain user interface consistency.
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For more information, see “About Communications Toolbar Configuration” on 
page 265.

Communications Drivers and Profiles
A communications driver is initially configured by setting default parameter values 
for the driver within the Communications Drivers and Profiles view.

A communications driver can be made available to serve a particular purpose by 
creating one or more profiles that reference this driver. For each profile, parameter 
values can be specified to override those of the referenced driver or to provide 
values not otherwise specified.

Communications administrators, who are the primary audience for this book, 
generally configure drivers and create profiles. Depending on the features or 
products your company is deploying, multiple administrators may coordinate to 
perform these tasks.

For example, administrators who have expertise in CTI middleware, email servers, 
or wireless messaging may be tasked to configure the communications drivers and 
profiles that are specific to the technology or product areas with which they are 
familiar. Or some administrators may configure profiles only, under the direction of 
another administrator who configures drivers.

For profiles that may be specified by end users in some of the contexts described 
below, administrators can specify in the Communications Drivers and Profiles view 
in the Communications Administration screen which Siebel responsibilities will 
have visibility to the profiles. 

Profile visibility applies to the Send Email window (with the Siebel native email 
client) and Send Fax window, to email reply features using Siebel eMail Response, 
and to outbound communication requests. Users can see only those profiles 
associated with their responsibilities, or the profiles they have created themselves.

If your company implements multiple organizations, administrators can also 
associate each profile with an organization. For example, this may be used by Siebel 
eMail Response in looking up the contact associated with an inbound email 
message.
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Contexts of Use for Communications Profiles
Communications profiles, whether created by administrators or by end users, may 
be specified for use by administrators and end users in many communications-
related contexts within the Siebel application.

Administrator Contexts for Using Profiles
Administrators would specify profiles in the following contexts:

■ When defining communications configurations to support handling interactive 
work items such as voice calls for Siebel CTI or email messages for Siebel eMail 
Response with Siebel Universal Queuing.

■ When defining response groups for inbound communications, such as to 
support Siebel eMail Response.

■ When configuring mobile devices associated with employees, contacts, or 
others, to support wireless messaging. These profiles are associated with device 
addresses for each mobile device for each person.

■ For Siebel Wireless Messaging drivers, profiles must be created for each 
service node required by MobileSys MX (one-way outbound messaging) or 
the MobileSys Network (two-way messaging).

A service node is typically defined for each mobile network provider and 
each wireless message type to be used.

■ For the WAP V1.2 driver, profiles are required for each WAP gateway through 
which messages will be sent.

End Users Contexts for Using Profiles
General end users would specify profiles in the following contexts:

■ When specifying a default email/fax profile in the User Preferences screen 
(Outbound Communications tab). The profile specifies the message sender.

■ To specify the sender when sending outbound communications using the Send 
Email command (for the native Siebel email client) or Send Fax commands.
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■ When configuring mobile devices associated with the user, to support wireless 
messaging. Profiles are associated with device addresses for each mobile device 
for the user.

Specialized end users would specify profiles in the following contexts:

■ When defining communications templates for use with outbound 
communication requests.

■ When defining email/fax offers for Siebel Marketing.

■ When defining contact lists for vendor campaign execution for Siebel Marketing.

In any of these contexts, an end user can see only the profiles that meet one of the 
following conditions:

■ The profile has one of the user’s responsibilities associated with it.

■ The profile is created by the user.

If this capability is provided to them, end users can create profiles for their own use, 
by using the My Profiles view in the Communications screen. User-defined profiles 
support particular features, such as the Send Email or Send Fax commands, for 
which the users can directly specify the profile to be used.

Configuring Communications Drivers and Profiles
This section describes how to work with communications drivers and profiles to 
enable Siebel Communications Server to work with communications systems such 
as CTI middleware, email servers, wireless messaging, and so on. 

Every Siebel module that uses Communications Server makes use of 
communications drivers and profiles.

In the Communications Drivers and Profiles view, the Communications Drivers list 
displays settings for each driver. Generally, the only driver data you should create 
or modify directly for drivers provided by Siebel Systems are the default driver 
parameter values and the profiles you create for the drivers.
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The rest of this section describes specifying driver parameter values, creating 
profiles, and adding new driver records for custom driver files created using the 
Adaptive Communications API.

For more information about the parameters supported by each driver provided by 
Siebel Systems, see:

■ Appendix A, “Using Siebel CTI Connect”

■ Appendix B, “Using Wireless Messaging”

■ Appendix C, “Using Email, Fax, and Other Systems”

Specifying Driver Parameter Values
For each driver listed in the Communications Drivers and Profiles view, driver 
parameter data is displayed in the Driver Parameters list. For each driver parameter, 
a flag indicates whether the parameter requires a value.

Driver parameter values can be provided in one of two ways:

■ By setting a default value for a driver parameter. For more information, see 
“Setting Driver Parameter Default Values,” below.

■ By specifying an override value for the parameter in each profile you create for 
the driver. For more information, see “Defining Communications Profiles” on 
page 71.

Driver parameter values are in effect for all profiles using the driver, unless you 
override parameter values for a given profile.

Values for many parameters are likely to be specific to your site (such as a server 
name) or to an individual profile (such as a mailbox name).

NOTE: For any required parameter for which no value has been provided as a driver 
parameter, a value must be provided for the parameter, for each profile, in the form 
of a profile parameter override. If any parameter is expected to be specified as an 
profile parameter override, then the driver parameter must first be defined in the 
Driver Parameters list.
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Field Types for Driver Parameters
Parameters for communications drivers use one of the following field types:

■ Characters (letters, numerals, _ (underscore), and special characters used in 
macro-expansion)

Macro expansion can be used in fields of character type, as described in the 
section “Using Macro Expansion for Character Fields” on page 195. You can also 
use macros described in the section “Macros for Parameter Values” on page 196.

■ Boolean (allowable values are TRUE and FALSE)

■ Numeric (numerals 0–9)

Wildcard characters are not applicable to driver parameter values.

Setting Driver Parameter Default Values
You can specify a new default value for a driver parameter. Any default value can 
be overridden in a profile. Values for certain parameters will typically be provided 
through a profile parameter override.

If you expect that a particular parameter value will apply to all or most of the 
profiles you will create—that is, you do not expect to override the value—you 
should probably specify this value as the default driver parameter value. Doing so 
will save you time when you create profiles, as you may not have to define an 
override for this driver parameter.

For the Internet SMTP/POP3 Server driver, which supports the email channel, if end 
users will create profiles for personal use with the Send Email or Send Fax 
commands, then you must carefully consider for which parameter values these 
users will be expected to provide override values.

For information about creating personal profiles, see “Creating Communications 
Profiles for Personal Use” on page 366. For information about using the Send 
commands, see “Sending Email, Fax, Page, and Wireless Messages” on page 368.

For information about configuring the Send commands, see “Configuring the Send 
Commands” on page 280.
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To specify a driver parameter default value

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Communications Drivers and Profiles.

2 In the Communications Drivers list, select the driver for which you will modify 
default parameter values.

3 Click the Driver Parameters view tab.

4 In the Driver Parameters list, clear the existing default value for a parameter, and 
enter a new value.

Defining Communications Profiles
After you configure the communications drivers you will use, as described in 
“Specifying Driver Parameter Values” on page 69, you create communications 
profiles. 

Each profile specifies which driver is to be used, and how the driver will be used, 
for communications that use the profile. For email drivers, the profile also specifies 
the sender of outbound communications that use the profile.

When a Siebel Communications Server administrator or end user creates a 
communications template to be included in a communication request, the profile 
that will be used to deliver the template must be associated with the template.

NOTE: For more information about creating and using profiles with particular 
products such as Siebel eMail Response, refer to Siebel documentation for those 
products.

To create a communications profile

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Communications Drivers and Profiles.

2 In the Communications Drivers list, select the driver for which you will be 
creating a profile.

3 Click the Profiles view tab.
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4 In the Profiles list, add a new record to create a profile for the current driver.

5 Provide a name for the new profile.

6 Specify the organization that will use the profile.

7 Specify one or more responsibilities that will use the profile.

The profile will be visible to a user in the profile’s context of use, if the user’s 
responsibility is one of the responsibilities associated with the profile—for 
example, in Siebel eMail Response and in the Send Email and Send Fax 
commands. Profiles created by a user will also be visible to that user.

Now you will specify parameter override values, as described below.

Specifying Parameter Override Values for Profiles
This section describes specifying any new values to override the default values of 
driver parameters. You must do this for required parameters that are not defined for 
the driver, or for parameters for which the driver parameter default value is not 
appropriate for each profile.

For example, if you are using the Internet SMTP/POP3 Server driver within an 
environment supporting multiple email servers, you must create different profiles 
for this driver, each of which provides a different value for the SMTP Server 
parameter, identifying the name of the server.

For more information about driver parameters, see “Specifying Driver Parameter 
Values” on page 69.

To specify parameter override values for a profile

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Communications Drivers and Profiles.

2 In the Communications Drivers list, select the driver for which you created the 
profile you are configuring.

3 Click the Profiles view tab.

4 In the Profiles list, select the profile you are configuring.
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5 In the Profile Parameter Overrides list, add a new record for each driver 
parameter whose default value you are overriding.

6 For each parameter, specify the parameter name.

7 Enter an override value for the parameter.

You must specify a parameter override for any parameter for which no value has 
been provided as a driver parameter.

Adding a Custom Communications Driver
If you have developed a custom communications driver, using the Adaptive 
Communications API, or acquired such a driver from another vendor, you will need 
to add one or more records for the driver in the Communications Drivers and 
Profiles view.

For more information about drivers and about the settings mentioned below, see 
“Communications Driver Settings” on page 60. For more information about 
developing a custom driver, see Appendix D, “Developing a Communications 
Driver.” 

NOTE: If you are implementing a custom driver, see also “Configuring 
Communications List of Values Types” on page 282.

To add a custom communications driver

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Communications Drivers and Profiles.

2 In the Communications Drivers list, add a new record for the driver.

The Communications Drivers form appears.

3 Provide a name for the driver.

4 Specify the channel type for the driver.

5 Specify the channel string the driver uses to identify its own channel type.

6 Specify if the driver will be used for inbound communications.
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7 Specify if the driver will be used for outbound communications.

8 Specify if the driver is interactive.

9 Enter the name of the file, such as a library file, this driver record references.

Include the complete file name of the file, with the file extension.

10 For an interactive driver, enter the name of the driver’s icon file.

11 Optionally, provide a description for the new driver.
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This chapter explains how to set up communications configurations and related 
data. Communications configurations support Siebel CTI and other forms of session 
communications. This chapter also provides information about importing and 
exporting communications configuration data.

Previous and subsequent chapters address related and advanced topics pertinent to 
the topics in this chapter:

■ For an overview of steps involved in configuring your communications 
environment, see “Process of Configuring Communications Server” on page 43.

■ To configure communications drivers and profiles, see Chapter 2, “Configuring 
Communications Drivers and Profiles.”

■ For more information about configuring events or commands in your 
communications configurations, see Chapter 4, “Configuring Events and 
Commands.”

■ To perform a variety of advanced or special-purpose configuration tasks, see 
Chapter 5, “Advanced Communications Configuration.”

■ To configure communications elements in the user interface for Siebel eBusiness 
Applications, see Chapter 6, “Configuring User Interface Elements.”

■ To enable interactive communications sessions, and to configure and run Siebel 
Server components for Siebel Communications Server, see Chapter 7, 
“Administering Siebel Communications Server.”

For more information:

■ If you are upgrading from a previous version, see also Appendix G, “Upgrading 
from Version 6.x.” This appendix primarily addresses upgrade issues for 
Siebel CTI and Siebel Communications Server. Also refer to the Upgrade Guide 
for the operating system you are using.
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■ For all implementations, also refer to related Siebel documentation for your 
products, such as Siebel eMail Response Administration Guide, Siebel Universal 
Queuing Administration Guide, Siebel Wireless Administration Guide, or Siebel 
Marketing Guide.

Creating or Modifying a Communications Configuration
In the Communications Administration screen, use the All Configurations view to 
create or modify a communications configuration.

The sample configurations shown in Table 3 are provided with Siebel 
Communications Server to support handling work items of communications 
channels such as voice and email. These channels are supported by third-party 
products such as CTI middleware/switches or email software. 
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Your installation may include other configurations than these, such as those that 
may be imported from .def files. For more information about .def files, see 
“Exporting and Importing Configuration Data” on page 112.

After you create a communications configuration, you must create and associate 
parameters, profiles, agents, events, and commands, in order for the configuration 
to be functional.

■ For information about specifying parameters, see “Specifying Parameters for 
Communications Configurations” on page 80.

■ For information about specifying profiles, see “Configuring Communications 
Drivers and Profiles” on page 68.

■ For information about specifying agents, see “Specifying Agents” on page 89.

Table 3. Communications Configurations and Channels

Configuration Name Voice Channel Requirements Email Channel Requirements

Multichannel configuration A ■ Requires Siebel CTI Connect 
(based on Intel NetMerge)

■ Configuration requires profile for 
Dialogic CTI communications 
driver 

■ Optionally, routing work items 
uses Siebel Universal Queuing

■ Requires integration to email 
server using Internet SMTP/
POP3 Server driver

■ Configuration requires profile for 
User-interactive Email 
communications driver

■ Routing work items requires 
Siebel Universal Queuing or 
another routing solution

Reception configuration A
(for Reception screen)

■ Requires Siebel CTI Connect 
(based on Intel NetMerge)

■ Configuration requires profile for 
Dialogic CTI communications 
driver 

■ Optionally, routing work items 
uses Siebel Universal Queuing

■ Requires integration to email 
server using Internet SMTP/
POP3 Server driver

■ Configuration requires profile for 
User-interactive Email 
communications driver

■ Routing work items requires 
Siebel Universal Queuing or 
another routing solution
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■ For information about specifying events, see “Defining Communications Events” 
on page 99.

■ For information about specifying commands, see “Defining Communications 
Commands” on page 106.

Rather than using the Communications Administration screen to create or modify 
communications configuration data directly, you can export some of the data to files 
and modify or extend it using a text editor. Then you can import the data into the 
test or production Siebel database when you are ready to test, deploy, or update the 
communications configuration. For more information, see “Exporting and 
Importing Configuration Data” on page 112.

To create a communications configuration

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

The All Configurations view appears.

2 In the Configurations list, add a new record.

3 In the Name field, enter the name of the configuration.

4 Add any comments.

5 As appropriate, create or associate elements such as parameters, profiles, agents, 
commands, and event handlers, as described later in this chapter.

To edit an existing communications configuration

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

The All Configurations view appears.

2 In the Configurations list, select the record for the configuration to edit.

3 Make your changes.

4 As appropriate, create or associate elements such as parameters, profiles, agents, 
commands, and event handlers, as described later in this chapter.
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Copying or Deleting a Communications Configuration
You can copy or delete an existing communications configuration record.

Copying a Communications Configuration
You can copy an existing communications configuration record by using the 
available menu commands.

NOTE: When you copy a record for a communications configuration, associated 
configuration parameters, profiles, agents, commands (commands and command 
data), and events (event handlers, event responses, and event logs) are not copied.

Deleting a Communications Configuration
You can delete an existing communications configuration by using the available 
menu commands.

When you delete a record for a communications configuration, associated 
configuration parameters, commands (commands and command data), and events 
(event handlers, event responses, and event logs) are also deleted, recursively. For 
agents and profiles, however, the associations with these elements are deleted, but 
the underlying employee records and profile records are not deleted. 

When you perform this operation, the application may take several minutes to 
respond.

Viewing All Communications Configuration Data
Use the Configuration Explorer view to view information about all the elements of 
your communications configuration.

The Configuration Explorer view displays communications configuration data in a 
hierarchical format. This view comprises an explorer (tree control) on the left and 
lists on the right. The explorer on the left is read-only.
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To view communications configuration data

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Configuration Explorer.

The Configuration Explorer view is displayed. Any item in the explorer that is 
preceded by a plus sign (+) may contain other configuration items. For example, 
configurations contain commands, which in turn contain command parameters 
and associated command data definitions.

2 Click the plus sign for an item in the explorer to expand the item and reveal its 
specific subitems or categories of subitems.

3 Click an item’s name in the explorer applet to display subitem information in the 
relevant list on the right.

Specifying Parameters for Communications Configurations
Use the All Configurations view to specify parameter values for a communications 
configuration. Configuration parameters are in effect for all agents who are included 
in the configuration for the contact center.

Certain elements associated with a communications configuration also have 
parameters that affect the overall function of the configuration. Such elements 
include communications drivers and profiles, commands, and events.

The communications configurations provided by Siebel Systems include 
configuration parameters and default values. “Parameters for Communications 
Configurations” on page 81 lists these configuration parameters and provides 
applicable default values which are in effect for each parameter if it is not defined. 
Some parameters must be included, while others are optional.

For more information about creating or modifying communications configurations, 
see “Creating or Modifying a Communications Configuration” on page 76.

To specify configuration parameters

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

2 In the Configurations list, click to select the configuration record for which you 
are specifying parameters.
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3 In the Parameters list:

a If the configuration does not include all supported parameters you require, 
add a record for each such parameter, specifying the parameter name and 
parameter value.

b Verify or edit values for all the parameters in your configuration. 

c Click the check mark for the Active field to enable or disable a configuration 
parameter. A disabled parameter has no effect on the communications 
configuration.

Parameters for Communications Configurations
This section describes the configuration parameters for communications 
configurations and displays applicable default values.

■ AutoLogin. Specifies whether auto-login is the global default setting for all agents 
in the communications configuration, or whether agents can set auto-login:

■ If AutoLogin is set to TRUE, then auto-login is in effect for all agents.

■ If AutoLogin is set to FALSE, then auto-login is disabled for all agents. If the 
parameter is not defined, the default setting is FALSE.

■ If AutoLogin is set to UserPreference, then auto-login is determined by the 
auto-login setting (“Auto Login to Call Center at Startup”) in the agent’s User 
Preferences screen (Communications tab).

If AutoLogin is either TRUE or FALSE, then agents cannot set the preference Auto 
Login to Call Center at Startup.

For more information, see “Setting Communications User Preferences” on 
page 339 and “Configuring Communications Login and Logout” on page 222.

■ AutoLoginCmd. Specifies which communications command for logging in should 
be executed for each user’s session, if AutoLogin is set to TRUE.

For more information, see “Setting Communications User Preferences” on 
page 339 and “Configuring Communications Login and Logout” on page 222.
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■ ChannelCleanupTimer. Specifies a timeout value, in seconds, that can help the 
Application Object Manager to clean up orphaned communications sessions, 
such as in the event of browser failure.

When a communications message, such as a new inbound call, is pushed from 
the Communications Session Manager to the Application Object Manager, if the 
message is not successfully pushed, then the value of this parameter is 
compared to the number of seconds since the last successful push message was 
delivered to the agent’s browser. If this number is greater than the value of 
ChannelCleanupTimer, then the agent’s communications session is considered 
to be orphaned. The session is terminated and the session resources on the 
Object Manager are freed up for other uses.

For example, if a message cannot be pushed, ChannelCleanupTimer is set to 60 
(seconds), and the last successful push message occurred 180 seconds ago, then 
this communications session will be terminated.

NOTE: You must define the ChannelCleanupTimer parameter if you are using the 
Push Keep Alive driver with your communications configuration. For more 
information, see “Using Push Keep Alive Driver for Session Connections” on 
page 232.

■ CheckPopupBeforeExecute. Specifies whether a screen pop for an incoming work 
item should be generated for an agent if a pop-up window is pending.

A pop-up window is pending after an agent has initiated an action that displays 
a pop-up window (for example, when specifying a value to complete a record in 
an applet, when invoking the Send Email command, and so on) and before the 
agent has completed and closed the window. A screen pop is likely to be 
disruptive to an agent’s workflow if it occurs during this time.

■ If CheckPopupBeforeExecute is set to TRUE, then a screen pop will not be 
generated for an agent if a pop-up window is pending. This parameter is 
TRUE by default.

■ If CheckPopupBeforeExecute is set to FALSE, then a screen pop may be 
generated regardless of any pending pop-up window.
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■ CommSessionMgr. Specifies the name of the Communications Session Manager 
component applicable to this communications configuration. 

The value is the component alias (such as CommSessionMgr), not the 
component name (such as Communications Session Manager).

NOTE: This parameter should be defined only when the Communications Session 
Manager is running on a different machine than the Siebel Server on which the 
Application Object Manager is running.

You define the CommSessionMgr, EnterpriseServer, GatewayAddress, and 
RequestServer parameters, as needed, in order to fully identify the 
Communications Session Manager applicable to this communications 
configuration.

You must define the CommSessionMgr parameter if your Communications 
Session Manager component has a different name than “CommSessionMgr.” 
Otherwise, it is optional.

For more information, see “Administering Communications Session Manager” 
on page 327.

■ ConnectString. Specifies the connect string to indicate the name of a remote 
instance of a server such as a CTI middleware server.

For more information, see “Configuring Remote Transfers and Conferences” on 
page 225.
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■ DialingFilter.RuleN. Used by the Siebel application to manipulate telephone 
numbers for voice calls made, transferred, or conferenced.

Specifies a set of phone-number translation rules that are invoked when the 
Lookup or PhoneTypeLookup keyword is specified in macro-expanded text in a 
communications command for the voice channel (using Siebel CTI).

The first set of numbers is searched for. If there is a match, the searched numbers 
are translated to the numbers after the -> symbols. For example:

DialingFilter.Rule001=“650477->”

This filter rule takes a ten-digit domestic phone number (for example) and 
translates it into four digits for dialing an internal extension.

For more information, see “Working with Dialing Filters” on page 214 and 
“Using Macro Expansion for Character Fields” on page 195.

■ EnterpriseServer. Specifies the name of the Siebel Enterprise Server for the Siebel 
Server on which the applicable Communications Session Manager is running.

NOTE: This parameter should be defined only when the Communications Session 
Manager is running on a different machine than the Siebel Server on which the 
Application Object Manager is running.

You define the CommSessionMgr, EnterpriseServer, GatewayAddress, and 
RequestServer parameters, as needed, in order to fully identify the 
Communications Session Manager applicable to this communications 
configuration.

You must define the EnterpriseServer parameter if the Siebel Servers supporting 
Communications Session Manager and Application Object Manager components 
run within different Siebel Enterprise Servers. Otherwise, it is optional.

For more information, see “Administering Communications Session Manager” 
on page 327.
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■ GatewayAddress. Specifies the name of the Siebel Gateway for the Siebel Server 
on which the applicable Communications Session Manager is running. The 
value is the Siebel Gateway machine name or IP address.

Include the port number if the Siebel Gateway uses a port other than the default 
(2320). For example, mygateway:2321.

NOTE: This parameter should be defined only when the Communications Session 
Manager is running on a different machine than the Siebel Server on which the 
Application Object Manager is running.

You define the CommSessionMgr, EnterpriseServer, GatewayAddress, and 
RequestServer parameters, as needed, in order to fully identify the 
Communications Session Manager applicable to this communications 
configuration.

You must define the GatewayAddress parameter if the Siebel Servers supporting 
Communications Session Manager and Application Object Manager components 
run within Siebel Enterprise Servers that are served by different Siebel Gateways. 
Otherwise, it is optional.

NOTE: It is recommended that you run your Communications Session Manager 
and Application Object Manager components on Siebel Servers for which the 
Enterprise Servers (one or more) are served by the same Siebel Gateway. In this 
case, the GatewayAddress parameter is optional.

For more information, see “Administering Communications Session Manager” 
on page 327.
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■ MaxCommToolbars. Specifies the number of instances of the Siebel application, 
for each agent, for which communications session capability can be enabled at 
one time—that is, for which the communications toolbar can be active.

If this parameter is not defined, the applicable value is 1; only one 
communications toolbar can be active at one time for each agent. It is generally 
advised to leave this parameter set to 1, so that communications events are 
received by one Siebel application instance only.

If an agent is running multiple Siebel application instances (for which 
communications would otherwise be enabled), the number of active 
communications toolbars cannot exceed the value of this parameter. If the 
maximum has been reached, and another Siebel application instance is started, 
the communications toolbar is not displayed in the new instance.

By using the Reset Active Session Count command, an agent can reset 
communications session capabilities. An agent may need to use this command, 
for example, following a browser hang. In such a scenario, the Communications 
Session Manager may internally retain an agent session that is unavailable to the 
agent, and would not allow any new agent session that would exceed the value 
of MaxCommToolbars.

After using Reset Active Session Count, the next time the agent starts a Siebel 
application instance, the communications toolbar will be enabled.

To access this command, an agent chooses View > Communications > Reset 
Active Session Count from the application-level menu, or uses the keyboard 
shortcut Ctrl+F8. 

The Reset Active Session Count command is configured in Siebel Tools and 
should not be modified. The shortcut may be modified, if desired.

The command is available when the user is defined as an agent within a valid 
configuration and the Enable Communication parameter is TRUE for the agent’s 
application.
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■ MultiTenancy. Specifies whether or not organization-visibility rules should be 
applied:

If MultiTenancy is set to FALSE (the default), then organization-visibility rules 
will not be applied. Use this setting if your Siebel implementation does not use 
the multitenancy (multiple organization) feature.

If the parameter is set to TRUE, then organization-visibility rules apply. Use this 
setting if your Siebel implementation uses multitenancy.

For more information, see “Supporting Multitenancy” on page 218.

■ PreferenceLoginCmd. Specifies which communications command should be 
executed when the agent clicks the Login button in the Agent Queues list, 
located in the Communications view in the User Preferences screen.

The default value is PreferenceLoginCmd.

For more information, see “Setting Communications User Preferences” on 
page 339 and “Configuring Communications Login and Logout” on page 222.

■ PreferenceLogoutCmd. Specifies which communications command should be 
executed when the agent clicks the Logout button in the Agent Queues list, 
located in the Communications view in the User Preferences screen.

The default value is PreferenceLogoutCmd.

For more information, see “Setting Communications User Preferences” on 
page 339 and “Configuring Communications Login and Logout” on page 222.
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■ RequestServer. Specifies the name of the Siebel Server on which the applicable 
Communications Session Manager is running.

NOTE: This parameter should be defined only when the Communications Session 
Manager is running on a different machine than the Siebel Server on which the 
Application Object Manager is running.

You define the CommSessionMgr, EnterpriseServer, GatewayAddress, and 
RequestServer parameters, as needed, in order to fully identify the 
Communications Session Manager applicable to this communications 
configuration.

For more information, see “Administering Communications Session Manager” 
on page 327.

■ RestoreScreenOnWorkResumed. Specifies whether or not the screen state should 
be restored when a suspended work item of any channel is resumed.

■ If this parameter is set to TRUE, then the screen state is restored when a work 
item of any channel is resumed. This parameter is TRUE by default.

■ If this parameter is set to FALSE, then the screen state is not restored when 
a work item of any channel is resumed.

■ UpdateChannelStatusTable. Channel status data is logged for display in the All 
Channel Items view only if the UpdateChannelStatusTable configuration 
parameter is set to TRUE. 

By default, this parameter is set to TRUE.

In a large call center, setting this parameter to TRUE may have performance 
implications: the Siebel database is updated as communications activity occurs, 
and the database is queried each time a manager or administrator displays or 
refreshes the All Channel Items view.

For more information, see “Viewing Communications Status Data” on page 260.
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■ UQConfigurationName. Specifies the name of the Siebel Universal Queuing 
configuration to use for agents specified for this communications configuration.

The Siebel Universal Queuing configuration is defined in the UQ Administration 
screen.

For more information about configurations for Siebel Universal Queuing, refer to 
Siebel Universal Queuing Administration Guide.

Specifying Agents
Use the All Configurations view and the Agent General Profile view to specify and 
configure agents for your communications configurations.

You specify agents by adding employees to one or more communications 
configurations in the All Configurations view, as described in “Creating or 
Modifying a Communications Configuration” on page 76.

As an alternative to adding individual employees to a configuration, you can add 
employees by adding responsibilities to the configuration. If you do this, all 
employees who have the specified responsibilities are added as agents.

After you have added agents, you configure them using the Agent General Profile 
view. For example, you can associate telesets or specify agent login and password 
for ACD queues.

For more information about the role of agents within a communications 
configuration, see “About Communications Configuration Data” on page 34.
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Relationship of Agents and Telesets for Siebel CTI
If you are using Siebel CTI, note that you must associate agents with 
communications configurations, specify telesets for your call center, and then 
associate the agents with any telesets they will use. However, agents do not need to 
be associated with hoteling telesets they may use.

NOTE: When an agent starts the Siebel application, any explicit association of the 
agent with a teleset is overridden if the user’s computer (host name) has been 
associated with the teleset for hoteling purposes. 

For more information about specifying telesets, see “Specifying Telesets” on 
page 94. For more information about hoteling, see “Configuring Telesets for 
Hoteling” on page 217.

Agents and ACD Queue Settings
If agents will receive voice calls through ACD queues, one or more ACD queues can 
be associated with the agent using the Agent General Profile view.

NOTE: If the parameter Service:IsQueueRequired is FALSE for any profiles for 
applicable CTI drivers that are associated with this configuration, then you need not 
associate agents with ACD queues. For more information, see “Siebel CTI Connect 
Driver Parameters” on page 457.

One or more ACD queues can be designated as primary for the agent. The Login and 
Logout buttons on the communications toolbar, and the auto-login function, log an 
agent into or out of all primary ACD queues.

In the User Preferences screen, an agent can selectively log into or out of any of the 
associated queues, including those not designated as primary. For more 
information, see “Setting Communications User Preferences” on page 339.
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For more information, see “Configuring Communications Login and Logout” on 
page 222.

NOTE: For information about setting ACD queue values, see also “Configuring 
Communications List of Values Types” on page 282.

Specifying Agents for Configurations
This section provides instructions for adding agents to a communications 
configuration. Once you have added an agent to a configuration, using the All 
Configurations view, you can further configure the agent, including associating the 
agent to other configurations, using the Agent General Profile view.

To add agents to a communications configuration

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

2 In the Configurations list, select the record for the configuration to which you 
will add the agent.

You can add an agent to more than one configuration, though only one 
configuration is in effect for the agent at a time.

3 Click the Agents view tab.

4 In the Agents list, add a new record. The Add Agents dialog box appears.

a Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

b For each employee that you want to add as an agent, click the check box to 
select this employee record.

c Click OK to add all selected employees to the Agents list.

5 Alternatively, in the Agents list, click Add by Responsibilities or choose it from 
the menu to add to the configuration all agents with the specified 
responsibilities.
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a Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

b For each responsibility that you want to add, click the check box to select this 
record.

c Click OK to add all selected responsibilities to the Agents list.

6 To add an agent to another configuration, return to Step 2 and repeat the steps 
that follow.

Configuring Agents
This section provides instructions for configuring an agent after the agent has been 
added to at least one communications configuration.

Using the Agent General Profile view, you can add the agent to additional 
configurations, associate the agent with telesets, and specify the ACD queues from 
which the agent may receive voice calls. You can also designate which configuration 
is primary for the agent, and which ACD queues are primary for the agent.

NOTE: The Agent General Profile view lists only those agents who have been 
associated with one or more configurations. For more information, see “Creating or 
Modifying a Communications Configuration” on page 76.

Only one configuration can be designated as primary for the agent, and only one 
configuration is in effect at one time. When an agent logs in for the first time, the 
primary configuration is in effect for the agent. In the Communications tab of the 
User Preferences screen, the agent can choose a different configuration, which will 
be in effect the next time the agent logs in. For more information, see “Setting 
Communications User Preferences” on page 339.

Telesets can be associated with an agent in this procedure only if the telesets have 
been defined. For more information, see “Specifying Telesets” on page 94.
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You can define the Agent Login and Password that are retrieved from the database 
each time an agent logs into the ACD queue. You must provide these values for 
agents who will be configured to log into the ACD queue, when required by the 
ACD. These values do not need to be specified for other users. The agent login and 
password need to be specified only once for an agent.

NOTE: For an Aspect switch, Agent Login also represents the number that other call-
center agents dial to reach the agent.

For more information about configuring login commands, see “Configuring 
Communications Login and Logout” on page 222. For more information about 
agent login procedures, see “Using the Communications Toolbar” on page 352.

The Agent General Profile view also displays the profiles associated with the 
configurations the agent is associated with.

To configure agents

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Agent General Profile.

The Agent General Profile list displays all agents that have been added to one or 
more communications configurations.

2 For agents who will need to log into ACD queues, enter the appropriate values 
into the Agent Login and Password fields, if no values have been specified 
previously.

3 Specify one or more existing configurations to associate this agent with:

a Click the Configurations view tab.

b In the Configurations list, add a new record. The Add Configurations dialog 
box appears.

c Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

d Select one or more configurations with which you want to associate the 
agent.
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e Click OK to associate all selected configurations with the agent.

4 If the agent is associated with multiple configurations, specify the primary 
configuration for the agent:

a In the Configurations list, select the record of the configuration that you want 
to be the agent’s primary configuration.

b Click the check box for the Primary field to make this the primary 
configuration.

5 For voice agents, you can specify one or more existing telesets to associate this 
agent with:

a Click the Telesets view tab.

b In the Telesets list, add a new record. The Add Telesets dialog box appears.

c Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

d Select one or more telesets with which you want to associate the agent.

e Click OK to associate all selected telesets with the agent.

6 To associate the agent with one or more ACD queues:

a Click the ACD Queues view tab.

b In the ACD Queues list, add a new record.

c Specify an ACD queue the agent will use.

d If this ACD queue is one of the primary ACD queues for the agent, click the 
check box for the Primary field.

Specifying Telesets
Use the All Telesets view to specify telesets for your communications 
configurations, including associating agents and extensions.
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Because teleset data is specific to your enterprise, you must specify this data for 
your call center. Some demo telesets are defined in the Sample Database, but no 
predefined teleset data is otherwise provided.

Teleset data is indirectly associated with communications configurations, by way of 
the agents who use the teleset. In this way, Siebel Communications Server can 
support CTI functions for your call center agents.

You define extensions for the telesets, then associate the extensions with agents 
(unless you are using hoteling) that have already been associated with a 
configuration.

For information about how end users can set preferences for telesets and 
extensions, see “Setting Communications User Preferences” on page 339.

Teleset Naming and Hoteling Considerations
You can provide any sort of unique name or number for a teleset. Naming telesets 
after cubicle or station identifiers or machine names may be a good approach to 
naming telesets. This approach avoids problems that may be associated with 
naming them after users or extensions, given that multiple users and extensions 
may be associated with one teleset.

If you implement hoteling, you may choose to name a hoteling teleset after the host 
name of the associated hoteling computer.

When you have specified a host name for a teleset in order to support hoteling, any 
agent logging into the Siebel client on the hoteling computer will also use the 
associated hoteling teleset. Associating a host name with a teleset overrides any 
association of the teleset with an agent.

For more information about hoteling, see “Configuring Telesets for Hoteling” on 
page 217.

Specifying Telesets, Agents, and Extensions
This section provides instructions for specifying telesets and specifying agents and 
extensions for telesets.
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To specify telesets

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Telesets.

2 In the Telesets list, add a new record.

3 In the Teleset field, enter the name of the teleset.

4 If the teleset and computer are to be used for hoteling, specify in the Host field 
the name of the computer where the teleset is located.

The host name you enter will be stored using all uppercase letters.

5 Enter any desired comments for the teleset.

6 For a non-hoteling teleset, click the Agents view tab and add agents for the 
telesets, as described below.

7 Click the Extensions view tab and add extensions for the teleset, as described 
below.

Specifying Agents for Telesets
This section provides instructions for specifying agents for telesets. You associate 
an agent with a teleset in order to authorize the agent to use this teleset.

All agents you associate with telesets must already have been associated with one 
or more communications configuration. For more information, see “Specifying 
Agents” on page 89.

Agents and telesets have a many-to-many relationship.

Agents who will use hoteling exclusively, or who will not use the voice channel 
(CTI), do not need to be associated with telesets.

To specify agents for a teleset

1 In the All Telesets view, select the record for the teleset to which you will add 
agents who will be authorized users of the teleset.

2 Click the Agents view tab.
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3 In the Agents list, add a new record. The Add Agents dialog box appears, 
displaying employees who have been added as agents to one or more 
configurations.

a Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

b For each agent that you want to associate with the current teleset, click the 
check box to select this record.

c Click OK to add all selected agents to the Agents list.

4 If no Agent Login and Password values exist for a given agent, you can add this 
data, as necessary:

a Click the hyperlink in the Agent field to drill down to the Agent General 
Profile view.

b In the Agent General Profile list, enter values for the Agent Login and 
Password fields.

For more information, see “Specifying Agents” on page 89.

Specifying Extensions for Telesets
This section provides instructions for specifying extensions for telesets.

After telesets, agents, and extensions have been specified, each agent who will use 
the teleset must specify a default standard extension from the telesets the agent is 
associated with. If the teleset an agent will use has been defined as a hoteling 
teleset, this step is not necessary. For details, see “Setting Communications User 
Preferences” on page 339.
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The way you specify extension data varies according to the switch you are using. 
Table 4 documents how extension type must be specified (S or A) for each of the 
switches supported in the communications configurations provided by Siebel 
Systems. For more information about supported switches, refer to Siebel System 
Requirements and Supported Platforms for your Siebel applications.

To specify extensions for a teleset

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Telesets.

2 In the All Telesets view, select the record for the teleset to which you will add 
extensions.

3 Click the Extensions view tab.

4 In the Extensions list, add a new record to create a new extension record.

5 In the Extension field, enter the extension.

6 In the Extension Type field, specify the type, as required for the switch:

■ “S” stands for standard DN: for all supported switch types, specify one 
extension of this type for each teleset.

■ “A” stands for the ACD DN: this extension type is only used for Nortel 
Meridian switches.

Table 4. Extension Type by Switch

Switch Name Extension Extension Type

Avaya (Lucent) Definity G3 Specify one extension per teleset. S – Standard DN

Nortel Meridian Specify two extensions per teleset: one of each 
type.

S – Standard DN
(also called Primary DN)

A – ACD DN
(also called Position DN)

Siemens Hicom 300E 
(Generic CSTA Phase II)

Specify one extension per teleset. S – Standard DN
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Viewing Extension Data
Use the All Extensions view to view information about the extensions for your 
telesets or to locate records for particular extensions.

You do not have to enter data in this view, because it displays data you previously 
specified in the All Telesets view.

To view extension data

■ From the application-level menu, choose View > Site Map > Communications 
Administration > All Extensions.

Defining Communications Events
You can specify events for your communications configuration. Siebel 
Communications Server supports three event types:

■ Event handlers

■ Event responses

■ Event logs

In general, you create event logs first, then create event responses and associate 
event logs with them, then create event handlers and associate event responses with 
them.

Event definitions are provided by Siebel Systems. You should verify whether the 
events in your communications configuration meet your needs before you modify 
them or create new events.

For more information about the role of events within a communications 
configuration, see “About Communications Configuration Data” on page 34.

For detailed information about working with communications events, including 
supported parameters, see Chapter 4, “Configuring Events and Commands.”

Creating Event Logs
This section describes how to create event logs, using the All Event Logs view.
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The Event Responses view tab in the All Event Logs view lets you view the event 
responses with which the current event log is associated.

NOTE: If you are implementing a custom communications driver, see also 
“Configuring Communications List of Values Types” on page 282.

To create an event log

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Logs.

2 In the Event Logs list, add a new record.

3 In the Name field, enter the name of the event log.

4 Specify the configuration to associate this event log with:

a In the Configuration field, click the select button. The Pick Configuration 
dialog box appears.

b Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

c Select an existing configuration with which you want to associate the event 
log, then click OK.

5 Enter any desired comments for the event log.

Specifying Event Log Parameters
This section describes how to add parameters for the current event log.

To add parameters for the current event log

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Logs.

2 In the Event Logs list, select the event log for which you want to add parameters.

3 Click the Event Log Parameters view tab.

4 In the Event Log Parameters list, add a new record.
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5 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type group, choose the parameter name, then type the name of the 
subparameter after the period. Available event log parameters are documented 
in “Event Logs” on page 168.

6 In the Value field, enter the value for the parameter.

Creating Event Responses
This section describes how to create event responses, using the All Event Responses 
view.

You can associate zero or more event logs with an event response. Some event 
responses do not need an event log.

The Event Handlers view tab in the All Event Responses view lets you view the 
event handlers with which the current event response is associated.

The Event Responses view tab in the All Event Logs view lets you view the event 
responses with which the current event log is associated.

NOTE: If you are implementing a custom communications driver, see also 
“Configuring Communications List of Values Types” on page 282.

To create an event response

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Responses.

2 In the Event Responses list, add a new record.

3 In the Name field, enter the name of the event response.

4 Specify the configuration to associate this event response with:

a In the Configuration field, click the select button. The Pick Configuration 
dialog box appears.
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b Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

c Select an existing configuration with which you want to associate the event 
response, then click OK.

5 Enter any desired comments for the event response.

Specifying Event Response Parameters
This section describes how to add parameters for the current event response.

To add parameters for the current event response

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Responses.

2 In the Event Responses list, select the event response for which you want to add 
parameters.

3 Click the Event Response Parameters view tab.

4 In the Event Response Parameters list, add a new record.

5 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type Group, choose the parameter name, then type the name of the 
subparameter after the period. Available event response parameters are 
documented in “Event Responses” on page 154.

6 In the Value field, enter the value for the parameter.

Associating Event Logs to an Event Response
This section describes how to associate an event log with the current event 
response.

To associate an event log with the current event response

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Responses.
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2 In the Event Responses view, select the event response with which you want to 
associate an event log.

3 Click the Associated Event Logs view tab.

4 In the Associated Event Logs list, add a new record.

5 Specify the event log to associate with this event response:

a In the Name field, click the select button. The Pick Event Log dialog box 
appears, displaying existing event logs associated with the same 
configuration as the event response.

b Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

c Select an event log with which you want to associate the event response, then 
click OK.

6 In the Log Type field, specify the type for this log.

Available types are AddLog, ContextLog, FindLog, Log, MultiLog, and SingleLog. 
For more information, see the parameter descriptions for these elements in 
“Event Responses” on page 154.

Creating Event Handlers
This section describes how to create event handlers, using the All Event Handlers 
view.

Associating an event response to an event handler is optional.

The Event Handlers view tab in the All Event Responses view lets you view the 
event handlers with which the current event response is associated.

The Associated Event Logs view tab in the All Event Handlers view lets you 
associate an event log with the event response that is associated with the current 
event handler. The procedure is the same as that described in the section “Creating 
Event Responses” on page 101.
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In Step 6 below, associating a profile with an event handler is optional. It can help 
you avoid collisions if the same device event is available in multiple drivers.

NOTE: If you are implementing a custom communications driver, see also 
“Configuring Communications List of Values Types” on page 282.

To create an event handler

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Handlers.

2 In the Event Handlers list, add a new record.

3 In the Name field, enter the name of the event handler.

4 Specify the configuration to associate this event handler with:

a In the Configuration field, click the select button. The Pick Configuration 
dialog box appears.

b Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

c Select an existing configuration with which you want to associate the event 
handler, then click OK.

5 Specify the event response to associate this event handler with:

a In the Event Response field, click the select button. The Pick Event Response 
dialog box appears, displaying existing event responses associated with the 
same configuration as the event handler.

b Select an event response with which you want to associate the event handler, 
then click OK.

6 Optionally, specify the profile to associate this event handler with:

a In the Profile field, click the select button. The Pick Profile dialog box 
appears, displaying existing profiles associated with the same configuration 
as the event handler.
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b Select a profile with which you want to associate the event handler, then click 
OK.

The name of the communications driver for the profile is displayed along 
with that of the profile.

7 In the Device Event field, enter the name of the device event this event handler 
will match.

The device events you can specify are those supported by the communications 
driver for the associated profile, or special events.

8 In the Order field, specify an integer representing the order in which this event 
handler will be checked, relative to other event handlers specifying the same 
device event.

9 Enter any desired comments for the event handler.

Specifying Event Handler Parameters
This section describes how to add parameters for the current event handler.

To add parameters for the current event handler

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Handlers.

2 In the Event Handlers list, select the event handler for which you want to add 
parameters.

3 Click the Event Handler Parameters view tab.

4 In the Event Handler Parameters list, add a new record.

5 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type Group, choose the parameter name, then type the name of the 
subparameter after the period. Available event handler parameters are 
documented in “Event Handlers” on page 146.

6 In the Value field, enter the value for the parameter.
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Specifying Event Response Parameters
This section describes how to add event response parameters for the event response 
associated with the current event handler.

To add parameters for the current event response

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Event Handlers.

2 In the Event Handlers list, select the event handler for whose associated event 
response you want to add parameters.

3 Click the Event Response Parameters view tab.

4 In the Event Response Parameters list, add a new record.

5 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type Group, choose the parameter name, then type the name of the 
subparameter after the period. Available event response parameters are 
documented in “Event Responses” on page 154.

6 In the Value field, enter the value for the parameter.

Defining Communications Commands
You can specify commands for your communications configuration. Siebel 
Communications Server supports two command types:

■ Commands

■ Command data definitions

In general, you create command data definitions first, then create commands and 
associate command data definitions with them.

Commands and command data definitions are provided by Siebel Systems. You 
should verify whether the commands in your communications configuration meet 
your needs before you modify them or create new commands.
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For more information about the role of commands within a communications 
configuration, see “About Communications Configuration Data” on page 34.

For information about configuring commands for the communications toolbar and 
for communications menu items, see Chapter 6, “Configuring User Interface 
Elements.”

For detailed information about working with communications commands, 
including supported parameters, see Chapter 4, “Configuring Events and 
Commands.”

Creating Command Data Definitions
This section describes how to create command data definitions, using the All 
Command Data view.

The Commands view tab in the All Command Data view lets you view the 
commands with which the current command data definition is associated.

NOTE: If you are implementing a custom communications driver, see also 
“Configuring Communications List of Values Types” on page 282.

To create a command data definition

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Command Data.

2 In the Command Data list, add a new record.

3 In the Name field, enter the name of the command data definition.

4 Specify the configuration to associate this command data definition with:

a In the Configuration field, click the select button. The Pick Configuration 
dialog box appears.

b Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

c Select an existing configuration with which you want to associate the 
command data definition, then click OK.
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5 Enter any desired comments for the command data definition.

To add parameters for the current command data definition

1 Click the Command Data Parameters view tab.

2 In the Command Data Parameters list, add a new record.

3 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type Group, choose the parameter name, then type the name of the 
subparameter after the period. Available command data parameters are 
documented in “Command Data” on page 186.

4 In the Value field, enter the value for the parameter.

Creating Commands
This section describes how to create commands, using the All Commands view.

Associating a command data definition to a command is optional. For example, 
commands that contain subcommands do not need a command data definition.

The Commands view tab in the All Command Data view lets you view the 
commands with which the current command data definition is associated.

In Step 6 below, associating a profile with a command is optional. It can help you 
avoid collisions if the same device command is available in multiple drivers.

NOTE: If you are implementing a custom communications driver, see also 
“Configuring Communications List of Values Types” on page 282.

To create commands

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Commands.

2 In the Commands list, add a new record.

3 In the Name field, enter the name of the command.
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4 Specify the configuration to associate this command with:

a In the Configuration field, click the select button to display the Pick 
Configuration dialog box.

b Select an existing configuration with which you want to associate the 
command, then click OK.

5 Specify the command data to associate with this command:

a In the Command Data field, click the select button. The Pick Command Data 
dialog box appears, displaying existing command data definitions associated 
with the same configuration as the command.

b Scroll to display any additional records that are not shown, or use Query or 
Find to locate records matching certain criteria.

c Select a command data definition you want to associate with the command, 
then click OK.

6 Optionally, specify the profile to associate this command with:

a In the Profile field, click the select button. The Pick Profile dialog box 
appears, displaying existing profiles associated with the same configuration 
as the command.

b Select a profile with which you want to associate the command, then click 
OK.

The name of the communications driver for the profile is displayed along 
with that of the profile.

7 Enter any desired comments for the command.

Specify Subcommands for a Group Command
This section describes how to specify subcommands for a command. For more 
information about group commands that specify subcommands, see 
“Communications Group Commands in Toolbar” on page 276.

When you specify subcommands for a group command, do not specify invalid 
recursive relationships between subcommands and group commands.
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For example, do not specify a subcommand that is itself a group command for 
which the current group command is specified as a subcommand. A relationship 
like this will invalidate the communications configuration when it is loaded for an 
agent’s session and disable the communications toolbar.

To specify subcommands for a group command

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Commands.

2 In the Commands list, create or select a command to which you will add 
subcommands.

3 Click the Subcommands view tab.

4 In the Subcommands list, add a new record.

5 In the Subcommands field, click the select button to display the Pick Command 
dialog box.

6 Select an existing command that you want to serve as a subcommand for the 
current command, then click OK.

7 Specify the order for the subcommand.

8 Repeat Step 4 through Step 7, as necessary, for each subcommand.

Specifying Command Parameters
This section describes how to add parameters for the current command.

To add parameters for the current command

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Commands.

2 In the Commands list, select a command to which you will add parameters.

3 Click the Command Parameters view tab.

4 In the Command Parameters list, add a new record.
110 Siebel Communications Server Administration Guide Version 7.5.3



Configuring Session Communications

Defining Communications Commands
5 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type Group, choose the parameter name, then type the name of the 
subparameter after the period. Available command parameters are documented 
in “Commands” on page 172.

For example, the DeviceCommand parameter lets you specify a device command 
to execute, such as for a communications driver to pass on to an external 
communications package such as CTI middleware.

6 In the Value field, enter the value for the parameter.

Specifying Command Data Parameters
This section describes how to add command data parameters for the command data 
definition associated with the current command.

To add parameters for the current command data definition

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Commands.

2 In the Commands list, select a command for which you will add parameters to 
the associated command data definition.

3 Click the Command Data Parameters view tab.

4 In the Command Data Parameters list, add a new record.

5 In the Name field, specify the name of the parameter.

You can choose the parameter name from a list or type the name. For a 
parameter of type Group, choose the parameter name, then type the name of the 
subparameter after the period. Available command data parameters are 
documented in “Command Data” on page 186.

6 In the Value field, enter the value for the parameter.
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Exporting and Importing Configuration Data
Siebel Communications Server provides import and export mechanisms that enable 
administrators to move communications configuration data between the database 
and ASCII text files. You can use these mechanisms to:

■ Upgrade your implementations from previous versions of Siebel CTI (versions 
6.x and earlier)

■ Move configuration data between databases or between communications 
configurations within the same database

■ Move configuration data and custom communications drivers obtained from 
another source such as a third-party vendor into Siebel Communications Server

■ Edit or enter data in text files rather than directly within the Communications 
Administration screen 

For more information about adding custom communications drivers, see Chapter 2, 
“Configuring Communications Drivers and Profiles.”

For more information about upgrading Siebel CTI from previous versions, see 
Appendix G, “Upgrading from Version 6.x.”

The basic options for exporting and importing are as follows:

■ Export communications configuration data from the database to a .def file

■ Import communications configuration data into the database from a .def file (or 
from a .ini file exported from a previous release)

For more information about the .def file format, see “Communications .def Files” 
on page 116.

NOTE: Using the Export Configuration and Import Configuration features, you can 
transfer all types of communications configuration data from one configuration to 
another except data for agents (and ACD queues) and telesets (and extensions). 
Driver and profile data could not be exported or imported prior to version 7.0.
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Exporting Communications Configuration Data
Exporting communications configuration data from the database into a file can 
make it easier to review your configuration settings. You may want to do this before 
you put your system into production, or when you consult with Siebel Technical 
Support. Or, you may prefer making communications configuration data 
modifications in text files, and then importing this data.

For instructions on exporting CTI configuration data from a previous version, such 
as version 6.x, refer to Siebel CTI documentation for that version.

To export communications configuration data

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

2 In the Configurations list, select the configuration record for which you want to 
export data.

3 Click Export Configuration, located at the top of the view. 

The Export Configuration dialog box appears. It contains four export options:

■ Configuration Parameters. Exports configuration parameters. This data is 
displayed in the All Configurations view, in the Configuration Parameters list.

■ Commands. Exports commands and command data. This data is displayed in 
the All Commands and All Command Data views.

■ Events. Exports event handlers, event responses, and event logs. This data is 
displayed in the All Event Handlers, All Event Responses, and All Event Logs 
views.

■ Drivers and Profiles. Exports communications drivers and profiles. This data is 
displayed in the Communications Drivers and Profiles view.

4 Click the applicable check boxes named in Step 3 to specify what kinds of data 
to export, then click Next.

The following message is displayed: “Please press OK button to begin exporting. 
The process may take several minutes. Please wait while exporting...”
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5 Click OK.

A File Download window prompts you to open or save this file.

6 Specify whether to open or save the file, then click OK.

■ If you choose to open, the .def file is opened in your default text editor.

■ If you choose to save, you are prompted to choose a location and file name 
to save to. Click Save to export to this destination file.

NOTE: When you export a configuration, the prompted filename has the 
extension .def. However, files when exported may be appended by .def.def.txt, 
.txt, or another extension, depending on your system. 

7 After the export has completed, close the Export Configuration dialog box.

8 Rename the exported file to change the extension to .def.

Importing Communications Configuration Data
Importing communications configuration data from a file into the database can be 
done for several reasons. You can import data previously exported from the same 
software version, or from a previous version (Siebel CTI). You can also use .def files 
to import data that you previously exported from another configuration or another 
database—for example, exporting data from a test database and importing it into 
your production Siebel database.

An import file must contain valid data and use correct .def file notation. The import 
file must be consistent with files exported from the current version of Siebel 
Communications Server, or with previous versions of Siebel CTI. 

As described in “Upgrading Siebel CTI from Version 6.x (and Earlier)” on page 640, 
each configuration file you export from the current version has an entry like this:
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[Siebel]
CommServerVersion = "7.0"

CAUTION: For any communications configuration file you import that does not 
contain an entry as shown above, upgrade steps will be performed on the file. Do 
not manually add such an entry to a configuration file unless the file is known to 
be valid for the current version and should not be upgraded.

For files created in previous versions, the upgrade scenario applies. When importing 
files from previous versions, import the .ini file first, then the .def file.

For more information about the .def file format, see “Communications .def Files” 
on page 116. For more information about upgrades, see Appendix G, “Upgrading 
from Version 6.x.”

CAUTION: When you import communications configuration data, existing data of the 
same type is first deleted from the database, for the current configuration. There is 
no way to cancel an import operation once begun. If you are not sure of the effects 
of importing configuration data, you should either back up the database tables or 
export the old configuration data to .def files before you import the configuration 
data.

To import communications configuration data

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

2 In the Configurations list, create a new configuration record, or select the 
configuration record for which you want to import data.

For information about creating configurations, see “Creating or Modifying a 
Communications Configuration” on page 76.

3 Click Import Configuration, located at the top of the view.

4 Click Next.

The Import Configuration dialog box appears. It contains four import options:
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■ Configuration Parameters. Imports configuration parameters. This data is 
displayed in the All Configurations view, in the Configuration Parameters list.

■ Commands. Imports commands and command data. This data is displayed in 
the All Commands and All Command Data views.

■ Events. Imports event handlers, event responses, and event logs. This data is 
displayed in the All Event Handlers, All Event Responses, and All Event Logs 
views.

■ Drivers and Profiles. Imports communications drivers and profiles. This data is 
displayed in the Communications Drivers and Profiles view.

5 Click the applicable check boxes named in Step 4 to specify what kinds of data 
to import.

6 Enter the name of the source file, or click Browse and select the file.

7 Click OK to import the specified configuration data from the source file.

Wait for the import process to finish, as shown by the imported configuration 
elements displayed in the Siebel application user interface. After the import has 
completed, the Import Configuration dialog box closes.

Communications .def Files
This section describes the sample communications definitions (.def) files that are 
provided by Siebel Systems. The following .def files are provided:

■ multichannelA.def. Contains communications definitions that correspond to the 
communications configuration named Multichannel configuration A. Supports 
Siebel Universal Queuing and the voice (for Siebel CTI Connect) and email 
channels.

■ receptionA.def. Contains communications definitions that correspond to the 
communications configuration named Reception configuration A. Supports the 
voice channel (for Siebel CTI Connect), particularly for the Reception screen. 
Does not support Siebel Universal Queuing or support any channels other than 
voice.
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■ callrouteA.def. Contains communications definitions that support using Siebel 
Universal Queuing to route communications work items of the following 
channels: voice, email.

The sample .def files provided by Siebel Systems are in the following locations:

■ bin\language_code, in the Siebel Server installation directory

■ bin\language_code, in the Siebel Dedicated Web Client installation directory

where language_code represents the language code for the installed software, such 
as ENU for U.S. English.

Siebel Communications Server does not directly use the .def files; they are samples 
only. However, in addition to the sample definitions, these files contain comments 
to help you understand how the communications configuration elements work.

The .def files contain the following types of information:

■ Communications drivers and profiles

■ Configuration parameters

■ Communications commands

■ Communications events

File Format for .def Files
The Siebel Communications Server .def file are text files that employ the file format 
described below:

■ The names in brackets ([ ]) identify elements such as drivers, profiles, 
commands, and events. Each bracketed name is followed by lines containing 
names and values for parameters.

■ Field values are enclosed in double quotation marks (which are not used for this 
data within the Communications Administration screen), and are indicated 
using an equals sign (=), as in the following example line from a 
communications command:

DeviceCommand="MakeCall"
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■ Parameters are used in .def files to represent some elements that, in the current 
version, you would not specify using parameters when you work in the 
Communications Administration screen. For example, the line below, for an 
event handler definition, associates the event handler with an event response:

Response="InboundConsumerCall"

■ Any lines preceded by a semicolon (;) are not in effect and may contain 
explanatory comments.

■ A file exported from version 7.x contains lines like the following, to enable it to 
be handled differently (as an upgrade case) than files exported from previous 
versions. Do not remove these lines from your export files. (Files exported from 
versions subsequent to 7.0 may include an updated version number.)

[Siebel]
CommServerVersion = "7.0"

If you need to manually prepare a file for import, you can export a file of the same 
type containing preconfigured data, then check that your file to be imported uses 
the correct format.

Example Section from .def File
Each .def file includes lines like the ones in the following example, from a 
configuration that supports Siebel CTI Connect.

; --- Handle inbound customer call ---

[EventHandler:InboundConsumerCall]
DeviceEvent = "TpAnswered"
Response = "InboundConsumerCall"
Filter.CollectedDigits = "?*"
Order = "3"

[EventResponse:InboundConsumerCall]
QueryBusObj = "Consumer"
QueryBusComp = "Consumer"
QuerySpec = "[CSN]='{dtmfDigits}'"
SingleView = "Consumer Detail View"
FindDialog = "Consumer"
FindField.CSN = "{dtmfDigits}"
SingleLog = "LogIncomingCallConsumerFound"
Log = "LogIncomingCallConsumerNotFound"
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[EventLog:LogIncomingCallConsumerFound]
Display = "TRUE"
BusObj = "Consumer"
BusComp = "Action"
LogField.Type = "Call - Inbound"
LogField.'Contact Id' = "{Consumer.Id}"
LogField.Description = "Inbound consumer call"
LogField.'Call Id' = "{refId}"
AfterWork.'ACD Call Duration' = "{@WorkDuration}"

[EventLog:LogIncomingCallConsumerNotFound]
BusObj = "Consumer"
BusComp = "Action"
LogField.Type = "Call - Inbound"
LogField.Description = "Unknown Consumer 

CSN({dtmfDigits})"
LogField.'Call Id' = "{refId}"
AfterWork.'ACD Call Duration' = "{@WorkDuration}"
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This chapter explains how to customize the events and commands in your 
communications configuration to serve your business needs.

NOTE: Communications events and commands apply only to communications 
involving interactive drivers that control communications toolbar functionality, 
such as for voice and email channels.

About Events and Commands
You can customize the way Siebel Communications Server operates for functions 
supported by the Communications Session Manager server component:

■ You can customize the way Communications Server handles events received 
from the communications system, such as your CTI middleware.

Examples of events are when an inbound work item such as a voice call or email 
message is routed to an agent, when the agent accepts an inbound work item, 
when an agent completes a conference call, and so on.

■ You can customize commands that are to be sent from Communications Server 
to the external communications system, or that are to invoke some other 
function.

Examples of commands are when an agent accepts an inbound work item, 
initiates an outbound work item, transfers a work item, and so on. 

You can customize event or command definitions—for example, to attach different 
types of data to incoming, outgoing, or transferred communications work items.

For an overview of communications configuration data, see “About 
Communications Configuration Data” on page 34.
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For information about how to use the Communications Administration views to 
modify events and commands, see “Defining Communications Commands” on 
page 106 and “Defining Communications Events” on page 99.

Communications Definition Data in the Database
The Siebel database contains configuration data that helps determine how your 
communications system is integrated with your Siebel application. Among other 
functions, the communications configuration data:

■ Defines how a Siebel application will handle events received from the 
communications system

■ Defines how commands will be generated and sent from the Siebel application 
to the communications system

■ Defines the appearance and availability of commands in the Communications 
submenu in the Siebel application—by specifying hot keys, menu command 
titles, menu item sequence, and so on

NOTE: The events recognized by the communications driver, and the commands 
supported by the driver, are a subset of those supported by the communications 
system, such as your CTI middleware. For the supported driver parameters, events, 
and commands, see Appendix A, “Using Siebel CTI Connect.”

To customize the communications configuration, you must understand your call 
center’s workflow model, as well as the key business objects for your Siebel 
application.

You customize communications features by editing or entering data in a series of 
views in the Communications Administration screen, as described in Appendix F, 
“Views for Communications Administration.”

NOTE: For some examples in this chapter, the label Communications Simulator 
indicates an example that you can try using communications simulation. Use the 
Communications Simulator to test aspects of your configuration before deployment. 
For more information, see “Enabling Session Communications and Simulation” on 
page 311 and “Simulating a Communications Environment” on page 233.
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Communications Data Sets
A communications data set defines the commands, events, and associated data 
passing between the elements of your communications system—such as between 
your CTI middleware and the communications-enabled Siebel application that an 
agent is running. Events and commands have attributes and corresponding data.

Data set attributes can be supplied by:

■ External modules such as call control tables, campaign manager modules, 
predictive dialers, voice response units, call routers, and so on.

■ Siebel features or modules that play a role in supporting inbound 
communications—for example, Siebel CTI Connect, Siebel Universal Queuing, 
Siebel eMail Response, Siebel Business Process Designer, Siebel business service 
methods, and so on.

Each attribute has a name and contains associated data, such as the telephone 
number for the caller or for the caller’s organization.

To see examples of communications data sets, you can view the Siebel 
Communications Server log file for the communications drivers you use, and for 
your external communications systems—for example, ctc.log for Siebel CTI Connect 
(using Intel NetMerge middleware).

Each type of communications event generated has a unique name and an associated 
data set. Each event can be handled individually by the communications system. 
Similarly, commands the Siebel client sends to the communications system can 
accept parameter strings and data sets.

For example, a command to transfer a work item can, along with parameter data 
specifying data such as a phone extension, accept any data set. When transferring 
the work item, the data set might include a service request ID or context 
information for the agent’s current Siebel view.

Communications Server associates the data set with the work item (“attaches data”) 
and sends the data set to the Siebel client of the agent receiving the transferred work 
item. A screen pop may be generated for the receiving agent, causing the current 
Siebel view to be displayed with a relevant record—such as a customer’s current 
service request.
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Event and Command Definitions
This section lists the types of events and commands supported by Siebel 
Communications Server, describes the field types for event and command 
parameters, describes how wildcard characters can be used in parameter values, 
and notes the form in which parameters are defined in events or commands.

While communications configuration parameters and communications drivers and 
profiles control the feature set provided by the communications system, event and 
command definitions control how and when these features are used, how data 
attached to communications work items affects application behavior, and so on. 
Each event or command definition must have a unique name within its type.

Each communications command definition or event definition has a unique name 
within its type, and includes a set of parameters for which values are specified. Each 
type of event or command, and its supported parameters, is described in detail later 
in this chapter.

Event and Command Types
The following types of events and commands are defined in a communications 
configuration.

■ Event. Communications Server supports three types of event definitions:

■ Event handler. Defines how the Siebel client application responds to events in 
the communications system. Specifies a response to execute when an event 
handler matches an event. For details, see “Event Handlers” on page 146.

■ Event response. Determines a specific response to an event that matched the 
event handler that invokes the response. For details, see “Event Responses” 
on page 154.

■ Event log. Defines Siebel log-generation rules for communications events. For 
instance, events may be logged as activities (Action business component) or 
logged as another type of record. For details, see “Event Logs” on page 168.

■ Command. Defines communications commands that can be invoked in the Siebel 
application and specifies how they are to appear in the application. For details, 
see “Commands” on page 172.
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■ Command data. Defines data associated with a communications command that is 
invoked. For details, see “Command Data” on page 186.

Event and Command Parameters
This section provides general information about parameters you can define for your 
event and command definitions.

Field Types for Event and Command Parameters
Parameters for each type of event or command use one of the following field types:

■ Characters (letters, numerals, _ (underscore), and special characters used in 
macro-expansion)

Macro expansion can be used in fields of character type, as described in the 
section “Using Macro Expansion for Character Fields” on page 195. You can use 
the macros described in the section “Macros for Parameter Values” on page 196.

■ Boolean (allowable values are TRUE and FALSE)

■ Numeric (numerals 0–9)

Forms of Event and Command Parameters
Parameters of character type can be one of the following forms:

■ Single parameter

The parameter must be unique within the definition.

■ Multi-value

The parameter name does not need to be unique within the definition. Multiple 
instances of a multi-value parameter can be defined; each instance would have 
a different value.

■ Group of subparameters

The parameter name must be unique within the definition, but multiple 
instances of the parameter can be defined, each specifying a unique 
subparameter. For instance, if you have parameters called Filter.A and Filter.B, 
A and B are subparameters of the group parameter Filter.
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Table 5 illustrates the usage of parameters of the three forms of character fields. 
Parameters must be specified in a form similar to what is shown.

Wildcard Characters in Event and Command Parameters
The wildcard characters * (matching zero or more characters) and ? (matching 
exactly one character) can be used within communications event or command 
parameter values of character type.

Use the wildcard characters to perform pattern matching on communications event 
data field values or on Siebel database field values. Such matching can help 
determine which event or command is to be invoked. 

You can use ?* to match field values when the corresponding field value must not 
be empty. Separately, ? matches exactly one character, while * matches zero or more 
characters. The combination of these wildcard characters matches one or more 
characters.

NOTE: The characters * and ? do not function as wildcards for event or command 
parameters that pass parameters to a Siebel business service, a Siebel SmartScript, 
or a Siebel VB or Siebel eScript script.

Table 5. Event and Command Parameter Forms

Parameter Name Parameter Value

SingleParam Value

MultiValueParam Value1

MultiValueParam Value2

GroupParam.SubParam1 Value

GroupParam.SubParam2 Value
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Special Events for Device Events
This section describes special events, which are available for any communications 
configuration and are independent of the communications driver. Special events can 
be specified as device events in event handlers. 

For more information about device events, see “Defining Communications Events” 
on page 99 and see the description for the DeviceEvent parameter in “Event Handler 
Parameters” on page 148.

For more information about defining event handlers, see “Event Handlers” on 
page 146.

The special events are not received from the communications system, such as CTI 
middleware, as are many other communications events for which a device event is 
specified.

NOTE: Special events are primarily used for defining event handlers in your 
communications configuration. However, you can also invoke them from scripts 
written using Siebel VB or Siebel eScript.

When using special events, you use WorkItemID, instead of SiebelWorkItemID, to 
refer to work item attributes. For example, you might define an event handler as 
follows:

[EventHandler:OnWorkItemStarted]
DeviceEvent = "@PreWorkItemStartedEvent"
FilterSpec = "[$GetWorkItemAttr(WorkItemID, ANI)] IS NOT NULL"

Many of the special events correspond to client handle methods, and include work 
item attributes. For more information, see “Work Item Attributes” on page 208. For 
more information about the client handle methods, see “Methods of 
ISC_CLIENT_HANDLE” on page 582.

Special Event Attributes
Many of the special events shown in Table 6 on page 129 have some or all of the 
following attributes:
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■ ChannelType. The language-independent value representing the channel type of 
this work item.

■ ProfileName. The communications driver profile for which this work item is 
applicable.

■ WorkItemID. The ID number of this work item.

■ WorkItemMode. The mode of this work item, where 1 represents an inbound 
work item and 2 represents an outbound work item.
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List of Special Events
The special events, which have names that start with the symbol @, are described 
in Table 6.

Table 6. Special Events

Event Name Description

@HandleNonRealtimeWorkItem An event representing a nonreal-time work item received by an agent 
from Siebel Universal Queuing.

No communications channel is associated with such a work item, 
which may represent something like a service request that has been 
assigned to the agent. Administrators may want to configure the 
communications configuration to respond to such work items in 
certain ways.

Following are an event handler that specifies this type of event as the 
device event, and an event response that is in turn invoked:

[EventHandler:HandleNonRealTimeWorkItem]
DeviceEvent="@HandleNonRealTimeWorkItem"
Response="HandleNonRealTimeWorkItem"
Order="50"

[EventResponse:HandleNonRealTimeWorkItem]
QueryBusObj="Service Request"
QueryBusComp="Service Request"
QuerySpec="[Id]='{SRID}'"
SingleField.'Owned By Id'="{@UserId}"

The event response in this example sets the value of the "Owned By 
Id" field for the service request record to the ID of the assigned agent.

For more information about nonreal-time work items, refer to Siebel 
Universal Queuing Administration Guide.

@PreIndicateNewWorkItemEvent

@PostIndicateNewWorkItemEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method IndicateNewWorkItem is invoked. 
These special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

■ WorkItemMode
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@PreWorkItemReleasedEvent

@PostWorkItemReleasedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemReleased is invoked. These 
special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

@PreWorkItemResumedEvent

@PostWorkItemResumedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemResumed is invoked. These 
special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

@PreWorkItemStartedEvent

@PostWorkItemStartedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemStarted is invoked. These 
special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

@PreWorkItemSuspendedEvent

@PostWorkItemSuspendedEvent

Respectively, these special events correspond to when the client 
handle method WorkItemSuspended is invoked. These special events 
have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

Table 6. Special Events

Event Name Description
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Special Commands for Device Commands
This section describes special commands, which are available for any 
communications configuration and are independent of the communications driver. 
Special commands can be specified as device commands in commands. 

For more information about device commands, see “Defining Communications 
Commands” on page 106 and see the description for the DeviceCommand 
parameter in “Command Parameters” on page 174.

For more information about defining commands, see “Commands” on page 172.

@RuntimeEvent Corresponds to a Siebel runtime event, which was defined in the 
Runtime Events Administration screen. This special event has the 
following attributes:

■ Context – The business service context.

■ ActionSet – The name of the action set.

■ Action – The name of the action.

■ EventId – The ID of the runtime event.

■ Event Name – The name of the runtime event (for example, 
“SetFieldvalue”).

■ Sub Event – The name of the subevent.

■ Event Type – The event type specified in the “Object Type” field.

■ Object Name – The object name.

■ BusObjName – The business object name.

■ BusCompName – The business component name.

■ ActiveRowID – The current active row ID of the business 
component.

■ ViewName – The current view name.

For more information about configuring runtime events, refer to 
Personalization Administration Guide.

Table 6. Special Events

Event Name Description
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The communications driver does not receive these commands and so does not pass 
them to a system such as CTI middleware, as with many other device commands 
you specify. Some special commands may, however, require another module such 
as Siebel Universal Queuing.

NOTE: Special commands are primarily used for defining commands in your 
communications configuration. However, you can also invoke them from scripts 
written using Siebel VB or Siebel eScript.

Each special command allows attachment of any user-defined key/value pair to the 
work item. Within the communications configuration, these key/value pairs are 
represented by event or command parameters and the associated parameter values.

Commands in which special commands are specified as device commands support 
the event and command parameters documented in Chapter 4, “Configuring Events 
and Commands.” In your command definitions, you can specify custom 
subparameters for command parameters of type Group.

The special commands starting with “@UQ” are applicable only to Siebel 
implementations using Siebel Universal Queuing. These special commands invoke 
methods of business services for Siebel Universal Queuing. Command examples can 
be found in the sample configurations provided by Siebel Systems. For information 
about Siebel Universal Queuing business services, refer to Siebel Universal Queuing 
Administration Guide.

List of Special Commands
The special commands, which have names that start with the symbol @, are 
described in Table 7 on page 133.
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An asterisk (*) before a parameter name means that the parameter is optional for 
this command. Command parameters are described in Table 8 on page 144.

Table 7. Special Commands

Command Name Parameters Description

@Associate bus_comp_field Updates a work item’s tracking object. This object is 
specified using the event logging feature and the 
AfterWork event log parameter.

Note: In order for a command to be enabled that is 
based on the @Associate special command, all 
applicable event log definitions must include the 
AfterWork parameter, defined as follows:

AfterWork.'ACD Call Duration'="{@WorkDuration}"

For more information about the AfterWork parameter, 
see “Event Logs” on page 168.

To associate the tracking object to an account record, 
for example, the associated command data definition 
would include parameters like these, to specify the 
business component and field:

BusComp ="Account"
Param."Account Id"="{Id}"

Parameter names enclosed in single or double quotes, 
as shown for Param."Account Id" above, are 
interpreted as field names. Values for such a 
parameter—enclosed in quotes on the right—are 
interpreted as field values, for which macro-expansion 
is supported.

(The quotes enclosing the parameter values in this 
example are not part of the parameter values.)

The @Associate command always operates on the 
selected work item. This is the work item that has the 
current focus—which an agent has selected from the 
Work Items list in the communications toolbar.

For more information about event logging, see “Event 
Logs” on page 168.
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@CreatePopupFrame *AppletMode

*Dimension

*PageURL

Causes the browser to display a window in which to 
display content. 

The browser window content can be filled in as 
appropriate for a specified URL, based on what you 
specify for the PageURL parameter. Or, it can display an 
applet.

For example, a command definition using 
@CreatePopupFrame as the device command could 
have an associated command data definition that 
provides a URL to be displayed in the window—for 
example:

Param.PageURL="http://www.siebel.com"

The URL can also be specified without the prefix 
“http://”, if the URL begins with “www.”.

A third-party company integrating with Siebel 
applications can use this method to open a new 
browser window and connect to its own Web server for 
integration purposes.

In order to display an applet, the command data for a 
command using @CreatePopupFrame should include 
the following parameters:

Param.AppletMode="mode_name"
SelectParam="TRUE"
SelectApplet="applet_name"

where mode_name is either Edit or Base (use Edit for 
form applets and Base for list applets), and 
applet_name is the applet name in Siebel Tools. Base is 
the default value for AppletMode.

The browser window dimensions can be specified 
using the Dimension parameter. For example, the 
following parameter creates a window with 
dimensions 500 x 300 pixels:

Param.Dimension="500x300"

If the Dimension parameter is not defined, the 
dimensions are determined by the applet specified 
using SelectApplet, or by the browser.

Table 7. Special Commands

Command Name Parameters Description
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@InvokeSWECommand SWECommand Invokes a command on the Siebel Web Engine (SWE). 
The SWE command is specified using the 
SWECommand parameter.

For example, for the command SendFaxGroup, which 
uses @InvokeSWECommand as the device command, 
this command data parameter is defined:

Param.SWECommand="Send Fax (SWE)"

All of the Send commands (Send Email, Send Fax, Send 
Wireless Message, and Send Page) are invoked using 
@InvokeSWECommand.

@OpenView View Navigates the Siebel application to the specified view.

In the command data definition, specify the view name 
as defined in Siebel Tools—for example:

Param.View="Service Contact Detail View"

@UpdateRecord bus_comp_field Updates a database record for the current business 
component. For example, if the current view is based 
on the Service Request business component, you can 
change a status-related field for this business 
component.

In the command data definition, specify parameters 
based on what business component field to update and 
what values the field supports. For example:

BusComp="Service Request"

Param.'Status'="Pending"

@UQAbortWorkItem WorkItemID Notifies Siebel Universal Queuing that the work item 
that was assigned to the agent has been aborted.

For example, for a routed voice call, if a calling 
customer hangs up before the agent answers, this 
command can be used to notify Siebel Universal 
Queuing of the outcome.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

Table 7. Special Commands

Command Name Parameters Description
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@UQAcceptWorkItem WorkItemID Notifies Siebel Universal Queuing that the agent has 
accepted the work item that was assigned to the agent.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQAddWorkItem MediaType

WorkItemID

*workitem_attr1

*workitem_attr2...

Requests Siebel Universal Queuing to create a new 
work item, typically a nonreal-time work item such as 
a service request.

In the command data definition, you can specify the 
MediaType parameter as follows, for example:

Param.MediaType="Service Request"

The language-independent strings that you use to 
represent the channel in the value for MediaType are 
from the List of Values type COMM_MEDIA_TYPE 
(where Parent LIC is set to “UQ”). Default channels 
include “Activity” and “Service Request”.

In the command data definition, specify the 
WorkItemID parameter. For example:

Param.WorkItemID="{Id}"

Additional work item attributes can be specified by the 
administrator to be passed to Siebel Universal 
Queuing. For example, define parameters like this:

Param.MyWorkItemAttr1="{MyField1}"

Param.MyWorkItemAttr2="{MyField2}"

Table 7. Special Commands

Command Name Parameters Description
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@UQAgentAvailable *MediaType Notifies Siebel Universal Queuing that the agent is 
available for any or all supported channels.

■ When specified without the MediaType parameter, 
notifies Siebel Universal Queuing that the agent is 
available for all channels.

■ When specified with MediaType, notifies Siebel 
Universal Queuing that the agent is available for 
the channel specified using the MediaType 
parameter.

The language-independent strings that you use to 
represent the channel in the value for MediaType are 
from the List of Values type COMM_MEDIA_TYPE 
(where Parent LIC is set to “COMMON”). Default 
channels include Email and Voice.

In the command data definition, you can specify the 
MediaType parameter as follows, for example:

Param.MediaType="Email"

Table 7. Special Commands

Command Name Parameters Description
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@UQAgentChange
ReadyState

*Reason Toggles the Ready/Not Ready state for a specified 
channel. Optionally, a business component field can be 
specified from which a reason code is obtained at 
runtime.

This special command must be specified with an 
attribute value representing a communications 
channel, as follows:

@UQAgentChangeReadyState(channel)

The language-independent strings that you use to 
represent the channel are from the List of Values type 
COMM_MEDIA_TYPE (where Parent LIC is set to 
“COMMON”). Default channels include Email and 
Voice.

The channels you can specify are those for the drivers 
whose profiles are associated with the communications 
configuration for the agent.

In the command data definition, you can specify the 
Reason parameter as follows:

Param.Reason="[reason_code]"

where reason_code represents a business component 
field.

Table 7. Special Commands

Command Name Parameters Description
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@UQAgentInitAuxWork *MediaType

*Reason

Notifies Siebel Universal Queuing that the agent is 
unavailable for any or all supported channels, in order 
to perform auxiliary work. Optionally, a business 
component field can be specified from which a reason 
code is obtained at runtime.

■ When specified without the MediaType parameter, 
notifies Siebel Universal Queuing that the agent is 
unavailable for all channels.

■ When specified with MediaType, notifies Siebel 
Universal Queuing that the agent is unavailable for 
the channel specified using the MediaType 
parameter.

The language-independent strings that you use to 
represent the channel in the value for MediaType are 
from the List of Values type COMM_MEDIA_TYPE 
(where Parent LIC is set to “COMMON”). Default 
channels include Email and Voice.

In the command data definition, you can specify the 
parameters as follows, for example:

Param.MediaType="Email"

Param.Reason="[reason_code]"

where reason_code represents a business component 
field.

@UQAgentLogon Logs the agent into Siebel Universal Queuing.

@UQAgentLogout Logs the agent out of Siebel Universal Queuing.

@UQAgentSignOnOff Toggles the login/logout state of the agent for Siebel 
Universal Queuing.

You can use this command to configure a toolbar 
button that will toggle the agent’s login/logout state.

Internally, this command invokes either 
@UQAgentLogin or @UQAgentLogout, according to 
whether the agent is currently logged off or logged on, 
respectively.

Table 7. Special Commands

Command Name Parameters Description
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@UQBlindTransfer
WorkItemToAgent

AgentLogin

WorkItemID

Performs a blind transfer of the current work item to 
another agent.

In the command definition, the FilterSpec parameter 
could be used as follows, to make sure a command is 
only activated for a particular channel, such as email:

FilterSpec="[@SelectedWorkItem:ChannelType]=
'Email'"

In the command data definition, specify the 
AgentLogin and WorkItemID parameters as follows:

Param.AgentLogin="{Login Name}"

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQBlockAgentChannel AgentLogin

MediaType

Blocks a particular inbound communications channel 
for an agent. This special command supports the 
sequential assignment feature for Siebel Universal 
Queuing.

@UQCancelTransfer WorkItemID Cancels the transfer of a work item through Siebel 
Universal Queuing.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQChangeAgent
MediaMode

AgentMediaMode

MediaType

Notifies Siebel Universal Queuing about the agent’s 
availability and work mode.

The language-independent strings that you use to 
represent the channel in the value for MediaType are 
from the List of Values type COMM_MEDIA_TYPE 
(where Parent LIC is set to “COMMON”). Default 
channels include Email and Voice.

In the command data definition, you can specify the 
parameters as follows, for example:

Param.MediaType="Email"

Param.AgentMediaMode="N"

where N is either 1 or 2. These values are defined for 
the ChangeAgentMediaMode business service method 
for Siebel Universal Queuing.

Table 7. Special Commands

Command Name Parameters Description
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@UQCompleteTransfer WorkItemID Completes the transfer of a work item through Siebel 
Universal Queuing.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQCompleteWorkItem WorkItemID Notifies Siebel Universal Queuing that the agent has 
completed the assigned work item.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQHoldWorkItem WorkItemID Notifies Siebel Universal Queuing that the agent has 
suspended the assigned work item.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQInitTransfer AgentLogin

WorkItemID

Initiates a transfer of a work item through Siebel 
Universal Queuing.

In the command data definition, specify the parameters 
as follows:

Param.AgentLogin="{Login Name}"

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQRejectWorkItem WorkItemID Notifies Siebel Universal Queuing that the agent has 
rejected the assigned work item.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{$GetInboundWorkItemAttr
(channel, UQWorkItemID)}"

where channel represents the channel type for the 
work item.

Table 7. Special Commands

Command Name Parameters Description
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@UQTransfer AgentLogin

TransferCmd

WorkItemID

Transfers a work item in two steps, through Siebel 
Universal Queuing.

This command invokes @UQInitTransfer, then invokes 
a specified transfer command, then invokes either 
@UQCompleteTransfer or @UQCancelTransfer.

For example, if the command in which @UQTransfer is 
specified matches based on channel type (such as 
email), then a specified transfer command for that 
channel can be invoked.

■ If the specified transfer command is successful, 
then @UQCompleteTransfer is invoked and the 
work item is transferred.

■ If the specified transfer command is not successful, 
then @UQCancelTransfer is invoked, and the work 
item is returned to the original agent.

In the command data definition, specify parameters as 
follows:

Param.AgentLogin="{Login Name}"

Param.TransferCmd="command_name"

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@UQTransferWorkItem
ToRoute

RouteID

WorkItemID

Transfers a work item to a route in Siebel Universal 
Queuing.

In the command data definition, specify parameters as 
follows:

Param.RouteID="[route_name]"

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

For information about values you can specify for 
RouteID, refer to Siebel Universal Queuing 
Administration Guide.

@UQUnBlockAgentChannel AgentLogin

MediaType

Unblocks (makes available) a particular inbound 
communications channel for an agent. This special 
command supports the sequential assignment feature 
for Siebel Universal Queuing.

Table 7. Special Commands

Command Name Parameters Description
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@UQUnHoldWorkItem WorkItemID Notifies Siebel Universal Queuing that the agent has 
resumed the assigned work item.

In the command data definition, specify the 
WorkItemID parameter as follows:

Param.WorkItemID="{@SelectedWorkItem:
UQWorkItemID}"

@ViewWorkObject View Views a work-tracking object for a work item. 
Navigates to the view, such as a view in the Activities 
screen, where you can view the tracking object’s 
record.

Note: In order for a command to be enabled that is 
based on the @ViewWorkObject special command, all 
applicable event log definitions must include the 
AfterWork parameter, defined as follows:

AfterWork.'ACD Call Duration'="{@WorkDuration}"

For more information about the AfterWork parameter, 
see “Event Logs” on page 168.

A command data parameter with the name 
Param.View must exist and must contain the name of 
the view in which to view the tracking object. For 
example, if the tracking object is Action (for activities), 
then this record can be found in the view specified as 
follows:

Param.View="Activity Attachment View"

The @ViewWorkObject command always operates on 
the selected work item. This is the work item that has 
the current focus—which an agent has selected from 
the Work Items list in the communications toolbar.

Note: The work-item duration is updated for the work-
tracking object (such as an activity record) when a 
work item is released. This update may conflict with 
changes made by the agent. Consequently, an agent 
who is viewing a work-tracking record must save any 
changes before releasing the work item. In order to 
make changes after releasing the work item, the agent 
must first refresh the record.

Table 7. Special Commands

Command Name Parameters Description
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Special Command Parameters
Table 8 lists special command parameters and their usage. Table 7 on page 133 
identifies the commands that use each of these parameters.

Within the communications configuration, special command parameters and values 
can be specified within command data definitions as subparameters of the Param 
parameter. For more information, see “Command Data” on page 186.

Table 8. Parameters for Special Commands

Command Parameter Description

AgentLogin For @UQBlindTransferWorkItemToAgent, @UQBlockAgentChannel, 
@UQInitTransfer, @UQTransfer, or @UQUnBlockAgentChannel, specifies the login 
name of an agent to whom a work item is routed or transferred through Siebel 
Universal Queuing.

AgentMediaMode For @UQChangeAgentMediaMode, specifies the media mode for an agent.

AppletMode For @CreatePopupFrame, specifies the mode for an applet to be displayed in the new 
browser window.

Dimension For @CreatePopupFrame, specifies the dimension of the new browser window.

MediaType For @UQAddWorkItem, @UQAgentAvailable, @UQAgentInitAuxWork, 
@UQBlockAgentChannel, @UQChangeAgentMediaMode, or 
@UQUnBlockAgentChannel, specifies the channel (media) type, such as the channel 
for which an agent changes availability.

PageURL For @CreatePopupFrame, specifies a URL to be displayed in the new browser window.

Reason For @UQAgentChangeReadyState or @UQAgentInitAuxWork, specifies a business 
component field from which a reason code is obtained. The agent chooses the reason 
code when changing availability for any or all channels.

RouteID For @UQTransferWorkItemToRoute, specifies the name of a route defined for Siebel 
Universal Queuing.

SWECommand For @InvokeSWECommand, specifies a Siebel Web Engine (SWE) command to be 
invoked.

TransferCmd For @UQTransfer, specifies the name of a transfer command in the communications 
configuration that is to be invoked.
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Special Command Examples
This section describes examples of special commands.

@Associate Special Command Example
Table 9 and Table 10 provide an example command using the @Associate special 
command.

This example defines a command and associated command data that creates an 
association between the current activity object and the current account object. The 
example command is enabled only when the agent is working with accounts and 
when a work-item tracking object exists. For more information, see the description 
for @Associate in Table 7 on page 133.

View For @ViewWorkObject, specifies the name of a view.

WorkItemID For several special commands (relating to Siebel Universal Queuing), specifies the ID 
for a work item upon which the command operates. The value should be set as 
appropriate for the command.

Table 8. Parameters for Special Commands

Command Parameter Description

Table 9. Command: AssociateAccount

Parameter Name Parameter Value

DeviceCommand @Associate

Hidden TRUE

Table 10. Command Data: AssociateAccount

Parameter Name Parameter Value

BusComp Account

Param."Account Id" {Id}
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@ViewWorkObject Special Command Example
Table 11 and Table 12 provide an example command using the @ViewWorkObject 
special command.

This example defines a command and associated command data that allows a user 
to view the work-item tracking record. The command specifies the menu item to be 
used for viewing the record, and assigns the command to the hot key SHIFT+F8. 
The command is enabled only when a work-item tracking object exists. For more 
information, see the description for @ViewWorkObject in Table 7 on page 133.

Event Handlers
Communications events from the communications system are directly passed to 
Siebel Communications Server, in particular the Communications Session Manager, 
for further processing.

Event Handler Process Overview
Communications events involve the following phases of activity:

Table 11. Command: ViewWorkObject

Parameter Name Parameter Value

DeviceCommand @ViewWorkObject

HotKey SHIFT+F8

MenuPosition 8

Title View Work Item Object

Table 12. Command Data: ViewWorkObject

Parameter Name Parameter Value

Param.View Activity Attachment View
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1 An event or action, such as a phone call being disconnected, occurs in the 
communications system, such as a telephony switch. The switch forwards 
events to a communications middleware server, such as a CTI middleware 
server.

2 The middleware server, such as CTI middleware, forwards the event to the 
Communications Client business service.

3 The Communications Client business service processes the event and executes 
any actions defined in the configuration data in the database, or forwards events 
to business service methods or to Siebel VB or Siebel eScript code.

By working with event data in the Communications Administration screen, you 
can define the actions to be performed when a particular communications event 
is received. Such actions are invoked immediately upon receipt of such an event.

Event handlers specify what kind of event from the communications system will 
be processed, and specify which event response should be called as a result.
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Event Handler Parameters
Table 13 describes the parameters available in event handlers in the 
communications configuration data. A dash (—) in the Macro column indicates that 
macro expansion is not applicable for the parameter. Y indicates that macro 
expansion applies to the parameter.

Table 13. Event Handler Parameters

Parameter Type Macro Description

DeviceEvent Char — Communications device-generated event name.

For possible values, see the events table for the relevant driver in 
Appendix A, “Using Siebel CTI Connect.”

Note: This parameter should not be specified as an event handler 
parameter. Rather, the device event for the event handler should be 
specified directly, using the Communications Administration 
screen. This parameter is used in .def files that you export to or 
import from.

Filter Group — Event data-field filter.

This works like a standard IsLike() function. All filter results are 
logically joined by AND to determine if the event matches this 
event handler.

You can filter data received from the communications driver, data 
attached to the work item by the channel manager, or data 
attached or modified by an agent who previously handled the work 
item—such as a transferring agent.

The Filter and FilterSpec parameters can be used together to 
evaluate event data-field data received with the device event 
associated with this event handler. Evaluations using the Filter 
parameter (AND conditions) occur before evaluations using the 
FilterSpec parameter (compound predicate).

For information on fields available for filtering, see the event data 
fields table for the relevant driver in Appendix A, “Using Siebel 
CTI Connect.”
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FilterSpec Char Y Event data-field filter that supports simple or complex queries.

Filter results are evaluated using a compound predicate that can 
include standard query operators to determine if the event handler 
matches the event.

FilterSpec queries use standard comparison operators, including:

=
LIKE
AND
OR
EXISTS
>
<
>=
<=

For example:

FilterSpec="[attr1] IS NOT NULL OR [attr2] LIKE 'value*'"

where attr1 and attr2 are event data fields and value represents 
part of a comparison value for attr2. In this example, the event 
handler is evaluated for a match if attr1 is not empty or if attr2 is 
like the value of “value*”.

Here is another example:

FilterSpec="[@UserName]='SADMIN'"

In this example, @UserName is macro-expanded before the query 
is performed.

The Filter and FilterSpec parameters can be used together to 
evaluate event data-field data received with the device event 
associated with this event handler. Evaluations using the Filter 
parameter (AND conditions) occur before evaluations using the 
FilterSpec parameter (compound predicate).

See also the descriptions for the Filter event handler parameter and 
the QuerySpec event response parameter.

Table 13. Event Handler Parameters

Parameter Type Macro Description
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Order Numeric — The order in which event handlers for which the same device event 
is specified will be tested against event matching.

Each received communications event is checked against all event 
handlers to determine which response to execute. Event handlers 
with a lower Order value will be checked before those with higher 
values. The default is 0. The check stops once there is a match.

Note: This parameter should not be specified as an event handler 
parameter. Rather, the order for the event handler should be 
specified directly, using the Communications Administration 
screen. This parameter is used in .def files that you export to or 
import from.

Profile Char — Name of the communications driver profile that generates the 
device event associated with this event handler.

If a profile is associated with the event handler, then the event 
handler is evaluated only for events received from the 
communications driver for that profile. See also “Creating Event 
Handlers” on page 103.

Note: This parameter should not be specified as an event handler 
parameter. Rather, the profile for the event handler should be 
specified directly, using the Communications Administration 
screen. This parameter is used in .def files that you export to or 
import from.

Response Char — Name of the event response that will be executed when a matching 
event is detected.

Note: This parameter should not be specified as an event handler 
parameter. Rather, the event response for the event handler should 
be specified directly, using the Communications Administration 
screen. This parameter is used in .def files that you export to or 
import from.

Table 13. Event Handler Parameters

Parameter Type Macro Description
150 Siebel Communications Server Administration Guide Version 7.5.3



Configuring Events and Commands

Event Handlers
ServiceMethod Char — The name of a Siebel business service and method to be called in 
order to evaluate the event handler for a match.

You can use the ServiceMethod and ServiceParam parameters to 
supplement or replace filter mechanisms using the Filter or 
FilterSpec parameters. You can also use this method to execute 
custom code before executing a specified event response.

The business method should set a parameter of Result to a value 1 
or 0 (or TRUE or FALSE):

■ 1 (TRUE) indicates that this event handler matches and should 
be executed, and the associated event response should be 
executed.

■ 0 (FALSE) invalidates this event handler; the next event 
handler will then be evaluated.

The service and method are specified in the form service.method. 

Optionally, you can use the ServiceParam parameter to provide 
parameter names and values to pass to the method to be called.

For more information, see “Using Business Services with 
Communications Server” on page 238.

ServiceParam Group Y A group of subparameters that are parameters to the Siebel 
business service method (if any) invoked using the ServiceMethod 
parameter.

You create each parameter you need in the form 
ServiceParam.param_name, then specify a parameter value. The 
parameter name and value are both passed to the service method. 
Parameters should be ordered in the sequence in which they are 
expected by the service method.

ServiceParam.Param1="value1"
ServiceParam.Param2="name"

Param1 and Param2 are subparameters of the ServiceParam 
parameter.

For more information, see “Using Business Services with 
Communications Server” on page 238.

Table 13. Event Handler Parameters

Parameter Type Macro Description
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Handling an Inbound Call Received by an Agent
Communications events provide the following general options for handling device 
events for calls received by an agent. Such an inbound call may employ events like 
call incoming or event ringing, or call connected or event established, as defined for 
a communications system employing CTI.

■ Handle when call connected after agent answers (default). In this scenario, the agent 
answers the call, triggering the event handler.

The phone rings. The agent clicks Accept Work Item. The call connected or event 
established type of event is received. This event triggers handling such as to 
perform a query to generate a screen pop.

In this case, an agent’s work is not interrupted by an unexpected screen pop. An 
example follows. 

This scenario uses the TpAnswered device event for the Dialogic CTI driver (for 
Siebel CTI Connect).

■ Handle when agent answers (for Dialogic CTI). In this scenario, the agent answers 
the call, triggering the event handler (before the TpAnswered event is received).

The phone rings. The agent clicks Accept Work Item. The EventAnswerCall 
device event (for Dialogic CTI driver) is triggered when the AnswerCall 
command is invoked. This event triggers handling such as to perform a query to 
generate a screen pop. Then the call is connected, as described for the previous 
scenario.

In this case, an agent’s work is not interrupted by an unexpected screen pop.

This scenario uses the EventAnswerCall device event for the Dialogic CTI driver 
(for Siebel CTI Connect).

For more information, see “Using Device Event to Enhance Screen Pop 
Performance” on page 229.
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■ Handle immediately, when phone rings. In this scenario, the phone rings, triggering 
the event handler (before the agent answers the call).

The phone rings. The call incoming or event ringing type of event is received. 
The event triggers handling such as to perform a query to generate a screen pop. 
The agent clicks Accept Work Item, then the connection is established.

In this case, an agent’s work could be interrupted by a screen pop when the 
phone rings, without any notifications or confirmations.

This scenario uses the InboundCall device event for the Dialogic CTI driver (for 
Siebel CTI Connect).

The Siebel sample communications configurations provide examples of some of 
these scenarios. You can implement other screen-pop behavior using Siebel VB or 
Siebel eScript.

Example of Using Event Handler to Handle Inbound Call
Here is an example event handler, named InboundCallReceived, that is based on the 
default inbound call screen-pop scenario described above (handle when call is 
connected after agent answers). For this event handler:

■ Set the Order field to 0 to make sure it takes priority over any other event 
handlers that may otherwise match.

■ Set the Device Event field to one of the following:

■ TpAnswered (for Dialogic CTI driver)

■ event_name (for another Adaptive Communications driver, where 
event_name corresponds to an event like TpAnswered)

■ Include the following event handler parameter:

Filter.ANI="*"

The example event handler would be associated with an event response 
OnInboundCallReceived.
Version 7.5.3 Siebel Communications Server Administration Guide 153



Configuring Events and Commands

Event Responses
Because the Order field is set to 0, this event handler will be checked first for any 
event received where the device event is as specified. The event handler filters the 
event data field ANI. If this field exists, the event matches and invokes the event 
response OnInboundCallReceived.

To handle the call incoming or event ringing type of event without waiting for the 
agent to click Accept Work Item, you can create a similar event handler specifying 
the InboundCall device event for the Dialogic CTI driver (for Siebel CTI Connect). 
You might name such an event handler ImmediateRingingHandler, and invoke a 
similarly named response.

Event Responses
Event responses in the communications configuration data specify how the Siebel 
client will associate response actions with an event. Each event handler specifies a 
response that corresponds to an event response. The same event response can be 
initiated by different event handlers.

Event Response Process Overview
In executing the event response, Siebel Communications Server performs the 
actions described below. For more information about the parameters mentioned 
here, see Table 14 on page 157.

1 If a Siebel business service method name is specified, such as to update the 
customer dashboard, that method is invoked.

If the method does not return the required result, such as a value of TRUE (1) 
for the output argument Continue, the response will stop executing. If an event 
log of type Log is specified, that event log is processed. Go to Step 13 on 
page 156.

The business service method can also alter the event data fields that were 
associated with the work item, such as to add new fields.
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2 If a Siebel VB or Siebel eScript script name is specified, that script is invoked.

If the script does not return the required result, such as Continue, the response 
will stop executing. If an event log of type Log is specified, that event log is 
processed. Go to Step 13 on page 156.

For more information about invoking a Siebel VB or Siebel eScript script from an 
event response, see “Integrating with Siebel Scripting Languages” on page 247 
and see the descriptions for the Script and ScriptParam parameters in Table 14 
on page 157.

3 If a communications command is specified, the command is executed.

4 If the UseCtxData parameter is defined and set to TRUE, Communications Server 
checks to determine if the event has screen context data attached.

If screen context data is available, the corresponding screen and view are 
displayed. This behavior is applicable only for screen pops and screen transfers. 

If an event log of type ContextLog is specified, that event log is processed. If 
ContextLog is not specified, but an event log of type Log is specified, that event 
log is processed. Go to Step 13 on page 156.

5 If the QueryBusObj, QueryBusComp, and QuerySpec parameters are defined, 
then the query specified by QuerySpec is macro-expanded and executed. If these 
parameters are not defined, go to Step 9; otherwise, go to Step 6.

Step 7 and Step 8 define the views upon which this query will be displayed.

6 If there is only one row in the query result from QuerySpec, and if the 
QueryBusComp2 and QuerySpec2 parameters are defined, then the query 
specified by QuerySpec2 is macro-expanded and executed. If these parameters 
are not defined, go to Step 9; otherwise, go to Step 7.

7 If there is only one row in the query result from QuerySpec, then that row is 
displayed in the view specified by the SingleView parameter. Any field specified 
by SingleField is populated with data defined in the parameter value. Go to 
Step 9.

8 If there are several rows in the query result from QuerySpec, then those rows are 
displayed in the view specified by the MultiView parameter. Go to Step 9.
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9 If the OpenView parameter is specified, then the view is displayed that is 
specified by OpenView. Go to Step 10.

10 If the AddBusComp, AddBusObj, AddRecordView, AddRecordApplet, and 
AddField parameters are defined, then the view is displayed that is specified by 
AddRecordView.

A new record is created in the applet specified by AddRecordApplet. Any field 
specified by AddField is populated with data defined in the parameter value. The 
record is not committed. Go to Step 13 on page 156.

11 If a Siebel SmartScript script name or other data is specified to be passed to 
Siebel SmartScript, that SmartScript is invoked.

For more information about invoking a SmartScript from an event response, see 
“Integrating with Siebel SmartScript” on page 254 and see the description for the 
SmartScript parameter in Table 14 on page 157.

12 If the FindDialog and FindField parameters are defined, the Search Center 
appears, populated with search criteria, and the search is executed.

13 If an event log is associated with this event response, then a log record is created 
using the object defined in the event log—for example, an activity record.

Multiple event logs can be associated, one of which matches, depending on how 
the event response executed. For example:

■ If UseCtxData is invoked, as in Step 4 on page 155, a ContextLog log can be 
created.

■ If SingleView is invoked, as in Step 7 on page 155, a SingleLog log can be 
created.

■ If MultiView is invoked, as in Step 8 on page 155, a MultiLog log can be 
created.

■ If AddBusComp, AddBusObj, AddRecordView, AddRecordApplet, and 
AddField are invoked, as in Step 10 on page 156, an AddLog log can be 
created.

■ If FindDialog is invoked, as in Step 12, a FindLog log can be created.
156 Siebel Communications Server Administration Guide Version 7.5.3



Configuring Events and Commands

Event Responses
■ Otherwise, a log can be created as specified by Log.

For more information about event logs, see “Event Logs” on page 168.

Event Response Parameters
Table 14 describes the parameters available in event responses. A dash (—) in the 
Macro column indicates that macro expansion is not applicable for the parameter. 
Y indicates that macro expansion applies to the parameter.

Table 14. Event Response Parameters

Parameter Type Macro Description

AddBusComp Char — Business component name to use when adding a new record.

AddBusObj Char — Business object name to use when adding a new record.

AddField Group Y Field names and predefined value when adding a new record.

AddLog Char — Event object to execute if the application navigates to the 
view and applet specified by the AddRecordView and 
AddRecordApplet parameters.

Determines the Siebel activity record to be created in 
response to communications events.

For an example of using this parameter, see “Event Response 
Process Overview” on page 154.

Note: This parameter should not be specified as an event 
response parameter. Rather, an event log of this type should 
be specified for the event response directly, using the 
Communications Administration screen. This parameter is 
used in .def files that you export to or import from.

AddRecordApplet Char — Name of the applet that is displayed, in the view specified by 
AddRecordView, when adding a new record.

If AddRecordApplet is not specified, the record is created in 
the first insertable applet which has the same business 
component as specified with AddBusComp.

AddRecordView Char — Name of the view that is displayed when adding a new 
record.
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Command Char — Optionally specifies the name of a command in the 
communications configuration that will be invoked when this 
event response is invoked.

ContextLog Char — Event object to execute if screen-context data is used for 
screen display.

Determines the Siebel activity record to be created in 
response to communications events.

For an example of using this parameter, see “Event Response 
Process Overview” on page 154.

Note: This parameter should not be specified as an event 
response parameter. Rather, an event log of this type should 
be specified for the event response directly, using the 
Communications Administration screen. This parameter is 
used in .def files that you export to or import from.

FindDialog Char — Find Object name to determine what is displayed in the 
Search Center if no rows are returned.

FindField Group Y Find Field names and default values to determine what is 
displayed in the Search Center if no rows are returned.

FindLog Char — Event object to execute if the Search Center is displayed, as 
specified using FindDialog and FindField.

Determines the Siebel activity record to be created in 
response to communications events.

For an example of using this parameter, see “Event Response 
Process Overview” on page 154.

Note: This parameter should not be specified as an event 
response parameter. Rather, an event log of this type should 
be specified for the event response directly, using the 
Communications Administration screen. This parameter is 
used in .def files that you export to or import from.

Table 14. Event Response Parameters

Parameter Type Macro Description
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Log Char — Event log to use if no other log is specified for an action.

Determines the Siebel activity record to be created in 
response to a communications event.

For an example of using this parameter, see “Event Response 
Process Overview” on page 154.

Note: This parameter should not be specified as an event 
response parameter. Rather, an event log of this type should 
be specified for the event response directly, using the 
Communications Administration screen. This parameter is 
used in .def files that you export to or import from.

MultiLog Char — Event object to execute if the view specified using the 
MultiView parameter is displayed.

Determines the Siebel activity record to be created in 
response to communications events.

For an example of using this parameter, see “Event Response 
Process Overview” on page 154.

Note: This parameter should not be specified as an event 
response parameter. Rather, an event log of this type should 
be specified for the event response directly, using the 
Communications Administration screen. This parameter is 
used in .def files that you export to or import from.

MultiView Char — Name of the view that will be displayed if the query result 
contains more than one row.

OpenView Char — Name of the view that will be displayed, regardless of query 
results.

The view specified by OpenView is displayed only if a view 
specified by SingleView or MultiView is not displayed.

Table 14. Event Response Parameters

Parameter Type Macro Description
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QueryAfterAnswer Boolean — A parameter that, when set to TRUE, causes Communications 
Server to answer the call first and then execute the screen-
pop query. 

When set to FALSE (the default setting), this parameter 
causes Communications Server to execute the query first and 
then answer the call.

This parameter is valid only for an event response invoked by 
an event handler that follows the “handle immediately” 
model.

For more information about screen pops, see “Handling an 
Inbound Call Received by an Agent” on page 152.

QueryBusComp Char — Business component name for the query specified by 
QuerySpec.

QueryBusComp2 Char — Business component name for a second query, specified by 
QuerySpec2.

The second query will be executed only if this parameter is 
specified and if the first query (specified by QuerySpec) 
returns exactly one row. This feature could be used to get 
screen pops related to campaigns.

For example, the first query can locate the campaign that 
matches the call type—using DNIS to identify the number the 
caller dialed. The second query can locate the contact (within 
that campaign) whose work number matches that of the 
caller—using ANI to identify a caller’s number.

QueryBusObj Char — Business object name containing the business components 
specified by QueryBusComp and QueryBusComp2.

Table 14. Event Response Parameters

Parameter Type Macro Description
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QueryFields Multi — Field names resulting from the business component query 
specified by QuerySpec.

Only the fields specified here will be activated when the 
Siebel application performs the query. Since the same 
business component is used to navigate to the destination 
view, you can use this feature to specify the fields required for 
that view.

If nothing is specified here, the navigation process will cause 
the business component to be queried again. QueryFields can 
speed up a screen-pop navigation by preventing additional 
queries of an entire business component.

QueryFields2 Multi — Field names resulting from the business component query 
specified by QuerySpec2.

For more details, see the description of the QueryFields 
parameter.

Table 14. Event Response Parameters

Parameter Type Macro Description
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QuerySpec Char Y Standard business component query.

The query uses business component field names from the 
business object and business component specified with the 
QueryBusObj and QueryBusComp parameters. (No other 
fields can be specified.)

Simple and complex queries are supported, using standard 
comparison operators, including:

=
LIKE
AND
OR
EXISTS
>
<
>=
<=

For example, if QuerySpec is defined as follows, then the 
query matches records in the current business component 
(assuming the business component contains the fields 
indicated) if either the work phone number or the home 
phone number matches the ANI value for the call:

'Work Phone #'='{ANI}' OR 'Home Phone #'='{ANI}'

Or, if QuerySpec is defined as follows, then the query matches 
records in the current business component (example is for 
Action business component) if the current user is one of the 
owners specified for the multi-value field Owned By:

EXISTS('Owned By'='{@UserName}')

The keyword EXISTS must be used when defining a query 
specification for a multi-value field.

Table 14. Event Response Parameters

Parameter Type Macro Description
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QuerySpec2 Char Y A second query that may be performed, after the query 
specified by the QuerySpec parameter.

QuerySpec2 queries the business component specified by the 
QueryBusComp2 parameter. (Both QueryBusComp and 
QueryBusComp2 specify business components in the 
business object specified by the QueryBusObj parameter.)

The result of the QuerySpec2 query may be used by Siebel 
SmartScript.

For more information on how the query may be constructed, 
see the description for the QuerySpec parameter.

Script Char — Siebel VB or Siebel eScript script name to invoke (if 
specified). Parameters are passed using the ScriptParam 
parameter.

For more information about using Siebel VB or Siebel eScript, 
see “Integrating with Siebel Scripting Languages” on 
page 247.

ScriptParam Group Y A group of subparameters that are parameters to the script 
method (if any) invoked using the Script parameter.

You create each parameter you need in the form 
ScriptParam.param_name, then specify a parameter value 
that will be passed to the script. The parameter names 
themselves are not passed to the script. Parameters should be 
ordered in the sequence in which they are expected by the 
script.

ScriptParam.Param1="value1"
ScriptParam.Param2="name"

Param1 and Param2 are subparameters of the ScriptParam 
parameter.

ServiceMethod Char — The name of a Siebel business service and method to be 
called. The service and method are specified in the form 
service.method. 

Optionally, you can use the ServiceParam parameter to 
provide parameter names and values to pass to the method to 
be called.

For more information, see “Using Business Services with 
Communications Server” on page 238.

Table 14. Event Response Parameters

Parameter Type Macro Description
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ServiceParam Group Y A group of subparameters that are parameters to the Siebel 
business service method (if any) invoked using the 
ServiceMethod parameter.

You create each parameter you need in the form 
ServiceParam.param_name, then specify a parameter value. 
The parameter name and value are both passed to the service 
method. Parameters should be ordered in the sequence in 
which they are expected by the service method.

ServiceParam.Param1="value1"
ServiceParam.Param2="name"

Param1 and Param2 are subparameters of the ServiceParam 
parameter.

For more information, see “Using Business Services with 
Communications Server” on page 238.

SingleField Group Y When the result from the QuerySpec query is exactly one 
record, that record can be updated if you provide a field name 
and predefined field value, using this parameter.

For example, in the following event response, QuerySpec will 
likely return a single record, then SingleField can update the 
Primary Owned By field to the current agent.

[EventResponse:EmailWorkStarted]
QueryBusObj="eMail Response"
QueryBusComp="Action"
QuerySpec="Id='{ActivityID}'"
SingleView="Communication Detail - Response View"
SingleField.'Primary Owned By'="{@UserName}"
Log=EmailWorkStarted

Table 14. Event Response Parameters

Parameter Type Macro Description
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SingleLog Char — Event object to execute if the view specified using the 
SingleView parameter is displayed.

Determines the Siebel activity record to be created in 
response to communications events.

For an example of using this parameter, see “Event Response 
Process Overview” on page 154.

Note: This parameter should not be specified as an event 
response parameter. Rather, an event log of this type should 
be specified for the event response directly, using the 
Communications Administration screen. This parameter is 
used in .def files that you export to or import from.

SingleView Char — Name of the view that will be displayed if the result from the 
QuerySpec query is exactly one row.

QueryBusComp2, QuerySpec2, and QueryFields2 can be used 
to query a second business component of the QueryBusObj 
for a single record.

SmartScript Group Y Parameter to be passed to Siebel SmartScript. Can include a 
script name or other data to pass to SmartScript. You can 
specify any of the following subparameters:

SmartScript.CampaignId
SmartScript.CampContactId
SmartScript.ContactId
SmartScript.LanguageCode
SmartScript.ScriptId
SmartScript.ScriptName

Either SmartScript.ScriptName or SmartScript.ScriptId must 
be specified in order to launch a particular SmartScript. For 
more information, see “Integrating with Siebel SmartScript” 
on page 254.

UseCtxData Boolean — Enables or disables automatic use of screen-context data 
attached to an event.

When UseCtxData is TRUE, and the event contains a Siebel 
screen bookmark, the bookmark will be used to perform a 
screen pop.

The default is FALSE.

Table 14. Event Response Parameters

Parameter Type Macro Description
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WorkObject Char Y Specifies data identifying a work-item tracking database 
record that can be written to the database.

This parameter can make work-item tracking possible even if 
your communications system does not fully support 
attaching data to a work item.

The WorkObject parameter is not necessary for Siebel CTI 
Connect (using Intel NetMerge) or another CTI middleware 
package that supports call data attachment. This data is 
passed to the communications driver, which attaches the data 
to the call without requiring the WorkObject parameter.

If you are using a custom driver developed for other 
middleware, you may need to use the WorkObject parameter 
in order to pass work-item tracking data from one agent to 
another, such as when a call is transferred or conferenced.

Example: An agent receives a call and creates the activity 
record for it. When this agent transfers the call to a second 
agent, the second agent will want access to the same activity 
record. For the first agent’s session, the row ID of the activity 
record is encoded, and the call is transferred. If the 
WorkObject parameter is defined appropriately, the second 
agent can continue tracking the call-activity record.

Values for this parameter should be formatted as follows:

bus_obj_name;bus_comp_name;row_ID

For activity records, “Action” is the name of the business 
object and the name of the business component.

Whether you require the WorkObject parameter, and how 
you would define the parameter, depend on your 
communications system and driver.

For example, with Aspect middleware, if variable E is used to 
store the row ID, the parameter would be defined as follows:

Action;Action;{E}

Whether this parameter definition would work as intended 
depends on whether the communications driver expects to 
receive data in this form to pass to the receiving agent.

Table 14. Event Response Parameters

Parameter Type Macro Description
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Event Response Example
Table 15 shows an example of an event response.

In this example, the information specified with the business object and business 
component parameters is retrieved. Communications Server then performs a query 
on the phone number retrieved from the ANI event data field, to see if it matches a 
value in the Work Phone # field in the Contact business component. (SingleLog, 
MultiLog, and Log are specified using fields, rather than parameters.)

If QuerySpec returns a single record, the agent is navigated to the service requests 
view specified by SingleView. The event log LogIncomingCallContactFound, which 
is specified by the SingleLog parameter, creates a call activity record automatically.

If QuerySpec returns multiple records, the agent is navigated to the contacts view 
specified by MultiView. The event log LogIncomingCallMultiContactFound, which 
is specified by the MultiLog parameter, creates a call activity record automatically.

If QuerySpec returns no records, the Search Center appears and displays “Ask 
Caller” in the CSN field. The event log LogIncomingCallContactNotFound, which is 
specified by the FindLog parameter, creates a call activity record automatically.

Table 15. Event Response: OnInboundCallReceived

Parameter Name Parameter Value

QueryBusObj Contact

QueryBusComp Contact

QuerySpec 'Work Phone #'='{ANI}'

SingleView Service Contact Detail View

MultiView Contact List View

FindDialog Service Request

FindField.CSN Ask Caller

SingleLog LogIncomingCallContactFound

MultiLog LogIncomingCallMultiContactFound

FindLog LogIncomingCallContactNotFound
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Event Logs
Event logs in the communications configuration data define log-generation rules for 
communications activity. Some event responses have an associated event log.

Event Log Parameters
Table 16 describes the parameters available in event logs. A dash (—) in the Macro 
column indicates that macro expansion is not applicable for the parameter. Y 
indicates that macro expansion applies to the parameter.

Table 16. Event Log Parameters

Parameter Type Macro Description

AfterWork Group Y Field names and values, from the log business component, that 
will be used to update the work-tracking log record when the 
work item has ended or been released.

Note: After the work item has been released, the log record that is 
modified according to the fields specified with this parameter is 
refreshed when the agent clicks off the record, then clicks on it 
again.

BusComp Char — Log business component name.

BusObj Char — Log business object name.

Display Boolean — Parameter that, when it is set to TRUE and the current view 
contains a business component specified in the event log, uses the 
current business component to add a new log record. The log 
record appears on the screen immediately, and is selected.

If Display is set to FALSE, the log record is generated but is not 
selected, and might not be displayed in the current record set. The 
default is FALSE.

Note: While the work item is active, the agent can modify the log 
record. After the work item has been released, however, if 
AfterWork is set, an agent’s changes may conflict with how the log 
record was written by the system at that time. The agent can click 
off the record, then click on it again in order to modify it.

LogField Group Y Field names and values of the log business component.
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QuerySpec Char Y Parameter that can be used to retrieve the desired record in the 
business component:

■ If QuerySpec is not defined, a new record is created for the 
event log.

■ If QuerySpec is defined and returns a single record, this record 
is used for the event log.

■ If QuerySpec is defined and returns more than one record, a 
new record will be created for the event log.

ServiceMethod Char — The name of a Siebel business service and method to be called. 
The service and method are specified in the form service.method.

Optionally, you can use the ServiceParam parameter to provide 
parameter names and values to pass to the method to be called.

If ServiceMethod and ServiceParam are specified, they are 
executed first when the event log is invoked. If the specified 
business service method does not return the required result, such 
as a value of TRUE (1) for the output argument Continue, the 
event log will stop executing.

For more information, see “Using Business Services with 
Communications Server” on page 238.

ServiceParam Group Y A group of subparameters that are parameters to the Siebel 
business service method (if any) invoked using the ServiceMethod 
parameter.

You create each parameter you need in the form 
ServiceParam.param_name, then specify a parameter value. The 
parameter name and value are both passed to the service method. 
Parameters should be ordered in the sequence in which they are 
expected by the service method.

ServiceParam.Param1="value1"
ServiceParam.Param2="name"

Param1 and Param2 are subparameters of the ServiceParam 
parameter.

For more information, see “Using Business Services with 
Communications Server” on page 238.

Table 16. Event Log Parameters

Parameter Type Macro Description
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Event Log Examples
Table 17 shows an example of an event log for Siebel CTI Connect. This example 
shows how a new activity is created. The activity is linked with the current contact 
and its account because the current contact is the result of a screen pop.

WorkTrackingObj Group Y Field name and values of a work-tracking object to create. You can 
retrieve the value of the tracking object from a command.

For example, the following parameter defines a custom work-
tracking object, called “ContactId”, whose value is derived from 
the Id field of the Contact business component.

WorkTrackingObj.ContactId="{Contact.Id}"

For a selected work item, this data could then be accessed from a 
communications command, using the WorkTrackingObj 
command data parameter. In this example, ContactId becomes a 
custom work item attribute.

Or, if an event log includes a parameter definition like the 
following, then text you specify is displayed in the Work Items list 
in the communications toolbar.

WorkTrackingObj.Description="your descriptive text goes here"

For more information about using these and other attributes, see 
“Work Item Attributes” on page 208.

Table 16. Event Log Parameters

Parameter Type Macro Description

Table 17. Event Log: LogIncomingCallContactFound

Parameter Name Parameter Value

Display FALSE

BusObj Contact

BusComp Action

LogField.Type Call - Inbound

LogField.'Account Id' {Contact.'Account Id'}

LogField.'Contact Id' {Contact.Id}

LogField.Description Inbound call

LogField.'Call Id' {refId}
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Communications Simulator. Table 18 shows an example of an event log. A definition 
like this could be used when the inbound caller is not found in the database.

If you choose a View Call command after answering a simulated call, you will go to 
the Activity Attachments view to see information about the current call. Notice that 
the description of the call starts with Unknown Caller, followed by the phone 
number from which the call was dialed.

You can change the LogField.Description parameter value to display other text here. 
For example, “Unknown Phone Number: {ANI}” will display the text “Unknown 
Phone Number:” followed by the phone number corresponding to the ANI event 
data field.

AfterWork.'ACD Call Duration' {@WorkDuration}

AfterWork.'Planned' {@WorkStartTime}

AfterWork.'Planned Completion' {@Now}

Table 18. Event Log: LogIncomingCallContactNotFound

Parameter Name Parameter Value

BusObj Contact

BusComp Action

LogField.Type Call - Inbound

LogField.Comment {refId}

LogField.Description Unknown Caller ({ANI})

AfterWork.'ACD Call Duration' {@WorkDuration}

Table 17. Event Log: LogIncomingCallContactFound

Parameter Name Parameter Value
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Commands
Commands in the communications configuration data define the appearance and 
availability of communications commands.

By using the DeviceCommand parameter in a command, you can invoke a 
command on the communications system or invoke a special command.

■ Device commands that are executed by the communications driver. Such 
commands are specific to particular middleware vendors, or to how Siebel 
Systems supports communications toolbar interactivity. For more information 
about commands supported by Siebel-provided drivers, see “Siebel CTI Connect 
Commands” on page 465 and “Supporting Email Interactivity” on page 536.

■ Device commands that are independent of communications drivers. For more 
information, see “Special Commands for Device Commands” on page 131.

Communications commands may instead invoke a business service method, a 
SmartScript, or a Siebel VB or Siebel eScript script. In these cases, the 
DeviceCommand parameter need not be specified.

■ For information about invoking a business service method, see “Using Business 
Services with Communications Server” on page 238.

■ For information about invoking a Siebel VB or Siebel eScript script, see 
Appendix E, “Communications Server Business Services.”

Hierarchical Commands
Communications commands can be defined in hierarchical fashion, where you 
define group commands to contain subcommands are to be invoked when the group 
command is invoked. Grouping or nesting commands using subcommands helps to 
define the communications user interface in the Siebel application.

For information about specifying subcommands, see “Defining Communications 
Commands” on page 106. For more information about how command groups are 
used in configuring the communications toolbar and menus, see Chapter 6, 
“Configuring User Interface Elements.”
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When you specify subcommands within group commands, note the following:

■ Commands can have subcommands. A command containing subcommands is 
sometimes referred to as a group command.

■ Do not define invalid recursive subcommand relationships, such as making a 
subcommand include its parent group command as a subcommand.

■ Commands execute in the order specified in the Subcommands list in the All 
Commands view. Or, if the command parameter ExecuteAll is set to TRUE, then 
all subcommands can execute. As with any command, subcommands can 
execute only when they are enabled. Subcommands that are disabled are 
skipped and not executed.

■ If a subcommand fails when executing, then the remaining subcommands are 
not executed. However, if the command parameter ExecUntilOK is set to TRUE, 
then the remaining subcommands are executed until one of them succeeds.

■ Subcommands and their order are represented in .def files you export by using 
the command parameter SubCommand_N, where N is the order value for each 
subcommand.

■ At runtime, commands that invoke device commands are enabled or disabled 
based in part on the status of the device command. For more information, see 
“SCCommandFlag” on page 577 and “CacheCommandInformation” on 
page 583.

■ At runtime, commands that invoke business service methods rather than device 
commands are determined to be enabled or disabled by invoking from the 
applicable business service the method CanInvokeMethod("method_name"), 
where method_name is your business service method to be invoked. If TRUE is 
returned, the method can be invoked. If FALSE is returned, the method cannot 
be invoked and the command is disabled.

■ Several command parameters are used to determine whether a group command 
or subcommand matches and can be executed. Such command parameters 
include AllViews, CmdChannelOnFocus, FilterSpec, OnEditControl, and View.

■ Several command data parameters are also used to determine whether a group 
command or subcommand matches and can be executed. Such command data 
parameters include BusComp, BusObj, Filter, and RequiredField.
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■ Commands specifying subcommands cannot also specify a device command or 
business service method.

■ If you require a command that executes both a device command and a business 
service method, define a group command where ExecuteAll is TRUE and where 
two subcommands are specified. Define one subcommand to execute a device 
command, such as a make-call command, and define the other subcommand to 
invoke your business service method. If you need command data parameters, 
create command data definitions and associate them with the subcommands.

■ In some cases, a group command should not have command data associated 
with it. If a group command is at the top-level (is not itself a subcommand), or 
if a group command is also a subcommand and ExecuteAll is set to TRUE for its 
parent group command, then command data may be associated. However, in the 
latter case, if ExecuteAll is not set to TRUE for the parent group command, then 
do not associate command data with the child group command.

■ The command parameter SelectApplet (and related parameters such as 
SelectBusObj, SelectBusComp, SelectView, and so on) can be used to display a 
dialog box that pertains to all subcommands in a group command, where 
ExecuteAll is TRUE. To configure this, you must define these parameters in the 
top-level command and not in the individual subcommands. The dialog box will 
apply to all subcommands.

Command Parameters
Table 19 on page 176 describes the parameters available in commands. A dash in 
the Macro column (—) indicates that macro expansion is not applicable for the 
parameter. Y indicates that macro expansion applies to the parameter.
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For more information about configuring the communications toolbar and 
Communications submenu commands, see Chapter 6, “Configuring User Interface 
Elements.” 
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Table 19. Command Parameters

Parameter Type Macro Description

AcceptReject Boolean — Indicates whether the command is for prompting the agent to 
accept or reject a work item. Set to TRUE for such a command.

Execution of the device command is subject to the Accept/Reject 
dialog box and subject to the agent’s choices. If AcceptReject is 
TRUE, then this dialog box displays, with the title specified by 
the ARTitle parameter. The work item matches the definition of 
the ARWorkItemID parameter.

■ If the agent accepts the work item, then the device command 
for this command can be executed.

■ If the agent rejects the work item, then the command 
specified by the AROnRejectCmd parameter is executed.

For example, the following command and command data 
definitions can be used for an accept/reject scenario for an email 
work item, where Siebel Universal Queuing is employed:

[Command:AcceptEmailGroup]
Hidden="TRUE"
DeviceCommand="AcceptEmailWork"
CmdData="AcceptEmailGroup"
AcceptReject="TRUE"
ARTitle="Would You Like to Accept This Email Work Item?"
ARWorkItemID="{$GetInboundWorkItemAttr(Email, 

WorkItemID)}"
AROnRejectCmd="OnEmailWorkItemRejected"

[CmdData:AcceptEmailGroup]
Param.TrackingID="{$GetInboundWorkItemAttr(Email, 

DriverWorkTrackID)}"

[Command:OnEmailWorkItemRejected]
Hidden="TRUE"
DeviceCommand="@UQRejectWorkItem"
CmdData="OnEmailWorkItemRejected"

[CmdData:OnEmailWorkItemRejected]
Param.WorkItemID="{$GetInboundWorkItemAttr(Email, 

UQWorkItemID)}"

AllViews Boolean — Parameter that, when set to FALSE, disables the command on all 
views other than those specified using the View parameter.

The default is TRUE.
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AROnRejectCmd Char — Specifies the name of a command to be executed if the agent 
chooses to reject the work item.

For example:

AROnRejectCmd="OnEmailWorkItemRejected"

ARTitle Char — Provides text to be presented to the agent when the agent is 
prompted to accept or reject the work item.

For example, for a command used for the accept/reject case for 
email work items, the parameter could be defined as follows:

ARTitle="Would You Like to Accept This Email Work Item?"

ARWorkItemID Char Y Defines the ID of the work item to be accepted or rejected.

For example, the parameter might be defined as follows:

ARWorkItemID="{$InboundWorkItem(Email, WorkItemID)}"

CmdChannelOnFocus Boolean — Specifies whether the command can only be enabled when the 
work item with the focus has the same channel as the device 
command for this command.

In other words, if CmdChannelOnFocus is TRUE, the current 
work item is of a particular channel, and the device command is 
valid for a work item of this channel, then this command can be 
enabled. Otherwise, the command is disabled.

For example, the command will be disabled if all of the following 
are true:

■ This parameter is set to TRUE.

■ The device command for this command is “HoldCall” 
(command is for Voice channel).

■ The work item that currently has the focus (that is, the 
current item displayed in the Work Items list in the 
communications toolbar) is for a channel other than Voice.

An equivalent way to filter the command would be to define the 
FilterSpec parameter as follows:

FilterSpec=[@SelectedWorkItem:ChannelType]='Voice'"

Table 19. Command Parameters

Parameter Type Macro Description
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CmdData Char — The command data definition name that describes parameter 
generation for this command to be passed to a device command 
(or to a business service method, for example).

This parameter can be empty if the device command does not 
require any parameters from a command data parameters, or if 
no device command is specified.

For more information, see “Command Data” on page 186.

Note: This parameter should not be specified as a command 
parameter. Rather, a command data definition for the command 
should be specified directly, using the Communications 
Administration screen. This parameter is used in .def files that 
you export to or import from.

Description Char Y Description string for the command.

This string appears in the ToolTip area when the user points to 
a communications toolbar button for this command.

For more information, see “About Communications Toolbar 
Configuration” on page 265 and “Configuring Communications 
Menu Commands” on page 277.

DeviceCommand Char — The device command executed when this communications 
command is executed. 

Device commands that are executed by the communications 
driver are specific to particular communications systems. See the 
commands table for the relevant driver in Appendix A, “Using 
Siebel CTI Connect.”

Device commands based on special commands are not executed 
by a communications driver. For more information, see “Special 
Commands for Device Commands” on page 131.

Table 19. Command Parameters

Parameter Type Macro Description
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ExecuteAll Boolean — When used within a group command (containing 
subcommands), specifies that all subcommands can be 
executed.

For example, if auto-login is in effect, and a default login 
command such as SignOnGroup is specified using the 
configuration parameter AutoLoginCmd, all of this group 
command’s subcommands would execute when the agent starts 
the Siebel session.

In this example, the agent would be logged into all applicable 
communications systems, such as Siebel Universal Queuing or 
applicable ACD queues.

See also “Hierarchical Commands” on page 172 and 
“Configuring Communications Login and Logout” on page 222.

ExecUntilOK Boolean — When used within a group command (containing 
subcommands), specifies that each subcommand will execute in 
sequence until one of them succeeds. If a subcommand fails to 
execute, the next subcommand executes.

See also “Hierarchical Commands” on page 172.

FilterSpec Char Y Filter that supports simple or complex queries.

Filter results are evaluated using a compound predicate that can 
include standard query operators to determine if the command 
matches.

FilterSpec queries use standard comparison operators, including:

=
LIKE
AND
OR
EXISTS
>
<
>=
<=

Or, FilterSpec can operate on the work item represented by the 
macro @SelectedWorkItem. For example, the following 
parameter definition matches voice work items:

FilterSpec="[@SelectedWorkItem:ChannelType]='Voice'"

See also the descriptions for the FilterSpec event handler 
parameter and the QuerySpec event response parameter.

Table 19. Command Parameters

Parameter Type Macro Description
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Hidden Boolean — Parameter that, when set to TRUE, hides the command from the 
Communications submenu. This command would typically be 
set to TRUE for commands to appear only in the 
communications toolbar, or for commands that will not appear 
in the user interface.

Set this parameter to FALSE (the default) or omit the parameter 
in order for the command to appear in the Communications 
submenu. Use the Description, HotKey, MenuPosition, and Title 
parameters to specify additional settings relevant to the 
command’s appearance in the Communications submenu.

For more information, see “About Communications Toolbar 
Configuration” on page 265 and “Configuring Communications 
Menu Commands” on page 277.

HotKey Char — Keyboard shortcut to assign to this command, for use in the 
Communications submenu.

This can be a combination of CTRL, ALT, or SHIFT and one of 
the keyboard letter or function keys—or just a single letter or 
function key.

For example, valid values for the HotKey parameter may include 
F12, CTRL+SHIFT+F, and so on.

Note: If you specify keyboard shortcuts, using the HotKey 
parameter, that conflict with keyboard shortcuts (accelerators) 
specified for commands in Siebel Tools, these shortcuts will take 
precedence over the shortcuts from Siebel Tools for the agent’s 
session.

Note: Keyboard shortcuts defined for communications 
commands do not use as input any data entered into the text 
entry field in the communications toolbar.

For more information, see “Configuring Communications Menu 
Commands” on page 277.

Table 19. Command Parameters

Parameter Type Macro Description
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HotKeyText Char — Specifies locale-dependent text to represent the keyboard 
accelerator for the command’s menu item. The keyboard 
accelerator itself is specified using the HotKey parameter. This 
locale-dependent text appears in the Communications submenu.

If HotKeyText is not used, the text specified in HotKey is used 
instead.

For more information, see “Configuring Communications Menu 
Commands” on page 277.

IndicateActiveCmd Boolean — Parameter that, when set to TRUE, specifies whether the toolbar 
button for this command should display the correct channel-
specific icon for the device command for the active 
subcommand.

This parameter is used in group commands containing 
subcommands for multiple channels—such as the 
AcceptWorkGroup command, for the Accept Work Item toolbar 
button.

For example, if the active work item is a voice call, then the 
AcceptCallGroup subcommand is active, for which the device 
command is AnswerCall (for Siebel CTI Connect), or an 
equivalent command for your CTI middleware. The Accept Work 
Item button will display the phone-type icon in this case.

The default is FALSE.

LocalMenu Boolean — Parameter that, when set to TRUE, enables this command so it 
appears in the context-sensitive applet-level menu.

This feature lets you, for example, define an applet-level menu 
item called Call Contact that can be invoked when working with 
contact records.

The default is FALSE.

For more information, see “Configuring Communications Menu 
Commands” on page 277.

Table 19. Command Parameters

Parameter Type Macro Description
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MenuPosition Char — Parameter setting that determines the order in which the 
command will appear in the Communications submenu or in the 
applet-level menu. Commands appear in ascending order with 
respect to the MenuPosition values: those with lower 
MenuPosition values will appear above those with higher 
MenuPosition values.

Values for the MenuPosition parameter can also specify 
additional menu command levels, within the Communications 
submenu of the View application level menu. The applet-level 
menu commands, however, are all on a single level.

For example, assume the SignOnGroupInMenu command (with 
Title parameter value “Log In”) has a MenuPosition value of 20. 
This group command would appear in the Communications 
submenu, below any items with lower number, and would in 
turn have subcommands representing submenu items.

The subcommands LoginToPBX and LoginToUQ would have 
values of 20.1, 20.2, and 20.3—specifying that they would 
appear as submenu items to SignOnGroupInMenu. LoginToPBX 
(with Title parameter value “Log In (Phone)”) would be 
available to agents at the following path in the application-level 
menu:

View > Communications > Log In > Log In (Phone)

For more information, see “Configuring Communications Menu 
Commands” on page 277.

Table 19. Command Parameters

Parameter Type Macro Description
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MultiActiveCmdIcon Char — Specifies the name of the icon file to use for the toolbar button, 
such as the Accept Work Item button, if multiple work items 
have arrived, such as a phone call and an email message.

For example, the parameter can be defined as follows:

MultiActiveCmdIcon="misc_work.gif"

The image files are in the following locations:

■ eapps\public\language_code\images, in the Siebel Server 
installation directory

■ public\language_code\images, in the Siebel Dedicated Web 
Client installation directory

where language_code is the installation language, such as ENU.

For more information about toolbar button configuration, see 
“About Communications Toolbar Configuration” on page 265.

OnEditControl Boolean — Parameter that, when set to TRUE, means that the command 
requires that the edit field in the communications toolbar has the 
focus and contains data.

The default is FALSE.

Profile Char — Name of the communications driver profile that supports the 
device command associated with this command.

If a profile is associated with the command, then the command 
can only be sent to the communications driver for that profile. 
See also “Creating Commands” on page 108.

Note: This parameter should not be specified as a command 
parameter. Rather, the profile for the command should be 
specified directly, using the Communications Administration 
screen. This parameter is used in .def files that you export to or 
import from.

Script Char — Siebel VB or Siebel eScript script name to invoke (if specified). 
Parameters are passed using the ScriptParam parameter for the 
associated command data definition.

For more information about using Siebel VB or Siebel eScript, see 
“Integrating with Siebel Scripting Languages” on page 247.

Table 19. Command Parameters

Parameter Type Macro Description
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ServiceMethod Char — The name of a Siebel business service and method to be called. 
The service and method are specified in the form service.method. 

Optionally, you can use the ServiceParam parameter for the 
associated command data definition to provide parameter names 
and values to pass to the method to be called.

For more information, see “Using Business Services with 
Communications Server” on page 238.

SubCommand_N Multi — The name of a command that is specified as a subcommand for 
the current command.

The commands may appear to an agent as one command 
because only one of them is active at any point, depending on 
the Siebel context and the specified Order values for the 
subcommands. Or, all subcommands can execute, if the 
ExecuteAll parameter is set to TRUE.

In a .def file (the only place this parameter appears), the suffix 
N represents the order value for the subcommand.

For example, a call-transfer command could be either to transfer 
to an employee or to transfer to a service request owner, 
depending on the current business component.

The commands that are invoked from the communications 
toolbar and the Communications submenu often invoke other 
commands, which are specified as subcommands.

Note: This parameter should not be specified as a command 
parameter. Rather, subcommands for the command should be 
specified directly, using the Communications Administration 
screen. This parameter is used in .def files that you export to or 
import from.

Title Char — Name of the Communications submenu item associated with 
this command.

If no Title parameter is specified, the name of the device 
command serves as the menu item name.

For more information, see “Configuring Communications Menu 
Commands” on page 277.

View Multi — Names of the views where this command is enabled if the 
AllViews parameter value is FALSE.

Table 19. Command Parameters

Parameter Type Macro Description
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Command Example
Communications Simulator. Table 20 and Table 21 provide an example of a command 
showing how the Communications Simulator defines the hot key that simulates an 
incoming call from someone who is not in the database.

You might want to change something about this simulated incoming call. For 
instance, you might want the command to appear on the Communications submenu 
to provide Communications Simulator users with an alternative to pressing 
CTRL+SHIFT+F11.

For more information about the Communications Simulator, see “Enabling Session 
Communications and Simulation” on page 311.

To add a Simulate Call command to the Communications submenu

1 Start the Demo version of a Siebel application such as Siebel Call Center Demo.

The demo versions of these applications use communications simulation and 
connect to the Sample Database.

2 Connect to the Sample Database as the Siebel administrator (SADMIN is both 
the login name and the password).

3 From the application-level menu, choose View > Site Map > Communications 
Administration > All Commands.

Table 20. Command: SimCallNotFound

Parameter Name Parameter Value

DeviceCommand SimulateCall

Hidden TRUE

HotKey CTRL+SHIFT+F11

Table 21. Command Data: SimCallNotFound

Parameter Name Parameter Value

Param.ANI 6504775000
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4 In the Commands list, select the record for the SimCallNotFound command.

5 Change the command parameter Hidden from TRUE to FALSE.

6 Add a new command parameter called Title and give it the value Simulate Call.

7 Exit the Siebel client.

8 Restart the Siebel client.

A new menu item, Simulate Call, has been added to the Communications 
submenu.

If you do not specify a title, the menu item is based on the value for the 
DeviceCommand parameter; in this case, it would be SimulateCall (with no 
space).

Command Data
Command data definitions in the communications configuration data define how 
communications command parameters should be generated for use with a 
corresponding command.

For example, a command data definition can instruct one of the transfer commands 
to transfer the caller to the current service request owner, or to display a specified 
Siebel view, and extract the transfer destination from that view.
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Command Data Parameters
Table 22 describes the parameters available in command data definitions. A dash 
(—) in the Macro column indicates that macro expansion is not applicable for the 
parameter. Y indicates that macro expansion applies to the parameter.

Table 22. Command Data Parameters

Parameter Type Macro Description

AttachContext Boolean — Parameter that, when set to TRUE, allows automatic passing of 
current screen-context data with the current work item. This is 
the easiest way of transferring screens between agents. 
AttachContext applies to voice work items only.

Note: The Send Screen Pop and Receive Screen Pop settings in 
the Communications tab of the User Preference screen override 
the setting of the AttachContext command parameter. For more 
information, see “Setting Communications User Preferences” on 
page 339.

The default is FALSE.

BusComp Char — Business component name.

If this parameter is empty, then the associated command is 
enabled on all views. If a business component name is specified, 
the associated command is enabled only on views that are based 
on the specified business component.

BusObj Char — Business object name.

If this parameter is empty, then the associated command is 
enabled on all views. If a business object name is specified, the 
associated command is enabled only on views that are based on 
the specified business object.

OnField Char — Field name that is required to be active.

If this property is specified, then the related command is enabled 
only when this field is active (that is, when a cursor is in this 
field).
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Param Group Y Parameter names and values for the command.

You can use this parameter to pass data to accompany the device 
command, whether for a communications driver or a special 
command.

You create each parameter you need in the form 
Param.param_name, then specify a value for the parameter that 
you will pass for the device command.

Parameters specific to commands for particular middleware 
vendors, and possible values for these parameters, are listed in 
the command parameters table for the relevant driver in 
Appendix A, “Using Siebel CTI Connect.”

The Param parameter can also be used to pass parameter values 
received from outside Communications Server, such as from a 
business service that invokes a Siebel communications 
command. For more information, see “About Using Business 
Services with Events and Commands” on page 241.

RequiredField Group Y Field name/filter pair that will be used as a criterion to 
determine if this command will be active for this condition. 
RequiredField is always based on the currently selected row.

For example, the following property will cause the specified 
command to be disabled if field A of the current (selected) row 
in the current (active) applet does not contain a value that ends 
with X2.

RequiredField.A="*X2"

ScriptParam Group Y A group of subparameters that are parameters to the script 
method (if any) invoked using the Script parameter.

You create each parameter you need in the form 
ScriptParam.param_name, then specify a parameter value that 
will be passed to the script. The parameter names themselves 
are not passed to the script. Parameters should be ordered in the 
sequence in which they are expected by the script.

ScriptParam.Param1="value1"
ScriptParam.Param2="name"

Param1 and Param2 are subparameters of the ScriptParam 
parameter.

Table 22. Command Data Parameters

Parameter Type Macro Description
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SelectApplet Char — An applet from which an agent can make a selection, such as to 
select a recipient for a work item or to specify a reason code.

For example, applets that can be specified include ACD Transfer 
Call Applet, Transfer Multiple LOV Popup Applet, and Accept 
Reject Popup Applet.

SelectBusComp Char — Business component for an applet from which an agent can 
make a selection.

SelectBusObj Char — Business object specifying application elements from which an 
agent can make a selection.

SelectParam Boolean — Parameter that, when set to TRUE, enables an applet in which 
the user can make a selection. For example, the applet can be 
used to select the person to whom to send, transfer, or 
conference a work item (such as to call or to transfer a call to) 
or used to specify a reason code.

For example, for a MakeCall command, a dialog box can be 
displayed from which the agent can select an employee to call.

The SelectBusObj, SelectBusComp, SelectApplet, SelectTitle, 
and SelectQuerySpec parameters determine the specific nature 
of the selection applet.

The default is FALSE.

Table 22. Command Data Parameters

Parameter Type Macro Description
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SelectQuerySpec Char Y Query specification for an applet, such as Transfer Multiple LOV 
Popup Applet, from which an agent can make a selection.

For example, a command data definition can use 
SelectQuerySpec as follows:

[CmdData:NotReadyWithPopup]
SelectParam="TRUE"
SelectTitle="Please select the reason for changing status to 

Not Ready"
SelectApplet="Transfer Multiple LOV Popup Applet"
SelectBusObj="List Of Values" 
SelectBusComp="List Of Values"
SelectQuerySpec="[Type]='REASON_CODE' AND 

[Active]='Y'"
Param.Reason="[Value]"

In this example, SelectQuerySpec queries the List of Values 
business component to obtain the values to display in the 
Reason Codes list.

If the applet allows you to select multiple records, as does 
Transfer Multiple LOV Popup Applet, then the selection values 
are concatenated as comma-separated values.

SelectTitle Char — The title for the applet (dialog box) from which an agent can 
select a recipient for a work item.

If this value is not specified, the applet will have the title that is 
assigned to the selection applet.

Table 22. Command Data Parameters

Parameter Type Macro Description
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ServiceParam Group Y A group of subparameters that are parameters to the Siebel 
business service method (if any) invoked using the 
ServiceMethod parameter for the associated command.

You create each parameter you need in the form 
ServiceParam.param_name, then specify a parameter value. The 
parameter name and value are both passed to the service 
method. Parameters should be ordered in the sequence in which 
they are expected by the service method.

ServiceParam.Param1="value1"
ServiceParam.Param2="name"

Param1 and Param2 are subparameters of the ServiceParam 
parameter.

For more information, see “Using Business Services with 
Communications Server” on page 238.

Table 22. Command Data Parameters

Parameter Type Macro Description
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WorkTrackingObj Group Y Field name and values of a work-tracking object previously 
specified in an event log definition. The WorkTrackingObj 
command data parameter stores or updates this object for the 
currently selected work item.

For example, the following command and command data 
definitions update the customer dashboard with a contact ID:

[Command:UpdateDashboardFromContact]
Hidden="TRUE"
ServiceMethod="Persistent Customer Dashboard.Update 
Dashboard from CTI"
CmdData="UpdateDashboardFromContact"

[CmdData:UpdateDashboardFromContact]
BusComp="Contact"
ServiceParam.Field="Id"
ServiceParam.Value="{Id}"
WorkTrackingObj.ContactId="{Id}"

The WorkTrackingObj parameter updates the attribute value of 
"ContactId" for the currently selected work item.

In this example, ContactId is a custom work item attribute.

You can also use WorkTrackingObj to update the Siebel 
bookmark. For example, using the following line in a command 
data definition for a command to resume a suspended work item 
(such as to remove a call from hold) prevents a screen pop from 
occurring when an agent resumes a work item. If this parameter 
is not defined as shown, a screen pop may display the view the 
agent was on when suspending the work item.

WorkTrackingObj.ViewBookmark=""

For more information, see “Work Item Attributes” on page 208.

Table 22. Command Data Parameters

Parameter Type Macro Description
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Command Data Example
Table 23 shows an example of a command data definition for a Siebel CTI Connect 
configuration.

The command that uses this command data definition is enabled only on Service 
Request applets. First, the command opens the applet ACD Transfer Call Applet, for 
selecting an employee to whom to transfer a call (this applet is also used for placing 
and conferencing calls). Next, it dials the extension of the selected employee by 
retrieving the sixth through tenth digits of the phone number—for example, a five-
digit extension that is part of a ten-digit phone field.

Table 23. Command Data: ConferenceTransferToPopupEmployee

Parameter Name Parameter Value

BusObj Service Request

BusComp Service Request

AttachContext TRUE

SelectParam TRUE

SelectBusObj Employee

SelectBusComp Employee

SelectApplet ACD Transfer Call Applet

SelectTitle SR Conference To Agent Group

Param.PhoneNumber [Phone #:6-10]

Param.CallNotifyText Conference transfer from {@UserName}...
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Communications Simulator. In the command and associated command data shown in 
Table 24 and Table 25, the phone number for the parameter Param.ANI is the same 
as the phone number specified in the Description field for the activity created for a 
simulated incoming call.

Table 24. Command: SimCallNotFound

Parameter Name Parameter Value

DeviceCommand SimulateCall

Hidden FALSE

HotKey CTRL+SHIFT+F11

Table 25. Command Data: SimCallNotFound

Parameter Name Parameter Value

Param.ANI 6504775000

Param.Testing My_Value_Here
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This chapter describes several advanced or special-purpose configuration tasks or 
topics for deploying Siebel Communications Server.

Using Macro Expansion for Character Fields
Some parameter values for events or commands, communications drivers, or 
configuration parameters can contain macro-expansion characters, which allow the 
actual values of those fields to be calculated based on contextual data such as the 
current business component or other runtime data.

For information about macros that represent runtime values such as the current 
agent’s login or a hoteling agent’s extension, see “Macros for Parameter Values” on 
page 196.

For examples illustrating macros and macro-expansion, see “Macro-Expansion 
Examples” on page 212.

Macro-Expansion Syntax Elements
Macro expansion uses the following syntax elements:

■ Brackets ([ ]) may contain a field name from the record that is currently selected 
in the Siebel application—for example, a record displayed in a dialog box. 
Brackets are applicable to event and command parameters only.

■ Braces ({ }) may contain a field name from the current business object, business 
component, work item, or session data, or may contain one of the macros 
described in “Macros for Parameter Values” on page 196.
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■ A colon (:) following a field name functions as a separator to introduce 
modifying keywords, attributes, subfields, or numeric ranges that determine 
what data to extract and substitute. For information about how this element is 
used in phone number processing, see “Macro Expansion with Phone Numbers” 
on page 205.

■ A backslash (\) functions as an escape character, allowing you to place a literal 
bracket, brace, or colon in a value without its being subject to macro expansion.

Macros for Parameter Values
Several macros (sometimes referred to as special fields) can be used within values 
for applicable event or command parameters, configuration parameters, or, in 
limited cases, driver parameters.

NOTE: Unless otherwise stated, the macros described in this section cannot be used 
within values for communications driver parameters.

When the parameter value is read into memory (such as when the event or 
command is invoked), particular values are substituted for the macro name. These 
macros are not specific to any particular communications system, such as a specific 
CTI middleware product.

Some macros require work item attributes to be provided. Notations for specifying 
attributes are shown in examples. For details, see “Work Item Attributes” on 
page 208.

Event attributes are also available for use in parameter values that support macro 
expansion. For example, the event attribute “SiebelChannelType” represents the 
channel type of the current work item. For more information, see “Driver Event 
Attributes” on page 574.

The macros, which have names that start with the symbol @ or $, are listed below. 
The macros that start with @ are static variables with values that are defined at 
runtime (values for some of these macros may change during a user session). The 
macros that start with $ are actually functions that return a value.
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■ @ACDDNList. The list of ACD DNs (extensions of type “A”) associated with the 
current agent.

This macro may be used, for example, in a value for the driver parameter 
Service:ACDDNList, for the Dialogic CTI driver (for Siebel CTI Connect).

The values are separated by commas.

■ @AgentId. Agent login for the current agent.

■ @AgentPin. Password for the agent login for the current agent.

■ @Configuration. The current configuration for the agent.

■ @CountryCode. The country code applicable to the agent’s location.

If the agent’s country is the U.S., this macro returns an empty value. 

If the agent’s country is other than the U.S., the macro returns the applicable 
country code, preceded by a plus (+). For example, if the agent’s country is 
France, the macro returns +33.

■ @DeselectedWorkItem. The item in the Work Items list in the communications 
toolbar that had the focus just prior to the item that currently has the focus. (The 
item with the focus is represented by the @SelectedWorkItem macro.)

This macro must be specified with an attribute value, as follows:

@DeselectedWorkItem:attribute_name

where attribute_name is the work item attribute you are providing.

For more information, see “Work Item Attributes” on page 208.
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■ $DialingRuleMethod. Used within parameter values for the DialingFilter.RuleN 
configuration parameters, this macro calls a custom business service method to 
determine how to translate phone numbers when the dialing filter is in effect.

The custom business service must recognize the input arguments Filter and 
PhoneNumber. Filter is the filter in effect for the parameter that invokes the 
macro. PhoneNumber is the number that needs to be translated. For example, 
for the following dialing rule, Filter should be “650”:

DialingFilter.Rule2="650->$DialingRuleMethod(myservice.mymethod)"

The business service must also support an output parameter called 
PhoneNumber. For example, if your dialing filter rule is to be applied to the U.S. 
number (650) 123-4567, where numbers with prefix 123 in the area code (650) 
should be changed to use prefix 555, the business service method might return 
the PhoneNumber output parameter with the value “916505554567”.

After a dialing filter rule is applied that uses the macro $DialingRuleMethod, no 
other filters are applied.

For more information about using this macro with dialing filters, see “Working 
with Dialing Filters” on page 214.

■ @DNList. The list of DNs (standard extensions of type “S”) associated with the 
current agent.

This macro may be used in a value for the driver parameter Service:DNList, for 
the Dialogic CTI driver (for Siebel CTI Connect).

The values are separated by commas.

■ @EditControl. The data in the edit field (text box) control in the communications 
toolbar.

This macro yields a value only when the edit field in the communications 
toolbar has the focus and contains a value. Use @EditControl when agents will 
input values other than phone numbers into the communications toolbar’s edit 
field—such as to log into the switch.

■ $GetCommandStatus. Obtains the status of the device command for a 
communications command. Possible status values returned are:
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■ Checked – command is in toggled-down state, button displays (for example, 
if the agent indicates Not Ready for new work items, the button is toggled 
down)

■ Blinking – command is available, button is blinking

■ Enabled – command is available, button is enabled

■ Disabled – command is not available, button is disabled

You can obtain the status with an expression like this:

$GetCommandStatus(device_command)

where device_command is the name of the device command for the command.

For example, a command parameter to determine the status of the device 
command may be defined as follows:

FilterSpec="[$GetCommandStatus(ChangeNotReadyState)]='Checked'"

In this case, if the status of ChangeNotReadyState is Checked, then FilterSpec 
matches, and the command containing this FilterSpec parameter can execute.

■ $GetInboundWorkItemAttr. Obtains the attributes of an inbound work item.

You can obtain the work item attributes with an expression like this:

$GetInboundWorkItemAttr(channel_name, attribute_name)

where channel_name is the name of the locale-independent channel for the 
work item, and attribute_name is the work item attribute you are interested in.

For example, a command data parameter to obtain the tracking ID of an inbound 
voice work item may be defined as follows:

Param.TrackID="{$GetInboundWorkItemAttr(Voice, DriverWorkTrackID)}"

For more information, see “Work Item Attributes” on page 208.
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■ $GetWorkItemAttr. Obtains the attributes of a work item—for example, in an 
event handler evaluating a new work item, or in a command.

You can obtain the work item attributes with an expression like this:

$GetWorkItemAttr(workitem_ID, attribute_name)

where workitem_ID is the ID number of the work item, if known, and 
attribute_name is the work item attribute you are interested in.

For example, an event handler parameter to verify that the ContactId attribute (a 
custom work item attribute) has a value may be defined as follows:

FilterSpec="[$GetWorkItemAttr(SiebelWorkItemID, ContactId)] IS NOT NULL"

For commands operating on the selected work item, you can also obtain work 
item attributes using @SelectedWorkItem:attribute_name.

For more information, see “Work Item Attributes” on page 208.

For more information about the SiebelWorkItemID attribute, see “Driver Event 
Attributes” on page 574.

■ $HotelingPhone. Retrieves an agent’s extension if the agent is using a hoteling 
teleset.

The field value is calculated at run time according to these rules:

■ Uses the login name of the currently selected agent (employee), or the name 
of a service request owner, to find the agent’s runtime extension, if the agent 
is using a hoteling teleset. In the first example below, “Login Name” would 
be the Login Name field of the current business component, which 
corresponds to the LOGIN column in the S_USER table.
200 Siebel Communications Server Administration Guide Version 7.5.3



Advanced Communications Configuration

Using Macro Expansion for Character Fields
■ If the extension is not found, $HotelingPhone retrieves the employee’s 
extension number from the S_USER table.

The following example parameter definition in a make-call command (command 
data definition) may generate the desired extension, based on the Login Name 
field:

Param.PhoneNumber="{$HotelingPhone(Login Name):Lookup}"

Or, the following example parameter definition for a make-call command may 
generate the desired extension, based on the Owner field. Use a parameter value 
like this for a command invoked when the current business component is 
Service Request, to call the owner of the current service request record.

Param.PhoneNumber="{$HotelingPhone(Owner):Lookup}"

For more information, see “Configuring Telesets for Hoteling” on page 217.

NOTE: The macro @HotelingPhone is still supported, for compatibility with 
version 6.x, but it is recommended that you use $HotelingPhone instead.

■ @Language. The language code applicable to the agent’s Siebel application 
session.

For example, the language code for U.S. English is “ENU”.

■ @Now. Returns the current timestamp, using the following format:

%month/%day/%Year %H:%M:%S

■ @Phone. Represents a phone number, whose value is calculated at run time 
according to these rules:

■ If the Phone # field in the communications toolbar has the focus and contains 
a value, @Phone is equal to the value of this field.

■ If the Phone # field has no value, but the currently active applet field is of the 
type DTYPE_PHONE, @Phone is equal to the value of this field.
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■ If the Phone # field has no value and the currently active field is not of the 
type DTYPE_PHONE, @Phone is equal to the value of the field referred to by 
the Primary Phone Field user property for the business component.

In all other cases, the @Phone macro contains no data.

For more information, see “Macro Expansion with Phone Numbers” on 
page 205.

■ @PrimaryQueueList. The list of ACD queues associated with the agent and 
designated as primary.

For example, a login command may include a parameter like this to identify 
which ACD queues to log the agent into:

Param.ACDQueue="{@PrimaryQueueList}"

The values are separated by commas.

■ @QueueId. The list of ACD queues associated with the agent and designated as 
primary.

NOTE: @PrimaryQueueList replaces @QueueId, but you can still use @QueueId 
for compatibility purposes.

■ @QueueList. The list of ACD queues associated with the agent.

This list includes all such queues, including those marked as primary and those 
not marked as primary. The values are separated by commas.

■ @Random. A string containing 10 random digits.

This macro may be used for testing purposes.

■ $RemoteConnectStr. Name of the remote call center. This macro, which can be 
used with transfers and conference calls between call centers, derives the name 
of a remote call center’s communications configuration from either:

■ The ConnectString configuration parameter (if defined), or
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■ The extension number of the agent to be called

For example, a command parameter in a transfer or conference command may 
generate the desired configuration name in this fashion:

Param.RemoteConnectStr="[$RemoteConnectStr(@Phone)]"

For more information, see “Configuring Remote Transfers and Conferences” on 
page 225.

■ $RemoteConnectStr2. Name of the remote call center. This macro, which can be 
used with transfers and conference calls between call centers, derives the name 
of a remote call center’s communications configuration from either:

■ The ConnectString configuration parameter (if defined), or

■ The employee ID of the agent to be called

For example, where the SelectBusObj and SelectBusComp parameters are set to 
“Employee,” a command parameter in a transfer or conference command may 
generate the desired configuration name in this fashion:

Param.RemoteConnectStr="[$RemoteConnectStr2(Id)]"

The Employee business component uses the Id field to uniquely identify an 
employee record. A command that references another business component 
might need to use another field name to uniquely identify a record.

For more information, see “Configuring Remote Transfers and Conferences” on 
page 225.

■ @SelectedDN. The currently selected extension in the Communications view in 
the User Preferences screen.

■ @SelectedQueue. The currently selected record in the ACD Queues list applet in 
the Communications view in the User Preferences screen.

■ @SelectedText. Text the user has selected in the browser, such as in a field in an 
applet within the Siebel application. The text could be used, for example, to 
provide a phone number to call or to provide some other input data for a 
command.
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■ @SelectedWorkItem. The item in the Work Items list in the communications 
toolbar that has the focus. (The item that had the focus just prior to this item is 
represented by the @DeselectedWorkItem macro.)

This macro must be specified with an attribute value, as follows:

@SelectedWorkItem:attribute_name

where attribute_name is the work item attribute you are providing.

For more information, see “Work Item Attributes” on page 208.

■ @UserId. Siebel login ID of the current Siebel user.

■ @UserName. Login name of the current Siebel user.

■ @WorkDuration. Length of time, in seconds, of the current work item—the time 
elapsed since the work item started.

■ @WorkObjectID. Row ID of the work-item tracking object that was transferred to 
the agent or that was created as a result of creating an event log and defining a 
value for the AfterWork event log parameter.

■ @WorkStartTime. Date and time (timestamp) when the work item arrived or was 
initiated. The timestamp is in the following format:

%month/%day/%year %H:%M:%S
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@Phone Macro Example
The example command and associated command data shown in Table 26 and 
Table 27 use the @Phone macro, and can be used to dial any phone field on any 
business component.

Macro Expansion with Phone Numbers
Macro expansion provides many options for retrieving and manipulating phone 
number data for use with communications events or commands. This section 
applies to event and command parameters only.

The macro @Phone is often used to retrieve a phone number; for a detailed 
description of this macro and its encoded logic, see “Macros for Parameter Values” 
on page 196. Alternatively, you can explicitly specify the name of a field from which 
to extract phone number data.

NOTE: When you work with phone number fields in event and command parameter 
definitions, you must be aware how phone number data is formatted in your 
deployment of the Siebel eBusiness Applications.

Table 26. Command: MakeCallToCurrentPhone

Parameter Name Parameter Value

Description Make Call to "{@Phone}"

DeviceCommand MakeCall

Hidden TRUE

Table 27. Command Data: MakeCallToCurrentPhone

Parameter Name Parameter Value

AttachContext TRUE

Param.CallNotifyText Call from {@UserName}...

Param.PhoneNumber {@Phone:PhoneTypeLookup}

RequiredField.@Phone ?*
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For information about phone number formatting, including formatting for 
international numbers, refer to Applications Administration Guide.

You can use the following special macro-expansion features when retrieving phone 
number data:

■ A keyword to specify how to apply dialing filters to the field value. See 
“Keywords to Specify Dialing-Filter Behavior” on page 206.

■ A keyword to indicate the part of the phone number that you want to extract. 
See “Keywords to Extract Part of a Phone Number” on page 207.

■ A specific range of numerals to extract from the field value. See “Numeric 
Ranges to Extract” on page 208.

Keywords to Specify Dialing-Filter Behavior
Follow the field name with a colon (:) and one of the following keywords to specify 
whether to filter the field data using dialing filter rules specified using 
DialingFilter.RuleN configuration parameters. Dialing filters are applied in numeric 
sequence until a match is found.

Dialing filter rules allow you to perform an intelligent translation of a phone 
number, in order to optimize dialing. The macro $DialingRuleMethod can be used 
within a dialing filter rule definition to invoke a business service method to specify 
custom logic in the application of the dialing filter rule to the results.

You can use the following keywords with either the @Phone macro or a field whose 
name you explicitly specify.

■ Lookup. Applies the dialing filters to the field data.

You can use Lookup with fields that you know to contain phone number data 
that can be successfully filtered with your dialing filters.

■ PhoneTypeLookup. Checks if a field is of type DTYPE_PHONE (as defined in Siebel 
Tools). If it is of this type, the dialing filters are applied to the field data. If it is 
not of this type, the dialing filters are not applied to the field data.

CAUTION: Do not modify the type for any field defined as DTYPE_PHONE, or phone 
number data will not be correctly handled in your application.
206 Siebel Communications Server Administration Guide Version 7.5.3



Advanced Communications Configuration

Using Macro Expansion for Character Fields
For examples, see “Macro-Expansion Examples” on page 212. For more information 
about DialingFilter.RuleN configuration parameters, see “Specifying Parameters for 
Communications Configurations” on page 80.

Keywords to Extract Part of a Phone Number
Follow a field name with a colon (:) and one of the following keywords to specify 
the portion of the phone number field to be extracted and substituted. You can use 
these keywords only with fields of type DTYPE_PHONE. If none of these keywords 
is specified after a field name, then the phone number from the field corresponds 
to IntlNumber. IntlNumber may also be specified explicitly.

NOTE: In the keyword descriptions below, references to the country code do not 
include the “+” character. The “+” is included only in the value for IntlNumber, 
when this keyword represents an international number.

■ IntlNumber. Represents one of the following:

■ If the country code for the number matches the current locale for the Siebel 
Server (Application Object Manager): represents the domestic phone number 
(number without the country code or extension).

■ If the country code for the number does not match the current locale for the 
Siebel Server (Application Object Manager): represents the international 
phone number (“+” and country code and number, without the extension).

■ Digits. The full phone number as stored in the database field (country code, 
phone number, and extension).

■ Country. The country code only (without the phone number or extension).

■ Number. The phone number only (without the country code or extension).

■ Extension. The phone number extension only (without the country code and 
phone number). This keyword is applicable when the phone number field 
contains an extension number prefaced with an “x” or another localized 
character).
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Numeric Ranges to Extract
Follow the field name or a keyword with a colon (:) and a range of numerals to be 
extracted from the field value. A substring numeric range can be specified directly 
after the field name or after a keyword indicating the part of the phone number.

Primary Phone Field User Property in Business Components
Any business component can have a named user property called Primary Phone 
Field. The property value is the field name of the same business component that 
contains the phone number and that should be dialed when a make-call command 
is invoked on an applet that uses this business component.

For example, the Account business component can have a Primary Phone Field user 
property set to the value Main Phone Number. This tells Communications Server 
that Main Phone Number is the field that should be dialed by default when dialing 
is requested on an account.

Under certain circumstances, the value of the @Phone macro is equal to the field 
designated as the Primary Phone Field.

For more information about specifying user properties, refer to Siebel Tools 
Reference and Siebel Tools Online Help.

Work Item Attributes
Table 28 on page 209 describes work item attributes that can be specified in values 
for parameters that support macro expansion. Communications events and 
commands can reference these attributes as subparameters of the parameter Param, 
or as elements within other parameter values where macro expansion is supported. 
The following macros, when used in parameter values, can process these attributes: 
@SelectedWorkItem, @DeselectedWorkItem, and $GetWorkItemAttr.

In addition, custom work item attributes can be stored and updated by using the 
WorkTrackingObj parameter in event log or command data definition. Database 
records that store work item attributes can be updated after work items are released, 
by using the AfterWork event log parameter. (The WorkObject event response 
parameter can also be used to update database records for tracking work items.)

For example, if an event log includes a parameter definition like the following, then 
“ContactId” becomes a custom work item attribute that is available for use 
wherever work item attributes can be accessed. For example, commands that 
update the customer dashboard can access such attribute values.
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WorkTrackingObj.ContactId="{Contact.Id}"

Or, if an event log includes a parameter definition like the following, then text you 
specify is displayed in the Work Items list in the communications toolbar.

WorkTrackingObj.Description="your descriptive text goes here"

NOTE: Of the predefined work item attributes described in Table 28 on page 209, 
only ParentWorkItemID and Description can be updated.

For more information about the WorkTrackingObj and AfterWork event log 
parameters, see “Event Logs” on page 168. For more information about the 
WorkTrackingObj command data parameter, see “Command Data” on page 186. For 
more information about the WorkObject event response parameter, see “Event 
Responses” on page 154.

For additional attributes that can be specified in event handlers, see “Driver Event 
Attributes” on page 574.

Table 28. Work Item Attributes

Attribute Name Description

ChannelType The language-independent value representing the channel type of this work item.

ChannelTypeLocale The locale-dependent value for the channel type of this work item.

Description A description of this work item. The value for this attribute comes primarily from 
the client handle methods WorkItemStarted and IndicateNewWorkItem. For more 
information, see Appendix D, “Developing a Communications Driver.”

DriverWorkTrackID The ID number of this work item as tracked by the driver.

IsTransferred Indicates whether the work item has been transferred using Siebel Universal 
Queuing. Possible values are TRUE or FALSE (the default is FALSE).

If the value is TRUE, then the Reject button on the Accept/Reject dialog box is 
disabled. This dialog box allows an agent to accept or reject a work item.
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IsRevoked Indicates whether the work item has been rejected by an agent (using the Accept/
Reject dialog box) or has been taken back by Siebel Universal Queuing. Possible 
values are TRUE or FALSE (the default is FALSE).

This attribute is TRUE whenever the service handle method 
RevokeQueuedWorkItem has been invoked for the work item.

ParentWorkItemID The ID number of the parent of this work item. Note the following behavior for 
parent and child work items:

■ When a parent work item is released, all child work items are released.

■ When a parent work item is suspended, all child work items are suspended.

■ When a parent work item is resumed, all child work items are resumed.

■ When a child work item is started or resumed, the parent work item gains the 
focus.

■ Agent can use the Work Items list in the communications toolbar to select a 
child work item and operate on this child work item individually.

■ Parent and child work items can be of different channels, such as when an 
outbound voice call is placed to a customer who initiated an email work item.

Refer to the sample communications configurations provided by Siebel Systems for 
examples.

ProfileName The communications driver profile for which this work item is applicable.

UQWorkItemID The ID number of this work item from Siebel Universal Queuing, if this work item 
was originally assigned by Siebel Universal Queuing.

ViewBookmark The bookmark for the view which was current when this work item was 
suspended. The bookmark data is serialized and compressed into a string.

WorkDuration The duration of this work item.

The value is the same as the @WorkDuration macro.

WorkItemID The ID number of this work item.

WorkObjectID The work tracking object ID number.

The value is the same as the @WorkObjectID macro.

Table 28. Work Item Attributes

Attribute Name Description
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WorkStartTime The start time of this work item.

The value is the same as the @WorkStartTime macro.

The value for this attribute comes primarily from the client handle method 
WorkItemStarted. For more information, see Appendix D, “Developing a 
Communications Driver.”

WorkState The state of this work item. Possible values are Created, Active, Suspended, and 
Released. The value for this attribute comes primarily from client handle methods.

■ When IndicateNewWorkItem is invoked, the WorkState value is Created.

■ When WorkItemStarted is invoked, the WorkState value is Active.

■ When WorkItemSuspended is invoked, the WorkState value is Suspended.

■ When WorkItemResumed is invoked, the WorkState value is Active.

■ When WorkItemReleased is invoked, the WorkState value is Released.

For more information, see Appendix D, “Developing a Communications Driver.”

Table 28. Work Item Attributes

Attribute Name Description
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Macro-Expansion Examples
The examples in Table 29 demonstrate macro-expansion usage. From the nominal 
parameter value shown in the second column, macro expansion calculates the 
resulting value shown in the third column. Each example is explained to show how 
the result was generated.

Table 29. Macro-Expansion Examples

Parameter Name Parameter Value Result Explanation

Param.PhoneNumber #8[Phone #:7-10] #85000 If the value of the Phone # field in 
the current business component is 
6504775000, macro expansion 
extracts the seventh through tenth 
digits of the phone number. The 
characters “#8” prefix the result.

Because no keyword is specified, 
the Number part is assumed, and 
the country code and extension are 
excluded.

Because the macro-expansion 
characters representing the phone 
number are enclosed in brackets, 
this Phone # field could be in a 
dialog box or in the current 
business component.

Param.PhoneNumber {Phone #:Number:6-10} 75000 Assume the same value for the 
Phone # field as in the previous 
example. Macro expansion extracts 
the sixth through tenth digits of the 
phone number.

In this example, the Number 
keyword is explicitly specified.

Because the macro-expansion 
characters representing the phone 
number are enclosed in curly 
braces, this Phone # field could not 
be in a dialog box.
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Param.GetId {Id} 10-CSAE If the Id field for a record in the 
current business component is 
10-CSAE, macro expansion yields 
this string as the result.

Param.Greet \{Hi\} {Hi} The backslashes escape the curly 
brace characters, allowing them to 
be included literally as part of the 
result. Because “Hi” is not 
enclosed in curly braces, it is not 
interpreted as a field name.

Param.ExtField {Extension} 5000 For a field called Extension, macro 
expansion extracts the value of this 
field—for example, 5000.

Because the Extension field is not 
of type DTYPE_PHONE, you 
cannot use keywords to specify a 
phone number part to extract.

Param.Ext {Work Phone #:Extension} 6000 If the value of the Work Phone # 
field of the current business 
component (for example, Contacts) 
is (650)4775000 x6000 for a U.S. 
phone number and extension, only 
the extension number after the “x” 
is extracted.

Param.PhoneNumber {Work Phone #:Lookup} phone_num Macro expansion generates a 
phone number based on applying 
the dialing filters to the data in the 
Work Phone # field of the current 
business component.

Param.PhoneNumber {@Phone:PhoneTypeLookup} phone_num Macro expansion generates a 
phone number based on the logic 
described for the @Phone macro, 
in “Macros for Parameter Values” 
on page 196.

Dialing filters are applied only if a 
field is of type DTYPE_PHONE.

Table 29. Macro-Expansion Examples

Parameter Name Parameter Value Result Explanation
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Working with Dialing Filters
Dialing filters are used by the Siebel application to manipulate telephone numbers 
for voice calls made, transferred, or conferenced.

Dialing filters specify a set of phone-number translation rules that are invoked when 
the Lookup or PhoneTypeLookup keyword is specified in macro-expanded text in a 
communications command for the voice channel (using Siebel CTI). Dialing filters 
are defined as configuration parameters in the All Configurations view in the 
Communications Administration screen. 

In each of the examples in this section, the first set of numbers is searched for. If 
there is a match, the searched numbers are translated to the numbers after the -> 
symbols. 

Filter rules are checked for matches in numerical sequence. The last rule in the 
sequence should always be defined to match any number.

The numeric elements in the names of the filter rule parameters are applied by 
string comparison, from small to large. For example, this means that a dialing filter 
named DialingFilter.Rule11 will be applied before one named DialingFilter.Rule2. 
Consequently, you should use the same number of digits for each rule, according to 
your total anticipated number of rules. For example, the numeric elements in the 
filter rules could use a sequence starting with 000, followed by 001, and so on, up 
to 999.

NOTE: How dialing filters actually function is subject to the command data definition 
for the command that is performing the make-call operation. 

By default, the Lookup and PhoneTypeLookup keywords used in command data 
definitions do the following:

■ Treat a phone number as domestic (that is, omit the country code) if the country 
code matches the current locale.

■ Treat a phone number as international (that is, include the country code) if the 
country code does not match the current locale.
214 Siebel Communications Server Administration Guide Version 7.5.3



Advanced Communications Configuration

Working with Dialing Filters
For CTI implementations supporting multiple call centers, dialing filter 
requirements should be considered among the factors in deciding how to organize 
your agents in communications configurations. You may decide, for example, to 
ensure that all agents included in a single configuration are located within a single 
location for which the same set of dialing filters will apply. For example, this 
grouping may be defined as a particular call center facility, or a particular locale 
corresponding to a country code.

For more information about configuration parameters, including 
DialingFilter.RuleN, see “Specifying Parameters for Communications 
Configurations” on page 80.

For more information about the Lookup and PhoneTypeLookup keywords, 
keywords to represent parts of phone numbers, phone-number formatting, and the 
$DialingRuleMethod macro, see “Using Macro Expansion for Character Fields” on 
page 195.

For more information about international telephone numbers, refer to Applications 
Administration Guide.

Dialing Filter Examples
The following are examples of dialing filter rules:

■ DialingFilter.Rule001=“650477->” – This rule takes a ten-digit domestic phone 
number (for example) and translates it into four digits for dialing an internal 
extension. 

You can use such a rule for internal calls, call transfers, or call conferences, 
where, for example, the U.S. area code 650 and prefix 477 apply to the call 
center. Or use such a rule for calls, transfers, or conferences to another call 
center, where this area code and prefix apply to the destination call center. For 
more information, see “Configuring Remote Transfers and Conferences” on 
page 225.

■ DialingFilter.Rule002=“650->9” – This rule takes a ten-digit domestic phone 
number (for example) and translates it into eight digits for dialing an outside 
local call in the U.S.
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■ DialingFilter.Rule003=“+33->901133” – This rule takes a French phone 
number (any number for which the country code is 33, when the current locale 
is not France) and prefaces it with the digits that are required for dialing an 
international number when your locale is the U.S. or Canada.

■ DialingFilter.Rule004=“+->9011” – This rule takes any international phone 
number (that is, any number for which the country code does not match the 
current locale) and prefaces it with the digits required for dialing an 
international number when your locale is the U.S. or Canada. 

■ DialingFilter.Rule005=“->91” – This rule takes any domestic phone number 
(that is, any number that did not match the preceding rule) and prefaces it with 
the digits required for dialing an outside call to another area code in the U.S.

For the preceding examples:

■ If a telephone number matches 650477****, then Rule001 will be applied.

■ If the number does not match this pattern, but matches 650*******, then 
Rule002 will be applied. 

■ If the number does not match this pattern, but matches a French number (when 
the current locale is not France), then Rule003 will be applied.

■ If the number does not match this pattern, but matches any international 
number (for which the country code does not match the current locale), then 
Rule004 will be applied.

■ If the number does not match any of these patterns, then Rule005 will be 
applied. As noted, the last defined rule should match any number.

The following example is an alternative definition for DialingFilter.Rule002.

■ DialingFilter.Rule002=“650->$DialingRuleMethod(service.method)” – This rule 
takes a ten-digit domestic phone number (for example) and translates it into a 
number that is determined by the specified business service method. You can 
use such a rule to invoke a method that will provide a correct phone number to 
dial, where other filter rules may not be able to filter unambiguously. 

For example, if internal numbers use a prefix, such as 477, that is also used 
outside the company, the business service invoked using this macro can 
determine the correct number to dial by identifying the specific number as 
internal or external.
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The following example is an alternative definition for DialingFilter.Rule004.

■ DialingFilter.Rule004=“+->$DialingRuleMethod(service.method)” – This rule 
takes an international phone number and translates it into a number that is 
determined by the specified business service method.

Configuring Telesets for Hoteling
You can configure the telesets in your call center for hoteling, which allows an agent 
to log into the Siebel application from any one of a pool of telesets and computers 
that have been configured for this purpose, and to be able to use voice 
communications features.

You configure hoteling by associating a teleset with the host name of the computer 
that is located at the same station as the teleset. Do this in the All Telesets view in 
the Communications Administration screen.

For instructions for configuring telesets, see “Specifying Telesets” on page 94.

When you have specified a host name to enable hoteling for a teleset, any agent 
logging into the Siebel client on the hoteling computer will use the standard 
extension of the hoteling teleset that is associated with that computer’s host name.

Hoteling Requirements and Issues
Note the following requirements and issues for implementing hoteling:

■ In order for multiple call-center agents to be able to log into one computer, the 
computer or browser may need to be prepared for this purpose, for instance by 
creating Windows profiles for all hoteling users. For instructions for such tasks, 
refer to your computer system documentation.

■ After each agent is added to the communications configuration, the agent can 
then be associated with a teleset. Associating a host name with a teleset 
overrides any such association of the teleset with an agent.

■ If an agent logs into the Siebel application on a computer that is not associated 
with a hoteling teleset, voice communications are enabled for the agent only if 
that agent is explicitly associated with the teleset at the new location.
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■ Hoteling can be configured only for computers that are always expected to be 
located at the same station as the hoteling teleset. A laptop computer that an 
agent connects to the network at any of several locations, for example, can be 
configured for hoteling only for a single location where a particular teleset is 
located.

■ Agents who log into a hoteling computer cannot specify any other teleset in the 
Communications tab of the User Preferences screen. The agent can specify a 
different extension for this teleset, however, if more than one extension is 
defined.

■ Commands for internal calls to employees who are using hoteling telesets can 
be configured to retrieve the runtime extension of the employee by using the 
$HotelingPhone macro. For more information, see “Macros for Parameter 
Values” on page 196.

Supporting Multitenancy
Siebel Communications Server supports the multiple-organization feature in the 
Siebel eBusiness Applications. This feature, called multitenancy for call centers, 
helps provide the contact center, including those supporting multiple channels, 
with flexibility to organize its work and agent resources and to control visibility of 
data.

Contact centers that provide outsource services to other companies, or to multiple 
internal entities, can support these multiple entities using multitenancy. 

In an outsource contact center, agents with expertise supporting products or 
services from Company A, for example, would be assigned positions in the 
organization defined for Company A, while agents supporting Company B would be 
assigned positions in the organization defined for Company B.

Agents can be assigned to multiple positions in multiple organizations, according to 
their expertise and the contact center’s operational requirements.

For more information about positions, responsibilities, and organization visibility 
for Siebel applications, refer to Security Guide for Siebel eBusiness Applications and 
Applications Administration Guide.
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Organization Visibility and Positions
Some Siebel data records can be viewed only by users whose current position is 
within a particular organization. Other records are visible to users whose positions 
are in different organizations. Records may be associated with one or more 
organizations.

Each user can have only one position active at a time. In some situations, a user 
may be allowed to see data for all of that user’s assigned positions.

Organization visibility is defined for both business components and views.

Organization Visibility for Business Components
Organization visibility is defined for each business component, determining which 
of the following applies to the business component:

■ Visibility is for one organization.

■ Visibility is for multiple organizations.

■ Organization visibility does not apply.

A business component for which organization visibility applies is said to be 
position-dependent.

Organization Visibility for Views
Organization visibility is enforced for each view. Multiple views that display data 
for the same business component may enforce visibility differently. For example, in 
the Contacts screen, the All Contacts view allows a user to view contact records 
within one organization, while the All Contacts across Organizations view (not 
available for all users) allows a user to view all contact records for all organizations.

You can determine whether a view enforces organization visibility by using Siebel 
Tools. For each view object definition:

■ Organization visibility is enforced for the view if the field Visibility Applet Type 
is set to Organization and the field Admin Mode Flag is not checked (FALSE).

■ Organization visibility is not enforced for the view if the field Admin Mode Flag 
is checked (TRUE).
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Changing Position Manually or Automatically
For the agent to view some data, such as for certain screen pops, the agent’s 
position must be changed, either manually or automatically. At any time, an agent 
can manually change the current position in the Siebel application by using the 
Change Position view in the User Preferences screen.

If the agent is the recipient of a screen pop for an incoming or transferred work item 
or a conference call, the agent’s position is changed automatically, as appropriate 
for the context and for the screen-pop data. When an agent retrieves a paused work 
item, the original screen pop and position are both restored. As described earlier, 
the business component determines the organization visibility for the screen-pop 
data, enabling the agent’s position to be changed, as necessary.

What screen-pop data to display is determined by the current business component, 
which is specified in the QueryBusComp parameter in the event response. See also 
“Event Responses” on page 154.

After an agent’s position has been automatically changed, when a work item is 
concluded, the agent’s position remains what it was changed to. The agent must 
manually change the position again if the new current position is not appropriate.

Scenarios for Generating Screen Pops and Changing Position
Application behavior for generating screen pops and changing positions varies for 
each of the scenarios described below. When a position is changed, a message is 
displayed to the user. If the position is not changed, no message appears, except in 
certain error conditions.

■ If the agent’s current position matches the screen-pop data, the screen pop is 
displayed and the agent’s position is not changed.

■ If the agent’s current position does not match the screen-pop data, and the agent 
has one other position that matches the data, the screen pop is displayed and 
the agent’s position is changed.
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■ If the agent’s current position does not match the screen-pop data, and the agent 
has more than one position that matches the data, the screen pop is displayed. 
The agent’s position is changed to the first position that matches the data, and 
the agent is allowed to view all data that is defined to be visible for all the agent’s 
assigned positions.

The Siebel client allows the agent to view this data by using the VIEW_ALL 
mode, which ignores organization-visibility rules. A message advises the agent 
to manually change to a position appropriate for the screen-pop data, so that the 
agent can subsequently navigate to related records without hindrance.

■ If the agent does not have a position that allows the agent visibility to the screen-
pop data, no screen pop will be displayed.

NOTE: Routing inbound work items using Siebel Universal Queuing should take 
into account the way organizations and positions are defined for your company. 
This way, you can make sure that a screen pop can always be displayed for an 
incoming work item.

■ If the business component for a view does not have enough data to determine 
organization visibility, the screen pop will occur without restriction. The 
position will not be changed. No error message will be displayed.

■ Organization-visibility rules for screen pops apply to inbound work items and to 
transfers and conferences between contact-center users. For inbound work 
items, the Siebel application always attempts to set the user’s position 
automatically. For transfers and conferences, the position is set only if the 
screen-pop view enforces organization visibility.

■ When a view has no records displayed, organization-visibility rules do not apply 
for screen pops for call transfers or conferences.

■ When organization visibility is not enforced for a view, organization-visibility 
rules are not used when changing an agent’s position.
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■ Multitenancy affects screen pops differently for different views. Siebel 
application developers, contact-center managers, and end users need to 
understand how this issue relates to screen pops.

Some views, such as administration views, do not have organization-visibility 
rules. Some views, such as views whose names include the phrase “Across 
Organizations,” allow users to view records for multiple organizations. 
Organization-visibility rules are applied to screen pops according to the business 
component data. You should verify organization-visibility behavior, changing 
position manually as needed, for the views involved in your screen pops.

Setting the MultiTenancy Configuration Parameter
The Siebel Communications Server configuration parameter MultiTenancy allows 
you to specify whether or not organization-visibility rules should apply.

■ Set this parameter to TRUE if your Siebel implementation uses multitenancy. The 
parameter is set to TRUE by default.

■ Set this parameter to FALSE if your Siebel implementation does not use 
multitenancy.

For more information, see “Specifying Parameters for Communications 
Configurations” on page 80.

Configuring Communications Login and Logout
Agents can log into call-center communications systems that work with Siebel 
Communications Server, either automatically or manually. See the following for 
more information about login issues:

■ For end user login procedures, see “Using the Communications Toolbar” on 
page 352.

■ For a description of logging into selected ACD queues, and of the end user 
preference Auto Login to Call Center at Startup (in Communications tab in User 
Preferences), see “Setting Communications User Preferences” on page 339.
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■ For descriptions of the configuration parameters AutoLogin, AutoLoginCmd, 
PreferenceLoginCmd, and PreferenceLogoutCmd, see “Specifying Parameters for 
Communications Configurations” on page 80.

■ For a descriptions of the Dialogic CTI driver parameter Service:AutoLogout (for 
Siebel CTI Connect), see “Siebel CTI Connect Driver Parameters” on page 457.

Login and Logout Command Configuration
This section documents the command and command data definitions from a Siebel-
provided communications configuration file (.def), that determine the availability 
of login and logout functions for the communications toolbar and for menus.

■ For more information about all command and command data parameters shown 
below, see Chapter 4, “Configuring Events and Commands.”

■ For more information about configuring the communications toolbar and 
communications menu items, see Chapter 6, “Configuring User Interface 
Elements.”

■ For more information about macros such as @PrimaryQueueList, 
@UQAgentLogon, and so on, see “Macros for Parameter Values” on page 196.

In the commands below, SignOnGroup and SignOnGroupInMenu both specify the 
same set of subcommands, which control login and logout functionality in the 
communications toolbar and in the Communications submenu of the View 
application-level menu, respectively.

[Command:SignOnGroup]
Hidden = "TRUE"
Description = "Log in"
ExecuteAll = "TRUE"
SubCommand_1 = "LoginToPBX"
SubCommand_3 = "LoginToUQ"

[Command:SignOnGroupInMenu]
MenuPosition = "20"
Title = "Log In"
Description = "Log in"
SubCommand_1 = "LoginToPBX"
SubCommand_3 = "LoginToUQ"
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[Command:LoginToPBX]
MenuPosition = "20.1"
Title = "Log In (Phone)"
DeviceCommand = "LogIn"
CmdData = "LoginToPBX"

[CmdData:LoginToPBX]
Param.ACDQueue = "{@PrimaryQueueList}"
Param.AgentId = "{@AgentId}"
Param.AgentPin = "{@AgentPin}"

[Command:LoginToUQ]
MenuPosition = "20.3"
Title = "Log In (Universal Queuing)"
DeviceCommand = "@UQAgentLogon"

Automatic and Manual Login
This section provides a brief overview of the automatic and manual login 
capabilities provided for communications-enabled Siebel applications.

Automatic Login
With automatic login, after starting the Siebel application, the end user is 
automatically logged into all applicable communications systems. Auto-login can be 
enabled or disabled for all users. Or, administrators can allow each user to specify 
whether to log in automatically.

When auto-login is in effect, using the Connect command in the File application-
level menu in order to log into a different Siebel database, or in order to change the 
Siebel login you are using, logs you out of the communications systems and then 
automatically logs you in again.

Agents who use ACD queues can manually log into or out of any of the queues with 
which they are associated. Agents do this in the Communications view in the User 
Preferences screen.

Manual Login
With manual login, after starting the Siebel application, the end user clicks the 
Log In button on the communications toolbar in order to log into the applicable 
communications systems. Auto-login must be disabled for all users or for the 
individual user.
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When manual login is in effect, using the Connect command in the File application-
level menu in order to log into a different Siebel database, or in order to change the 
Siebel login you are using, logs you out of all applicable communications systems 
and you must log in again manually.

Agents who use ACD queues can manually log into or out of any of the queues with 
which they are associated. Agents do this in the Communications view in the User 
Preferences screen.

Configuring Remote Transfers and Conferences
You can configure Siebel Communications Server to allow agents to initiate, 
transfer, and conference voice calls between call centers—with attached data to 
support screen pops. This capability is supported for Siebel CTI Connect (using Intel 
NetMerge) and may also apply to other middleware.

NOTE: For Intel NetMerge, the Call Information Manager server connected to each 
switch must be configured for multisite operation. For more information, refer to 
the Intel NetMerge document Call Information Manager User’s Guide.

Follow the additional guidelines in this section to implement this functionality.

Creating Communications Configurations
You must create separate communications configurations for each call center. For 
example, for call centers in San Mateo and Emeryville, create a configuration called 
San Mateo and a configuration called Emeryville.
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Each configuration must define the agents applicable to that physical call center. All 
configurations must exist in the Siebel database at all call centers. In the example, 
both the San Mateo and Emeryville configurations would exist at both call centers.

NOTE: Session-based communications functionality, such as Siebel CTI, is supported 
only for single-database environments. Session communications capability is not 
supported for users of a regional database, to which data is replicated using Siebel 
Replication Manager.

Specifying Dialing Filters
Each communications configuration must contain configuration parameters 
specifying dialing filters, in order to support dialing for both locations. These 
parameters may have names such as DialingFilter.Rule1, DialingFilter.Rule2, and so 
on. For more information, see “Specifying Parameters for Communications 
Configurations” on page 80.

For example, assume that you are configuring communications between two call 
centers located in the U.S. The San Mateo call center is located in area code 650 and 
has exclusive use of the prefix 477. The Emeryville call center is located in area code 
510 and has exclusive use of the prefix 788. Five-digit dialing is supported between 
these call centers.

With dialing filters such as the examples shown in Table 30, phone numbers for call 
transfers and call conferences initiated from Siebel Communications Server from 
either site to the other site (or internal to one site) are converted from ten-digit 
numbers, as they are stored in the Siebel database, to four-digit numbers, then 
prepended with a numeral such as “1” or “2” for five-digit dialing.

Table 30. Dialing Filter Examples

Parameter Name Parameter Value

DialingFilter.Rule1 510788->1

DialingFilter.Rule2 650477->2
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In these examples, the resulting five-digit numbers would match extensions defined 
(with the same number of digits) in the organization’s switches and match the 
extensions defined in the Communications Administration screen.

The macro $DialingRuleMethod can help you to implement advanced logic for your 
dialing filters. For details, see “Macros for Parameter Values” on page 196.

Using Macros to Identify Remote Call Centers
This section describes how you can use parameters to obtain a call center 
configuration name.

In the communications configurations for San Mateo and Emeryville, you would 
add a command parameter like one of the examples below to the command data 
definition for any applicable commands—such as commands used for initiating a 
call transfer or conference call to another call center.

The command data parameter Param.RemoteConnectStr can include one of two 
related macros in its parameter value in order to obtain the desired configuration 
name. For more information, see “Macros for Parameter Values” on page 196.

■ $RemoteConnectStr. This macro derives the name of a remote call center’s 
communications configuration, using the agent’s extension number as a 
parameter. Table 31 shows examples:

Table 31. $RemoteConnectStr Examples

Parameter Name Parameter Value

Param.RemoteConnectStr [$RemoteConnectStr(@Phone)]

Param.RemoteConnectStr {$RemoteConnectStr(Owner Phone:Lookup)}
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■ $RemoteConnectStr2. This macro derives the name of a remote call center’s 
communications configuration, using the agent’s employee ID as a parameter.

For example, where the Employee business object and business component are 
specified, the parameter definition uses the business component field Id to get 
the name of the configuration. Table 32 shows an example:

Example Command Using $RemoteConnectStr
The example command and command data definitions shown in Table 33 on 
page 228 and Table 34 on page 228, using the $RemoteConnectStr macro, use the 
Owner Phone field in the Service Request business component to determine which 
call center has the phone number.

In this example, the Param.RemoteConnectStr command parameter gets the 
extension number for the call recipient by macro-expanding Owner Phone:Lookup. 
The Siebel application looks up which configuration has this extension and returns 
the name of the call center with this extension.

Table 32. $RemoteConnectStr2 Example

Parameter Name Parameter Value

Param.RemoteConnectStr [$RemoteConnectStr2(Id)]

Table 33. Command: BlindTransferToSROwner

Parameter Name Parameter Value

Description Blind Transfer to Service Request Owner

DeviceCommand TransferMute

Hidden TRUE

Table 34. Command Data: BlindTransferToSROwner

Parameter Name Parameter Value

BusComp Service Request

RequiredField.'Owner Phone' ?*
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Using Device Event to Enhance Screen Pop Performance
The Dialogic CTI communications driver, used as part of Siebel CTI Connect (based 
on Intel NetMerge), includes an event that provides a way to enhance CTI screen 
pop performance for your call center agents.

The EventAnswerCall event is triggered whenever the AnswerCall device command 
is invoked by the Dialogic CTI driver, such as when an agent answers a call using 
the communications toolbar. 

To use this feature, create an event handler definition in your communications 
configuration that is based on the EventAnswerCall device event. This event 
handler invokes an event response that generates a screen pop and invokes the 
appropriate event logs.

The EventAnswerCall event occurs after the driver sends the AnswerCall command, 
but before the Siebel CTI Connect middleware sends the corresponding 
TpAnswered event. In this manner, extra time is available in which to generate the 
screen pop.

The event handler definition using EventAnswerCall causes the screen pop to be 
generated for the agent upon answering the call from the communications toolbar. 
This screen pop may occur before the call is actually connected. Event logging 
should still be based on the TpAnswered device event. See “Event Examples for 
Agents Answering Call from Communications Toolbar” on page 230.

Param.PhoneNumber {Owner Phone:Lookup}

AttachContext TRUE

Param.CallNotifyText Blind transfer from {@UserName} about SR {Id}...

Param.RemoteConnectStr {$RemoteConnectStr(Owner Phone:Lookup)}

(In this example, Owner Phone is a field from the Service 
Request business component.)

Table 34. Command Data: BlindTransferToSROwner

Parameter Name Parameter Value
Version 7.5.3 Siebel Communications Server Administration Guide 229



Advanced Communications Configuration

Using Device Event to Enhance Screen Pop Performance
For the case where the agent answers the call from the physical teleset instead of 
the communications toolbar, do not use the EventAnswerCall event. Instead, both 
the screen pop and event logging should be based on the TpAnswered device event. 
See “Event Examples for Agents Answering Call From Teleset” on page 231.

For additional information about handling inbound calls, see “Handling an Inbound 
Call Received by an Agent” on page 152.

Dependency for Multiple Event Handlers
With this feature, it is possible to configure event handlers where the completion of 
one event handler is dependent on the completion of another event handler. 
(Otherwise, the execution of event handlers is independent.)

For example, your call center may require an automatic call-answering function, 
such as to invoke the AnswerCall command using a script initially invoked by the 
InboundCall event handler.

As described, the AnswerCall command invokes the EventAnswerCall event. If you 
have defined an event handler to be triggered by EventAnswerCall, then your 
original InboundCall event handler will not complete until the EventAnswerCall 
event handler has completed. If the EventAnswerCall event handler performs some 
lengthy operation (such as to invoke another script), then it will delay completion 
of the InboundCall event handler from which the initial script was invoked.

Event Examples for Agents Answering Call from Communications Toolbar
The following examples show event handler, event response, and event log 
definitions based on receiving the EventAnswerCall device event. Use examples like 
these for when the agent answers the call using the communications toolbar:

[EventHandler:AnswerCallReceived]
DeviceEvent = "EventAnswerCall"
Response = "OnAnswerCallReceived"
Filter.ANI = "*"
Order = "1"

[EventResponse:OnAnswerCallReceived]
QueryBusObj = "Contact"
QueryBusComp = "Contact"
QuerySpec = "'Work Phone #'='{ANI}'"
SingleView = "Service Contact Detail View"
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MultiView = "Visible Contact List View"
FindDialog = "Service Request"
FindField.CSN = "Ask Caller"
Log = "LogIncomingCallContactAnswerCall"

[EventLog:LogIncomingCallContactAnswerCall] 
WorkTrackingObj.PopView = "YES"

[EventHandler:InboundCallReceived-no-pop]
DeviceEvent = "TpAnswered"
Response = "InboundCallReceived-no-pop"
Filter.ANI = "*"
FilterSpec = "[$GetWorkItemAttr(SiebelWorkItemID, PopView)] = 

'YES'"
Order = "2"

[EventResponse:InboundCallReceived-no-pop]
QueryBusObj = "Contact"
QueryBusComp = "Contact"
QuerySpec = "'Work Phone #'='{ANI}'"
SingleLog = "LogIncomingCallContactFound"
MultiLog = "LogIncomingCallMultiContactFound"
Log = "LogIncomingCallContactNotFound"

Event Examples for Agents Answering Call From Teleset
The following examples show event handler and event response definitions based 
on receiving the TpAnswered device event. Use examples like these for when the 
agent answers the call using the physical teleset:

[EventHandler:InboundCallReceived-pop]
DeviceEvent = "TpAnswered"
Response = "InboundCallReceived-pop"
Filter.ANI = "*"
Order = "3"

[EventResponse:InboundCallReceived-pop]
QueryBusObj = "Contact"
QueryBusComp = "Contact"
QuerySpec = "'Work Phone #'='{ANI}'"
SingleView = "Service Contact Detail View"
MultiView = "All Contacts across Organizations"
FindDialog = "Service Request"
FindField.CSN = "Ask Caller"
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SingleLog = "LogIncomingCallContactFound"
MultiLog = "LogIncomingCallMultiContactFound"
Log = "LogIncomingCallContactNotFound"

Using Push Keep Alive Driver for Session Connections
The Push Keep Alive communications driver provides a heartbeat message that is 
useful in maintaining connections for your communications sessions in some 
environments. You use this driver with Communications Session Manager, such as 
when you are using Siebel CTI, or using Siebel eMail Response with Siebel Universal 
Queuing.

The Push Keep Alive driver helps to solve problems that may be experienced in 
some environments, where push communications sessions between the Application 
Object Manager and a user’s Web browser are sometimes dropped. A connection 
may be dropped if messages have not been pushed to an agent for a particular 
length of time.

The Push Keep Alive driver sends a heartbeat message to the Application Object 
Manager, and each agent user’s browser, at a regular interval. This heartbeat 
message allows the push connection applicable to each agent’s communications 
toolbar not to be dropped in such cases. The heartbeat interval is specified using a 
driver parameter.

NOTE: When you use the Push Keep Alive driver, you must also set the 
ChannelCleanupTimer configuration parameter, in order to make sure that 
abandoned connections for communications sessions are dropped promptly. For 
more information, see “Specifying Parameters for Communications Configurations” 
on page 80.

To use the Push Keep Alive driver, you perform the following general steps:

1 Create a profile for the Push Keep Alive driver.

2 Specify a profile parameter override for the parameter PushKeepAliveTimer.

For example, you may choose to set PushKeepAliveTimer to 180 (seconds).

3 Associate this profile with applicable communications configurations.
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For more information about PushKeepAliveTimer and other parameters available 
for the Push Keep Alive driver, see “Other Communications Drivers” on page 560.

Simulating a Communications Environment
This section describes how to use the Communications Simulator to simulate basic 
capabilities for handling work items of different channel types.

The Communications Simulator can help you to understand how Siebel 
Communications Server works. It allows you, for example, to experiment with event 
responses such as those that generate screen pops or populate the customer 
dashboard. The Communications Simulator simulates:

■ Inbound calls

■ Inbound call (received from a predictive dialer)

■ Inbound email

Any changes to communications profiles, configuration parameters, agents, 
telesets, commands, or events that you make as part of using the Communications 
Simulator must be made using the applicable communications configuration.

NOTE: The Communications Simulator can simulate CTI voice call-handling only for 
communications configurations using profiles for the communications driver 
provided by Siebel Systems to support Intel NetMerge middleware.

Setting Up and Running the Communications Simulator
The Communications Simulator is included as part of the Siebel eBusiness 
Applications, when communications modules are licensed. Users can access the 
Communications Simulator with any of the Siebel client types. Configuration varies 
somewhat for each client type.

For instructions and requirements for enabling and running the Communications 
Simulator, see “Enabling Session Communications and Simulation” on page 311.
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Using the Communications Simulator
Using the Communications Simulator, you can begin trying out basic 
communications features, such as accessing functions through the communications 
toolbar, or viewing Siebel records based on data associated with an inbound call. 
These features are described in more detail in the rest of this section.

You can simulate communications activity and experiment with associated screen-
pop behavior.

Communications-Simulation Keys
The following sets of simulation keys have been preconfigured in the 
Communications Simulator. Consult the file predefined communications 
configurations for additional simulation commands.

■ SHIFT+F11 simulates an incoming new voice call. In this case, the call contains 
Caller ID data known as ANI (Automatic Number Identification). The caller 
exists in the Siebel Sample Database and has presumably called before. See 
“Simulated Inbound Call with Caller ID” on page 234.

■ CTRL+SHIFT+F11 simulates an incoming new voice call, in which the caller 
either does not have Caller ID or is not in the Siebel database. See “Simulated 
Inbound Call from an Unknown Caller” on page 236.

■ SHIFT+F6 simulates an inbound campaign call, such as initiated by a predictive 
dialer. See “Inbound Campaign Call Simulation” on page 237.

■ CTRL+F11 simulates an incoming new email work item.

Inbound Call Simulations
This section describes two inbound call scenarios.

Simulated Inbound Call with Caller ID
When you press SHIFT+F11 in the Communications Simulator, you will hear a ring 
or a beep, depending on how Enable Sound is set in the User Preferences screen, 
and you will see the Accept Work Item button blink on the communications toolbar. 
These indicators signal an incoming call. Clicking the Accept Work Item button on 
the toolbar to answer the call initiates the following:
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■ A screen pop displays contact information about the caller.

■ An activity record is automatically created, of type Call - Inbound.

The Siebel application performs the screen pop using ANI. By default, the 
Communications Simulator matches the contact’s phone number to the setting of 
the Param.ANI parameter for the call simulation command. Find a contact in the 
Sample Database and enter the phone number as the value for Param.ANI.

Table 35 and Table 36 show the values used in the simulation. These values are 
displayed and can be edited in the All Commands and All Command Data views in 
the Communications Administration screen (when you are logged in as SADMIN).

You can modify the value for Param.ANI to specify the phone number, and therefore 
the contact, that the Communications Simulator uses for the screen pop. Many 
contacts in the Sample Database have work phone numbers defined. Enter another 
contact’s work phone number to select that contact during simulation.

You can also change the view that will be displayed for the screen pop:

■ The event response parameter SingleView specifies the view to display if the 
telephone number of the inbound call matches a single contact record in the 
Siebel database. 

Table 35. Command: SimCallFound

Parameter Name Parameter Value

DeviceCommand SimulateCall

Hidden TRUE

HotKey SHIFT+F11

Table 36. Command Data: SimCallFound

Parameter Name Parameter Value

Param.ANI phone_number
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■ The event response parameter MultiView specifies the view to display if the 
telephone number of the incoming call matches more than one contact record 
in the database.

The example event response in Table 37 shows values that are used in simulating 
screen pops.

Two event logs are associated with this event response:

■ An event log of type SingleLog, named LogIncomingCallContactFound

■ An event log of type Log, named LogIncomingCallContactNotFound

Simulated Inbound Call from an Unknown Caller
When you press CTRL+SHIFT+F11 in the Communications Simulator, you will 
hear a ring or a beep, depending on how the Enable Sound option is set, and you 
will see the Accept Work Item button blink.

Click the Accept Work Item button on the communications toolbar to answer the 
call. No information about the caller is retrieved, because the caller’s telephone 
number was not in the database; the Search Center appears.

Table 37. Event Response: OnInboundCallReceived

Parameter Name Parameter Value

QueryBusObj Contact

QueryBusComp Contact

QuerySpec 'Work Phone #'='{ANI}'

SingleView Service Contact Detail View

MultiView All Contacts across Organizations

FindDialog Service Request

FindField.Owner Ask Caller
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Table 38 and Table 39 show values used for inbound call simulation. This operation 
is similar to that for the simulated inbound call with ANI. In this case, however, the 
phone number in the Param.ANI setting does not exist in the Sample Database.

Once the Siebel application determines that the phone number does not exist in the 
Sample Database, the Search Center appears on the right side of the screen. In the 
Search drop-down list, the Service Request option is highlighted.

You can change the option that is highlighted in the Search Center by changing the 
value for the FindDialog parameter. For details, see Table 37 on page 236.

Other possible values for the FindDialog parameter include Opportunity, Service 
Account, Corporate Contact, Service Product, and Consumer.

Inbound Campaign Call Simulation
When you press SHIFT+F6, the Accept Work Item button on the communications 
toolbar blinks. Click the Accept Work Item button to connect to the call. You will 
then get a screen pop that displays the campaign associated with the simulated call.

Table 38. Command: SimCallNotFound

Parameter Name Parameter Value

DeviceCommand SimulateCall

Hidden TRUE

HotKey CTRL+SHIFT+F11

Table 39. Command Data: SimCallNotFound

Parameter Name Parameter Value

Param.ANI 6504775000
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Accepting the call automatically creates an activity record of type Call - Inbound. 
When the call ends, the date and time are entered in the activity’s Description field.

NOTE: Typically, a campaign call like this originates from a predictive dialer, and 
would be thought of as an outbound call—from the call center to the consumer. 
However, as it relates to the communications configuration, the call functions as an 
inbound call, due to how it arrives at the agent’s communications toolbar.

Table 40 and Table 41 show values used for inbound campaign call simulation.

Using Business Services with Communications Server
This section describes some ways in which you can use Siebel business services 
with Siebel Communications Server.

Table 40. Command: SimCampaignCall

Parameter Name Parameter Value

DeviceCommand SimulateCall

Hidden TRUE

HotKey SHIFT+F6

Table 41. Command Data: SimCampaignCall

Parameter Name Parameter Value

Param.CampID 1-CQZ

Param.CampContactID FAKE_ID
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Business services represent encapsulated functionality in the form of methods that 
can be called by Siebel application modules or by scripts within the Siebel 
application environment. Many types of Siebel eBusiness Applications 
functionality, including Communications Server functionality, can be accessed as 
methods of Siebel-provided business services. Siebel applications running on all 
client types support Siebel business services.

This section describes using business services in two general ways:

■ Access Siebel Communications Server functionality outside of the standard 
means offered by the Siebel application user interface. For example, Siebel 
Business Process Designer invokes Communications Server business services, 
and Siebel VB and Siebel eScript scripts can invoke Communications Server 
business services.

■ Integrate Siebel Communications Server events and commands with Siebel 
business services, in particular with custom business services or business 
services other than those provided for Communications Server.

Siebel Communications Server supports multiple business services that support the 
different functional areas of interactive session communications, outbound 
communications, and inbound communications.

The Outbound Communications Manager business service runs on the Siebel Server 
on which the Communications Outbound Manager server component is running.

For information about business services related to inbound communications, refer 
to Siebel eMail Response Administration Guide and Siebel Universal Queuing 
Administration Guide.

For additional information about Siebel business services, refer to:

■ Siebel Business Process Designer Administration Guide

■ Siebel Tools Reference

■ Siebel Tools Online Help

■ Overview: Siebel eBusiness Application Integration Volume I (and other books in 
the Siebel eAI area)
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Invoking Communications Server Business Service Methods
Siebel Communications Server includes two business services that support session 
communications for agents:

■ Communications Client. Supports the communications user interface features 
such as the communications toolbar and communications menu commands. 
This business service aggregates the Communications Session Manager business 
service. It is not involved with server-based communications functionality.

■ Communications Session Manager. Provides an interface to session-based 
communications functionality at the server level. Through Server Request 
Manager and Server Request Broker, this business service communicates with 
the Communications Session Manager server component. It does not deal with 
the communications user interface. 

NOTE: Because the Communications Session Manager business service is 
aggregated by the Communications Client business service, you can access all 
Communications Session Manager business service methods from the 
Communications Client business service. For configuring communications 
events or commands, the communications toolbar, or the Application Object 
Manager, you must invoke all methods through the Communications Client 
business service.

The first two of these business services work together, and may be run either on the 
Application Object Manager supporting instances of the Siebel Web Client, or on 
instances of the Siebel Dedicated Web Client. They run together with the channel 
manager, depending on how you have deployed interactive session 
communications. For more information, see “Enabling Session Communications 
and Simulation” on page 311.

Siebel Communications Server includes one business service that supports 
outbound communications:

■ Outbound Communications Manager. Provides an interface to the outbound 
communications functionality of the Communications Outbound Manager 
server component.
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Methods of Communications Server business services can be invoked from outside 
Communications Server. You can invoke a method from an applet, a script, a 
workflow, or another business service, or invoke it in some other way. Siebel 
Business Process Designer and scripts for Siebel VB or Siebel eScript can invoke 
Communications Server business services.

For detailed information about Communications Server business services, methods, 
and arguments, see Appendix E, “Communications Server Business Services.”

About Using Business Services with Events and Commands
This section describes scenarios for integrating business services with 
communications event and commands. These scenarios are applicable to a contact 
center using Siebel CTI and related modules, Siebel eMail Response, and Siebel 
Universal Queuing. These scenarios are described:

■ Invoking a business service method from an event handler

■ Invoking a business service method from an event response

A business service method can also be invoked from an event log, but this 
scenario is not described here.

■ Invoking a communications command from a business service method

■ Invoking a business service method from a communications command

Invoking a Command Through the Business Service Model
You can set up a custom business service that will invoke a command from a 
communications configuration. To set this up, you would:

■ Create a communications command (and a corresponding command data 
definition) that is intended to be invoked from outside of Siebel 
Communications Server, and

■ Modify or create an applet, script, or business service to invoke a particular 
communications command

An example is provided below for a make-call command and for a business service 
method that will invoke this command.
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Table 42 and Table 43 show an example of a command that will be called by a 
custom business service. This example executes a MakeCall device command.

The values for Callee Phone Number and My Display Text will be passed from the 
custom business service to the command when the command is invoked.

A business service must be implemented that will invoke the command 
MakeCallFromCustomService. Communications Server would retrieve the values of 
Callee Phone Number and My Display Text from the input arguments of the 
business service method, and assign these values to the command data parameters 
Param.PhoneNumber and Param.DisplayText. The device command MakeCall 
would be executed, using the values for these parameters.

NOTE: By default, communications commands are invoked from business service 
methods associated with communications toolbar buttons. For more information, 
see “About Communications Toolbar Configuration” on page 265.

Table 42. Command: MakeCallFromCustomService

Parameter Name Parameter Value

Description Make Call from Custom Service

DeviceCommand MakeCall

Hidden TRUE

Table 43. Command Data: MakeCallFromCustomService

Parameter Name Parameter Value

Param.PhoneNumber {Callee Phone Number}

Param.DisplayText {My Display Text}
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Invoking a Business Service Method from a Command
You can create or modify a command and a corresponding command data definition 
in the communications configuration to specify a Siebel business service and 
method to be invoked. To do this, you would:

■ Use the command parameter ServiceMethod in a command to specify the name 
of the business service and method to invoke.

■ Use the command parameter ServiceParam in the associated command data 
definition to specify argument names and values to pass to the business service 
method.

For more information about using these command parameters, see “Commands” on 
page 172 and “Command Data” on page 186.

In the example shown in Table 44 on page 244 and Table 45 on page 244, 
Communications Server invokes the method MyMakeCall of the business service 
MyMakeCallService, and passes arguments to the service method. The value of the 
ServiceParam.PhoneNumber parameter is from the @Phone macro; the value of the 
ServiceParam.AgentID parameter is from the @AgentId macro.

At runtime, commands that invoke business service methods are determined to be 
enabled or disabled by invoking from the applicable business service the method 
CanInvokeMethod(“method_name”), where method_name is your business service 
method to be invoked. If TRUE is returned, the method can be invoked. If FALSE is 
returned, the method cannot be invoked and the command is disabled.
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No DeviceCommand parameter is included in this example, because the 
communications command is not designed to call a function on the external 
communications system.

Communications Server can invoke the methods of any business service, not only 
those, like this example, that pertain to communications.

NOTE: By default, several communications commands invoke business service 
methods. For examples, see the communications configuration data provided by 
Siebel Systems.

Invoking a Business Service Method from an Event Handler
You can create or modify an event handler in the communications configuration to 
specify a Siebel business service and method to be invoked. The business service 
method returns data to determine whether this event handler matches. In addition, 
it may perform other functions desired by the customer.

Table 44. Command: MakeCallInService

Parameter Name Parameter Value

Description Make Call In My Service

ServiceMethod MyMakeCallService.MyMakeCall

Hidden TRUE

Table 45. Command Data: MakeCallInService

Parameter Name Parameter Value

ServiceParam.PhoneNumber {@Phone}

ServiceParam.AgentID {@AgentId}
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To configure this, you would use the event parameters ServiceMethod and 
ServiceParam to specify the name of the business service and method to invoke, and 
to specify argument names and values to pass to the business service method. For 
more information about using these event parameters, see “Event Handlers” on 
page 146.

In the example shown in Table 46, Communications Server invokes the method 
MyMethod of the business service MyService, and passes arguments “attribute1” 
and “attribute2” to the method, using the values of the ServiceParam.Param1 and 
ServiceParam.Param2 parameters.

The example event handler would have the Device Event field set to the appropriate 
device event for the driver, such as InboundCall for the Dialogic CTI driver (for 
Siebel CTI Connect).

You can use the ServiceMethod and ServiceParam parameters to supplement or 
replace filter mechanisms using the Filter or FilterSpec parameters. You can also use 
this method to execute custom code before executing a specified event response. 
The business method should set a parameter of Result to a value 1 or 0 (or TRUE or 
FALSE):

■ 1 (TRUE) indicates that this event handler matches and should be executed, and 
the associated event response should be executed.

■ 0 (FALSE) invalidates this event handler; the next event handler will then be 
evaluated.

Table 46. Event Handler: OnInboundCallReceived

Parameter Name Parameter Value

ServiceMethod MyService.MyMethod

ServiceParam.Param1 {attribute1}

ServiceParam.Param2 {attribute1}
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Invoking a Business Service Method from an Event Response
You can create or modify an event response in the communications configuration to 
specify a Siebel business service and method to be invoked whenever this event 
response is invoked by an event handler.

To configure this, you would use the event parameters ServiceMethod and 
ServiceParam to specify the name of the business service and method to invoke, and 
to specify argument names and values to pass to the business service method. For 
more information about using these event parameters, see “Event Responses” on 
page 154.

The business service method may also alter the event data fields that were 
associated with the work item, such as to add new fields.

In the example event response shown in Table 47 (for Siebel Connect), the method 
MyMethod of the business service MyService is invoked to handle the event. The 
value of the ServiceParam.CallingDN parameter is from the ANI event data field; the 
value of the ServiceParam.Connection parameter is from the refId event data field.

When a business service method is invoked from an event response, the value for 
the output argument Continue will be either TRUE (1) or FALSE (0). If Continue is 
TRUE, event handling as specified in the event handler that called this event 
response will proceed (such as to generate a screen pop).

Table 47. Event Response: OnInboundCallReceived

Parameter Name Parameter Value

ServiceMethod MyService.MyMethod

ServiceParam.CallingDN {ANI}

ServiceParam.Connection {refId}
246 Siebel Communications Server Administration Guide Version 7.5.3



Advanced Communications Configuration

Integrating with Siebel Scripting Languages
Integrating with Siebel Scripting Languages
Siebel VB and Siebel eScript scripts can be used in many ways to extend your 
communications-enabled Siebel applications.

NOTE: For information about scripting methods from Siebel CTI version 6.x, see 
“Using Siebel Scripts from Version 6.x” on page 671.

Siebel VB and Siebel eScript scripts can be used in the following ways:

■ Communications events or commands can invoke Siebel VB or Siebel eScript 
scripts.

■ Communications events can invoke Siebel VB or Siebel eScript scripts, for 
instance on the arrival of an incoming work item or upon releasing a work 
item.

■ Communications commands can invoke Siebel VB or Siebel eScript scripts.

■ Siebel VB or Siebel eScript scripts can invoke communications commands (using 
business service methods) and access event data fields or work item attributes.

■ Siebel VB or Siebel eScript scripts can invoke communications commands. 
Commands such as transferring a work item can be invoked from Siebel VB–
based menu items, buttons, or toolbar buttons.

■ Siebel VB or Siebel eScript scripts can access data attached to a work item, 
such as event data fields like ANI, DNIS, digits collected from an IVR system, 
or Siebel work item attributes.

■ Siebel VB or Siebel eScript scripts can access methods and arguments of 
Communications Server business services. For more information, see “Using 
Business Services with Communications Server” on page 238 and 
Appendix E, “Communications Server Business Services.”

■ Siebel VB or Siebel eScript scripts can access runtime data provided by the 
macros described in “Macros for Parameter Values” on page 196.

Siebel Communications Server integration with Siebel VB and Siebel eScript allows 
customers to write event handler functions and advanced communications 
commands in Siebel VB or Siebel eScript.
Version 7.5.3 Siebel Communications Server Administration Guide 247



Advanced Communications Configuration

Integrating with Siebel Scripting Languages
The methods of all Communications Server business server methods are exposed 
and can be called with any applicable arguments. All event data fields (such as ANI, 
DNIS, and so on) are accessible. A Siebel VB or Siebel eScript script can be invoked 
on any communications event.

A major use of scripting is to allow communications event handling (such as screen-
pop logic). But you can also use it to take complete control of the communications 
technology: to obtain information about the current work item, to intercept events 
and perform the necessary handling, or to control communications work items 
(initiate work items, transfer work items, and so on).

NOTE: Scripts can be defined in the general section of the application object or in a 
custom business service. They will be compiled into the Siebel repository (.srf) file 
for the Siebel Application Object Manager or the Siebel Dedicated Web Client.

Integrating Using Server and Browser Scripts
Siebel eScript scripts are generally supported only for the Object Manager layer, not 
for the browser layer.

■ For Siebel Web Client, the Object Manager is on the Siebel Server (Application 
Object Manager, such as SCCObjMgr for Siebel Call Center).

■ For Siebel Dedicated Web Client, the Object Manager is part of the siebel.exe 
executable program.

However, Siebel eScript scripts defined on the browser layer can be supported 
indirectly by using both server scripts and the @InvokeSWECommand special 
command. See the example below for creating a communications command, a 
command for the Siebel Web Engine (SWE), and related server and browser scripts.

NOTE: Transferring data from a server script to a browser script is not supported, due 
to limitations of SWE commands.

For more information about the @InvokeSWECommand special command, see 
“Special Commands for Device Commands” on page 131.
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Command Example
Table 48 and Table 49 show an example command and associated command data 
definition that invokes the AlertTest SWE command.

SWE Command Example
In Siebel Tools, create a command named AlertTest with the properties shown in 
Table 50. This SWE command is executed by the communications command shown 
above, and in turn invokes the CTI_Test.Alert business service method.

Table 48. Command: Alert

Parameter Name Parameter Value

DeviceCommand @InvokeSWECommand

CmdData Alert

Table 49. Command Data: Alert

Parameter Name Parameter Value

Param.SWECommand AlertTest

Table 50. SWE Command Example

Property Name Value

Name AlertTest

Business Service CTI_Test

Force Enable Y

Method Alert

Target Browser
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Server and Browser Script Examples
Define the following server script in the CTI_Test business service. The 
PreCanInvokeMethod server script in the CTI_Test business service allows the SWE 
command to be enabled that in turn will invoke the browser-layer scripting business 
service method Alert.

function Service_PreCanInvokeMethod (MethodName, &CanInvoke)
{

var ReturnVal = ContinueOperation;
if (MethodName == "Alert")
{

CanInvoke = "True";
ReturnVal = CancelOperation;

}
return ReturnVal;

}

Define the following browser scripts in the CTI_Test business service. The 
PreInvokeMethod browser script invokes the Alert method to create an alert box in 
the browser.

function Service_PreCanInvokeMethod (methodName)
{

if (methodName == "Alert")
return true;

else
return ("ContinueOperation");

}

function Service_PreInvokeMethod (methodName, inputPropSet, outputPropSet)
{

if (methodName == "Alert")
{

alert("CTI browser script test");
return ("CancelOperation");

}
else

return ("ContinueOperation");
}

In the previous steps, you have successfully created a new communications 
command named Alert. This command can be executed, for example, from the 
Communications submenu of the View menu, or from a keyboard shortcut. Another 
option is to further integrate this command with a server script, as illustrated in the 
following server script example:

function BrowserScriptTest()
{

// Invoking Browser Script
var ctibs = TheApplication().GetService("Communications Client"); 
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var ip = TheApplication().NewPropertySet();
var op = TheApplication().NewPropertySet();
ctibs.InvokeMethod("Alert", ip, op);

}

Integrating Using Server Scripts
Here are some examples of using business services and Siebel scripting with your 
communications configurations, such as for Siebel CTI Connect (using Dialogic CTI 
driver). These examples are for server-side scripting using Siebel eScript.

Event Response Example
Table 51 shows an example event response that invokes the server-layer scripting 
business service method CTI_Test.EvtBSGotoView. This event response retrieves 
work item data and generates a screen pop to the view Contact List View, with all 
contacts whose last name starts with the letter S.

Table 51. Event Response: OnInboundCallReceived

Parameter Name Parameter Value

ServiceMethod CTI_Test.EvtBSGotoView

ServiceParam.myWorkItemID {SiebelWorkItemID}

ServiceParam.ANI {ANI}
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Command Example
Table 52 and Table 53 show an example communications command and associated 
command data that invokes the server-layer scripting business service method 
CTI_Test.CmdBSGotoView. This command makes an outbound phone call to the 
number the user specified in the communications toolbar’s text input field.

Server Script Examples
Define the following server scripts in the CTI_Test business service. These scripts 
are invoked by the event response and command described above.

function Service_PreCanInvokeMethod (MethodName, &CanInvoke)
{

var ReturnVal = ContinueOperation;
switch (MethodName)
{

case "EvtBSGotoView":
case "CmdBSGotoView":
CanInvoke = "True";
ReturnVal = CancelOperation;

}
return (ReturnVal);

}

Table 52. Command: MakeCallToPhone

Parameter Name Parameter Value

ServiceMethod CTI_Test.CmdBSGotoView

CmdData MakeCallToPhone

OnEditControl TRUE

Table 53. Command Data: MakeCallToPhone

Parameter Name Parameter Value

ServiceParam.PhoneNumber {@Phone:PhoneTypeLookup}

RequiredField.@Phone ?*

Param.CallNotifyText Call from {@UserName}...
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function Service_PreInvokeMethod (MethodName, Inputs, Outputs)
{

var ReturnVal = ContinueOperation;
switch (MethodName)
{

case "EvtBSGotoView":
EvtBSGotoView(Inputs, Outputs);
ReturnVal = CancelOperation;
break;

case "CmdBSGotoView":
CmdBSGotoView(Inputs, Outputs);
ReturnVal = CancelOperation;
break;

}
return (ReturnVal);

}

function EvtBSGotoView(Inputs, Outputs)
{

// Getting input arguments from Event Response parameters
var itemID = Inputs.GetProperty("myWorkItemID");
var ANI = Inputs.GetProperty("ANI");

// Invoking Business Service "Communications Session Manager" method
var ctibs = TheApplication().GetService("Communications Session Manager");
var ip = TheApplication().NewPropertySet();
var op = TheApplication().NewPropertySet();
ip.SetProperty("WorkItemID", itemID);
ctibs.InvokeMethod("GetWorkItemInfo", ip, op);

// Generate a screen pop to "Contact List View" with
// all the contacts whose last name start with letter "S"
var boGlobal = TheApplication().GetBusObject("Contact");
var bcContact = boGlobal.GetBusComp("Contact");
bcContact.SetViewMode(AllView);
bcContact.ClearToQuery();
bcContact.SetSearchSpec("Last Name", "S*");
bcContact.ExecuteQuery(ForwardBackward);
TheApplication().GotoView("Contact List View", boGlobal);

}

function CmdBSGotoView(Inputs, Outputs)
{

// Getting input arguments from Command Data parameters
var number = Inputs.GetProperty("PhoneNumber");

// Invoking Business Service "Communications Client" method
var ctibs = TheApplication().GetService("Communications Client"); 
var ip = TheApplication().NewPropertySet();
var op = TheApplication().NewPropertySet();
ip.SetProperty("PhoneNumber", number);
ip.SetProperty("ProfileName", "Dialogic CTI for San Mateo");
ctibs.InvokeMethod("MakeCall", ip, op);

}
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More Information About Scripting
For more information about Siebel scripting, refer to the following documents:

■ Siebel Tools Reference

■ Siebel Tools Online Help

■ Siebel Web Client Administration Guide

■ Siebel Server Administration Guide

Integrating with Siebel SmartScript
You can integrate Siebel Communications Server with Siebel SmartScript. For more 
information about SmartScript, refer to Siebel SmartScript Administration Guide.

Invoking Siebel SmartScript Through Siebel Communications Server
Siebel Communications Server can invoke Siebel SmartScript in order to execute 
SmartScripts. To enable this behavior, you define parameters for the appropriate 
event response, using the views in the Communications Administration screen. If 
the event response is executed in response to a corresponding event handler 
matching the call data parameters, the script will be launched.

The following parameter and value must be added to the event response in order to 
enable the link between Communications Server and Siebel SmartScript.

■ Parameter name: SmartScript.ScriptName

■ Parameter value: Your_script_name

Any parameters received that are prefixed with “SmartScript” will be passed to the 
SmartScript that is invoked. The available parameters are:

■ SmartScript.ScriptName

■ SmartScript.ScriptId

■ SmartScript.LanguageCode

■ SmartScript.CampaignId
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■ SmartScript.CampContactId

■ SmartScript.ContactId

Either ScriptName or ScriptId must be specified in order to start a specific 
SmartScript. Otherwise, the agent will be prompted, through the Choose Script 
dialog box, for the name of the script to run. In addition, either Siebel VB or Siebel 
eScript must be invoked to set the correct focus for the applicable business 
component.

For more information about defining event response parameters, see “Event 
Responses” on page 154.

Example Events to Invoke SmartScript Script
Table 54 shows an example event response that invokes a Siebel SmartScript script. 
The event handler that would invoke this event response would have the Device 
Event field set to the appropriate device event for the driver, such as TpAnswered 
for Siebel CTI Connect.

Displaying Communications Parameter Data in SmartScript
If a SmartScript is invoked from Communications Server, call data parameters are 
also available to be passed to SmartScript. These parameters, which have the same 
names in SmartScript as in the communications configuration data, can be accessed 
through either Siebel VB or Siebel eScript by using the GetParameter function 
against the SmartScript object. The parameters can be included among the variables 
displayed in the customer dashboard by using the prefix CTI. 

For example, a variable using the GetParameter function may be defined as follows:

var s = GetParameter("CTI.ANI")

For more information about variables and programming for SmartScript, refer to 
Siebel SmartScript Administration Guide.

Table 54. Event Response: OnInboundCallReceived

Parameter Name Parameter Value

SmartScript.ScriptName Customer Service
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Integrating with the Customer Dashboard
The customer dashboard, at the top of the application window for Siebel Call Center 
and other applications, contains fields with customer data for an agent to view. The 
customer dashboard typically displays contact information, but can be configured 
in Siebel Tools to display other fields.

For more information about configuring the customer dashboard using Siebel Tools, 
refer to Siebel Tools Reference.

Customer dashboard fields can be populated, or cleared, automatically upon the 
execution of a communications event or command. For example, the fields may be 
populated by an event response or event log that is invoked when an inbound work 
item arrives.

The fields in the dashboard are populated with customer data by invoking a 
business service and method and passing values from business component fields or 
event data fields, such as the ANI phone number of a caller. If a match is produced, 
the dashboard fields can be populated.

Example Events for Updating and Clearing Customer Dashboard
For example, the following sequence of event handler, event response, and event 
logs causes the dashboard to be populated with data, or cleared. 

In these examples, when a single matching contact record is found, the dashboard 
is populated. When no contact records are found, or multiple records are found, the 
dashboard is cleared. 

Adjust your event definitions as necessary, such as if you are using a different 
business component than Contact.

[EventHandler:InboundCallReceived]
Filter.ANI = "*"
Profile = ""
Comments = ""
Order = "1"
Response = "OnInboundCallReceived"
DeviceEvent = "TpAnswered"
256 Siebel Communications Server Administration Guide Version 7.5.3



Advanced Communications Configuration

Integrating with the Customer Dashboard
[EventResponse:OnInboundCallReceived]
MultiView = "All Contacts across Organizations"
QueryBusComp = "Contact"
QueryBusObj = "Contact"
QuerySpec = "'Work Phone #'='650477{ANI}'"
SingleView = "Service Contact Detail View"
SingleLog = "LogIncomingCallContactFound"
Log = "LogIncomingCallContactNotFound"
MultiLog = "LogIncomingCallMultiContactFound"
Comments = ""

If contact data is found, the event log below updates the customer dashboard:

[EventLog:LogIncomingCallContactFound]
AfterWork.'ACD Call Duration' = "{@WorkDuration}"
AfterWork.'Done' = "{@Now}"
AfterWork.'Planned Completion' = "{@Now}"
BusComp = "Action"
BusObj = "Contact"
Display = "FALSE"
LogField.'Account Id' = "{Contact.'Account Id'}"
LogField.'Call Id' = "{refId}"
LogField.'Contact Id (Thin)' = "{Contact.Id}"
LogField.'Planned' = "{@WorkStartTime}"
LogField.'Started' = "{@WorkStartTime}"
LogField.Description = "Inbound call"
LogField.Type = "Call - Inbound"
ServiceMethod = "Persistent Customer Dashboard.Update Dashboard 

from CTI"
ServiceParam.Field = "Id"
ServiceParam.Value = "{Contact.Id}"
WorkTrackingObj.ContactId = "{Contact.Id}"
Comments = ""

If no contact record is found, the event log below clears the customer dashboard:

[EventLog:LogIncomingCallContactNotFound]
AfterWork.'ACD Call Duration' = "{@WorkDuration}"
BusComp = "Action"
BusObj = "Contact"
LogField.'Call Id' = "{refId}"
LogField.Description = "Unknown Caller({ANI})"
LogField.Type = "Call - Inbound"
ServiceMethod = "Persistent Customer 

Dashboard.CleanDashBoard_UI"
Comments = ""
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If multiple contact records are found, the event log below clears the customer 
dashboard:

[EventLog:LogIncomingCallMultiContactFound]
AfterWork.'ACD Call Duration' = "{@WorkDuration}"
BusComp = "Action"
BusObj = "Contact"
LogField.'Call Id' = "{refId}"
LogField.Description = "Inbound call({ANI})"
LogField.Type = "Call - Inbound"
ServiceMethod = "Persistent Customer 

Dashboard.CleanDashBoard_UI"
Comments = ""

Generating Communications Reports
Communications administrators and call center managers can generate reports 
tracking inbound and outbound activity for Siebel Communications Server.

For information about configuring additional reports, refer to Siebel Reports 
Administration Guide.

To generate a communications report

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Reports.

2 As instructed, choose View > Reports.

The Reports dialog box appears.

3 Select one of the following preconfigured call-center reports, or another report 
you have previously configured:

■ Call Center Volume

■ Call Center Volume (Inbound)

■ Call Center Volume (Outbound)

4 Click Run.

The selected report is generated for you to view or print.
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Requirement for Defining Fields in Event Logs
Generating the reports identified in this section requires that event log definitions 
in your communications configuration include parameters that specify field names 
as shown in the examples in Table 55, Table 56 on page 260, and Table 57 on 
page 260. The field names are specified using the parameters LogField and 
AfterWork.

Table 55. Event Log: LogIncomingCallContactFound

Parameter Name Parameter Value

Display FALSE

BusObj Contact

BusComp Action

LogField.Type Call - Inbound

LogField.'Account Id' {Contact.'Account Id'}

LogField.'Contact Id (Thin)' {Contact.Id}

LogField.Description Inbound call

LogField.'Call Id' {ConnID}

LogField.'Planned' {@WorkStartTime}

LogField.'Started' {@WorkStartTime}

AfterWork.'Planned Completion' {@Now}

AfterWork.'Done' {@Now}

AfterWork.'ACD Call Duration' {@WorkDuration}

ServiceMethod Persistent Customer Dashboard.Update 
Dashboard from CTI

ServiceParam.Field Id

ServiceParam.Value {Contact.Id}

WorkTrackingObj.ContactId {Contact.Id}
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Viewing Communications Status Data
System administrators and call-center administrators can display status data about 
agents who are engaged in communications activity in Siebel applications. Status 
data is displayed in:

Table 56. Event Log: LogIncomingCallContactNotFound

Parameter Name Parameter Value

BusObj Contact

BusComp Action

LogField.Type Call - Inbound

LogField.Description Unknown Caller({ANI})

LogField.'Call Id' {ConnID}

AfterWork.'ACD Call Duration' {@WorkDuration}

ServiceMethod Persistent Customer 
Dashboard.CleanDashBoard_UI

Table 57. Event Log: LogIncomingCallMultiContactFound

Parameter Name Parameter Value

BusObj Contact

BusComp Action

LogField.Type Call - Inbound

LogField.Description Inbound call({ANI})

LogField.'Call Id' {ConnID}

AfterWork.'ACD Call Duration' {@WorkDuration}

ServiceMethod Persistent Customer 
Dashboard.CleanDashBoard_UI
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■ All Active Agent Status view

■ All Channel Items view

Viewing Agent Status Data
You can use the All Active Agent Status view to view status data for each agent who 
is currently logged in and using a Siebel application configured to support session 
communications. For each agent, the view displays:

■ The agent’s login, agent ID, and first and last name

■ The communications configuration that is active for the agent

■ The teleset the agent is using, for voice agents

■ Currently active work items for the agent, for each channel

■ The agent’s state (such as Ready, Not Ready) for each channel for the agent’s 
configuration

To view agent status data

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Active Agent Status.

2 Click Refresh to update the displayed data.

NOTE: The All Active Agent Status view is always updated by the system, and does 
not require specific parameter settings or event log definitions.

Viewing Channel Status Data
You can use the All Channel Items view to view status data about current 
communications work items for agents. For each work item, the view displays:

■ The work item’s channel, such as voice, email, and so on

■ The channel target address

■ The time the work item started
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■ The agent’s Siebel login, agent log, and agent password

NOTE: For each work item, the value displayed in the Start Time field is accurate only 
to the extent that the system time is synchronized between the various computers 
running instances of Communications Session Manager or Application Object 
Manager, and those running instances of the Siebel Dedicated Web Client.

To view channel status data

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Channel Items.

2 Click Refresh to update the displayed data.

Modifying How Channel Status Data Is Displayed
Channel status data is logged for display in the All Channel Items view only if the 
UpdateChannelStatusTable configuration parameter is set to TRUE. In the Siebel-
provided communications configurations, this parameter is set to TRUE. For more 
information, see “Specifying Parameters for Communications Configurations” on 
page 80.

NOTE: Records in the All Channel Items view reflect current activity only. If any 
records persist in this view for past work items, then you may need to delete such 
records manually in this view.

Distributing Status Data to Agents
Call-center administrators may want to distribute call-center statistics from the 
switch or CTI middleware to call-center agents for display in the message broadcast 
area of the Siebel client.

For example, it may be useful for an agent to know how long a call has been in an 
ACD queue before taking the call, how many calls are currently in an ACD queue, 
or the average talk time for a call.

Consult the documentation for your switch or CTI middleware for information 
about how call-center statistics can be retrieved.
262 Siebel Communications Server Administration Guide Version 7.5.3



Advanced Communications Configuration

Viewing Communications Status Data
You configure message broadcasting in the Message Broadcasts view, located in the 
Communications Administration screen. For more information, refer to Applications 
Administration Guide.
Version 7.5.3 Siebel Communications Server Administration Guide 263



Advanced Communications Configuration

Viewing Communications Status Data
264 Siebel Communications Server Administration Guide Version 7.5.3



Configuring User Interface Elements 6
This chapter describes how to configure the communications toolbar, the 
Communications submenu, and communications-related menu items in the applet-
level menu.

In addition, it describes configuring recipient groups for outbound communications, 
and configuring communications-related lists of values that you may need to 
customize.

About Communications Toolbar Configuration
This section explains how the communications toolbar buttons relate to commands 
defined for the communications configuration and provides information about 
modifying the communications toolbar for your agents.

For information about enabling communications activities through the 
communications toolbar, see “Enabling Session Communications and Simulation” 
on page 311.

For information about using the communications toolbar, see “Using the 
Communications Toolbar” on page 352.

The communications toolbar is defined and configured, in part, within Siebel Tools, 
like other toolbars in the Siebel applications. Within Siebel Tools, the 
Communication toolbar object definition contains, or is linked to, a series of other 
object definitions, including toolbar items, commands, and bitmaps. 
Version 7.5.3 Siebel Communications Server Administration Guide 265



Configuring User Interface Elements

About Communications Toolbar Configuration
These object definitions, combined with associated business service methods, 
communications commands, and bitmap/image files, determine the functioning 
and appearance of the communications toolbar for your agents.

NOTE: The available communications toolbar functions are also determined by 
functionality supported by applicable communications drivers and external 
communications systems, such as CTI middleware. 

The communications toolbar is a Java applet, and connects to the Web server using 
HTTP. Toolbar functions are determined by communications events and commands, 
which interact with communications drivers loaded by the Communications 
Session Manager component. Communications between the driver and applicable 
middleware is subject to the implementation of the driver.

For more information about configuring object definitions for toolbars, toolbar 
items, commands, and bitmaps, refer to Siebel Tools Reference and Siebel Tools 
Online Help.

Communications Toolbar Items, Commands, and Methods
Table 58 displays information about elements associated with the toolbar items for 
the Communication toolbar object definition. From left to right, the table displays 
each toolbar item name, the associated Siebel Tools command name, and the 
business service method associated with the command (where applicable). The 
methods are those of the Communications Client business service.

The Default column indicates whether the toolbar button appears in the toolbar by 
default. An asterisk (*) indicates that the button is part of a submenu.
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Each business service method name also corresponds to the name of a 
communications command. Communications configurations provided by Siebel 
Systems include commands with these names. For more information, see 
“Commands” on page 172.

Table 58. Communications Toolbar Items, Commands, and Methods

Toolbar Item Tools Command (Display Name)
Business Service Method / 
Communications Command Default

Accept Email Accept Incoming Email AcceptEmailGroup Yes*

Accept Misc Work Accept Miscellaneous Work Item AcceptMiscWorkGroup *

Accept Phone Answer Phone Call AnswerCallGroup Yes*

Accept Work Accept Work Item AcceptWorkGroup Yes

Blind Transfer Blind Transfer Work Item BlindTransferGroup Yes

Consultive Conference Consultative Conference Work Item ConferenceTransferGroup Yes

Consultative Transfer Consultative Transfer Work Item ConsultativeTransferGroup Yes

Forward Work Forward Work Item ForwardWorkGroup Yes

Hold Work Hold Work Item SuspendWorkGroup Yes

Initiate Email Initiate Email SendEmailGroup Yes*

Initiate Fax Initiate Fax SendFaxGroup Yes*

Initiate Paging Initiate Paging SendPageGroup Yes*

Initiate Phone Initiate Phone Call MakeCallGroup Yes*

Initiate SMS Initiate SMS SendSMSGroup Yes*

Initiate Work Initiate Work Item InitiateWorkGroup Yes

InQueue Time InQueue Time N/A Yes

Media Indicator Media Indicator N/A Yes

Not Ready Not Ready State NotReadyGroup Yes

Not Ready Email Not Ready for Email NotReadyForEmailGroup Yes*

Not Ready Phone Not Ready for Phone NotReadyForPhoneGroup Yes*
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Communications Toolbar Commands and Bitmaps
Table 59 on page 269 displays the names of the bitmap object definitions that are 
associated with the Siebel Tools commands for the communications toolbar items.

From left to right, the table displays the same Siebel Tools command names shown 
in Table 58 on page 267, the name of the bitmap object definition specified as the 
HTML Bitmap, and the name of the bitmap object specified as the HTML Disabled 
Bitmap.

HTML Bitmap is for controls in an enabled state, while HTML Disabled Bitmap is 
for controls in a disabled state.

The applicable image file names can be found in Siebel Tools, by viewing the bitmap 
object definitions for the bitmap category HTML Command Icons.

The image files are in the following locations:

■ eapps\public\language_code\images, in the Siebel Server installation directory

■ public\language_code\images, in the Siebel Dedicated Web Client installation 
directory

Release Work Release Work Item ReleaseWorkGroup Yes

Resume Work Resume Work Item ResumeWorkGroup Yes

Retrieve Work Retrieve Work Item RetrieveWorkGroup Yes

SignOff Communication Sign Off SignOffGroup Yes

SignOn Communication Sign On SignOnGroup Yes

Work Item List Work Item List WorkItemList Yes

Working Time N/A N/A Yes

Table 58. Communications Toolbar Items, Commands, and Methods

Toolbar Item Tools Command (Display Name)
Business Service Method / 
Communications Command Default
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where language_code represents the language code for the installed software, such 
as ENU for U.S. English.

Table 59. Communications Toolbar Commands and Bitmaps

Tools Command (Display Name) HTML Bitmap HTML Disabled Bitmap

Accept Incoming Email Comm Email Comm Email Disabled

Accept Miscellaneous Work Item Comm Misc Work Comm Misc Work Disabled

Accept Work Item Comm Accept Work Comm Accept Work Disabled

Answer Phone Call Comm Phone Comm Phone Disabled

Blind Transfer Work Item Comm Blind Transfer Comm Blind Transfer Disabled

Communication Sign On Comm SignOn Comm SignOn Disabled

Communication Sign Off Comm SignOff Comm SignOff Disabled

Consultative Conference Work Item Comm Consultive Conference Comm Consultive Conference Dis

Consultative Transfer Work Item Comm Consultive Transfer Comm Consultive Transfer Disab

Forward Work Item Comm Forward Work Comm Forward Work Disabled

Hold Work Item Comm Hold Work Comm Hold Work Disabled

Initiate Email Comm Email Comm Email Disabled

Initiate Fax Comm Fax Comm Fax Disabled

Initiate Paging Comm Page Comm Page Disabled

Initiate Phone Call Comm Phone Comm Phone Disabled

Initiate SMS Comm SMS Comm SMS Disabled

Initiate Work Item Comm Initiate Work Comm Initiate Work Disabled

InQueue Time Comm InQueue Time Comm InQueue Time

Media Indicator Comm Phone Comm Phone

Not Ready for Email Comm Email Comm Email Disabled

Not Ready for Phone Comm Phone Comm Phone Disabled

Not Ready State Comm Not Ready Comm Not Ready Disabled
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Modifying the Communications Toolbar
In implementing Siebel Communications Server, you can modify communications 
toolbar functionality in several ways. Several types of modifications that may apply 
to your implementation are described in this section.

For more information about configuring the communications toolbar in Siebel 
Tools, refer to Siebel Tools Reference and Siebel Tools Online Help.

NOTE: Generally, it is best not to make changes in Siebel Tools unless it is strictly 
necessary or it is done in conjunction with other application development work.

Modifying the Function of an Existing Toolbar Button
You can modify the function of an existing communications toolbar button in 
several different ways. You can:

■ Change which communications command an existing communications toolbar 
button invokes

■ Change which device command an existing communications toolbar button 
invokes

■ Change which business service method an existing communications toolbar 
button invokes

Release Work Item Comm Release Work Comm Release Work Disabled

Resume Work Item Comm Resume Work Comm Resume Work Disabled

Retrieve Work Item Comm Retrieve Work Comm Retrieve Work Disabled

Work Item List N/A N/A

Table 59. Communications Toolbar Commands and Bitmaps

Tools Command (Display Name) HTML Bitmap HTML Disabled Bitmap
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Modifying Communications Command for Existing Toolbar Button
If you have created a command in the communications configuration and you want 
a communications toolbar button to invoke this communications command instead 
of an existing command, you should rename your commands so that the new 
command uses the name of the command that is currently associated with the 
toolbar button.

Renaming commands in the communications configuration has less impact on an 
upgrade effort than modifying object definitions in Siebel Tools.

This approach can be used whether you are only implementing a custom command 
or you are both implementing a custom command and invoking a device command 
supported by a custom communications driver, as described below.

For more information about communications commands, see “Commands” on 
page 172.

Modifying Device Command for Existing Toolbar Button
If you are using a custom communications driver, created using the Adaptive 
Communications API, in order to extend or replace the functionality of a driver 
provided by Siebel Systems, then you can reuse the existing communications 
toolbar configuration and you can reuse existing commands from the configuration 
data provided by Siebel Systems. Of course, you can also create new 
communications commands, as described earlier in this section.

If your communications driver supports different device command names than do 
the drivers provided by Siebel Systems, you should specify your driver’s device 
commands in your communications commands. Or, for commands that do not 
specify a device command and do not execute something else such as a business 
service method or script, the application attempts to execute a device command 
with the same name as the communications command.

For more information about device commands, see “Commands” on page 172. For 
more information about Adaptive Communications, see Appendix D, “Developing 
a Communications Driver.”
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Modifying Business Service Method for Existing Toolbar Button
If you have created a custom business service and you want an existing 
communications toolbar button to invoke a method for this service, then you must 
use Siebel Tools to modify the command object definition that is associated with the 
toolbar item, to specify the new business service and method.

This approach is of limited practical value, however, because you can customize the 
function of a button without using Siebel Tools.

For more information about how business service methods are specified for the 
toolbar buttons, see “Communications Toolbar Items, Commands, and Methods” on 
page 266.

Modifying the Appearance of an Existing Toolbar Button
You can modify the appearance of an existing communications toolbar button in 
several different ways. You can:

■ Change the image file or bitmap object definition for an existing toolbar button

■ Change the icon file for an interactive communications driver

Changing Image File or Bitmap Object Definition for Existing 
Toolbar Button
If you want to customize the communications toolbar by using your own graphical 
elements in place of existing elements, you can do so by using your own graphics 
files in place of existing files.

You can change the image file specified for the HTML Bitmap and the image file 
specified for the HTML Disabled Bitmap. If you want to change the graphics used 
to represent a given channel, for example, you can simply identify the files used to 
represent the channel and change them to use your new images. All toolbar buttons 
that use the same bitmap object definitions will now use the new image files.

Suppose, however, that you want to change the appearance of a particular button 
but you do not want to change the appearance of all buttons that may display the 
same image file. In this case, you can create a new bitmap object definition in Siebel 
Tools, associate it with your new image file, and associate the toolbar item object 
definition with the new bitmap object definition.
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For more information about how bitmaps are specified for the toolbar buttons, and 
about the locations of the image files, see “Communications Toolbar Commands 
and Bitmaps” on page 268.

Changing Icon File for Interactive Communications Driver
You can change the icon file for an interactive communications driver. The icon file 
represents communications work items of a particular channel, and is used for the 
Channel Type Indicator and to support blinking toolbar buttons.

Some communications toolbar buttons blink, based on event occurrence. For 
example, when a new work item arrives, the button for Accept Work Item blinks 
until the agent accepts the work item. When a work item has been paused, the 
button for Resume Work Item blinks until the agent resumes the work item.

For any buttons executing methods of the Communications Client business service, 
as do the default buttons on the communications toolbar, the blinking behavior is 
controlled by the applicable communications driver and cannot be configured. If a 
button is configured to execute a method of another business service, behavior is 
controlled by that service.

The names of the icon files are specified in the Icon File field in the 
Communications Drivers and Profiles view in the Communications Administration 
screen. The files are in the same location as those for the bitmap object definitions.

Although different file names are used, the image content of the driver icon files is 
identical to those of some of the bitmaps used for the same communications 
channel. These bitmaps, and the locations of the associated image files are 
described in “Communications Toolbar Commands and Bitmaps” on page 268.

For more information about interactive drivers and icon files, see “Interactive 
Drivers” on page 64.

Moving, Adding, or Removing a Toolbar Button
You can customize the communications toolbar to add a new toolbar button or to 
remove an existing button. You can:
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■ Move a toolbar button or other control on the communications toolbar

You can move a toolbar control, in relation to other controls, by modifying the 
value of the Position field for the applicable toolbar item in Siebel Tools.

■ Remove a toolbar button or other control from the communications toolbar

You can prevent a control from appearing in the communications toolbar by 
setting the Inactive flag to TRUE for the applicable toolbar item in Siebel Tools.

■ Add a new button to the communications toolbar

If you add a new toolbar button to the communications toolbar, you must also 
add, or re-use, all associated object definitions in Siebel Tools and image files. 
The scope of what you need to do depends on the purpose of the new button.

Communications Toolbar Buttons and Commands
This section provides an overview of how communications commands are invoked 
from the communications toolbar, about command parameters that affect toolbar 
commands, and about how group commands function to support the 
communications toolbar, especially in a multichannel environment.

How Communications Toolbar Buttons Work
When an agent clicks a communications toolbar button, the Siebel client attempts 
to execute a command, corresponding to the method name, from the 
communications configuration.

If no matching command is found, the communications driver (a profile for which 
is associated with the configuration) that supports a device command with the same 
name as the method will execute that device command.

If a command invokes a subcommand, business service method, or script, then it 
need not execute a device command. All other commands generally execute a 
specified device command.
274 Siebel Communications Server Administration Guide Version 7.5.3



Configuring User Interface Elements

Communications Toolbar Buttons and Commands
A communications command executing a device command can be explicitly 
associated with a profile for the driver that supports that device command. This can 
help to avoid possible collisions where the same device command is supported by 
multiple drivers, and can also help the administrator to keep track of the intended 
functions of commands in a complex, multichannel environment.

For more information about the DeviceCommand parameter, see “Command 
Parameters” on page 174. For available device commands, see the commands table 
for the relevant driver in Appendix A, “Using Siebel CTI Connect,” or see “Special 
Commands for Device Commands” on page 131.

Command Parameters Affecting Communications Toolbar Buttons
The presence and visual appearance of items in the communications toolbar are 
determined in part by a set of related command parameters defined for the 
communications commands that are accessible through the toolbar.

■ Description. Provides the text to be displayed as ToolTip text for the toolbar 
button for the command. Many references to toolbar buttons by name are based 
on the ToolTip text specified with this parameter. For more information, see 
“Communications Toolbar ToolTip Text” on page 276.

■ Hidden. Although this parameter has no direct effect on the communications 
toolbar, it would typically be set to TRUE for a command that is to appear in the 
communications toolbar (and that is not to appear in the Communications 
submenu).

■ LocalMenu. Although this parameter has no direct effect on the communications 
toolbar, it would typically be set to FALSE, or omitted from the command, for a 
command that is to appear in the communications toolbar (and that is not to 
appear in the applet-level menu).

For more information about these parameters, see “Command Parameters Affecting 
Communications Menu Items” on page 278 and “Command Parameters” on 
page 174.
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Communications Group Commands in Toolbar
In the communications configurations provided by Siebel Systems, commands 
whose names end in “Group” are commands that may contain several 
subcommands. Most of the communications toolbar buttons invoke group 
commands. A group command can invoke another group command.

When a group command is executed, such as by clicking the associated toolbar 
button, one of its subcommands is typically invoked, based on the current context. 
Alternatively, a group command can be configured to execute all subcommands, 
where this is appropriate.

The order specified for each subcommand determines the sequence in which the 
subcommands are checked to find one that matches the context.

For more information about group commands and subcommands, see “Hierarchical 
Commands” on page 172.

Communications Toolbar ToolTip Text
The ToolTips displayed when the agent points to a communications toolbar button 
are usually derived from the command in the communications configuration. They 
may also be obtained from the communications driver or from the associated 
command object definition in Siebel Tools. 

The ToolTip text is derived in this fashion:

■ For the communications command (which may be a subcommand of another 
command) that the toolbar button represents, the value of the command 
parameter Description is used as the ToolTip text. Obtaining text from the 
context-appropriate subcommand allows the ToolTip text itself to vary by 
context. For the MakeCallToContact command, for example, “Make Call to 
Contact” is the ToolTip text.
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■ If the command parameter Description is not used for the communications 
command that the toolbar button represents, then any ToolTip text defined in 
the communications driver for the associated device command is used. Such text 
may also be context-sensitive, depending on the driver implementation.

NOTE: In order to update the description of a device command, a driver must use 
the client handle method CacheCommandInformation. In turn, this description 
will be used for the ToolTip text.

■ If neither of the previous two sources provides ToolTip text, then any ToolTip 
text is used that is defined for the command object definition in Siebel Tools. 
Such text cannot be context-sensitive, because only a single string is defined for 
the toolbar button.

Communications drivers and configurations provided by Siebel Systems provide 
ToolTip text. If you use a driver provided by Siebel Systems, ToolTip text derived 
from Siebel Tools is not used.

Configuring Communications Menu Commands
This section describes the Communications submenu and communications 
commands in the applet-level menu, explains how items in these menus relate to 
commands defined for the communications configuration, and provides 
instructions and guidelines for modifying communications menu commands.

For information about using communications menu commands and the Send 
commands, see “Using Communications Menu Commands” on page 362 and 
“Sending Email, Fax, Page, and Wireless Messages” on page 368.

For more information about outbound communication requests, see Chapter 10, 
“Defining Outbound Communication Requests.”

Communications Submenu and Applet-Level Menu
When communications are enabled for a user, the Communications submenu is 
displayed in the View application-level menu. The Communications submenu is 
configured by configuring commands defined in the communications configuration.
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The name and position of “Communications” as an item in the View menu is 
determined in Siebel Tools by the “View - Communications” menu item definition.

Like the communications toolbar, the exact content of the Communications 
submenu varies according to the communications configuration you are using. All 
the communications configurations provided by Siebel Systems contain definitions 
to configure the Communications submenu.

The applet-level menu, which is accessed at the top of each applet, below the applet 
name, is generally available in the Siebel client. When communications are enabled, 
communications-related items are added to it, according to the commands defined 
for the communications configuration.

Command Parameters Affecting Communications Menu Items
The presence and visual appearance of items in the Communications submenu and 
applet-level menu are determined by a set of related command parameters defined 
for the communications commands that are to appear in the affected menus. For 
more information, see “Command Parameters” on page 174.

■ Hidden. Should be set to FALSE, or omitted from the command, for a command 
to appear in the Communications submenu. Should be set to TRUE for a 
command that is intended to appear in the applet-level menu or the 
communications toolbar, or that is not to appear directly in the user interface.

■ HotKey. Specifies the key combination that serves as a keyboard accelerator for 
the command’s menu item.

NOTE: If you specify keyboard shortcuts, using the HotKey parameter, that 
conflict with keyboard shortcuts specified in Siebel Tools, these shortcuts will 
take precedence over the shortcuts from Siebel Tools for the agent’s session.

NOTE: Keyboard shortcuts defined for communications commands do not use as 
input any data entered into the text entry field in the communications toolbar.
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■ HotKeyText. Specifies locale-dependent text to represent the keyboard accelerator 
for the command’s menu item. The keyboard accelerator itself is specified using 
the HotKey parameter. This locale-dependent text appears in the 
Communications submenu.

■ LocalMenu. Should be set to TRUE for a command to appear in the applet-level 
menu. Should be set to FALSE, or omitted from the command, for all other 
commands.

■ MenuPosition. Specifies the position of the command’s submenu item, relative to 
the other submenu items in the Communications submenu, or the position of 
the command’s menu item relative to other menu items in the applet-level 
menu. This parameter supports multiple menu levels.

■ Title. Provides the text of the command’s menu item in the Communications 
submenu or in the applet-level menu.

Communications Group Commands in Menus
In the communications configurations provided by Siebel Systems, the commands 
whose names end in “GroupInMenu” or “GroupInLocalMenu” may specify several 
subcommands, one of which is invoked when the menu item is chosen, based on 
the current context.

The order specified for each subcommand determines the sequence in which the 
subcommands are checked to find one that matches the context.

The “GroupInMenu” commands are for the Communications submenu, and the 
“GroupInLocalMenu” commands are for the applet-level menu.

For example, MakeCallGroupInLocalMenu has several subcommands defined, each 
of which specifies another command, such as MakeCallToAccount, 
MakeCallToContact, and so on. When the agent chooses Make Call in the applet-
level menu, one of these subcommands is invoked, according to the current context.

If the agent is viewing a contact record, for example, Contact is the current business 
component. Because this business component is specified in the command data 
defined for MakeCallToContact, a match is found in this command.

For more information about group commands and subcommands, see “Hierarchical 
Commands” on page 172.
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Communications Menu Items and Device Commands
When an agent chooses a communications command from the Communications 
submenu or the applet-level menu, the corresponding command is executed from 
the communications configuration. The communications driver (a profile for which 
is associated with the configuration) that supports the device command specified 
for the communications command will execute that device command.

If a command invokes a subcommand, business service method, or script, then it 
need not execute a device command. All other commands generally execute a 
specified device command.

A communications command executing a device command can be associated with 
a profile for the driver that supports that device command. This can help to avoid 
possible collisions where the same device command is supported by multiple 
drivers, and can also help the administrator to keep track of the intended functions 
of commands in a complex, multichannel environment.

For more information about the DeviceCommand parameter, see “Command 
Parameters” on page 174. For available device commands, see the commands table 
for the relevant driver in Appendix A, “Using Siebel CTI Connect,” or see “Special 
Commands for Device Commands” on page 131.

Configuring Commands in the File Menu
This section describes configuring commands in the File menu for sending email, 
fax, page, or wireless messages. It also describes configuring the New 
Communication command for initiating outbound communication requests.

Configuring the Send Commands
This section describes how the Send commands in the File application-level menu 
are configured.

The File application-level menu contains communications commands for sending 
email, fax, page, or wireless messages. These commands are available as submenu 
items under the menu item Send.
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End User Requirements for Using Send Commands
End users must have communications profiles available to choose from, if they are 
sending email or fax messages. End users should also have communications 
templates defined. For more information about end user operations, see:

■ “Sending Email, Fax, Page, and Wireless Messages” on page 368

■ “Creating Communications Profiles for Personal Use” on page 366

■ Chapter 9, “Configuring Communications Templates”

For more information about drivers and profiles, see:

■ Chapter 2, “Configuring Communications Drivers and Profiles”

Send Menu Commands Defined in Siebel Tools
The name and position of “Send” as an item in the File menu is determined in Siebel 
Tools by the “File - Send” menu item definition. Use Siebel Tools to configure this 
menu item and all of its submenu items.

The Send submenu items invoke Siebel Tools commands, which in turn invoke the 
SendCommunication method of the Communications Client business service—each 
with a different setting for the method argument CommType.

■ The Send Email command invokes the SendCommunication method with the 
method argument CommType set to Email.

■ The Send Fax command invokes the SendCommunication method with the 
method argument CommType set to Fax.

■ The Send Wireless Message command invokes the SendCommunication method 
with the method argument CommType set to Wireless.

■ The Send Page command invokes the SendCommunication method with the 
method argument CommType set to Page.

For Send Email, Send Fax, and Send Wireless Message, the SendCommunication 
method in turn invokes Outbound Communications Manager business service 
methods.
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The Send Page command offers similar functionality to the other Send commands, 
but uses the Page Manager server component, rather than Communications Server. 
For more information, see “Server Components for Communications Server” on 
page 308.

Send Commands in Communications Toolbar
The communications configurations provided by Siebel Systems include commands 
for choosing communications toolbar buttons for the Send Email, Send Fax, Send 
Wireless Message, and Send Page commands. These commands invoke the same 
business service methods. They do not, however, affect the Send commands in the 
File application-level menu.

Configuring the New Communication Command
This section describes how the New Communication command in the File 
application-level menu is configured.

The File menu contains the New Communication command, which initiates a new 
outbound communication request. The name and position of this command as an 
item in the File menu are determined in Siebel Tools by the “File - New 
Communication” menu item definition.

The New Communication menu item invokes a command defined in Siebel Tools, 
which in turn invokes a business method. The command is available only when the 
current business object corresponds to a recipient group defined for outbound 
communication requests.

For more information, see “Using the New Communication Command to Create a 
Request” on page 435.

Configuring Communications List of Values Types
Several List of Values (LOV) types define what can be selected for certain fields in 
the Communications Administration screen.

Each of the List of Values types described here must be active in order to use the 
associated features.
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Most of these types, as provided by Siebel Systems, will serve your needs without 
alteration. However, depending on your implementation, you may need to modify 
LOV display values to include your custom content in existing administration user 
interface elements. In particular, if you are implementing a custom communications 
driver, you must modify values for several List of Values types.

Some of the List of Values types for which you may provide your own values are 
described in this section. Your deployment may require you to modify additional 
List of Values types not described here.

To modify List of Values types, you use the Application Administration screen and 
the List of Values Explorer and List of Values views.

For information about configuring the List of Values type for recipient groups for 
outbound communication requests, see “Configuring Recipient Groups for Requests 
and Advanced Templates” on page 287.

NOTE: For instructions for modifying List of Values types, refer to Applications 
Administration Guide. Follow all documented guidelines and restrictions.

List of Values Types for Channel Type
This section describes modifying List of Values types for specifying the channel type 
for communications drivers, templates, and outbound communication requests.

List of Values Type for Channel for Communications Drivers and 
Siebel Universal Queuing
If the available communications channel types do not meet your needs for your 
communications drivers and for Siebel Universal Queuing, and you want to add or 
remove channels, you must modify the appropriate List of Values type to contain 
the values you require. Modify the List of Values type named COMM_MEDIA_TYPE.

■ For values to be displayed in the Channel Type field in the Communications 
Drivers applet (in the Communications Drivers and Profiles view in the 
Communications Administration screen), Parent LIC is set to “COMM.”

■ For values to be displayed in the Channel Type field in the Channels applet (in 
the Channels view in the UQ Administration screen), Parent LIC is set to “UQ.”
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■ For values to be displayed both in the Channel Type field in the Communications 
Drivers applet and in the Channel Type field in the Channels applet (in the 
Channels view in the UQ Administration screen), Parent LIC is set to 
“COMMON.”

For more information about defining drivers, see “Configuring Communications 
Drivers and Profiles” on page 68.

For more information about Siebel Universal Queuing, refer to Siebel Universal 
Queuing Administration Guide.

List of Values Type for Channel for Templates and Requests
If the available channel types do not meet your needs for your communications 
templates and outbound communication requests, you must modify the appropriate 
List of Values type to contain the values you require. The same List of Values type 
is used for:

■ The Channel Type field in the Templates list applet. The Templates list applet 
appears in the All Templates view, in the Communications Administration 
screen, and in the My Templates view, in the Communications screen.

■ The Default Preferences check box in the More Info form applet. This applet 
appears in the All Outbound Requests and Outbound Request Overview views, 
in the Communications Administration screen, and in the My Outbound 
Requests and My Outbound Request Overview views, in the Communications 
screen.

Modify the List of Values type named OFFER_MEDIA for which “Package” is the 
value of the Parent LIC field.

For more information about defining templates, see Chapter 9, “Configuring 
Communications Templates.”

For more information about defining communication requests, see Chapter 10, 
“Defining Outbound Communication Requests.”
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List of Values Type for ACD Queues
If you are supporting the voice channel (using Siebel CTI), and supporting ACD 
queues for your agents, then you may need to modify the List of Values type for the 
ACD Queue field in the ACD Queues applet to put the values required for your call 
center in the associated drop-down list. The ACD Queues applet appears in the 
Agent General Profile view, in the Communications Administration screen. Modify 
the List of Values type named CTI_ACD_QUEUES.

For more information about specifying agents and ACD queues, see “Specifying 
Agents” on page 89.

List of Values Type for Reason Code
If you are supporting reason codes for your call or contact center agents to choose 
from when they specify that they are not ready to receive work items, then you may 
need to modify the appropriate List of Values type, to put the values required for 
your call center in the associated list. The reason code values appear in the applet 
Transfer Multiple LOV Popup Applet, which displays when agents specify the Not 
Ready state for any or all supported communications channels. By default, this 
applet is multi-select enabled. Modify the List of Values type named 
REASON_CODE.

For more information about how agents specify the Not Ready state, see “Using the 
Communications Toolbar” on page 352.

List of Values Types for Event Parameters
This section describes modifying List of Values types for parameters for event 
handlers, event responses, and event logs.

For more information about specifying events, see “Defining Communications 
Events” on page 99.
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List of Values Type for Event Handler Parameters
If you are implementing a custom communications driver, you must modify the List 
of Values type for the Name field in the Event Handler Parameters applet, to put the 
values required for your driver in the associated drop-down list. The Event Handler 
Parameters applet appears in the All Event Handlers view, in the Communications 
Administration screen. Modify the List of Values type named 
COMM_EVTHNDLR_PARAM.

List of Values Type for Event Response Parameters
If you are implementing a custom communications driver, you must modify the List 
of Values type for the Name field in the Event Response Parameters applet, to put 
the values required for your driver in the associated drop-down list. The Event 
Response Parameters applet appears in the All Event Responses view, in the 
Communications Administration screen. Modify the List of Values type named 
COMM_EVTRESP_PARAM.

List of Values Type for Event Log Parameters
If you are implementing a custom communications driver, you must modify the List 
of Values type for the Name field in the Event Log Parameters applet, to put the 
values required for your driver in the associated drop-down list. The Event Log 
Parameters applet appears in the All Event Logs view, in the Communications 
Administration screen. Modify the List of Values type named 
COMM_EVTLOG_PARAM.

List of Values Types for Command Parameters
This section describes modifying List of Values types for parameters for commands 
and command data.

For more information about specifying commands, see “Defining Communications 
Commands” on page 106.
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List of Values Type for Command Parameters
If you are implementing a custom communications driver, you must modify the List 
of Values type for the Name field in the Command Parameters applet, to put the 
values required for your driver in the associated drop-down list. The Command 
Parameters applet appears in the All Commands view, in the Communications 
Administration screen. Modify the List of Values type named COMM_CMD_PARAM.

List of Values Type for Command Data Parameters
If you are implementing a custom communications driver, you must modify the List 
of Values type for the Name field in the Command Data Parameters applet, to put 
the values required for your driver in the associated drop-down list. The Command 
Data Parameters applet appears in the All Command Data view, in the 
Communications Administration screen. Modify the List of Values type named 
COMM_CMDDATA_PARAM.

Configuring Recipient Groups for Requests and 
Advanced Templates

This section describes configuring recipient groups for outbound communication 
requests and advanced communications templates. A recipient group is a way to 
specify a group of people you would like to send communications to. Generally, you 
do not need to configure recipient groups unless existing recipient groups do not 
meet your needs.

■ For outbound communication requests, recipient groups determine the actual 
recipients for communications. For example, for the Opportunity Contacts 
recipient group, recipients come from the contacts associated with one or more 
opportunities.

■ For communications templates, which are used by requests and by other 
communications features, recipient groups determine which Siebel objects the 
template is associated with:

■ For advanced templates used for outbound communication requests, 
substitution fields for templates come from these objects. For example, for 
the Opportunity Contacts recipient group mentioned above, substitution 
fields come from the Opportunity and Contact business components.
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■ For simple templates used for the Send commands in the File menu and for 
email replies in Siebel eMail Response, substitution fields come from a 
specified business object. Recipient groups of this type do not need to be 
configured. 

For more information about recipient groups for simple templates, see 
Chapter 9, “Configuring Communications Templates,” and “Configuring 
Recipients for Send Commands” on page 299.

For a more detailed description of recipient groups for communication requests and 
advanced templates, see “About Recipient Groups for Requests and Advanced 
Templates” on page 288.

Outbound communication requests use advanced templates in sending email, fax, 
or wireless messages in an automated fashion. Communication requests can 
support high-volume processing and output.

Outbound communication requests can be created and submitted directly by a user, 
or can be created and submitted automatically by Siebel Workflow or other 
modules, by invoking methods of the Outbound Communications Manager 
business service. For example, Siebel Marketing uses this business service to 
support its offers feature.

For more information about Communications Server business services, see “Using 
Business Services with Communications Server” on page 238 and Appendix E, 
“Communications Server Business Services.”

For more information about Siebel Workflow and Siebel Marketing, refer to Siebel 
Business Process Designer Administration Guide and Siebel Marketing Guide.

For more information about working with recipient groups when creating templates 
and requests, see Chapter 9, “Configuring Communications Templates,” and 
Chapter 10, “Defining Outbound Communication Requests.”

About Recipient Groups for Requests and Advanced Templates
This section describes concepts that will help you in either using or configuring 
recipient groups used with advanced templates and outbound communication 
requests.
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For more information about working with business objects, business components, 
links, and other elements mentioned here, refer to Siebel Tools Reference.

Each recipient group specifies a source business object, called the recipient source—
such as Opportunity, Account, Action, Internal Division, and so on. The recipient 
group also specifies a recipient group business component, which must be a direct 
child of the primary business component for the recipient source business object.

The actual recipients for a communication request come from the recipient group 
business component, such as Contact, Employee, and so on. The link between the 
primary and child business components defines these recipients. For example:

■ A recipient group could be based on a recipient source specifying one or more 
accounts and the contacts of these accounts (Account Contacts).

■ A recipient group could be based on a recipient source specifying one or more 
opportunities and the sales-team members of these opportunities (Opportunity 
Sales Team Members).

■ A recipient group could be based on a recipient source directly specifying one or 
more employees (Employees).

Recipient groups directly determine actual recipients only for outbound 
communication requests. For advanced communications templates, they determine 
which fields are available to be substituted with Siebel application data when the 
template is sent to each specific recipient for the request.

Predefined Recipient Groups for Requests and Advanced Templates
Several predefined recipient groups, and their underlying business objects and 
business components, are provided by Siebel Systems. If the predefined recipient 
groups do not serve all your business needs, you must configure the Siebel 
application to extend or modify the available recipient groups. For more 
information, see “Configuring Additional Recipient Groups and Recipient Sources 
Applets” on page 293.
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Table 60 on page 290 lists predefined recipient groups that users or administrators 
can choose in the Recipient Group drop-down list in the end-user and administrator 
views for working with outbound communication requests, or in the end-user and 
administrator views for working with communications templates (Advanced tab). 
These recipient groups can also be specified in workflow processes created using 
Siebel Workflow.

(In the Simple tab of the templates views, the Recipient Group drop-down list 
displays business objects for which a primary business component is defined. These 
entries are not the same as the recipient groups discussed in this section.)

NOTE: The Recipient Group drop-down list itself (for requests or for advanced 
templates) contains the complete and up-to-date list of recipient groups. The list of 
recipient groups in Table 60 on page 290 may not be comprehensive for your Siebel 
applications.

Most of the recipient groups in the Recipient Group drop-down list apply to both 
requests and advanced templates, but some recipient groups apply only to 
templates. Recipient groups not applicable to requests display an asterisk (*).

Each recipient group is shown in Table 60, along with the name of the recipient 
source business object and recipient group business component. In the Application 
Administration screen, List of Values view, for type COMM_RECIP_SRC, the Parent 
LIC column corresponds to the recipient source business object, and the Language 
Independent Code column corresponds to the recipient group business component. 
These elements are described in “About Recipient Groups for Requests and 
Advanced Templates” on page 288.

Table 60. Predefined Recipient Groups for Communication Requests and Advanced Templates

Recipient Group (Display Value) Source Business Object (Parent LIC)
Recipient Business Component 
(Language Independent Code)

Account Contacts Account Contact

Account Team Members Account Position

Activity Contacts Action Contact(All)

Activity Owner Action Employee (MM)
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Campaign Contacts/Prospects Campaign Campaign Recipient

Campaign Team Members Campaign Campaign Position

Contacts Contact Contact

Division Positions Internal Division Position

Email Activity Receiver* Comm Outbound Email Comm Outbound Email

Email Activity Sender Action Action

Employees Employee Employee

Expense Approver Expense Expense Report Approver

Expense Owner Expense Expense Report Owner

List Contacts/Prospects List Mgmt List Mgmt List Member

Messaging Activity* Messaging Messaging Activity

Messaging Activity Assignee Action Messaging Activity Assignee

Messaging Assignee* Messaging Messaging Assignee

Messaging Contacts* Messaging Messaging

Opportunity Contacts Opportunity Contact

Opportunity Key Contact Opportunity Opportunity Key Contact

Opportunity Sales Team Members Opportunity Position

Order Contact Order Entry Comm Contact

Order Contact (Purchasing Mgr) Order Entry Contact(Purchasing Manager)

Order Sales Team Members Order Entry Position

Project Team Members Project PS Project Team

Prospect Partner Channel Partner Prospect Partner

Quote Contact Quote Comm Contact

Table 60. Predefined Recipient Groups for Communication Requests and Advanced Templates

Recipient Group (Display Value) Source Business Object (Parent LIC)
Recipient Business Component 
(Language Independent Code)
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Configuring Substitution Fields for Recipient Groups
For the business components defined in the recipient group, all business component 
fields are generally listed as available substitutions. Fields are listed from both the 
recipient group business component and recipient source business component, if 
they are different. For example:

■ For the recipient group Contacts, the available substitution fields are from the 
Contact business component, in the form [Field Name].

Quote Sales Rep Quote Position

Service Request Contact Service Request Comm Contact

Service Request Owner Service Request Comm Employee

Time Sheet Approver Time Sheet Comm Employee

Time Sheet Owner Time Sheet Comm Contact

Third Party Registration* Third Party Registration Training Third Party 
Registration

Training Class Registrants Training Class Training Class Registration

dCommerce Alert Recipients* eAuction Alerts Auction Alert Definition

dCommerce Bidders* dCommerce Bid Service Bid

dCommerce Invoicees* Auction Invoice Auction Invoice

dCommerce Listers* Auction Services Auction Item Detail

dCommerce Lister with Bid* dCommerce Winning Bids dCommerce Winning Bid

dCommerce Registered Users* User Registration - eAuction eAuction Contact

eEvent Attendee eEvents Event Attendee eEvents Event Attendee

eTraining Attendee Training Class Registration Training Class Registration

Table 60. Predefined Recipient Groups for Communication Requests and Advanced Templates

Recipient Group (Display Value) Source Business Object (Parent LIC)
Recipient Business Component 
(Language Independent Code)
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■ For the recipient group Account Contacts, the available substitution fields are 
from both the Contact business component, in the form [Field Name], and 
Account business component, in the form [Account.Field Name].

If you want to explicitly specify the substitution fields that are to be listed for any 
business component, you can do this by adding a Substitution Field user property 
on the business component, using Siebel Tools.

NOTE: If you add one or more Substitution Field user properties, only those business 
component fields identified by these user properties are listed as available 
substitution fields in the All Templates or My Templates view. No other fields are 
listed for this business component. In most cases, it is unnecessary to define this 
user property.

For the example recipient group Account Contacts, any Substitution Field user 
properties defined on the Accounts or the Contacts business component affect the 
substitution fields for that business component only.

For more information about specifying user properties, refer to Siebel Tools 
Reference and Siebel Tools Online Help.

Configuring Additional Recipient Groups and Recipient Sources Applets
If the Recipient Group picklist does not contain the options you need, follow the 
instructions in this section. This section describes how to configure your Siebel 
application to add or modify recipient groups, and to modify user interface features 
for specifying recipients for outbound communication requests.

For additional information, see “About Recipient Groups for Requests and Advanced 
Templates” on page 288 and “Predefined Recipient Groups for Requests and 
Advanced Templates” on page 289. See also “Configuring Substitution Fields for 
Recipient Groups” on page 292.

If the predefined recipient groups do not serve all your needs, you must:

■ Configure the List of Values for the Recipient Group drop-down list to add values 
you need, or to remove values you do not need. This is described in “Configuring 
the Recipient Group List of Values” on page 294.
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If you are adding any items to the List of Values, you must also:

■ Configure the Recipient Sources applet (applet name in Siebel Tools is Comm 
Source List Applet) to display records associated with the business objects and 
business components from which you want to specify recipients. This is 
described in “Configuring Recipient Sources Applets” on page 295. Do this for 
these views:

■ Outbound Request Overview view in Communications Administration screen 
(view name in Siebel Tools is Comm Request Source Recipient Admin View)

■ My Outbound Request Overview view in Communications screen (view 
name in Siebel Tools is Comm Request Source Recipient Personal View)

If you only want to remove an option from the List of Values, you do not need 
to configure the applet in Siebel Tools.

For additional information about any of the steps in the following procedures, refer 
to relevant Siebel documentation. For configuring Lists of Values, refer to 
Applications Administration Guide. For configuring applets, refer to Siebel Tools 
Reference and Siebel Tools Online Help.

Configuring the Recipient Group List of Values
This section describes configuring the List of Values for the Recipient Group drop-
down list.

To configure the List of Values for the Recipient Group drop-down list

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

2 Optionally, create a new List of Values item of type COMM_RECIP_SRC, if one 
does not already exist that specifies the business object that will serve as the 
recipient source for the recipient group you require:

a Locate a record of type COMM_RECIP_SRC, for which the field Parent LIC is 
NULL (that is, contains no value). Parent LIC stands for Parent Language 
Independent Code.

b Copy the record.
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c Specify values for the new record. Set the Display Value and the Language 
Independent Code fields to the business object name that represents the 
recipient source—for example, Campaign, Account, and so on.

3 Locate a record of type COMM_RECIP_SRC for which the field Parent LIC is not 
NULL (that is, contains a value).

4 Copy the record.

5 Specify values for the new record:

a Set the Parent LIC field to the business object name that represents the 
recipient source, such as one you specified in Step 2.

b Set the Display Value field to any appropriate value.

c Set the Language Independent Code field to the business component 
specified as the recipient group business component.

Configuring Recipient Sources Applets
This section describes configuring applets, including association applets, for the 
Recipient Sources applet, which is described at the start of this section.

To configure Recipient Sources applets

1 Start Siebel Tools.

If an existing applet is defined, named Comm Source bus_obj_name List Applet, 
where bus_obj_name is the name of the business object that is to serve as the 
recipient source, then you do not need to create the applet in Step 2 and Step 3.

2 As necessary, create a new applet, or copy and modify an existing applet.

For example, you can copy the applet Comm Source List Applet, which is 
displayed as the Recipient Sources applet.
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3 Provide a name for the new applet, in the form Comm Source bus_obj_name List 
Applet, where bus_obj_name is the name of the business object that is to serve 
as the recipient source.

NOTE: The applet Comm Source bus_obj_name List Applet must be specified for 
recipient groups for communication requests. The recipient groups listed for 
communication requests are only those for which applets with this naming 
convention have been defined. For recipient groups to be used only for 
communications templates, this naming convention is not required.

The class of the new applet must be CSSFrameListCommSrc.

4 Specify the business component associated with your new applet. If you copied 
Comm Source List Applet or another existing applet, then you must also modify 
which business component your new applet is associated with.

5 Add the new applet to the Applet Toggle list for the applet Comm Source List 
Applet.

When a user chooses the corresponding value from the Recipient Group picklist, 
as configured in the previous procedure, the Recipient Sources applet will 
automatically function as the new applet you are defining here. The recipient 
source business object is identified using a label displayed on the right side of 
the applet header area.

6 Create a new association applet for the new recipient source, or use an existing 
association applet, and set it into the new list applet.

An association applet is the applet that appears in a dialog box when you add a 
new record in a fixed applet that allows association. For example, in this case, it 
could be for associating an account with a communication request. Every list 
applet has an Assoc Applet property that you can set to an association applet.

7 Create a link between the Comm Request business component and the new 
recipient source business component, using S_COMM_REQ_SRC as the 
intersection table.

For examples, refer to existing links defined for the Comm Request business 
object.
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8 Add the new recipient source business component to the Comm Request 
business object, specifying the link created in Step 7.

9 For outbound communication requests for email, fax, or page, define the 
following user properties on the business component that you plan to use as the 
recipient group:

■ Recipient First Name Field. The business component field containing the 
recipient’s first name.

■ Recipient Last Name Field. The business component field containing the 
recipient’s last name.

■ Recipient Preferred Medium Field. The business component field containing the 
recipient’s communications channel preference.

If the setting Only Send Preference is specified for a communication request, 
a communications template is sent to a recipient if the template’s channel 
type corresponds to the value in the field indicated by this user property. 

If this user property is not set, the preference is retrieved from the Preferred 
Communications field, if the business component includes such a field. 

For more information about Only Send Preference, see “Fields for Outbound 
Communication Requests” on page 438.

■ Recipient Email Address Field. The business component field containing the 
recipient’s email address data.

For example, in the Contact business component, your application may use 
the Email Address field for email address data. In this case, Recipient Email 
Address Field should specify the Email Address field. (This field is specified 
by default.)
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■ Recipient Fax Address Field. The business component field containing the 
recipient’s fax address data.

For example, in the Contact business component, your application may use 
the Fax Phone # field for fax address data. However, Recipient Fax Address 
Field should specify the Fax Address field (this field is specified by default). 
Fax Address is a calculated field that prepares fax addressing data obtained 
from the Fax Phone # field for use with your fax server.

The formatting for fax-related fields depends on your fax server 
requirements. By default, the calculated field value for the Fax Address field 
contains fax formatting that applies to Captaris RightFax. All such field 
values must be modified as appropriate for your specific fax integration. 

For example, for RightFax, the calculated field value should specify the email 
account that is monitored by RightFax. For more information, see 
“Integrating with Fax Systems” on page 521 and “Configuring Fax Integration 
Elements in Siebel Tools” on page 522.

■ Recipient Pager Address Field. The business component field containing the 
recipient’s pager address data. Refer to the Recipient Pager Address Field in 
the Employee business component for the correct pager address format. 

For more information, see “Modem-based TAP Paging Driver Parameters” on 
page 563.

For outbound communication requests using wireless messaging, the user 
properties described above are not used. Each recipient’s mobile device address 
data is obtained from the Mobile Device Address business component using the 
recipient’s ID stored in the S_PARTY table. 

Mobile device address data is entered into the Mobile Devices view in the 
Communications Administration screen, entered by users in the Mobile screen, or 
captured automatically. 

For more information about wireless messaging, see Appendix B, “Using Wireless 
Messaging,” and refer to Siebel Wireless Administration Guide.
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Configuring Recipients for Send Commands
This section describes how to specify user properties to configure generic recipients 
for messages sent using the Send Email, Send Fax, and Send Wireless Message 
commands.

The Send Wireless Message command uses generic recipients, but does not use the 
non- joined generic recipient user properties described in this section.

The Send Page command does not use generic recipients, and the user properties 
identified in this section do not apply.

For information about using the Send commands, see “Sending Email, Fax, Page, 
and Wireless Messages” on page 368.

About Generic Recipients
A generic recipient is associated with a business component and identifies a 
potential recipient related to a specific record. Generic recipients are of two types: 
non-joined and joined.
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■ Non-joined generic recipients. With non-joined generic recipients, addressing 
information is obtained directly from fields in the current business component. 
For details, see “Configuring Non-Joined Generic Recipients” on page 302.

For example, the Contact business component uses the non-joined generic 
recipient type. If a contact record is selected when the user invokes the Send 
Email command, the Send Email window appears, preaddressed to the selected 
recipient. Recipient data comes directly from the contact record.

As noted, the Send Wireless Message command does not use the non-joined 
generic recipient user properties described in this section. The wireless 
messaging recipient’s mobile device address data is obtained from the Mobile 
Device Address business component using the recipient’s ID stored in the 
S_PARTY table. 

Mobile device data is entered into the Mobile Devices view in the 
Communications Administration screen, entered by users in the Mobile screen, 
or captured automatically. 

For more information about wireless messaging, see Appendix B, “Using 
Wireless Messaging,” and refer to Siebel Wireless Administration Guide.
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■ Joined generic recipients. With joined generic recipients, addressing information 
is obtained from fields in another business component that is joined to the 
current business component. For details, see “Configuring Joined Generic 
Recipients” on page 303.

For example, the Service Request business component uses the joined generic 
recipient type. If a service request record is selected when the user invokes the 
Send Email command, the Recipient field allows the user to choose Service 
Request Owner or Service Request Contact as the email recipient (or the user can 
choose None and specify the recipient directly). After the user selects the 
recipient (and other settings), the Send Email window appears, preaddressed to 
the appropriate recipient.

For Service Request Owner, recipient data comes from an employee record. For 
Service Request Contact, recipient data comes from a contact record. In each 
case, recipient data comes from a record that is joined to the service request 
record.

For Send Wireless Message, mobile device address data is obtained without 
using the non-joined generic recipient user properties described in this section. 
However, the joined generic recipient user properties are used.

User Interface Context for the Recipient Field
The user interface context for the Recipient field is as follows for the Send Email, 
Send Fax, and Send Wireless Message commands:

■ For Send Email using the native Siebel email client, or for Send Fax or Send 
Wireless Message, the Recipient field is part of the Pick Recipient dialog box.

If invoking the Send command does not require the user to select from this 
field—such as when the current business component uses non-joined generic 
recipients for Send Email or Send Fax, or any time the user invokes Send 
Wireless Message—the Pick Recipient dialog box does not appear. The Send 
Email, Send Fax, or Send Wireless Message window appears.
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■ For Send Email using Lotus Notes or Microsoft Outlook, the Recipient field is 
part of the Recipient/Template dialog box. 

If invoking the Send Email command does not require the user to select from 
this field—such as when the current business component uses non-joined 
generic recipients for Send Email—the Recipient/Template dialog box appears 
without the Recipient field. After the user selects a template, the Lotus Notes or 
Microsoft Outlook email window appears.

Configuring Non-Joined Generic Recipients
To configure non-joined generic recipients for a business component, specify values 
for the business component user properties listed below. For Contact, Employee, 
and certain other business components, default values are provided.

■ Recipient Email Address Field. The business component field from which email 
address data will be obtained for the Send Email command.

For example, in the Contact business component, your application may use the 
Email Address field for email address data. In this case, Recipient Email Address 
Field should specify the Email Address field. (This field is specified by default.)

■ Recipient Fax Address Field. The business component field from which fax 
address data will be obtained for the Send Fax command.

For example, in the Contact business component, your application may use the 
Fax Phone # field for fax address data. However, Recipient Fax Address Field 
should specify the Fax Address field (this field is specified by default). Fax 
Address is a calculated field that prepares fax addressing data obtained from the 
Fax Phone # field for use with your fax server.

The formatting for fax-related fields depends on your fax server requirements. 
By default, the calculated field value for the Fax Address field contains fax 
formatting that applies to Captaris RightFax. All such field values must be 
modified as appropriate for your specific fax integration. 

For example, for RightFax, the calculated field value should specify the email 
account that is monitored by RightFax. For more information, see “Integrating 
with Fax Systems” on page 521 and “Configuring Fax Integration Elements in 
Siebel Tools” on page 522.
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Additional Requirement for Non-Joined Generic Recipients
When you configure non-joined generic recipients, the business component must 
belong to the Messaging Recipient business object. (The Contact and Employee 
business components already belong to this business object.)

Configuring Joined Generic Recipients
To configure joined generic recipients for a business component, specify values for 
the business component user properties listed below. For Service Request and 
certain other business components, default values are provided.

■ Recipient Id Field N (where N is an integer). A comma-delimited list of three 
required values, and an optional fourth value, that points to records in the joined 
business component. This user property is used by Send Email, Send Fax, and 
Send Wireless Message commands.

For example, the Service Request Contact joined generic recipient type is defined 
for the Service Request business component, using the value “Contact Id, 
Contact, Service Request Contact.” The value for this user property includes the 
following elements:

■ The foreign key field in the parent business component that points to records 
in the joined business component. In our example, this field is Contact Id, a 
field in the Service Request business component that corresponds to the Id 
field in the Contact business component.

■ The joined business component. In our example, this is Contact.

■ The text of the label to appear for this generic recipient in the Recipient field. 
In our example, this is Service Request Contact.

■ An optional fourth element that identifies the primary key field in the target 
business component to join to. By default, the field name is assumed to be 
Id. Include this element in the user property value if the field name is other 
than Id. (In our example, this element is unnecessary because the Contact 
business component uses the Id field.)

You can specify multiple joined generic recipients for a business component. That 
is, you can define the user property Recipient Id Field 1 to specify one joined generic 
recipient (such as Service Request Contact), Recipient Id Field 2 to specify another 
recipient (such as Service Request Owner), and so on. The order of the integers in 
the user property names determines the order in which the joined generic recipients 
are listed in the Recipient field.
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Additional Requirements for Joined Generic Recipients
When you configure joined generic recipients, also consider the following 
requirements:

■ For Send Email and Send Fax, the user properties of the non-joined type 
described in “Configuring Non-Joined Generic Recipients” on page 302 must be 
set in the joined business component—such as in the Contact business 
component, joined from the Service Request business component.

■ The joined business component, such as Contact, must belong to the Messaging 
Recipient business object. (The Contact and Employee business components 
already belong to this business object.)

■ If a business component has user properties defined to specify both non-joined 
and joined generic recipients, the joined recipients take precedence.

■ If any user property definitions of Recipient Id Field N are specified as inactive 
in Siebel Tools, then all such definitions with higher numbers are also inactive.

Configuring Default Templates for Send Email Command
This section describes how to configure a default communications template for an 
applet, for use with the Send Email command (F9 shortcut).

A default template is pre-chosen and populates the message area when the Send 
Email command is invoked, based on the current (active) applet at the time the 
command was invoked.

To specify that a specific email template is the default for a given applet, specify the 
template name as the value for the Mail Template applet property for the applet. You 
do this in Siebel Tools.

For example, by default, the email template “Service Request Assignment” has been 
associated in this manner with the applet Service Request List Applet and with 
other applets that display service request records in the Service screen.

When the Mail Template applet property has been set for an applet, and the 
repository changes have been compiled and distributed, then users do not need to 
explicitly select the template from the Body drop-down list when they use the Send 
Email command when this applet is active.
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Setting a default template for the Send Email command, as described above, 
overrides template visibility by channel. For example, if a template is specified as 
the default email template for Change Request applets, this same template will also 
be the default template for these applets for the fax and wireless message channels 
(using the Send Fax and Send Wireless Message commands).

For more information about using Siebel Tools, refer to Siebel Tools Reference and 
Siebel Tools Online Help.
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This chapter describes how to enable session communications and simulation for 
your applications, and how to configure and run the server components for Siebel 
Communications Server.

Session-based Communications Server functionality can be accessed either through 
server components or business services, depending on your Siebel client 
deployment choices. For details, see “Enabling Session Communications and 
Simulation” on page 311.

For information about the communications architecture, see “About 
Communications Server Architecture” on page 33.

NOTE: For more information about running, configuring, or monitoring Siebel Server 
components, refer to Siebel Server Administration Guide.

Siebel Server Requirements for Communications Server
In order for you to be able to use Siebel Communications Server within your 
enterprise, note the following basic requirements relating to Siebel Server:

■ The Siebel Server installation must include the Communications Management 
(CommMgmt) component group.

■ After installation, the Communications Management component group must be 
enabled.

The rest of this section describes the Siebel Communications Server components 
and describes additional Siebel Server requirements.
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Server Components for Communications Server
The Communications Management component group includes these server 
components:

■ Communications Session Manager. Supports multichannel user-interactive 
sessions for agents using the communications toolbar for voice, email, or other 
types of work items. For details, see “Enabling Session Communications and 
Simulation” on page 311 and “Administering Communications Session Manager” 
on page 327.

■ Communications Configuration Manager. Loads and caches communications 
configuration data, for agents using functions supported by the Communications 
Session Manager. For details, see “Administering Communications Configuration 
Manager” on page 329.

■ Communications Inbound Manager. Processes inbound work items, including voice 
or email work items that are to be routed using Siebel Universal Queuing. Also 
processes inbound email messages for Siebel eMail Response or wireless 
messages for Siebel Wireless Messaging. For details, see “Administering 
Communications Inbound Manager” on page 331.

■ Communications Outbound Manager. Processes outbound communications, for 
email, fax, wireless message, or page channels. Supports communication 
requests, whether directly or through Siebel Business Process Designer. Also 
supports outbound capabilities for Siebel eMail Response and for the Send 
Email, Send Fax, and Send Wireless Message commands. For details, see 
“Administering Communications Outbound Manager” on page 333.

■ Page Manager. Used to send pages by the Send Page command. Also used by 
some workflow processes in Siebel Business Process Designer. For more 
information about setting up and using Page Manager, refer to Siebel Business 
Process Designer Administration Guide.

■ Email Manager. Used to send email by some workflow processes in Siebel 
Business Process Designer. For more information about setting up and using 
Email Manager, refer to Siebel Business Process Designer Administration Guide.

■ Smart Answer Manager. Supports the Siebel Smart Answer product option. For 
more information, refer to Siebel Smart Answer Administration Guide and Siebel 
eMail Response Administration Guide.
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Running Communications Server in Heterogeneous Server Environments
Siebel Communications Server supports heterogeneous server environments. 
Because Communications Server components such as Communications Session 
Manager load driver library files, the applicable components must be enabled on 
the same platform that the driver was developed for. The Application Object 
Manager can run in parallel on a different platform for heterogeneous operation.

For more information, refer to Siebel System Requirements and Supported Platforms 
for your Siebel product, and see also “About Communications Drivers and Profiles” 
on page 53.

Using Resonate Central Dispatch with Communications Server
If you are using Resonate Central Dispatch to implement load balancing among 
multiple instances of Siebel Server, then for each Siebel Server participating in load 
balancing, you must:

■ Enable the Communications Management component group, as noted, and 
enable or start any applicable Communications Server components.

If you are also using Communications Session Manager, then you must:

■ Set the Enable Communication parameter to TRUE for each Application Object 
Manager instance. For more information about enabling communications, see 
“Enabling Session Communications and Simulation” on page 311.

NOTE: Resonate Central Dispatch does not load balance requests for Siebel 
Communications Server. Rather, in this case the Application Object Manager from 
which a Communications Server request is made is load-balanced, and requires that 
the necessary Communications Server components be enabled and running.

For more information about installing and configuring Siebel Server and Resonate 
Central Dispatch, refer to the Siebel Server Installation Guide for the operating 
system you are using and to Siebel Server Administration Guide.
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Synchronizing Request-Mode Server Components
Communications Inbound Manager and Communications Outbound Manager are 
request-mode components, which are also known as batch-mode components. You 
need to synchronize request-mode server components between the Siebel Name 
Server and the database whenever you:

■ Create new server components

■ Create new component jobs

■ Modify existing server components

■ Delete server components

■ Enable server components

■ Disable server components

For more information about synchronizing request-mode server components, refer 
to Siebel Server Administration Guide.

Restriction for Siebel Replication Manager
Communications Server components are not supported on regional nodes, to which 
data is replicated using Siebel Replication Manager. This restriction applies to:

■ Communications Session Manager

■ Communications Configuration Manager

■ Communications Inbound Manager

■ Communications Outbound Manager
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Enabling Session Communications and Simulation
Interactive session-based communications can be enabled for employees who use 
the Siebel Web Client or the Siebel Dedicated Web Client (the Siebel Mobile Web 
Client in connected mode). Optionally, you can also configure the Communications 
Simulator for your agents.

NOTE: This section applies only to enabling communications activities that use the 
communications toolbar or menu commands for handling voice and email channels 
for interactive communications.

For information about using the communications toolbar and menu items, see 
“Using the Communications Toolbar” on page 352 and “Using Communications 
Menu Commands” on page 362.

About Communications Session Modes
Three modes of operation for session communications are supported:

■ Siebel Web Client – server-based communications session

■ Siebel Dedicated Web Client – server-based communications session

■ Siebel Dedicated Web Client – local communications session

Server-based communications sessions use the Communications Session Manager 
server component. Local communications sessions do not use this component, but 
rather perform communications processing locally, similar to Siebel CTI version 6.x.

The Communications Client and Communications Session Manager business 
services run on the Application Object Manager for Siebel Web Client deployments. 
These business services run locally for Siebel Dedicated Web Client deployments.

For enabling communications, Siebel Web Client is configured through the 
Application Object Manager. Siebel Dedicated Web Client is configured through the 
configuration file, such as uagent.cfg for Siebel Call Center.
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About Communications Simulator
You can configure communications simulation, for any type of Siebel client, for 
individual users or groups of users. In addition to the client scenarios described 
earlier in this section for enabling communications, the Communications Simulator 
also supports the Siebel Mobile Web Client, connected to a local database.

The Communications Simulator enables you to test parts of your communications 
configuration, such as event and command definitions. It can also help you to train 
agents in handling communications work items in the Siebel applications.

NOTE: The Communications Simulator does not simulate outbound email, such as 
may be sent using the Send Email button on the communications toolbar. (The Send 
Email button is available through the Initiate Work Item button.)

For details, see “Enabling Communications Simulation” on page 325. See also 
“Simulating a Communications Environment” on page 233.

Prerequisites for Enabling Session Communications
In order for agents to be able to use communications features, including simulation, 
you must set up your communications environment. For more information, see 
“Process of Configuring Communications Server” on page 43. In particular:

■ Siebel communications-related products (such as Siebel CTI, Siebel eMail 
Response, or Siebel Universal Queuing) must be licensed, configured, and 
available. Applicable third-party communications systems also must be 
configured and available.

■ For scenarios requiring the Communications Session Manager or 
Communications Configuration Manager server component, these Siebel Server 
components must be enabled and running. Also, they must be available for the 
instances of the Application Object Manager or Siebel Dedicated Web Client that 
connect to them for each agent’s communications session.

■ Call center users must have been defined as agents within a communications 
configuration, as described in “Specifying Agents” on page 89. (Demo users are 
predefined in the sample communications configuration data.)
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■ For CTI (voice-call handling), telesets and extensions must be defined, and the 
telesets must be associated with actual users who will run the Siebel application.

Or, demo telesets and extensions must be defined and associated with demo 
users associated with Demo applications that support the Communications 
Simulator. In the Sample Database, the demo users CCHENG and SLYBRAND are 
associated with demo telesets in order to support communications simulation.

The Demo applications are the shortcuts that start with “Demo” in the Siebel 
application program group for a Siebel client installation (Mobile/Dedicated 
Web Client). These shortcuts start the indicated application, such as Siebel Call 
Center Demo, in a demonstration-only mode: logging into the Sample Database 
as a demonstration user.

NOTE: Activating the communications toolbar is a prerequisite for being able to 
access the Communications Simulator. For details, see “Enabling Communications 
Simulation” on page 325.

Parameters for Application Object Manager and Dedicated Web Client
This section describes parameters for the Application Object Manager (for Siebel 
Web Client) and Siebel Dedicated Web Client. These parameters are described in 
Table 61 on page 315.

■ For deployments of the Siebel Web Client (“zero footprint”), parameters are 
specified as server component parameters for the Application Object Manager 
that is to support communications users.
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■ For deployments of the Siebel Dedicated Web Client (where applicable), 
parameters are specified in the [Communication] section of the configuration 
file, such as uagent.cfg for Siebel Call Center, for each communications user’s 
Siebel client. 
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Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description

CommConfigCache Communication 
Configuration Cache

FALSE Enables or disables the caching 
of communications 
configuration data on the 
Application Object Manager.

Note: This parameter applies to 
the Siebel Web Client only, not 
to the Siebel Dedicated Web 
Client.

■ When this parameter is 
FALSE, communications 
configuration data is loaded 
separately for each agent 
session, with no caching on 
the Object Manager.

■ When this parameter is 
TRUE, the Application 
Object Manager loads and 
caches communications 
configuration data. 

When CommConfigCache is 
TRUE, after the first agent logs 
in, subsequent agent logins for 
the same configuration will 
download the configuration 
data from the cache. This 
speeds up the login process and 
reduces memory usage per 
agent session.

This parameter may be used 
with or without the 
Communications Configuration 
Manager component and the 
CommConfigManager 
parameter.

See also the description of the 
CommConfigManager 
parameter.
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CommConfigManager Communication 
Configuration Manager

FALSE Enables or disables use of the 
Communications Configuration 
Manager (CommConfigMgr) for 
loading and caching 
communications configuration 
data to reduce configuration 
downloads.

■ When this parameter is 
FALSE, communications 
configuration data is loaded 
separately for each agent 
session, with no caching.

■ When this parameter is 
TRUE, Communications 
Configuration Manager is 
employed to load and cache 
communications 
configuration data. After the 
first agent logs in, 
subsequent agents using the 
same configuration will 
download the configuration 
data from the cache, thereby 
speeding up the login 
process.

For more information, see 
“Administering 
Communications Configuration 
Manager” on page 329.

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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CommConfigManagerName Communication 
Configuration Manager 
Name

CommConfigMgr Specifies the name of the 
Communications Configuration 
Manager server component to 
use when the parameter 
CommConfigManager is TRUE.

A global deployment may, for 
example, use different 
components for different 
languages within the same 
enterprise.

CommEnable Enable 
Communication

FALSE Enables or disables session-
based communications for 
agents.

■ When this parameter is 
TRUE, the communications 
toolbar and menu elements 
are displayed and activated 
for agents who are 
associated with a 
configuration.

■ When this parameter is 
FALSE, the communications 
toolbar and menu elements 
are not displayed.

If an agent is not associated 
with a configuration, the 
communications toolbar is not 
displayed, even if CommEnable 
is TRUE.

Enabling communications has 
many additional requirements, 
which are described in 
Chapter 3, “Configuring Session 
Communications.”

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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CommLocalDriver Local Communication 
Driver

FALSE (as 
component 
parameter)

TRUE (as 
configuration file 
parameter for 
Dedicated Web 
Client)

Specifies on which machine 
interactive communications 
drivers should be loaded by the 
channel manager for each agent 
communications session.

■ For either the Siebel Web 
Client or the Siebel 
Dedicated Web Client: when 
this parameter is FALSE, 
interactive drivers are 
loaded on the Siebel Server 
machine where 
Communications Session 
Manager is running.

■ For the Siebel Dedicated 
Web Client: if this parameter 
is TRUE in the configuration 
file, interactive drivers are 
loaded on each agent’s 
Siebel client.

■ For the Siebel Web Client: if 
this parameter is TRUE on 
the Application Object 
Manager, interactive drivers 
are loaded on the 
Application Object Manager.

For more information, see 
“Administering 
Communications Session 
Manager” on page 327.

CommLogDebug Log Debug Message FALSE Specifies whether the log file 
specified with the CommLogFile 
parameter should contain extra 
detail.

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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CommLogFile Log File SComm_user.log Specifies the name of the log file 
to create for the agent’s 
communications session, where 
user is the agent’s Siebel login 
name.

The file is written in the log 
subdirectory of the Siebel Server 
or Siebel Dedicated Web Client 
installation directory.

CommMaxLogKB Maximum Log Size 
(KB)

1024 Specifies the maximum size, in 
Kilobytes, of log files specified 
using CommLogFile.

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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CommMaxMsgQ Maximum Message 
Queue

64 The maximum number of 
messages to be queued for the 
agent’s communications 
toolbar.

If the number of messages 
exceeds the maximum, the 
oldest message is discarded. For 
example, with the default value 
of 64, the most recent 64 
messages are queued. If a 65th 
message arrives, the oldest 
message in the queue is 
discarded in order for the new 
message to be received.

It is recommended that you use 
the default setting unless you 
require changing it.

If you set this value too low, 
older messages might be deleted 
in some cases, such as in a slow 
network environment.

If you set this value too high, 
server resources may be 
overused, by storing many 
messages for agents who 
experience browser problems 
that interrupt the session.

The behavior is also subject to 
the general session timeout 
defined for Siebel Web Client 
deployments. If an agent’s 
session times out, all toolbar 
messages for the session are 
cleared.

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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CommReleaseLogHandle Release Log Handle TRUE Indicates that the log file handle 
for each agent should be 
released periodically, after logs 
have been generated.

Performance for agent sessions 
can be improved by setting this 
parameter to FALSE. This may 
be most effective if 
CommLogDebug is also FALSE, 
because logging is less 
intensive.

When CommReleaseLogHandle 
is FALSE, some log files may not 
be generated if the number of 
concurrent users exceeds the 
file-handle capacity provided by 
the operating system.

CommReqTimeout Request Timeout 600 Specifies the number of seconds 
to wait for a response from the 
Communications Session 
Manager for a particular 
communications interaction.

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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CommSimulate Simulate 
Communication

FALSE Enables or disables the 
Communications Simulator.

■ When this parameter is 
TRUE, communications 
simulation is enabled for 
agents.

■ When this parameter is 
FALSE, communications 
simulation is disabled for 
agents.

The Communications Simulator 
can be enabled in other ways as 
well. Additional requirements 
are described in “Enabling 
Communications Simulation” 
on page 325.

Table 61. Object Manager and Dedicated Client Parameters for Communications Sessions

Parameter Name
Display Name (for 
Component Parameter) Default Value Description
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Parameters for Communications Session Manager
Parameters relating to log files can be specified as server component parameters for 
Communications Session Manager. These parameters are described in Table 62.

Table 62. Communications Session Manager Parameters

Parameter Name Display Name Default Value Description

LogDebug Log Debug Message FALSE Specifies whether the log file 
specified with the LogFile 
parameter should contain extra 
detail.

LogFile Log File SComm_user.log Specifies the name of the log file 
to create for the agent’s 
communications session, where 
user is the agent’s Siebel login 
name.

The file is written in the log 
subdirectory of the Siebel Server 
installation directory.

MaxLogKB Maximum Log Size 
(KB)

1024 Specifies the maximum size, in 
Kilobytes, of log files specified 
using LogFile.

ReleaseLogHandle Release Log Handle TRUE Indicates that the log file handle 
for each agent should be 
released periodically, after logs 
have been generated.

Performance for agent sessions 
can be improved by setting this 
parameter to FALSE. This may 
be most effective if LogDebug is 
also FALSE, because logging is 
less intensive.

When ReleaseLogHandle is 
FALSE, some log files may not 
be generated if the number of 
concurrent users exceeds the 
file-handle capacity provided by 
the operating system.
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Enabling Communications Sessions for Siebel Web Client
End users can access communications using the Siebel Web Client by connecting 
the Web browser to an Applications Object Manager for which server component 
parameter values are set as described in this section.

For more information about setting server component parameter values, refer to 
Siebel Server Administration Guide.

To enable or disable session communications for Siebel Web Client users

1 On each Application Object Manager that is to support users for whom session 
communications must be available, set the server component parameter 
CommEnable to TRUE. Or, to disable communications, set it to FALSE. To set this 
parameter, do one of the following:

■ From the application-level menu, choose View > Site Map > Server 
Administration > Component, select Call Center Object Manager (for 
example), and set a value for the Enable Communication parameter.

■ On the command line, enter (on one line) text similar to the following:

srvredit /g gateway_name /e enterprise_name 
/r $enterprise.app_object_mgr.CommEnable=true /d bool /f

Substitute the values for your Siebel Gateway, Siebel Enterprise Server, and 
Application Object Manager component, as appropriate. For example, for 
Siebel Call Center, you might enter:

srvredit /g localhost /e siebel 
/r $enterprise.SCCObjMgr.CommEnable=true /d bool /f

2 After setting the CommEnable parameter value, restart the Siebel Server on 
which the Application Object Manager is running.

Enabling Communications Sessions for Siebel Dedicated Web Client
This section describes how end users can enable communications using the Siebel 
Dedicated Web Client—the Siebel Mobile Web Client in connected mode. Enabling 
communications is subject to your having the appropriate license keys.

If simulation is also used, this section also applies to using the Siebel Mobile or 
Dedicated Web Client with the Sample Database.
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Enabling Communications Using Command-Line Option
An agent can enable communications in the Siebel Dedicated Web Client by 
including the command-line option /ct at the end of the command line, such as in 
the application shortcut. Any of the Siebel eBusiness Applications can support this 
command-line option.

Enabling Communications by Modifying Configuration File
An agent can enable communications in the Siebel Dedicated Web Client by setting 
the following parameter in the [Communication] section of the application’s 
configuration file, such as uagent.cfg for Siebel Call Center:

CommEnable=TRUE

Enabling Communications Simulation
This section describes how to enable the Communications Simulator for end users. 
You can simulate communications for voice and email channels.

An end user can access communications simulation using any of the Siebel clients, 
depending on how simulation is enabled. Users commonly access simulation in the 
Siebel Mobile Web Client, using the Sample Database.

For information about enabling session communications, which is a prerequisite for 
communications simulation, see “Prerequisites for Enabling Session 
Communications” on page 312.

For information about end-user operations using communications simulation, see 
“Simulating a Communications Environment” on page 233.

NOTE: In order to test communications simulation, make sure that any configuration 
in which you are defining simulation functionality is the primary configuration for 
the applicable users.

Role of the Simulate Parameter
Enabling communications simulation as described in this section automatically sets 
the value of the Simulate driver parameter to TRUE, in the memory for each agent 
session, for all profiles for interactive communications drivers.
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To specify communications simulation for users, administrators or agents that 
follow the procedures in this section do not need to explicitly set the value of the 
Simulate driver parameter to TRUE for communications drivers or profiles.

Simulate Parameter and Custom Drivers
If you are implementing a custom communications driver developed using the 
Adaptive Communications API, if you define a driver parameter Simulate to support 
communications simulation, enabling simulation as described in this section can 
also apply to this driver. Otherwise, it is recommended that you do not define a 
parameter with this name.

Enabling Simulation for Siebel Mobile Web Client
End users can access communications simulation using the methods described in 
this section.

Enabling Using Command-Line Option
An agent can enable communications simulation in the Demo versions of the Siebel 
applications, which use the Siebel Mobile Web Client with the Sample Database, by 
including the command-line option /ctsim at the end of the command line, such as 
in the application shortcut. Any of the Siebel eBusiness Applications can support 
this command-line option.

Enabling by Modifying Configuration File
An agent can enable communications simulation in the Demo version of the Siebel 
applications, which use the Siebel Mobile Web Client with the Sample Database, by 
setting the following parameters in the [Communication] section of the 
application’s configuration file, such as uagent.cfg for Siebel Call Center:

CommEnable=TRUE
CommSimulate=TRUE

Enabling Simulation for Siebel Web Client
Users can access communications simulation from the Siebel Web Client by 
connecting the Web browser to an Applications Object Manager for which an 
administrator has activated simulation by setting server component parameter 
values. You can use this method of enabling simulation to provide a training 
environment for your contact-center agents.
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As described in “Parameters for Application Object Manager and Dedicated Web 
Client” on page 313, the CommSimulate parameter activates the Communications 
Simulator, and the CommEnable parameter activates the communications toolbar.

For more information about setting server component parameter values, refer to 
Siebel Server Administration Guide.

To enable or disable communications simulation for Siebel Web Client users

1 On each Application Object Manager that is to support communications 
simulation for users, set the server component parameter CommSimulate to 
TRUE. Or, to disable simulation, set it to FALSE. To set this parameter, do one of 
the following:

■ From the application-level menu, choose View > Site Map > Server 
Administration > Component, select Call Center Object Manager (for 
example), and set a value for the Simulate Communication parameter.

■ On the command line, enter (on one line) text similar to the following:

srvredit /g gateway_name /e enterprise_name 
/r $enterprise.app_object_mgr.CommSimulate=true /d bool /f

Substitute the values for your Siebel Gateway, Siebel Enterprise Server, and 
Application Object Manager component, as appropriate. For example, for 
Siebel Call Center, you might enter:

srvredit /g localhost /e siebel 
/r $enterprise.SCCObjMgr.CommSimulate=true /d bool /f

2 After setting the CommSimulate parameter value, restart the Siebel Server on 
which the Application Object Manager is running.

Administering Communications Session Manager
This section describes how to administer the server component Communications 
Session Manager. The short name for this component is CommSessionMgr.

This server component uses generic configuration parameters and does not need to 
be configured. However, you can configure logging parameters. For details, see 
“Parameters for Communications Session Manager” on page 323.
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Overview of Communications Session Manager
The Communications Session Manager supports multichannel user-interactive 
sessions for agents using the communications toolbar for voice, email, or other 
types of work items. It manages agent sessions, for which applicable interactive 
communications drivers are loaded into memory.

For most Siebel client deployment choices, the Communications Session Manager 
must be available for the instances of the Application Object Manager or Siebel 
Dedicated Web Client that connect to it for each agent’s communications session. 

In each case, the component that is employed is identified through the applicable 
data source for the Siebel application session. For each data source, a specific Siebel 
Gateway, Siebel Enterprise Server, and Siebel Server are associated. The 
Communications Session Manager component must be enabled and running on this 
Siebel Server.

Alternatively, you can specify the following communications configuration 
parameters, to identify the Communications Session Manager to use:

■ GatewayAddress. Specify the Siebel Gateway. For example, specify a value like 
“gateway-host” for this parameter.

■ EnterpriseServer. Specify the Siebel Enterprise Server. For example, specify a 
value like “siebel” for this parameter.

■ RequestServer. Specify the Siebel Server. For example, specify a value like 
“server-host” for this parameter.

■ CommSessionMgr. Specify the Communications Session Manager. For example, 
specify a value like “CommSessionMgr” for this parameter.

If an agent logs in using a configuration containing these parameters, the agent will 
be connected to the component identified by these values. For more information, 
see “Specifying Parameters for Communications Configurations” on page 80.

For information about how the CommLocalDriver parameter relates to the 
Communications Session Manager component, see “Parameters for Application 
Object Manager and Dedicated Web Client” on page 313.
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When Communications Session Manager Is Unavailable
If the Communications Session Manager stops running or becomes unavailable for 
some reason, all connected users (agents) will receive the following message in an 
alert-type dialog box in their browser: “Connection to Communications Server is 
down. Toolbar is reset!” 

For each such agent, the communications toolbar displays as if no communications 
driver is loaded. That is, the toolbar is displayed but most of the toolbar buttons are 
unavailable.

Running Communications Session Manager
When the Communications Management component group is enabled, the 
Communications Session Manager component is started automatically. For any 
machine on which you do not want to run Communications Session Manager, 
configure the Siebel Server not to start it.

Communications Session Manager is a request-mode server component. It relies on 
the services of the Server Request Broker server component. This component must 
be running on the Siebel Server for communications to be processed successfully.

NOTE: If a messaging server, such as a CTI middleware server, is restarted, then the 
Communications Session Manager server component that connects to it must also 
be restarted.

For more information about configuring, starting, and stopping Siebel Server 
components, refer to Siebel Server Administration Guide.

Administering Communications Configuration Manager
This section describes how to administer the server component Communications 
Configuration Manager. The short name for this component is CommConfigMgr.

This server component uses generic configuration parameters and does not need to 
be configured.
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The Communications Configuration Manager enhances application performance 
when agent communications sessions are initiated. It does this by reducing or 
eliminating the downloading of communications configuration data for each 
session. After the first agent login that uses a particular configuration, for all 
subsequent logins with the same configuration, the configuration is loaded from a 
cache rather than loaded from the database.

For information about enabling the use of this component using the 
CommConfigManager parameter, see “Parameters for Application Object Manager 
and Dedicated Web Client” on page 313.

The Communications Configuration Manager must be available for the instances of 
the Application Object Manager or Siebel Dedicated Web Client that connect to it 
for each agent’s communications session.

In each case, the component that is employed is identified through the applicable 
data source for the Siebel application session. For each data source, a specific Siebel 
Gateway, Siebel Enterprise Server, and Siebel Server are associated. The 
Communications Configuration Manager component must be enabled and running 
on this Siebel Server.

NOTE: You should enable the Communications Configuration Manager only after the 
communications configuration has been thoroughly tested and you are ready to 
deploy it to your agents. If any changes are made to the communications 
configuration, then you must restart the Communications Configuration Manager 
component in order to refresh the cached configuration data.

Running Communications Configuration Manager
When the Communications Management component group is enabled, the 
Communications Configuration Manager component is started automatically. For 
any machine on which you do not want to run Communications Configuration 
Manager, configure the Siebel Server not to start it.

For more information about configuring, starting, and stopping Siebel Server 
components, refer to Siebel Server Administration Guide.
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Administering Communications Inbound Manager
This section describes how to administer the server component Communications 
Inbound Manager. The short name for this component is CommInboundMgr.

The Communications Inbound Manager processes inbound work items, such as 
inbound email messages received with Siebel eMail Response implementations.

This server component uses generic configuration parameters and does not need to 
be configured. However, some parameters belonging to the SMTP Subsystem can 
optionally be specified for the server component, as described in “Configuring 
Parameters for Communications Inbound Manager” on page 332.

Running Communications Inbound Manager
When the Communications Management component group is enabled, the 
Communications Inbound Manager component is started automatically. For any 
machine on which you do not want to run Communications Inbound Manager, 
configure the Siebel Server not to start it.

Communications Inbound Manager is a request-mode server component. It relies 
on the services of the Server Request Broker server component. This component 
must be running on the Siebel Server for communications to be processed 
successfully.

NOTE: If a messaging server, such as an email server, is restarted, then the 
Communications Inbound Manager server component that connects to it must also 
be restarted.

As a request-mode component, Communications Inbound Manager is subject to the 
requirements described in “Synchronizing Request-Mode Server Components” on 
page 310.

For more information about configuring, starting, and stopping Siebel Server 
components, refer to Siebel Server Administration Guide.
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Configuring Parameters for Communications Inbound Manager
You can specify values for parameters for the Communications Inbound Manager 
server component. The parameters listed here, which belong to the SMTP 
Subsystem, can optionally be specified for the server component, the Siebel Server, 
or the enterprise. Each higher-level specification provides a default value that can 
be used if the parameter is not set at a lower level.

■ Administrator Email Address. Specify a value for the Administrator Email Address 
parameter, to provide an administrator email address to send messages to in case 
of inbound communications processing errors, when no such address is defined 
for the response group. (This parameter is specific to CommInboundMgr.)

■ Default Administrator Address. Specify a value for the Default Administrator 
Address parameter, to provide an administrator email address to send messages 
to in case of server errors, such as when the database connection has been 
broken. (This parameter is part of the SMTP Subsystem.)

■ Event Queue Directory. Specify a value for the Event Queue Directory parameter, 
to provide the name of the directory in which to store queued events. Use this 
parameter to specify a value to override the default location in the “bin/queued” 
directory. (This parameter is specific to CommInboundMgr.)

■ SMTP Server Name. Specify a value for the SMTP Server Name parameter, to 
provide the name of the SMTP server that will be used to send email to the 
administrator. (This parameter is part of the SMTP Subsystem.)

Activity Attachments Stored for Inbound Email
For each inbound email message that has been processed by Communications 
Inbound Manager, an activity record is created, using activity type Email - Inbound. 
The original content of the email is saved in the form of one or more attachments 
to this activity record.

The text parts of the original email message are saved in an attachment file named 
OriginalMsg.txt. For a plain-text message or the text component of a multipart 
MIME alternate message, OriginalMsg.txt includes the message headers and 
message body text. For an HTML-only email message (not multipart), 
OriginalMsg.txt contains the message headers and message body text extracted 
from the HTML.
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Embedded messages cause the creation of attachment files that contain the 
embedded message’s header and any text parts. These files are named 
EmbeddedMsgpartspecifier.txt, where partspecifier represents the file’s placement 
in the message’s embedding structure—for example, EmbeddedMsg01.txt, 
EmbeddedMsg3.4.txt, and so on.

For an HTML email message, all HTML components are saved in one or more 
attachment files. These files are named texthtmlpartspecifier.htm, where 
partspecifier represents the file’s placement in the message’s embedding structure—
for example, texthtml01.htm, texthtml3.4.htm, and so on.

Any attachments to the original email message are also saved as attachments to the 
activity record, using their original file names.

If the original message is more than 15,000 characters long (including any HTML 
markup), then the full message is saved as another attachment, named 
SiebelLongEmailBody.txt (for plain-text messages) or SiebelLongEmailBody.htm 
(for HTML messages).

Administering Communications Outbound Manager
This section describes how to administer the server component Communications 
Outbound Manager. The short name for this component is CommOutboundMgr.

The Communications Outbound Manager processes outbound communications, for 
email, fax, wireless message, or page channels. It supports communication 
requests, whether they are created and submitted directly or by Siebel Business 
Process Designer. It also supports outbound capabilities for Siebel eMail Response 
and for the Send Email, Send Fax, and Send Wireless Message commands.

For this server component, you can configure a parameter that specifies how Siebel 
bookmarks are generated and configure a logging parameter. Otherwise, this 
component uses generic parameters and does not need to be configured.

For details, see “Configuring Communications Outbound Manager” on page 334 
and “Configuring Shared or Separate Logging” on page 335.

See also Chapter 10, “Defining Outbound Communication Requests,” and other 
sections describing features that use outbound communications.
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Running Communications Outbound Manager
When the Communications Management component group is enabled, the 
Communications Outbound Manager component is started automatically. For any 
machine on which you do not want to run Communications Outbound Manager, 
configure the Siebel Server not to start it.

Communications Outbound Manager is a request-mode server component. It relies 
on the services of the Server Request Broker server component. This component 
must be running on the Siebel Server for communication requests to be dispatched 
successfully.

NOTE: If a messaging system server, such as an email server, is restarted, then the 
Communications Outbound Manager server component that connects to it must 
also be restarted.

As a request-mode component, Communications Outbound Manager is subject to 
the requirements described in “Synchronizing Request-Mode Server Components” 
on page 310. If Communications Outbound Manager has not been synchronized, as 
appropriate, then users who submit outbound communication requests may receive 
this error message: “Unable to find definition for component CommOutboundMgr.”

For more information about monitoring communication requests and server 
requests, see “Monitoring Outbound Communication Request Status” on page 442 
and “Monitoring Siebel Server Request Status” on page 443.

For more information about configuring, starting, and stopping Siebel Server 
components, refer to Siebel Server Administration Guide.

Configuring Communications Outbound Manager
For Communications Outbound Manager, you can configure a parameter that 
specifies how Siebel bookmarks are generated, configure a parameter that specifies 
whether logging should use shared or separate files, and configure logging levels.

For more information about configuring logging for server components, refer to 
Siebel Server Administration Guide.
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Configuring Siebel Bookmarks
In order to support the Attach Bookmark setting for advanced communications 
templates, the Siebel administrator must specify a value for the WebServer server 
component parameter for the Communications Outbound Manager.

This parameter specifies a string identifying the Web server and Application Object 
Manager to include in the URL, in the following form:

http://web_server/application_object_manager

In order to access the bookmarked record, the recipient users must have access to 
this Web server and Application Object Manager.

For more information about using the Attach Bookmark setting for advanced 
templates, see “Fields for Templates” on page 410.

Configuring Shared or Separate Logging
An administrator can review log files for Communications Outbound Manager to 
monitor its performance and to monitor user activities that invoke this component.

Depending on how you have configured the Communications Outbound Manager 
server component, a single log file may be generated for all requests, or a separate 
log file may be generated for each request (the default). The parameter that 
modifies this setting is called LogUseSharedFile.

Log files are written to the log subdirectory of the Siebel Server installation 
directory.

Set LogUseSharedFile according to how the server component is generally used:

■ For miscellaneous uses, including supporting the Send commands, sending 
auto-acknowledgement messages and replies for Siebel eMail Response, or 
sending several outbound requests to a small number of recipients each, it may 
be best to set LogUseSharedFile to TRUE, to reduce clutter in your log directory.

■ For high-volume outbound communication requests, however, including those 
sent using Siebel Marketing, it may be best to leave this parameter set to FALSE, 
to generate a single log file for each request that you can analyze. 
LogUseSharedFile is FALSE by default.

The log file names vary according to how you set LogUseSharedFile:
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■ When a single log file is generated for all requests, the file name is in the form 
CommOutboundMgr.log.

■ When a separate log file is generated for each request, the file names are in the 
form CommOutboundMgr_xxx.log, where xxx is the ID number for the request’s 
thread in the Communications Outbound Manager component.

The business service Outbound Communications Manager, run on the Siebel Server, 
also generates log files in the same location, using the same naming convention.

Configuring Log Levels
An administrator can set logging levels for Communications Outbound Manager, to 
specify the degree of detail captured in the logs. Logging levels are:

■ CommSrvrError (level 1). The lowest level of logging. The most severe errors are 
logged. Level 1 is the default.

■ CommSrvrWarning (2). Moderate level of logging. Logs more detail than level 1. 
Generally recommended for production use.

■ CommSrvrTrace (3). Moderately high level of logging. Logs more detail than 
level 2.

■ CommSrvrDebug (4). The highest level of logging. All errors and warnings and 
other events are logged. Use level 4 for testing purposes.

The procedures below are for the Siebel Server Manager, both the Siebel client 
version (GUI) and the command-line version.

To configure log levels for Communications Outbound Manager (GUI)

1 From the application-level menu, choose View > Site Map > Server 
Administration > Components.

2 In the Components list, select the record for the Communications Outbound 
Manager component.

3 Click the Component Events Configuration tab.

4 Select the record for the event type CommServer.

5 Specify one of the values described above, from 1 to 4.
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To configure log levels for Communications Outbound Manager (command line)

1 Start the command-line version of the Siebel Server Manager.

2 Type the following at the command line:

change evtloglvl CommSrvr=n for comp CommOutboundMgr

where n is the log level you want to specify, from 1 to 4.

Specifying Siebel Server Name Using Driver Parameter
If you have more than one Siebel Server, and you want all outbound 
communications that are processed using a particular communications driver or 
profile to use a specific Siebel Server, you can configure a parameter to specify the 
Siebel Server name.

To do this, set the value of the Siebel Server driver parameter (generally, using a 
profile parameter override) to the name of the Siebel Server that is to handle the 
delivery of the communications. 

This parameter is supported for all of the Siebel-provided communications drivers 
used for outbound communications (using the Communications Outbound 
Manager server component).

NOTE: The value of the Siebel Server parameter must exactly match the actual name 
of the Siebel Server.

As with other driver parameters, you can either specify a default value or provide 
an override value for a particular communications profile.

NOTE: If an outbound communication request includes multiple templates, and a 
value is provided for this parameter for the delivery profile associated with any of 
these templates, then a different value cannot be specified for this parameter for 
profiles for any of the other templates specified in the same request.

For more information, see the driver parameter sections in Appendix C, “Using 
Email, Fax, and Other Systems.”
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Specifying Component Name for Outbound Communication Requests
When you create an outbound communication request, you can specify the name 
of the server component that is to process the request.

The default component name is CommOutboundMgr (for Communications 
Outbound Manager). If you have configured new server components based on 
CommOutboundMgr, you can give them other names. Then, when you create 
requests, you can provide the applicable component name in the Component Name 
field for the request. 

When Siebel Server load-balancing is in effect, you can create multiple components 
using the same name, such as on a subset of your total set of Siebel Servers.

If different Siebel Servers may use different Siebel repository (.srf) files, then you 
may want to use this mechanism to make sure that certain types of requests are 
processed by a specified set of Siebel Servers.

For more information, see the description for the Component Name field, in the 
section “Fields for Outbound Communication Requests” on page 438.

Outbound Communications for Siebel Mobile Web Client
Outbound communications sent from Siebel Web Client or Siebel Dedicated Web 
Client are processed immediately. Communications sent from Siebel Mobile Web 
Client, while you are connected to the local database and disconnected from the 
enterprise database, are saved until you synchronize. They are then processed for 
delivery by the Communications Outbound Manager server component.
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This chapter provides information about end-user operations relating to 
communications capabilities.

Most of the tasks described in this chapter are typically performed by end users 
such as call center agents who are primary users of communications features. These 
tasks may also be performed by users such as call center managers or 
communications administrators.

NOTE: End users are not expected to directly use this guide. Your Siebel application 
implementation may differ from what is described in this chapter. This chapter 
contains references to administration topics that relate to the end-user operations 
described here.

For information about creating communications templates and about creating and 
submitting outbound communication requests, which are advanced end-user 
activities, see Chapter 9, “Configuring Communications Templates,” and 
Chapter 10, “Defining Outbound Communication Requests.”

Setting Communications User Preferences
The User Preferences screen contains two tabs that contain communications-related 
settings. Users can modify, or may need to modify, these settings depending on the 
needs of your business or on the users’ preferences.

The Communications tab also contains a list of the agent’s ACD queues, which the 
agent can selectively log into or log out of.

Preferences are stored separately for each user, and are stored separately based on 
Siebel client type:
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■ Preference settings specified in the Siebel Web Client are stored on the Siebel 
Server machine.

■ Preference settings specified in the Siebel Dedicated Web Client or Siebel Mobile 
Web Client are stored on the user’s local machine.

NOTE: Generally, end users should change preference settings only at the direction 
of the system administrator or call-center administrator.

Specifying Communications Preferences
This section describes how to specify communications preferences.

To specify communications preferences

1 From the application-level menu, choose View > User Preferences.

The User Preferences screen is displayed.

2 Click the Communications tab, or the Outbound Communications tab.

Communications preferences are displayed.

3 Specify the appropriate preferences. Preference settings are described in the 
following sections:

■ “Preference Settings in the Communications Tab” on page 340

■ “Logging Into or Out of an ACD Queue” on page 346

■ “Preference Settings in the Outbound Communications Tab” on page 347

4 As necessary for the particular setting, log out of the Siebel application and log 
in again. 

The descriptions for each user preference setting indicate whether this step is 
required.

Preference Settings in the Communications Tab
This section describes in detail the preferences in the Communications tab in the 
User Preferences screen. The preference settings are grouped by category. Each 
preference applies only to certain communications features.
340 Siebel Communications Server Administration Guide Version 7.5.3



Communications Operations for End Users

Setting Communications User Preferences
General Settings
The following are the communications preferences in the General category. These 
preferences apply to users who are part of a communications configuration. Such 
users would typically handle voice calls using Siebel CTI, or receive inbound work 
items using Siebel eMail Response.

■ Receive Screen Pop. If a user should not be the recipient of screen pops upon 
communications events, such as receiving a new or transferred work item, the 
user can clear this check box to disable receiving screen pops.

If this option is not checked, no screen pops will be received. By default, each 
user receives screen pops.

■ Send Screen Pop. When this check box is checked, attaching Siebel client context 
data is enabled for work item transfers and conferences and for internal calls 
placed by the agent.

If this option is not checked, context data will not be attached—no screen pops 
will be sent. By default, each communications user sends screen pops.

For more information about requirements for screen pops, see “Event 
Responses” on page 154.

■ Bring Siebel to Front. This drop-down list specifies whether, or when, the Siebel 
client window should be restored from being minimized and move to the front 
of the screen on a communications event such as an inbound work item.

NOTE: The behavior of this feature varies on Microsoft Windows platforms. In 
some cases, a non-minimized Siebel client window may not move to the front. 
In this case, restore the window from the taskbar.

By specifying either On All Communications Events or On Matching Events, the 
agent can make sure that the Siebel application window will be displayed when 
it is needed—to use the communications toolbar or other features, or to view 
screen pops. Screen pops, if they are enabled, will still be generated regardless 
of the setting of the Bring Siebel to Front option.

The options are:
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■ On All Communications Events. Brings the Siebel client window to the front on 
all communications events received at the agent’s machine. This option is the 
default and is best for general use by agents running a single instance of the 
Siebel client.

■ On Matching Events. Brings the Siebel client window to the front on 
communications events that match that instance of the Siebel client. 

This option should be used only by agents running multiple instances of the 
Siebel client that are each enabled for session communications but that have 
different settings, such as for language or locales. In such a situation, 
different event handlers may be defined, for example, for each language or 
locale. Use this setting only at the instruction of your administrator.

Administrators can find more information by referring to the description of 
the MaxCommToolbars configuration parameter, in “Specifying Parameters 
for Communications Configurations” on page 80.

■ Off. Does not bring the Siebel client window to the front on communications 
events. The window may remain hidden behind another window or 
minimized.
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■ Auto Login to Call Center at Startup. When this check box is checked, an agent 
automatically logs into the call center’s communications systems when starting 
the Siebel client or connecting to the Siebel database.

What the agent logs into depends on how your communications environment 
has been deployed and how login commands are configured in the 
communications configuration. Agents can log into ACD queues or Siebel 
Universal Queuing. Auto-login can make it easier for your users to begin 
receiving inbound work items from these sources.

Voice agents who are authorized users for more than one teleset may be best 
advised not to use auto-login, so they can verify which extension they are using 
before logging in.

NOTE: Generally, end users should change this setting only at the direction of the 
system administrator or call-center administrator.

Whether this control can be set by agents depends on the setting of the 
AutoLogin configuration parameter. Administrators can find more information 
under “Specifying Parameters for Communications Configurations” on page 80 
and “Configuring Communications Login and Logout” on page 222.

Sound Settings
The following are the communications preferences in the Sound category. These 
preferences apply to users who are part of a communications configuration. Such 
users would typically handle voice calls using Siebel CTI, or receive inbound work 
items using Siebel eMail Response.

■ Enable Sound. Lets the agent specify if a sound file will play when an inbound 
work item arrives. By default, no sound file plays.

If Enable Sound is checked, when a work item arrives, if no valid sound file is 
specified or the specified file does not exist, the computer may beep.
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■ Sound File. Lets the agent specify which sound file to play, when Enable Sound 
is checked. For example, you can specify ringin.au or another such file that is 
valid for your environment.

The default sound file, files/ringin.au, is in the following locations:

■ eapps\public\language_code, in the Siebel Server installation directory

■ public\language_code, in the Siebel Dedicated Web Client installation 
directory

where language_code represents the language code for the installed software, 
such as ENU for U.S. English.

Or, you can specify the full path for a sound file that is to be loaded, if the file is 
located in a different directory, and if the Java applet for the communications 
toolbar is signed. For example, the following may be valid paths for specifying a 
sound file on a user’s local system or on a network location:

■ e:\dev\ringin.au (for Microsoft Windows)

■ \\host\dev\ringin.au (for Microsoft Windows)

■ file:///e:\dev\ringin.au (for Microsoft Windows)

■ http://network_path/ringin.au (for Microsoft Windows or UNIX)

■ /usr/ringin.au (for UNIX)

Teleset and Configuration Settings
The following are the communications preferences in the Teleset and Configuration 
category. These preferences apply to users who are part of a communications 
configuration. Such users would typically handle voice calls using Siebel CTI, or 
handle other types of inbound work items through the communications toolbar.

The first two options described apply only to agents who handle voice calls using 
Siebel CTI.
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■ Teleset. Lets the agent specify the teleset to use the next time the agent logs in.

The telesets an agent can choose from are those that have been associated with 
the agent, and will have been specified when the teleset, agent, and extension 
data was entered in the Communications Administration views. The Standard 
Extension field lists extensions for the currently selected teleset.

An agent can choose a teleset from the Teleset field only if at least one teleset 
has been associated with the agent, and the agent is not using a hoteling teleset.

If the agent has logged into a hoteling computer, the current hoteling teleset is 
shown in this field—the agent cannot change it.

NOTE: After you choose a different teleset and extension, you must log out and 
log in again in order for the new extension to be in effect.

Administrators can find more information under “Specifying Telesets” on 
page 94.

■ Standard Extension. Lets the agent specify the standard extension to use, from the 
teleset selected in the Teleset field, the next time the agent logs in.

The available extensions to choose from are those of the current teleset, and will 
have been specified when the teleset, agent, and extension data was entered in 
the Communications Administration views. Standard extensions (of type “S”—
for standard DN) are listed for each teleset the agent is assigned to, or for each 
hoteling teleset.

If the agent is using a computer associated with a hoteling teleset, the extensions 
of this teleset are shown in this field.

NOTE: After you choose a different extension, you must log out and log in again 
in order for the new extension to be in effect.

Administrators can find more information under “Specifying Telesets” on 
page 94.
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■ Configuration. This option specifies which communications configuration is in 
effect for the agent.

This field lists all configurations with which the agent has been associated. If 
this option has not previously been chosen, the default configuration displayed 
here is the agent’s primary configuration, as specified by the administrator. 
Otherwise, the configuration displayed is the last configuration used.

Although an agent may be specified for multiple configurations, only one 
configuration can be in effect at one time.

NOTE: After you choose a different configuration, you must log out and log in 
again in order for the new configuration to be in effect. Just before you log out 
to end a session for any configuration that is not your regular configuration, you 
should change this field back to the configuration you regularly use.

Administrators can find more information under “Specifying Agents” on 
page 89.

Logging Into or Out of an ACD Queue
This section describes how to log into or out of an ACD queue. This procedure is 
performed in the Communications view of the User Preferences screen.

NOTE: This section applies only to users who handle voice calls (Siebel CTI users) 
and receive inbound calls routed from one or more ACD queues. Logging into ACD 
queues is not always necessary for voice call implementations, depending on the 
switch type. Consult your administrator.

The procedure below should be used in conjunction with the Login and Logout 
buttons on the communications toolbar. Using the Login and Logout buttons on the 
communications toolbar, you can log into/out of all ACD queues designated as 
primary queues for you, or log into/out of other communications systems such as 
Siebel Universal Queuing.

In the Agent Queues list in the User Preferences screen, you can log into or out of 
individual queues selectively, including those which are not designated as primary.
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For more information, see “Using the Communications Toolbar” on page 352. 
Administrators can find more information in the section “Configuring 
Communications Login and Logout” on page 222.

To log into or out of an ACD queue

1 From the application-level menu, choose View > User Preferences.

The User Preferences screen is displayed.

2 Click the Communications tab.

The Agent Queues list appears, below the Communications form. All ACD 
queues with which the agent is associated are listed, and the current login status 
for each queue is indicated.

3 To log into a queue, select the record for the queue, then click Login in the Agent 
Queues list applet.

4 To log out of a queue, select the record for the queue, then click Logout in the 
Agent Queues list applet.

Preference Settings in the Outbound Communications Tab
This section describes in detail the preferences in the Outbound Communications 
tab in the User Preferences screen. The preference settings are grouped by category. 
Each preference applies only to certain communications features.

Send Email Settings (Also for Some Other Send Commands)
The following are the outbound communications preferences in the Send Email 
category. These preferences apply to using some or all of the Send commands: Send 
Email, Send Fax, Send Wireless Message, or Send Page. Also refer to the settings 
under the Advanced Features category.

■ Upon Sending Messages Generate. Specifies activity generation for messages sent 
using the Send Email, Send Fax, Send Wireless Message, and Send Page 
commands. Options are:

■ Public activities. Sets the Internal flag to FALSE for activity records generated 
by sending outbound messages. The Internal flag is used to restrict visibility 
of activity records.
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■ Private activities. Sets the Internal flag to TRUE for activity records generated 
by sending outbound messages.

■ No activities. Specifies that no activity records should be generated by sending 
outbound messages.

For more information, see “Using Activity Records for Send Commands” on 
page 386.

■ Default Profile. Specifies the default communications profile for a user to use, for 
the Send Email and Send Fax commands. 

The default profile information is copied to the From field in the Send Email and 
Send Fax windows. Alternatively, agents can specify the profile directly.

The profile provides access to the communications driver (typically, the Internet 
SMTP/POP3 Server driver) that serves as the interface from the Siebel software 
to the email/fax server. For the Send Email and Send Fax commands, the profile 
handles outbound communications using the SMTP protocol.

Which profiles are available to choose from depends on the visibility applicable 
to the user. A profile is visible in the following cases:

■ The user created the profile for personal use, using the My Profiles view in 
the Communications screen.

■ The user’s responsibility is one of the responsibilities associated with the 
profile.

Profiles applicable to the wireless messages are associated with the recipient’s 
mobile device from the Mobile screen. For more information, see “Specifying 
Mobile Device Settings” on page 388.

■ Default Recipient Class. Specifies the default choice for where recipient email or 
fax address information will be populated, for the Send Email and Send Fax 
commands. Choices are To, Cc, and Bcc.

For example, an individual user might generally want to populate recipients to 
the To field. However, depending on the user’s typical activities or workflow and 
on your company’s business needs, it may be more appropriate to populate 
recipients to the Cc or Bcc field instead of the To field.
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■ Default Message Format. Specifies whether email or fax messages composed in 
the Send Email or Send Fax windows can be formatted and sent using HTML, or 
are plain text only.

Choose the option HTML to enable HTML editing controls for Send Email and 
Send Fax, or specify Plain Text to edit and send messages as plain text only.

When the default message format is HTML, formatting is preserved for email 
and fax messages you send. Email messages are sent as HTML messages. Fax 
messages are, of course, sent as facsimiles.

This preference also specifies which templates are displayed in the Body drop-
down list in the Send Email and Send Fax windows, based on the setting of the 
HTML Template check box for each applicable template. HTML templates are 
listed when the default message format is HTML, and plain-text templates are 
listed when the default message format is plain text.

For more information, see:

■ “Using the Send Email Command” on page 369

■ “Using the Send Fax Command” on page 377

■ “Editing and Formatting Controls for Send Email and Send Fax” on page 380

■ Chapter 9, “Configuring Communications Templates”

■ Email Client. Specifies whether to use a supported third-party email client 
application for the Send Email command. If a third-party option is not specified, 
then the user can use the native Siebel email client.

■ Lotus Notes. Specify that you will use Lotus Notes for the Send Email 
command.

■ Microsoft Outlook. Specify that you will use Microsoft Outlook for the Send 
Email command.

■ Siebel eMail Client. Do not use a third-party email client. Use the email client 
option provided by Siebel Systems. This option is sometimes referred to as 
the “native Siebel email client.”

Each option requires the administrator to perform additional configuration and 
integration steps. Administrators: for more information, see “Interfacing with 
Email and Fax Servers” on page 517.
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NOTE: The Send Fax command does not support using Lotus Notes or Microsoft 
Outlook.

■ Siebel/Outlook Form. If Microsoft Outlook is specified for the Email Client setting, 
then specify the Outlook form you will use. The name of the form provided by 
Siebel Systems is IPM.Note.Siebel. The name specified here must match the 
name of the form the administrator has installed and specified.

■ Siebel/Lotus Form. If Lotus Notes is specified for the Email Client setting, then 
specify the Notes form you will use. The name of the form provided by Siebel 
Systems is Siebel Memo. The name specified here must match the name of the 
form the administrator has installed and specified.

Email Response Settings
The following are the outbound communications preferences in the Email Response 
category. These preferences apply only to using Siebel eMail Response. Also refer 
to the settings under the Advanced Features category.

For more information about these preference settings and about composing email 
replies, refer to Siebel eMail Response Administration Guide and Siebel Call Center 
User Guide.

■ Default Greeting Template. Specifies a communications template (for the email 
channel) to use as a greeting for an email reply sent using Siebel eMail Response. 
The template content is inserted automatically into the message.

■ Default Closing Template. Specifies a communications template (for the email 
channel) to use as a closing for an email reply sent using Siebel eMail Response. 
The template content is inserted automatically into the message.
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■ Default Message Format. Specifies whether email replies to inbound messages can 
be formatted and sent using HTML, or are plain text only. 

Choose the option HTML to enable HTML editing controls in the Outbound 
Message form, or specify Plain Text to edit and send messages as plain text only.

When the default message format is HTML, formatting is preserved for email 
messages you send, and messages are sent as HTML messages.

This preference also specifies which templates are displayed in the Body drop-
down list in the Outbound Message form, based on the setting of the HTML 
Template check box for each applicable template. HTML templates are listed 
when the default message format is HTML, and plain-text templates are listed 
when the default message format is plain text.

For more information, see Chapter 9, “Configuring Communications 
Templates.”

■ Include Original Message in Reply. Specifies if the content of the original inbound 
message to which an agent is replying is included in the reply.

■ Remain on Same View After Send (Cancel). Specifies that, after clicking Send or 
Cancel in the Outbound Message form, the agent prefers to stay in this view, 
rather than to return to a display of the Communications list. If the agent clicked 
Send, the next record is displayed from the current list of communications.

Advanced Features Settings
The following are the outbound communications preferences in the Advanced 
Features category. These settings affect both the Send Email command and email 
replies you compose using Siebel eMail Response.

For more information, see “Using the Send Email Command” on page 369 and 
Chapter 9, “Configuring Communications Templates.”

For more information about composing email replies, refer to Siebel eMail Response 
Administration Guide and Siebel Call Center User Guide.
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■ Language. Specifies the language that determines which templates may be 
displayed in the Body drop-down list for each of the Send commands or for the 
Outbound Message form for email replies.

Templates are displayed only if the language specified here matches that 
specified for the template. Template filtering is based on both language and 
locale, and on other factors. For details, see “Template Visibility and Access” on 
page 398.

If this field is blank, then template filtering as described above refers to the 
language in effect for the Application Object Manager.

This setting can be overridden at runtime in the window for the Send command 
or in the Outbound Message form, in order to display other templates.

■ Locale. Specifies the locale that determines which templates may be displayed in 
the Body drop-down list for each of the Send commands or for the Outbound 
Message form for email replies.

Templates are displayed only if the locale specified here matches that specified 
for the template. Template filtering is based on both language and locale, and on 
other factors. For details, see “Template Visibility and Access” on page 398.

If this field is blank, then template filtering as described above refers to the 
locale in effect for the Application Object Manager.

This setting can be overridden at runtime in the window for the Send command 
or in the Outbound Message form, in order to display other templates.

Using the Communications Toolbar
The communications toolbar allows you to manage many types of inbound and 
outbound communications work items. Channel types can include voice, email, fax, 
wireless message, and others.

Supported channel types depend on the Siebel and third-party products your 
company is using and on your job function. Your company may support types of 
communications work items not listed here.
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The toolbar buttons can be configured based upon the Siebel modules and third-
party communications systems available to you. The communications toolbar is 
used by various Siebel modules that support communications functions.

The Siebel administrator or configurator can customize the communications 
toolbar, such as to modify the command a button invokes or add buttons for new 
commands. For details, see “About Communications Toolbar Configuration” on 
page 265.

The agent can use a menu command to refresh the status of the communications 
toolbar. For details, see “Menu Command for Refreshing the Communications 
Toolbar” on page 364.

NOTE: If a record is being created or edited, and has not been committed, then 
clicking a button on the communications toolbar might not perform the desired 
function correctly. You will not be able to save the record if some required fields 
have not yet been filled in appropriately. Before performing an action such as to 
transfer a call (and send a screen transfer), agents should complete and commit all 
changes or undo the record, as appropriate.

Communications Toolbar Controls
The communications toolbar controls work together to allow you to perform 
communications tasks within your Siebel application. Toolbar controls have 
ToolTips, so you can point to any control to learn its name or to determine its 
current state or availability.

NOTE: All communications features in the Siebel application user interface are 
subject to the configuration decisions for your company’s implementation.

■ Channel Type Indicator. Indicates the channel type of the active work item, such 
as email, phone, and so on. If there are no active work items, the icon will be 
blank.

■ In-Queue Time Indicator. Indicates, in the ToolTip text, how long the active work 
item has been assigned to you (in-queue time).
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■ Elapsed Time Indicator. Indicates the working time for the active work item, in the 
form HH:MM:SS, where HH is the hours, MM is the minutes, and SS is the 
seconds. This is the time elapsed since a work item became active, such as when 
an inbound call was answered.

■ Text Input Field. Allows you to enter data such as the extension of a person to 
whom you want to transfer a voice call or of a person to whom you want to make 
a new call.

NOTE: Keyboard shortcuts for communications commands do not use as input 
any data entered into this field.

■ Initiate Work Item. Allows you to initiate a communications work item. Use the 
pop-up menu to initiate a work item of the desired channel:

■ Make Call (voice/phone channel)

■ Send Email (email channel)

■ Send Fax (fax channel)

■ Send Wireless Message (wireless message channel)

■ Send Page (pager channel)

■ Accept Work Item. Indicates the channel type of an active inbound 
communications work item that has arrived. You can click the main button to 
accept the work item, or use the pop-up menu.

■ Accept Call (voice/phone channel)

■ Accept Email (email channel)

■ A multichannel icon indicates that work items of multiple channels have 
arrived, such as a voice call and an email message. Use the pop-up menu to 
accept an individual work item of a specific channel.

■ Release Work Item. Allows you to release or disconnect the active work item.

■ Blind Transfer. Allows you to perform a one-step transfer of a work item such as 
a voice call.

■ Consultative Transfer. Allows you to initiate, and to complete, a two-step transfer 
of a voice call.
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■ Conference. Allows you to initiate, and to complete, a conference call.

■ Retrieve Call. Allows you to retrieve the original call when the intended recipient 
declines a consultative transfer or conference call.

■ Pause Work Item. Allows you to pause the active work item, such as to put a voice 
call on hold.

■ Work Items list. Allows you to select a paused work item on which to resume 
work.

■ Resume Work Item. Allows you to resume work on a paused work item selected 
from the Work Items list.

■ Forward Work Items/Cancel Forward. Allows you to forward inbound work items, 
such as forwarding voice calls to a different extension, and to cancel forwarding.

■ Change Ready State. For each supported inbound channel type, allows you to 
specify that you are unavailable to accept work items (Not Ready state), or that 
you are available again (Ready state). Use the pop-up menu to change the state 
for a specific channel. For example:

■ Ready/Not Ready for Call (voice/phone channel)

■ Ready/Not Ready for Email (email channel)

■ Login. Allows you to log into a communications system such as an ACD queue 
or Siebel Universal Queuing.

■ Logout. Allows you to log out of a communications system such as an ACD queue 
or Siebel Universal Queuing.

Logging Into the Communications System
If this capability is supported by your company’s call center implementation, you 
can log into and out of elements of your communications system by using the Login 
and Logout buttons.

Your Siebel application may be configured to log you into ACD call queues or Siebel 
Universal Queuing, and may be configured to support automatic login or automatic 
logout. For voice calls, these capabilities depend on the CTI middleware your 
company uses. Siebel CTI Connect (based on Intel NetMerge) supports automatic 
login and automatic logout.
Version 7.5.3 Siebel Communications Server Administration Guide 355



Communications Operations for End Users

Using the Communications Toolbar
If the option Auto Login to Call Center at Startup is checked in your 
communications user preferences, starting the Siebel application automatically logs 
you in. Alternatively, automatic login may be set by the administrator in the 
communications configuration.

If automatic logout is set by the administrator, exiting the Siebel application 
automatically logs you out of applicable communications systems, such as ACD 
queues.

Use Login and Logout commands and the Auto Login to Call Center at Startup 
setting as instructed by your call center manager.

For more information about the Auto Login to Call Center at Startup user preference, 
see “Preference Settings in the Communications Tab” on page 340.

For information about logging into or out of ACD queues selectively, see “Logging 
Into or Out of an ACD Queue” on page 346.

To log into the communications system manually

■ After starting the Siebel application, click Login.

To log out of the communications system

■ Click Logout.

Receiving Inbound Work Items
When an inbound work item is routed to you, the Accept Work Item button blinks, 
and you can accept and begin working on the item.

The Accept Work Item button shows what type of work item is coming in: a phone 
icon represents a voice call, an envelope icon represents an email message, and so 
on.

When an inbound work item arrives, the following events may also occur:

■ Customer data may be displayed in the customer dashboard.

■ A screen pop with relevant data may appear, or you may need to navigate to the 
appropriate part of the Siebel application.
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To accept an inbound work item

■ Click Accept Work Item when the pause blinks to indicate the arrival of a work 
item.

You can have multiple work items at the same time, such as voice calls on hold or 
other paused work items. However, only one work item is active at a time. The 
channel type of the active work item is indicated on the left side of the 
communications toolbar.

To release the current work item

1 Select the work item from the Work Items list.

2 Click Release Work Item, as appropriate for the channel type for the work item.

NOTE: If you are working with an activity record or another type of record that is 
automatically associated with a work item, you must save any changes to the record 
before you release the work item. In addition, in order to make changes after 
releasing the work item, you must first refresh the record. Otherwise, changes you 
make to the record may be lost.

Initiating Work Items
You can initiate communications work items, such as voice calls or email messages, 
from the communications toolbar. The Initiate Work Item button allows you to 
choose the channel type for the work item.

NOTE: Using the Send Email, Send Fax, Send Wireless Message, or Send Page 
commands in the File menu is equivalent to using the communications toolbar to 
initiate these activities. For more information, see “Sending Email, Fax, Page, and 
Wireless Messages” on page 368.
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To initiate a work item

1 Optionally, specify the recipient for the work item by selecting a contact or 
employee record, or by entering a phone number into the text input field.

NOTE: Recipient information entered into the text input field of the 
communications toolbar applies to initiating voice calls only. It does not apply 
to initiating email, fax, page, or wireless messages.

2 Do one of the following: 

■ If no work item has been initiated within the current session, click Initiate 
Work Item to initiate a work item of the channel type that corresponds to the 
current context.

■ If a work item of a particular channel was previously initiated, click the 
Initiate Work Item button to initiate another work item of the same channel 
type.

■ If you want to choose the channel type explicitly, click the arrow to the right 
of Initiate Work Item, then select a supported channel type from the 
displayed menu.

3 If you did not specify contact information first, do so now in the dialog box that 
appears.

To release the current work item

1 Select the work item from the Work Items list.

2 Click Release Work Item, as appropriate for the channel type for the work item.

NOTE: If you are working with an activity record or another type of record that is 
automatically associated with a work item, you must save any changes to the record 
before you release the work item. In addition, in order to make changes after 
releasing the work item, you must first refresh the record. Otherwise, changes you 
make to the record may be lost.
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Transferring or Conferencing Work Items
You can transfer a current work item to another person (such as when you need to 
escalate an item to a supervisor, or conference another person into a customer call). 
A voice call can also be transferred to an ACD call queue, depending on your call 
center.

Three transfer and conference operations are supported:

■ Blind transfer (one-step transfer)

■ Consultative transfer (two-step transfer, voice calls only)

■ Conference (two steps, voice calls only)

NOTE: If a screen transfer of the transferring agent’s current record will be sent to the 
receiving agent of a transferred work item, then any changes to this record must be 
saved before the agent performs the transfer. If a single record only is displayed in 
a list, the transferring agent must save changes explicitly before transferring.

To perform a blind transfer on the active work item

1 Specify the person to whom you want to transfer the active work item by 
selecting an employee record or by entering contact information, such as phone 
extension, in the text input field.

2 Click Blind Transfer.

The work item is released immediately.

To perform a consultative (two-step) transfer on the active voice call

1 Specify the person to whom you want to transfer the active voice call by 
selecting an employee record or by entering the recipient’s extension in the text 
input field.

2 Click Consultative Transfer.

The current call is paused, and the transfer recipient is dialed.

3 Do one of the following: 
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■ When the transfer recipient answers and indicates acceptance of the transfer, 
click Consultative Transfer again (toggle the button) to complete the transfer 
and release the call.

■ If the transfer recipient does not accept the transfer, click Retrieve Call to 
retrieve the call.

To create a conference for the active voice call

1 Specify the person with whom you want to conference the active voice call by 
selecting an employee record or by entering the recipient’s extension in the text 
input field.

2 Click Conference.

The current call is paused, and the conference recipient is dialed.

3 Do one of the following:

■ When the conference recipient answers and indicates acceptance of the 
conference, click Conference again (toggle the button) to complete the 
conference and include all parties on the active call.

■ If the conference recipient does not accept the conference, click Retrieve Call 
to retrieve the call.

4 Repeat Step 1 through Step 3 to add participants, as appropriate.

Pausing and Resuming Work Items
You can pause the active work item, such as putting a voice call on hold, and you 
can resume a paused work item.

To pause the active work item

■ Click Pause Work Item.

A voice call is put on hold, or a work item of another channel is paused, until 
you resume it.

To resume a paused work item or activate a different item

1 If you have an active work item, pause it, as described above.
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2 Select a work item from the Work Items list.

3 Click Resume Work Item to activate the selected work item.

Forwarding Work Items
You can have inbound work items of supported channel types forwarded to you, 
such as having voice calls forwarded to you at a different extension. Only work 
items subsequently routed to you will be forwarded. The toolbar button is a toggle, 
where the button name changes depending on the state.

To specify forwarding for inbound work items

1 In the text input field, enter the contact information, such as a phone extension, 
where you want your work items forwarded.

2 Click Forward Work Items.

3 Toggle the button to cancel forwarding.

Changing Ready State
You can specify that you are unavailable to receive new inbound work items of each 
supported channel type (such as when you need time to complete after-call work, 
or you are taking a break). For each channel type, new work items will not be 
assigned to you while the Not Ready state is set for that channel.

You can choose Change Ready State separately for each channel type, or for work 
items of all supported channel types. The toolbar button is a toggle.

If all channels are in Not Ready state, the button is toggled down (appearing to be 
depressed). If any, or all, channels are in Ready state, the button is toggled up.

To indicate that you are not ready to receive inbound work items

■ Do one of the following:

■ Click Change Ready State to indicate that you are not ready to receive any 
inbound work items of all channel types for which you are eligible.
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■ Click the arrow to the right of Change Ready State, then choose one or more 
options from the displayed menu to indicate that you are not ready to receive 
work items for the applicable channel types.

NOTE: If you click the Change Ready State button to set the Not Ready State for all 
channel types, but the button does not display as “toggled-down” (depressed), this 
may be due to a configuration error or some other issue for one or more channels. 
Please report this issue to your supervisor. You can still choose the Not Ready State 
for individual channels, as described in the second bullet item above.

To indicate that you are ready to receive inbound work items

■ Do one of the following:

■ Click Change Ready State to indicate that you are ready to receive any 
inbound work items of all channel types for which you are eligible.

■ Click the arrow to the right of Change Ready State, then choose one or more 
options from the displayed menu to indicate that you are again ready to 
receive work items of the applicable channel types.

Using Communications Menu Commands
This section describes using the Communications submenu and communications 
commands in the applet-level menus.

The Communications submenu, which is a submenu of the View application-level 
menu in a communications-enabled Siebel application, contains several 
communications commands for agents to use. The applet-level menus also contain 
communications commands. Some of the menu commands may perform functions 
equivalent to buttons in the communications toolbar.
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The communications-related menu options support context sensitivity. Agents can 
initiate several communications operations that extract data from Siebel database 
records, such as phone numbers for contacts or service requests, in order to initiate 
communications or take actions affecting the current communications work item.

NOTE: If a record is being created or edited, and has not been committed, then 
choosing a communications menu command might not perform the desired 
function correctly. You will not be able to save the record if some required fields 
have not yet been filled in appropriately. Before performing an action such as to 
transfer a call (and send a screen transfer), agents should complete and commit all 
changes or undo the record, as appropriate.

To choose communications commands

■ Do one of the following:

■ From the application-level menus, choose View > Communications, then 
choose one of the displayed submenu commands.

■ From the applet-level menu, choose one of the displayed communications 
commands.

Example commands may include Answer Call, Associate, Blind Transfer, View Work 
Item, and so on.

The available commands in these menus vary according to the communications 
configuration in effect for the agent. Administrators can customize the content and 
functioning of the Communications submenu and the applet-level menus by 
working with the commands in the All Commands view in the Communications 
Administration screen. For more information, see “Configuring Communications 
Menu Commands” on page 277.

NOTE: If you are working with an activity record or another type of record that is 
automatically associated with a work item, you must save any changes to the record 
before you release the work item. In addition, in order to make changes after 
releasing the work item, you must first refresh the record. Otherwise, changes you 
make to the record may be lost.
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Menu Commands for Displaying Error Messages
Agents can choose the following menu commands in order to redisplay messages, 
such as error messages, that had previously appeared in the area above the 
communications toolbar and to the right of the application-level menus. These 
commands may be helpful for troubleshooting purposes. These commands are 
available through the communications configurations provided by Siebel Systems.

To display the previous message

■ Choose View > Communications > Toolbar > Previous Message

The previous message appears, from the stack of messages that had appeared 
since the time the agent logged on. 

To display the next message

■ Choose View > Communications > Toolbar > Next Message

The next message appears , assuming the agent previously invoked the Previous 
Message command.

Menu Command for Refreshing the Communications Toolbar
Agents can choose the following menu command in order to refresh the status of 
buttons on the communications toolbar. (The message area above the 
communications toolbar is not refreshed.)

To refresh the communications toolbar

■ Choose View > Communications > Toolbar > Refresh

The communications toolbar is refreshed to the current status. 

Using the Reception Screen
The Reception screen, a feature of Siebel Call Center and of Siebel CTI, enables 
receptionists and other agents with similar functions to efficiently handle multiple 
incoming voice calls and view relevant information about calls and callers.
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To display the Reception screen

■ From the application-level menu, choose View > Site Map > Reception.

Reception Screen User Interface Elements
The Reception screen includes the following elements:

■ Inbound Calls list. Displays information about the current call and about any calls 
that are on hold.

Inbound calls that are routed to the agent are represented in the Inbound Calls 
list as new records with the Status field set to Ringing.

When the agent selects a record for a new inbound call, any active call is 
automatically placed on hold (status Hold). The status for the new call changes 
from Ringing to Talking. If an agent selects a call that is on hold, the current 
active call is placed on hold and the selected call becomes the active call.

NOTE: The Elapsed Time field shows the total time elapsed since the phone call 
arrived, starting from the first ring. The displayed time will be longer than the 
time since the call was answered, which is displayed on the communications 
toolbar.
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■ Person form. Displays information about the caller or about transfer recipients.

The Person form displays information about the person associated with an 
inbound call, if the caller can be identified. Identifying the caller helps the agent 
determine what types of information may be shared with the caller and how to 
interact with the caller.

The agent also uses the Person form to identify a person to transfer the active 
call to. The agent would perform a query to identify the transfer recipient. Once 
the recipient is found, the agent transfers the call using the Blind Transfer or 
Consultative Transfer buttons on the communications toolbar.

If the agent’s query displays multiple records for persons, these records are 
displayed in the Persons list. The agent can select the appropriate transfer 
recipient from the list, which populates the Person form with information about 
that person.

For information about using the communications toolbar, see “Using the 
Communications Toolbar” on page 352.

■ Persons list. Displays a list of records that matched as a result of a query 
performed from the Person form, or records that result from an inbound call 
matching multiple persons.

When the agent selects a record from the Persons list, the Person form is 
populated with the selected information. Queries can be performed from either 
the Persons lists or the Person form. Call transfers are supported from the Person 
form, after a person is identified as the desired recipient to transfer the call to.

Creating Communications Profiles for Personal Use
This section describes creating communications profiles for personal use. Each user 
can create profiles for personal use in the My Profiles view in the Communications 
screen. Such profiles will be available to this user only.

NOTE: By default, end-user responsibilities such as eMail Response Agent and 
Universal Agent do not have visibility to the My Profiles view (CommSrv CM Profile 
Personal View). Administrators can add this view to any responsibility, as required.
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Profiles created by end users are generally applicable only to the Send Email and 
Send Fax commands. Profiles for the Send Wireless Message command should 
generally be created by administrators.

For more information about using these commands, see “Sending Email, Fax, Page, 
and Wireless Messages” on page 368.

Communications administrators, who create communications profiles for various 
purposes, should be able to provide guidance to end users about creating personal 
profiles, addressing issues such as:

■ How should personal profiles be named

■ For which drivers can profiles be created

■ What profile parameters, and what override values, should be specified

■ How should personal profiles be used

For more information about communications drivers and profiles, see “About 
Communications Drivers and Profiles” on page 53 and “Configuring 
Communications Drivers and Profiles” on page 68.

For more information about communications drivers provided by Siebel Systems 
and about driver parameters for which you can provide override values in profiles, 
see Appendix C, “Using Email, Fax, and Other Systems.”

To create a communications profile for personal use

1 From the application-level menu, choose View > Communications > My 
Profiles.

The Profiles list displays the profiles that the user has created.

2 In the Profiles list, add a new record.

3 Enter the name of the profile.

The name can be any unique name among existing profiles—including profiles 
for which you do not have visibility. Typically, you would specify your email 
address as the name—which you would also specify as a parameter override 
value for the From Address parameter.

4 Specify a communications driver on which this profile should be based:
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■ For profiles for email or fax, select Internet SMTP/POP3 Server.

5 Specify parameter override values for the profile:

a In the Profile Parameter Overrides list, add a new record.

b For the Name field, specify a driver parameter name for which you will 
provide an override value.

For example, you would likely add the From Address parameter. You may also 
want to provide a value for the Reply-To Address parameter. In some cases, 
your administrator may instruct you to add the SMTP Server parameter.

c For the Value field, specify the value for the parameter. For example:

❏ For From Address, you would likely want to specify your own email 
address, using the appropriate form.

❏ For Reply-To Address, specify a reply address, if it differs from that 
specified using From Address.

❏ For SMTP Server, specify the name of the SMTP server that is to process 
your outbound email communications.

Sending Email, Fax, Page, and Wireless Messages
This section describes using the Send Email, Send Fax, Send Wireless Message, and 
Send Page commands.

When you use the Send commands, you can specify communications templates to 
provide content, into which Siebel field data may be substituted. Or, you can enter 
text or (for email or fax) attachments directly. The templates may have been created 
for you, or you can create your own templates.

When you use the Send Email (with the native Siebel email client) or Send Fax 
commands, you can specify a profile to indicate who is sending the message. The 
profile may have been created for your individual use or for group use, and typically 
includes your own email address or another email address as the sender. Or, you 
(end user) may be allowed to create your own profiles. Among the profiles available 
to you, you can specify a default profile as a user preference.
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Communications sent from Siebel Web Client or Siebel Dedicated Web Client are 
processed immediately. Communications for email, fax, or wireless message 
channels sent from Siebel Mobile Web Client, while you are connected to the local 
database and disconnected from the enterprise database, are saved until you 
synchronize. They are then processed for delivery by the Communications 
Outbound Manager server component.

For information about creating your own templates, see Chapter 9, “Configuring 
Communications Templates.”

For information about creating your own profiles for email or fax, see “Creating 
Communications Profiles for Personal Use” on page 366. For information about 
specifying communications preferences for the Send commands, such as a preferred 
default profile, see “Setting Communications User Preferences” on page 339.

Settings in the Spelling tab of the User Preferences screen generally apply to all of 
the Send commands. However:

■ Always Check Spelling Before Sending applies to Siebel eMail Response only.

■ Ignore HTML Tags applies to Siebel eMail Response, Send Email, and Send Fax 
only.

For more information about the spelling user preferences, refer to Siebel Call Center 
User Guide. 

Using the Send Email Command
You can send email, optionally including Siebel application content, to any 
recipient. Email addresses can be retrieved from the Siebel database, such as for 
email to employees or contacts.

■ For instructions on using the native Siebel email client, see “Using Send Email 
with Native Siebel Email Client” on page 369.

■ For instructions on using the Lotus Notes or Microsoft Outlook email clients, see 
“Using Send Email with Lotus Notes or Microsoft Outlook” on page 373.

Using Send Email with Native Siebel Email Client
This section describes using the Send Email command when your default email 
client is the native Siebel email client.
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Editing and formatting controls for Send Email message text are described in 
“Editing and Formatting Controls for Send Email and Send Fax” on page 380.

Whether the Pick Recipient dialog box appears after Step 2 in the following 
procedure depends on what kind of data currently has the focus when you choose 
the Send Email command:

■ If the current record is a person, such as a contact or employee, then the Pick 
Recipient dialog box does not appear. The Send Email window appears.

■ If the current record is an element such as a service request or account, then the 
Pick Recipient dialog box appears if generic recipients have been configured. 
Choose generic recipients such as the contacts associated with the current 
service request. 

NOTE: Users should generally select a single record before invoking Send Email 
when using templates for which field substitution will be performed. If multiple 
records are selected, generic recipients chosen will be drawn from all selected 
records. However, field substitution applies only to the first selected record, and 
a single email message is sent to all recipients.

■ If the current record is a Siebel attachment or literature item, then the Pick 
Recipient dialog box does not appear. The Send Email window appears, and the 
item is added as an attachment to the pending email message. (Siebel 
attachments of type URL are not added as email attachments.)

To use the Send Email command with the native Siebel email client

1 Optionally, select one or more records of contacts, employees, or other persons 
for whom email addresses are defined in the Siebel database. Or, select one or 
more records of attachments or literature items to send as attachments to the 
email message.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Email.

■ Press F9.
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■ Click to the right of Initiate Work Item on the communications toolbar, then 
click Send Email, or click Initiate Work Item when the displayed ToolTip text 
is “Send Email.” See also “Initiating Work Items” on page 357.

The Pick Recipient dialog box appears, if you did not specify recipients in Step 1. 
If you chose recipients before invoking the command, the Send Email window 
appears; go to Step 4.

3 In the Pick Recipient dialog box, specify the recipient or specify no recipient yet.

The available recipients to choose from depend on the application context. For 
example, if Send Email was invoked from a Service Requests list, the choices are 
Service Request Contact and Service Request Owner.

The Send Email window appears.

4 For the From field, specify the profile to represent who is sending the message.

The profiles listed are those created for communications drivers that support 
email, such as Internet SMTP/POP3 Server. In some cases, a profile may be 
inserted automatically. You can specify a default profile in the User Preferences 
screen, Outbound Communications tab.

5 For the To, Cc, or Bcc fields, do one or more of the following:

■ Verify any recipients that were inserted automatically in previous steps.

■ Type any additional recipient email addresses. Note that email addresses you 
enter are not automatically validated. You must verify that the email 
addresses you enter are valid.

■ Use the address book to enter additional recipients. Click the To, Cc, or Bcc 
button and explicitly specify individual persons from the address book dialog 
box. For each intended recipient, check the To, CC, or BCC check box. After 
specifying all recipients, click OK. Verify that the addresses appear correctly.
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6 Optionally, for the Body drop-down list, choose the name of a communications 
template (of type Body) to insert into the message body.

A template may be configured to be inserted automatically, according to where 
you invoked the Send Email command. (Administrators: for more information, 
see “Configuring Default Templates for Send Email Command” on page 304.)

Field substitution applies to template text upon insertion. For substitution to 
work correctly, the fields must exist in the current list or form (containing the 
focus) in the Siebel application. Field substitution applies to a single selected 
record only.

You can insert more than one template. Any template you choose is appended 
to the existing text.

Templates listed here are subject to filtering based on several factors, including 
channel, language, locale, and whether the template is HTML or plain text. For 
details, see “Template Visibility and Access” on page 398.

7 Click the Change Language/Locale button to change the language or locale, as 
necessary.

Setting the language and locale changes the list of available templates to those 
associated with the language and locale you specify.

8 Optionally, verify or enter text for the subject line.

Text may have been inserted into the subject line automatically when you chose 
a template.

9 Optionally, enter and format free-form text, or modify or add to the template text 
you inserted in Step 6.

For information about the available text-editing controls, see “Editing and 
Formatting Controls for Send Email and Send Fax” on page 380.

10 Optionally, if you are editing in plain text mode, you can click the Remove HTML 
Tags button, at lower left, to remove any HTML tagging that may be present in 
your message text.
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11 Optionally, click the icons on the lower right to specify operating system files 
(“paper clip” icon) or literature items (“document” icon) as attachments to the 
email message.

The attachments icon lets you specify files from the operating system as 
attachments, and displays a list of all files and literature items previously 
specified for the email message.

The literature icon displays a list of literature items you can specify as 
attachments.

The Attachments field displays the most recently specified attachment, if more 
than one attachment has been specified. All email attachments are saved as 
attachments to the corresponding Siebel activity record, which is updated when 
the message is sent.

12 Optionally, check spelling for your message.

13 Click Send, or click Cancel if you decide not to send the email message.

If you cancel the email, the corresponding Siebel activity record (created to track 
the send operation) is deleted.

Using Send Email with Lotus Notes or Microsoft Outlook
This section describes using the Send Email command when your default email 
client is set to Lotus Notes or Microsoft Outlook.

For additional information on using Lotus Notes or Microsoft Outlook, refer to your 
documentation for these third-party products. For more information about setting 
user preferences for using third-party email clients, see “Preference Settings in the 
Outbound Communications Tab” on page 347.

Whether the Recipient field appears in the Recipient/Template dialog box after 
Step 2 on page 374 in the procedure below depends on what kind of data currently 
has the focus when you choose the Send Email command:

■ If the current record is a person, such as a contact or employee, then the 
Recipient field does not appear.
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■ If the current record is an element such as a service request or account, then the 
Recipient field appears if generic recipients have been configured. Choose 
generic recipients such as the contacts associated with the service request.

NOTE: Users should generally select a single record before invoking Send Email 
when using templates for which field substitution will be performed. If multiple 
records are selected, generic recipients chosen will be drawn from all selected 
records. However, field substitution applies only to the first selected record, and 
a single email message is sent to all recipients.

■ If the current record is a Siebel attachment or literature item, then the Recipient 
field appears if generic recipient have been configured. The item will be added 
as an attachment to the pending email message. (Siebel attachments of type URL 
are not added as email attachments.)

To use the Send Email command with Lotus Notes or Microsoft Outlook

1 Optionally, select one or more records of contacts, employees, or other persons 
for whom email addresses are defined in the Siebel database. Or, select one or 
more records of attachments or literature items to send as attachments to the 
email message.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Email.

■ Press F9.

■ Click to the right of Initiate Work Item on the communications toolbar, then 
click Send Email, or click Initiate Work Item when the displayed ToolTip text 
is “Send Email.” See also “Initiating Work Items” on page 357.

3 In the Recipient/Template dialog box:
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a From the Recipient field, specify the recipient, or specify no recipient yet.

If you chose recipients before invoking the command, the Recipient field 
does not display.

The available recipients to choose from depend on the application context. 
For example, if Send Email was invoked from a Service Requests list, the 
choices are Service Request Contact and Service Request Owner.

b From the Message Template field, choose the name of a communications 
template (of type Body) to insert into the message body.

Field substitution applies to template text upon insertion. For substitution to 
work correctly, the fields must exist in the current list or form (containing the 
focus) in the Siebel application. Field substitution applies to a single selected 
record only.

Templates listed here are subject to filtering based on several factors, 
including channel, language, locale, and whether the template is HTML or 
plain text. For details, see “Template Visibility and Access” on page 398.

NOTE: If the current record type (business component) has a default template 
associated with it, then you do not need to specify a template. If you do 
specify a template, its text is appended to the default template text in the 
email message. Consult your administrator or verify the software behavior to 
see if a default template has been configured.

c From the Attachments field, specify literature items from the Siebel database 
to add as attachments, as necessary.

The literature icon (“paper clip” icon) displays a list of Siebel literature items 
you can specify as attachments.

The Attachments field displays the most recently specified attachment, if 
more than one attachment has been specified. You can add file attachments 
later, from the Notes or Outlook window. When the message is sent, all email 
attachments are saved as attachments to the corresponding Siebel activity 
record.
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d Click the Change Language/Locale button to change the language or locale, 
as necessary.

Setting the language and locale changes the list of available templates to 
those associated with the language and locale you specify.

e In the Recipient/Template dialog box, click OK to continue to the email 
message window for Lotus Notes or Microsoft Outlook. 

4 In the Lotus Notes or Microsoft Outlook email message window:

a For the To, Cc, or Bcc fields, do one or more of the following:

❏ Verify any recipients that were inserted automatically in previous steps.

❏ Specify any additional recipient email addresses from the email 
directories available through your email client program.

b Optionally, verify or enter text for the subject line.

Text may have been inserted into the subject line automatically when you 
chose a template.

c Optionally, enter and format free-form text, or modify or add to the template 
text you inserted previously.

d Optionally, specify operating system files as attachments to the email 
message.

Siebel literature items you previously specified are also saved as attachments 
for the email message.

All email attachments are saved as attachments to the corresponding Siebel 
activity record, which is updated when the message is sent.

e Optionally, check spelling for your message, according to what your email 
client program supports.

f Send the message, or cancel if you decide not to send the email message.

If you cancel the email, the corresponding Siebel activity record (created to 
track the send operation) is deleted.
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Using the Send Fax Command
You can send a fax, optionally including Siebel application content, to any recipient. 
Fax addresses can be retrieved from the Siebel database, such as for faxes to 
employees or contacts.

Whether the Pick Recipient dialog box appears after Step 2 in the following 
procedure depends on what kind of data currently has the focus when you choose 
the Send Fax command:

■ If the current record is a person, such as a contact or employee, then the Pick 
Recipient dialog box does not appear. The Send Fax window appears.

NOTE: In order for the fax activity record to be associated with a recipient derived 
from the current record (such as a contact or employee), the fax addressing 
information in the To, Cc, or Bcc line must not be changed. In addition, the fax 
addressing field must have been configured in Siebel Tools for your deployment.

■ If the current record is an element such as a service request or account, then the 
Pick Recipient dialog box appears if generic recipients have been configured. 
Choose generic recipients such as the contacts associated with the current 
service request.

■ If the current record is a Siebel attachment or literature item, then the Pick 
Recipient dialog box does not appear. The Send Fax window appears, and the 
item is added as an attachment to the pending fax message. (Siebel attachments 
of type URL are not added as email attachments.)

To use the Send Fax command

1 Optionally, select one or more records of contacts, employees, or other persons 
for whom fax numbers are defined in the Siebel database. Or, select one or more 
records of attachments or literature items to send as attachments to the fax 
message.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Fax.

■ Press Ctrl+F9.
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■ Click to the right of Initiate Work Item on the communications toolbar, and 
then click Send Fax, or click Initiate Work Item when the displayed ToolTip 
text is “Send Fax.” See also “Initiating Work Items” on page 357.

The Pick Recipient dialog box appears, if you did not specify recipients in Step 1. 
If you chose recipients before invoking the command, the Send Fax window 
appears; go to Step 4 on page 378.

3 In the Pick Recipient dialog box, specify the recipient or specify no recipient yet.

The available recipients to choose from depend on the application context. For 
example, if Send Fax was invoked from a Service Requests list, the choices are 
Service Request Contact and Service Request Owner.

The Send Fax window appears.

4 For the From field, specify the profile to represent who is sending the message.

The profiles listed are those created for communications drivers that support 
email or fax, such as Internet SMTP/POP3 Server. In some cases, a profile may 
be inserted automatically. You can specify a default profile in the User 
Preferences screen, Outbound Communications tab.

5 For the To, Cc, or Bcc fields, do one or more of the following:

■ Verify any recipients that were inserted automatically in previous steps.

■ Type any additional recipient fax addresses, using the appropriate format for 
your fax integration.

■ Use the address book to enter additional recipients. Click the To, Cc, or Bcc 
button and explicitly specify individual persons from the address book dialog 
box. For each intended recipient, check the To, CC, or BCC check box. After 
specifying all recipients, click OK. Verify that the addresses appear correctly.
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6 Optionally, for the Body drop-down list, choose the name of a communications 
template (of type Body) to insert into the message body.

A template may be configured to be inserted automatically, according to where 
you invoked the Send Fax command. (Administrators: for more information, see 
“Configuring Default Templates for Send Email Command” on page 304.)

Field substitution applies to template text upon insertion. For substitution to 
work correctly, the fields must exist in the current list or form (containing the 
focus) in the Siebel application.

You can insert more than one template. Any template you choose is appended 
to the existing text.

Templates listed here are subject to filtering based on several factors, including 
channel, language, locale, and whether the template is HTML or plain text. For 
details, see “Template Visibility and Access” on page 398.

7 Optionally, verify or enter text for the subject line.

Text may have been inserted into the subject line automatically when you chose 
a template.

8 Optionally, enter and format free-form text, or modify or add to the template text 
you inserted in Step 6.

For information about the available text-editing controls, see “Editing and 
Formatting Controls for Send Email and Send Fax” on page 380.

9 Optionally, if you are editing in plain text mode, you can click the Remove HTML 
Tags button, at lower left, to remove any HTML tagging that may be present in 
your message text.
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10 Optionally, click the icons on the lower right to specify operating system files 
(“paper clip” icon) or literature items (“document” icon) as attachments to the 
fax message.

The attachments icon lets you specify files from the operating system as 
attachments, and displays a list of all files and literature items previously 
specified for the fax message.

The literature icon displays a list of literature items you can specify as 
attachments.

The Attachments field displays the most recently specified attachment, if more 
than one attachment has been specified. All fax attachments are saved as 
attachments to the activity record that is created when the message is sent.

11 Optionally, check spelling for your message.

12 Click Send, or click Cancel if you decide not to send the fax.

If you cancel the fax, the corresponding Siebel activity record (created to track 
the send operation) is deleted.

Editing and Formatting Controls for Send Email and Send Fax
For the Send Email command (native Siebel email client only) and for the Send Fax 
command, you can edit and format your message text before sending it, using 
controls in an editing bar that appears when you click in the message area in the 
Send Email or Send Fax window.

The editing bar appears only when HTML is the setting for the Send Email: Default 
Message Format option in the Outbound Communications tab of the User 
Preferences screen. For more information about this user preference setting, see 
“Preference Settings in the Outbound Communications Tab” on page 347.

NOTE: If you are using Lotus Notes or Microsoft Outlook for the Send Email 
command, the editing and formatting capabilities are those provided by the third-
party vendor. The Siebel software attempts to specify an editing environment 
according to the user’s Send Email Default Message Preference setting. However, 
the behavior of the third-party email client software cannot be guaranteed. Users 
can also specify editing preferences in Lotus Notes or Microsoft Outlook.
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For email messages, message recipients who cannot view HTML messages in their 
email client program will instead view a plain-text version of each message, from 
which any formatting has been stripped out.

When HTML editing is enabled, note the following behavior regarding line breaks:

■ Pressing ENTER creates a new paragraph.

■ Pressing SHIFT+ENTER creates a new line.

For email messages, when HTML editing is enabled, you can enter URL or mailto 
links directly and they will be automatically converted to links in the HTML output. 
For example:

■ www.siebel.com

■ http://www.siebel.com

■ ftp://ftp.topsecretclassified.gov

■ mailto:user@siebel.com

Graphics or other elements displayed on Web pages, such as a horizontal rules or 
tables, may be selectable by dragging the mouse pointer. In some cases, such 
elements can be copied and pasted into the Send Email/Fax message body.

If you are using plain-text mode in the Send Email or Send Fax window, you can 
remove any remnant HTML formatting by clicking the button Remove HTML Tags.

The HTML formatting options include, from left to right:

■ Find/Replace. Click the arrow to display the Find controls above the editing bar, 
or to hide these controls. Click the arrow on the left side of this area to toggle 
between Find controls and Find and Replace controls. Enter text to find, or enter 
replacement text, then click Go. Find operations are not case-sensitive.

■ Cut. Click to cut selected text to the clipboard.

■ Copy. Click to copy selected text to the clipboard.

■ Paste. Click to paste text from the clipboard into the message area. Depending 
on the source, text you paste may include HTML formatting.
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■ Font. Choose a font from a drop-down list to apply to selected text. Available 
fonts include Arial (the default), Verdana, Times New Roman, and Courier.

■ Size. Choose a size from a drop-down list to apply to selected text. Point sizes 
include 8 (the default), 10, 12, 14, 18, 24, 36.

■ Font Color. Click the arrow to display font colors above the editing bar, then click 
to choose a color to apply to selected text.

■ Bold. Click to apply bold formatting to selected text, or to remove bold.

■ Italic. Click to apply italic formatting to selected text, or to remove italics.

■ Underline. Click to apply underlining to selected text, or to remove underlining.

■ Ordered List. Click to apply numbering to selected text (make it an ordered list), 
or to remove numbering.

■ Unordered List. Click to apply bullets to selected text (make it an unordered list), 
or to remove bullets. Bullets appear differently at different levels of indenting.

■ Indent. Click to increase indenting for selected paragraphs.

■ Outdent. Click to decrease indenting for selected paragraphs (outdent).

■ Left Align. Click to left-align selected paragraphs.

■ Center Align. Click to center selected paragraphs.

■ Right Align. Click to right-align selected paragraphs.

Using the Send Wireless Message Command
You can send a wireless message, optionally including Siebel application content, 
to any recipient whose mobile device and device address information is stored in 
the Siebel database.

Whether the Pick Recipient dialog box appears after Step 2 in the following 
procedure depends on what kind of data currently has the focus when you choose 
the Send Wireless Message command:
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■ If the current record is a person, such as a contact or employee, then the Pick 
Recipient dialog box does not appear. The Send Wireless Message window 
appears.

■ If the current record is an element such as a service request or account, then the 
Pick Recipient dialog box appears if generic recipients have been configured. 
Choose generic recipients such as the contacts associated with the current 
service request.

To use the Send Wireless Message command

1 Optionally, select one or more records of contacts, employees, or other persons 
for whom mobile device information is defined in the Siebel database.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Wireless Message.

■ Press Alt+F9.

■ Click to the right of Initiate Work Item on the communications toolbar, then 
click Send Wireless Message, or click Initiate Work Item when “Send 
Wireless Message” is the displayed ToolTip text. See also “Initiating Work 
Items” on page 357.

The Pick Recipient dialog box appears, if you did not specify recipients in Step 1. 
If you chose recipients before invoking the command, the Send Wireless 
Message window appears; go to Step 4.

3 In the Pick Recipient dialog box, specify the recipient or specify no recipient yet.

The available recipients to choose from depend on the application context. For 
example, if Send Wireless Message was invoked from a Service Requests list, the 
choices are Service Request Contact and Service Request Owner.

The Send Wireless Message window appears.

4 For the To field, do one or more of the following:

■ Verify any recipients that were inserted automatically in previous steps. (No 
more than one recipient is displayed in the To line, even though all specified 
recipients will receive the message.)

■ Click the select button to the right of the To field and explicitly specify 
individual persons from the Siebel database for the To field.
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5 Optionally, for the Body drop-down list, choose the name of a communications 
template (of type Body) to insert into the message body.

Field substitution applies to template text upon insertion. For substitution to 
work correctly, the fields must exist in the current list or form (containing the 
focus) in the Siebel application.

You can insert more than one template. Any template you choose is appended 
to the existing text.

Templates listed here are subject to filtering based on several factors, including 
channel, language, and locale. For details, see “Template Visibility and Access” 
on page 398.

6 Optionally, enter free-form text, such as to modify or add to the template text 
you inserted in Step 5.

NOTE: Wireless network operators and wireless messaging protocols impose 
limits of message text length. Customers should consult their network operators 
to find out what limits apply and should be observed.

7 Optionally, check spelling for your message.

8 Click Send, or click Cancel if you decide not to send the wireless message.

If you cancel the wireless message, the corresponding Siebel activity record 
(created to track the send operation) is deleted.

Using the Send Page Command
You can send a page, optionally including Siebel application content, to any 
recipient whose paging data is stored in the Siebel database.

NOTE: The Send Page command requires the Page Manager server component. For 
more information about setting up and using Page Manager, refer to Siebel Business 
Process Designer Administration Guide.
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To use the Send Page command

1 Optionally, select a record of a contact, an employee, or another person for 
whom paging data is defined in the Siebel database.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Page.

■ Press Shift+F9.

■ Click to the right of Initiate Work Item on the communications toolbar, then 
click Send Page, or click Initiate Work Item when “Send Page” is the 
displayed ToolTip text. See also “Initiating Work Items” on page 357.

3 For the To field, do one or more of the following:

■ Verify any recipient that was inserted automatically in previous steps.

■ Click the select button to the right of the To field and explicitly specify an 
individual person from the Siebel database.

4 Specify page addressing information, including the pager company, paging 
phone number, and pager PIN, as appropriate.

5 Optionally, for the Body drop-down list, choose the name of a communications 
template (of type Body) to insert into the message body.

Field substitution applies to template text upon insertion. For substitution to 
work correctly, the fields must exist in the current list or form (containing the 
focus) in the Siebel application.

You can insert more than one template. Any template you choose is appended 
to the existing text.

Templates listed here are subject to filtering based on channel and other factors. 
For details, see “Template Visibility and Access” on page 398.

6 Optionally, enter free-form text, such as to modify or add to the template text, 
as appropriate.

7 Optionally, check spelling for your message.

8 Click Send.
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Using Activity Records for Send Commands
Activity records may be generated for all of the Send commands that you use to 
send outbound communications: Send Email, Send Fax, Send Wireless Message, 
and Send Page.

For more information about using the Send commands, see “Sending Email, Fax, 
Page, and Wireless Messages” on page 368.

In the User Preferences screen, Outbound Communications view, you can specify 
whether to generate activity records for the Send commands, and, if so, whether the 
activity records will be public or private. For details, see the setting Upon Sending 
Messages Generate, in “Preference Settings in the Outbound Communications Tab” 
on page 347.

Each activity record documents a communication initiated within the Siebel 
application. Generally, this activity is also a child record of another record which 
was current when the command was invoked. For example, if the Send Email 
command is invoked when a service request record was active, then the activity 
record for the email message is a child of the service request record, and can be 
accessed from the service request. You can fill in other fields to complete the activity 
record, as may be appropriate for your company’s use of activities.

NOTE: For an activity generated by using Send Email, the Status field is set to Done 
when the message is sent. If the message is sent to an invalid address, the sender 
is notified by email that the message could not be delivered. Note, however, that the 
Status field is not updated in this case. The email system does not update the 
activity record that a message could not be delivered.

The owner for an activity generated by a Send command is the sender of the 
communication. Recipients are associated with the activity as contacts, if the Siebel 
application can match the recipients with persons in the Siebel database. For details, 
see “Matching Contacts for Activity Records for Send Email” on page 388.

Activity Types for Each Send Command
The activity records generated by each Send command are of different types, as 
outlined in Table 63 on page 387.
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Activity records for outbound communication requests also use the same activity 
types described in this section, but are not generated in the same way. For more 
information about these activity records, see “Viewing Activity Records for 
Communication Requests” on page 445.

For Siebel eMail Response, activity records for inbound email messages use the 
Email - Inbound activity type, while activity records for outbound email messages 
use the Email - Outbound activity type. For more information, refer to Siebel eMail 
Response Administration Guide. See also “Activity Attachments Stored for Inbound 
Email” on page 332.

Text from the Subject line of the message is written to the Description field for the 
activity record. (For wireless messages and pages, this text is from the Subject field 
of the template.) Message body text is written to the Comments field for the activity 
record, up to a maximum possible size of 1,500 characters. 

For Send Email and Send Fax, message body text is also written to the Email Body 
field, up to a size of at least 16,000 characters (actual length depends on your 
database).

For Send Email and Send Fax, message body content that is longer than the Email 
Body field allows is also saved as activity attachments. The attachment files are 
named SiebelLongEmailBody.txt (for plain-text messages) or 
SiebelLongEmailBody.htm (for HTML messages). If you are using Microsoft 
Outlook as your email client, RTF messages are saved in HTML format.

For the Send Email and Send Fax commands, attachments (such as files or literature 
items) to email or fax messages are also saved as attachments to the activity record.

Table 63. Activity Records for Outbound Communications

Send Command Activity Type

Send Email Email - Outbound

Send Fax Fax - Outbound

Send Wireless Message Wireless Message

Send Page Paging
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Matching Contacts for Activity Records for Send Email
As noted, recipients are associated with an activity as contacts, if the Siebel 
application can match the recipients with persons in the Siebel database. For Send 
Email, this matching is based primarily on the email address. If more than one 
record exists in the database that includes the same email address, the first such 
record is associated with the activity as a contact.

For a third-party email integration with Lotus Notes, an email address specified 
through Notes is passed back to the Siebel application in order to match recipients 
to contacts and associate these contacts with the activity. If no match is found in 
the Siebel database, then the recipients are not associated as contacts.

For a third-party email integration with Microsoft Outlook, an email address may 
not always be passed back to the Siebel application, in order to match recipients to 
contacts and associate these contacts with the activity. If the email address is not 
passed, then the Siebel application tries to match recipients to contacts using the 
first and last names of the recipient, or using the first, middle, and last names. If no 
match is found in the Siebel database, then the recipients are not associated as 
contacts.

NOTE: If the option Collaborative Data Object (CDO) is installed on each client 
machine running Microsoft Outlook 2000 or XP, then the email address is passed to 
the Siebel application, not just the name, and a match can generally be made.

Specifying Mobile Device Settings
By using the Mobile screen, which is available with many Siebel eBusiness 
Applications, you can manage your mobile devices and wireless messaging 
addresses for these devices. You can:

■ Register your mobile devices and specify device priority

■ Specify mobile device addresses and specify address priority

■ Specify which types of wireless messages you would like to receive 
automatically from the Siebel application
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The Mobile screen is accessible in the following Siebel applications: Siebel Call 
Center, Siebel Sales, Siebel Service, and Siebel Partner Portal. However, this screen 
requires a license for either Siebel Wireless Messaging or Siebel Wireless.

NOTE: You can access the Mobile screen from your Siebel eBusiness Application 
running the Siebel Web Client. The Mobile screen is not available from the Siebel 
Mobile Web Client or Siebel Dedicated Web Client.

For more information about registering mobile devices in the Mobile screen, refer 
to Siebel Wireless Administration Guide. If you are using the Siebel Wireless 
application, Online Help for this application is available, which contains 
information to help guide you through device registration and personalization.

To configure wireless messaging for your mobile device

1 From the application-level menu, choose View > Site Map > Mobile.

2 In the Mobile Devices list, select the mobile device you want to work with, or, if 
necessary, create a new mobile device record, as described in the next section.

3 Use the Message Delivery or Mobile Alerts view tabs to establish the 
configuration of the selected device, as described in subsequent sections.

Configuring Mobile Devices
The Mobile Devices list allows you to register your mobile devices and establish the 
device priority. The Mobile Devices list includes the following fields pertinent to 
supporting wireless messaging:

■ Device Name. Enter any name you would like for your device. It can be any 
descriptive name—for example, “John Cheng’s Nokia cell phone.” The mobile 
device name must be unique for each device registered to a user.

■ Login Preference. The Auto Login level for the mobile device. The value for each 
registered device can be set to any of three values:

■ Automatic Login

■ Password Only
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■ User Name and Password

For a WAP Push message that includes a URL for a Siebel Wireless application, 
the login preference is applied when authenticating users for the application. 
The login preference is ignored for any wireless messaging that does not launch 
the Siebel Wireless application. For more information, refer to Siebel Wireless 
Administration Guide.

■ Device Priority. Select a priority, from 1- Highest to 6 - Unranked, for each mobile 
device that you register. Wireless messages are generally sent to the device with 
the highest device priority.

To guarantee message delivery, make sure that only one registered device is 
assigned the highest device priority: only one device registered for a particular 
user may have a device priority set to 1 - Highest. 

Any other registered devices must have the device priority set to 2 or a higher 
number. Do not attempt to register any additional devices if a device with 
priority 6 already exists.

Configuring Message Delivery
The Message Delivery list allows you to enter wireless messaging address 
information for each of your mobile devices. You must enter information in three 
fields to define a wireless messaging address:

■ Message Delivery Profile. Describes the network and message type that will be 
used to send wireless messages to your device.

For example, if your device is connected to wireless network operator ABC and 
uses the SMS protocol to receive messages, then your administrator creates a 
message delivery profile, such as “ABC Network SMS,” for either the Wireless 
Messaging 1-Way or Wireless Messaging 2-Way driver.

If your administrator has not done so, you must associate the appropriate profile 
with your mobile device to receive messages. Consult your administrator for 
guidance on which profile to choose, or to have a profile added for your device.

Administrators: For more information about using communications profiles for 
message delivery, see Appendix B, “Using Wireless Messaging.”
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■ Device Address. A unique identifier for a particular mobile device, enabling 
messages to be sent to this device.

■ Frequently, the device address required to send an SMS or TAP page message 
is the phone number or PIN number of the device. 

If your company uses MobileSys Network in the United States, the phone 
number is preceded with a numeral 1. If you are using MobileSys Network 
in other countries, contact MobileSys for additional information and prefixes.

■ For WAP V1.2 Push messages, the device address may be either a user-
defined address or any device address understood by the mobile network, 
such as the MSISDN or IP address of the device. Consult your administrator 
or service provider to determine your WAP V1.2 Push address.

■ Address Priority. Select a priority, from 1 - Highest to 6 - Unranked, for each 
address for each mobile device. Wireless messages are sent to the device with 
the highest device priority, and to the highest priority address for that device.

To guarantee message delivery, make sure that only one device address is 
assigned the highest address priority: only one address for a particular mobile 
device may have an address priority set to 1 - Highest. 

Any other address must have the address priority set to 2 or a higher number. 
Do not attempt to define any additional addresses if an address with priority 6 
already exists.

Configuring Mobile Alerts
The Mobile Alerts list in the Mobile screen lets you select which types of event-
driven wireless message alerts you would like to receive on your device. 

Normally, all event-driven alert messages are sent to the highest priority device and 
address for a recipient. In this case, individual settings for receiving alerts are 
ignored.

However, if your system administrator allows it, you may override the device 
priority settings in the Mobile Alerts list and specify to receive an alert on a specific 
device. 
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When you enable an alert for a particular device in the Mobile Alerts list, the alert 
is sent to the highest priority address defined for that device, regardless of the 
device priority settings previously established.

For information about how alerts are configured in your organization, consult your 
system administrator.

For example, you may choose to receive a wireless message alert automatically each 
time you are assigned a new activity, if your system administrator has activated 
such an alert. In this case, you can enable or disable this specific alert for a mobile 
device. To do this, you create a record in the Mobile Alerts list for each alert and set 
the alert’s status to On or Off. 

NOTE: Alternatively, your company may choose to send some alert messages 
manually, using the Send Wireless Message command, to your highest priority 
device and address. A manual alert message is not event-driven. You cannot 
customize such alerts through the Mobile Alerts list.

The following are the settings in the Mobile Alerts list:

■ Alert Name. Select the particular alert you want to enable or disable for the device 
selected in the Mobile Devices list. To have more alerts made available to you 
that meet your particular needs, contact your system administrator.

■ Status. For each mobile alert that has been added for a device, you can specify 
whether the alert is activated or deactivated.

■ To enable an alert so you can receive wireless message alerts of the specified 
type on this device, set the value to On.

■ To disable an alert so you will not receive message alerts of this type on any 
device, set the value to Off.

NOTE: Disabling an alert (setting it to Off) for one of your devices disables it for all 
of your devices, if the alert is not On for any other device. If you want to receive a 
particular alert on a particular device, set the Status to On.
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This chapter describes how to create communications templates that are to be sent 
to recipients of outbound email, fax, or wireless messages sent using Siebel 
application features that support outbound communications.

The procedures described in this chapter can be performed either by administrators 
or by advanced end users.

For additional guidelines on creating templates for use by Siebel products 
documented in other books, such as Siebel eMail Response, refer to applicable 
documentation.

NOTE: If you are implementing a custom channel type, see also “Configuring 
Communications List of Values Types” on page 282.

About Communications Templates
Communications templates may be sent when using the following features:

■ Using the Send Email, Send Fax, Send Wireless Message, or Send Page 
commands

■ Replying to an inbound message in Siebel eMail Response

■ Creating and submitting an outbound communication request (whether this is 
done manually or done using a module like Siebel Business Process Designer 
that can invoke business service methods)
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Templates provide both structure and content for outbound messages. Content may 
include both explicitly specified text and Siebel field values substituted into the 
outbound message. Field data may be substituted for all supported Siebel datatypes. 
In an end-user context of using the Send commands or replying to inbound 
messages, additional content can also be specified by the end user.

For outbound communication requests, which can include multiple templates per 
request, each template also includes a specification of the communications profile 
that determines how the template’s message will be delivered. For more 
information about outbound communication requests, see Chapter 10, “Defining 
Outbound Communication Requests.”

Template Content and Formatting
Templates can include any of the following content elements:

■ A single block of template text specified in the Template Text field.

■ One or more template items providing component parts for the template. A 
template item can be based on a Siebel literature item or a text file.

■ A combination of template text and template items.

NOTE: For template users to be able to work with literature items or files, the Siebel 
File System must be properly configured.

For email or fax messages, the content of a template item can be specified to appear 
in the body of a message or to appear as an attachment. Both plain-text and HTML 
content are supported for email or fax templates, with some limitations for fax. 
Standard HTML tagging options can support text formatting, images, hyperlinks, 
tables, and so on. For more information, see “HTML Formatting.”

HTML Formatting
For email or fax templates, HTML can be defined in the template text or, for 
advanced templates, in template items. (Template items are supported only for 
advanced templates, which are sent using outbound communication requests.)
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Template text can be formatted as HTML using controls in the Template Text field. 
When a template is saved, formatting of text in this field is preserved only if the 
HTML Template check box is checked for the template.

For advanced templates, checking the HTML Template check box also specifies that 
HTML text from template items specified for the message body is sent as HTML. If 
HTML Template is not checked, this text is converted to plain text before sending.

If the default message format (specified in the Send Email group in the Outbound 
Communications tab of the User Preferences screen) is set to HTML, then HTML 
formatting is enabled for the Send Email and Send Fax windows. HTML templates 
only are listed in the Body drop-down list.

Similarly, if the default message format setting for Siebel eMail Response is set to 
HTML (also in the Outbound Communications tab of the User Preferences screen), 
then HTML formatting is enabled for email replies in the Outbound Messages form 
of the Communications screen. HTML templates only are listed in the Body drop-
down list.

For more information, see:

■ “Template Visibility and Access” on page 398

■ “Preference Settings in the Outbound Communications Tab” on page 347

■ “Editing and Formatting Controls for Send Email and Send Fax” on page 380

■ “Editing and Formatting Controls for Template Text Field” on page 405

■ Chapter 10, “Defining Outbound Communication Requests”

■ “Using HTML Email” on page 519

For more information about HTML formatting for Siebel eMail Response, refer to 
Siebel eMail Response Administration Guide and Siebel Call Center User Guide.

HTML Wrapper Templates for Email
You can create a special template to serve as a wrapper around each outbound email 
message, in order to format messages with HTML. Such a wrapper template can 
contain links to your Web site, marketing messages, and so on.
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To create a wrapper template, you can use any HTML editor. To use this feature with 
outgoing email, create communications templates as described in this section, and 
modify the appropriate workflows in Siebel Business Process Designer. By default, 
the applicable workflow is eMail Response - Client Send Email.

Users send messages as they normally would. When a user clicks Send, the email 
is embedded in your wrapper template and sent to the message recipient.

For more information about using HTML wrapper templates with Siebel eMail 
Response, refer to Siebel eMail Response Administration Guide.

Substitution Fields in Templates
Field values from Siebel database records can be substituted into the structure of 
the template for each recipient of a communication for which the template is used. 
Field substitution can apply to text specified directly for the template, and to the 
subject line, as well as to literature items and files.

Available fields for substitution are those that correspond to the recipient group 
specified for the template. Recipient groups are specified differently for templates 
used by different communications features:

■ For templates to be used with Send commands or Siebel eMail Response replies, 
you can specify a primary business component for the recipient group, such as 
Account. Create such templates using the Simple tab.

■ For templates to be used with outbound communication requests, you can 
specify a predefined recipient group that corresponds to one of the recipient 
groups you can specify for requests—for example, Account Team Members. 
Create such templates using the Advanced tab.

In each case, fields from the Account business component can be inserted into 
template text or inserted into template items.

For a template item, you can also use advanced field substitution, where you specify 
an iteration child business component from which to substitute field values for a 
given template item. Each template item repeats, in iterative fashion, for every 
applicable child record.
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For example, assume the recipient group is Account Team Members, and 
Opportunity is specified in the Iteration Child BC field for the template item. In the 
outgoing message, the template item’s content will be repeated once for each 
opportunity (child business component) that is associated with the account (parent 
business component).

Field substitution can be employed within plain-text or HTML templates or template 
items. (Template items specifying files of other formats, such as RTF or Microsoft 
Word, cannot support field substitution.)

In an HTML template or template item, for example, a row containing substitution 
fields can, for example, be specified in a single-row HTML table in order to align 
field data. If an iteration child business component is specified, the tables are 
repeated, thus allowing you to align field data from multiple records.

In order for field substitution to function correctly for an outbound communication 
request, the request must specify the same recipient group as was specified for the 
template. If a different recipient group is used, the field names (with enclosing 
brackets) may appear in each message as literal character strings without 
substitution. Substitution still occurs for fields that are applicable to the request’s 
recipient group.

Siebel Repository Requirement for Using Substitution Fields
The Siebel repository applicable to where templates are created must be consistent 
with the repository applicable to where templates will be used. Otherwise, field 
substitution behavior when the templates are used may not occur as desired. 

For example, if you use the Siebel Mobile Web Client (connected to a local 
database), then you should create templates only if the applicable business objects 
and business components (and substitution fields) in that environment are 
consistent with those in the enterprise database.
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Template Visibility and Access
Templates can be created solely for personal use, or can be made publicly available 
to all users of the applicable communications features.

NOTE: In general, templates that are created for group use should be created, 
modified, or reviewed by advanced users who have administrator privilege. Such 
users would work with templates in the All Templates view in the Communications 
Administration screen.

Depending on the context of use, which templates are displayed to a user, such as 
in the Body drop-down list, also depends on the following factors:

■ The setting of the Public check box for the template. Templates listed for a user 
will not include those for which Public was not checked. Templates the user 
created (such as in the My Templates view in the Communications screen) are 
not subject to this limitation.

■ The specified channel (such as email, fax, or wireless message) for the template. 
Templates listed are only those applicable to the feature. For example, only email 
templates are listed for Send Email and other email features.

■ The specified template type, such as Greeting, Body, or Closing. For the Send 
commands, the template type must be Body in order to appear in the Body drop-
down list. For email replies, templates of each type are specified using a different 
drop-down list. (Template type is ignored for communication requests.)

■ The specified language and locale for the template. For the Send Email, Send 
Fax, and Send Wireless Message commands, templates listed are only those for 
which the language and locale correspond to the user’s outbound 
communications preferences. (If these user preferences are not set, these 
language and locale for the Application Object Manager are used—as applies for 
all Siebel client types.)

For the Send Email command and for email replies, the user can specify 
overrides for the language and locale settings, in order to view a different set of 
templates to choose from.
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■ For templates used with the Send commands: the specified recipient group for 
the template. Templates listed are only those for which the recipient group 
corresponds to the business component (such as Account) for the current applet 
when the user chose the Send command. Templates listed may also include 
those for which no recipient group was specified.

■ For templates used with the Send Email or Send Fax commands, or with email 
replies: the setting of the HTML Template check box for the template. In the 
Outbound Communications view of the User Preferences screen, users can 
specify a default message format of either HTML or Plain Text for Send Email 
and Send Fax, or for eMail Response. In each context of use:

■ If the preference setting is HTML, templates listed are only those for which 
HTML Template is checked.

■ If the preference setting is Plain Text, templates listed are only those for 
which HTML Template is not checked.

Siebel Views for Working with Templates
You create templates in either of the following views:

■ My Templates view (in the Communications screen, for end users)

■ All Templates view (in the Communications Administration screen, for 
administrators or other authorized advanced users)

In these views, respectively, end users see only the templates they have created, and 
administrators see all templates.

NOTE: Procedures in this section assume a non-administrator user, using the My 
Templates view in the Communications screen.
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Creating Simple Templates
This section describes how to create a simple template. Simple templates are used 
for the Send Email, Send Fax, Send Page, or Send Wireless Message commands. 
These commands may be accessed from the File application-level menu, from the 
communications toolbar, or using keyboard shortcuts. Simple templates also apply 
to replies in Siebel eMail Response. 

For information about the fields for the Templates list and the Simple tab, see 
“Fields for Templates” on page 410.

Outbound communication requests use advanced templates. Template items are 
supported for advanced templates only. For more information, see “Creating 
Advanced Templates” on page 402 and “Specifying Template Items for an Advanced 
Template” on page 407.

To create a simple template

1 From the application-level menu, choose View > Site Map > 
Communications > My Templates.

2 In the Templates list:

a Add a new record.

b Specify the name of the template for which you added a new record.

c Specify the channel type, such as Email, Fax, Pager, or Wireless Message.

d Specify the language and locale that is applicable to this template.

e Optionally, provide a short description for the template.

3 In the Simple form:

a Optionally, specify the appropriate business component as the template’s 
recipient group.

❏ The business component you specify here as the recipient group 
determines which substitution fields are available for the template text. 
The business components listed are those that serve as the primary 
business component for a business object. For more information, see 
“Substitution Fields in Templates” on page 396. 
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❏ For the Send commands, the recipient group also helps determine when 
users can specify the template. For more information, see “Template 
Visibility and Access” on page 398.

The actual recipients are determined in the context in which the template is 
used.

b Specify the template type, such as Greeting, Body, or Closing.

❏ When using the Send Email, Send Fax, Send Page, or Send Wireless 
Message command, users can choose specific templates of type Body to 
insert into the message.

❏ When replying to an inbound email message using Siebel eMail Response, 
users can choose specific templates of each type to insert into the reply.

c Specify a subject line for the template, as applicable for the channel type.

The subject line is overridden by any subject line specified by the user in the 
context in which the template is used—for example, in an email message in 
the Send Email window, or in a reply in Siebel eMail Response.

d For a template that is intended for public use, check the Public box when the 
template is ready to be publicly available.

e For an email or fax template, specify whether this is an HTML template or a 
plain-text template.

For a simple template, this setting determines whether the template is listed 
in the Body drop-down in usage context. Templates are listed only when they 
correspond to the user preference setting for Default Message Format. For 
more information, see “Template Visibility and Access” on page 398.

f Specify the language and locale for this template, if you did not already do 
so in the Templates list.
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g Enter the template text. As appropriate, copy and paste fields from the list of 
available substitutions. Include the brackets around the field names.

The Template Text field allows you to use editing and formatting controls, as 
described in “Editing and Formatting Controls for Template Text Field” on 
page 405. For an HTML email or fax template, formatting you apply is 
preserved. For a plain-text template, formatting is stripped when the template 
is saved.

The Available Substitutions list is populated with field names as described 
for the Simple tab in “Fields for Templates” on page 410.

4 Test the template to verify that it functions as required and that field substitution 
behavior works correctly. Do this before you make a template publicly available.

To test a template, send it in the intended context: that is, by using the applicable 
Send command, or by specifying a test reply for Siebel eMail Response.

Creating Advanced Templates
This section describes how to create an advanced template. Advanced templates are 
specified for outbound communication requests. Differences from simple templates 
include the following:

■ Delivery profile can be associated for an advanced template.

■ The recipient group for an advanced template is defined differently.

■ You can specify to create activities for requests that use the template.

■ You can specify to include a bookmark URL for the recipient source record.

■ You can create template items for advanced template. For more information, see 
“Specifying Template Items for an Advanced Template” on page 407.

For information about the fields for the Templates list and the Advanced tab, see 
“Fields for Templates” on page 410. For information about the fields for template 
items, see “Fields for Template Items” on page 421.
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For information about creating a simple template, see “Creating Simple Templates” 
on page 400.

NOTE: For an advanced template, a communications profile you will specify as the 
delivery profile must already exist before you can specify it for the template. For 
more information about creating profiles, see “Configuring Communications 
Drivers and Profiles” on page 68.

To create an advanced template

1 From the application-level menu, choose View > Site Map > 
Communications > My Templates.

2 In the Templates list:

a Add a new record.

b Specify the name of the template for which you added a new record.

c Specify the channel type, such as Email, Fax, Pager, or Wireless Message.

d Specify the language and locale that is applicable to this template.

e Optionally, provide a short description for the template.

3 Click the Advanced view tab.

4 In the Advanced form:

a Specify the delivery profile for the template.

b Optionally, specify the recipient group, which determines what kind of 
recipients the template will be sent to.

The recipient group you specify here only determines which substitution 
fields are available for the template text. The actual recipients are determined 
in the context in which the template is used (for a communication request).

c Specify a subject line for the template, as applicable for the channel type.

d Check the Create Activity box, if you want to set activity logging for any 
outbound communication request for which this template is specified.
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e For a template that is intended for public use, check the Public box when the 
template is ready to be publicly available.

f For an email or fax template, specify whether this is an HTML template or a 
plain-text template.

NOTE: The HTML Template setting affects the text you enter in the Template 
Text field. It does not affect template items.

g For an email template, specify whether to include a Siebel bookmark with the 
message.

h Specify the language and locale for this template, if you did not already do 
so in the Templates list.

i Optionally, enter the template text. As appropriate, copy and paste fields 
from the list of available substitutions. Include the brackets around the field 
names.

The Template Text field allows you to use editing and formatting controls, as 
described in “Editing and Formatting Controls for Template Text Field” on 
page 405. For an HTML email or fax template, formatting you apply is 
preserved. For a plain-text template, formatting is stripped when the template 
is saved.

The Available Substitutions list is populated with field names as described 
for the Advanced tab in “Fields for Templates” on page 410.

A template that includes template items does not require that you also 
include template text.

5 Optionally, add template items to the template, as described in “Specifying 
Template Items for an Advanced Template” on page 407.

A template that does not include template text should generally include one or 
more template items in order to provide content. You can combine template text 
and template items in the same template. The template text appears in the 
message body, before the content specified with the template items.
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6 Test the template to verify that it functions as required and that field substitution 
behavior works correctly. Do this before you make a template publicly available.

To test a template, send it in the intended context: that is, by creating and 
submitting an outbound communication request.

Editing and Formatting Controls for Template Text Field
For email or fax templates, you can edit and format your template text, using 
controls in an editing bar that appears when you click in the Template Text field in 
the Simple tab or Advanced tab. 

NOTE: HTML formatting does not apply to templates for channels other than email 
or fax, even if the HTML Template check box is checked. Any formatting is stripped 
out when such a template is used.

You can use the editing controls, such as those for clipboard operations, without 
applying HTML formatting.

For an HTML email or fax template, formatting you apply in the Template Text field 
is preserved when the template is saved. For a plain-text template, such formatting 
is stripped out when the template is saved.

NOTE: If you change the setting of the HTML Template check box, the change is not 
apparent until you step off the record to display another template record, then re-
select this template record. In particular, note that if you uncheck this box, the 
HTML formatting controls will still be available, and formatted text is not 
immediately converted to plain text. However, when the template is saved, any 
formatting you applied is removed.

Managing Line Breaks for HTML and Plain-Text Templates
The following behavior regarding line breaks applies to both plain-text and HTML 
templates:

■ Pressing ENTER creates a new paragraph.
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■ Pressing SHIFT+ENTER creates a new line.

Managing Links and HTML Elements from Other Sources
For email messages, you can enter URL or mailto links directly and they will be 
automatically converted to links if the template is saved as HTML. (This behavior 
may not apply to email sent using third-party email clients.) For example:

■ www.siebel.com

■ http://www.siebel.com

■ ftp://ftp.topsecretclassified.gov

■ mailto:user@siebel.com

Graphics or other elements displayed on Web pages, such as a horizontal rules or 
tables, may be selectable by dragging the mouse pointer. In some cases, such 
elements can be copied and pasted into the template text.

Editing and Formatting Options
The editing and formatting options for your template text include, from left to right:

■ Find/Replace. Click the arrow to display the Find controls above the editing bar, 
or to hide these controls. Click the arrow on the left side of this area to toggle 
between Find controls and Find and Replace controls. Enter text to find, or enter 
replacement text, then click Go. Find operations are not case-sensitive.

■ Cut. Click to cut selected text to the clipboard.

■ Copy. Click to copy selected text to the clipboard.

■ Paste. Click to paste text from the clipboard into the template text. Depending 
on the source, text you paste may include HTML formatting.

■ Font. Choose a font from a drop-down list to apply to selected text. Available 
fonts include Arial (the default), Verdana, Times New Roman, and Courier.

■ Size. Choose a size from a drop-down list to apply to selected text. Point sizes 
include 8 (the default), 10, 12, 14, 18, 24, 36.

■ Font Color. Click the arrow to display font colors above the editing bar, then click 
to choose a color to apply to selected text.
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■ Bold. Click to apply bold formatting to selected text, or to remove bold.

■ Italic. Click to apply italic formatting to selected text, or to remove italics.

■ Underline. Click to apply underlining to selected text, or to remove underlining.

■ Ordered List. Click to apply numbering to selected text (make it an ordered list), 
or to remove numbering.

■ Unordered List. Click to apply bullets to selected text (make it an unordered list), 
or to remove bullets. Bullets appear differently at different levels of indenting.

■ Indent. Click to increase indenting for selected paragraphs.

■ Outdent. Click to decrease indenting for selected paragraphs (outdent).

■ Left Align. Click to left-align selected paragraphs.

■ Center Align. Click to center selected paragraphs.

■ Right Align. Click to right-align selected paragraphs.

Specifying Template Items for an Advanced Template
This section describes how to add template items for an advanced template.

Specifying template items allows you to construct templates in modular fashion, 
based on literature items or files. It also allows you to use advanced field 
substitution (iteration child business component), to specify content both for the 
message body and for attachments, and to specify alternate versions of the message 
body (for email only): plain text and HTML.

You can combine template text and template items in the same advanced template. 
A template that does not include template text should include at least one template 
item. If you include template text, this text appears in the message body, before any 
content specified with template items.

You must select either a literature item or a file to include for the template item.

Checking the HTML Template check box for a template specifies that HTML text 
from template items specified for the message body is sent as HTML. If HTML 
Template is not checked, this text is converted to plain text before sending.
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For more information about template item fields mentioned here, see “Fields for 
Template Items” on page 421.

To add template items for a template

1 From the application-level menu, choose View > Site Map > 
Communications > My Templates.

2 In the Templates list, select the advanced template for which you are adding 
template items.

3 For an HTML template, verify that the HTML Template check box is checked.

4 Click the Template Items view tab.

5 In the Template Items list, add a new record for each template item.

6 Specify a sequence number for the template item.

7 To add a literature item:

a Click the select button for the Literature Name field.

b In the Pick Literature dialog box, specify a literature item, then click OK.

8 To add a file:

a Click the select button for the Attachment Name field.

b In the Add Attachment dialog box, click Browse, specify a file from the 
operating system, then click Add.

9 For a template item that is to be an attachment to an email or fax message, 
specify a label in the Attachment Label field.

10 In the Template Item form:

a Optionally, specify an iteration child business component from which you 
can specify substitution fields.

b Check the Substitute Values box, if you want to use field substitution for the 
file or literature item specified for the template item in previous steps.

The Available Substitutions list is populated with field names as described in 
“Fields for Template Items” on page 421.
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c Check the Message Body box, as appropriate.

❏ For an email or fax template, check the Message Body box to include the 
template item content in the message body. Otherwise, the template item 
content will be an attachment to the email or fax message.

❏ For a wireless message or page template, you must check the Message 
Body box to include the template item. For a wireless message template, 
template item content that is not specified for the message body is 
ignored. For a page template, the message will fail if any template item is 
not specified for the message body. (Template items must be plain-text 
files or literature items.)

Modifying a Template Item That Specifies a File
If you need to modify a file you added to a template item in the previous procedure, 
you can do this in either of two ways.

To modify a template item file if the original operating system file still exists

1 Open the file in the operating system environment.

2 Modify it, and save it to the operating system.

3 Delete the template item record to which you added the file.

4 Create a new template item record, adding the modified version of the file. 

To modify a template item file if the original operating system file does not exist

1 Open the file from the template item record, by clicking the hyperlink in the 
Attachment Name field.

2 Modify that file, and save it to the operating system.

3 Delete the template item record to which you added the file.

4 Create a new template item record, adding the modified version of the file you 
just saved.
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Copying or Deleting Templates and Template Items
You can copy or delete a template, copy a template item within a template, or delete 
a template item from a template.

Copying Templates and Template Items
When you copy a template, you must specify a new name for the new template. As 
appropriate, you can modify existing settings such as the delivery profile, specify 
different template text, or add template items. No template items are automatically 
associated with the new template.

When you copy a template item within a template, the copy is identical to the 
template item that you copied, except that its sequence number is one higher than 
the highest sequence number for all the other template items. As appropriate, you 
can modify existing settings, such as to specify a different file or literature item, 
change whether the template item’s content is to appear in the message body, or 
change the value-substitution settings.

Deleting Templates and Template Items
When you delete a template, its template items are also deleted. However, the files 
or literature items used by the template items are not deleted from the Siebel File 
System. When you delete a template item, the file or literature item used by the 
template item is not deleted from the Siebel File System.

Each end user can delete any template the user has created, or delete template items 
from such a template. A Siebel administrator can delete any template or template 
item.

Fields for Templates
This section contains descriptions for the fields in the My Templates or All 
Templates view that you specify when you create templates. The options are 
organized according to where they are specified.

For descriptions of the fields for template items, see “Fields for Template Items” on 
page 421.
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Templates List
The following options are specified in the Templates list:

■ Name (required). Specify a unique name for the template.

■ Channel Type (required). Select from a picklist the type of communications 
channel for the template. Predefined options include Email, Fax, Pager, and 
Wireless Message.

For templates to be used with outbound communication requests, the channel 
type can help determine how to deliver a template, such as for wireless 
messages.

The Default Preference setting you can specify when creating requests (for use 
with the Only Send Preference check box) would generally correspond to the 
Channel Type setting for the included templates.

For the Send commands and for email replies in Siebel eMail Response, the 
channel type also determines whether the template will appear in the Body 
drop-down list in the context of use. For more information, see “Template 
Visibility and Access” on page 398.

■ Language (required). Specify the language for the template. Templates listed for 
use are filtered based on this setting. The field value defaults to the current 
language in effect for the user’s session.

For more information, see “Template Visibility and Access” on page 398 and 
“Preference Settings in the Outbound Communications Tab” on page 347.

■ Locale (required). Specify the locale for the template. Templates listed for use are 
filtered based on this setting. The field value defaults to the current locale in 
effect for the user’s session.

For more information, see “Template Visibility and Access” on page 398 and 
“Preference Settings in the Outbound Communications Tab” on page 347.

■ Description. Enter a brief description of the template.
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Simple Form
The following options are specified in the Simple form:

■ Recipient Group. Select from a picklist the type of recipient group for the template. 
The recipient groups you can choose correspond to business objects for which 
a primary business component is specified—such as Account, Opportunity, 
Contact, and so on.

The recipient group specified for the template is optional and is used to obtain 
values for the Available Substitutions list.

The recipient group you specify here only determines which substitution fields 
are available for the template text. The actual recipients are determined in the 
context in which the template is used—such as in using the Send commands or 
sending email replies.

NOTE: The Recipient Group field on the Simple tab functions differently than the 
field with the same name on the Advanced tab.

■ Template Type. Specify the type of template. This option helps users choose 
templates with the appropriate function. Default values include Greeting, Body, 
and Closing.

■ A reply message for Siebel eMail Response can use all of these template 
types.

■ The Send commands use templates of type Body.

■ Subject. Enter text for a subject line for the template.

Text in the Subject field can also include substitutions from the Available 
Substitutions list, as determined by the specified recipient group.

■ For a new email message (as opposed to a reply), the text from this field is 
used in the Subject line of the message.

■ For a reply message in Siebel eMail Response, the subject-line text is derived 
from the subject line of the original inbound email message.
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■ For a fax, the text from this field appears on the cover page of the faxed 
message.

NOTE: If you are using Captaris RightFax with the Unicode patch, then the 
subject text will appear on the fax cover page only for ENU (U.S. English) 
software. For all other languages, the subject text will appear on a second 
page of the faxed message. For more information, see “Integrating with Fax 
Systems” on page 521.

■ For a page or wireless message, text from the Subject field is not used.

■ Public. Check this option to make this template available for all users to specify 
in the context in which the templates will be used, such as in using the Send 
commands or sending email replies. Leave this box unchecked if the template 
should be available only to the current user and to administrators.

■ HTML Template. Check this option to specify that an email or fax template is an 
HTML template. Leave this box unchecked if the template is plain text. If this 
box is not checked, then any formatting you apply in the Template Text field is 
stripped when you save the template. 

For an advanced template, checking the HTML Template check box also specifies 
that HTML text from template items specified for the message body is sent as 
HTML. If HTML Template is not checked, this text is converted to plain text 
before sending.

For information about HTML formatting in the Template Text field, see “Editing 
and Formatting Controls for Template Text Field” on page 405.

This setting also determines whether the template may be listed in the context 
of use, based on the applicable outbound communications user preference 
setting for default message format (for Send Email or Send Fax, or for email 
replies for Siebel eMail Response).

For more information, see “Template Visibility and Access” on page 398 and 
“Preference Settings in the Outbound Communications Tab” on page 347.
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■ Available Substitutions. Displays the business component fields that are valid for 
substitution. You can copy and paste such fields into the Template Text field for 
the template.

The fields available for substitution are from the primary business component 
of the business object specified by the Recipient Group field.

All substitution fields must be enclosed within brackets ([ ]) in the template text.

For example, available substitution fields for Contact include [Contact.Last 
Name], while fields for Account include [Account.Name].

NOTE: For an HTML template, make sure that the enclosing brackets and text of 
any substitution field text do not include any tagging changes. For example, do 
not change from bold to regular text within the enclosing brackets of a 
substitution field. Doing so may prevent proper data substitution.

If your template must contain a literal bracket character ([ or ]), insert a 
backslash character (\) before the bracket to “escape” the bracket character, so 
it will be correctly interpreted.

NOTE: If a substitution field is not enclosed in brackets, or if some other notation 
is used, such as enclosing the field name within percentage characters (%), then 
Communications Outbound Manager cannot perform substitution for the field.

■ Language (required). See “Templates List” on page 411.

■ Locale (required). See “Templates List” on page 411.

■ Template Text. Specify text for the template. As appropriate, you can copy and 
paste fields from the available substitutions.

All template text appears at the start of the message body. 

For information about editing and formatting within this field, see “Editing and 
Formatting Controls for Template Text Field” on page 405.
414 Siebel Communications Server Administration Guide Version 7.5.3



Configuring Communications Templates

Fields for Templates
Advanced Form
The following options are specified in the Advanced form:

■ Delivery Profile. Select the communications profile to use in order to deliver the 
template to recipients. The profile must support the specified channel type.

The delivery profile must be specified for any template that will be sent using an 
outbound communication request, except for templates for the Wireless 
Message channel, for which it is optional. This field is not present on the Simple 
tab, because it is only used for outbound communication requests.

For templates of channel type Wireless Message used for outbound 
communication requests:

■ If a template has a profile, then, for each recipient: Communications 
Outbound Manager identifies the highest priority mobile device that has a 
corresponding profile and sends the message to the associated address using 
that profile. If there is no match, then no message is sent to that recipient.

■ If a template does not have a profile, then, for each recipient: 
Communications Outbound Manager identifies the highest priority mobile 
device and that device’s highest priority address, and uses the associated 
profile to send the message to that device.

For more information, see “Configuring Communications Drivers and Profiles” 
on page 68.
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■ Recipient Group. Select the type of recipient group for the template. The recipients 
might be, for example, all contacts associated with an opportunity—this 
particular group is identified as Opportunity Contacts.

The recipient group specified for the template is optional and is used to obtain 
values for the Available Substitutions list.

The recipient group you specify here only determines which field substitutions 
are available for the template text. The actual recipient group, and actual 
recipients, are determined for the communication request where the template is 
used.

NOTE: The Recipient Group field on the Advanced tab functions differently than 
the field with the same name on the Simple tab.

The Recipient Group picklist displays recipient groups for many major business 
objects and business components. For predefined values, see “Predefined 
Recipient Groups for Requests and Advanced Templates” on page 289. 

You can customize the list of values for the Recipient Group picklist in order to 
add or remove recipient groups. For more information, see “Configuring 
Recipient Groups for Requests and Advanced Templates” on page 287.

■ Subject. Enter text for a subject line for the template.

Text in the Subject field can also include substitutions from the Available 
Substitutions list, as determined by the specified recipient group.

■ For an email message sent using a communication request, the text from this 
field is used in the Subject line of the message.

■ For a fax sent using a communication request, the text from this field appears 
on the cover page of the faxed message.

NOTE: If you are using Captaris RightFax with the Unicode patch, then the 
subject text will appear on the fax cover page only for ENU (U.S. English) 
software. For all other languages, the subject text will appear on a second 
page of the faxed message. For more information, see “Integrating with Fax 
Systems” on page 521.

■ For a page or wireless message, text from this field is not used.
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■ Create Activity. Check this option to set activity logging for outbound 
communication requests that include this template.

If Create Activity is checked for the template, one activity is created for each 
recipient, after the message is sent to that recipient. For each activity record, the 
text from the template’s Subject field is written to the Description field, and the 
text from the template’s message body is written to the Comments field.

Sending a message to a large number of recipients generates an equally large 
number of activity records.

NOTE: If you add a new recipient group using a custom business component, then 
you must create a System Activity object on the custom business component in 
order to specify fields that can be logged with activity logging.

For more information about activity logging, see “Viewing Activity Records for 
Communication Requests” on page 445.

■ Public. Check this option to make this template available for all users to specify 
in the context in which the templates will be used, such as in sending outbound 
communication requests. Leave this box unchecked if the template should be 
available only to the current user and to administrators.

NOTE: The Public field is ignored for any template that is specified to be sent 
using an outbound communication request initiated through Siebel Business 
Process Designer. Any defined template can be specified.

■ HTML Template. Check this option to specify that an email or fax template is an 
HTML template. Leave this box unchecked if the template is plain text. If this 
box is not checked, then any formatting you apply in the Template Text field is 
stripped when you save the template.

For information about HTML formatting in the Template Text field, see “Editing 
and Formatting Controls for Template Text Field” on page 405.
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■ Attach Bookmark. Includes a Siebel bookmark in communication requests sent 
using this template.

A Siebel bookmark is a URL that links to a specific record in the Siebel 
application. A bookmark included in an email message allows a user to click to 
navigate directly to this record. If you specify this option, a bookmark is 
included in outbound messages sent using this template. The bookmark URL is 
appended to the message body. The bookmark URL functions as a link whether 
the template is HTML or plain text.

For example, if you are sending email to account team members, a bookmark 
URL may be sent providing access to the account record that was specified as 
the recipient source for the communication request.

Bookmarks can be included in messages sent using templates of any applicable 
channel. However, only bookmarks in email messages allow the recipient to 
click to navigate to the target record in the Siebel application.

If the recipient user is running the Siebel application, the bookmark record can 
open in this window or can open in another browser window. If the user is not 
logged in, the user is prompted to log in before the record is accessed.

NOTE: A bookmark can be manually inserted in an email message or document 
by choosing the command Get Bookmark URL from the applet-level menu.

Before you can specify to include bookmarks, note the following requirements:

■ The Siebel administrator must specify a value for the WebServer server 
component parameter for the Communications Outbound Manager. In order 
to access the bookmarked record, the recipient users must have access to the 
Web server and Application Object Manager specified using this parameter.

For more information, see “Administering Communications Outbound 
Manager” on page 333.
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■ For each business component representing a type of record for which 
bookmarks are to be supported, the Siebel configurator must verify that the 
user property Default Bookmark View has been appropriately defined.

This property specifies the Siebel application view in which the bookmark 
record should open for the end user, who is in this case the email recipient. 
The specified view should be an end user view that is available to the 
intended recipients. This user property is already defined for many key 
business components. For example, for the Account business component, the 
default bookmark view is Account List View.

For more information about configuring user properties for business 
components, refer to Siebel Tools Reference and Siebel Tools Online Help.
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■ Available Substitutions. Displays the business component fields that are valid for 
substitution. You can copy and paste such fields into the Template Text field for 
the template.

The fields available for substitution are from the recipient business component 
specified by the Recipient Group (such as Contact, for Account Contacts), or 
from the primary business component in the recipient source business object 
(such as Account, for Account Contacts). Fields for the primary business 
component are prefaced by the business component name, followed by a period.

All substitution fields must be enclosed within brackets ([ ]) in the template text.

For example, available substitution fields for Account Contacts include [Last 
Name], from the Contact business component, and [Account.Name], from the 
Account business component.

NOTE: For an HTML template (HTML text in the Template Text field) or an HTML 
template item, make sure that the enclosing brackets and text of any substitution 
field text do not include any tagging changes. For example, do not change from 
bold to regular text within the enclosing brackets of a substitution field. Doing 
so may prevent proper data substitution.

If your template must contain a literal bracket character ([ or ]), insert a 
backslash character (\) before the bracket to “escape” the bracket character, so 
it will be correctly interpreted.

NOTE: If a substitution field is not enclosed in brackets, or if some other notation 
is used, such as enclosing the field name within percentage characters (%), then 
Communications Outbound Manager cannot perform substitution for the field.

■ Language (required). See “Templates List” on page 411.

■ Locale (required). See “Templates List” on page 411.
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■ Template Text. Specify text for the template. As appropriate, you can copy and 
paste fields from the available substitutions.

All template text appears at the start of the message body.

For information about editing and formatting within this field, see “Editing and 
Formatting Controls for Template Text Field” on page 405.

Fields for Template Items
This section describes the information you can specify for a template item. The 
options are organized according to where they are specified.

For descriptions of the fields for templates, see “Fields for Templates” on page 410.

Template Items List
The following options are specified in the Template Items list or the Template Item 
form:

■ Sequence (required). A sequence number is provided for the template item, using 
the lowest available number (starting with 1). The sequence number is used in 
assembling the template items for the communication.

The default sequence value for a new template item is the lowest number not 
used by an existing or previously created template item for the same template. 
For template items specified for the message body, messages to be delivered to 
recipients are constructed as follows:

■ All plain-text template items are concatenated, in sequence, to form the 
plain-text message body for the email message. (Applies to email, fax, 
wireless message, and page templates.)
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■ All HTML template items are concatenated, in sequence, to form the HTML 
message body for the email message. If HTML template text is defined, then 
this text is appended by the HTML template items for the message body. 
(Applies to email templates only.)

Only template items that have the Message Body flag checked form the plain-
text message body or (for email only) HTML message body.

For an email message, the recipient’s email client will display the HTML version 
of the message body if it can do so; otherwise, the email client will display the 
plain-text version of the message body. Sending separate plain-text and HTML 
versions of the same email message body is called MIME multipart/alternative 
support. (MIME stands for Multipurpose Internet Mail Extension.)

NOTE: For a fax template, specify HTML template items as attachments only. Do 
not specify HTML template items for the message body. (The text in the 
Template Text field may be either HTML or plain text.)

You can change the sequence number for a template item, but you cannot 
specify a sequence number that is in use by another template item. Instead, you 
must shift the numbers to make space for the one you want to modify. For 
example, if you have sequences 1 and 2, to swap them you could change 1 to 3, 
change 2 to 1, then change 3 to 2.

■ Attachment Label. Specify a label for a template item that is to be an attachment 
to an email or fax message. In this context, what is meant by an attachment is 
any template item for which Message Body is not checked.

For a template item that you are adding as an attachment to an email or fax 
message, the Attachment Label field provides an optional string to name the 
attachment. If an attachment label is not specified, the file name and extension 
are used as the attachment label.

For an HTML template item that you are adding as an attachment to an email or 
fax message:
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■ The Attachment Label field specifies a string that is used for embedding the 
template item into the HTML. The string must exactly match a reference in 
the HTML markup, in order for the HTML content to provide recipients 
access to the template item content, such as an embedded picture.

The email client for an email recipient, or the email server for your fax 
gateway, matches these strings in order to correctly locate and display or 
process each picture, or other embedded attachment.

For example, for an attachment label “my_picture.jpg” (without the 
enclosing quotes), the matching HTML reference for this embedded picture 
file would be:

<IMG SRC="my_picture.gif">

■ If an attachment label is not specified, the attachment is a true attachment to 
the HTML email or fax message, and is not embedded in the HTML message.

NOTE: If an attachment label is specified that does not exactly match a reference 
in the HTML markup, then email clients, or the email server for your fax 
gateway, may not be able to access the template item. The template item would 
be an embedded attachment for which the HTML markup provides no access.

For more information, see the description for the Attachment Name field, later 
in this section.

Embedding pictures or other referenced files in HTML makes an email message 
larger and makes it take longer to send, or makes a fax take longer to be 
processed by your fax gateway. For an email message, you can also make a file 
available on the Internet and include its URL in the HTML. If you do this, do not 
also add the files as template items. Recipients can view the images only if they 
are connected to the Internet when they read the email message.
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■ Literature Name. Specify a literature item from the Siebel File System that you 
want to use for the template item.

When you click the select button for this field to add a file, the Pick Literature 
dialog box displays, where you can browse literature items.

For a literature item you specify, values can be substituted using the business 
component fields listed in the Available Substitutions list, if Substitute Values is 
checked.

A template item containing a literature item can be specified for the message 
body for the template, or specified to be an attachment.

You can drill down on the literature item to navigate to another view where you 
can open the item.

For information about adding literature items to the Siebel File System, refer to 
Applications Administration Guide.
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■ Attachment Name. Specify the name of an operating system file you want to use 
for the template item. The file can be a text file, an HTML file, a graphics file, or 
another type of file.

When you click the select button for this field to add a file, the Add Attachment 
dialog box displays, where you can click Browse to browse files in the operating 
system environment.

Once you have specified a file, its name (without the file extension) is displayed 
in the Attachment Name field.

Any graphics (picture) file for an HTML message must be added as a file and 
specified as an attachment to the message—that is, it cannot be specified for the 
message body. An attachment label must be specified for the file, as described 
in this section for the Attachment Label field.

For a file you specify, values can be substituted using the business component 
fields listed in the Available Substitutions list, if Substitute Values is checked.

A template item containing a file can be specified for the message body for the 
template, or specified to be an attachment.

NOTE: When you specify a file for a template item, the file is automatically added 
to the Siebel File System. The operating system file is never referenced after this. 
When you send the file, you send the version in the Siebel File System.

■ File Type. (read only) Displays the extension of a file you added. The file name, 
without the extension, is displayed in the Attachment Name field.

■ File Size. (read only) Displays the size, in kilobytes, of a file you added.
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Template Item Form
The following options are specified in the Template Item form:

■ Iteration Child BC. Select the name of a business component from which you want 
to include record data.

The available business components you can specify are direct children of the 
recipient source business object that was specified by the Recipient Group. 

NOTE: Within the source business object, any business component that you want 
to be able to specify in the Iteration Child BC field must have a link in which the 
parent business component is the primary business component on the business 
object.

If Substitute Values is checked and you specify a child business component, the 
template item is appended to the message body or attachment once for each 
record in the child business component, in iterative fashion. Business 
component field values are substituted for each record.

A template item can include fields from the child business component for which 
values will be substituted. The Template Item form displays the available 
substitutions.

For example, if you are targeting a template to Account Team Members, and you 
want to include a list of opportunities for the account, you can choose 
Opportunity as the iteration child business component for a template item. 

If the file or literature item for this template item includes any of the field names 
shown in the Available Substitutions list, then values for these fields, for all 
opportunities that are children of the account, are included in the message body 
or attachment. In this example, values for opportunity name and expected 
revenue figures may be substituted.

■ Substitute Values. Check this option to enable value substitution for the template 
item. For more information, see the descriptions for the Available Substitutions 
list and for the Iteration Child BC field.
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■ Message Body. Check this option to specify that the template item’s content 
should be used in the message body of the template’s message.

Multiple plain-text or HTML template items marked for the message body will 
be concatenated into a single message body for each of these types, in the 
sequence determined by their sequence numbers. See also the description for 
the Sequence field, earlier in this section.

NOTE: For a fax template, specify HTML template items as attachments only. Do 
not specify HTML template items for the message body.

If a template item is used as part of the message body, it must be either a plain-
text or HTML file. Communications Outbound Manager uses the file extension 
to distinguish whether a template item’s file is in HTML format. Any file with an 
extension containing “htm” (such as .htm, .html, or .shtml) is treated as an 
HTML file.

The setting of the HTML Template check box also determines how HTML 
template items are handled. For details, see “Fields for Templates” on page 410.

A file or literature item, for which values will be substituted using business 
component fields, can be specified for the message body or specified as an 
attachment. (When specified for the message body, files or literature items can 
be plain-text or HTML files only; other file types are not supported and may 
produce unacceptable results.)

If Message Body is not checked, the current template item will be an attachment 
to the message, using the label you specify in the Attachment Label field.

For templates of channel type Fax, any template items not specified for the 
message body are subject to what is supported by the sending fax server. Some 
fax servers support certain types of attachments only; some may not support any 
attachments.

For templates of channel type Wireless Messaging, any template items not 
specified for the message body are ignored.

For templates of channel type Pager, any template that has one or more template 
items that are not specified for the message body will not be sent.
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■ Available Substitutions. Displays the business component fields that are valid for 
substitution. You can use the Available Substitutions list for reference, or copy 
and paste such fields into a template file or literature item that you use for the 
template item.

The fields in the Available Substitutions list are from one of the following:

■ The recipient business component specified by the Recipient Group (such as 
Contact, for Account Contacts), or the primary business component in the 
recipient source business object (such as Account, for Account Contacts). 
Fields for the primary business component are prefaced by the business 
component name, followed by a period. These business component fields are 
displayed in the Available Substitutions list if the Iteration Child BC field is 
empty.

■ The business component specified in the Iteration Child BC field representing 
a child (such as Account Note) of the recipient source business object (such 
as Account). Fields for the iteration child business component are prefaced 
by the business component name, followed by a period.

All substitution fields must be enclosed within brackets ([ ]) in the template 
item’s file or literature item.

For example:

■ Available substitution fields for the Account recipient group (for a simple 
template) include [Account.Name], [Account.Last Name], 
[Account.Location], and so on, from the Account business component, 
which is the primary business component for the Account business object.

■ Available substitution fields for the Account Contacts recipient group 
(advanced template) include:

❏ [Last Name], [City] and so on, from the Contact business component

❏ [Account.Name], [Account.Last Name], [Account.Location], and so on, 
from the Account business component
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■ Available substitution fields for the Account Note iteration child business 
component include [Note], [Note Type], and so on, from the Note business 
component.

NOTE: For an HTML template (HTML text in the Template Text field) or an HTML 
template item, make sure that the enclosing brackets and text of any substitution 
field text do not include any tagging changes. For example, do not change from 
bold to regular text within the enclosing brackets of a substitution field. Doing 
so may prevent proper data substitution.

If your template must contain a literal bracket character ([ or ]), insert a 
backslash character (\) before the bracket to “escape” the bracket character, so 
it will be correctly interpreted.

NOTE: If a substitution field is not enclosed in brackets, or if some other notation 
is used, such as enclosing the field name within percentage characters (%), then 
Communications Outbound Manager cannot perform substitution for the field.
Version 7.5.3 Siebel Communications Server Administration Guide 429



Configuring Communications Templates

Fields for Template Items
430 Siebel Communications Server Administration Guide Version 7.5.3



Defining Outbound Communication Requests 10
This chapter describes how to create and submit outbound communication 
requests, and monitor the status of outbound communication requests.

The procedures described in this chapter can be performed either by administrators 
or by advanced end users.

About Outbound Communication Requests
An outbound communication request is a defined request to send content from 
communications templates (optionally with field substitution) to recipients 
associated with business object instances—such as to contacts associated with an 
account. Requests are sent using email, fax, wireless message, pager, or other 
channels, as defined in the specified templates and as supported for your 
communications infrastructure.

Requests can be created and submitted directly, as described in this section, or from 
modules such as Siebel Marketing, using Siebel Business Process Designer and 
business services.

Prerequisite Recipient Addressing Information
For an outbound communication request to succeed, the business component 
records, or other associated records, for the recipients of the communication must 
have the appropriate contact information defined for them. As necessary:

■ Email address, fax number, and pager fields for contacts, employees, partners, 
prospects, or other potential recipients must contain valid data.

■ Mobile device records associated with wireless messaging recipients must 
contain valid data.
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For information about specifying which business components fields contain 
addressing information, see “Configuring Recipient Sources Applets” on page 295.

Siebel Views for Working with Outbound Communication Requests
End users can create and submit communication requests in these views in the 
Communications screen:

■ My Outbound Requests

■ My Outbound Request Overview

Administrators can create and submit communication requests in these views in the 
Communications Administration screen:

■ All Outbound Requests

■ Outbound Request Overview

End users see only the requests they have created. Administrators see all requests.

NOTE: Procedures in this section assume a non-administrator user, using the My 
Outbound Requests and My Outbound Request Overview views in the 
Communications screen.

Creating and Submitting Outbound Requests
This section describes how to create and submit an outbound communication 
request. The procedures are the same for end users and administrators, though the 
administrators would generally use different views for this activity.

Communication requests submitted from Siebel Web Client or Siebel Dedicated Web 
Client are processed immediately. Requests submitted from Siebel Mobile Web 
Client, while you are connected to the local database and disconnected from the 
enterprise database, are saved until you synchronize. They are then processed for 
delivery by the Communications Outbound Manager server component.
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For more information about the New Communication menu command, see “Using 
the New Communication Command to Create a Request” on page 435.

For information about dividing high-volume requests into subrequests for efficient 
processing, see “Configuring Subrequests” on page 436.

NOTE: If you are implementing a custom channel type, see also “Configuring 
Communications List of Values Types” on page 282.

Creating an Outbound Communication Request
This section describes how to create an outbound communication request.

To create an outbound communication request

1 Display the My Outbound Request Overview view by doing one of the following:

■ From the application-level menu, choose View > Site Map > 
Communications > My Outbound Request Overview.

■ When in a view displaying information about the intended recipients of a 
communication, choose, from the application-level menu, File > New > 
Communication.

The My Outbound Request Overview view appears.

2 If necessary, add a new record in the Communication Requests list.

This step is not necessary if you chose New Communication in Step 1.

3 Provide information for the new communication request, as described in “Fields 
for Outbound Communication Requests” on page 438.

a Specify a type of recipient group, such as Opportunity Contacts.

b Specify at least one instance of the recipient source (such as an opportunity) 
in order to determine the actual recipient group for the request.

Step 3 is not necessary if you chose New Communication in Step 1.

4 Add templates for the request, as follows:
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a Click the Request Templates view tab.

b In the Request Templates list, add a new record.

c Choose one or more existing templates from the dialog box that appears.

For an end user, the templates displayed in the dialog box are those for which 
the primary business component of the associated recipient group matches 
that of the request’s recipient group. The templates listed were either created 
by that user or marked for public access. For an administrator, all templates 
are displayed.

In the requests views, records for templates are read-only. You can modify 
the template in the end-user or administrator views for templates. For more 
information, see Chapter 9, “Configuring Communications Templates.”

5 Optionally, specify how many subrequests the request should be broken into, as 
described in “Configuring Subrequests” on page 436.

a Click the Subrequests button in the top right, on the Communication Request 
form or the Communication Requests list.

b In the dialog box that appears, specify a number between 2 and 26, inclusive, 
to indicate how many subrequests should process the parent request.

6 Submit the request, as described in the following section.

Submitting an Outbound Communication Request
This section describes how to submit an outbound communication request you 
previously created.

NOTE: If the Communications Outbound Manager component aborts, a 
communication request that has already been submitted can be resumed 
automatically upon restarting the Siebel Server. Or, the request can be resubmitted 
in order to process it from start to finish. 

For more information, see “Outbound Communication Request Restart Capability” 
on page 441, “Monitoring Outbound Communication Request Status” on page 442, 
and “Monitoring Siebel Server Request Status” on page 443.
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To submit an outbound communication request

1 From the application-level menu, choose View > Site Map > Communications 
> My Outbound Requests.

2 In the Communication Requests list, select the record for a communication 
request that is ready to be submitted.

For an end user, the requests displayed are those that were created by that user. 
For an administrator, all requests are displayed.

3 From the Show drop-down list, choose My Outbound Request Overview.

The My Outbound Request Overview view appears.

4 Verify that the request has been correctly configured and includes the intended 
templates. Modify the request, as appropriate.

5 Click Submit in the Communication Request form.

If the communication request is properly processed by the Server Request 
Processor, Server Request Broker, and Communications Outbound Manager 
server components, the request will be passed to the appropriate messaging 
systems for delivery to the intended recipients.

6 Monitor the request in progress, as appropriate.

For information about monitoring requests, see “Monitoring Outbound 
Communication Request Status” on page 442 and “Monitoring Siebel Server 
Request Status” on page 443.

Using the New Communication Command to Create a Request
Using the New Communication command displays the My Outbound Request 
Overview view (in the Communications screen) with a newly created request 
record.

A recipient source record is created, based on the current record in the original view. 
For example, an account record is specified, if you chose the command with a 
selected record from an Accounts view. The recipient group for the request is also 
based on the current record in the original view.
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For example, if you chose the command while displaying an Accounts view, the 
current account is the recipient source, and the account contacts are the recipients. 
If more than one recipient group is based on the same business object (recipient 
source), the first matching recipient group is used.

If no recipient groups are defined for the current business object, then the New 
Communication command is not available.

After you choose the command, finish specifying the outbound communication 
request, as described in “Creating and Submitting Outbound Requests” on 
page 432.

Configuring Subrequests
An outbound communication request can be broken into subrequests, which can 
be processed by more than one instance of the Communications Outbound Manager 
server component in order to achieve greater scalability for requests with a large 
number of recipients or large processing demands. 

You can specify from 2 to 26 subrequests for a given request. Subrequests are 
divided based on the last name of each recipient.

For example, if 2 subrequests are specified, then all recipients with last names A–M 
are handled by one subrequest, and those with last names N–Z are handled by the 
second subrequest. If 3 subrequests are specified, recipients are allocated to three 
alphabetical groupings (A–I, J–R, S–Z). If 4 subrequests are specified, recipients are 
allocated to four alphabetical groupings (A–F, G–M, N–S, T–Z), and so on.

Subrequests are distributed to multiple instances of the server component whose 
name is specified for the request. This approach load-balances your communication 
requests to achieve scalability objectives—particularly when subrequests are 
divided among multiple Siebel Server machines. Requests are distributed by Server 
Request Processor and Server Request Broker.

If you click the Subrequests button after subrequests have already been specified, 
the number of subrequests is displayed. After a request has been processed, the 
Communication Subrequests view tab displays a list of the subrequests for the 
request. The form below the Communication Subrequests list includes the Recipient 
Search Specification field, which may display information about how the set of 
recipients for the subrequest was defined.
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To configure your system for optimal processing of high-volume outbound 
communication requests using subrequests, you can designate Siebel Server 
instances running on multiple server machines to run Communications Outbound 
Manager. For more information about Communications Outbound Manager, see 
“Administering Communications Outbound Manager” on page 333.

NOTE: Subrequests cannot be specified for any outbound communication request for 
which more than one recipient source object has been specified. For example, for a 
request based on the recipient group Campaign Contacts, one and only one 
campaign record can be specified if you are to specify subrequests for this request.

Subrequest SQL File Option
Depending on the requirements for your deployment, your company may choose to 
implement alternative SQL for processing subrequests. You can do this by creating 
a SQL file to be read in place of the default Siebel method of processing subrequests.

This file must be named commoutboundmgr.cfg, and it must be located in the 
subdirectory CMS of the Siebel File System directory. For example, depending on 
your installation, the full path might be as follows:

C:\sea752\FS\CMS\commoutboundmgr.cfg

If no file exists of this name exists in the designated location, then the default 
hardcoded SQL from Siebel Systems is used for processing subrequests.

For more information on this issue, refer to Siebel SupportWeb.

Deleting Outbound Communication Requests
You can delete a record for an outbound communication request. An end user can 
delete any request the user has created. A Siebel administrator can delete any 
request.

Any request that is being processed (that is, the status has changed from Submitted 
to Processing) will continue to be processed until completion, even if the request is 
deleted.
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Fields for Outbound Communication Requests
This section describes the fields for outbound communication requests. Several 
fields are read only, and can be referenced for tracking purposes.

■ Description. Enter a description for the request.

■ Request #. (read only) A unique ID for each request, which is generated when 
the request is created.

■ Recipient Group. Select from a picklist the group of intended recipients for the 
communication. The recipients might be, for example, all contacts associated 
with an opportunity—this group is identified as Opportunity Contacts.

After you specify the Recipient Group here, the Recipient Sources list in My 
Outbound Request Overview changes to reflect the business object representing 
the source from which the recipients are derived, such as Opportunities. The 
recipient source business object is identified using a label displayed on the right 
side of the applet header area.

You add records to the Recipient Sources list, which is renamed to reflect the 
specified business object, to specify one or more instances of the primary 
business component for this business object—such as particular opportunities.

The read-only Recipients list at the bottom shows every individual recipient to 
whom a separate instance of the communication will be sent—such as the 
Opportunity Contacts for each opportunity.

NOTE: The Recipient Group picklist displays recipient group types for many major 
business objects and business components. For a list of the predefined values 
and the business object and business component associated with the recipient 
group, see “Predefined Recipient Groups for Requests and Advanced Templates” 
on page 289. 

You can customize which values appear in the Recipient Group picklist. For 
more information, see “Configuring Recipient Groups for Requests and 
Advanced Templates” on page 287.
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■ Component Name. Displays the name of the server component that is to process 
the outbound communication request.

The default component name is CommOutboundMgr (for Communications 
Outbound Manager). If you have configured any new server components based 
on CommOutboundMgr, you can specify another component name here.

For example, if you have created and configured the server component 
CommOutboundMgr2, and want the current request to be processed by an 
instance of this component, specify this new component name in this field.

NOTE: If your Siebel application deployment involves different .srf files (Siebel 
repository files), then you should run differently named server components, 
based on CommOutboundMgr, for each different repository file used by one or 
more Siebel Server. Otherwise, field data may not be correctly substituted in 
your communications templates. 

For more information, see “Administering Communications Outbound Manager” 
on page 333. Also refer to Global Deployment Guide.

NOTE: Subrequests specified for a request may be processed by more than one 
server task for the server component designated to handle the request, according 
to how your environment is configured. For more information about 
subrequests, see “Configuring Subrequests” on page 436.

■ Status. (read only) The current status of the request. For more information, see 
“Monitoring Outbound Communication Request Status” on page 442.

■ Status Message. (read only) Status message text generated by the 
Communications Outbound Manager server component for the request, if such 
text was generated. For more information, see “Monitoring Outbound 
Communication Request Status” on page 442.
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■ Only Send Preference. Check this option to send to each individual recipient only 
the templates that match the recipient’s communications preference, if it is 
specified, or that match the channel preference specified in the Default 
Preference field.

If you construct a communication request that contains templates of more than 
one channel type, and this option is checked, then an individual recipient can 
receive communications only for a single channel type.

The communications preference field affected by the Only Send Preference 
check box generally corresponds to the setting of the Recipient Preferred 
Medium Field user property for the business component. 

For example, for both employees and contacts, the Preferred Communications 
field is the default field containing the channel preference. (For contacts, the 
caption for this field is Contact Method.) If this user property is not defined, then 
the preference is retrieved from the Preferred Communications field, if the 
business component includes such a field. 

For more information, refer to Applications Administration Guide.

If the communications preference is not specified for a recipient, and the Only 
Send Preference option is checked, then the preference specified in the Default 
Preference field is used for that recipient.

■ Default Preference. Specify a default delivery type to use for communication 
requests to each individual recipient if Only Send Preference is checked for the 
request, but no communications preference is specified for the recipient.

For more information, see the description for Only Send Preference.

■ Start Time. (read only) The time that the Communications Outbound Manager 
server component started processing the request.

■ End Time. (read only) The time that the request was fulfilled.

■ Created. (read only) The time that the request was created.

■ Created By. (read only) The user who created the request.

■ Comments. Enter comments about the request.
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Outbound Communication Request Restart Capability
If the Siebel Server aborts (or the host machine goes down) while the 
Communications Outbound Manager component is processing a communication 
request, Communications Outbound Manager creates a file in the Siebel File System 
containing information about the last message sent.

The file is named CommOutboundMgrxxx.crf, where xxx is the ID number for the 
request.

If, at a later time, a request with the same request ID is submitted, Communications 
Outbound Manager will detect the corresponding file .crf file and resume the 
request where it left off.

If the request or the template data was modified since the time the request was 
originally submitted, then the total message output of the resumed request plus the 
aborted request may not exactly match the output that the original request would 
have generated had it not been aborted.

You can delete the .crf file if you do not need it. If you delete the .crf file and 
resubmit the request, then the request will be processed completely from start to 
finish.

The restart capability described in this section applies only to when the 
Communications Outbound Manager component aborts while processing a valid 
communication request. It does not apply to when the component stops processing 
a request due to error, such as incorrectly specified recipients. In such a case, 
Communications Outbound Manager does not abort and can continue to receive 
and process requests.
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Monitoring Outbound Communication Request Status
Outbound communication requests initiated by end users or administrators can be 
monitored in the views for working with outbound communication requests. These 
views display the status of each communication request that has been run by the 
Communications Outbound Manager component. 

NOTE: It is recommended that you specify text for the Comments field when you 
create requests. Such comment text can help you to identify or differentiate requests 
or subrequests you are monitoring.

To monitor outbound communication requests

1 From the application-level menu, choose one of the following:

■ View > Site Map > Communications Administration > All Outbound 
Requests

■ View > Site Map > Communications > My Outbound Requests

2 In the Communication Requests list, query the listed communication requests 
for all records matching certain criteria. Then check the status for these requests.

For example, you might want to find all email requests with a particular status, 
all requests created or submitted by a particular user, or all requests submitted 
to a specific server component.

3 As applicable, in the Communications Subrequests list, browse the listed 
subrequests for a request that has been submitted. Then check the status for 
each subrequest.

Status Settings for Outbound Communication Requests
For each outbound communication request record, or subrequest record, detailed 
status information may be shown in the Status Message field. In addition, the Status 
field displays one of the following values:

■ In Progress. The request has been created but has not yet been submitted for 
processing by the Communications Outbound Manager.
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■ Submitted. The request has been submitted to the Communications Outbound 
Manager server component. The request will have this status even if the 
Communications Outbound Manager has not yet received it.

■ Processing. The Communications Outbound Manager has received and is 
processing the request.

■ Done. The Communications Outbound Manager has successfully completed 
processing the request.

■ Incomplete. The request could not be fully processed because it did not include 
all necessary information—for example, one or more recipients could not be 
resolved, no templates were specified for the request, or a template was invalid.

A request with subrequests may have the status incomplete if only some of the 
subrequests were correctly processed. Each subrequest has its own status. You 
should resubmit any subrequest that was not processed.

NOTE: If address information, such as the email address, is missing for any of the 
recipients of a communication request, the request status after processing will 
be Incomplete. This status does not, however, mean that Siebel Communications 
Server failed to deliver to recipients for which addresses were available.

Monitoring Siebel Server Request Status
Outbound communication requests initiated by end users or administrators can be 
monitored in the Server Administration screen: the Enterprise Operations view, 
Component Requests tab. This view displays the status of a request that is being 
sent as a server request to the Communications Outbound Manager component for 
processing as a communication request.

When a user or an administrator clicks the Submit button to submit an outbound 
communication request to Siebel Communications Server, a Siebel Server request is 
created.
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The Server Request Processor and Server Request Broker server components 
initially process the request, then pass it to the Communications Outbound 
Manager server component for further processing.

NOTE: The Server Request Processor and Server Request Broker must be running for 
the Communications Outbound Manager to operate. The processing of a request is 
subject to the availability of these components. Delays in request processing may 
be due to intermittent availability of these components.

An administrator can monitor outbound communication requests as server 
requests, using the Component Requests view.

In addition, the administrator can perform several actions on a request:

■ Hold. Hold back a request from the queue.

■ Requeue. Place a request back in the queue.

■ Cancel. Cancel a request that is currently in the queue.

For more information about server requests, refer to Siebel Server Administration 
Guide.

To monitor outbound communication requests as server requests

1 From the application-level menu, choose View > Site Map > Server 
Administration > Enterprise Operations.

2 Click the Component Requests view tab.

3 In the Component Requests form, query for all request records in which the 
value for the Component/Job field is CommOutboundMgr (or the component 
name for your implementation).

Server Request Status Settings
For each outbound communication request record, the Status field in the 
Component Requests view displays one of the following values:
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■ Queued. The request has been queued by the Server Request Processor and 
Server Request Broker, and will be passed to the Communications Outbound 
Manager.

■ Active. The request is currently being processed.

■ Success. The request has been successfully processed.

■ On Hold. An administrator has placed the request on hold. Placing a request on 
hold removes it from the queue.

■ Cancelled. An administrator has cancelled the request.

NOTE: Once an outbound communication request has been submitted for 
processing, it can be cancelled only as a server request, from the Enterprise 
Operations/Component Requests view. A request can be cancelled only if the 
request has a status of On Hold or Queued.

■ Error. An error occurred during processing, and the Server Request Processor and 
Server Request Broker could not successfully pass the request to the 
Communications Outbound Manager.

NOTE: If a request has the Error status, use one of the communication request 
views to obtain more detailed status information. For more information, see 
“Monitoring Outbound Communication Request Status” on page 442.

Viewing Activity Records for Communication Requests
Users and administrators can monitor and troubleshoot communication requests 
that include particular templates by viewing activity logs or Siebel Communications 
Server logs.

You specify activity logging by checking the Create Activity check box when 
creating an advanced template. Activity records are viewed in the Activities screen. 
For more information, see “Fields for Templates” on page 410.

The procedure below, for the All Templates view in the Communications 
Administration screen, also applies to the My Templates view in the 
Communications screen.
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If Create Activity is checked for the template, one activity is created for each 
recipient, after the message is sent to that recipient. 

The message body text (and some other data, such as the sender name and the To 
line) is written to the Email Body field, up to a size of at least 16,000 characters 
(actual length depends on your database).

NOTE: When a message is sent to a large number of recipients, an equally large 
number of activity records is generated.

To set activity logging for any requests using a particular template

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Templates.

2 In the Templates list, select a template that will be included in an outbound 
communication request.

3 Click the Advanced tab.

4 Check the Create Activity check box.

Any outbound communication requests that include this template will generate 
activity records.

To view activity data for requests

1 From the application-level menu, choose View > Site Map > Activities > All 
Activities.

2 In the All Activities view, query the listed activities by searching for all relevant 
activity records.

For example, the Activity Type differentiates Communications Outbound 
Manager activities as follows:

■ For activities logged for email templates, Email - Outbound is the activity 
type.

■ For activities logged for fax templates, Fax - Outbound is the activity type.
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■ For activities logged for wireless messaging templates, Wireless Message is 
the activity type.

■ For activities logged for pager templates, Paging is the activity type.
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This appendix provides information about using Siebel CTI Connect to support 
handling voice communications work items using Intel NetMerge (formerly 
Dialogic) CTI middleware.

The parameters, commands, and events for the Dialogic CTI communications driver 
used for Siebel CTI Connect are described. Additional information is provided about 
installing and using Siebel CTI Connect.

For more information about communications drivers for third-party CTI 
middleware, see “About Communications Drivers and Profiles” on page 53.

About Siebel CTI Connect
This section describes communications driver parameters, commands, and events 
for configuring Siebel Communications Server to work with Siebel CTI Connect, 
which is based on Intel NetMerge, and the applicable communications driver.

It also provides Siebel CTI Connect installation and configuration instructions. 
Siebel CTI Connect, available from Siebel Systems, includes the following:

■ Intel NetMerge Call Processing Software (formerly Dialogic CT Connect Server)

■ Intel NetMerge Call Information Manager (CIM) (formerly Dialogic Call 
Information Manager)

■ Communications driver (Dialogic CTI) for Siebel Connect (using Intel NetMerge)
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■ Sample communications configuration data for Siebel Connect (using Intel 
NetMerge)

NOTE: Siebel CTI Connect is licensed as a separate module in this version of Siebel 
eBusiness Applications. If you have not licensed the Siebel CTI Connect module, it 
will not be enabled for use.

The sample Siebel Connect configuration data can be found in the Siebel database 
or the Sample Database. For more information on particular parameters, 
commands, or events, refer to Intel NetMerge (Dialogic) documentation such as the 
CT Connect C Programming Guide. For more information, see “Additional 
Documentation for Siebel CTI Connect” on page 450.

For more information about configuring Siebel Communications Server, see 
Chapter 3, “Configuring Session Communications,” and Chapter 4, “Configuring 
Events and Commands.”

NOTE: For additional or different parameters, commands, or events, you can extend 
the Siebel-provided driver or develop a custom communications driver to support 
these parameters. For more information, see Appendix D, “Developing a 
Communications Driver.”

Additional Documentation for Siebel CTI Connect
In addition to the Siebel Communications Server Administration Guide, Siebel 
CTI Connect includes the following Intel NetMerge (Dialogic) documentation:

NOTE: Documentation listed below still uses the Dialogic product names (now Intel 
NetMerge). For CT Connect or CTC, read Call Processing Software.

■ CT Connect Introduction (ctc_intro.pdf)

■ CT Connect Installation and Configuration Guide (Windows NT/Windows 2000) 
(ctc_install.pdf)
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■ CT Connect Management Guide (ctc_mgmt.pdf)

■ CT Connect C Programming Guide (ctc_prog.pdf)

■ CTC Test User’s Guide (ctc_test.pdf)

■ Call Information Manager User’s Guide (cim.pdf)

These documentation files, provided as PDF files, are located in the Siebel eBusiness 
Third-Party Bookshelf CD-ROM.

NOTE: For information about hardware and software requirements for using Intel 
NetMerge, refer to the documentation listed above, particularly CT Connect 
Installation and Configuration Guide. The typical platform is Windows 2000 Server.

Installing Siebel CTI Connect Server Components
This section provides information about installation and configuration of Siebel CTI 
Connect server components, including Intel NetMerge Call Processing Software and 
Intel NetMerge Call Information Manager. It also includes information about 
limitations that apply when you are using the Nortel Meridian switch.

NOTE: This section refers to Intel NetMerge modules by their old Dialogic names.

Installing Dialogic CT Connect
This section describes how to install Dialogic CT Connect and the necessary service 
pack. For detailed installation instructions, refer to CT Connect Installation and 
Configuration Guide.

NOTE: In the procedure below, installing Online Documentation is optional, and 
installs the same Dialogic documentation set that is described in “Additional 
Documentation for Siebel CTI Connect” on page 450.
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To install Dialogic CT Connect

1 Install the Dialogic CT Connect hardware key.

Attach the hardware key to the parallel printer port on the Siebel CTI Connect 
Server machine. The hardware key must be present before the CT Connect 
Server software is started.

2 On the machine on which you will install Dialogic CT Connect Server and 
Dialogic Call Information Manager, log on as administrator.

You must have administrator privileges to install Dialogic CT Connect Server.

3 On the Windows Server Ancillary Programs CD-ROM from Siebel Systems, locate 
setup.exe in the directory \Thirdpty\enu\dialogic\ctconnect.

4 Run setup.exe.

5 Accept the CT Connect license.

6 Verify CT Connect registration information.

7 In the CT Connect Destination dialog box, accept the default destination 
directory for the installation.

8 In the CT Connect Installation Type dialog box, select the Custom installation 
type.

9 In the CT Connect Components dialog box, make sure that the following 
components are selected:

■ CT Connect Server

10 Accept the default shortcut location.

11 In the Select Interfaces dialog box, select both options, Java(TM) RMI and DCE/
RPC.

12 In the Select Next Step dialog box, accept both defaults.

13 Specify that you will restart your computer later, and click Finish.
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Installing Dialogic CT Connect Service Pack
This section describes how to install the necessary service pack for Dialogic CT 
Connect. For detailed installation instructions, refer to CT Connect Installation and 
Configuration Guide.

NOTE: Make sure that the Control Panel Services application is not running on this 
system before you install the service pack.

To install Dialogic CT Connect service pack

1 On the Windows Server Ancillary Programs CD-ROM from Siebel Systems, locate 
ctcv5sp2.exe in the directory \Thirdpty\enu\dialogic\ctconnect\CTCV5SP2.

2 Run ctcv5sp2.exe.

3 When the installer has completed, specify that you will restart your computer 
later, and click Finish.

Installing Dialogic Call Information Manager
This section describes how to install the Dialogic Call Information Manager (CIM 
Service), and the necessary service pack. For detailed installation instructions, refer 
to Call Information Manager User’s Guide.

NOTE: You should install the CIM Service on the same server machine on which you 
installed Dialogic CT Connect Server.

To install Dialogic Call Information Manager

1 Install the Dialogic Call Information Manager hardware key.

2 Attach the CIM Service hardware key to the CT Connect hardware key on the 
Siebel CTI Connect Server machine.

NOTE: The CIM Service hardware key must be present before the CIM Service is 
started.
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3 On the Windows Server Ancillary Programs CD-ROM from Siebel Systems, locate 
setup.exe in the directory \Thirdpty\enu\dialogic\cim.

4 Run setup.exe.

5 Accept the CIM Service license.

6 Verify CIM Service registration information.

7 Accept the default destination directory for the installation.

8 Accept the default program folder.

9 Verify current settings, and click Next.

10 Click OK to acknowledge installation of Aladdin Device Driver Installation 
Utility for Win32.

11 When the installer has completed, specify that you will restart your computer 
later, and click Finish.

Installing Dialogic Call Information Manager Service Pack
This section describes how to install the necessary service pack for Dialogic Call 
Information Manager. For detailed installation instructions, refer to Call Information 
Manager User’s Guide.

NOTE: Make sure that the Control Panel Services application is not running on this 
system before you install the service pack.

To install Dialogic Call Information Manager service pack

1 On the Windows Server Ancillary Programs CD-ROM from Siebel Systems, locate 
cimv30sp1.exe in the directory Thirdpty\enu\dialogic\cim\cimv30sp1.

2 Run cimv30sp1.exe.

3 When the installer has completed, specify that you will restart your computer 
now, and click Finish.
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Configuring and Running Siebel CTI Connect Server 
Components

This section directs you to documents containing detailed information about 
configuring and running Siebel CTI Connect server components.

NOTE: This section refers to Intel NetMerge modules by their old Dialogic names.

Configuring Dialogic CT Connect
For detailed instructions for configuring Dialogic CTI Connect, refer to CT Connect 
Installation and Configuration Guide.

To configure Dialogic CT Connect

1 Choose Start > Programs > Dialogic CTC Server > Configuration Program.

The Dialogic CT Connect Configuration program appears.

2 Enter a logical identifier for a new link, then click Add.

3 Select your switch type, and select TCP/IP as the transport, then click Next.

4 Enter your switch IP address and associated link number.

5 Accept or change the setting of 1000 for Maximum Monitors.

6 Leave Auto Start Link selected.

7 Click Advanced.

8 Check the Enable Link State Checking check box, then click Save.

9 To save the new link, click Save again.

10 Click Exit.

11 On Microsoft Windows NT: choose Start > Settings > Control Panel > Services, 
and restart the Dialogic CT Connect Manager service.
Version 7.5.3 Siebel Communications Server Administration Guide 455



Using Siebel CTI Connect

Configuring and Running Siebel CTI Connect Server Components
12 On Microsoft Windows 2000: choose Start > Settings > Control Panel > 
Administrative Tools > Component Services, and restart the service (from the 
Services (Local) section).

Configuring Dialogic Call Information Manager
For detailed instructions for configuring Dialogic Call Information Manager, refer to 
Call Information Manager User’s Guide.

To configure Dialogic Call Information Manager

1 Choose Start > Programs > Dialogic Call Information Manager > CimConfig.

The Dialogic Call Information Manager Configuration program appears.

2 Configure the CT Connect link and add devices to monitor.

a Click Add and enter a CT Connect link name.

b Configure the CT Connect link parameters. 

c Enter the server name where CT Connect is installed.

d Enter the corresponding CT Connect logical link identifier.

e Select ncacn_ip_tcp as the network type.

f Select your switch type.

3 Click the Data Storage tab.

4 Select the data storage type In Memory Only.

5 Click the Devices tab.

6 For each monitored device you require (where the device type is 
DialableNumber), enter the value in the Devices No. field, and click Add.

You can specify individual devices or specify a range of devices to add.

7 Click OK to finish.
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Running Dialogic CT Connect and Call Information Manager
For detailed execution instructions for Dialogic CT Connect and Dialogic Call 
Information Manager, refer to CT Connect Installation and Configuration Guide and 
Call Information Manager User’s Guide, respectively.

To run Dialogic CT Connect and Call Information Manager

1 On the machine on which the Dialogic CT Connect Server and Call Information 
Manager are installed, choose Start > Control Panel > Services.

2 Select Cim Service, then click Startup.

3 If it is not already selected, select the startup type Automatic, then click OK.

4 Click Close to close the Services dialog box.

Limitations with Nortel Meridian Switch
The following limitations apply to call scenarios when you are using Siebel CTI 
Connect software with a Nortel Meridian switch:

■ When an agent initiates a consultative or conference transfer to another agent, 
the communications toolbar of the originating agent indicates that the call is on 
hold. If this agent needs to retrieve the call from hold, it is recommended that 
the agent click the Release Work Item button to release the active call and then 
click the Resume Work Item button to retrieve the call from hold.

■ Call forwarding is not supported from an agent’s ACD/Position DN. The agent 
must log out of the ACD before call forwarding can be enabled.

■ When a customer disconnects during a conference transfer, the communications 
toolbar of the originating agent does not indicate that the call has been 
disconnected.

Siebel CTI Connect Driver Parameters
Table 64 lists the supported driver parameters specific to the communications driver 
(Dialogic CTI) for Siebel CTI Connect, for Intel NetMerge CTI middleware. This 
table indicates required parameters and displays applicable default values.
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You view and modify these driver parameters in the Communications Drivers and 
Profiles view, which is one of the views in the Communications Administration 
screen. The channel type for this driver is Voice.

Each parameter may be prefaced with a keyword indicating how it will be used 
internally:

■ Parameters prefaced with “Driver:” are sent to the driver handle when the driver 
is being initialized. These parameters are sent to the CreateISCDriverInstance 
method.

■ Parameters prefaced with “Service:” are sent to the driver handle when it 
requests a service (creates the service handle). These parameters are sent to the 
RequestService method.

■ Parameters without a prefacing keyword are sent to both 
CreateISCDriverInstance and RequestService.

For more information about the driver handle methods, see Appendix D, 
“Developing a Communications Driver.”

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description

Driver:
CIMServer

Yes CHANGE_ME Host name of the machine on which the CIM 
Server is running.

Driver:
CIMTimeDelay

No 100 Specifies the time, in milliseconds, after which 
call data is fetched from the CIM Server.

Increase this value if you notice call data is 
missing, such as when a call is transferred.

Driver:
CTCServer

Yes CHANGE_ME Host name of the machine on which the 
CT Connect Server is running.
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Driver:
DriverLogFile

No ctc.log If a filename is specified using this parameter, 
Siebel Communications Server will write 
detailed information about activity for the 
active call into a log file. Data for Siebel 
Communications Server and Intel NetMerge 
activity is logged, including device events and 
event data fields.

Log files are created by default in the log 
subdirectory of the Siebel Server or Siebel 
Dedicated Web Client installation directory, 
depending on the client type and on your 
communications deployment.

A complete path can be specified along with 
the filename in order to write the file to a 
nondefault location.

Optionally, if you want to use a single log file 
in a multichannel environment, you can 
specify the same log file name for all 
interactive drivers you are using.

For debugging purposes, the parameter 
Driver:LogDebug can be set to TRUE, to cause 
debug messages to be included in the file. 
Also, the Communications Server log file can 
be compared with the log file for Intel 
NetMerge. In each log file, log records 
referring to the same call would contain the 
same value for the refId event data field.

See also the description for the parameter 
Service:ServiceLogFile.

Driver:
LogicalID

Yes CHANGE_ME Logical ID of the link for the switch as 
configured in the CT Connect Server. 
Example: CTCLINK.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
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Driver:
MaxServices

No 25 Specifies the maximum number of service 
objects that the driver handle 
(ISC_DRIVER_HANDLE) can service. If the 
specified limit is reached, another instance of 
the driver handle is created.

For more information about the driver handle, 
see Appendix D, “Developing a 
Communications Driver.”

Driver:
NetCallPort

No 9400 For any users running the Communications 
Simulator, this parameter specifies a number 
representing a simulated port number, so that 
users can simulate an “inside call” to another 
teleset.

Driver:
NetworkType

Yes ncacn_ip_tcp Network communications protocol as 
configured in the CT Connect Server. Possible 
values include:

ncacn_nb_nb – NetBIOS over NetBEUI
ncacn_ip_tcp – TCP/IP
ncacn_dnet_nsp – DECnet
ncacn_nb_tcp – NetBIOS over TCP/IP
ncacn_np – Named Pipes
ncacn_spx – Novell SPX

Driver:
Simulate

No FALSE TRUE or FALSE

When this parameter is set to TRUE, this 
driver supports the Communications 
Simulator.

This parameter need not be explicitly set in 
order to use the Communications Simulator.

For more information, see “Enabling Session 
Communications and Simulation” on page 311 
and “Simulating a Communications 
Environment” on page 233.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
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Driver:
SwitchType

Yes CHANGE_ME The type of switch for your call center. Values 
include:

0 – Avaya (Lucent) Definity G3
2 – Nortel Meridian
3 – Siemens Hicom 300E U.S., Siemens Hicom 
300E International

For information about the switches supported 
with Siebel CTI Connect, refer to Siebel System 
Requirements and Supported Platforms for 
your Siebel applications.

Service:
ACCDNList

No {@ACDDNList} Uses the macro @ACDDNList to obtain a list 
of ACD DNs (extensions of type A) associated 
with the current agent.

Service:
AutoLogout

No FALSE Determines whether to automatically log the 
agent out of the ACD queue when the 
communications session has ended. 

■ If FALSE, the agent is not automatically 
logged out of the ACD queue when the 
agent logs out of the Siebel session.

■ If TRUE, the agent is automatically logged 
out of the ACD queue when the agent logs 
out of the Siebel session.

This setting applies whether the agent 
specifically exited the Siebel application or the 
browser, or if the agent’s application session 
times out.

Service:
DNList

Yes {@DNList} Uses the macro @DNList to obtain a list of 
DNs (standard extensions of type “S”) 
associated with the current agent.

Service:
HandleRouteRequest

No FALSE TRUE or FALSE

Should be set to TRUE if you are using Route 
DNs for routing calls. For regular DNs, should 
be set to FALSE.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
Version 7.5.3 Siebel Communications Server Administration Guide 461



Using Siebel CTI Connect

Siebel CTI Connect Driver Parameters
Service:
HasKeyName

No TRUE TRUE or FALSE

Settings that, when set to TRUE, specify 
whether the connected switch provides 
programmatic support for the indicated 
functionality.

You can also disable a feature that is 
supported by the switch but that you do not 
want your agents to use. If the value is FALSE, 
the associated feature is disabled.

For a disabled feature, an administrator can 
remove the associated toolbar button from the 
repository using Siebel Tools.

The following capabilities can be enabled or 
disabled:

■ HasAgentBusy – Set agent state to Busy/
Not Busy

■ HasAnswer – Answer the incoming call

■ HasDisconnect – Disconnect the call

■ HasForward – Set call forwarding

■ HasHold – Put the call on hold

For a list of the particular features your switch 
supports, refer to Intel NetMerge 
documentation.

Service:
IsQueueRequired

No FALSE TRUE or FALSE

Specifies whether an ACD queue must be 
specified in order for an agent to log into a call 
center.

Set to FALSE for an Avaya (Lucent) Definity 
G3 switch or for other switches that support 
Expert Agent Selection (EAS).

Set to TRUE for all other switches. When this 
parameter is set to TRUE, the ACD queue 
number will be provided with the login 
command.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
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Service:
IsSiemens

No FALSE TRUE or FALSE

When set to TRUE, specifies that you are using 
a Siemens switch, which requires special 
handling.

If you are using the Siemens Hicom 300E 
switch, set this parameter to TRUE.

Service:
SelectDN

No CHANGE_ME Specifies a DN to be used to issue commands 
such as MakeCall, and so on.

Otherwise, the first DN in the list specified 
with the parameter Service:DNList is used.

Service:
ServiceLogFile

No ctc_{@Username}.log If a filename is specified using this parameter, 
Siebel Communications Server will write 
detailed information about activity for the 
active call, for each agent’s session, into a log 
file. Data for Siebel Communications Server 
and Intel NetMerge activity is logged, 
including device events and event data fields.

Log files are created by default in the log 
subdirectory of the Siebel Server or Siebel 
Dedicated Web Client installation directory, 
depending on the client type and on your 
communications deployment.

For information about the @Username macro, 
see “Macros for Parameter Values” on 
page 196.

For more information, see the description for 
the parameter Driver:DriverLogFile.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
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Service:
Use1StepTransfer

No FALSE TRUE or FALSE

■ Set to TRUE to specify that the switch you 
are using supports the OneStepTransfer 
function. The TransferMute driver 
command maps to this function.

■ Set to FALSE when OneStepTransfer is not 
supported. The Blind Transfer toolbar 
button is disabled.

Set this parameter to FALSE for an Avaya 
(Lucent) Definity G3 switch or for other 
switches that do not support OneStepTransfer.

The TransferMute command is used by the 
Blind Transfer toolbar button.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more 
detailed.

This parameter is generic and applies to log 
files specified using Driver:DriverLogFile and 
using Service:ServiceLogFile.

If you specify this parameter prefixed with 
either Service: or Driver:, it will apply to the 
applicable log file only.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
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Siebel CTI Connect Commands
Table 65 on page 466 lists and explains usage for commands specific to the 
communications driver (Dialogic CTI) for Siebel CTI Connect, for Intel NetMerge 
CTI middleware.

MaxLogKB No 128 Specifies the maximum size of the log file, in 
kilobytes (KB). 

This parameter is generic and applies to log 
files specified using Driver:DriverLogFile and 
using Service:ServiceLogFile.

If you specify this parameter prefixed with 
either Service: or Driver:, it will apply to the 
applicable log file only.

When the applicable log file is full, it is 
emptied completely, then logging begins 
again.

ReleaseLogHandle No TRUE Indicates that the log file handle for each 
agent should be released periodically, after 
logs have been generated.

This parameter is generic and applies to log 
files specified using Driver:DriverLogFile and 
using Service:ServiceLogFile.

If you specify this parameter prefixed with 
either Service: or Driver:, it will apply to the 
applicable log file only.

Performance for agent sessions can be 
improved by setting this parameter to FALSE. 
This may be most effective if Driver:LogDebug 
is also FALSE, because logging is less 
intensive.

When ReleaseLogHandle is FALSE, however, 
some log files may not be generated if the 
number of concurrent users exceeds the file-
handle capacity provided by the operating 
system.

Table 64. Siebel CTI Connect Driver Parameters

Parameter Name Required Default Value Description
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A Yes value in the Any K/V column in Table 65 on page 466 indicates that the 
command allows attachment of any user-defined key/value pair to the call. Within 
the communications configuration, these key/value pairs are represented by event 
or command parameters and the associated parameter values.

The commands you define, in which driver commands listed here are specified as 
device commands, support the command parameters documented under Chapter 4, 
“Configuring Events and Commands.” In your command definitions, you can 
specify custom subparameters for command parameters of type Group.

An asterisk (*) before a parameter name means that the parameter is optional for 
this command. Command parameters are described in Table 66 on page 471.

Most of the commands in Table 65 on page 466 correspond to commands defined 
in the communications configuration, in which they are specified as the device 
command. They may also correspond to a communications toolbar button.

For more information, see Chapter 6, “Configuring User Interface Elements.” For 
descriptions of the communications toolbar, see Chapter 8, “Communications 
Operations for End Users.”

For commands for which the TrackingID parameter is optional, the command 
operation is performed on the work item identified by the TrackingID parameter 
value. If this parameter is not provided, the command operates on the first available 
work item.

Table 65. Siebel CTI Connect Commands

Command Name
Any 
K/V Parameters Description

AnswerCall No *TrackingID Answer incoming call.

AttachData No Call data object Attach user-defined data to the current call. This command 
can be invoked from a Siebel VB or Siebel eScript script. 
For example, a script in which “callobject” has previously 
been defined might include a line such as the following:

CTI.InvokeCommand "AttachData," callobject

CancelForwardCall No Cancel call forwarding.
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ChangeBusyState No Toggle agent state between Busy and Not Busy.

Busy state is defined as setting the device state such that 
incoming calls do not ring at the device.

ChangeNotReadyState No *ID
*AgentId
*AgentPin
*ACDQueue

Toggle agent state between being available and not 
available to receive calls from the queue.

This command may use either the ID parameter or the 
AgentId, AgentPin, and ACDQueue parameters. For more 
information, see “Siebel CTI Connect Command 
Parameters” on page 470.

ConferenceComplete No Complete the conference call.

The caller and the agents in conference can now talk to 
each other at the same time.

ConferenceInit Yes PhoneNumber
*CallNotifyText

Begin conference call.

The caller is put on hold and the current agent dials 
another agent’s extension.

The CallNotifyText parameter conveys status information 
to the second agent.

ForwardCall No PhoneNumber Set call forwarding.

HoldCall No *TrackingID Put the current call on hold.

LogIn No *ID
*AgentId
*AgentPin
*ACDQueue

Agent login on ACD queue.

This command may use either the ID parameter or the 
AgentId, AgentPin, and ACDQueue parameters. The Login 
command is used for both automatic and manual login.

For details, see “Siebel CTI Connect Command Parameters” 
on page 470, and see “Configuring Communications Login 
and Logout” on page 222.

LogOut No ACD agent logout.

MakeCall No PhoneNumber Place the outbound call.

MergeCall No Combines an active call and a suspended (held) call into a 
conference call.

Table 65. Siebel CTI Connect Commands

Command Name
Any 
K/V Parameters Description
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ReleaseCall No *TrackingID Release (disconnect) current call.

ResetState No Reset internal information about current call states for the 
monitored teleset.

This command resets call-status tracking information to 
the initial state when the agent started the Siebel 
application. ResetState resets all tracking information, 
regardless of the actual current status. For this reason, it 
should be used only when the teleset and Siebel 
Communications Server are out of sync and there are no 
current calls.

Note: Although this command is part of the Dialogic CTI 
communications driver, it is specific to Siebel 
Communications Server and is not passed to Intel 
NetMerge.

RetrieveCall No Retrieve the original call initiated using ConferenceInit or 
TransferInit, after the current call has been released using 
ReleaseCall.

RouteCall No routeId Specifies a new destination for the incoming call, if the 
device is of type Route Point.

SelectDN1... 
SelectDN5

No Select Directory Number (DN) #1 (2, 3, 4, or 5) for 
subsequent use.

Using one of these commands selects the DN that will be 
used in commands such as MakeCall.

It is recommended that end users select the preferred 
teleset and extension in the Communications tab in the 
User Preferences screen to keep teleset information in sync.

Table 65. Siebel CTI Connect Commands

Command Name
Any 
K/V Parameters Description
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SetAgentWorkMode No *ID
*AgentId
*AgentPin
*ACDQueue

Set the agent work mode to one of five settings.

This command may use either the ID parameter or the 
AgentId, AgentPin, and ACDQueue parameters. For more 
information, see “Siebel CTI Connect Command 
Parameters” on page 470.

The five work mode commands are:

■ SetAgentReady – Sets AgentReady work mode. After 
each call, the agent is available to take another call.

■ SetAgentNotReady – Sets AgentNotReady work mode. 
After each call, the agent is not available to take 
another call and must select the Ready State (for the 
voice channel) in the communications toolbar to 
become available.

■ SetAgentAfterCallWork – Sets AgentAfterCallWork 
work mode. This means that the agent has completed a 
call and requires wrap-up time before taking another 
call. The agent is not available to take calls and must 
select Ready State to become available. 
(AgentAfterCallWork is not supported by Nortel 
Meridian switches.)

■ SetAgentBusy – Sets AgentBusy work mode. After each 
call, the agent is available to take another call. 
(AgentBusy is not supported by Nortel Meridian, Avaya 
(Lucent) Definity G3, or CSTA Phase I switches.)

■ SetAgentOtherWork – Sets AgentOtherWork work 
mode. Typically, this means that the agent is not 
engaged in call center work. The agent is not available 
to take calls and must select Ready State to become 
available. (AgentOtherWork is not supported by CSTA 
Phase II switches.)

The mode the agent is in upon logging in depends on the 
switch. If an agent is in AgentOtherWork or 
AgentNotReady mode upon logging in, for example, the 
agent must select the Ready State before taking any calls.

An agent can choose work mode commands only after 
logging in.

Table 65. Siebel CTI Connect Commands

Command Name
Any 
K/V Parameters Description
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Siebel CTI Connect Command Parameters
Table 66 on page 471 lists command parameters applicable to Siebel CTI Connect, 
and describes their usage. Table 65 on page 466 identifies the commands that use 
each of these parameters.

SimulateCall Yes *CallNotifyText Simulate incoming call.

Used for configuration debugging purposes.

Note: Although this command is part of the Dialogic CTI 
communications driver, it is specific to Siebel 
Communications Server and is not passed to Intel 
NetMerge.

ToggleForward No *PhoneNumber Set call forwarding, or cancel call forwarding.

When canceling call forwarding, the PhoneNumber 
parameter is not used.

TransferComplete No Complete the consultative transfer.

The current agent is disconnected and the caller is 
connected to the agent to whom the call was transferred.

TransferInit Yes PhoneNumber
*CallNotifyText

Begin consultative transfer.

The caller is put on hold, and the current agent dials 
another agent’s extension.

The CallNotifyText parameter conveys status information 
to the second agent.

TransferMute Yes PhoneNumber
*CallNotifyText

Initiate a mute (blind) transfer of the caller.

The CallNotifyText parameter conveys status information 
to the second agent.

UnHoldCall No *TrackingID Remove the current call from hold state.

Table 65. Siebel CTI Connect Commands

Command Name
Any 
K/V Parameters Description
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Within the communications configuration, command parameters and values to pass 
to the communications driver can be specified within command data definitions as 
subparameters of the Param parameter. For more information, see “Command 
Data” on page 186.

Table 66. Siebel CTI Connect Command Parameters

Command Parameter Description

ACDQueue ACD queue name.

This parameter can be used with the LogIn, ChangeNotReadyState, and 
SetAgentWorkMode commands, which may be included in the communications 
configuration for Siebel CTI Connect.

The same data can be retrieved from the Siebel database using the macro @Queued. 
For details, see “Macros for Parameter Values” on page 196.

AgentId An agent’s login name.

This parameter can be used with the LogIn, ChangeNotReadyState, and 
SetAgentWorkMode commands, which may be included in the communications 
configuration for Siebel CTI Connect.

The same data can be retrieved from the Siebel database using the macro @AgentId. 
For details, see “Macros for Parameter Values” on page 196.

AgentPin The password (personal identification number) for an agent’s login name.

This parameter can be used with the LogIn, ChangeNotReadyState, and 
SetAgentWorkMode commands, which may be included in the communications 
configuration for Siebel CTI Connect.

The same data can be retrieved from the Siebel database using the macro @AgentPin. 
For details, see “Macros for Parameter Values” on page 196.

CallNotifyText Text that will be displayed in the status line to the second agent in order to announce 
the incoming call (for internal call, call transfer, or call conference).
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Siebel CTI Connect Events
Table 67 lists and describes some of the common Intel NetMerge events that Siebel 
Communications Server may receive. Many of the events listed are referenced as 
device events in the communications configuration for Siebel CTI Connect. 
Communications Server receives and can be configured to support additional Intel 
NetMerge events. Refer to Intel NetMerge documentation for detailed information 
about such events.

ID This parameter can be used with the LogIn, ChangeNotReadyState, and 
SetAgentWorkMode commands, which may be included in the communications 
configuration for Siebel CTI Connect. The ID parameter can be used in place of the 
AgentID, AgentPin, and ACDQueue parameters. 

This parameter has the format QQQQ/AAAA-PPPP, where:

QQQQ is the ACD queue
AAAA is the agent login
PPPP is the agent password

If the LogIn command is defined to use the ID parameter, you should have the 
command read current agent data from the database, using macros such as @QueueId, 
@AgentId, and @AgentPin. For details, see “Macros for Parameter Values” on 
page 196.

The LogIn command as defined in the sample communications configuration data uses 
the AgentId, AgentPin, and ACDQueue parameters instead of the ID parameter.

Each of the QQQQ, /AAAA, and -PPPP components of the string is optional—that is, 
depending on the switch and how you have configured the LogIn command, you may 
be able to skip some of them.

PhoneNumber Phone number (dialing pattern).

DialingFilter.RuleN configuration parameters must be defined that filter full telephone 
numbers from a database so they can be handled as extensions. For more information, 
see “Specifying Parameters for Communications Configurations” on page 80.

TrackingID The designated tracking ID of a work item, to identify the specific work item on which 
an operation is to be performed.

Table 66. Siebel CTI Connect Command Parameters

Command Parameter Description
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Table 67. Siebel CTI Connect Events

Event Name Description

AgentLoggedOff The agent has logged out (off).

AgentLoggedOn The agent has logged in (on).

AgentModeChange The work mode for an agent has changed. Check the agentMode field for a 
value that identifies the new work mode.

BackInService The device has returned to service.

CallInformation The account information or authorization information associated with a call 
has changed.

DestBusy The destination device is busy (engaged).

DestChanged The call from the assigned device was not answered at the original destination 
and has been redirected to another destination.

DestInvalid The attempted call has failed because the destination device is incompatible. 
(For example, making a call from a voice set to a data set.)

DestNotObtainable The call could not be completed, probably because the wrong number was 
dialed.

DestSeized A call has been successfully dialed.

Diverted An incoming call on the assigned device has been diverted to another 
destination.

Error The call has failed for an unspecified reason. For more information, check the 
eventQualifier field. For descriptions of event qualifiers, refer to CT Connect 
C Programming Guide.

EventAnswerCall Indicates the arrival of a new call. This event is triggered whenever the 
AnswerCall device command is invoked by the Dialogic CTI driver, such as 
when an agent answers a call using the communications toolbar. This event 
may be used in your event handler definitions in order to enhance the speed 
of screen pops.

For more information, see “Using Device Event to Enhance Screen Pop 
Performance” on page 229.

InboundCall A new call has arrived at the assigned device.

Offhook A new call has been made from the assigned device.

OpAnswered The other party answered the call from the assigned device.
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OpConferenced Another party on the call has created a conference call.

OpDisconnected The other party has disconnected the current call.

OpHeld The other party has placed the call on hold.

OpRetrieved The other party has retrieved the held call.

Other An event has occurred. This event is not significant for basic call processing 
and can be generated by a number of causes.

OutOfService The device is out of service.

Private Data has been sent by the switch. The type of data sent is specific to the switch 
manufacturer.

TpAnswered This party has answered an incoming call on the assigned device.

TpConferenced This party has included another party in a conference call.

TpDisconnected This party has disconnected the current call.

TpRetrieved This party has retrieved a call that was either on hold or in the call-waiting 
queue.

TpSuspended This party has placed a call on hold.

Transferred The call has been transferred from another device. This event is returned to 
both parties on the new call.

Unavailable The device has become unavailable (out of service). This could be:

■ A temporary condition, because, for example, the device has remained off-
hook too long.

■ A more permanent condition, if the device is in maintenance.

Table 67. Siebel CTI Connect Events

Event Name Description
474 Siebel Communications Server Administration Guide Version 7.5.3



Using Siebel CTI Connect

Siebel CTI Connect Events
Siebel CTI Connect Event Data
Table 68 on page 475 lists Intel NetMerge event data fields. Whether a given event 
data field has meaningful data depends on the switch.

The fixed work item attributes received for any work item are described in “Work 
Item Attributes” on page 208.

Table 68. Siebel CTI Connect Event Data Fields

Event Field Name Field Type Description

accountInfo String This field contains 32 bytes of free-format data.

agentData String This field returns agent data—for example, an agent’s password.

agentGroup String This field contains the DN for a group (ACD group or queue).

agentId String When the channel is assigned to a queue, this field returns the 
identifier (ID)—for example, an extension number—for an agent 
associated with that queue.

agentMode Number This 32-bit field returns the current work mode for an agent. It can 
contain one of the following values:

1100 – AgentAfterCallWork
1101 – AgentLogin
1102 – AgentLogout
1103 – AgentNotReady
1104 – AgentReady
1105 – AgentOtherWork
1107 - AgentBusy

ANI Number Automatic Number Identification, identifies the billable number 
of the person dialing into the system.

Note: This field is received from Intel NetMerge Call Information 
Manager, not from Intel NetMerge Call Processing Software.

applicationData String This field returns data that has been associated with a call (for 
example, by the MakeCall command) and stored by the switch. 
The data is returned as a character string.
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associatedEvent Number This 32-bit field identifies whether application data associated 
with an inbound call has been passed from another link 
configured on the CTC server or from another CTC server. If 
supported by your license, application data can be passed from 
one CTC server to another for calls that have been handled by 
more than one switch. For more information about configuring 
the CTC server to support distributed data, refer to CT Connect 
Installation and Configuration Guide.

calledParty String This field contains the CLID, DN, or DNIS for the called party.

calledPartyDialingPlan Number This 32-bit field contains a value that identifies the dialing plan 
associated with the call. For details of supported values, refer to 
CT Connect C Programming Guide.

calledPartyGroup Number This 32-bit field contains the trunk group number.

calledPartyQualifier Number This 32-bit field provides additional information about the called 
party. For more information, refer to CT Connect C Programming 
Guide.

calledPartyTrunk Number This 32-bit field contains the trunk line number from the switch.

calledPartyType Number This 32-bit field identifies the number for the called party as a 
CLID, DN, or DNIS.

callsQueued Number If the call is placed in a queue, this 32-bit field can return the total 
number of calls in the queue.

CimCallId Number A unique value generated by the Call Information Manager and 
used to access call-related information.

Note: This field is received from Intel NetMerge Call Information 
Manager, not from Intel NetMerge Call Processing Software.

DNIS Number Dialed Number Identification Service, also known as Dialed 
Digits, identifies the telephone number that the caller dialed.

Note: This field is received from Intel NetMerge Call Information 
Manager, not from Intel NetMerge Call Processing Software.

dtmfDigits String This field returns Dual-Tone Multi-Frequency (DTMF) digits 
collected from the call.

event Number This 32-bit integer identifies the call event. Table 67 on page 473 
shows the possible call event values (and agent values) returned.

Table 68. Siebel CTI Connect Event Data Fields

Event Field Name Field Type Description
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eventQualifier Number This 32-bit integer provides more detailed information on certain 
events. For descriptions of event qualifiers, refer to CT Connect 
C Programming Guide.

globalRefId String This 8-byte array contains the global reference for the call when 
the call is handled by a network of switches of the same type. The 
switch must be configured to provide this value. The format of the 
global reference is dependent on your switch. For details, refer to 
CT Connect C Programming Guide.

logicalAgent String This field returns the DN for a logical agent.

monitorParty String This field returns data for monitor channels. You can assign a 
monitor channel to receive events for a number of devices on a 
single channel.

monitorPartyType String Information is returned in this field for monitor channels. You can 
assign to a monitor channel to receive events for a number of 
devices on a single channel.

nestedMonitorChannel String This field returns a device number that identifies the nested 
monitor channel for which event information is returned. A 
nested monitor channel is a monitor channel that is monitored by 
another monitor channel.

netCallId Number This 32-bit field returns a network call identifier.

oldNetCallId Number This 32-bit field returns the previous network call identifier.

oldRefId Number If the reference identifier for a call changes, this 32-bit field 
contains the previous call reference.

originatingParty String This field contains the CLID, DN, or DNIS for the originating 
party.

originatingPartyDialingPlan Number This 32-bit field contains a value that identifies the dialing plan 
associated with the call. For details of supported values, refer to 
CT Connect C Programming Guide.

originatingPartyGroup Number This 32-bit field contains the trunk group number.

originatingPartyQualifier Number This 32-bit field provides additional information about the 
originating party. For more information, refer to CT Connect 
C Programming Guide.

Table 68. Siebel CTI Connect Event Data Fields

Event Field Name Field Type Description
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originatingPartyTrunk Number This 32-bit field contains the trunk line number from the switch.

originatingPartyType Number This 32-bit field identifies the originating number as a Calling Line 
ID (CLID, DN, or DNIS).

otherParty String This field contains the CLID, DN, or DNIS for the other party.

otherPartyDialingPlan Number This 32-bit field contains a value that identifies the dialing plan 
associated with the call. For details of supported values, refer to 
CT Connect C Programming Guide.

otherPartyGroup Number This 32-bit field contains the trunk group number.

otherPartyQualifier Number This 32-bit field provides additional information about the other 
party. For more information, refer to CT Connect C Programming 
Guide.

otherPartyTrunk Number This 32-bit field contains the trunk line number from the switch.

otherPartyType Number This 32-bit field identifies the number for the other party as a 
Calling Line ID (CLID, DN, or DNIS).

privateData Number A value in this field indicates that the CT Connect Server has 
received from the switch data relating to the event. The type of 
data returned is specific to individual switches.

refId Number This 32-bit field contains the call reference identifier for a 
particular call.

secOldRefId Number If the reference identifier for a call changes because it has been 
transferred or merged in a conference call, this 32-bit field 
contains the call reference for the consultation call.

state Number This 32-bit field contains a value that identifies the state of the 
current call.

thirdParty String This field contains the CLID, DN, or DNIS for the third party.

thirdPartyDialingPlan Number This 32-bit field contains a value that identifies the dialing plan 
associated with the call. For details of supported values, refer to 
CT Connect C Programming Guide.

thirdPartyGroup Number This 32-bit field contains the trunk group number.

Table 68. Siebel CTI Connect Event Data Fields

Event Field Name Field Type Description
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thirdPartyQualifier Number This 32-bit field provides additional information about the third 
party. For more information, refer to CT Connect C Programming 
Guide.

thirdPartyTrunk Number This 32-bit field contains the trunk line number from the switch.

thirdPartyType Number This 32-bit field identifies the number for the third party as a 
CLID, DN, or DNIS.

Table 68. Siebel CTI Connect Event Data Fields

Event Field Name Field Type Description
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timeStamp String This event data field has the following format:

year/month/day/hour/minute/second/millisec/mindiff/utc

where each element of the field is defined as follows:

year – a 4-digit number

month – uses digits 1–12

day – uses digits 1–31

hour – uses digits 0–23

minute – uses digits 0–59

second – uses digits 0–59

millisec – uses digits 0–999

mindiff - Minimum differential between the current time and 
GMT. A nonzero value is returned in this field for UTC time only. 
For absolute time, it returns zero.

utc - A nonzero value in this element of the field indicates that the 
time given is UTC. If this element is zero, the time given is 
absolute time.

Each time the Communications Session Manager server 
component receives an event from the CT Connect Server, an 
entry is written into the log file (ctc.log by default) that includes 
all the event data fields, including the timeStamp field. Usually, 
the date and time represent when the event was processed on the 
CT Connect Server. Alternatively, you can configure a CSTA Phase 
II switch so CT Connect Server returns the date and time the event 
was processed on the switch.

For more information about the log file, see Table 64 on page 458. 
For more information about the timeStamp field, refer to CT 
Connect C Programming Guide.

type Number This 32-bit integer identifies the type of call in progress. The call 
type helps to clarify the result of the call event and state. For 
descriptions of event qualifiers, refer to CT Connect 
C Programming Guide.

Table 68. Siebel CTI Connect Event Data Fields

Event Field Name Field Type Description
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This appendix provides information about configuring Siebel Communications 
Server to support Siebel Wireless Messaging and WAP Push messaging.

The parameters for the communications drivers that support these systems are 
described here. Additional information is provided about installing and using Siebel 
Wireless Messaging.

About Wireless Messaging
Siebel Communications Server can send and receive messages in wireless message 
formats.

■ Both one-way (outbound) and two-way (inbound and outbound) wireless 
messaging are supported using the module Siebel Wireless Messaging. For more 
information, see “Installing and Configuring Siebel Wireless Messaging” on 
page 484.

■ One-way (outbound) WAP Push wireless messaging using the WAP V1.2 or WAP 
V1.1 communications driver is supported in the base Siebel eBusiness 
Applications. For more information, see “Configuring WAP Push Messaging” on 
page 513.

In a one-way wireless messaging scenario with Siebel Wireless Messaging, you use 
the MobileSys MX wireless messaging engine, which is included with Siebel 
Wireless Messaging. Using MobileSys MX, you can connect directly to network 
operators or connect to multiple network operators through the MobileSys Network.
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In a two-way wireless messaging scenario, you connect directly to the MobileSys 
Network, without using MobileSys MX.

NOTE: Siebel Wireless Messaging is available as an option for the Siebel Wireless 
application, or as an option for Siebel eBusiness Applications such as Siebel Call 
Center.

Administrators must configure mobile devices for users and create profiles for 
wireless messaging communications drivers. For details, see “Administering Mobile 
Devices” on page 494. End users may also configure their own mobile devices. For 
details, see “Specifying Mobile Device Settings” on page 388.

NOTE: Messages sent using Siebel Wireless Messaging and received by mobile 
devices are subject to character-set limitations or requirements of the MobileSys MX 
Gateway or of network operators. In particular, if characters from the extended 
character set (for example, ¼ or ®) are included, the message may not be received. 
Contact your network operator for more information about supported characters.

Wireless Messaging Usage Scenarios
Wireless messaging may be used by various Siebel application modules and 
features, as described below. Users can send outbound wireless messages, including 
SMS or WAP Push messages, automatically or manually from within Siebel 
eBusiness Applications.

■ In a one-way wireless messaging scenario (SMS messages require the Siebel 
Wireless Messaging module), outbound wireless messages can be sent to 
various kinds of recipients using:

■ Send Wireless Message command manually invoked by a user by choosing 
the application-level menu command File > Send > Wireless Message. For 
more information, see “Using the Send Wireless Message Command” on 
page 382.
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■ Send Wireless Message command manually invoked by a user from the 
communications toolbar. For more information, see “Initiating Work Items” 
on page 357.

■ Workflows, which can be triggered, for example, when an activity record is 
assigned or updated. For more information, see “Using One-Way Wireless 
Messaging Workflows” on page 499.

End users can choose to receive automatically triggered, workflow-driven 
wireless messages. Users activate such alerts in the Mobile screen (requires 
a license for either Siebel Wireless Messaging or Siebel Wireless). For more 
information, see “Configuring Mobile Alerts” on page 391.

■ Outbound communication requests, specified using views in the 
Communications Administration screen (administrators) or the 
Communications screen (end users). For more information, see Chapter 10, 
“Defining Outbound Communication Requests.”

■ Any module that invokes methods of the Outbound Communications 
Manager business service to send outbound communications for the wireless 
message channel.

■ In a two-way wireless messaging scenario (requires Siebel Wireless Messaging):

■ Outbound wireless messages can be sent to a recipient automatically using 
workflows which can be triggered, for example, when an activity record is 
assigned.

■ Inbound wireless messages are sent as a response by the recipient of an 
outbound message. Inbound message delivery status messages are also sent 
from the MobileSys Network. Inbound messages are received using a 
workflow process invoked by Inbound Communications Manager and an 
associated response group.

For more information, see “Using Two-Way Wireless Messaging Workflows” on 
page 505.
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Installing and Configuring Siebel Wireless Messaging
This section describes how to install and configure Siebel Wireless Messaging. 
Siebel Wireless Messaging can connect directly to network operators or connect to 
the MobileSys Network in order to send and receive messages. 

As shown in Table 69, using the MobileSys Network is optional for one-way 
messaging, and required for two-way messaging.

For one-way wireless messaging with Siebel Wireless Messaging, you use the 
MobileSys MX wireless messaging engine, which is included with Siebel Wireless 
Messaging. Depending on the services available from particular wireless network 
operators, you may be able to connect directly, through MobileSys MX, to the 
individual network operators that service the wireless devices of the message 
recipients. Or, you can connect to the MobileSys Network through MobileSys MX.

Table 69 shows connection options for Siebel Wireless Messaging. Steps required to 
install and configure Siebel Wireless Messaging and MobileSys MX vary depending 
on whether wireless messages will be sent directly to wireless network operators or 
through the MobileSys Network. Determine which method you will use before 
proceeding with your installation.

Table 69. Siebel Wireless Messaging Connection Options

Connection Option

One-Way 
Messaging 
(requires 
MobileSys MX)

Two-Way 
Messaging See...

MobileSys Network X X “Connecting to the MobileSys 
Network” on page 485

Direct to Network 
Operators

X “Connecting Directly to Wireless 
Network Operators” on page 486
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Connecting to the MobileSys Network
Connecting to the MobileSys Network simplifies the deployment of Siebel Wireless 
Messaging. The MobileSys Network provides a single connection point to many 
messaging networks around the world, thus reducing or eliminating the need for 
direct network operator connections.

NOTE: Siebel Wireless Messaging customers must agree directly with MobileSys to 
connect to the MobileSys Network. Siebel Systems does not provide or resell 
MobileSys Network connections.

■ For one-way wireless messaging, MobileSys MX is required. When your 
company has reached an agreement with MobileSys to connect to the MobileSys 
Network for one-way messaging, MobileSys will send you an XML configuration 
update for the MobileSys MX Server.

The configuration update includes all service node information required to begin 
sending messages to supported network operators through the MobileSys 
Network. This data must be specified using parameters for the Siebel Wireless 
Messaging 1-Way driver.

The update also includes a license for MobileSys MX (in addition to that 
provided through Siebel Wireless Messaging). You will use MobileSys MX to 
send messages through the MobileSys Network.

■ For two-way wireless messaging, MobileSys MX is not required. When your 
company has reached an agreement with MobileSys to connect to the MobileSys 
Network for two-way messaging, MobileSys will send you MX Client ID, MX 
Client Password, MX Gateway, and MX Reference data. This data must be 
specified using parameters for the Siebel Wireless Messaging 2-Way driver.

When using the MobileSys Network, you must create communications driver 
profiles that reference the wireless network operators required to reach all intended 
message recipients. For information on how to establish these profiles, refer to 
“Configuring Communications Drivers and Profiles” on page 488.

For additional details on the MobileSys Network and to register for trial use, visit 
the Web site http://siebel.mobilesys.net. This Web site includes:

■ Descriptions of MobileSys Network features, benefits, and trial offer pricing.
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■ Up-to-date information on supported wireless network operators and service 
areas.

■ An online registration process to help Siebel Wireless Messaging customers 
establish a trial connection to the MobileSys Network.

■ MXReference values required for creating a communications driver profile for 
each wireless network operator supported by the MobileSys Network.

■ Quality-of-service information for wireless messages sent through the MobileSys 
Network.

Connecting Directly to Wireless Network Operators
For one-way wireless messaging, if you connect directly to wireless network 
operators, rather than going through the MobileSys Network, you should be careful 
to connect to all the operators required to reach the entire population of wireless 
message recipients.

NOTE: In some cases, network operators make public connections available, such as 
TAP dial-up connections or SMTP connections. In other cases you may be allowed 
to connect to network operators directly through private connections. Check with 
particular network operators for the connection options they provide.

To use these direct network connections, you must determine the following 
information for each wireless network operator:

■ The connection method required, for example, a URL to which wireless 
messages are sent over IP connections or a dial-up connection to a paging server.

■ The message type required. MobileSys MX supports SMTP email, TAP paging, 
and a variety of leading SMS protocols including SNPP and SMPP. Refer to 
MobileSys MX Reference Manual on the Siebel eBusiness Third-Party Bookshelf 
for a full list of supported wireless messaging protocols.

■ Addressing and other information required to establish a service node within 
MobileSys MX.
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A service node must be defined within MobileSys MX to support each network 
operator and message type. You must also create a communications driver profile 
to reference each MobileSys MX service node. For additional information, see 
“Configuring Communications Drivers and Profiles” on page 488.

Installing Siebel Server Components for Siebel Wireless Messaging
Siebel Wireless Messaging uses the Communications Outbound Manager server 
component for sending outbound messages, and uses the Communications 
Inbound Manager server component for receiving inbound messages (for two-way 
wireless messaging). These Communications Server components are part of the 
Communications Management component group.

In order to send or receive wireless messages, you must first enable the 
Communications Management enterprise component group on the Siebel Server. 
You can enable this component group when installing Siebel Server, or after Siebel 
Server is installed. Make sure that the components you need are configured and 
running. 

For more information, see Chapter 7, “Administering Siebel Communications 
Server,” and refer to Siebel Server Administration Guide.

In order to use workflows in sending or receiving wireless messages, the Workflow 
Management enterprise component group must also be enabled. You can enable 
this component group when installing Siebel Server, or after Siebel Server is 
installed. Make sure that the components you need are configured and running. 

For more information, refer to Siebel Business Process Designer Administration 
Guide and Siebel Server Administration Guide.

Installing and Configuring MobileSys MX Server
One-way wireless messaging with Siebel Wireless Messaging requires that the 
MobileSys MX wireless messaging server be installed and configured to connect 
with the Siebel Server.

Versions of MobileSys MX supporting Microsoft Windows 2000, Sun Solaris, and 
IBM AIX platforms are included in the ThirdParty directory of the Windows Server 
Ancillary Programs CD-ROM from Siebel Systems.
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For specific information on supported operating systems and versions, refer to 
Siebel System Requirements and Supported Platforms for your Siebel products, and 
refer to the release notes provided by MobileSys.

For instructions for installing MobileSys MX, refer to MobileSys MX Getting Started 
Guide and MobileSys MX Reference Manual on the Siebel eBusiness Third-Party 
Bookshelf.

NOTE: The installation documentation for MobileSys MX assumes that you are 
connecting directly to network operators to send messages. If you will send 
messages through the MobileSys Network instead, visit http://siebel.mobilesys.net 
for alternate installation instructions. These connection options are described in 
“Installing and Configuring Siebel Wireless Messaging” on page 484.

MobileSys MX may be installed on the same server that hosts the Siebel Server, or 
on its own server. Siebel Communications Server sends XML messages to MobileSys 
MX over HTTP using the wireless messaging communications driver.

A service node must be defined within MobileSys MX to support each network 
operator and message type. The service node definition is part of the MobileSys MX 
configuration file.

NOTE: If you experience difficulties with the installation, configuration, or operation 
of the MobileSys MX wireless messaging engine, contact Siebel Technical Support 
immediately. Siebel Technical Support will work with MobileSys to resolve relevant 
issues.

Configuring Communications Drivers and Profiles
To complete configuring Siebel Wireless Messaging, you must create a separate 
communications driver profile for each wireless network operator and each 
connection type that will be used to send or receive wireless messages. Do this 
whether you use the MobileSys Network or connect directly to wireless network 
operators.

Siebel Wireless Messaging drivers include:
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■ Wireless Messaging 1-Way. Supports outbound wireless messaging using SMS, 
TAP, and SMTP wireless message types. Requires Siebel Wireless Messaging. For 
parameter information, see “Wireless Messaging 1-Way Driver Parameters” on 
page 490.

■ Wireless Messaging 2-Way. Supports inbound and outbound wireless messaging 
using SMS wireless message types. Requires Siebel Wireless Messaging. For 
parameter information, see “Wireless Messaging 2-Way Driver Parameters” on 
page 491.

NOTE: The WAP V1.2 and WAP V1.1 communications drivers may also be used with 
Siebel Wireless Messaging. Using them does not require Siebel Wireless Messaging. 
For information, see “Configuring WAP Push Messaging” on page 513.

The Wireless Messaging 1-Way or Wireless Messaging 2-Way communications 
drivers send and receive wireless messages using XML over HTTP or HTTPS. The 
XML document contains content and addressing information for the message.

■ For one-way messaging, which uses MobileSys MX, Siebel Communications 
Server sends outbound messages to MobileSys MX in XML format over HTTP.

■ For two-way messaging, which uses the MobileSys Network and does not use 
MobileSys MX, Siebel Communications Server sends outbound messages to, and 
receives inbound messages from, the MobileSys Network in XML format over 
HTTPS.

NOTE: After a wireless message is sent to a wireless messaging gateway using one of 
the communications drivers described in this section, the Communications 
Outbound Manager server component may log that the message has been 
successfully sent. However, the log file cannot indicate whether the wireless 
message was ultimately delivered to a valid wireless messaging address by the 
wireless messaging gateway. In addition, customers can retrieve message delivery 
status from MobileSys MX or the MobileSys Network.

For more information about communications drivers, see “About Communications 
Drivers and Profiles” on page 53 and “Configuring Communications Drivers and 
Profiles” on page 68.
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Wireless Messaging 1-Way Driver Parameters
Table 70 lists the supported parameters for the Wireless Messaging 1-Way 
communications driver. This driver supports various SMS (Short Message Service) 
protocols, and can be used for outbound messaging only. The channel type for this 
driver is Wireless Message.

Table 70. Wireless Messaging 1-Way Driver Parameters

Name Required Default Value Description

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more detailed.

Log files are created in the log subdirectory of the Siebel 
Server installation directory.

MXGateway Yes The URL to connect to the network operator for outbound 
messages, through the MX gateway. The URL may 
optionally include a specified port and resource such as a 
CGI script to be invoked.

For example, the specified URL may be defined as:

http://www.customerdomain.com/cgi-bin/ 
postmsgblob.cgi

MXReference Yes The name of the unique service node that the MX 
gateway’s XML configuration file uses for the network 
operator.

The XML configuration file contains a named service node 
for each network operator. The file determines how to 
communicate with each network operator using the MX 
gateway.

The value for the MXReference parameter must be 
different in each driver profile that is to communicate with 
a particular network operator.

For additional information on naming service nodes, refer 
to the MobileSys MX Reference Manual on the Siebel 
eBusiness Third-Party Bookshelf. Visit http://
siebel.mobilesys.net for service node names required to 
send messages through the MobileSys Network.
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Wireless Messaging 2-Way Driver Parameters
Table 71 on page 492 lists the supported parameters for the Wireless Messaging 
2-Way communications driver. This driver supports various SMS (Short Message 
Service) protocols, and can be used for both inbound and outbound messaging. The 
channel type for this driver is Wireless Message.

Save Sent Messages No FALSE TRUE or FALSE

Specifies whether to save sent wireless messages.

■ If TRUE, sent messages are saved into the “sent” 
message directory.

■ If FALSE, sent messages are not saved.

Each message is saved as a separate XML file.

See also the description of the Sent Message Directory 
parameter.

Sent Message 
Directory

No The directory where sent messages should be saved, if 
Save Sent Messages is TRUE.

By default, if Save Sent Messages is TRUE, sent messages 
are saved into the bin/sent subdirectory of the Siebel 
Server installation directory.

See also the description of the Save Sent Messages 
parameter.

Table 70. Wireless Messaging 1-Way Driver Parameters

Name Required Default Value Description
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For more information, see “Using Two-Way Wireless Messaging Workflows” on 
page 505.

Table 71. Wireless Messaging 2-Way Driver Parameters

Name Required Default Value Description

Delete Processed 
Messages

No TRUE or FALSE

Specifies whether processed messages are 
deleted.

■ If TRUE, then messages are deleted from 
the “incoming” message directory after 
they are processed.

■ If FALSE, then messages are moved to 
the “processed” message directory after 
they are processed.

See also the descriptions for the Processed 
Message Directory parameter.

Incoming Message 
URL

Yes https://
prodgw.xmlgw.mobilesys.
net/httpg/inbound

The URL to connect to the MobileSys 
Network for inbound mobile-originated 
messages.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more 
detailed.

Log files are created in the log subdirectory 
of the Siebel Server installation directory.

MX Client Id Yes The client ID to access the MobileSys 
Network.

MX Client Password Yes The password to access the MobileSys 
Network.

MXGateway Yes https://
prodgw.xmlgw.mobilesys.
net/httpg/send

The URL to connect to the MobileSys 
Network for outbound messages.
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MXReference Yes The name of the unique service node that 
the MobileSys Network’s XML 
configuration file uses for the network 
operator.

The XML configuration file contains a 
named service node for each network 
operator. The file determines how to 
communicate with each network operator 
using the MobileSys Network.

The value for the MXReference parameter 
must be different in each driver profile that 
is to communicate with a particular 
network operator.

Visit http://siebel.mobilesys.net for service 
node names required to send messages 
through the MobileSys Network.

PollingInterval No 60 Number of seconds between checks for new 
inbound messages and status of outbound 
messages arriving at the MobileSys 
Network.

Processed Message 
Directory

No The directory where wireless messages in 
XML format are retrieved from the 
MobileSys Network should be moved, after 
they have been processed—unless they are 
to be deleted instead.

The Delete Processed Messages parameter 
is used to determine whether processed 
messages are deleted or moved to this 
directory.

By default, if Delete Processed Messages is 
FALSE, the “processed” message directory 
is the bin/processed subdirectory of the 
Siebel Server installation directory.

See also the description for the Delete 
Processed Messages parameter.

Table 71. Wireless Messaging 2-Way Driver Parameters

Name Required Default Value Description
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Administering Mobile Devices
Customers must enter and store the following mobile device address information 
required to send wireless messages to their employees, customers, and partners:

■ Mobile devices. Device names may be specified for each person in the Siebel 
database. Mobile devices are stored in the table S_MBL_DVC.

■ Device addresses. Device addresses may be specified for each mobile device. 
Each device must have a minimum of one address associated. Device addresses 
are stored in the table S_MBL_DVC_ADDR.

Save Sent Messages No FALSE TRUE or FALSE

Specifies whether to save sent wireless 
messages.

■ If TRUE, sent messages are saved into 
the “sent” message directory.

■ If FALSE, sent messages are not saved.

Each message is saved as a separate XML 
file.

See also the description of the Sent Message 
Directory parameter.

Sent Message 
Directory

No The directory where sent messages should 
be saved, if Save Sent Messages is TRUE.

By default, if Save Sent Messages is TRUE, 
sent messages are saved into the bin/sent 
subdirectory of the Siebel Server 
installation directory.

See also the description of the Save Sent 
Messages parameter.

Status URL Yes https://
prodgw.xmlgw.mobilesys.
net/httpg/status

The URL to connect to the MobileSys 
Network for status of outbound messages.

Table 71. Wireless Messaging 2-Way Driver Parameters

Name Required Default Value Description
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Mobile device and device address information can be entered into the Siebel 
database in any of three ways:

■ Using the Mobile Devices view in the Communications Administration screen. 
The Mobile Devices view allows system administrators to enter and edit mobile 
device and addressing information for all persons defined in the Siebel database.

■ Using the Mobile screen. This screen allows individual employees, customers, 
and partners to update information about their own mobile devices and device 
addresses defined in the Siebel database. For information about using the Mobile 
screen, see “Specifying Mobile Device Settings” on page 388.

■ In batch mode using Siebel Enterprise Integration Management (EIM) or similar 
methods. For more information, refer to Siebel Enterprise Integration Manager 
Administration Guide on the Siebel Bookshelf.

Wireless message addressing information is displayed both to system administrators 
(in the Mobile Devices view in the Communications Administration screen) and to 
end users (in the Mobile screen), using common naming conventions.

Specifying Mobile Device and Device Addressing Information
A system administrator enters mobile device data required to send wireless 
messages in the Mobile Devices view in the Communications Administration 
screen. This view allows you to associate one or more wireless devices to a person, 
and one or more addresses to each wireless device.

To specify mobile device and address information

1 From the application-level menu, choose View > Site Map > Communications 
Administration > Mobile Devices.

The Mobile Devices view displays the Persons list, the Mobile Devices list, and 
the Device Addresses list.

2 In the Persons list, select the person to whom you want to assign a mobile 
device.
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3 In the Mobile Devices list, create a new record and fill out the mobile device 
information.

You can associate multiple mobile devices with a particular person. Specifying a 
mobile device for a person is also known as registering the device. For each 
person, each device name must be unique. Mobile device information is 
described in “Mobile Device Settings” on page 496.

4 In the Mobile Devices list, select the device for which you want to establish the 
address.

5 In the Device Addresses list, create a new record and fill out the addressing 
information for the selected device.

You can associate multiple addresses with a particular device. Mobile device 
addressing information is described in “Device Address Settings” on page 497.

Mobile Device Settings
For each person in the Siebel database, the Mobile Device list in the Mobile Devices 
view contains settings for device name, login preference, and device priority for 
each mobile device that will receive wireless messages. Mobile device information 
includes the following:

■ Device Name. The name to assign to the mobile device. It can be any descriptive 
name. For each person, each device name must be unique.

■ Login Preference. The Auto Login level for the mobile device. The value for each 
registered device can be set to any of three values:

■ Automatic Login

■ Password Only

■ User Name and Password

NOTE: For a WAP Push message that includes a URL for a Siebel Wireless 
application, the login preference is applied when authenticating users for the 
application. For more information, refer to Siebel Wireless Administration Guide. 
The login preference is ignored for any wireless messaging that does not launch 
the Siebel Wireless application.
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■ Device Priority. Select a priority, 1- Highest to 6 - Unranked, for each mobile 
device you register. Wireless messages are generally sent to the mobile device 
with the highest priority, for each user.

To guarantee message delivery, make sure that only one registered device is 
assigned the highest device priority: only one device registered for a particular 
user may have a device priority set to 1 - Highest. Any other registered devices 
must have the device priority set to 2 or a higher number. Do not attempt to 
register any additional devices if a device with priority 6 already exists.

NOTE: Normally, all messages are sent to the highest priority device and address 
for a recipient. However, end users may override the device priority settings in 
the Mobile Alerts view in the Mobile screen. When an end user enables an alert 
for a particular device, the alert is sent to that device, regardless of the device 
priority settings established for the user. 

For more information on allowing end users to enable alerts, see “Configuring 
One-Way Wireless Messaging Workflows for Siebel Wireless” on page 504. For 
information about how end users can configure mobile alerts, see “Specifying 
Mobile Device Settings” on page 388.

■ Comments. Comments you can enter about a particular mobile device.

Device Address Settings
The Device Addresses list in the Mobile Devices view contains settings for message 
delivery profile, device address, and address priority for each mobile device that will 
receive wireless messages. Device addressing information includes the following:
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■ Message Delivery Profile. Specify a message delivery profile, which describes the 
network and message type that will be used to send wireless messages to this 
mobile device.

Using Siebel Wireless Messaging, for example, if a device is connected to 
wireless network operator ABC and uses the SMS protocol to receive messages, 
then the administrator creates a message delivery profile, such as ABC Network 
SMS Profile. Such a profile would be based on the Wireless Messaging 1-Way or 
Wireless Messaging 2-Way communications driver.

The driver profile references the applicable service node, which is used to send 
a message through the wireless network operator that provides service to the 
person’s mobile device. 

For more information, see “Configuring Communications Drivers and Profiles” 
on page 488.

If an administrator does not do so, each end user must associate the appropriate 
profile with the mobile device to receive messages.

■ Device Address. Specify a unique identifier for a particular mobile device, 
enabling messages to be sent to this device.

■ Often, the device address required to send an SMS or TAP page message is 
the phone number or PIN number of the device. If you are using the 
MobileSys Network in the United States, the phone number is preceded with 
a numeral 1. If you are using the MobileSys Network in other countries, 
contact MobileSys for additional information and prefixes.

■ For WAP Push messages, the device address may be either a user-defined 
address or any device address understood by the network operator, such as 
the MSISDN or IP address of the device. Consult your service provider to 
determine your WAP Push address.
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■ Address Priority. Select a priority, from 1 - Highest to 6 - Unranked, for each 
address for each mobile device, for each applicable recipient. Wireless messages 
are sent to the device with the highest device priority, and to the highest priority 
address for that device.

To guarantee message delivery, make sure that only one device address is 
assigned the highest address priority: only one address for a particular mobile 
device may have an address priority set to 1 - Highest. Any other address must 
have the address priority set to 2 or a higher number. Do not attempt to define 
any additional addresses if an address with priority 6 already exists.

■ Comments. Comments you can enter about a particular mobile device address.

Using One-Way Wireless Messaging Workflows
One-way wireless messages can be sent automatically using Siebel workflow 
policies and workflow processes, which codify business rules defined by your 
enterprise. Workflows are configured using Siebel Business Process Designer.

Different workflows are provided for one-way and two-way wireless messaging 
scenarios. For two-way wireless messaging, see “Using Two-Way Wireless 
Messaging Workflows” on page 505.

For more information about working with Communications Server components, see 
Chapter 7, “Administering Siebel Communications Server.”

For more information about using workflow policies, workflow processes, and 
applicable server components, refer to Siebel Business Process Designer 
Administration Guide.

Setting Up One-Way Wireless Messaging Workflows
This section outlines the basic process for setting up and using one-way wireless 
messaging workflows.

1 Create the communications driver profiles you will need. For more information, 
see “Configuring Communications Drivers and Profiles” on page 488.
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2 Configure the workflow policies and workflow processes, according to your 
business needs. For more information, see “Configuring One-Way Wireless 
Messaging Workflows for Siebel Wireless” on page 504.

3 Make sure that the workflows you need are activated, and the workflows you do 
not need are inactive.

NOTE: Do not activate both the Wireless Activity Policy (Service) workflow policy 
(used for one-way messaging) and the Outbound Wireless Messaging Activity 
Dispatch Policy workflow policy (used for two-way messaging).

4 For each workflow policy used for outbound wireless messaging, generate 
triggers that correspond to the applicable triggering condition, by using the 
Generate Triggers server component.

Trigger conditions for the predefined one-way wireless messaging workflow 
policies are noted in Table 72 on page 501.

5 Start the Workflow Monitor Agent server component to monitor trigger 
conditions. Specify the corresponding group name.

6 Test your workflows.

NOTE: Communications Outbound Manager is automatically started when an 
applicable workflow is invoked.

Predefined One-Way Wireless Messaging Workflows
To facilitate automated one-way outbound wireless messaging, Siebel eBusiness 
Applications include in the seed data several predefined workflow policies, 
associated workflow actions, and associated workflow processes.

NOTE: The one-way wireless messaging workflows may be used with Siebel Wireless 
applications, with Siebel Wireless Messaging, or both. These workflows can be used 
with any of the wireless messaging drivers. Messages can be sent as SMS, WAP 
V1.2, or WAP V1.1 message types.
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These predefined workflow policies are designed to send outbound wireless 
messages, under the conditions shown in Table 72 on page 501. Each of these 
workflow policies in turn triggers a workflow process.

The workflows listed in Table 72 are designed to work in concert with the Siebel 
Call Center, Siebel Sales, Siebel Service, Siebel Partner Portal, and Siebel 
Self-Service Wireless applications.

Table 72. One-Way Wireless Messaging Workflow Policies

Workflow Policy Name Description of Workflow Functionality Conditions That Trigger the Workflow

Wireless Activity Policy (Sales) Sends a wireless message to the 
new owner (Primary Employee) for 
an activity

Setting or changing the primary 
employee for an activity to a user 
with the Sales Representative - 
Wireless responsibility

Wireless Activity Policy (Service) Sends a wireless message to the 
new owner (Primary Employee) for 
an activity

Setting or changing the primary 
employee for an activity to a user 
with the Field Service 
Representative - Wireless 
responsibility

Wireless Opportunity Policy Sends a wireless message to the 
new owner (Primary Sales Team 
Member) for an opportunity

Setting or changing the primary 
sales team member for an 
opportunity to a user with the 
Sales Representative - Wireless 
responsibility

Wireless Service Request Policy Sends a wireless message to the 
new owner for a service request

Setting or changing the service 
request owner to a user with the 
Field Service Representative - 
Wireless responsibility

eChannel Activity Assigned 
Wireless Alert

Sends a wireless message to the 
new owner (Primary Employee) for 
an activity

Setting or changing the primary 
employee for an activity to a user 
with the Partner Sales 
Representative - Wireless 
responsibility

eChannel Opportunity Assigned 
Wireless Alert

Sends a wireless message to the 
new owner (Primary Sales Team 
Member) for an opportunity

Setting or changing the primary 
sales team member for an 
opportunity to a user with the 
Partner Sales Representative - 
Wireless responsibility
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Configuring Send Behavior for One-Way Wireless Messaging Workflows
This section describes how you can configure the send behavior for the one-way 
workflows listed in Table 72 on page 501.

eChannel Service Request 
Assigned Wireless Alert

Sends a wireless message to the 
new owner for a service request

Setting or changing the owner of 
the service request to a user with 
the Partner Sales Representative - 
Wireless responsibility

eService Request Confirm 
Wireless Alert

Sends a wireless message to the 
contact for a service request

Creating a new service request, 
assigning its contact to someone 
who has the Registered Customer - 
Wireless responsibility, and 
adding an area for the service 
request

eService Request Assigned 
Wireless Alert

Sends a wireless message to the 
contact for a service request

Adding an owner for a service 
request and setting the service 
request’s Sub-Status to Assigned, 
for a service request whose 
contact has the Registered 
Customer - Wireless responsibility

eService Request Resolved 
Wireless Alert

Sends a wireless message to the 
contact for a service request

Setting the service request’s Sub-
Status to Resolved, for a service 
request whose contact has the 
Registered Customer - Wireless 
responsibility

Table 72. One-Way Wireless Messaging Workflow Policies

Workflow Policy Name Description of Workflow Functionality Conditions That Trigger the Workflow
502 Siebel Communications Server Administration Guide Version 7.5.3



Using Wireless Messaging

Using One-Way Wireless Messaging Workflows
By default, mobile alerts are sent to the highest priority address of the user’s highest 
priority device. To configure workflows to automatically send wireless messages 
only to message recipients who have requested to receive these mobile alerts using 
the Mobile screen, set the SendIfNoUserPref parameter of the predefined workflow 
actions to FALSE. In the Mobile screen, users can override the setting of this 
parameter to customize how mobile alerts are sent.

NOTE: The Mobile screen for end users is available only with Siebel Wireless 
Messaging or the Siebel Wireless application. For more information, see “Specifying 
Mobile Device Settings” on page 388.

■ SendIfNoUserPref = TRUE. If SendIfNoUserPref is set to TRUE for a workflow 
action (the default), alerts are sent to the highest priority address of the user’s 
highest priority device, without the intended recipient specifically enabling that 
alert. 

However, Siebel Workflow Policies checks for an On or Off setting in the 
ENABLED_CD column of the S_MBL_ALERT table, for this alert and this device. 
(An On or Off setting is created when a particular user sets the status for a 
specific alert on a specific device, in the Mobile screen.)

■ If an alert is On for a particular device for a user, this alert will be sent to the 
highest priority address defined for the associated device. Device priorities 
defined by the user or administrator are ignored.

■ If an alert is Off for a particular device for a user, this alert will not be sent 
to any device for this user, unless the same alert is On for a different device. 
Device priorities are ignored.

■ SendIfNoUserPref = FALSE. If SendIfNoUserPref is set to FALSE for a particular 
workflow action, Siebel Workflow Policies also checks for an On or Off setting 
for this alert and this device.

■ If an alert is On for a particular device for a user, this alert will be sent to the 
highest priority address defined for the associated device. Device priorities 
defined by the user or administrator are ignored.

■ Generally, an alert should not be set to Off if SendIfNoUserPref is FALSE.
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The operation of the SendIfNoUserPref parameter for a given workflow-based alert 
is outlined in Table 73.

Configuring One-Way Wireless Messaging Workflows for Siebel Wireless
This section describes various ways you can configure the one-way workflows listed 
in Table 72 on page 501. These configurations are applicable to using these 
workflows with the Siebel Wireless application.

If a message is sent using WAP Push with one of the workflows listed in Table 72 
on page 501, the workflow adds to the text of the message a URL link to the relevant 
view from the relevant Siebel Wireless application.

For example, when an activity with the description ABC is created and assigned to 
user TSMYTHE, the Wireless Activity Policy workflow pushes a wireless message 
to TSMYTHE with text that reads “You have a new Siebel Activity. View it Now?” If 
the message recipient (TSMYTHE, in our example) has a browser that supports 
WAP Push and links to view this message, the recipient’s browser is launched and 
displays the view Siebel Wireless Activity Detail View for ABC.

Depending on how your company uses wireless messaging, you may need to make 
one or more of the following modifications to the preconfigured workflows.

Table 73. Operation of SendIfNoUserPref Parameter for Workflow-Based Alerts

SendIfNoUserPref Setting User Specified Alert ON User Specified Alert OFF

TRUE (default)

Alerts are sent to the highest priority address 
of the user’s highest priority device.

User can override to receive alerts on a 
different device, or not to receive alerts.

Alerts are sent to the highest 
priority address of this 
device. Device priority is 
ignored.

Alerts will not be sent to this 
device.

If the alert is not ON for any 
other device, then alerts will 
not be sent to any device.

FALSE

Alerts are not sent to any devices for the user.

User can override to receive alerts on a 
specific device.

Alerts are sent to the highest 
priority address of this 
device. Device priority is 
ignored.

(Not recommended to be set 
to OFF in this case.)

Alerts will not be sent to this 
device for the user.
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Specifying a Base URL for Siebel Wireless
If wireless messages are sent to Siebel Wireless application users through WAP 
Push, as described above, the ChangeMe text of the Base URL parameter of the 
workflow action should be set to the external static IP address of the Siebel Server 
that supports Siebel Wireless.

NOTE: For the WAP V1.2 driver, if no URL is provided from the workflow, then a URL 
specified with the Default URL parameter is used instead. For more information 
about this parameter, see Table 75 on page 515.

Enabling Recipient Access to Views in Siebel Wireless
If you want to send wireless messages to recipients that do not have access to a 
Siebel Wireless application that includes the view name defined in the SWEView 
workflow action argument for a particular policy, the HasViewResponsibility step of 
the appropriate workflow processes should be eliminated.

Alternatively, if the view defined in the SWEView argument is added to another 
responsibility held by the message recipient, the recipient can link to the URL to 
access that view, even though the recipient does not have the responsibility shown 
in Table 72 on page 501.

Using Two-Way Wireless Messaging Workflows
In a two-way wireless messaging scenario using predefined workflows, a wireless 
message is sent automatically to a user with Field Service Representative - Wireless 
responsibility. The wireless message represents an activity record (the “dispatch 
activity”) that has been assigned to the field service representative. This 
representative then responds to the message by accepting or declining the activity, 
thus completing the two-way communication.

A second activity record (the “tracking activity”) is used to track the status of the 
communication associated with the dispatch activity.

To support two-way wireless messaging for Siebel Wireless Messaging, Siebel 
eBusiness Applications include in the seed data one predefined workflow policy, 
associated workflow actions, and associated workflow processes.
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■ The Outbound Wireless Messaging Activity Dispatch Policy workflow policy and 
the Outbound Wireless Messaging Activity Dispatch workflow process are used 
for outbound wireless messages.

■ The Inbound Wireless Messaging Activity Dispatch workflow process is used for 
inbound wireless messages.

NOTE: Two-way wireless messaging requires the Wireless Messaging 2-Way driver, 
provided with Siebel Wireless Messaging. Messages are sent and received as SMS 
message type.

For more information about working with Communications Server components, see 
Chapter 7, “Administering Siebel Communications Server.”

For more information about using working with workflow policies, workflow 
processes, and related server components, refer to Siebel Business Process Designer 
Administration Guide.

For more information about using working with Siebel Tools or Siebel business 
services, refer to Siebel Tools Reference and Siebel Tools Online Help.

For more information about working with response groups, refer to Siebel eMail 
Response Administration Guide.

Setting Up Two-Way Wireless Messaging
This section outlines the basic process for setting up and using two-way wireless 
messaging.

1 Create the communications driver profiles you will need. Profiles must be based 
on the Wireless Messaging 2-Way communications driver. For more information, 
see “Configuring Communications Drivers and Profiles” on page 488.

2 Configure the workflow policies and workflow processes, according to your 
business needs.
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3 Make sure that the workflows you need are activated, and the workflows you do 
not need are inactive.

NOTE: Do not activate both the Wireless Activity Policy (Service) workflow policy 
(used for one-way messaging) and the Outbound Wireless Messaging Activity 
Dispatch Policy workflow policy (used for two-way messaging).

4 For each workflow policy used for outbound wireless messaging, generate 
triggers that correspond to the applicable triggering condition, by using the 
Generate Triggers server component.

Trigger conditions for the predefined two-way wireless messaging workflow 
policy are noted in Table 74 on page 508.

5 For inbound wireless messaging, create a response group. Do this in the All 
Response Groups view in the Communications Administration screen. For this 
response group:

a Associate one or more profiles to this response group. Associate profiles for 
the communications driver Wireless Messaging 2-Way.

b Create an input argument record named ProcessName, with the value 
Inbound Wireless Messaging Activity Dispatch.

6 Start the Workflow Monitor Agent server component to monitor trigger 
conditions. Specify the corresponding group name.

7 Configure the Inbound Communications Manager server component. Create the 
component parameter Response Group Name, and provide the exact name of the 
applicable response group.

8 Start the Inbound Communications Manager server component.

9 Test your workflows.

NOTE: Communications Outbound Manager is automatically started when an 
applicable workflow is invoked.
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Predefined Two-Way Wireless Messaging Workflow for Outbound
The predefined workflow policy, Outbound Wireless Messaging Activity Dispatch 
Policy, is designed to send outbound wireless messages, under the conditions 
shown in Table 74. The associated workflow action invokes the workflow process 
Outbound Wireless Messaging Activity Dispatch.

Activities and Two-Way Wireless Messaging
This section describes how the dispatch activity and the tracking activity are 
handled for a two-way wireless messaging scenario using the predefined workflows.

Two-way wireless messaging uses, in addition to the outbound workflow described 
in Table 74, the workflow process Inbound Wireless Messaging Activity Dispatch. 
The Communications Inbound Manager server component and response groups 
you have configured process inbound messages, then invoke this workflow process 
to update the applicable dispatch activity and tracking activity records.

■ The dispatch activity record is updated according to the response sent by the 
field service representative who received the outbound message.

The inbound message includes the users’s reply and the original outbound 
message. The inbound workflow parses the inbound reply message for this data 
in order to update the dispatch activity.

■ The tracking activity record is updated according to status information for the 
outbound message that is returned from the MobileSys Network.

The status message includes a status code for success or failure, and a unique 
message ID. The inbound workflow parses the inbound status message for this 
data in order to update the tracking activity.

Table 74. Two-Way Wireless Messaging Workflow Policy

Workflow Policy Name Description of Workflow Functionality Conditions That Trigger the Workflow

Outbound Wireless Messaging 
Activity Dispatch Policy

Sends a wireless message to a field 
service representative who is the 
new owner (Primary Employee) for 
an activity

Setting or changing the primary 
employee for an activity to a user 
with the Field Service 
Representative - Wireless 
responsibility
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Dispatch Activity Message Sent to Field Service Representative
When a dispatch agent assigns an activity to a field service representative and the 
Outbound Wireless Messaging Activity Dispatch Policy workflow policy is triggered, 
data is extracted from the activity in order to send the wireless message to the field 
service representative.

Each outbound wireless message in a two-way wireless messaging scenario is 
preformatted using a standard set of labels and data for each activity. For the default 
workflows, each message is similar to the example below:

!B! A#: 1-4GTB Dsc: Replace Scan Unit Pr: 2-High 
Ac: AcquaMarine Fisheries C: Jacques Andre 
Ph: (331) 456-7890 PS: 04/18 05:00 PM !E!

The outbound wireless message contains the following configurable elements:

■ !B! indicates the beginning of the message. This element is configured using the 
Message Head workflow process property.

■ !E! indicates the end of the message. This element is configured using the 
Message Tail workflow process property.

■ A#: indicates the ID number of the dispatch activity that has been assigned to 
the recipient.

■ Dsc: indicates the description of the activity.

■ Pr: indicates the priority of the activity.

■ Ac: indicates the name of the applicable account.

■ C: indicates the name of the applicable contact for this account.

■ Ph: indicates the phone number for the contact.

■ PS: indicates the planned start time (Start field) for the dispatch activity.

NOTE: The Comments field of the dispatch activity record is also used to log errors 
received from the applicable workflows. This may be helpful for troubleshooting 
purposes.
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Field Service Representative Response to Outbound Message
After receiving the message, the field service representative sends a response to the 
Siebel Server. The inbound response message is received and processed by the 
Inbound Wireless Messaging Activity Dispatch workflow process, and causes the 
dispatch activity to be updated.

For the predefined workflows, the inbound message must begin with either of the 
following:

■ Sebl A (for acknowledge) sets the status of the dispatch activity to 
Acknowledged.

■ Sebl D (for decline) sets the status of the dispatch activity to Unscheduled.

If a different message is sent in error, such as one beginning with “Sebl B” or some 
other string, an error message is logged in the Comments field of the dispatch 
activity and no further updating of the dispatch activity occurs.

The MobileSys Network also sends message delivery status data to the Siebel 
Server, and causes the tracking activity to be updated.

Tracking Activity Record
When the initial outbound wireless message is sent, a corresponding tracking 
activity record is created. The message text is copied to the Comments field for the 
tracking activity, and the activity ID of the dispatch activity is copied to the 
Description field for the tracking activity. For this tracking activity record:

■ The text in the Description field consists of A# plus the activity ID of the dispatch 
activity. For example, this text might be A#: 99-4CGJM, in which 99-4CGJM is 
the row ID of the dispatch activity.

■ The text in the Comments field consists of the message text from the outbound 
message.

■ The setting of the Status field is modified over time, as follows:

■ Initially, the status of the tracking activity is Done.

■ If the outbound message is received by the recipient successfully, the status 
of the tracking activity is set to Acknowledged.
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■ If the outbound message fails to reach the recipient for whatever reason, the 
status of the tracking activity is set to Cancelled.

Configuring Two-Way Wireless Messaging Workflows
This section describes in general terms various ways you can configure the 
workflows for two-way wireless messaging.

The predefined workflow policy, Outbound Wireless Messaging Activity Dispatch 
Policy, supports sending outbound messages to a field service representative, with 
the Field Service Representative - Wireless responsibility, who has been assigned an 
activity. 

The predefined workflow process, Inbound Wireless Messaging Activity Dispatch, 
is configured to support processing inbound messages sent as replies from these 
field service representatives and to support inbound messages from the MobileSys 
Network.

You can configure workflow policies and associated workflow actions and workflow 
processes to support modifications to this scenario, or to support other two-way 
wireless messaging scenarios, such as those described in this section.

Using Different Field Data or Labels, or Using Different Operators
You can modify your workflows to send outbound messages with different field data 
or labels, or to support sending messages through different network operators.

To do this, you would need to modify the workflow process to include different 
content, as necessary, and make corresponding changes to the inbound messaging 
workflow process.

In particular, the Message Head, Message Tail, and Message Length properties for 
the outbound workflow process may need to be modified in order to send messages 
that meet the requirements of particular network operators. The workflow process 
checks the message length before sending the outbound message. Messages longer 
than the defined value will not be sent.
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The values for the Message Head, Message Tail, and Message Length properties 
must be kept consistent in the workflow processes for both outbound and inbound 
wireless messaging.

NOTE: The default message length and the !B! and !E! strings for the message head 
and tail, respectively, support sending messages through AT&T Wireless.

Sending Messages Based on Different Assignment Scenario
You can modify your workflows to send outbound messages when a service request 
is assigned, rather than an activity, or when an activity or service request is 
assigned to a user with a different responsibility than Field Service Representative 
- Wireless.

To do this, you would need to modify the workflow policy and generate triggers 
triggers accordingly, modify the workflow process to include different content, and 
make corresponding changes to the inbound messaging workflow.

If the workflow policy is to support a different triggering condition, you must 
specify the appropriate column, component, and object in Siebel Tools in order to 
define the database events to be monitored, then update the workflow policy and 
associated workflow action accordingly.

For example, you may configure your workflow policy to monitor the database 
column for the Service Request Owner field.

You may also choose to implement a custom business service that will retrieve field 
data from the intended business component, such as the Service Request business 
component. Then, in the Construct Message Body workflow step of the outbound 
workflow process, you can construct the outbound message body with these fields.

Receiving Inbound Messages with Different Response Content
You can modify your workflows to receive inbound messages with different 
response content, such as if the outbound message pertained to a service request 
rather than an activity, or if different response information was required from the 
recipient of the original message.

To do this, you would need to modify the inbound messaging workflow to accept 
and process this content.
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If you need to parse out additional kinds of data as substrings, you can configure 
the inbound workflow to do this, using the parseString method of the Mobile Device 
business service or using a custom business service. The parseString method has 
the following arguments, of type String:

■ Left Token. The left boundary of the substring.

■ Right Token. The right boundary of the substring.

■ Message Body. The text message from which the substring will be parsed out.

■ Mode. Determines which parts of the message body are parsed out.

■ The value “inside” (the default) indicates that the message text that is 
enclosed between the Left Token and the Right Token should be parsed.

■ The value “outside” indicates that the message text that is not enclosed 
between the Left Token and the Right Token should be parsed.

In addition to specifying different data to be parse out, the workflow process may 
need to handle this data differently. You may, for example, invoke subprocesses, 
custom business service methods, or other means of achieving your business 
objectives.

For more information about how the predefined inbound messaging workflow 
processes data and updates activity records, see “Activities and Two-Way Wireless 
Messaging” on page 508.

Configuring WAP Push Messaging
In addition to the Siebel Wireless Messaging product option and communications 
drivers, the base Siebel eBusiness Applications also provide the following drivers:

■ WAP V1.2
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■ WAP V1.1

NOTE: The WAP V1.1 communications driver includes a single predefined profile, 
which requires no configuration. For more information, see “Enabling WAP V1.1 
Push Messaging” on page 516.

The WAP V1.2 communications driver provides support to push linkable URLs 
along with wireless messages. The URL link allows the user to launch the Siebel 
Wireless application, or another application that is compliant with WAP V1.2. 

Messages can be pushed to wireless browsers that support the WAP V1.2 Push 
standard. Such messages must be sent through a Push Proxy Gateway that can be 
hosted internally by an enterprise or externally outside the enterprise firewall, such 
as by a wireless network operator.

The following infrastructure elements support wireless messaging using WAP V1.2. 
Functionality is provided with the Siebel base applications, unless otherwise noted.

■ Mobile device and device address information specified by system 
administrators through the Mobile Devices view in the Communications 
Administration screen. This information is stored in the S_MBL_DVC and 
S_MBL_DVC_ADDR tables.

■ Mobile device, device address, and mobile alert information specified by end 
users through the Mobile screen. This information is stored in the S_MBL_DVC, 
S_MBL_DVC_ADDR, and S_MBL_ALERT tables. (The Mobile screen requires a 
license for either Siebel Wireless or Siebel Wireless Messaging.)

■ Predefined workflows that automate wireless messaging. For details, see “Using 
One-Way Wireless Messaging Workflows” on page 499.

WAP V1.2 Driver Parameters
A separate communications driver profile for the WAP V1.2 communications driver 
must be created for each individual WAP Push Proxy Gateway through which WAP 
Push messages are sent.
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Table 75 lists the supported parameters for the WAP V1.2 communications driver. 
This driver supports Wireless Application Protocol version 1.2, and supports WAP 
Push as defined by the WAP Forum in its WAP V1.2 specification. The channel type 
for this driver is Wireless Message.

For more information about communications drivers, see “About Communications 
Drivers and Profiles” on page 53 and “Configuring Communications Drivers and 
Profiles” on page 68.

Table 75. WAP V1.2 Driver Parameters

Name Required Default Value Description

Default URL No The default URL linked to an outbound message, in the 
following cases:

■ If no URL is specified in a workflow process that sends 
the message, the URL specified with this parameter is 
sent to the recipients.

■ Or, if a message is sent using the Send Wireless Message 
command to a device address for which the profile 
specifies this parameter, then the URL specified with 
this parameter is sent to the recipient.

For more information about URLs and one-way wireless 
messaging workflows, see “Specifying a Base URL for 
Siebel Wireless” on page 505.

For more information about sending wireless messages 
manually, see “Using the Send Wireless Message 
Command” on page 382.

Gateway Yes The URL to connect to the WAP V1.2 gateway.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more detailed.

Log files are created in the log subdirectory of the Siebel 
Server installation directory.
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Enabling WAP V1.1 Push Messaging
Siebel eBusiness Applications support WAP V1.1 Push (HDML) messaging to 
Openwave browsers. You must download and register the UPNotify.dll file from the 
Openwave software developer’s kit.

NOTE: The WAP V1.1 communications driver requires that the UPNotify.dll file be 
registered by users. This communications driver can be enabled only for Microsoft 
Windows operating systems. By default, port 4445 is used to connect to the network 
operator. You must make sure this port is available for use.

The WAP V1.1 communications driver has a single predefined profile, named WAP 
V1.1 Profile. This profile requires no profile parameter overrides.

Instead, both the unique identifier for the mobile device to be pushed to and the 
wireless gateway through which the message is pushed must be specified as the 
device address for the mobile device. This information is contained in the 
HTTP_X_UP_SUBNO header element for a particular device. 

A utility is available within the Openwave software developer’s kit to identify this 
information for a WAP V1.1 Push-compliant browser.

Upgrading from Siebel Wireless 6.x Applications
If you have enabled automated alerts (WAP V1.1 Push) with Siebel Wireless version 
6.x applications and plan to also enable WAP V1.1 Push functionality for Siebel 7.x 
applications, you should use the current WAP V1.1 communications driver, rather 
than the WAP V1.1 Push business service that was provided with Siebel 6.x 
applications.

Additionally, you must replace the predefined workflow provided with Siebel 6.x 
applications to facilitate automated alerts with the new predefined wireless 
messaging workflows.

When you upgrade from Siebel 6.x applications, the automatic upgrade script 
creates new entries for employees in the S_MBL_DVC and S_MBL_DVC_ADDR 
tables, for any existing mobile device addresses defined in the WAP_DEVICE_ADDR 
column of the S_EMPLOYEE table for Siebel 6.x.
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This appendix provides information about configuring Siebel Communications 
Server to support:

■ Integrating with email and fax servers

■ Handling interactive email work items (for Siebel eMail Response when 
implemented with Siebel Universal Queuing)

■ Integrating the Send Email command with email client software: Lotus Notes or 
Microsoft Outlook

■ Using the Push Keep Alive driver to maintain communications sessions

■ Modem-based TAP paging

■ FTP (for Siebel Marketing)

The parameters for the communications drivers that support these systems are 
described here.

Interfacing with Email and Fax Servers
This section describes the parameters for communications drivers provided by 
Siebel Systems that support email and fax. For this release, the Internet SMTP/POP3 
Server driver is the only such driver.

NOTE: For information about upgrade issues that relate to communications drivers 
(adapters) used in version 6.x, see Appendix G, “Upgrading from Version 6.x.”
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The Internet SMTP/POP3 Server driver supports inbound email for Siebel eMail 
Response, and supports outbound email and fax messages for many different Siebel 
application modules and features. Outbound email and fax messages can be sent 
using:

■ Siebel eMail Response (email only)

■ Send Email and Send Fax commands

■ Outbound communication requests views in the Communications 
Administration screen (for administrators) and Communications screen (for end 
users)

■ Siebel Marketing views for sending offers (email or fax)

■ Workflow policies and workflow processes, created using Siebel Business 
Process Designer

■ Any module that invokes methods of the Outbound Communications Manager 
business service to send email or fax messages

For more information about these Siebel modules, refer to the appropriate section 
in this guide and to other documentation on Siebel Bookshelf.

For more information about specifying recipients for email or fax messages, see 
“Configuring Recipient Groups for Requests and Advanced Templates” on page 287 
and “Configuring Recipients for Send Commands” on page 299.

For more information about communications drivers, see “About Communications 
Drivers and Profiles” on page 53 and “Configuring Communications Drivers and 
Profiles” on page 68.

Integrating with Email Systems
Sending outbound email messages and receiving inbound email messages using 
Siebel Communications Server requires that you integrate your email system. You 
must configure profiles for the Internet SMTP/POP3 Server driver, using the 
parameters described in Table 76 on page 525.
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However, client-side email integration with Lotus Notes or Microsoft Outlook, 
options for the Send Email command, does not use Siebel Communications Server. 
For details, see “Configuring Client-Side Integration for Send Email” on page 542.

NOTE: After an email message is sent to the email server, the Communications 
Outbound Manager server component may log that the email has been successfully 
sent. However, the log file cannot indicate whether the email was sent to a valid 
email address. If the email server subsequently fails to deliver the message, a non-
delivery report will be sent from the email server to your sending mailbox.

For information about supported third-party products, refer to Siebel System 
Requirements and Supported Platforms for your Siebel applications. For information 
about configuring inbound communications, refer to Siebel eMail Response 
Administration Guide.

Using HTML Email
HTML email messages are supported for both outbound and inbound email, and for 
all Siebel application features that employ Siebel Communications Server to process 
email.

For more information, see “Template Content and Formatting” on page 394, 
“Editing and Formatting Controls for Send Email and Send Fax” on page 380, 
“Editing and Formatting Controls for Template Text Field” on page 405.

For inbound email, the HTML email is rendered in the browser (running the Siebel 
client) according to the capabilities of the browser.

For outbound email, HTML tagging may be applied in various ways or by various 
features, including any combination of the following:

■ Tagging may be applied manually to template items for advanced templates.

■ Tagging may be applied by the Web browser when you use HTML editing 
controls with the Send Email command, with Siebel eMail Response replies, or 
when editing template text.

■ Tagging may be included in text or other elements you have copied from a 
browser and pasted into your email message or template text.
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■ Tagging may be specified in HTML wrapper templates, configured as described 
in “HTML Wrapper Templates for Email” on page 395.

When users have specified HTML editing user preference settings, the HTML tags 
that are applied by the HTML editing controls in the Send Email window or in Siebel 
eMail Response replies in the Communications screen are subject to the capabilities 
of the supported browser. Some tags are implicitly inserted, regardless of whether 
a user has employed any specific HTML editing controls. Other tags are applied, or 
removed, by the browser, as the user formats the email text using these controls.

If HTML outbound email is generated, as outlined above, then an email message 
that is actually sent may be constructed as multipart MIME alternate email, 
containing an HTML version and a plain-text version of the message. This behavior 
can be specified by setting the parameter Create Plain Text From HTML to TRUE for 
the Internet SMTP/POP3 Server communications driver or for applicable profiles.

For details, see “Driver Parameters for Internet SMTP/POP3 Server” on page 524.

The Ignore HTML Tags setting, in the Spelling tab of the User Preferences screen, 
will cause spell checking to ignore any text enclosed in angle brackets (< and >), 
even text that did not derive from HTML tags. If an open angle bracket (<) appears 
in the text, then the Check Spelling feature will ignore all subsequent message text, 
because it expects a matching closing angle bracket (>).

For more information about the user preferences that determine whether users can 
access editing controls for directly formatting HTML outbound email, see 
“Preference Settings in the Outbound Communications Tab” on page 347.

For more information about HTML formatting for the Send Email window, see 
“Editing and Formatting Controls for Send Email and Send Fax” on page 380.

For more information about HTML formatting for Siebel eMail Response, refer to 
Siebel eMail Response Administration Guide and Siebel Call Center User Guide. See 
also “Activity Attachments Stored for Inbound Email” on page 332.

For more information about HTML issues for communications templates, see 
Chapter 9, “Configuring Communications Templates.”

For more information about using HTML email with Siebel Marketing, refer to Siebel 
Marketing Guide.
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Integrating with Fax Systems
Sending outbound fax messages requires that you integrate your email system with 
Siebel Communications Server and integrate your fax server with your email server. 
In addition, you must prepare your Siebel applications to format fax addressing data 
correctly.

Siebel software does not natively send any fax messages. Rather, the software sends 
an email message with special formatting codes that an email-fax gateway can 
process. The fax server then picks up this email, converts it to a fax and sends it to 
the recipient. For information about supported third-party products, refer to Siebel 
System Requirements and Supported Platforms for your Siebel applications.

NOTE: After a fax is sent to the email server for submission to the fax server, the 
Communications Outbound Manager server component may log that the fax has 
been successfully sent. However, this log file message does not indicate whether the 
fax was sent to a valid fax number. 

Most fax software sends a notification message when a fax cannot be transmitted 
to the destination. Some fax software applications can also be set up to send a 
notification when a fax is transmitted successfully. If the fax server has been 
configured to send notifications to the sender, the notification would appear in the 
mailbox that corresponds to the profile that was used to send the fax.

Your fax software, such as Captaris RightFax, must be configured to communicate 
with the email server over a configured gateway connection (or communications 
link). For example, when installing RightFax, you should use the gateway for SMTP/
POP3. For more information about email-fax gateways, refer to the documentation 
for your fax server.
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You must also create an email account (mailbox) that will be solely monitored by 
the fax server. For example, email messages addressed to the RightFax email 
account are transmitted through the gateway connection and automatically picked 
up by the RightFax server, which converts them into faxes and sends them. Each 
RightFax email gateway for SMTP/POP3 can monitor a single such email account.

NOTE: If you are using Communications Server with Captaris RightFax, in order to 
support Unicode configurations you should download the Unicode patch for 
Captaris RightFax. For more information, refer to Siebel System Requirements and 
Supported Platforms for your Siebel applications.

Configuring Fax Integration Elements in Siebel Tools
Siebel eBusiness Applications are preconfigured to send messages to be processed 
by Captaris RightFax. You must modify the configuration data in Siebel Tools in 
order to have fax recipient information processed correctly for the fax server you 
are using, as necessary, and to work with the email account you are using with the 
fax server.

For each business component from which you want to extract fax addressing 
information for recipients, the Recipient Fax Address Field user property should be 
set to the appropriate field, such as the Fax Address field for the Contact business 
component. 

For example, in views based on the Contact business component, your users may 
enter customer fax information in the Fax Phone # field. The Fax Address field is a 
calculated field that prepares fax addressing data obtained from the Fax Phone # 
field for use with your fax server. In this case, the Recipient Fax Address Field user 
property should specify the Fax Address field.

The formatting for fax-related fields depends on your fax server requirements. The 
calculated value for Fax Address or equivalent fields contains fax formatting that 
applies to RightFax. All such field values must be modified as appropriate for your 
specific fax integration. 

For example, for RightFax, the calculated value should specify the email account 
that is monitored by RightFax as well as the field, such as Fax Phone #, that contains 
the specific fax address for the recipient.
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By default, the Fax Address field for the Contact business component, for example, 
contains the following value for the Calculated Value field in Siebel Tools:

IIF([Fax Phone #] IS NOT NULL, '"/fax='+ToChar([Fax Phone #])+'/"
<replace_me@replace.me.com>', "")

The above definition should work correctly for Captaris RightFax, if you modify 
replace_me@replace.me.com to specify your fax integration’s email address. 
Retain the <> brackets enclosing the email address. Also make sure that a space 
character precedes the opening bracket (<) enclosing the email address.

For more information about configuring user properties and working with Siebel 
Tools, refer to Siebel Tools Reference and Siebel Tools Online Help.
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Driver Parameters for Internet SMTP/POP3 Server
Table 76 on page 525 lists the supported parameters for the Internet SMTP/POP3 
Server communications driver. Some parameters are applicable only to inbound 
email processing of messages retrieved from a POP3 server (for Siebel eMail 
Response), and some are applicable only to outbound email sent using an SMTP 
server. The channel type for this driver is Email.
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Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description

Create Plain Text 
From HTML

No FALSE If this parameter is TRUE, and an outbound message being 
sent contains text tagged with HTML but no plain text, 
synthesize (extract) the plain text from the HTML and send 
it as an alternate to the HTML. This situation may apply in 
these cases:

■ User sends email using Send Email command, when 
Send Email: Default Message Format is set to HTML in 
the Outbound Communications tab of the User 
Preferences screen.

■ User sends reply email using Siebel eMail Response, 
when Email Response: Default Message Format is set 
to HTML in the Outbound Communications tab of the 
User Preferences screen.

■ User sends outbound communication request for the 
email channel, for which a template contains either or 
both of the following: HTML template text or at least 
one HTML template item.

Sending separate plain-text and HTML versions of the 
same message body is called MIME multipart/alternative 
support.

To increase performance when sending HTML messages to 
recipients known to use email clients that can read or 
convert HTML messages, set this parameter to FALSE.

Note: The results of setting this option to TRUE may not be 
compatible with all major email clients. This factor must 
be considered before you set this parameter to TRUE.

For more information about HTML email, see “Using 
HTML Email” on page 519. For more information about 
setting outbound communications user preferences, see 
“Preference Settings in the Outbound Communications 
Tab” on page 347.
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Delete Processed 
Messages

No TRUE TRUE or FALSE

Specifies whether processed messages are deleted.

■ If TRUE, then messages are deleted from the 
“incoming” email directory after they are processed.

■ If FALSE, then messages are moved to the “processed” 
email directory after they are processed.

See also the descriptions for the Incoming Email Directory 
and Processed Email Directory parameters.

Failed Email Directory No The directory where failed incoming email messages 
retrieved from the POP3 server should be stored.

An incoming message is considered to be a failed message 
if any error or exception occurs while the message is 
parsed.

By default, failed email messages are saved to the bin/
failed subdirectory of the Siebel Server installation 
directory.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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From Address Yes The sender’s email address for outbound communications.

Should be in one of the following two forms:

sendername@companyname.com

sender_display_name 
<sendername@companyname.com>

Use the second form above if you want the recipient to see 
a display name for the sender, in addition to the email 
address.

The specified address is passed to the SMTP server in the 
“MAIL” command, and is used as the “From:” address in 
the message header.

Note: End users who create email/fax profiles for personal 
use can specify their own email address, as appropriate, 
for the From Address parameter, as a profile parameter 
override. For more information, see “Creating 
Communications Profiles for Personal Use” on page 366.

If no parameter value is provided, the driver tries to use the 
“SenderAddress” that is passed to the driver when it is 
asked to compose and send an email.

Note: For a profile used for inbound communications, 
which is specified for a response group, the From Address 
parameter represents the recipient’s email address.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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Incoming Email 
Directory

No The directory where email messages retrieved from the 
POP3 server are stored.

By default, incoming email messages are saved to the bin/
incoming subdirectory of the Siebel Server installation 
directory.

Messages may be moved to another directory after 
processing.

See also the descriptions for the Delete Processed 
Messages and Processed Email Directory parameters.

Note: As inbound email messages are processed, they are 
saved in a series of formats and filenames in the incoming 
directory and related directories. Corresponding 
attachment files to the Email - Inbound activity record are 
saved to the Siebel File System. For more information, see 
“Activity Attachments Stored for Inbound Email” on 
page 332.

For more information about inbound message processing, 
refer to Siebel eMail Response Administration Guide.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more detailed. The 
additional detail in the log file can help you to 
troubleshoot.

Log files are created in the log subdirectory of the Siebel 
Server installation directory. 

Log files for the Internet SMTP/POP3 Server driver have 
the name POP3SMTP_xxxxxxxxxxxxxxxx.log, where 
xxxxxxxxxxxxxxxx is a unique string of numerals.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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Loopback Detection 
Interval

No 90 An integer value that specifies the number of seconds to 
flag any inbound messages as loopback messages that 
were received from a sender from which another message 
was just received.

A message is determined to be a loopback message if the 
following are true:

■ The value for Loopback Detection Interval is greater 
than 0 (zero), and

■ The message is received no later than the specified 
number of seconds after a previous message was 
received from the same email address.

This parameter is based on the premise that a message 
received within a short period of time has a high likelihood 
of being an auto-response.

For example, if your system receives a message and sends 
out an auto-acknowledgement, that auto-
acknowledgement message could, when processed by the 
recipient, generate a return auto-response. Setting this 
parameter can prevent message looping that may 
otherwise occur in this instance.

If you set this value too high, you risk rejecting valid 
follow-up messages. If you set it too low, the driver may 
not correctly detect an inbound message that is actually 
just an auto-response.

Loopback messages are not auto-acknowledged or auto-
responded. They may either be moved to a “loopback” 
email directory, or processed as are other messages.

See also the descriptions for the Loopback Email Directory 
and Process If Loopback Detected parameters.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
Version 7.5.3 Siebel Communications Server Administration Guide 529



Using Email, Fax, and Other Systems

Interfacing with Email and Fax Servers
Loopback Email 
Directory

No The directory where email messages determined to be 
loopback messages should be stored, if they are not to be 
processed.

By default, email messages determined to be loopback 
messages are saved to the bin/loopback subdirectory of 
the Siebel Server installation directory.

See also the description for the Loopback Detection 
Interval and Process If Loopback Detected parameters.

Max Sends Per 
Session

No 0 Integer. Forces the driver to log off of the SMTP server after 
sending the number of messages specified using this 
parameter. The driver will then re-logon for the next send 
request.

(Some SMTP servers may have problems sending a large 
number (1000 or more) of messages in one session.)

A value of “0” (zero) means that the driver never logs off 
of the SMTP server.

POP3 Account Name Yes The account name for the POP3 mailbox from which to 
retrieve inbound communications.

POP3 Account 
Password

Yes The password for the POP3 mailbox account.

POP3 Batch Size No 15 The number of messages that will be retrieved before the 
driver is forced to log off from the POP3 server.

If there is a failure during the POP3 session, messages 
previously retrieved show up again the next time the driver 
logs into the POP3 server. If the driver logs off periodically, 
you minimize the number of such duplicated messages in 
the event of a failure.

POP3 Reconnection 
Delay

No 400 Minimum amount of time to wait, in milliseconds, before 
logging onto a POP3 server you just logged off of.

Specifying a delay interval may help avoid problems 
associated with email servers that may duplicate messages 
if a POP3 logon occurs very quickly after a logoff.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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POP3 Server Yes The host name or IP address of the machine on which the 
Internet POP3 server is running, as appropriate for your 
network configuration.

Note: If you specify a host name rather than an IP address 
for this parameter value, a corresponding entry must be 
included in your DNS server or the local hosts file. If an IP 
address parameter value works correctly, but a problem 
occurs when you have specified a host name parameter 
value, consult your network system administrator to verify 
that host name lookup is correctly configured.

POP3 Server Port No 110 The port used by the Internet POP3 server to listen for new 
socket connections.

POP3 Timeout No 60 Number of seconds to wait for a response from the POP3 
server before timing out.

PollingInterval No 30 Number of seconds between checks for new inbound mail 
arriving on the POP3 server.

Processed Email 
Directory

No The directory where email messages retrieved from the 
POP3 server should be moved, after they have been 
processed—unless they are to be deleted instead.

The Delete Processed Messages parameter is used to 
determine whether processed messages are deleted or 
moved to this directory.

By default, if Delete Processed Messages is FALSE, the 
“processed” Email Directory is the bin/processed 
subdirectory of the Siebel Server installation directory.

See also the description for the Delete Processed Messages 
parameter.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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Process If Loopback 
Detected

No TRUE TRUE or FALSE

Specifies how to handle an incoming message that is 
determined to be a loopback message.

■ If TRUE, then a loopback message is processed by 
Communications Inbound Manager and associated 
workflows, as are any other messages.

■ If FALSE, then a loopback message is saved to the 
“loopback” directory.

Loopback messages are not auto-acknowledged or auto-
responded.

The Loopback Detection Interval parameter is used to 
determine whether a message is flagged as a loopback.

See also the descriptions for the Loopback Detection 
Interval and Loopback Email Directory parameters.

Reply-To Address No An optional reply-to email address for the message, if it is 
different than that specified with the From Address 
parameter.

Multiple email addresses can be specified, separated by 
semicolons.

If a reply-to address is specified, then outgoing messages 
will have a “Reply-To:” header field added to the message 
envelope with the specified value.

Should be in one of the following two forms:

sendername@companyname.com

sender_display_name 
<sendername@companyname.com>

Use the second form above if you want the recipient to see 
a display name for the sender, in addition to the email 
address.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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Return Attachments No TRUE TRUE or FALSE

Specifies whether to accept or discard attachments.

■ If TRUE, any attachments parsed from the incoming 
message are passed into the Siebel application.

■ If FALSE, the attachments are simply discarded.

Save Sent Messages No FALSE TRUE or FALSE

Specifies whether to save sent messages.

■ If TRUE, sent messages are saved into the “sent” email 
directory.

■ If FALSE, sent messages are not saved.

Each message is saved as a separate, MIME-encoded file, 
in the exact format in which it was sent to the SMTP server.

See also the description of the Sent Email Directory 
parameter.

Sent Email Directory No The directory where sent messages should be saved, if 
Save Sent Messages is TRUE.

By default, if Save Sent Messages is TRUE, messages are 
saved into the bin/sent subdirectory of the Siebel Server 
installation directory.

See also the description of the Save Sent Messages 
parameter.

Siebel Server No The name of the Siebel Server that is to handle the delivery 
of the communications.

For more information, see “Administering 
Communications Outbound Manager” on page 333.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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SMTP Backup Server Yes The host name or IP address of the machine on which the 
backup Internet SMTP server is running, as appropriate for 
your network configuration.

You use this parameter when you have implemented a 
failover strategy for your SMTP server handling outbound 
email or fax communications.

If the primary SMTP server goes down, outbound 
communications using profiles in which these parameters 
are defined will be sent to the backup SMTP server 
instead, until the primary SMTP server has come back up.

■ If you have implemented failover support for your 
SMTP server, then you must use both the SMTP Server 
and SMTP Backup Server parameters.

■ If you have not implemented failover support for your 
SMTP server, use the SMTP Server parameter only. Do 
not define the SMTP Backup Server parameter.

Note: If a message cannot be sent to an SMTP server 
because it is down, the driver returns a message to the 
Communications Outbound Manager, which will lead to 
another attempt to send the message at a later time. (This 
behavior is not specific to a failover configuration.)

For more information, see the description of the SMTP 
Server parameter.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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SMTP Server Yes The host name or IP address of the machine on which the 
Internet SMTP server is running, as appropriate for your 
network configuration.

Note: If a message cannot be sent to an SMTP server 
because it is down, the driver returns a message to the 
Communications Outbound Manager, which will lead to 
another attempt to send the message at a later time.

Note: If you specify a host name rather than an IP address 
for this parameter value, a corresponding entry must be 
included in your DNS server or the local hosts file. If an IP 
address parameter value works correctly, but a problem 
occurs when you have specified a host name parameter 
value, consult your network system administrator to verify 
that host name lookup is correctly configured.

See also the description of the SMTP Backup Server 
parameter.

SMTP Server Port No 25 The port used by the Internet SMTP server to listen for new 
socket connections.

SMTP Timeout No 60 Number of seconds to wait for a response from the SMTP 
server before timing out.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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Supporting Email Interactivity
The User-interactive Email driver supports email interactivity within the Siebel 
application, enabling agents to use the communications toolbar for 
communications work items of this channel type.

The User-interactive Email driver supports Siebel eMail Response.

Try POP3 Logon No FALSE TRUE or FALSE

If TRUE, the driver tries to log on to the POP3 server during 
its initialization process. If the driver cannot log on to the 
POP3 server, it will fail to load.

By failing to load, the driver prevents unnecessary error 
messages from being generated at the interval specified 
with the PollingInterval parameter (the interval for 
checking for new messages).

See also the description of the PollingInterval parameter.

Use EHLO No TRUE TRUE or FALSE

Set to TRUE if SMTP extension (ESMTP) commands 
should be used on a particular email server. Causes the 
first command sent to the server to be “EHLO”, which 
enables the extension commands to be available.

Set to FALSE if you are using an SMTP server that cannot 
handle the EHLO command.

Table 76. Internet SMTP/POP3 Server Driver Parameters

Name Required Default Value Description
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Within the applicable communications configuration, events and commands for 
work items for these products must reference profiles for this communications 
driver. The communications configurations provided by Siebel Systems support 
multichannel communications for voice and email work items.

NOTE: Using this user-interactive driver requires that Siebel Universal Queuing or an 
equivalent queuing integration is deployed in order to route email work items to 
agents. When such a work item is routed to an agent, the agent is notified by the 
Accept Work Item button blinking on the communications toolbar. 

For more information about Siebel Universal Queuing, refer to Siebel Universal 
Queuing Administration Guide.

In the Communications Drivers and Profiles view, note that the two user-interactive 
drivers, along with the CTI drivers, have the Interactive flag set. For more 
information, see “About Communications Drivers and Profiles” on page 53 and 
“Configuring Communications Drivers and Profiles” on page 68.

NOTE: The Siebel-provided communications driver Internet SMTP/POP3 Server, 
although also of channel type Email, does not support user-interactive functionality 
for email. For more information about the function of this driver, see “Interfacing 
with Email and Fax Servers” on page 517.

User-interactive Email Driver
The User-interactive Email driver enables agents to use the communications toolbar 
for inbound email communications work items, in support of Siebel eMail 
Response, when deployed in conjunction with Siebel Universal Queuing. The 
Channel Type for this driver is Email.

User-interactive Email Driver Parameters
Table 77 lists the supported driver parameters for the User-interactive Email 
communications driver. 
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Parameters are sent to the driver handle when the driver is being initialized 
(CreateISCDriverInstance method), and when the driver handle requests a service 
(RequestService method). For more information about the driver handle methods, 
see Appendix D, “Developing a Communications Driver.”

Table 77. User-interactive Email Driver Parameters

Name Required Default Value Description

AutoAccept No FALSE TRUE or FALSE

If TRUE, and Siebel Universal Queuing 
dispatches a work item, the driver will 
automatically accept the work item and put the 
work item in an active state.

AutoSuspend No TRUE TRUE or FALSE

If TRUE, and Siebel Universal Queuing 
dispatches a work item, the driver will 
automatically accept the work item and put the 
work item in a suspended (paused) state.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more 
detailed.

LogFile No mail_{@UserName}.log The name of the file where logging information 
will be written. If this parameter is empty, no log 
file is generated. Logging data is always 
appended to this file.

Log files are created in the log subdirectory of 
the Siebel Server or Siebel Dedicated Web Client 
installation directory, depending on the client 
type and on your communications deployment.

Optionally, if you want to use a single log file in 
a multichannel environment, you can specify the 
same log file name for all interactive drivers you 
are using.

MaxLogKB No 128 Specifies the maximum size of the log file, in 
kilobytes (KB).

When the log file is full, it is emptied completely, 
then logging begins again.
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User-interactive Email Commands
Table 78 on page 540 lists and explains usage for commands specific to the 
communications driver User-interactive Email.

The commands you define, in which driver commands listed here are specified as 
device commands, support the command parameters documented in Chapter 4, 
“Configuring Events and Commands.” In your command definitions, you can 
specify custom subparameters for command parameters of type Group.

An asterisk (*) before a parameter name means that the parameter is optional for 
this command. Command parameters are described in Table 79 on page 541.

Most of the commands in Table 78 on page 540 correspond to commands defined 
in the communications configuration, in which they are specified as the device 
command. They may also correspond to a communications toolbar button.

ReleaseLogHandle No TRUE Indicates that the log file handle for each agent 
should be released periodically, after logs have 
been generated.

Performance for agent sessions can be improved 
by setting this parameter to FALSE. This may be 
most effective if LogDebug is also FALSE, 
because logging is less intensive.

When ReleaseLogHandle is FALSE, however, 
some log files may not be generated if the 
number of concurrent users exceeds the file-
handle capacity provided by the operating 
system.

Simulate No FALSE When this parameter is set to TRUE, this driver 
supports the Communications Simulator.

This parameter need not be explicitly set in order 
to use the Communications Simulator.

For more information, see “Enabling Session 
Communications and Simulation” on page 311 
and “Simulating a Communications 
Environment” on page 233.

Table 77. User-interactive Email Driver Parameters

Name Required Default Value Description
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For more information, see Chapter 6, “Configuring User Interface Elements.” For 
descriptions of the communications toolbar, see Chapter 8, “Communications 
Operations for End Users.”

For commands for which the TrackingID parameter is optional, the command 
operation is performed on the work item identified by the TrackingID parameter 
value. If this parameter is not provided, the command operates on the first available 
work item.

User-interactive Email Command Parameters
Table 79 on page 541 lists User-interactive Email command parameters and 
describes their usage. Table 78 on page 540 identifies the commands that use each 
of these parameters.

Table 78. User-interactive Email Commands

Command Name Parameters Description

AcceptEmailWork *TrackingID Accept a new email work item.

ReleaseEmailWork *TrackingID Release a new email work item.

ResetEmailState Reset the state of the User-interactive Email driver, in case it 
has gotten out of sync.

ResumeEmailWork *TrackingID Resume a new email work item.

SimNewEmailWork Simulate a new email work item.

Accepts any parameters received (by creating Param 
subparameters for the command data definition).

SuspendEmailWork *TrackingID Suspend a new email work item.
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Within the communications configuration, command parameters and values to pass 
to the User-interactive Email driver can be specified within command data 
definitions as subparameters of the Param parameter. For more information, see 
“Command Data” on page 186.

User-interactive Email Events
Table 80 lists and describes User-interactive Email events that Siebel 
Communications Server may receive. Events listed may be referenced as device 
events in communications configurations with which profiles for the User-
interactive Email driver are associated.

Table 79. User-interactive Email Command Parameters

Command Parameter Description

TrackingID The designated tracking ID of a work item, to identify the specific work item on which 
an operation is to be performed.

Table 80. User-interactive Email Events

Event Name Description

EventEmailWorkArrived A new email work item has arrived, having been delivered by Siebel 
Universal Queuing.

EventEmailWorkReleased The agent has released an email work item.

EventEmailWorkResumed The agent has resumed an email work item.

EventEmailWorkRevoked An email work item has been revoked by Siebel Universal Queuing.

EventEmailWorkStarted The agent has accepted an email work item and the work item is now 
active.

EventEmailWorkSuspended The agent has suspended an email work item.
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User-interactive Email Event Data
The attributes received with an email event are determined by the workflow process 
for Siebel eMail Response. The workflow can be extended to pass other attributes 
to Siebel Universal Queuing, which in turn passes them to the agent’s 
communications toolbar as event attributes. The following attributes must be 
passed to the workflow process for submission to Siebel Universal Queueing:

■ LongDescription. The detailed description of the work item. This attribute is used 
in the Accept/Reject dialog box, where the descriptive information is displayed 
in order for the agent to decide whether to accept or reject the work item.

■ ShortDescription. The brief description of the work item. This attribute is used in 
the Work Items list in the communications toolbar. For example, after an agent 
accepts an email work item, the Work Items list uses text from this attribute to 
identify an email. For example, the attribute value might be a phrase like:

Email from sender_name@company_name.com

■ ChannelAddress. This attribute stores applicable channel information for the 
work item that is intended to be displayed in the Channel Target Address field 
in the All Channel Items view (in the Communications Administration screen). 
The email address the work item was sent to may be stored using an attribute 
value like:

support@company_name.com

The fixed work item attributes received for any work item are described in “Work 
Item Attributes” on page 208.

Configuring Client-Side Integration for Send Email
The Send Email command can be deployed to support three different email client 
options. Users can be configured to use Lotus Notes or Microsoft Outlook to send 
outbound email messages, or configured to use the native Siebel email client.

NOTE: The third-party email client integrations described in this section are 
supported for end users on Microsoft Windows client machines only. End users on 
UNIX client machines must use the native Siebel email client.
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■ Send Email integrations for Microsoft Outlook are assumed to use Microsoft 
Exchange Server as the email server.

■ Send Email integrations for Lotus Notes are assumed to use Lotus Domino as the 
email server.

The third-party email client integration options use email client software on each 
user’s client machine, and do not use Siebel Communications Server. By contrast, 
the native Siebel email client for the Send Email command integrates with your 
email server, using Siebel Communications Server and the Internet SMTP/POP3 
Server communications driver.

If third-party email client integration is not configured, then the Siebel application 
uses the native Siebel email client. For more information, see “Interfacing with 
Email and Fax Servers” on page 517.

You can configure your system so that all users use the same email client for the 
Send Email command. Alternatively, you can support multiple email clients and let 
individual users specify their preferred email client.

Configuring third-party email client integrations requires the following general 
steps, which are described in more detail in the subsections that follow:

1 Create and configure one or more directories to use for temporary storage of 
email attachment files.

2 Install the Siebel email form for Lotus Notes or Microsoft Outlook.

3 As appropriate for your Siebel client deployment, set component parameter 
values for the Application Object Manager or set parameter values for the 
application’s configuration file, such as uagent.cfg for Siebel Call Center.

4 (Optional) Set user preferences for each end user.

For information about using the Send Email command with a third-party email 
client integration, see “Using the Send Email Command” on page 369.

For more information about activity records and email, see “Using Activity Records 
for Send Commands” on page 386, including the subsection about matching 
contacts for these activity records.
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For information about supported versions of third-party software, refer to Siebel 
System Requirements and Supported Platforms for your Siebel products.

NOTE: If you are using Microsoft Outlook for the Send Email command, note that 
communications between Outlook and the Siebel application, which is handled by 
scripts for the email form, may cause alert messages to be displayed. Whether such 
messages are displayed, and which messages may be displayed, depends on the 
current security settings for Outlook.

Email-related error messages received by users will use the language applicable to 
the source of the message. For example, an error message returned from a French 
version of Microsoft Outlook will be in French. 

Errors generated from Siebel software may use the language and locale of the Siebel 
Server, such as in the execution of a script used in the email form, or use the 
language and locale the user specified as a user preference or temporary setting for 
sending messages.

Creating and Configuring the Attachments Directory
If the Send Email command is configured to generate activity records, then when a 
Siebel user sends an email message using Lotus Notes or Microsoft Outlook, email 
attachment files are used to create attachment records for this activity record. A 
temporary storage directory must be defined to facilitate transferring attachments 
in this manner.

When the email message is sent, the email form invokes a script, which in turn 
invokes a Siebel business service method that transfers the files from this 
attachments directory to the Siebel Server and deletes the files from this directory.

For more information about activity records and email, see “Setting 
Communications User Preferences” on page 339 and “Using Activity Records for 
Send Commands” on page 386.

The attachments directory is typically (but not necessarily) located on the Siebel 
Server machine. For users on the Siebel Mobile Web Client who will use Lotus Notes 
or Microsoft Outlook for the Send Email command while disconnected from the 
network, a local attachments directory must be specified.
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The attachments directory must be accessible from each Microsoft Windows 
machine where the Siebel client may run. Access to this directory should be 
configured as follows:

■ For all Siebel users on applicable client machines, write access should be 
provided. Read and execute access should not be provided.

■ For the system user login that started the Siebel Server, read and execute access 
must be provided.

The attachments directory you configure in this section is then specified for use for 
all users or for individual users, as described in “Overview of Completing Email 
Client Configuration” on page 550.

Next, install the Siebel email form for Lotus Notes or Microsoft Outlook.

About Installing the Siebel Email Form
In order for users to be able to use either Lotus Notes or Microsoft Outlook for the 
Send Email command, Siebel-customized files described in this section must be 
copied to designated locations on server or client machines, and applicable email 
forms must be made available to your users.

For each of these email client programs, an email form is installed which has been 
set up for use with Siebel eBusiness Applications. Sending an email message from 
the form invokes a script that interacts with the Siebel application. 

The script updates the activity record for the email message and generates 
attachment records for this activity record, based on any email attachment files. If 
the email is canceled, the activity is deleted.

The Notes or Outlook form you install in this section is then specified for use for all 
users or for individual users, as described in “Overview of Completing Email Client 
Configuration” on page 550.

NOTE: Customizing the Notes or Outlook form beyond what is described in this 
document is not supported by Siebel Systems.
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Locations of Source Files for Siebel Email Forms
The Siebel email form for Lotus Notes is included in a Notes database file. The 
Siebel email form for Microsoft Outlook is included in an Outlook template file. 
These files are available on both server and client installation CD-ROMs from Siebel 
Systems.

The Server Ancillary Programs (for your Siebel Server operating system) and Web 
Client Ancillary Programs CD-ROMs include:

■ The Lotus Notes database file Siebel7Email.nsf, in the directory 
\Thirdpty\send_email\enu\Lotus_Notes

This database file supports only ENU (U.S. English) in the user interface. 
However, error messages will reflect the currently deployed supported language, 
if you choose to use this file in deployments other than ENU.

■ The Microsoft Outlook template file Siebel7Outlook.oft, in the directory 
\Thirdpty\send_email\enu\MS_Outlook

This template file supports only ENU (U.S. English) in the user interface. 
However, error messages will reflect the currently deployed supported language, 
if you choose to use this file in deployments other than ENU.

Installing the Siebel Email Form for Lotus Notes
This section describes how to install the Siebel email form for Lotus Notes. The 
email form may be installed on the server machine where Lotus Domino is running, 
or on each client machine.

For users on the Siebel Mobile Web Client who will use Lotus Notes for the Send 
Email command while disconnected from the network, the email form must be 
installed locally on the client machine. Note that deploying the form on local client 
machines has implications for subsequent updates.

NOTE: For additional deployment options for the Notes database and email form, 
contact your administrator for Lotus Notes and Lotus Domino.

The Siebel email form for Lotus Notes, Siebel Memo, is contained within the Notes 
database file Siebel7Email.nsf.
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You can rename the default email form, or add to this database additional Siebel 
forms based on the default. If you do either of these, make sure that the names of 
all supported Siebel forms are included in the List of Values type for the Siebel/
Lotus Form drop-down list, located in the Outbound Communications view of the 
User Preferences screen.

To specify a custom form as a global default, then you must also specify its name 
using the Siebel/Lotus Form server component parameter or the LotusForm 
configuration file parameter, as described in Table 81 on page 557.

To install the Siebel email form for Lotus Notes

1 Locate the Notes database file Siebel7Email.nsf on the server or client 
installation CD-ROM, as described in “Locations of Source Files for Siebel Email 
Forms” on page 546.

2 Copy this file to the clipboard.

3 Paste the Siebel7Email.nsf file into the appropriate destination location. Do one 
of the following:

■ On the Lotus Domino server machine, paste the file into the Data 
subdirectory in the Lotus Domino installation directory. For example, the 
location may be:

D:\Lotus\Domino\Data\Siebel

In this example, a Siebel subdirectory has been created in the Data directory.

■ On each client machine, paste the file into the Data subdirectory in the Lotus 
Notes client installation directory. For example, the location may be:

D:\Lotus\Notes\Data

4 Right-click on the file Siebel7Email.nsf, select Properties, uncheck the check box 
for the Read-only attribute (in order to allow read-write access), and click OK.

NOTE: If the Siebel7Email.nsf has the Read-only attribute set, then error messages 
may be displayed to end users when they use the Send Email command.
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5 On each client machine, add a line to the notes.ini file in your Lotus Notes 
installation, to indicate the location of the Notes database file. Do one of the 
following:

■ If you pasted the Siebel7Email.nsf file onto the Lotus Domino server 
machine, add an entry like the following (on one line):

SIEBELFORMPATH = server_host_name/
domino_server_name:Siebel\Siebel7Email.nsf

where server_host_name is the name of the host machine on which the Lotus 
Domino server is running and domino_server_name is the name of the Lotus 
Domino server itself. 

In this example, a Siebel subdirectory has been created in the Data directory. 
The path above would be appropriate for an actual location such as the 
following directory on the server_host_name machine:

D:\Lotus\Domino\Data\Siebel\Siebel7Email.nsf

■ If you pasted the Siebel7Email.nsf file onto each client machine, add an entry 
like the following (on one line):

SIEBELFORMPATH = D:\Lotus\Notes\Data\Siebel7Email.nsf

The Notes email form Siebel Memo is now ready to be used. To finish configuring 
your use of Lotus Notes, go to “Overview of Completing Email Client Configuration” 
on page 550.

Installing the Siebel Email Form for Microsoft Outlook
This section describes how to install the Siebel email form for Microsoft Outlook. 
The email form may be installed on the server machine where Microsoft Exchange 
Server is running, or on each client machine.
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For users on the Siebel Mobile Web Client who will use Microsoft Outlook for the 
Send Email command while disconnected from the network, the email form must 
be installed locally on the client machine. Note that deploying the form on local 
client machines has implications for subsequent updates. Also, note that a form in 
the Personal Form Library takes precedence over a form of the same name in the 
Organizational Form Library.

NOTE: For additional deployment options for the Outlook template and email form, 
contact your administrator for Microsoft Outlook and Microsoft Exchange Server.

The Siebel email form for Microsoft Outlook, IPM.Note.Siebel, is contained within 
the Outlook template file Siebel7Outlook.oft.

You can rename the default email form when you publish it, or publish additional 
Siebel forms based on the default. If you do either of these, make sure that the 
names of all supported Siebel forms are included in the List of Values type for the 
Siebel/Outlook Form drop-down list, located in the Outbound Communications 
view of the User Preferences screen.

To specify a custom form as a global default, then you must also specify its name 
using the Siebel/Outlook Form server component parameter or the OutlookForm 
configuration file parameter, as described in Table 81 on page 557.

To install the Siebel email form for Microsoft Outlook

1 Locate the Outlook template file Siebel7Outlook.oft on the server or client 
installation CD-ROM, as described in “Locations of Source Files for Siebel Email 
Forms” on page 546.

2 Optionally, you may choose to copy this file to the clipboard, and paste it 
somewhere on the network before continuing.

3 Publish the email form to the Organizational Form Library on Microsoft 
Exchange Server, or to the Personal Form Library on a local client machine:

a On the server machine or on the client machine, double-click the template 
file Siebel7Outlook.oft.

b At the prompt, specify Enable Macros.

c In Microsoft Outlook, choose Tools > Forms > Publish Form As.
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d From Look In, choose Organizational Form Library (for installation on the 
Exchange Server machine) or choose Personal Form Library (for installation 
on a client machine).

e Specify the display name “Siebel” for this form, then save the form.

The actual name of the email form is IPM.Note.Siebel.

f At the prompt, specify not to send the form definition to email recipients.

g Close the Outlook window without saving a message draft.

The Outlook email form is now ready to be used.

To finish configuring your use of Microsoft Outlook, go to “Overview of Completing 
Email Client Configuration.”

Overview of Completing Email Client Configuration
In order to configure third-party email integration using Lotus Notes or Microsoft 
Outlook, several parameter values must be set appropriately, according to your 
Siebel client deployment:

■ For Siebel Web Client deployments, configuration is on the Application Object 
Manager.

■ For Siebel Mobile Web Client and Dedicated Web Client deployments, 
configuration is in Siebel client’s configuration file.

For more information about setting parameters for Siebel Server, including 
specifying component parameters using the Server Manager (Siebel client or 
command-line), refer to Siebel Server Administration Guide.

For more information about specifying Siebel client parameters in the configuration 
file, refer to Siebel Web Client Administration Guide.

Completing Configuration for Lotus Notes
This section describes the remaining steps for configuring the Siebel software to use 
Lotus Notes for the Send Email command.
550 Siebel Communications Server Administration Guide Version 7.5.3



Using Email, Fax, and Other Systems

Configuring Client-Side Integration for Send Email
To complete configuration for Lotus Notes email client

1 Set the following parameters to TRUE in the configuration file on the client or 
Siebel Server, such as uagent.cfg for Siebel Call Center.

These parameters, for the Siebel Web Engine, are located in the [SWE] section 
of the configuration file. By default, these parameters are FALSE.

■ EnableWebClientAutomation. Allows the Siebel Web automation object to be 
downloaded.

■ EnableEmailClientAutomation. Allows the Siebel email automation object, 
named MailClient, to be downloaded. 

The MailClient object is downloaded from the ActiveX file 
SiebExtMailClient.cab. This .cab file is located in the 
public\language_code\build_num\applets directory for the Siebel Server or 
Siebel Dedicated Client installation, where language_code is the current 
language and build_num is the installed software’s build number.

2 As appropriate, specify a global default designating Lotus Notes as the email 
client your users will use for the Send Email command. Specify one of the 
following:

■ Default Email Client. For Siebel Web Client deployments, specify this as a 
component parameter for the Application Object Manager.

■ DefaultMailClient. For Siebel Mobile Web Client or Dedicated Web Client 
deployments, specify this parameter in the [EMail] section of the local 
configuration file, such as uagent.cfg for Siebel Call Center.

For more information, see “Email Client Parameters” on page 555.

3 Specify a global default designating Siebel Memo as the name of the email form 
you will use with Lotus Notes. Specify one of the following:

■ Siebel/Lotus Form. For Siebel Web Client deployments, specify this as a 
component parameter for the Application Object Manager.
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■ LotusForm. For Siebel Mobile Web Client or Dedicated Web Client 
deployments, specify this parameter in the [EMail] section of the local 
configuration file, such as uagent.cfg for Siebel Call Center.

For more information, see “Email Client Parameters” on page 555.

4 Specify a global default specifying where email attachments will be temporarily 
stored. Specify one of the following:

■ Email Temporary Attachment Location. For Siebel Web Client deployments, 
specify this as a component parameter for the Application Object Manager.

■ SiebelExtMailClientAttDir. For Siebel Mobile Web Client or Dedicated Web 
Client deployments, specify this parameter in the [EMail] section of the local 
configuration file, such as uagent.cfg for Siebel Call Center.

For more information, see “Creating and Configuring the Attachments 
Directory” on page 544 and “Email Client Parameters” on page 555.

5 As appropriate for your deployment, end users may specify Siebel user 
preference settings for their email client. Users may set user preferences, for 
example, if you are supporting more than one email client option for Send Email.

Setting user preferences overrides the corresponding global defaults specified 
using the Default Email Client or Siebel/Lotus Form parameters, described in 
Table 81 on page 557. The global defaults are used if no user preference has been 
set.

Applicable user preferences in the Send Email section of the Outbound 
Communications view of the User Preferences screen include:

■ Email Client. Set this to Lotus Notes.

■ Siebel/Lotus Form. Set this to Siebel Memo.

For more information, see “Preference Settings in the Outbound 
Communications Tab” on page 347.

Completing Configuration for Microsoft Outlook
This section describes the remaining steps for configuring the Siebel software to use 
Microsoft Outlook for the Send Email command.
552 Siebel Communications Server Administration Guide Version 7.5.3



Using Email, Fax, and Other Systems

Configuring Client-Side Integration for Send Email
To complete configuration for Microsoft Outlook email client

1 Set the following parameters to TRUE in the configuration file on the client or 
Siebel Server, such as uagent.cfg for Siebel Call Center.

These parameters, for the Siebel Web Engine, are located in the [SWE] section 
of the configuration file. By default, these parameters are FALSE.

■ EnableWebClientAutomation. Allows the Siebel Web automation object to be 
downloaded.

■ EnableEmailClientAutomation. Allows the Siebel email automation object, 
named MailClient, to be downloaded. 

The MailClient object is downloaded from the ActiveX file 
SiebExtMailClient.cab. This .cab file is located in the 
public\language_code\build_num\applets directory for the Siebel Server or 
Siebel Dedicated Client installation, where language_code is the current 
language and build_num is the installed software’s build number.

2 As appropriate, specify a global default designating Microsoft Outlook as the 
email client your users will use for the Send Email command. Specify one of the 
following:

■ Default Email Client. For Siebel Web Client deployments, specify this 
parameter for the Application Object Manager.

■ DefaultMailClient. For Siebel Mobile Web Client or Dedicated Web Client 
deployments, specify this parameter in the [EMail] section of the local 
configuration file, such as uagent.cfg for Siebel Call Center.

For more information, see “Email Client Parameters” on page 555.

3 Specify a global default designating IPM.Note.Siebel as the name of the email 
form you will use with Microsoft Outlook. Specify one of the following:

■ Siebel/Outlook Form. For Siebel Web Client deployments, specify this 
parameter for the Application Object Manager.
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■ OutlookForm. For Siebel Mobile Web Client or Dedicated Web Client 
deployments, specify this parameter in the [EMail] section of the local 
configuration file, such as uagent.cfg for Siebel Call Center.

For more information, see “Email Client Parameters” on page 555.

4 Specify a global default specifying where email attachments will be temporarily 
stored. Specify one of the following:

■ Email Temporary Attachment Location. For Siebel Web Client deployments, 
specify this as a component parameter for the Application Object Manager.

■ SiebelExtMailClientAttDir. For Siebel Mobile Web Client or Dedicated Web 
Client deployments, specify this parameter in the [EMail] section of the local 
configuration file, such as uagent.cfg for Siebel Call Center.

For more information, see “Creating and Configuring the Attachments 
Directory” on page 544 and “Email Client Parameters” on page 555.

5 As appropriate for your deployment, end users may specify Siebel user 
preference settings for their email client. Users may set user preferences, for 
example, if you are supporting more than one email client option for Send Email.

Setting user preferences overrides the corresponding global defaults specified 
using the Default Email Client or Siebel/Outlook Form parameters, described in 
Table 81 on page 557. The global defaults are used if no user preference has been 
set. 

Applicable user preferences in the Send Email section of the Outbound 
Communications view of the User Preferences screen include:

■ Email Client. Set this to Microsoft Outlook.

■ Siebel/Outlook Form. Set this to IPM.Note.Siebel.

For more information, see “Preference Settings in the Outbound 
Communications Tab” on page 347.
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Email Client Parameters
The parameters described in Table 81 on page 557 specify settings applicable to 
your client-side email integration. Set these parameters either as server component 
parameters or as parameters in the [EMail] section of the configuration file, as noted 
in the previous section.
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For more information about user preferences mentioned here, see “Preference 
Settings in the Outbound Communications Tab” on page 347.
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Table 81. Email Client Parameters

Component Parameter for 
Application Object Manager

Parameter in [EMail] 
Section of Configuration File Description

Default Email Client DefaultMailClient Set to one of the following:

■ Siebel Mail Client

■ Lotus Notes

■ Microsoft Outlook

Corresponds to the Outbound Communications 
user preference Email Client. The parameter 
setting is in effect unless it is overridden by this 
user preference.

If the value is either Lotus Notes or Microsoft 
Outlook, then the name of the applicable email 
form must also be specified.

The default value is Siebel Mail Client.
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Email Client Debug Level DebugLevel Specifies the level of debugging information to 
be logged when Lotus Notes or Microsoft 
Outlook is used for Send Email.

Set it to one of the following:

■ 0 – No logging will occur for the email client.

■ 1 – Logging will occur for ActiveX and 
JavaScript (Siebel eScript) associated with 
the email client. Debugging information is 
logged to the file siebelmail.log on each 
user’s desktop.

The siebelmail.log file tracks the execution of 
scripts associated with the Notes or Outlook 
form.

When this parameter is set to 1, note also:

■ For Microsoft Outlook, the file siebelmail.log 
is overwritten for each new email message 
that is sent. Additional debugging data is 
emailed to the sender, with a subject line in 
the form SiebelDebugLog_activity_ID.

■ For Lotus Notes, additional debugging data is 
logged to the file SiebelEmaildbg.log.

Note: You should set this parameter to 1 for a 
development or test environment only. For a 
production environment, set it to 0.

Table 81. Email Client Parameters

Component Parameter for 
Application Object Manager

Parameter in [EMail] 
Section of Configuration File Description
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Email Temporary 
Attachment Location

SiebelExtMailClientAttDir Specifies the name of the directory to be used to 
temporarily store email attachments. Specify the 
name in the following general form (entered on 
one line):

clientpath;serverpath

where clientpath identifies the server machine 
and path to the attachments directory, as 
accessed from client machines, and serverpath 
identifies the same directory as accessed from the 
server itself.

■ If the server machine is running Microsoft 
Windows, then the two elements defined 
here should be identical. For example:

\\servername\attachment;
\\servername\attachment

■ If the server machine is running on a 
supported UNIX platform, then the left 
element represents how Windows clients 
access the directory, while the right element 
represents the path on the UNIX server 
machine itself. For example:

\\aixhost\attachment;
/export/user/attachment

■ For Siebel Mobile Web Client deployments on 
Microsoft Windows platforms, a local 
attachments directory is required if users will 
operate the Siebel application while 
disconnected from the network. The two 
elements defined here should be identical. 
For example:

C:\temp;C:\temp

For more information, see “Creating and 
Configuring the Attachments Directory” on 
page 544.

Table 81. Email Client Parameters

Component Parameter for 
Application Object Manager

Parameter in [EMail] 
Section of Configuration File Description
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Other Communications Drivers
This section describes the parameters for the following communications drivers 
provided by Siebel Systems.

■ The Push Keep Alive communications driver provides a heartbeat message that 
is useful in maintaining connections for your communications sessions in some 
environments.

For more information, see “Using Push Keep Alive Driver for Session 
Connections” on page 232.

Siebel/Lotus Form LotusForm Specifies the name of the email form to use as a 
global default, when Lotus Notes is used as the 
email client. Typically, this parameter should be 
set to Siebel Memo.

Corresponds to the Outbound Communications 
user preference Siebel/Lotus Form. The 
parameter setting is in effect unless it is 
overridden by this user preference.

For more information, see “About Installing the 
Siebel Email Form” on page 545.

Siebel/Outlook Form OutlookForm Specifies the name of the email form to use as a 
global default, when Microsoft Outlook is used 
as the email client. Typically, this parameter 
should be set to IPM.Note.Siebel.

Corresponds to the Outbound Communications 
user preference Siebel/Outlook Form. The 
parameter setting is in effect unless it is 
overridden by this user preference.

For more information, see “About Installing the 
Siebel Email Form” on page 545.

Table 81. Email Client Parameters

Component Parameter for 
Application Object Manager

Parameter in [EMail] 
Section of Configuration File Description
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■ The Modem-based TAP Paging communications driver is a feature of Siebel 
Paging.

NOTE: Siebel Paging is included with all base applications of the Siebel eBusiness 
Applications. The module Siebel Wireless Messaging is available as an 
alternative to Siebel Paging.

■ The FTP communications driver is used by Siebel Marketing to send contact lists 
to vendors who are contracted to execute campaigns. It can also be used to send 
outbound communication requests from any Siebel application. For more 
information about Siebel Marketing, refer to Siebel Marketing Guide.

For more information about communications drivers, see “About Communications 
Drivers and Profiles” on page 53 and “Configuring Communications Drivers and 
Profiles” on page 68.
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Push Keep Alive Driver Parameters
Table 82 lists the supported parameters for the Push Keep Alive communications 
driver. The channel type for this driver is Keep-Alive.

Table 82. Push Keep Alive Driver Parameters

Name Required Default Value Description

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more 
detailed.

LogFile No push_{@UserName}.log The name of the file where logging 
information will be written. If this parameter 
is empty, no log file is generated. Logging data 
is always appended to this file.

Log files are created in the log subdirectory of 
the Siebel Server or Siebel Dedicated Web 
Client installation directory, depending on the 
client type and on your communications 
deployment.

Optionally, if you want to use a single log file 
in a multichannel environment, you can 
specify the same log file name for all 
interactive drivers you are using.

MaxLogKB No 128 Specifies the maximum size of the log file, in 
kilobytes (KB).

When the log file is full, it is emptied 
completely, then logging begins again.
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Modem-based TAP Paging Driver Parameters
Table 83 on page 564 lists the supported parameters for the Modem-based TAP 
Paging communications driver. This driver supports the TAP (Telocator 
Alphanumeric Paging) protocol. The channel type for this driver is Page.

Error messages received when using CommOutboundMgr with the Modem-based 
TAP Paging communications driver may include:

PushKeepAliveTimer Yes 0 Specifies the interval, in seconds, for the 
heartbeat message sent by the Keep Push 
Alive driver to the Application Object 
Manager. and to each agent’s Web browser.

For example, if this parameter is set to 180, 
then the heartbeat message is sent every 180 
seconds.

The default value, 0, specifies that no 
heartbeat message is sent.

Typically, this parameter would be defined as 
a parameter override in a driver profile that 
has been associated with the communications 
configuration.

ReleaseLogHandle No TRUE Indicates that the log file handle for each agent 
should be released periodically, after logs have 
been generated.

Performance for agent sessions can be 
improved by setting this parameter to FALSE. 
This may be most effective if LogDebug is also 
FALSE, because logging is less intensive.

When ReleaseLogHandle is FALSE, however, 
some log files may not be generated if the 
number of concurrent users exceeds the file-
handle capacity provided by the operating 
system.

Table 82. Push Keep Alive Driver Parameters

Name Required Default Value Description
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■ Unable to connect to the paging host system. The phone line may 
be busy or the phone number may be invalid.

Check the paging phone number the modem is dialing, including area code. 
Check if “9” is included, as may be required.

■ Unable to open the communication port.

Verify the communications settings for your system.

■ Error communication profile profile_name for CommSrvr paging.

An error has occurred using a specific profile (shown here as profile_name) for 
the communications driver Modem-based TAP Paging. Verify that driver and 
profile parameter values are defined appropriately for your system.

Table 83. Modem-based TAP Paging Driver Parameters

Name Required Default Value Description

Dial Prefix No 9 The prefix for outbound dialing.

Local Area Code No The area code of the phone line used for sending pages.

There is no default value for this parameter, but a value 
must be specified at the customer site in order to dial 
local numbers successfully.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more detailed.

Log files are created in the log subdirectory of the Siebel 
Server installation directory.

Long Distance Prefix No 1 The long-distance prefix to add to long-distance calls.

Modem Dial String No ATDT The modem command for dialing a phone number.

Modem Hangup String No ATH The modem command for hanging up.
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FTP Driver Parameters
Table 84 on page 566 lists the supported parameters for the FTP communications 
driver. This driver supports FTP (File Transfer Protocol). The channel type for this 
driver is FTP.

In order to send files using the FTP driver, note the following requirements:

Modem Init String No AT&FQ0V1 The modem command for initializing the modem.

The default value may need to be changed to work with 
different modems. For example, some modems expect a 
numeric value such as “AT&F1Q0V1” after the “&F” 
string. Consult your modem’s manual for valid modem 
commands and values.

You may need to add other commands to initialize your 
modem properly. For example, you may need to turn off 
any compression or speed-enhancing features on your 
modem. Consult your modem’s manual for more 
information.

Modem Port No COM1 The computer’s communications port to which the 
modem is attached.

The exact value for Modem Port is dependent on the 
platform and on the specific devices.

For example, for Solaris, you can use:

/dev/cua/a

For AIX, you can use:

/dev/tty1

Modem Reset String No ATZ The modem command for resetting the modem.

Modem Restore String No AT&F The modem command for restoring the default settings 
of the modem.

Siebel Server No The name of the Siebel Server that is to handle the 
delivery of the communications.

For more information, see “Administering 
Communications Outbound Manager” on page 333.

Table 83. Modem-based TAP Paging Driver Parameters

Name Required Default Value Description
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■ The name of the FTP server machine (such as a vendor’s FTP server) to which 
the files will be sent using FTP must be identified in the hosts file (or equivalent) 
on the Siebel Server machine.

■ The user specified in the profile for the FTP driver, by using the Username and 
Password parameters, must be defined as a user locally on the FTP server to 
which the files will be sent using FTP.

Table 84. FTP Driver Parameters

Name Required Default Value Description

Filename No The name of a specific file that is to be uploaded every 
time the profile for this driver is used.

Hostname No The host name of the machine to which the FTP 
connection will be established.

Note: Either Hostname or IP Address must be defined for 
any profile created for this driver.

IP Address No The IP address of the machine to which the FTP 
connection will be established.

Note: Either Hostname or IP Address must be defined for 
any profile created for this driver.

LogDebug No FALSE TRUE or FALSE

If TRUE, data output to the log file is more detailed.

Log files are created in the log subdirectory of the Siebel 
Server installation directory.

Password Yes The password for the user account that is accessing the 
FTP server.

Port No 21 The port used by the FTP server.

Siebel Server No The name of the Siebel Server that is to handle the delivery 
of the communications.

For more information, see “Administering 
Communications Outbound Manager” on page 333.

Username Yes The login name for the account that is accessing the FTP 
server.
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This chapter provides developer guidelines for writing a communications driver 
using the Siebel Adaptive Communications application programming interface. It 
also describes the methods, data types, and constants for the Siebel Adaptive 
Communications API.

Required Skills for Adaptive Communications Developer
In order to develop an interface to Adaptive Communications, it is recommended 
that you understand:

■ The Siebel product from an end-user standpoint and from a development 
standpoint

■ Communications concepts and event-handling model

■ Technologies and development tools for the languages C++ or C

NOTE: Siebel Professional Services may be engaged to provide guidance and support 
in the development of custom communications drivers using Adaptive 
Communications. Custom communications drivers are to be supported and 
maintained by their originators. Siebel Systems is not liable in any way for custom 
communications drivers.

Driver Issues for Version 7.5
Communications drivers from version 7.0.x of the Siebel eBusiness Applications 
will not work as is with version 7.5.x, unless you follow the guidelines in this 
section. Version 7.5.x requires version 2 of the Siebel Adaptive Communications 
API.
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Requirements are different for each supported platform:

■ All existing driver vendors must compile the driver using the current version of 
the API. The version 7.0.x communications driver cannot work with version 
7.5.x of the Siebel eBusiness Applications, due to version checking.

■ For a communications driver for Microsoft Windows platforms, it is not 
necessary to change the code. It is necessary only to recompile.

■ For a communications driver for IBM AIX platforms, it is not necessary to change 
the code. It is necessary only to recompile.

■ For a communications driver for Sun Solaris platforms, it is necessary to make 
changes to the driver code and to recompile. Version 7.0.x used UCS4 for Solaris, 
but version 7.5 uses UTF16 (to support Unicode). This change requires that the 
driver code be modified.

Adaptive Communications Design
Siebel Adaptive Communications is a programmable software layer between Siebel 
applications and the external communications system that a communications driver 
is written to support, such as a CTI middleware package or email server.

The Adaptive Communications layer has two main parts:

■ The client handle, which is how the communications driver can access 
functionality in the Siebel application

■ The communications driver (encompassing the driver handle and the service 
handle), through which communications pass between the Siebel application 
and the external communications system

Communications Drivers
Communications drivers can be provided by Siebel Systems or developed by others:
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■ Siebel Systems provides communications drivers for use with Dialogic 
CT Connect, standard email servers that support SMTP and POP3, wireless 
messaging using SMS or WAP Push, FTP, and other systems.

For driver parameter, command, and event details for each driver provided by 
Siebel Systems, see Appendix A, “Using Siebel CTI Connect,” and Appendix C, 
“Using Email, Fax, and Other Systems.” For information about third-party 
product support, refer to Siebel System Requirements and Supported Platforms 
for your Siebel applications.

■ Siebel customers and vendors of CTI middleware, email servers, and so on, can 
use Adaptive Communications to write custom drivers to support other 
communications systems.

To find out about communications drivers created by other vendors, refer to the 
Alliances page on the Siebel Web site, http://www.siebel.com.

Drivers can be created that will run on Microsoft Windows or on UNIX platforms. 
For example, drivers on Microsoft Windows may be Dynamic Link Libraries (DLL 
files), or drivers on UNIX platforms may be shared object (.so) files. Or, drivers may 
be created as other types of files than these, such as executable files.
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Adaptive Communications Architecture
The communications flow among the elements of Adaptive Communications is 
shown in Figure 3. As shown, the implementations of the driver handle and the 
service handle together make up the communications driver, along with any other 
program data and logic built into the driver.

The channel manager initializes the implementation object for the driver handle, 
which in turn initializes the implementation object for the service handle.

Multiple instances of the client handle and service handle implementation objects 
may be initialized, such as for each interactive agent session, depending on the 
driver implementation and on the client deployment.

For an overview of the entire communications system, see “About Communications 
Server Architecture” on page 33.

Event and Command Model
Siebel Adaptive Communications, when it is used to write interactive drivers such 
as those used with CTI middleware, uses the concept of events and commands.

Figure 3. Adaptive Communications Architecture
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For more information about interactive drivers, see “Interactive Drivers” on 
page 64.

■ A command is a feature of the communications driver that can execute a 
particular function, such as on an external system like a telephone switch.

Usually, the command, such as a request from the Siebel client to make a call or 
send a message, is executed with parameters whose values contain associated 
data, such as the number to call. The communications driver passes the 
command and associated data to the communications system for execution.

■ An event is a notification of a communications occurrence that the Siebel client 
receives from the communications driver along with some data fields—such as 
notification of an incoming work item, with associated data such as a caller’s 
telephone number (ANI).

Once you have written a communications driver, you configure Siebel 
Communications Server, as described in Chapter 3, “Configuring Session 
Communications,” and Chapter 4, “Configuring Events and Commands.”

Events and commands you define in the Communications Administration views 
must be based on what the interactive communications driver supports. 
Commands, command parameters, events, and event data fields will vary among 
communications drivers, just as they vary among vendors of communications 
systems, such as CTI middleware vendors.

You can retrieve driver parameter values from the Siebel database. Storing the 
parameters you need in the Siebel database allows the administrator to set 
parameter values appropriately for your communications driver.

You can write a communications driver to support the driver parameters you 
require. If you have created a custom driver to function in place of a Siebel-provided 
driver, you must then create all the driver parameters in the Communications 
Administration views and assign values to them. If you have created a custom driver 
as an aggregate driver, to extend a Siebel-provided driver, then you can use 
parameters defined by Siebel Systems.

The communications driver and the Siebel system software, such as Siebel business 
services and server components, work together to implement the desired 
communications behavior for the Siebel application.
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Initialization of Communications Drivers
Driver initialization may involve initializing two handles for each communications 
driver implementation: ISC_DRIVER_HANDLE (the driver handle) and 
ISC_SERVICE_HANDLE (the service handle).

For drivers loaded on a Siebel Server machine, the driver handle would typically be 
initialized only once, rather than once for each agent session. This depends on your 
driver implementation.

The driver handle and service handle can be implemented in any appropriate 
language, but must be implemented together using the same language.

Loading Communications Drivers
The process of loading a communications driver is as follows:

1 The channel manager invokes the driver handle method APIVersion, to check 
the driver’s API version. The API version defined in the driver’s header file must 
match the API version for Communications Server. See “APIVersion” on 
page 586.

2 The channel manager invokes the driver handle method 
CreateISCDriverInstance, to create the driver instance. The channel string 
passed to this method is collected from the driver record that is created in the 
Communications Drivers and Profiles view, in the Communications 
Administration screen. See “CreateISCDriverInstance” on page 586.

3 The channel manager invokes the driver handle method 
RequestCommandEventList, to retrieve the list of events and commands this 
driver supports. See “RequestCommandEventList” on page 588.

4 The channel manager invokes the driver handle method RequestService, to 
create a service object. See “RequestService” on page 588.

If any step listed above fails, the driver loading fails. If multiple driver profiles must 
be loaded, the above process is repeated for each profile.

ISC_DRIVER_HANDLE
During initialization of an interactive communications driver, the 
CreateISCDriverInstance method is called to create the driver handle. 
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This method uses driver and profile parameter data (parameters prefaced with 
“Driver:” or parameters without a prefacing keyword) from the communications 
configuration, specified in the Communications Drivers and Profiles view. 

For more information about the CreateISCDriverInstance method, see 
“CreateISCDriverInstance” on page 586.

ISC_SERVICE_HANDLE
After the driver handle has been created, the driver handle method RequestService 
is invoked, to request the driver handle to provide a service. Driver parameters 
(parameters prefaced with “Service:” or parameters without a prefacing keyword) 
are passed, which were specified in the Communications Drivers and Profiles view.

In response to this request, the driver handle returns the service handle 
(ISC_SERVICE_HANDLE), one instance for each agent. Calling methods of the 
service handle makes the feature set of the communications system available.

The driver handle and service handle together make up the implementation of the 
communications driver, along with other program data and logic.

Your implementation of the service handle invokes methods of the client handle, 
ISC_CLIENT_HANDLE. The client handle is implemented by Siebel Systems.

For more information about the RequestService method, see “RequestService” on 
page 588.

Driver Parameters and Initialization
For the drivers provided by Siebel Systems, each driver parameter may be prefaced 
with a keyword indicating how it will be used. Driver parameters defined for custom 
Adaptive Communications drivers can also follow this scheme for controlling how 
parameters are used.

■ Parameters prefixed with “Driver:” are sent (with the prefix “Driver:” removed) 
to the driver handle when the driver is being initialized. These parameters are 
sent to the CreateISCDriverInstance method. (This applies to the Dialogic CTI 
driver provided by Siebel Systems.)
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■ Parameters prefaced with “Service:” are sent (with the prefix “Service:” 
removed) to the driver handle when it requests a service (creates the service 
handle). These parameters are sent to the RequestService method. (This applies 
to the Dialogic CTI driver provided by Siebel Systems.)

■ Parameters that are not prefixed with either “Driver:” or “Service:” (as is the 
case for most of the drivers provided by Siebel Systems) are sent to the driver 
handle when the driver is being initialized (CreateISCDriverInstance method), 
and also when the driver handle requests a service (RequestService method).

Driver Event Attributes
Table 85 on page 574 lists event attributes that are included by the channel manager 
for all events processed by the client handle method HandleEvent. These attributes 
apply to any communications driver that invokes the client handle method 
HandleEvent—whether for drivers provided by Siebel Systems or custom drivers 
developed by customers or by other vendors.

You can use these attributes with event handler definitions in communications 
configurations. For more information, see “Event Handlers” on page 146. See also 
“Work Item Attributes” on page 208.

The event attributes described in Table 85 are also available for workflows used in 
processing inbound communications.

For more information about the HandleEvent client handle method, see 
“HandleEvent” on page 584.

Table 85. Driver Event Attributes

Attribute Name Description

SiebelChannelProfile The name of the applicable profile for the driver.

SiebelChannelType The language-independent value of the channel type.

SiebelChannelTypeString The channel string defined for the driver.

SiebelDriverEventName The device event name as known by the driver.
574 Siebel Communications Server Administration Guide Version 7.5.3



Developing a Communications Driver

Siebel Adaptive Communications API Reference
For events received for each interactive driver, additional data is received as event 
data fields. For more information about the events and event data fields for 
interactive drivers provided by Siebel Systems, see Appendix A, “Using Siebel CTI 
Connect.”

Siebel Adaptive Communications API Reference
This section provides a reference for the methods supported by the Adaptive 
Communications application programming interface. Siebel Adaptive 
Communications is a programmable software layer between Siebel applications and 
the communications system.

For more information for developing a communications driver using Siebel Adaptive 
Communications, see “Adaptive Communications Design” on page 568.

This section describes the client, driver, and service handles and the constants used 
by Adaptive Communications; and describes the methods for these handles.

SiebelDriverNotifyWhenDone The setting of whether the driver requests notification from the client 
when event-handling is done.

The client handle method HandleEvent includes the parameter 
notifyWhenDone, which is used to request the client to notify the driver 
when the client has finished handling the event.

The client notifies the driver that event handling is done by using the 
service handle method NotifyEventHandlingFinished.

SiebelWorkItemID The unique work item ID, a value in the form 
profile_ID##driver_tracking_ID, where profile_ID is the ID of the driver 
profile and driver_tracking_ID is the work item’s tracking ID, as known by 
the driver.

For example, if the ID of the driver profile is 12-01234, and the driver uses 
the tracking ID "abcdefg” for this work item, then “12-01234##abcdefg” is 
the value of SiebelWorkItemID for this work item.

Table 85. Driver Event Attributes

Attribute Name Description
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Handles for Adaptive Communications
The Adaptive Communications layer includes a set of constants and the three 
handles described in the following paragraphs. The syntax with which each 
Adaptive Communications method is expressed is that of a C header file. In the 
handle names below, ISC stands for “interface for Siebel communications.”

For more information about these handles, see “Adaptive Communications Design” 
on page 568.

■ ISC_CLIENT_HANDLE. The client handle, which provides methods called by the 
communications driver. Siebel Systems has implemented ISC_CLIENT_HANDLE 
and its methods.

For descriptions of the client handle methods, see “Methods of 
ISC_CLIENT_HANDLE” on page 582.

■ ISC_DRIVER_HANDLE. The driver handle, which is created when communications 
are initialized (for example, when the first user logs in). ISC_DRIVER_HANDLE 
then creates ISC_SERVICE_HANDLE, from which services are requested. 
Customers writing communications drivers must implement methods of the 
driver handle.

For descriptions of the driver handle methods, see “Methods of 
ISC_DRIVER_HANDLE” on page 586.

■ ISC_SERVICE_HANDLE. The service handle, which is created by 
ISC_DRIVER_HANDLE when communications are initialized (for example, 
when a user logs in). The Siebel client calls ISC_SERVICE_HANDLE methods in 
order to perform actual communications functions. Customers writing 
communications drivers must implement methods of the service handle.

For descriptions of the service handle methods, see “Methods of 
ISC_SERVICE_HANDLE” on page 589.

Constants for Communications Drivers
Each of the following elements enumerates one or more constants. Values for all 
fields are stored when information about objects is passed back and forth between 
the Siebel software and the communications driver.
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For example, object information is passed in this manner when the client handle 
method UpdateObjectInformation is invoked. See “UpdateObjectInformation” on 
page 585.

SCCommandFlag
Communications commands have dynamic or runtime status, consisting of the bit-
flags enumerated by SCCommandFlag. Zero or more bit-flags can apply to a given 
command at any given time.

NOTE: In developing a driver, specify the names of the status flags, such as 
SC_CF_DISABLED, SC_CF_BLINKING, and so on, rather than the integer values.

enum SCCommandFlag
{

SC_CF_NOTSUPPORTED = 1,
SC_CF_DISABLED = 2,
SC_CF_CHECKED = 4,
SC_CF_BLINKING = 8,
SC_CF_NOPARAMSOK = 16,
SC_CF_STRPARAMSOK = 32

};

Each bit-flag that can be associated with a command is described below:

■ SC_CF_NOTSUPPORTED – The command is not supported.

■ SC_CF_DISABLED – The command is supported, but is disabled at this time.

■ SC_CF_CHECKED – The command is in a “checked” state—for example, when 
an agent is in Not Ready mode, the command to set the Not Ready state will be 
checked. This flag can be used to specify a toggle state for commands in the 
communications toolbar or in the Communications submenu of the View 
application-level menu.

■ SC_CF_BLINKING – Blinking is enabled for communications toolbar buttons, 
such as those for the Accept Work Item and Resume Work Item commands. 

■ SC_CF_NOPARAMSOK – The command does not require any parameters to 
execute. For example, the commands for releasing a call and for toggling the Not 
Ready state do not require parameters.
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■ SC_CF_STRPARAMSOK – The command can be executed by providing a single 
unnamed string parameter (no named parameter is provided). The command for 
placing a call, for example, requires only a single parameter. Such commands are 
invoked when the user types something in the input field in the communications 
toolbar—such as an extension number—and clicks the command’s button.

NOTE: If a device command’s status excludes SC_CF_NOTSUPPORTED or 
SC_CF_DISABLED bit flags, then the command is considered enabled.

SCCommandTypeEx
Communications commands can be specified using either the InvokeCommand or 
InvokeCommandEx methods of the service handle. The values enumerated by 
SCCommandTypeEx specify the command type for an invocation of the 
InvokeCommandEx method. See “InvokeCommandEx” on page 590.

NOTE: In developing a driver, specify the names of the command types, such as 
SC_CT_MAKECALL, rather than the integer values.

enum SCCommandTypeEx
{

SC_CT_MAKECALL = 1,
SC_CT_SENDMESSAGE = 2

};

Each command type is described below:

■ SC_CT_MAKECALL – The command to be invoked is a command for placing a 
phone call. The InvokeCommandEx command includes predefined parameters 
concerning the phone call to be made.

■ SC_CT_SENDMESSAGE – The command to be invoked is a command to send an 
email message. The InvokeCommandEx command includes predefined 
parameters concerning the email message to be sent.
578 Siebel Communications Server Administration Guide Version 7.5.3



Developing a Communications Driver

Siebel Adaptive Communications API Reference
SCErrorCode
The values enumerated by SCErrorCode specify predefined error codes. The error 
codes from 0 to 1000 are reserved.

NOTE: In developing a driver, specify the names of the error codes, such as 
SC_EC_OK, SC_EC_ERROR, and so on, rather than the integer values.

enum SCErrorCode
{

SC_EC_OK = 0,
SC_EC_ERROR = 1,
SC_EC_CMD_NOT_SUPPORTED = 2,
SC_EC_MEDIA_TYPE_NOT_SUPPORTED = 3,
SC_EC_INVALID_HANDLE = 4,
SC_EC_OUT_OF_MEMORY = 5,
SC_EC_NETWORK_ERROR = 6,
SC_EC_LIB_LOAD_ERR = 7,
SC_EC_FUNC_NOT_RESOLVED = 8,
SC_EC_DRIVER_CREATION_ERR = 9,
SC_EC_DRIVER_RELEASE_ERR = 10,
SC_EC_SERVICE_CREATION_ERR = 11,
SC_EC_SERVICE_RELEASE_ERR = 12,
SC_EC_INVALID_ITEM_TRACKING_ID = 13,
SC_EC_CLIENT_INTERFACE_ERR = 14,
SC_EC_SENDMSG_FAILED_RETRY = 15,
SC_EC_IMPOBJ_CREATE_ERR = 16,
SC_EC_INVALID_LICENSE = 17,
SC_EC_WORK_ITEM_WRONG_STATE = 18,
SC_EC_DRIVER_SPECIFIC = 1000

};

Each error code is described below:

■ SC_EC_OK – The operation is successful.

■ SC_EC_ERROR – The operation failed.

■ SC_EC_CMD_NOT_SUPPORTED – The command is not supported.

■ SC_EC_MEDIA_TYPE_NOT_SUPPORTED – The channel type string is not 
recognized.

■ SC_EC_INVALID_HANDLE – Invalid handle.
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■ SC_EC_OUT_OF_MEMORY – Out of memory.

■ SC_EC_NETWORK_ERROR – Networking error.

■ SC_EC_LIB_LOAD_ERR – Failure on loading the driver file.

■ SC_EC_FUNC_NOT_RESOLVED – Failure on resolving function address while 
invoking the command.

■ SC_EC_DRIVER_CREATION_ERR – Failure on creating the driver handle.

■ SC_EC_DRIVER_RELEASE_ERR – Failure on releasing the driver handle.

■ SC_EC_SERVICE_CREATION_ERR – Failure on creating the service handle.

■ SC_EC_SERVICE_RELEASE_ERR – Failure on releasing the service handle.

■ SC_EC_INVALID_ITEM_TRACKING_ID – Invalid tracking ID.

■ SC_EC_CLIENT_INTERFACE_ERR – Failure on invoking the ISC_CLIENT 
interface.

■ SC_EC_SENDMSG_FAILED_RETRY – SC_CT_SENDMESSAGE failed, please 
resend later.

■ SC_EC_IMPOBJ_CREATE_ERR – Unable to create the underlying 
implementation object.

■ SC_EC_INVALID_LICENSE – License error—used by the driver to report its 
license checking.

■ SC_EC_WORK_ITEM_WRONG_STATE – The work item is in the wrong state for 
the operation.

■ SC_EC_DRIVER_SPECIFIC – Specify for driver.

SCObjectProperty
Properties of monitored communications objects.

NOTE: In developing a driver, specify the names of the object properties, such as 
SC_OP_ONOFF, SC_OP_AGENTID, and so on, rather than the integer values.
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enum SCObjectProperty
{

SC_OP_ONOFF = 1,
SC_OP_AGENTID = 2,
SC_OP_ISNOTREADY = 4,
SC_OP_ISBUSY = 5,
SC_OP_DESCRIPTION = 7,
SC_OP_TIMEINQUEUE = 9,
SC_OP_QUEUEID = 12,
SC_OP_ISLOGON = 13

};

Each object property is described below:

■ SC_OP_ONOFF – A Boolean value indicating whether teleset control is on or off.

■ SC_OP_AGENTID – The ID number of an agent, for an agent or DN that is being 
monitored.

■ SC_OP_ISNOTREADY – A Boolean value indicating whether an agent has set the 
Not Ready state, for an agent or DN that is being monitored.

■ SC_OP_ISBUSY – A Boolean value indicating whether an agent has set the Busy 
state, for an agent or DN that is being monitored.

■ SC_OP_DESCRIPTION – A string describing the object that is being monitored.

■ SC_OP_TIMEINQUEUE – The number of seconds during which the call stayed 
in the ACD queue before it was answered.

■ SC_OP_QUEUEID – A string specifying the name of a queue. This is used 
together with SC_OP_ISLOGON to update the agent’s login status for an ACD 
queue in the Communications view in the User Preferences screen.

■ SC_OP_ISLOGON – A value indicating that the agent logged on or logged off.

SCWorkItemMode
Identifies work item modes, for inbound or outbound work items.

NOTE: In developing a driver, specify the names of the error codes, such as 
SC_WM_INBOUND, rather than the integer values.
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enum SCWorkItemMode
{

SC_WM_INBOUND = 1,
SC_WM_OUTBOUND = 2

};

Each work item type is described below:

■ SC_WM_INBOUND – The work item is an inbound item.

■ SC_WM_OUTBOUND – The work item is an outbound item, initiated by a user.

Data Types for Communications Drivers
The following are data types referenced in this appendix.

struct ISC_KeyValue /* Key-Value element */
{

ISC_STRING paramName;
ISC_STRING paramValue;

};

struct ISC_KVParamList /* List of Key-Value parameter */
{

struct ISC_KeyValue* dataItems;
long len;

};

struct ISC_StrParamList /* List of String */
{

ISC_STRING* dataItems;
long len;

};

struct ISC_LongParamList /* List of "long" */
{

long* dataItems;
long len;

};

Methods of ISC_CLIENT_HANDLE
The client handle, ISC_CLIENT_HANDLE, is implemented by Siebel Systems. The 
communications driver calls client handle methods in order to communicate with 
the Siebel application, such as to send communications events and associated data.
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When a call to a client handle method is successful, it returns 0 (zero). ISC_RESULT 
represents the API result type defined for the Siebel Adaptive Communications API.

BeginBatch
Begins a set of client methods to be invoked in a batch when the corresponding 
EndBatch method is invoked. Using these methods can reduce network overhead. 
Developers can use these methods at their discretion, subject to the driver 
implementation design. See also “EndBatch” on page 583.

ISC_RESULT (*BeginBatch)
/* in */(ISC_CLIENT_HANDLE handle);

CacheCommandInformation
Notify the Siebel client about command-status caching. 

For the ith command in commandNames, the command description is at the ith 
position in commandDescriptions, and the command status is at the ith position in 
commandStatuses. The SCCommandFlags bit flags are used by commandStatuses.

ISC_RESULT (*CacheCommandInformation)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const struct ISC_StrParamList* commandNames,
/* in */ const struct ISC_StrParamList* commandDescriptions,
/* in */ const struct ISC_LongParamList* commandStatuses);

CleanAllWorkItem
Notifies the Siebel client that all work items for this service session have been 
removed.

ISC_RESULT (*CleanAllWorkItem)
/* in */(ISC_CLIENT_HANDLE handle);

EndBatch
Ends a set of client methods to be invoked in a batch when this method is invoked, 
given the use of the corresponding BeginBatch method to begin the batch. See also 
“BeginBatch” on page 583.

ISC_RESULT (*BeginBatch)
/* in */(ISC_CLIENT_HANDLE handle);
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HandleError
Handle asynchronous errors:

■ If clntCmdTrackID is not 0 (zero), then it contains the same value that was 
passed to the service handle method InvokeCommand that caused the error.

■ If clntCmdTrackID is set to 0 (zero), the error occurred out of context or the error 
was associated with a failed call attempt—with which no call ID data is 
associated.

ISC_RESULT (*HandleError)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING clntCmdTrackID,
/* in */ const ISC_STRING error);

HandleEvent
Handle the named event received from the communications driver, using the given 
fields. By calling this method, the communications driver notifies the Siebel client 
of a communications event, such as a call coming in on the monitored teleset.

If notifyWhenDone is set to TRUE, then the communications driver is notified when 
event handling is finished. The event’s ID is passed (using the trackingID 
parameter) in a call to the service handle method NotifyEventHandlingFinished. 
See “NotifyEventHandlingFinished” on page 590.

ISC_RESULT (*HandleEvent)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING name,
/* in */ const struct ISC_KVParamList* fields,
/* in */ ISC_BOOLEAN notifyWhenDone,
/* in */ const ISC_STRING trackingID);

IndicateNewWorkItem
Indicate a new incoming call by bringing the Siebel application to the front. If the 
end user has set the Enable Sound option in the User Preferences screen 
(Communications tab), the ringin.au or other user-specified sound file will play.

ISC_RESULT (*IndicateNewWorkItem)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING trackingID,
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/* in */ const ISC_STRING oldTrackingID,
/* in */ const ISC_STRING description,
/* in */ enum SCWorkItemMode workItemMode);

ShowStatusText
Display textual status information in the status line of the Siebel client.

ISC_RESULT (*ShowStatusText)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING text);

UpdateObjectInformation
Notify the Siebel application about status changes of communications objects—for 
example, that an agent has become busy. Notifications about DN status will be used 
to keep track of when calls end and new calls start. For the object properties that 
can be provided using datasetInfo, see “SCObjectProperty” on page 580.

ISC_RESULT (*UpdateObjectInformation)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING trackingID,
/* in */ const ISC_STRING mediaTargetAddr,
/* in */ const struct ISC_KVParamList* datasetInfo);

WorkItemReleased
After a work item has been released, such as a phone call disconnected, the driver 
calls this function.

ISC_RESULT (*WorkItemReleased)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING trackingID,
/* in */ time_t stopTime);

WorkItemResumed
After a work item has been resumed, such as a phone call resumed from hold at the 
switch, the driver calls this function.

ISC_RESULT (*WorkItemResumed)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING trackingID);
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WorkItemStarted
After a work item has been started, such as a phone call connected, the driver calls 
this function.

ISC_RESULT (*WorkItemStarted)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING trackingID,
/* in */ const ISC_STRING oldTrackingID,
/* in */ const ISC_STRING description,
/* in */ const ISC_STRING mediaTargetAddr,
/* in */ time_t startTime);

WorkItemSuspended
After a work item has been suspended, such as a phone call put on hold at the 
switch, the driver calls this function.

ISC_RESULT (*WorkItemSuspended)
/* in */(ISC_CLIENT_HANDLE handle,
/* in */ const ISC_STRING trackingID);

Methods of ISC_DRIVER_HANDLE
The driver handle, ISC_DRIVER_HANDLE, is implemented in the communications 
driver. Driver handle methods are invoked to request the driver to create a service 
handle, among other things. The service handle represents the functionality of the 
communications system with which you are integrating.

When a call to a driver handle method is successful, it returns 0 (zero). ISC_RESULT 
represents the API result type defined for the Siebel Adaptive Communications API.

APIVersion
Request the driver to return the API version (Siebel Communications API, or SCAPI) 
for which the driver is implemented. The driver should return the SCAPI_VERSION 
defined in the header file.

ISCAPI long APIVersion();

CreateISCDriverInstance
Request the driver to create the driver handle ISC_DRIVER_HANDLE, and to 
perform other initialization tasks, such as to connect to the CTI middleware.
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ISCAPI ISC_RESULT CreateISCDriverInstance
/* in */(const ISC_STRING mediaTypeStr,
/* in */ const ISC_STRING languageCode,
/* in */ const ISC_STRING connectString,
/* in */ const struct ISC_KVParamList* datasetParams,
/* out */ ISC_DRIVER_HANDLE* handle);

FreeSCStrParamList
Clean the parameter list.

ISCAPI void FreeSCStrParamList
/* in */(struct ISC_StrParamList strList);

GetImplementationObject
Return a data structure for an implementation object, such as may be part of a 
communications driver implementation. This function may be useful for extending 
the functionality of an existing driver.

If your communications driver implementation aggregates another communications 
driver, such that you have an additional object that mediates communication with 
the driver handle and service handle, this method can return implementation 
objects such as the driver handle, service handle, or some other structure.

An aggregate communications driver implementation typically includes a Siebel-
provided driver, such as the Dialogic CTI driver, and a separate driver called the 
aggregate communications driver that extends the main driver’s functionality or 
replaces part of its functionality.

If you write an aggregate communications driver, it may be useful to invoke the 
aggregate driver for certain functions. The aggregate communications driver 
intercepts certain commands for its special operation and passes other commands 
on to the existing communications driver.

The aggregate driver must be added to the Communications Drivers and Profiles 
view, so that the driver can be properly initialized and used.

Writing an aggregate communications driver to work with an existing 
communications driver can save much time compared with writing a driver from 
scratch.
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ISCAPI ISC_RESULT GetImplementationObject
/* in */(ISC_HANDLE key, 
/* out */ ISC_HANDLE* impObj);

ReleaseISCDriverInstance
Release the driver handle that was created using CreateISCDriverInstance, release a 
CTI middleware connection, and so on.

ISCAPI ISC_RESULT ReleaseISCDriverInstance
/* in */(ISC_DRIVER_HANDLE handle);

RequestCommandEventList
Return the list of supported commands or events.

ISCAPI ISC_RESULT RequestCommandEventList
/* in */(const ISC_STRING mediaTypeStr,
/* out */ struct ISC_StrParamList* commandList,
/* out */ struct ISC_StrParamList* eventList);

RequestMediaTypeList
Return the supported channel type.

ISCAPI ISC_RESULT RequestMediaTypeList
/* out */(struct ISC_StrParamList* mediaTypeList);

RequestService
Request the driver to create the service handle ISC_SERVICE_HANDLE, and pass 
the service type (such as teleset monitoring), user-defined parameters, and the 
pointer to the Siebel client handle. The driver handle creates the service handle, 
which in turn communicates with the Siebel application for each agent.

■ For Siebel-provided communications drivers, all parameter data is passed to the 
communications driver in the datasetParams parameter.

■ For a customer-implemented communications driver, additional data can be 
passed to the service handle using the paramString variable.

ISCAPI ISC_RESULT RequestService
/* in */(ISC_DRIVER_HANDLE handle,
/* in */ const struct ISC_CLIENT_INTERFACE clntInterface,
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/* in */ const ISC_STRING connectString,
/* in */ const struct ISC_KVParamList* datasetParams,
/* out */ ISC_SERVICE_HANDLE* serviceHandle);

Methods of ISC_SERVICE_HANDLE
The service handle, ISC_SERVICE_HANDLE, is implemented in the 
communications driver. Services are returned to the Siebel client in response to a 
call for the driver handle method RequestService. The service handle methods are 
called in order to communicate with the communications system—for example, to 
send commands and associated data. See “RequestService” on page 588.

When a call to a service handle method is successful, it returns 0 (zero). 
ISC_RESULT represents the API result type defined for the Siebel Adaptive 
Communications API.

When a call to a service method fails, the communications driver can call the client 
handle method HandleError to pass error data. See “HandleError” on page 584.

AcceptWorkItem
Accept a work item.

ISCAPI ISC_RESULT AcceptWorkItem
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING trackingID);

HandleQueuedWorkItem
Handle a queued work item.

ISCAPI ISC_RESULT HandleQueuedWorkItem
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING name,
/* in */ const struct ISC_KVParamList* fields,
/* in */ const ISC_STRING trackingID);

InvokeCommand
Invoke a command by name, using parameters. A basic ISC_SERVICE_HANDLE 
implementation should include at least the InvokeCommand method, in order to 
invoke named commands.
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When this method is called, a command is invoked that is to be executed—for 
example, placing a call, transferring a call, or setting the Not Ready state. Most 
commands, but not all, are passed from the communications driver to the 
communications system.

ISCAPI ISC_RESULT InvokeCommand
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING clntCmdTrackID,
/* in */ const ISC_STRING name,
/* in */ const ISC_STRING stringParam,
/* in */ const struct ISC_KVParamList* datasetParam);

InvokeCommandEx
Invoke a command by type, using parameters. The command type is represented by 
the value of the SCCommandTypeEx constant. You can use this method to invoke 
commands on an email server or CTI middleware server. The data structure 
ISC_KVParamList specifies the appropriate predefined parameters, according to the 
command type. For more information, see “SCCommandTypeEx” on page 578. See 
also the description for InvokeCommand.

ISCAPI ISC_RESULT InvokeCommandEx
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING clntCmdTrackID,
/* in */ enum SCCommandTypeEx commandType,
/* in */ const struct ISC_KVParamList* datasetParam);

NotifyEventHandlingFinished
Notify the communications driver that the Siebel client has finished handling the 
event that was sent by the communications driver to the Siebel client using a call 
for the client handle method HandleEvent. See “HandleEvent” on page 584.

ISCAPI ISC_RESULT NotifyEventHandlingFinished
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING trackingID,
/* in */ ISC_BOOLEAN result);

ReleaseISCServiceInstance
Release the service handle that was created using RequestService, and free 
resources. No subsequent calls to the driver handle will be made. The driver should 
in turn make no further calls to the client handle.
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ISCAPI ISC_RESULT ReleaseISCServiceInstance
/* in */(ISC_SERVICE_HANDLE handle);

ReleaseWorkItem
Release a work item.

ISCAPI ISC_RESULT ReleaseWorkItem
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING trackingID);

ResumeWorkItem
Resume a work item.

ISCAPI ISC_RESULT ResumeWorkItem
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING trackingID);

RevokeQueuedWorkItem
Revoke a queued work item.

ISCAPI ISC_RESULT RevokeQueuedWorkItem
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING trackingID);

SuspendWorkItem
Suspend a work item.

ISCAPI ISC_RESULT SuspendWorkItem
/* in */(ISC_SERVICE_HANDLE handle,
/* in */ const ISC_STRING trackingID);
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This appendix describes the business services, methods, and arguments for Siebel 
Communications Server.

The following are the business services of Siebel Communications Server. The 
names shown are the display names for these business services.

■ Communications Client. Supports the communications user interface features 
such as the communications toolbar and communications menu commands. 
This business service aggregates the Communications Session Manager business 
service. It does not deal with server-based communications functionality.

■ Communications Session Manager. Provides an interface to session-based 
communications functionality at the server level. Through Server Request 
Manager and Server Request Broker, this business service communicates with 
the Communications Session Manager server component. It does not deal with 
the communications user interface.

■ Outbound Communications Manager. Provides an interface to the outbound 
communications functionality of the Communications Outbound Manager 
server component.

For more information about integrating business services with Communications 
Server, see “Using Business Services with Communications Server” on page 238.

Communications Client Methods
This section describes the methods and method arguments of the business service 
Communications Client. For more information about the role of business services 
and methods in communications toolbar configuration, see “About 
Communications Toolbar Configuration” on page 265.
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The Communications Client business service is an aggregate business service that 
is built on top of the Communications Session Manager service. This means that 
you can invoke all the methods of the Communications Session Manager service as 
though they were methods of the Communications Client business service.

This section primarily uses the display names for each method (Method Display 
Name). The internal names, which should be used in any scripts that invoke these 
methods, are also shown (Method Name).

Table 86 lists the methods for the Communications Client business service.

Table 86. Communications Client Methods

Method Display Name Method Name Comment

Agent Sign Off AgentSignOff Execute logout command

Agent Sign On AgentSignOn Execute login command

Get Selected Work Item Info GetSelectedWorkItemInfo Retrieve complete work item information of 
the selected work item on toolbar

Handle Error HandleError Push error information to the agent’s 
communications toolbar

Is Comm Enabled IsCommEnabled Are communications enabled?

Is Comm Simulated IsCommSimulated Are communications running in simulation 
mode?

Make Call MakeCall Make a phone call

Obtain UI Focus ObtainUIFocus Bring the browser to the front (to gain user 
interface focus)

Send Communication SendCommunication Send outbound communication item

Shell UI Update ShellUIUpdate Update or refresh the status of the 
communications toolbar

Show Status Text ShowStatusText Push error information to the agent’s 
communications toolbar, and display 
message on the browser’s status bar

Work Item Released WorkItemReleased Notification of work item released

Work Item Resumed WorkItemResumed Notification of work item resumed
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Arguments for Communications Client Methods
This section lists the arguments for each method of the business service 
Communications Client. Each argument’s data type is also shown.

NOTE: In Siebel Tools, other arguments than these may also be listed. Disregard any 
arguments that are flagged as Hidden or Inactive.

Arguments for Agent Sign Off Method
The Agent Sign Off method has no arguments.

Arguments for Agent Sign On Method
The Agent Sign On method has no arguments.

Arguments for Get Selected Work Item Info Method
Table 87 lists the arguments for the Get Selected Work Item Info method. 

Work Item Started WorkItemStarted Notification of work item started

Work Item Suspended WorkItemSuspended Notification of work item suspended

Table 86. Communications Client Methods

Method Display Name Method Name Comment

Table 87. Arguments for Get Selected Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Channel Type

(type: String)

ChannelType Output Y The language-independent 
channel type

Channel Type Locale

(type: String)

ChannelTypeLocale Output Y The language-dependent 
channel type locale
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Description

(type: String)

Description Output Y Work item description

Driver Work Tracking ID

(type: String)

DriverWorkTrackID Output Y The tracking ID of this 
work item in driver scope

Icon File

(type: String)

IconFile Output Y Icon file of the driver 
profile that owns this work 
item

Is Active State

(type: Number)

IsActiveState Output Y Is this work item active?

Is Data Contained Inside

(type: Number)

HasWorkData Output Y Is data contained inside?

Is Inbound Item

(type: Number)

IsInboundItem Output Y Is this work item inbound 
work item?

Parent Work Item ID

(type: String)

ParentWorkItemID Output Y ID of parent work item

Profile ID

(type: String)

ProfileID Output Y ID of driver profile that 
owns this work item

Profile Name

(type: String)

ProfileName Output Y Name of driver profile that 
owns this work item

Time In Queue

(type: String)

TimeInQueue Output Y Time this work item stayed 
in the queue

UQ Work Item ID

(type: String)

UQWorkItemID Output Y The original work item ID 
when received from UQ

View Bookmark

(type: String)

ViewBookmark Output Y View bookmark

Table 87. Arguments for Get Selected Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Work Duration

(type: String)

WorkDuration Output Y Duration of work item

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Work Item Key

(type: String)

WorkItemKey Output Y Work item key

Work Item Not Exist

(type: Number)

WorkItemNotExist Output Y Work item does not exist

Work Object ID

(type: String)

WorkObjectID Input Y Object ID

Work Start Time

(type: String)

WorkStartTime Output Y Time work item started

Work State

(type: String)

WorkState Output Y Work item state

Work Tracking Object 
Business Component

(type: String)

WorkTrackObjBusComp Output Y Name of business 
component for after-work 
tracking

Work Tracking Object 
Business Object

(type: String)

WorkTrackObjBusObj Output Y Name of business object 
for after-work tracking

Table 87. Arguments for Get Selected Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Arguments for Handle Error Method
Table 88 lists the arguments for the Handle Error method.

Arguments for Is Comm Enabled Method
Table 89 lists the arguments for the Is Comm Enabled method.

Arguments for Is Comm Simulated Method
Table 90 lists the arguments for the Is Comm Simulated method. 

Table 88. Arguments for Handle Error Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Error

(type: String)

Error Input Y Error text

Table 89. Arguments for Is Comm Enabled Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Is Comm Enabled

(type: Number)

IsCommEnabled Output Y Indicate if communications 
toolbar is enabled. 1 means 
TRUE and 0 means FALSE.

Table 90. Arguments for Is Comm Simulated Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Is Comm Simulated

(type: Number)

IsCommSimulated Output Y Indicate if communications 
toolbar is in simulation 
mode. 1 means TRUE and 0 
means FALSE.
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Arguments for Make Call Method
Table 91 lists the arguments for the Make Call method.

Arguments for Obtain UI Focus Method
The Obtain UI Focus method has no arguments.

Arguments for Send Communication Method
Table 92 lists the arguments for the Send Communication method.

Arguments for Shell UI Update Method
The Shell UI Update method has no arguments.

Table 91. Arguments for Make Call Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Apply Dialing Rule

(type: Number)

ApplyDialingRule Input N If dialing rule needs to be 
applied

Phone Number

(type: String)

PhoneNumber Input Y Phone number

Profile Name

(type: String)

ProfileName Input Y Name of driver profile

Table 92. Arguments for Send Communication Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Channel Type

(type: String)

CommType Input Y Supported values:

Email
Fax
Page
Wireless

Method Argument

(type: String)

Method Argument Input Y
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Arguments for Show Status Text Method
Table 93 lists the arguments for the Show Status Text method. 

Arguments for Work Item Released Method
Table 94 lists the arguments for the Work Item Released method.

Arguments for Work Item Resumed Method
Table 95 lists the arguments for the Work Item Resumed method.

Table 93. Arguments for Show Status Text Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Text

(type: String)

Text Input Y The text that will be 
displayed at the browser’s 
status bar

Table 94. Arguments for Work Item Released Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Stop Time

(type: Number)

StopTime Input Y Time that work item is 
released

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 95. Arguments for Work Item Resumed Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID
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Arguments for Work Item Started Method
Table 96 lists the arguments for the Work Item Started method.

Arguments for Work Item Suspended Method
Table 97 lists the arguments for the Work Item Suspended method.

Table 96. Arguments for Work Item Started Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Channel Profile

(type: String)

MediaProfile Input Y Name of driver profile that 
owns this work item

Channel Type

(type: String)

MediaType Input Y Language-independent 
value of channel string

Description

(type: String)

Description Input Y Work item description

Object ID

(type: String)

ObjectID Input Y Object ID of work item

Old Work Item ID

(type: String)

OldWorkItemID Input Y Old work item ID

Start Time

(type: Number)

StartTime Input Y Time work item is started

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 97. Arguments for Work Item Suspended Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID
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Communications Session Manager Methods
This section describes the methods and method arguments of the business service 
Communications Session Manager.

This section primarily uses the display names for each method (Method Display 
Name). The internal names, which should be used in any scripts that invoke these 
methods, are also shown (Method Name).

Table 98 lists the methods for the Communications Session Manager business 
service.

Table 98. Communications Session Manager Methods

Method Display Name Method Name Comment

Accept Work Item AcceptWorkItem Accept inbound work item

Get Agent Extension GetAgentExtension Retrieve agent’s active extension 
number

Get All Work Item ID GetAllWorkItemID Retrieve all work item IDs

Get Inbound Work Item Attributes GetInboundWorkItemAttr Retrieve inbound work item attribute

Get Inbound Work Item Info GetInboundWorkItemInfo Retrieve complete information of 
inbound work item

Get Top Active Work Item ID GetTopActiveWorkItemID Retrieve the ID of most recent active 
work item

Get Top Idle Work Item ID GetTopIdleWorkItemID Retrieve the ID of most recent idle 
work item

Get Work Item Attributes GetWorkItemAttr Retrieve work item attributes

Get Work Item Info GetWorkItemInfo Retrieve complete information of a 
work item

Get Work Item Track Info GetWorkItemTrackInfo Retrieve the tracking info of work item

Invoke Command InvokeCommand Invoke device command

Invoke Extended Command InvokeCommandEx Invoke predefined device command

Notify Event Handling Finished NotifyEventHandlingFinished Notify driver that event handling is 
over
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Arguments for Communications Session Manager Methods
This section lists the arguments for each method of the business service 
Communications Session Manager. Each argument’s data type is also shown.

NOTE: In Siebel Tools, other arguments than these may also be listed. Disregard any 
arguments that are flagged as Hidden or Inactive.

Arguments for Accept Work Item Method
Table 99 lists the arguments for the Accept Work Item method. 

Release Work Item ReleaseWorkItem Release work item

Release Work Item by Activity ID ReleaseWorkItemEx Release work item by activity record ID

Resume Work Item ResumeWorkItem Resume work item

Set Work Item Attributes SetWorkItemAttr Set work item attributes

Suspend Work Item SuspendWorkItem Suspend work item

Work Item Released WorkItemReleased Notification of work item released

Work Item Resumed WorkItemResumed Notification of work item resumed

Work Item Started WorkItemStarted Notification of work item started

Work Item Suspended WorkItemSuspended Notification of work item suspended

Table 98. Communications Session Manager Methods

Method Display Name Method Name Comment

Table 99. Arguments for Accept Work Item Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID
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Arguments for Get Agent Extension Method
Table 100 lists the arguments for the Get Agent Extension method.

Arguments for Get All Work Item ID Method
Table 101 lists the arguments for the Get All Work Item ID method.

Table 100. Arguments for Get Agent Extension Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Agent Login

(type: String)

AgentLogin Input Y Agent’s login name

Destination DN

(type: String)

DestinationDN Output Y Agent’s active extension

Table 101. Arguments for Get All Work Item ID Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

ActiveWorkItem_N

(type: String)

ActiveWorkItem_N Output Y Attribute names are in 
ActiveWorkItem_? format, 
such as ActiveWorkItem_0, 
ActiveWorkItem_1

IdleWorkItem_N

(type: String)

IdleWorkItem_N Output Y Attribute names are in 
IdleWorkItem_? format, 
such as IdleWorkItem_0, 
IdleWorkItem_1
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Arguments for Get Inbound Work Item Attributes Method
Table 102 lists the arguments for the Get Inbound Work Item Attributes method.

NOTE: The Attribute Name and Attribute Value arguments are available for use, 
though they are not listed in Siebel Tools as arguments for this method.

Arguments for Get Inbound Work Item Info Method
Table 103 lists the arguments for the Get Inbound Work Item Info method.

Table 102. Arguments for Get Inbound Work Item Attributes Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Attribute Name

(type: String)

AttrName Input N Name of the attribute

Attribute Value

(type: String)

AttrValue Output N Value for the attribute

Channel Type

(type: String)

ChannelType Input Y Name of language-
independent channel type

Item Index

(type: Number)

ItemIndex Input Y Index of inbound work 
item

Table 103. Arguments for Get Inbound Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Channel Type

(type: String)

ChannelType Input Y The language-independent 
channel type

Channel Type Locale

(type: String)

MediaTypeLocale Output Y The language-dependent 
channel type locale
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Description

(type: String)

Description Output Y Work item description

Driver Work Tracking ID

(type: String)

DriverWorkTrackID Output Y Work tracking ID in driver 
scope

Icon File

(type: String)

IconFile Output Y Icon file of driver profile 
that owns this work item

Is Active State

(type: Number)

IsActiveState Output Y Is work item active?

Is Data Contained Inside

(type: Number)

HasWorkData Output N Is data contained inside?

Is Inbound Item

(type: Number)

IsInboundItem Output Y Is inbound work item?

Item Index

(type: Number)

ItemIndex Input Y The index of work item

Parent Work Item ID

(type: String)

ParentWorkItemID Output Y ID of parent work item

Profile ID

(type: String)

ProfileID Output Y Row ID of driver profile

Profile Name

(type: String)

ProfileName Output Y Name of driver profile

Time In Queue

(type: Number)

TimeInQueue Output Y Time work item in queue

UQ Work Item ID

(type: String)

UQWorkItemID Output Y The original work item 
when received from UQ

Table 103. Arguments for Get Inbound Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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View Bookmark

(type: String)

ViewBookmark Output Y View bookmark

Work Duration

(type: String)

WorkDuration Output Y Duration of work item

Work Item ID

(type: String)

WorkItemID Output Y Work item ID

Work Item Not Exist

(type: Number)

WorkItemNotExist Output Y If such work item exists

Work Object ID

(type: String)

WorkObjectID Output Y Work object ID

Work Start Time

(type: String)

WorkStartTime Output Y Time work item started

Work State

(type: String)

WorkState Output Y Work item state

Work Tracking Object 
Business Component

(type: String)

WorkTrackObjBusComp Output Y Name of business 
component for after-work 
tracking

Work Tracking Object 
Business Object

(type: String)

WorkTrackObjBusObj Output Y Name of business object 
for after-work tracking

Table 103. Arguments for Get Inbound Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Arguments for Get Top Active Work Item ID Method
Table 104 lists the arguments for the Get Top Active Work Item ID method.

Arguments for Get Top Idle Work Item ID Method
Table 105 lists the arguments for the Get Top Idle Work Item ID method.

Table 104. Arguments for Get Top Active Work Item ID Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Output N Work item ID

Table 105. Arguments for Get Top Idle Work Item ID Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Output N Work item ID
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Arguments for Get Work Item Attributes Method
Table 106 lists the arguments for the Get Work Item Attributes method.

NOTE: The Attribute Name and Attribute Value arguments are available for use, 
though they are not listed in Siebel Tools as arguments for this method.

Arguments for Get Work Item Info Method
Table 107 lists the arguments for the Get Work Item Info method.

Table 106. Arguments for Get Work Item Attributes Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Attribute Name

(type: String)

AttrName Input N Name of the attribute

Attribute Value

(type: String)

AttrValue Output N Value for the attribute

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 107. Arguments for Get Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Channel Type

(type: String)

MediaType Output Y The language-independent 
channel type

Channel Type Locale

(type: String)

MediaTypeLocale Output Y The language-dependent 
channel type locale

Description

(type: String)

Description Output Y Work item description
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Driver Work Tracking ID

(type: String)

DriverWorkTrackID Output Y The tracking ID of this 
work item in driver scope

Icon File

(type: String)

IconFile Output Y Icon file of driver profile 
that owns this work item

Is Active State

(type: String)

IsActiveState Output Y Is this work item active?

Is Data Contained Inside

(type: Number)

HasWorkData Output N Is data contained inside?

Is Inbound Item

(type: String)

IsInboundItem Output Y Is this work item inbound 
work item?

Parent Work Item ID

(type: String)

ParentWorkItemID Output Y ID of parent work item

Profile ID

(type: String)

ProfileID Output Y ID of driver profile that 
owns this work item

Profile Name

(type: String)

ProfileName Output Y Name of driver profile 
which owns this work item

Time In Queue

(type: String)

TimeInQueue Output Y Time this work item stays 
in the queue

UQ Work Item ID

(type: String)

UQWorkItemID Output Y The original work item ID 
when received from UQ

View Bookmark

(type: String)

ViewBookmark Output Y View bookmark

Work Duration

(type: String)

WorkDuration Output Y Duration of work item

Table 107. Arguments for Get Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Work Item Key

(type: String)

WorkItemKey Output Y Work item key

Work Item Not Exist

(type: Number)

WorkItemNotExist Output N Work item does not exist

Work Object ID

(type: String)

WorkObjectID Output Y Object ID

Work Start Time

(type: String)

WorkStartTime Output Y Time work item started

Work State

(type: String)

WorkState Output Y Work item state

Work Tracking Object 
Business Component

(type: String)

WorkTrackObjBusComp Output Y Name of business 
component for after-work 
tracking

Work Tracking Object 
Business Object

(type: String)

WorkTrackObjBusObj Output Y Name of business object 
for after-work tracking

Table 107. Arguments for Get Work Item Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Arguments for Get Work Item Track Info Method
Table 108 lists the arguments for the Get Work Item Track Info method.

Arguments for Invoke Command Method
Table 109 lists the arguments for the Invoke Command method.

Table 108. Arguments for Get Work Item Track Info Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

After Work Tracking Object 
Business Component

(type: String)

AfcBusComp Output Y Name of business 
component for after-work 
tracking

After Work Tracking Object 
Business Object

(type: String)

AfcBusObj Output Y Name of business object 
for after-work tracking

After Work Tracking Object 
Row ID

(type: String)

AfcRowID Output Y Record ID for after-work 
tracking

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 109. Arguments for Invoke Command Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Command Tracking ID

(type: String)

CommandTrackingID Input Y Command ID

Data Set

(type: Hierarchy)

DataSet Input Y Data parameters for driver

Device Command

(type: String)

DeviceCommand Input Y Command to be invoked in 
driver
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Arguments for Invoke Extended Command Method
Table 110 lists the arguments for the Invoke Extended Command method.

Driver Profile ID

(type: String)

DriverProfileID Input Y Row ID of driver profile 
which will be invoked

Profile Name

(type: String)

ProfileName Input Y Name of driver profile 
which will be invoked

String Parameter

(type: String)

StringParam Input Y Single string data

Table 109. Arguments for Invoke Command Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Table 110. Arguments for Invoke Extended Command Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Command Tracking ID

(type: String)

CommandTrackingID Input Y Command ID

Command Type

(type: Number)

CommandType Input Y Command type

Data Set

(type: Hierarchy)

DataSet Input Y Data parameters for driver

Driver Profile ID

(type: String)

DriverProfileID Input Y Row ID of driver profile 
which will be invoked

Profile Name

(type: String)

ProfileName Input Y Name of driver profile 
which will be invoked
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Arguments for Notify Event Handling Finished Method
Table 111 lists the arguments for the Notify Event Handling Finished method.

Arguments for Release Work Item Method
Table 112 lists the arguments for the Release Work Item method.

Arguments for Release Work Item by Activity ID Method
Table 113 lists the arguments for the Release Work Item by Activity ID method.

Table 111. Arguments for Notify Event Handling Finished Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Result

(type: Number)

Result Input Y Result code

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 112. Arguments for Release Work Item Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 113. Arguments for Release Work Item By Activity ID Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Activity ID

(type: String)

ActivityID Input Y Row ID of activity record
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Arguments for Resume Work Item Method
Table 114 lists the arguments for the Resume Work Item method.

Arguments for Set Work Item Attributes Method
Table 115 lists the arguments for the Set Work Item Attributes method.

NOTE: For this method, you can set values for one or more attributes for the work 
item, using key-value pairs rather than arguments with fixed names. (By contrast, 
the methods Get Inbound Work Item Attributes and Get Work Item Attributes use 
the Attribute Name and Attribute Value arguments to store the name of a single 
attribute to retrieve, and its value, respectively.)

Table 114. Arguments for Resume Work Item Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 115. Arguments for Set Work Item Attributes Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID
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Arguments for Suspend Work Item Method
Table 116 lists the arguments for the Suspend Work Item method.

Arguments for Work Item Released Method
Table 117 lists the arguments for the Work Item Released method.

Arguments for Work Item Resumed Method
Table 118 lists the arguments for the Work Item Resumed method.

Table 116. Arguments for Suspend Work Item Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 117. Arguments for Work Item Released Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Stop Time

(type: Number)

StopTime Input Y Time that work item is 
released

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 118. Arguments for Work Item Resumed Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID
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Arguments for Work Item Started Method
Table 119 lists the arguments for the Work Item Started method.

Arguments for Work Item Suspended Method
Table 120 lists the arguments for the Work Item Suspended method.

Table 119. Arguments for Work Item Started Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Channel Profile

(type: Number)

MediaProfile Input Y Name of driver profile that 
owns this work item

Channel Type

(type: Number)

MediaType Input Y Language-independent 
value of channel string

Description

(type: String)

Description Input Y Work item description

Object ID

(type: String)

ObjectID Input Y Object ID of work item

Old Work Item ID

(type: String)

OldWorkItemID Input Y Old work item ID

Start Time

(type: Number)

StartTime Input Y Time work item is started

Work Item ID

(type: String)

WorkItemID Input Y Work item ID

Table 120. Arguments for Work Item Suspended Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Work Item ID

(type: String)

WorkItemID Input Y Work item ID
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Outbound Communications Manager Methods
This section describes the methods and method arguments of the business service 
Outbound Communications Manager.

For more information about the Siebel application features for creating and 
submitting communication requests, see Chapter 10, “Defining Outbound 
Communication Requests.”

This section primarily uses the display names for each method (Method Display 
Name). The internal names, which should be used in any scripts that invoke these 
methods, are also shown (Method Name).

All the methods use profiles for a communications driver such as Internet SMTP/
POP3 Server.

Table 121 on page 618 lists the methods for the Outbound Communications 
Manager business service.

Table 121. Outbound Communications Manager Methods

Method Display Name Method Name Comment

Create and Submit Request CreateRequest Creates a record for a communication request, then 
submits it to the Communications Outbound Manager 
server component.

This method uses the Action business component to 
create recipient activity records, for any template that 
is specified to create activities.

Send Message SendMessage Sends a message to recipients specified by explicit 
semicolon-delimited lists of addresses (To list, CC list, 
and BCC list). 

This method accepts only literal subject and message 
body text and does not support field substitution or 
attachments.

Argument values are provided directly, such as from a 
workflow process or a script.
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Arguments for Outbound Communications Manager Methods
This section lists the arguments for each method of the business service Outbound 
Communications Manager.

NOTE: In Siebel Tools, other arguments than these may also be listed. Disregard any 
arguments that are flagged as Hidden or Inactive.

Send SMTP Message SendSmtpMessage Sends an SMTP message to recipients specified by 
explicit semicolon-delimited lists of addresses (To list, 
CC list, and BCC list).

This method accepts only literal subject and message 
body text and does not support field substitution or 
attachments.

Argument values are provided directly, such as from a 
workflow process or a script.

Unlike the Send Message method, this method does 
not require that a communications profile be 
specified. The profile Default SMTP Profile is used.

Submit Request SubmitRequest Submits a communication request, using the name or 
ID of a request previously created. Submits the 
request to the Communications Outbound Manager 
server component.

This method uses the Action business component to 
create recipient activity records, for any template that 
is specified to create activities.

Table 121. Outbound Communications Manager Methods

Method Display Name Method Name Comment
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Arguments for Create and Submit Request Method
Table 122 lists the arguments for the Create and Submit Request method. 

Table 122. Arguments for Create and Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

# of Recipients

(type: String)

NumRecipients Input N Estimated total number of 
recipients. Used as hint for 
auto-adjustment of number 
of subtasks. (Not available 
from user interface.)

# of Tasks

(type: String)

NumTasks Input N The number of subtasks to 
run, based on each 
recipient’s last name.

Child Recipient Search Spec

(type: String)

ChildRecipSearchSpec Input N Search specification to filter 
iteration child business 
component, in the form 
child_BC_name: 
child_recip_search_spec.

Comm Profile Override

(type: String)

CommProfileOverride Input N Communications profile to 
be used for all 
communications templates in 
this request.

Comm Template Name List

(type: String)

PackageNameList Input N Semicolon-delimited list of 
communications template 
names.

Comments

(type: String)

Comments Input N Comments for the request.

Corresponds to Comments 
field for the request.

Create Only

(type: String)

CreateOnly Input N Create the communication 
request without any 
associated source, recipient, 
or template records specified. 
Used when creating a parent 
request.
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Default Preference

(type: String)

RequestDefaultMedium Input N Communications channel to 
use if Only Send Preference is 
checked for request, and 
channel preference is not 
specified for a recipient.

Corresponds to Default 
Preference field for the 
request.

Defined Component

(type: String)

DefinedComponent Input N Name of the defined Siebel 
Server component, based on 
CommOutboundMgr, that is 
to receive this request.

Corresponds to Component 
Name field for the request.

Message Reply Address List

(type: String)

MsgReplyAddressList Input N Semicolon-delimited list of 
email addresses to be used 
for all recipients in this 
request.

Only Send Preference Flag

(type: String)

RequestSendFlag Input N (Currently this is set only 
from the user interface.)

Corresponds to Only Send 
Preference field for the 
request.

Recipient Group

(type: String)

RecipientGroup Input N Recipient group: the source 
business object and recipient 
business component, as 
selected from the Recipient 
Group picklist.

Corresponds to Recipient 
Group field for the request.

Recipient Search Spec

(type: String)

RecipSearchSpec Input N Search specification to filter 
the recipients returned by the 
recipient business 
component.

Table 122. Arguments for Create and Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Request End Date

(type: String)

EndDate Output N Date/time the request 
finished.

Corresponds to End Time 
field for the request.

Request ID

(type: String)

CommRequestId Output N ID for this communication 
request. A request must use 
either Request ID or Request 
Name.

Corresponds to Request # 
field for the request.

Request Language Code

(type: String)

RequestLanguageCode Input N The language applicable to 
this request. The value for 
this argument is derived, in 
priority order, from:

■ A value explicitly 
specified for this 
parameter, such as in a 
workflow process, or

■ The language specified 
for the first template for 
the request, or

■ The language applicable 
to the current Application 
Object Manager.

It is assumed that all 
recipients for a request share 
a common language and 
locale.

Table 122. Arguments for Create and Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
622 Siebel Communications Server Administration Guide Version 7.5.3



Communications Server Business Services

Outbound Communications Manager Methods
Request Locale Code

(type: String)

RequestLocaleCode Input N The locale applicable to this 
request. The value for this 
argument is derived, in 
priority order, from:

■ A value explicitly 
specified for this 
parameter, such as in a 
workflow process, or

■ The locale specified for 
the first template for the 
request, or

■ The locale applicable to 
the current Application 
Object Manager.

It is assumed that all 
recipients for a request share 
a common language and 
locale.

Request Name

(type: String)

RequestName Input N Name for this 
communication request. A 
request must use either 
Request ID or Request Name.

Corresponds to Description 
field for the request.

Request Parent ID

(type: String)

CommRequestParentId Input N ID for the parent request for 
this communication request 
(when current request is a 
subrequest).

Corresponds to Request # 
field for the request.

Request Start Date

(type: String)

StartDate Output N Date/time the request 
started.

Corresponds to Start Time 
field for the request.

Table 122. Arguments for Create and Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Source ID List

(type: String)

SourceIdList Input N Semicolon-delimited list of 
IDs for recipient source 
records.

SRM Request ID

(type: String)

SRMRequestId Output N The ID for the server request 
for this communication 
request, as known to the 
Server Request Broker 
(formerly Server Request 
Manager).

Status

(type: String)

Status Output N Status of the request.

Corresponds to Status field 
for the request.

Status Message

(type: String)

StatusMessage Output N Request status message.

Corresponds to Status 
Message field for the request.

Task Recipient Minimum

(type: String)

TaskRecipMin Input N Preferred minimum number 
of recipients for a subtask; 
warning issued if not met. 
(Not available from the user 
interface.)

Table 122. Arguments for Create and Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Arguments for Send Message Method
Table 123 lists the arguments for the Send Message method.

Test Address

(type: String)

TestAddress Input N Address to use for testing, 
which overrides all others. If 
it is set to Null (case 
insensitive), 
communications drivers will 
not be loaded and message 
will not be sent.

Web Server

(type: String)

WebServer Input N The Web server to be used for 
URL bookmarks.

This argument corresponds 
to the WebServer parameter 
for Communications 
Outbound Manager. For 
details, see “Configuring 
Communications Outbound 
Manager” on page 334. 

See also the description for 
the Create Bookmark check 
box for advanced templates, 
in “Fields for Templates” on 
page 410.

Table 122. Arguments for Create and Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Table 123. Arguments for Send Message Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Bcc Address List

(type: String)

MsgBccList Input N Semicolon-delimited list of email 
addresses for the BCC line.

Cc Address List

(type: String)

MsgCcList Input N Semicolon-delimited list of email 
addresses for the CC line.
Version 7.5.3 Siebel Communications Server Administration Guide 625



Communications Server Business Services

Outbound Communications Manager Methods
Communication Profile

(type: String)

CommProfile Input Y Name of the communications 
profile used to send the message.

Message Body

(type: String)

MsgBody Input N Email message body content, 
which may be specified from a 
workflow process or script.

How the content is processed 
depends in part on whether the 
argument type is Expression or 
Literal.

For example, when the type is 
Expression, you can enter 
operators such as +, specify field 
names for substitution, and 
enclose literal strings in quotes. 
Carriage returns to be included in 
output must be enclosed in 
quotes, such as in this example:

"New Quote" + "
" + [Quote Number]

For more information, refer to 
Siebel Business Process Designer 
Administration Guide.

Message Subject

(type: String)

MsgSubject Input N Descriptive subject line for the 
email message.

Mobile Media Type

(type: String)

MobileMediaType Input N For a wireless message, this 
argument should be set to 
Wireless. This argument should 
be empty in all other cases.

Table 123. Arguments for Send Message Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Arguments for Send SMTP Message Method
Table 124 lists the arguments for the Send SMTP Message method.

Reply to Address List

(type: String)

MsgReplyAddressList Input N Semicolon-delimited list of email 
addresses to be used for all 
recipients.

To Address List

(type: String)

MsgToList Input N Semicolon-delimited list of email 
addresses for the To line.

For a wireless message, this 
argument should contain a list of 
contact IDs to send the message 
to.

Table 123. Arguments for Send Message Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Table 124. Arguments for Send SMTP Message Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

Bcc Address List

(type: String)

MsgBccList Input N Semicolon-delimited list of email 
addresses for the BCC line.

Cc Address List

(type: String)

MsgCcList Input N Semicolon-delimited list of email 
addresses for the CC line.

From Address

(type: String)

FromAddress Input Y The email address of the sender.
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Message Body

(type: String)

MsgBody Input N Email message body content, which 
may be specified from a workflow 
process or script.

How the content is processed depends 
in part on whether the argument type is 
Expression or Literal.

For example, when the type is 
Expression, you can enter operators 
such as +, specify field names for 
substitution, and enclose literal strings 
in quotes. Carriage returns to be 
included in output must be enclosed in 
quotes, such as in this example:

"New Quote" + "
" + [Quote Number]

For more information, refer to Siebel 
Business Process Designer 
Administration Guide.

Message Subject

(type: String)

MsgSubject Input N Descriptive subject line for the email 
message.

To Address List

(type: String)

MsgToList Input N Semicolon-delimited list of email 
addresses for the To line.

Table 124. Arguments for Send SMTP Message Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Arguments for Submit Request Method
Table 125 lists the arguments for the Submit Request method.

Table 125. Arguments for Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment

# of Recipients

(type: String)

NumRecipients Input N Estimated total number of 
recipients. Used as hint for 
auto-adjustment of number of 
subtasks. (Not available from 
user interface.)

# of Tasks

(type: String)

NumTasks Input N The number of subtasks to 
run, based on each recipient’s 
last name.

Child Recipient Search Spec

(type: String)

ChildRecipSearchSpec Input N Search specification to filter 
iteration child business 
component, in the form 
child_BC_name: 
child_recip_search_spec.

Comm Profile Override

(type: String)

CommProfileOverride Input N Communications profile to be 
used for all communications 
templates in this request.

Defined Component

(type: String)

DefinedComponent Input N Name of the defined Siebel 
Server component, based on 
CommOutboundMgr, that is 
to receive this request.

Corresponds to Component 
Name field for the request.

Recipient Search Spec

(type: String)

RecipSearchSpec Input N Search specification to filter 
the recipients returned by the 
recipient business 
component.

Request End Date

(type: String)

EndDate Output N Date/time the request 
finished.

Corresponds to End Time 
field for the request.
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Request ID

(type: String)

CommRequestId Input N ID for this communication 
request. A request must use 
either Request ID or Request 
Name.

Corresponds to Request # 
field for the request.

Request Language Code

(type: String)

RequestLanguageCode Input N The language applicable to 
this request. The value for 
this argument is derived, in 
priority order, from:

■ A value explicitly 
specified for this 
parameter, such as in a 
workflow process, or

■ The language specified for 
the first template for the 
request, or

■ The language applicable 
to the current Application 
Object Manager.

It is assumed that all 
recipients for a request share 
a common language and 
locale.

Table 125. Arguments for Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Request Locale Code

(type: String)

RequestLocaleCode Input N The locale applicable to this 
request. The value for this 
argument is derived, in 
priority order, from:

■ A value explicitly 
specified for this 
parameter, such as in a 
workflow process, or

■ The locale specified for 
the first template for the 
request, or

■ The locale applicable to 
the current Application 
Object Manager.

It is assumed that all 
recipients for a request share 
a common language and 
locale.

Request Name

(type: String)

RequestName Input N Name for this communication 
request. A request must use 
either Request ID or Request 
Name.

Corresponds to Description 
field for the request.

Request Parent ID

(type: String)

CommRequestParentId Input N ID for the parent request for 
this communication request 
(for when current request is a 
subrequest).

Corresponds to Request # 
field for the request.

Request Start Date

(type: String)

StartDate Output N Date/time the request started.

Corresponds to Start Time 
field for the request.

Table 125. Arguments for Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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Status

(type: String)

Status Output N Status of the request.

Corresponds to Status field 
for the request.

Status Message

(type: String)

StatusMessage Output N Request status message.

Corresponds to Status 
Message field for the request.

Task Recipient Minimum

(type: String)

TaskRecipMin Input N Preferred minimum number 
of recipients for a subtask; 
warning issued if not met. 
(Not available from the user 
interface.)

Test Address

(type: String)

TestAddress Input N Address to use for testing, 
which overrides all others. If 
it is set to Null (case 
insensitive), communications 
drivers will not be loaded and 
message will not be sent.

Web Server

(type: String)

WebServer Input N The Web server to be used for 
URL bookmarks. 

This argument corresponds to 
the WebServer parameter for 
Communications Outbound 
Manager. For details, see 
“Configuring 
Communications Outbound 
Manager” on page 334. 

See also the description for 
the Create Bookmark check 
box for advanced templates, 
in “Fields for Templates” on 
page 410.

Table 125. Arguments for Submit Request Method

Argument Display Name / 
Data Type Argument Name Type Required Comment
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This appendix describes views in the Communications Administration screen. You 
use these views to specify communications configuration data. The views in this 
screen are listed here in the general sequence in which you would work with them.

Views for Defining Configurations, Drivers, Profiles, 
Agents, and Telesets

The following views are used to specify communications configurations, 
communications drivers and profiles, telesets and extensions, and agents.

■ All Configurations. Create, modify, copy, or delete a record for a named 
communications configuration and define or associate related data such as 
parameters, profiles, agents, commands, and events. See “Creating or Modifying 
a Communications Configuration” on page 76.

■ Communications Drivers and Profiles. Specify parameter values for 
communications drivers, and define profiles to provide access to the driver and 
to specify override values for selected parameters. See Chapter 2, “Configuring 
Communications Drivers and Profiles.”

■ Agent General Profile. View or modify information about call or contact center 
communications users (contact-center agents and supervisors), including their 
ACD agent logins and passwords and associated ACD queues. Also associate an 
agent with one or more configurations or telesets. See “Specifying Agents” on 
page 89.

■ All Telesets. Specify the telesets in your call center. For each teleset, specify its 
extensions (according to the switch you are using). You can specify authorized 
agents for the teleset here or in the Agent General Profile view. For hoteling 
telesets, specify the hoteling computer. See “Specifying Telesets” on page 94.
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■ All Extensions. View information about all defined extensions, and view or 
modify each extension’s type and associated teleset. For details, see “Specifying 
Telesets” on page 94.

Views for Defining Events
The following views are used to specify event handlers, event responses, and event 
logs. For details, see “Defining Communications Events” on page 99.

■ All Event Logs. Create or modify each event log, specify parameters and values, 
and associate the event log with a configuration.

■ All Event Responses. Create or modify each event response, specify parameters 
and values, and associate the event response with a configuration. Also 
associate the event response with one or more event logs.

■ All Event Handlers. Create or modify each event handler, specify parameters and 
parameter values, and associate the event handler with a configuration, and 
optionally with a profile. Also associate the event handler with an event 
response.

Views for Defining Commands
The following views are used to specify commands and command data definitions. 
For details, see “Defining Communications Commands” on page 106.

■ All Command Data. Create or modify each command data definition, specify 
parameters and values, and associate the command data definition with a 
configuration.

■ All Commands. Create or modify each command, specify parameters and values, 
and associate the command with a configuration, and optionally with a profile. 
Also associate the command with a command data definition.
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View for Exploring Configurations
View for Exploring Configurations
The following view provides an alternative way to view or specify some of the 
configuration elements identified above:

■ Configuration Explorer. View or specify communications configuration data. See 
“Viewing All Communications Configuration Data” on page 79.

Views for Generating Reports or Reviewing Runtime 
Status Data

The following views allow you to generate reports about inbound or outbound 
communications activities, or display runtime status information about agents and 
communications work items:

■ Reports. Generate communications-related reports. See “Generating 
Communications Reports” on page 258.

■ All Active Agent Status. View information about the communications activities of 
agents. See “Viewing Communications Status Data” on page 260.

■ All Channel Items. View information about active work items for each supported 
channel type. See “Viewing Communications Status Data” on page 260.

View for Defining Templates
The following view is used to specify communications templates and outbound 
requests:

■ All Templates. Create or modify outbound communications templates used by 
Siebel eMail Response; by the Send Email, Send Fax, Send Wireless Message, 
and Send Page commands; by outbound messages sent by Siebel Business 
Process Designer; and by outbound communication requests for various 
channels. See Chapter 9, “Configuring Communications Templates.”
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Views for Defining Outbound Communication Requests
The following views are used to specify outbound communication requests:

■ All Outbound Requests. Define and submit requests for outbound 
communications using email, fax, paging, or wireless messaging channels. See 
Chapter 10, “Defining Outbound Communication Requests.”

■ Outbound Request Overview. Define and submit requests for high-volume 
outbound communications, including specifying recipients and templates. See 
Chapter 10, “Defining Outbound Communication Requests.”

View for Specifying Mobile Devices
The following view allows you to configure mobile devices used for wireless 
messaging:

■ Mobile Devices. Add and administer mobile devices and device addresses, their 
associated priorities (used for determining which device and address a message 
is sent to for a particular Siebel employee or contact), and the profile to be used 
when messaging to a particular address.

Mobile device data is used with the Send Wireless Message command and with 
outbound requests or workflows that send wireless messages. 

For more information, see Appendix B, “Using Wireless Messaging.” Also refer 
to Siebel Wireless Administration Guide.

View for Defining Inbound Communications
The following view allows you to configure processing of inbound communications, 
such as for Siebel eMail Response:

■ All Response Groups. Configure processing of inbound communications. For more 
information, refer to Siebel eMail Response Administration Guide.
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View for Specifying Message Broadcast Settings
View for Specifying Message Broadcast Settings
The following view allows you to specify message broadcast settings:

■ Message Broadcasts. Specify message broadcast settings. For more information, 
refer to Applications Administration Guide.
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This appendix describes issues in upgrading Siebel implementations using:

■ Siebel CTI, version 6.x (or earlier)

■ Siebel Communications Server, version 6.x

■ Send Email/Send Fax/Send Page commands, version 6.x (or earlier)

■ Siebel CTI scripts from version 6.x

For more information about upgrading, refer to the Upgrade Guide for the operating 
system you are using and to Siebel System Requirements and Supported Platforms 
for your Siebel applications.

In order to understand the upgrade issues described here, you must understand how 
Siebel Communications Server in version 7.x differs from Siebel CTI, Siebel 
Communications Server, and other communications features in version 6.x. 

It is recommended that you closely compare the features documented for the 
current version with those described in the Siebel CTI Guide and Siebel 
Communications Server Administration Guide for previous versions.

For information about upgrading specific modules related to Communications 
Server, or implementing new modules, also refer to the following documentation:

■ Siebel Universal Queuing Administration Guide (new product for 7.x)

■ Siebel eMail Response Administration Guide

■ Applications Administration Guide

■ Siebel Marketing Guide
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Upgrading Siebel CTI from Version 6.x (and Earlier)
This section describes issues in upgrading implementations of Siebel CTI, version 
6.x (and earlier). Upgrade issues for Siebel CTI include:

■ CTI drivers

■ CTI/communications configurations

■ Scripting and business service methods

■ Siebel CTI Connect

■ Inbound call routing

Upgrade Issues for CTI Drivers
In version 6.x (and earlier), Siebel CTI drivers (whether drivers provided by Siebel 
Systems or custom drivers developed by customers or by other vendors) were 
written to the Adaptive CTI API, and were based on a client-side CTI architecture. 

Due to the architectural changes for Siebel Communications Server, CTI drivers 
from previous versions will not function in version 7.x and subsequent releases, and 
cannot be upgraded. Some of the code from an existing driver may be reusable in 
developing a replacement driver, however.

In version 7.x, Siebel Systems provides a new CTI-specific communications driver 
that supports Intel NetMerge CTI middleware (formerly Dialogic CT Connect), 
which is included in Siebel CTI Connect. 

The 7.x Dialogic CTI driver replaces the Dialogic CTI driver provided with previous 
versions of Siebel CTI Connect. (One other new driver is also provided that enables 
you to use Siebel Universal Queuing to support multichannel communications 
functionality: User-interactive Email.)

Siebel Systems also provides the Adaptive Communications API, which is described 
in Appendix D, “Developing a Communications Driver.” You must use this new API 
to develop any custom communications drivers intended to support CTI 
middleware products and other communications functionality.
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In previous versions, Adaptive CTI drivers used the COM object model, were loaded 
on each agent’s desktop machine, and could be developed using Visual Basic. In 
version 7.x, however, Adaptive Communications drivers run in a server 
environment and the COM model is no longer used. It is recommended that 
replacement custom drivers be created using C or C++, for best performance.

In version 6.x, a single CTI driver was generally used with your CTI configuration, 
and profiles were not used with such drivers. To support a multichannel call or 
contact center, now multiple communications drivers can be used in the same 
environment, and may be applicable to the same agent. 

For each applicable driver that supports a communications channel you require 
(such as voice or email), a profile must be created and associated with the 
communications configurations to which the driver’s functionality should apply.

The driver and profile model is based on what was supported for communications 
adapters (now drivers) and profiles for Siebel Communications Server, version 6.x. 
However, new driver records can now be added in the Communications Drivers and 
Profiles view, to support using custom drivers. For each driver record:

■ The Library Name field specifies the file, usually a library file such as a .dll or 
.so file, for the driver.

■ The Channel String field specifies a string that must match a designated string 
defined within the driver file. The channel string is used to identify the driver to 
itself. Each new driver must include this element.

These and other settings are described in “Communications Driver Settings” on 
page 60.

Some of the CTI configuration parameters from previous versions have become 
driver parameters for the Dialogic CTI driver. Several configuration parameters or 
driver parameters are new or have been renamed.

Drivers and driver parameters are configured, along with profiles and profile 
parameter overrides, in the Communications Drivers and Profiles view. 
Configuration parameters are configured in the All Configurations view.

For more information about communications drivers, see:

■ Chapter 2, “Configuring Communications Drivers and Profiles”

■ Appendix D, “Developing a Communications Driver”
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Upgrade Issues for CTI/Communications Configurations
Many issues for upgrading from Siebel CTI version 6.x (and earlier) concern 
communications configurations (formerly CTI configurations), which play a critical 
role in defining Siebel application functionality—in particular, using the 
communications toolbar—for interactive communications channels such as voice.

Some of the steps for upgrading a configuration can be done automatically, if you 
prepare .def and .ini files from your previous version, and then import data from 
these files into a new communications configuration for the current version. More 
information on this process is described later in this section.

NOTE: Siebel CTI version 6.x (and earlier) exported CTI configuration data into two 
different files: .ini for configuration parameters and .def for events and commands. 
In the current version, communications configuration data is exported to only a 
single file type, .def. You can, however, choose which elements to export.

Background for Configuration Upgrade
As noted, additional communications channels are now supported, such as email. 
You must determine which channels, and which communications-related Siebel 
products, you require before you complete the upgrade and configuration process 
and bring Siebel CTI into production in the new version of the Siebel eBusiness 
Applications.

Siebel Systems provides a replacement communications driver for Dialogic 
CT Connect CTI middleware, as described previously. In addition, Siebel Systems 
provides a replacement predefined communications configuration that is designed 
to work with this CTI middleware system (and also with email systems).

CTI configuration files from previous versions can be upgraded whether they were 
originally used with CTI drivers provided by Siebel Systems or used with custom 
Adaptive CTI drivers. However, the upgrade process described in this appendix 
performs specific functions; you must address all other configuration issues.

Communications configurations function differently in the current version than 
they did in previous versions. Many configuration elements have changed or are 
new, such as event and command parameters, macros for parameter values, special 
events and commands, configuration parameters, and driver parameters.
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Siebel-provided configurations and drivers are enhanced so that one configuration 
can support multiple drivers, for multichannel communications.

The relationships between configurations, agents, telesets, extensions, and ACD 
queues have also changed:

■ Agents are now associated with configurations, and can be associated with more 
than one configuration (although only one is in effect at a time).

■ Telesets are no longer directly associated with configurations, only with agents.

■ Agents do not need to be associated with telesets at all if they will only use 
hoteling telesets, or if they will only use channels other than voice.

■ ACD queues are now associated with agents, not with telesets. Agents can log 
into multiple ACD queues at the same time.

■ Multiple extensions can be defined for the same teleset.

■ The extension of a hoteling teleset is no longer used to determine the 
communications configuration for a user logged into a hoteling computer.

In the User Preferences screen, which replaces the Options dialog box, the options 
from the former CTI tab are now in the Communications view. In the previous 
version, agents could specify extensions, while in the current version, agents can 
specify both telesets and extensions for the next communications session. Agents 
can also specify which configuration to use for the next communications session, 
and can selectively log into ACD queues.

Agents, telesets, extensions, and ACD queues are not part of the configuration files 
you export or import. However, they are upgraded automatically when you upgrade 
the Siebel database, so that they are in the correct relationship in the database tables 
after upgrade.

For example, an agent who was previously associated with a teleset that was in turn 
associated with a particular configuration is directly associated with this 
configuration after you upgrade. The teleset remains associated with the agent, but 
not with the configuration.

NOTE: When teleset data is upgraded to Siebel 7, each teleset name is concatenated 
with a “+” followed by its database row ID. After upgrading, you can remove the 
added characters from the teleset names using a database script you create. Before 
doing so, make sure that any duplicate telesets or extensions have been resolved. 
The applicable table name is S_CM_TELESET, and the column name is NAME.
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The following sections list new or modified configuration elements from version 6.x 
to version 7.x. Included are configuration parameters, Dialogic CTI driver 
parameters, Dialogic CTI events and commands, event handler parameters, event 
response parameters, event log parameters, command parameters, command data 
parameters, special events and commands, and macros.

Configuration Parameters in Version 7.x
Most configuration parameters from version 6.x with the prefixes “Dialing:” and 
“Setting:” function in the current version as configuration parameters, and do not 
have a prefix. These parameters are not directly associated with any 
communications driver. Each version 7.x configuration parameter is listed in 
Table 126, along with an indication of its name in version 6.x. 

These parameters are described in “Specifying Parameters for Communications 
Configurations” on page 80.

Table 126. Configuration Parameters in Version 7.x

Version 7.x Version 6.x Comments

AutoLogin Setting:AutoLogin Renamed. (Parameter now supports 
“UserPreference” value.)

Note: This parameter is automatically 
renamed if you import configuration 
parameters from a .ini file exported 
from version 6.x.

AutoLoginCmd N/A New.

ChannelCleanupTimer N/A New.

CheckPopupBeforeExecute N/A New.

CommSessionMgr N/A New.

DialingFilter.RuleN Dialing:Filter.RuleN Renamed.

Note: These parameters are 
automatically renamed if you import 
configuration parameters from a .ini 
file exported from version 6.x.

EnterpriseServer N/A New.
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GatewayAddress N/A New.

MaxCommToolbars N/A New.

MultiTenancy Setting:MultiTenancy Renamed.

Note: This parameter is automatically 
renamed if you import configuration 
parameters from a .ini file exported 
from version 6.x.

PreferenceLoginCmd N/A New.

PreferenceLogoutCmd N/A New.

RequestServer N/A New.

RestoreScreenOnWorkResumed N/A New.

UpdateChannelStatusTable Setting:UpdatePhoneStatusTable Renamed.

Note: This parameter is automatically 
renamed if you import configuration 
parameters from a .ini file exported 
from version 6.x.

UQConfigurationName N/A New.

Table 126. Configuration Parameters in Version 7.x

Version 7.x Version 6.x Comments
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Dialogic CTI Driver Parameters in Version 7.x
Dialogic configuration parameters from version 6.x with the prefix “Driver:” 
function in the current version as Dialogic CTI driver parameters, with either the 
“Driver:” or “Service:” prefix. Each version 7.x driver parameter is listed in 
Table 127 on page 646, along with an indication of its name in version 6.x. These 
parameters are described in “Siebel CTI Connect Driver Parameters” on page 457.

NOTE: No automatic upgrading occurs for these driver parameters if you import 
Dialogic configuration parameters from a .ini file exported from version 6.x.

Table 127. Dialogic CTI Driver Parameters in Version 7.x

Version 7.x Version 6.x Comments

Driver:CIMServer Driver:CIMServer Changed from configuration 
parameter to driver parameter.

Driver:CIMTimeDelay N/A New.

Driver:CTCServer Driver:CTCServer Changed from configuration 
parameter to driver parameter.

Driver:DriverLogFile Driver:LogFileName Changed from configuration 
parameter to driver parameter, 
and renamed.

Driver:LogicalID Driver:LogicalID Changed from configuration 
parameter to driver parameter.

Driver:MaxServices N/A New.

Driver:NetCallPort N/A New.

Driver:NetworkType Driver:NetworkType Changed from configuration 
parameter to driver parameter.

Driver:Simulate N/A New.

Driver:SwitchType Driver:SwitchType Changed from configuration 
parameter to driver parameter.

N/A Driver:TraceLevel Obsolete.

Service:ACDDNList N/A New.
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New Dialogic CTI Event in Version 7.x
A new Dialogic CTI driver event is listed in Table 128. This event is described in 
“Siebel CTI Connect Events” on page 472.

Service:AutoLogout N/A New.

Service:DNList N/A New.

Service:HandleRouteRequest N/A New.

Service:HasKeyName Driver:HasKeyName Changed from configuration 
parameter to driver parameter, 
and renamed.

Service:IsQueueRequired N/A New.

Service:IsSiemens N/A New.

Service:SelectDN N/A New.

Service:ServiceLogFile N/A New.

Service:Use1StepTransfer Driver:Use1StepTransfer Changed from configuration 
parameter to driver parameter, 
and renamed.

LogDebug N/A New.

MaxLogKB Driver:MaxLogKB Changed from configuration 
parameter to driver parameter, 
and renamed.

ReleaseLogHandle N/A New.

Table 127. Dialogic CTI Driver Parameters in Version 7.x

Version 7.x Version 6.x Comments

Table 128. New Dialogic CTI Events in Version 7.x

Version 7.x

EventAnswerCall
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New Dialogic CTI Commands in Version 7.x
New Dialogic CTI driver commands are listed in Table 129. These commands are 
described in “Siebel CTI Connect Commands” on page 465.

Event Handler Parameters in Version 7.x
Where there are differences between version 6.x and version 7.x, each version 7.x 
event handler parameter is listed in Table 130, along with an indication of its name 
or status in version 6.x. These parameters are described in “Event Handler 
Parameters” on page 148.

Table 129. New Dialogic CTI Commands in Version 7.x

Version 7.x

ChangeBusyState

MergeCall

RouteCall

SelectDN1... SelectDN5

SimulateCall

ToggleForward

Table 130. New/Changed Event Handler Parameters in Version 7.x

Version 7.x Version 6.x Comments

DeviceEvent DeviceEvent Now specified as a field value 
(Device Event), not as an event 
handler parameter.

FilterSpec N/A New.

Order Order Now specified as a field value 
(Order), not as an event handler 
parameter.

Profile N/A New. Specified as a field value 
(Profile), not as an event handler 
parameter.
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Event Response Parameters in Version 7.x
Where there are differences between version 6.x and version 7.x, each version 7.x 
event response parameter is listed in Table 131, along with an indication of its name 
or status in version 6.x. These parameters are described in “Event Response 
Parameters” on page 157.

Response Response Now specified as a linked child 
record (Event Response), not as an 
event handler parameter.

ServiceMethod N/A New.

ServiceParam N/A New.

Table 130. New/Changed Event Handler Parameters in Version 7.x

Version 7.x Version 6.x Comments

Table 131. New/Changed Event Response Parameters in Version 7.x

Version 7.x Version 6.x Comments

AddLog AddLog Now specified as a field value 
(Type) in a child record 
(Associated Event Logs), not as an 
event response parameter.

AddRecordApplet N/A New.

ContextLog ContextLog Now specified as a field value 
(Type) in a child record 
(Associated Event Logs), not as an 
event response parameter.

FindLog FindLog Now specified as a field value 
(Type) in a child record 
(Associated Event Logs), not as an 
event response parameter.

N/A InvokeResponseIfNoData2 Obsolete.
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Event Log Parameters in Version 7.x
Where there are differences between version 6.x and version 7.x, each version 7.x 
event log parameter is listed in Table 132, along with an indication of its name and 
status in version 6.x. These parameters are described in “Event Log Parameters” on 
page 168.

Log Log Now specified as a field value 
(Type) in a child record 
(Associated Event Logs), not as an 
event response parameter.

MultiLog MultiLog Now specified as a field value 
(Type) in a child record 
(Associated Event Logs), not as an 
event response parameter.

OpenView N/A New.

SingleField N/A New.

SingleLog SingleLog Now specified as a field value 
(Type) in a child record 
(Associated Event Logs), not as an 
event response parameter.

WorkObject CallObject Renamed. Can be used with 
multiple types of work items.

Table 131. New/Changed Event Response Parameters in Version 7.x

Version 7.x Version 6.x Comments

Table 132. New/Changed Event Log Parameters in Version 7.x

Version 7.x Version 6.x Comments

AfterWork AfterCall Renamed.

Note: This parameter is 
automatically renamed if you 
import events and commands 
from a .def file exported from 
version 6.x.

WorkTrackingObj N/A New.
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Command Parameters in Version 7.x
Where there are differences between version 6.x and version 7.x, each version 7.x 
command parameter is listed in Table 133, along with an indication of its name or 
status in version 6.x. These parameters are described in “Command Parameters” on 
page 174.

Table 133. New/Changed Command Parameters in Version 7.x

Version 7.x Version 6.x Comments

AcceptReject N/A New.

AROnRejectCmd N/A New.

ARTitle N/A New.

ARWorkItemID N/A New.

CmdChannelOnFocus N/A New.

CmdData CmdData Now specified as a linked child 
record (Command Data), not as a 
command parameter.

ExecuteAll N/A New.

ExecUntilOK N/A New.

FilterSpec N/A New.

HotKeyText N/A New.

IndicateActiveCmd N/A New.

MenuPosition Order Renamed.

Note: This parameter is 
automatically renamed, for any 
command that was configured to 
appear in the CTI menu or the 
shortcut menu, if you import 
events and commands from a .def 
file exported from version 6.x.

MultiActiveCmdIcon N/A New.
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Command Data Parameters in Version 7.x
Several new command data parameters are available in the current version. Each 
version 7.x command data parameter is listed in Table 134, along with an indication 
of its name in version 6.x. These parameters are described in “Command Data 
Parameters” on page 187.

Profile N/A New. Specified as a field value 
(Profile), not as a command 
parameter.

N/A ScriptParam (This is a command data 
parameter, incorrectly 
documented as a command 
parameter for 6.x.)

SubCommand_N SubCommand Renamed. Now specified as a child 
record (Subcommands), not as a 
command parameter.

Table 133. New/Changed Command Parameters in Version 7.x

Version 7.x Version 6.x Comments

Table 134. New/Changed Command Data Parameters in Version 7.x

Version 7.x Version 6.x Comments

ScriptParam N/A (This command data parameter 
was incorrectly documented as a 
command parameter for 6.x.)

SelectQuerySpec N/A New.

WorkTrackingObj N/A New.
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Special Events in Version 7.x
Special events are new in version 7.x. Each version 7.x special event is listed in 
Table 135. These special events are described in “Special Events for Device Events” 
on page 127.

Special Commands in Version 7.x
Where there are differences between version 6.x and version 7.x, each version 7.x 
special command is listed in Table 136, along with an indication of its name or 
status in version 6.x. These special commands are described in “Special Commands 
for Device Commands” on page 131.

Table 135. New Special Events in Version 7.x

Version 7.x

@HandleNonRealtimeWorkItem

@PreIndicateNewWorkItemEvent

@PostIndicateNewWorkItemEvent

@PreWorkItemReleasedEvent

@PostWorkItemReleasedEvent

@PreWorkItemResumedEvent

@PostWorkItemResumedEvent

@PreWorkItemStartedEvent

@PostWorkItemStartedEvent

@PreWorkItemSuspendedEvent

@PostWorkItemSuspendedEvent

@RuntimeEvent

Table 136. New/Changed Special Commands in Version 7.x

Version 7.x Version 6.x Comments

@CreatePopupFrame N/A New.

@InvokeSWECommand N/A New.
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@OpenView N/A New.

@UpdateRecord N/A New.

@UQAbortWorkItem N/A New.

@UQAddWorkItem N/A New.

@UQAcceptWorkItem N/A New.

@UQAgentAvailable N/A New.

@UQAgentChangeReadyState N/A New.

@UQAgentInitAuxWork N/A New.

@UQAgentLogon N/A New.

@UQAgentLogout N/A New.

@UQAgentSignOnOff N/A New.

@UQBlindTransferWorkItemToAgent N/A New.

@UQBlockAgentChannel N/A New.

@UQCancelTransfer N/A New.

@UQChangeAgentMediaMode N/A New.

@UQCompleteTransfer N/A New.

@UQCompleteWorkItem N/A New.

@UQHoldWorkItem N/A New.

@UQInitTransfer N/A New.

@UQRejectWorkItem N/A New.

@UQTransfer N/A New.

@UQTransferWorkItemToRoute N/A New.

@UQUnBlockAgentChannel N/A New.

Table 136. New/Changed Special Commands in Version 7.x

Version 7.x Version 6.x Comments
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Macros in Version 7.x
Where there are differences between version 6.x and version 7.x, each version 7.x 
macro is listed in Table 137, along with an indication of its name or status in version 
6.x. These macros are described in “Macros for Parameter Values” on page 196.

@UQUnHoldWorkItem N/A New.

@ViewWorkObject @ViewCallObject Renamed.

Table 136. New/Changed Special Commands in Version 7.x

Version 7.x Version 6.x Comments

Table 137. New/Changed Macros in Version 7.x

Version 7.x Version 6.x Comments

@ACDDNList N/A New.

@Configuration N/A New.

@CountryCode N/A New.

@DeselectedWorkItem N/A New.

$DialingRuleMethod N/A New.

@DNList N/A New.

$GetCommandStatus N/A New.

$GetInboundWorkItemAttr N/A New.

$GetWorkItemAttr N/A New.

$HotelingPhone @HotelingPhone Renamed.

@Language N/A New.

@Now N/A New.

@PrimaryQueueList N/A New.

@QueueList N/A New.

@SelectedDN N/A New.
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Preparing to Upgrade the Configuration
In the All Configurations view in the Communications Administration screen, you 
can import a configuration file that you previously exported from Siebel CTI version 
6.x. The configuration data is manipulated so that your existing elements are 
properly mapped to the way in which events and commands and related elements 
are structured in the current version. You do this after the general upgrade.

Device Events Prefixed with “Sys_” No Longer Supported
In version 7.x, communications event handlers can no longer use device events 
prefixed with “Sys_”. Such device events were supported, across CTI drivers, in 
previous versions. Before you complete upgrading your communications 
configuration, you must make sure to make the following changes:

For users of CTI drivers for Intel NetMerge:

■ Sys_InboundCall device events should be changed to InboundCall

■ InboundCall device events should be changed to TpAnswered

For more information, see “Handling an Inbound Call Received by an Agent” on 
page 152 and “Using Device Event to Enhance Screen Pop Performance” on 
page 229.

Users of CTI drivers for other middleware products (that is, drivers supported by 
other vendors than Siebel Systems) must make comparable changes applicable to 
their Siebel CTI implementations.

@SelectedQueue N/A New.

@SelectedText N/A New.

@SelectedWorkItem N/A New.

@WorkDuration @CallDuration Renamed.

@WorkObjectID @CallObjectId Renamed.

@WorkStartTime @CallStartTime Renamed.

Table 137. New/Changed Macros in Version 7.x

Version 7.x Version 6.x Comments
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Version Identifier in 7.x .def File
Configuration files exported from version 7.x now contain an entry identifying the 
version. Configuration files from previous versions that you import for upgrade 
purposes must not contain the following entry, or else no upgrade manipulations 
will be performed:

[Siebel]
CommServerVersion = "7.0"

Event and Command Manipulation During Upgrade
Before you import, you must make sure you do not have (or that you do not require) 
existing commands or command data definitions with certain names, or those 
elements will be replaced when you import. Most of these changes are done in order 
to support the communications toolbar configuration in the current version. 
Affected commands are shown below:

■ AnswerCall and AcceptWorkGroup commands. If AnswerCall is found, this 
command will be renamed to AcceptWorkGroup. If AcceptWorkGroup already 
exists, it will be replaced by this command, or by a newly created command 
defined as follows:

[Command:AcceptWorkGroup]
DeviceCommand = AnswerCall
Hidden = TRUE

■ CancelForwardCall command. If CancelForwardCall exists, it will be removed.

■ ChangeBusyState and ChangeBusyStateGroup commands. If ChangeBusyState is 
found, this command will be renamed to ChangeBusyStateGroup. If 
ChangeBusyStateGroup already exists, it will be replaced by this command, or 
by a newly created command defined as follows.

[Command:ChangeBusyStateGroup]
DeviceCommand = ChangeBusyState
Hidden = TRUE

■ ChangeNotReadyState and NotReadyGroup commands. If ChangeNotReadyState is 
found, this command will be renamed to NotReadyGroup. If NotReadyGroup 
already exists, it will be replaced by this command, or by a newly created 
command defined as follows:
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[Command:NotReadyGroup]
DeviceCommand = ChangeNotReadyState
Hidden = TRUE

■ ConferenceComplete command. If ConferenceComplete is found, no change will 
be made to this command. If ConferenceComplete is not found, a new command 
will be created, defined as follows:

[Command:ConferenceComplete]
DeviceCommand = ConferenceComplete
Hidden = TRUE

■ ConferenceTransferGroupInToolbar and ConferenceTransferGroup commands. If 
ConferenceTransferGroupInToolbar is found, this command will be renamed to 
ConferenceTransferGroup. If ConferenceTransferGroupInToolbar is not found, 
no change will be made. If ConferenceTransferGroup already exists, it will be 
replaced by a newly created command defined as follows:

[Command:ConferenceTransferGroup]
SubCommand_0 = ConferenceComplete

■ ConsultativeTransferGroupInToolbar and ConsultativeTransferGroup commands. If 
ConsultativeTransferGroupInToolbar is found, this command will be renamed to 
ConsultativeTransferGroup. If ConsultativeTransferGroupInToolbar is not found, 
no change will be made. If ConsultativeTransferGroup already exists, it will be 
replaced by a newly created command defined as follows:

[Command:ConsultativeTransferGroup]
SubCommand_0 = TransferComplete

■ ForwardCall and ForwardWorkGroup commands. If ForwardCall is found, this 
command will be renamed to ForwardWorkGroup. If ForwardWorkGroup 
already exists, it will be replaced by this command, or by a newly created 
command defined as follows:

[Command:ForwardWorkGroup]
DeviceCommand = ToggleForward
Hidden = TRUE

■ HoldCall and SuspendWorkGroup commands and SuspendWorkGroup command data. 
If HoldCall is found, this command will be renamed to SuspendWorkGroup. If 
SuspendWorkGroup already exists, it will be replaced by this command, or by a 
newly created command and command data, defined as follows:
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[Command:SuspendWorkGroup]
DeviceCommand = HoldCall
Hidden = TRUE

[CmdData:SuspendWorkGroup]
Param.TrackingID = "{@SelectedWorkItem:DriverWorkTrackID}"

■ Login and SignOnGroup commands and SignOnGroup command data. If LogIn is 
found, this command will be renamed to SignOnGroup. If SignOnGroup already 
exists, it will be replaced by this command, or by a newly created command and 
command data, defined as follows:

[Command:SignOnGroup]
DeviceCommand = "LogIn"
CmdData = "SignOnGroup"

[CmdData:SignOnGroup]
Param.ACDQueue = "{@QueueList}"
Param.AgentId = "{@AgentId}"
Param.AgentPin = "{@AgentPin}"

■ LogOut and SignOffGroup commands and SignOffGroup command data. If LogOut is 
found, this command will be renamed to SignOffGroup. If SignOffGroup already 
exists, it will be replaced by this command, or by a newly created command and 
command data, defined as follows:

[Command:SignOffGroup]
DeviceCommand = "LogOut"
CmdData = "SignOffGroup"

[CmdData:SignOffGroup]
Param.ACDQueue = "{@QueueList}"

■ MakeCallGroupInToolbar, MakeCallGroup, and InitiateWorkGroup commands. If 
MakeCallGroupInToolbar is found, this command will be renamed to 
MakeCallGroup. In this case, if MakeCallGroup already exists, it will be replaced 
by this command. (If MakeCallGroupInToolbar is not found, this means that the 
Make Call button—now the Initiate Work Item button—was not previously 
enabled.)

In the case that MakeCallGroupInToolbar is found (and renamed to 
MakeCallGroup), then the InitiateWorkGroup command is created, defined as 
shown below. If InitiateWorkGroup already exists, it will be replaced by the 
newly created command, defined as follows:
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[Command:InitiateWorkGroup]
SubCommand = MakeCallGroup
Hidden = TRUE

■ MuteTransferGroupInToolbar and BlindTransferGroup commands. If 
MuteTransferGroupInToolbar is found, this command will be renamed to 
BlindTransferGroup. In this case, if BlindTransferGroup already exists, it will be 
replaced by this command. (If MuteTransferGroupInToolbar is not found, this 
means that the Mute Transfer button—now the Blind Transfer button—was not 
previously enabled.)

■ ReleaseCall and ReleaseWorkGroup commands. If ReleaseCall is found, this 
command will be renamed to ReleaseWorkGroup. If ReleaseWorkGroup already 
exists, it will be replaced by this command, or by a newly created command 
defined as follows:

[Command:ReleaseWorkGroup]
DeviceCommand = ReleaseCall
Hidden = TRUE

■ ResetState and ResetStateGroup commands. If ResetState is found, this command 
will be renamed to ResetStateGroup. If ResetStateGroup already exists, it will be 
replaced by this command, or by a newly created command defined as follows:

[Command:ResetStateGroup]
DeviceCommand = ResetState
Hidden = TRUE

■ RetrieveCall and RetrieveWorkGroup commands. If RetrieveCall is found, this 
command will be renamed to RetrieveWorkGroup. If RetrieveWorkGroup 
already exists, it will be replaced by this command, or by a newly created 
command defined as follows:

[Command:RetrieveWorkGroup]
DeviceCommand = RetrieveCall
Hidden = TRUE

■ TransferComplete command. If TransferComplete is found, no change will be made 
to this command. If TransferComplete is not found, the command will be created 
and defined as follows:

[Command:TransferComplete]
DeviceCommand = TransferComplete
Hidden = TRUE
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■ UnHoldCall and ResumeWorkGroup commands and ResumeWorkGroup command data. 
If UnHoldCall is found, this command will be renamed to ResumeWorkGroup, 
and the command data ResumeWorkGroup will be associated with it. If 
ResumeWorkGroup already exists, it will be replaced by this command, or by a 
newly created command and command data, defined as follows:

[Command:ResumeWorkGroup]
DeviceCommand = UnHoldCall
Hidden = TRUE 
CmdData = ResumeWorkGroup

[CmdData:ResumeWorkGroup]
Param.TrackingID = "{@SelectedWorkItem:DriverWorkTrackID}"

■ Subcommands. For any command that contains SubCommand parameters to 
specify subcommands, these subcommands will have the Order field set to 0 
(zero) when you import the configuration file from the previous version. 

In .def files exported from the current version, subcommand records are 
represented by parameters with the name in the form “SubCommand_N”, where 
N represents the value of the Order field for the subcommand record in the All 
Commands view (of the Communications Administration screen). 

If, before you import, you manually modify subcommand parameters to use the 
new form “SubCommand_N”, the value you use for N for each subcommand 
will be used for the value of the Order field for the subcommand record.

After importing the configuration data, assign a value in the Order field for each 
subcommand, as appropriate.

■ Commands for the CTI menu or the shortcut menu. For any command configured to 
appear in the CTI menu or the shortcut menu, the Order parameter will be 
renamed to the MenuPosition parameter.

For previous versions, a command is enabled for the CTI menu if the parameter 
Hidden is set to TRUE or is not defined; a command is enabled for the shortcut 
menu if the parameter LocalMenu is set to TRUE.

For the current version, the shortcut menu is now the applet-level menu, and the 
CTI menu is now the Communications submenu of the View application-level 
menu.

Minor changes occur with respect to event logs:
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■ Event logs containing AfterCall parameter. For any event log that includes the 
parameter AfterCall, this parameter is renamed AfterWork when you import the 
configuration file.

Upgrading the Configuration
Follow this general procedure in order to upgrade Siebel CTI and your 
communications configuration to the current version.

To upgrade your CTI configuration from a previous version

1 In version 6.x (or earlier), export your CTI configuration data to files:

■ Export configuration parameters to a .ini file.

■ Export events and commands to a .def file.

Prior to version 5.x, CTI configuration data existed only in the .def and .ini files, 
and was not stored in the Siebel database.

2 Follow documented procedures for upgrading the Siebel application and 
database from your previous version to the current version.

3 Optionally, add any new custom communications driver (to replace your CTI 
driver used in a previous version) in the Communications Drivers and Profiles 
view, in the Communications Administration screen.

4 Optionally, for the Dialogic CTI driver (for Siebel CTI Connect), enable logging 
for Communications Server activity for the driver (Driver:DriverLogFile and 
Driver:LogDebug parameters), in order to record all of the upgrade actions that 
are performed on the configuration files.

5 Create a profile for any custom communications driver, or for the Siebel-
provided CTI driver you will use in the current version.

6 Associate the driver profile with the upgraded version of the same configuration 
you used in the earlier release.
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7 Optionally, import your .ini file into the upgraded version of the same 
configuration from which you exported the configuration parameters in the 
previous version.

Because only a small number of parameters are imported and upgraded, you 
may choose to re-create all necessary configuration and driver parameters rather 
than import. For more information, see “Configuration Parameters in Version 
7.x” on page 644 and “Dialogic CTI Driver Parameters in Version 7.x” on 
page 646.

8 Import your .def file into the upgraded version of the same configuration from 
which you exported the events and commands in the previous version.

9 For all configuration parameters from the previous release that have become 
driver parameters in the current release, create records for the driver parameters, 
as applicable, and specify the appropriate values for them.

Some driver parameter values may best be specified in the form of profile 
parameter overrides.

10 Optionally, add or modify any other elements in your configuration, as 
necessary.

For example, you may choose to adapt elements from the Siebel-provided 
communications configurations for use in your upgraded configuration. This 
may be especially important if you will be supporting a multichannel 
environment. 

Also review the changes described in “Upgrade Issues for CTI/Communications 
Configurations” on page 642 and following subsections, and alter your 
configuration as appropriate.

11 Test your upgraded environment, then enable communications for your agents.

For information about enabling communications, see “Enabling Session 
Communications and Simulation” on page 311.

Upgrade Issues for Communications Toolbar and Menu Commands
Several changes affect the communications toolbar and communications menu 
commands.
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For more information about configuring toolbars and menus, refer to Siebel Tools 
Reference and Siebel Tools Online Help.

Also consult SupportWeb on the Siebel Systems Web site for relevant information, 
such as, for example, how CTI toolbar configuration changed between version 5.x 
and version 6.x.

CTI/Communications Toolbar Configuration
This section provides upgrade information for the communications toolbar.

■ The CTI toolbar in previous versions is now the communications toolbar.

■ In Siebel Tools, “Communication Toolbar” is the name of the object definition 
for the communications toolbar.

■ The business service methods and Siebel Tools commands invoked by each 
toolbar button have changed.

When you upgrade your communications configuration as described earlier, 
communications command names that invoke toolbar buttons are changed to 
match the business service methods that the toolbar buttons are now configured 
to invoke.

■ The Siebel Tools command names and bitmaps for toolbar buttons have 
changed.

■ Some functions that used two CTI toolbar buttons in version 6.x now use only 
a single button each. These functions include Consultative Transfer, 
Consultative Conference, and Forward Calls/Cancel Forward.

■ Image files for toolbar buttons are now .gif files, instead of .bmp files.

■ Drag-and-drop toolbar customization is no longer supported.

■ The floating toolbar display mode is no longer supported.

General Steps for Upgrading CTI/Communications Toolbar
If you have any custom toolbar buttons, you must perform the following general 
steps:
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1 Convert all .bmp files used for toolbar button icons into .gif files, or create the 
icon files you require, in .gif format. Files must be 18 x 18 pixels in dimension. 
The files must be located in the correct place in the Siebel installation.

2 For each icon file used for a toolbar button, create a new bitmap object definition 
in Siebel Tools.

3 For each custom toolbar button, create a new command object definition.

For more information, see “About Communications Toolbar Configuration” on 
page 265.

CTI/Communications Menu Configuration
This section provides upgrade information for communications menu commands.

■ The CTI menu in previous versions is now the Communications submenu of the 
View application-level menu.

■ The shortcut (“local”) menu in previous versions is now the applet-level menu.

For more information, see “Configuring Communications Menu Commands” on 
page 277.

Upgrade Issues for Scripting and Business Service Methods
Any references to the “CTI Client” business service in Siebel VB or Siebel eScript 
scripts from previous versions must be changed to the “Communications Client” 
business service in the current version.

For more information, see the following sections:

■ “Using Business Services with Communications Server” on page 238

■ “Integrating with Siebel Scripting Languages” on page 247

■ “Using Siebel Scripts from Version 6.x” on page 671

■ Appendix E, “Communications Server Business Services”
Version 7.5.3 Siebel Communications Server Administration Guide 665



Upgrading from Version 6.x

Upgrading Communications Server from Version 6.x
Upgrade Issues for Siebel CTI Connect
New versions of Intel NetMerge middleware (formerly Dialogic) software products 
are applicable to Siebel CTI Connect for the current version. Customers should 
uninstall and reinstall their Intel NetMerge Call Processing Software and Call 
Information Manager software.

For more information about Siebel CTI Connect, see “About Siebel CTI Connect” on 
page 449.

For more information about support for third-party products, refer to Siebel System 
Requirements and Supported Platforms for your Siebel applications.

Upgrade Issues for Inbound Call Routing
In version 6.x (and earlier), inbound call routing functionality was offered through 
the use of database stored procedures that were invoked by the CTI Inbound Call 
Router server component. In version 7.x, this component is no longer available.

In version 7.x, inbound call routing capability can be implemented using Siebel 
Universal Queuing, which can support a multichannel environment by using a 
single routing engine to route inbound work items of various channel types, 
including voice calls or email requests. For more information, refer to Siebel 
Universal Queuing Administration Guide.

As in previous versions, inbound routing of voice calls can still be implemented 
using routing capabilities of an ACD (Automatic Call Distributor) system. ACD 
routing for voice calls can be implemented alongside of a Siebel Universal Queuing 
implementation for routing work items of other channel types.

Upgrading Communications Server from Version 6.x
This section describes issues in upgrading Siebel implementations using 
Communications Server, version 6.x. Upgrade issues for Siebel Communications 
Server include:

■ Communications drivers and profiles

■ Communications templates
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■ Siebel Server component name

■ Business service methods

Upgrade Issues for Communications Drivers and Profiles
In version 6.x, communications drivers for Siebel Communications Server were 
called communications adapters.

Existing profiles you created in version 6.x for the Internet SMTP/POP3 Server 
driver/adapter will still work in the current version, but you can now take 
advantage of additional supported driver parameters and other driver settings. The 
From Address driver parameter, which was previously optional for outbound 
communications, is now required in all cases.

NOTE: Other drivers/adapters for email and fax from version 6.x (Extended MAPI, 
Microsoft Exchange Server, and Microsoft SMTP Service) have not been updated by 
Siebel Systems and are now unsupported. Use the Internet SMTP/POP3 Server 
driver instead.

For information about supported email servers, refer to Siebel System Requirements 
and Supported Platforms for your Siebel applications.

For more information, see Chapter 2, “Configuring Communications Drivers and 
Profiles.”

Upgrade Issues for Communications Templates
In version 6.x, communications templates for Siebel Communications Server were 
called communications packages. Similarly, template items were called package 
items.

Existing templates (packages) you created in version 6.x will still work in the 
current version, but you can now take advantage of enhanced template 
functionality, and you can use templates in a wider range of contexts.
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Communications templates are created and managed in the My Templates view 
(Communications screen) or All Templates view (Communications Administration 
screen). For more information, see Chapter 9, “Configuring Communications 
Templates.”

Response templates previously used for Siebel eMail Response in version 6.x are 
upgraded, and can be accessed with the other communications templates in version 
7.x. After upgrade, the name of each template has been appended with the template 
type, in parentheses. 

For example, a template named “Dear John” of type Body will now be named “Dear 
John (Body)”. You may choose to adjust the values of other template fields after 
upgrade, to take advantage of current template features. Use the Simple tab in the 
appropriate templates view to modify such templates.

Templates used for the Send Email, Send Fax, or Send Page commands in version 
6.x will not work in the current version. Such templates will need to be re-created 
as communications templates in the manner described in this book. Use the Simple 
tab in the appropriate templates view to re-create such templates.

In templates you re-create for the Send commands, notations for indicating fields to 
be substituted with data from the Siebel database must change. Such fields must be 
enclosed with brackets ([ and ]) instead of with % symbols. In addition, the 
business component name must precede each field name, followed by a period. For 
example, “%SR Number%” must change to “[Service Request.SR Number]”.

Communications templates are now used for:

■ Outbound communication requests (for all communications channels)

■ Siebel eMail Response outbound replies

■ Send Email command

■ Send Fax command

■ Send Page command

■ Send Wireless Message command (new feature for version 7.x)

The same template infrastructure is applicable to all of the features identified above. 
However, different features will use different template settings, and some advanced 
template features do not apply in certain contexts of use.
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As in version 6.x, Siebel Marketing uses the underlying data model used by 
communications templates. No upgrade issues are anticipated in this context.

Upgrade Issues for Communications Manager Server Component
The Siebel Server component for sending outbound communications has been 
renamed. In version 6.x, the server component name was Communications 
Manager (CommMgr). In the current version, this component is named 
Communications Outbound Manager (CommOutboundMgr).

Upgrade Issues for Outbound Communications Manager Business 
Service

Workflow processes (or scripts) that invoke business service methods (Outbound 
Communications Manager business service) that support outbound 
communications server functionality will still work in version 7.x, but you can now 
take advantage of additional supported method arguments. In addition, a new 
method is available, Send SMTP Message.

For more information, see the following sections:

■ “Using Business Services with Communications Server” on page 238

■ “Integrating with Siebel Scripting Languages” on page 247

■ Appendix E, “Communications Server Business Services”

Upgrading Send Email/Fax/Page from Version 6.x (and 
Earlier)

This section describes issues in upgrading the Send Email, Send Fax, and Send Page 
commands from version 6.x (and earlier). Upgrade issues for these commands 
include:

■ Migration to server-side integration using Siebel Communications Server 
infrastructure (for Send Email and Send Fax commands)

■ New communications template infrastructure

■ Migration to new Siebel Web Client architecture
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■ New user interface configuration, including communications toolbar

For information about using these commands and the new Send Wireless Message 
command, see “Sending Email, Fax, Page, and Wireless Messages” on page 368.

Migration to Siebel Communications Server
Send Email and Send Fax commands in version 6.x integrated with email 
application client software on each user’s machine, such as Microsoft Outlook. 

In the current version, these commands use the Communications Outbound 
Manager server component to submit the email and fax messages to an email 
server, which actually sends the messages. Applicable business service methods are 
used to invoke the server component functionality.

To support these commands, an administrator must configure and run one or more 
instances of the Communications Outbound Manager server component, and must 
configure profiles for the Internet SMTP/POP3 Server driver (or another applicable 
communications driver).

Each end user may also need to create one or more profiles for personal use, such 
as to specify the user’s email address as the sender (From Address parameter) for 
outbound messages. The My Profiles view in the Communications screen is 
provided for this purpose. 

NOTE: Most end user responsibilities do not have access to the My Profiles view. If 
you need to provide this view to your users, an administrator must add it to the end 
user responsibilities for your Siebel implementation.

For more information, see “Upgrade Issues for Communications Drivers and 
Profiles” on page 667.

Communications Templates
Custom templates may need to be re-created. For more information, see “Upgrade 
Issues for Communications Templates” on page 667.
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Migration to Siebel Web Client and Communications Toolbar
The configuration of the Send Email, Send Fax, and Send Page commands (which 
is also applicable to the new command Send Wireless Message) has changed. The 
commands are available to end users in two places: the File application-level menu 
and the communications toolbar. In addition, keyboard shortcuts are still available.

These commands are configured through a series of object definitions in Siebel 
Tools and, if the communications toolbar is used, through configuring commands 
and command data definitions in the applicable communications configurations.

For more information, see “About Communications Toolbar Configuration” on 
page 265 and “Configuring Communications Menu Commands” on page 277.

Using Siebel Scripts from Version 6.x
Siebel VB and Siebel eScript scripts that you used with Siebel CTI version 6.x can 
still be used with the current version of Siebel Communications Server to extend 
your CTI-enabled Siebel applications using the Siebel client.

NOTE: Scripts that support the objects and methods described in this chapter should 
not also attempt to support new version 7.x Communications Server functionality.

Such scripts can be used in the following ways:

■ Communications events or commands can invoke Siebel VB or Siebel eScript 
scripts.

■ Communications events can invoke Siebel VB or Siebel eScript scripts, for 
instance on the arrival of an incoming call or upon disconnection.

■ Communications commands can invoke Siebel VB or Siebel eScript scripts.

■ Siebel VB or Siebel eScript scripts can invoke communications commands and 
access call data fields.

■ Siebel VB or Siebel eScript scripts can invoke communications commands. 
Commands such as transferring a call can be invoked from Siebel VB–based 
menu items, buttons, or toolbar buttons.
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■ Siebel VB or Siebel eScript scripts can access call data fields such as ANI, 
DNIS, and digits collected from an IVR system.

The integration with Siebel VB and Siebel eScript described in this section allows 
customers to write call handlers and other advanced communications commands 
in Siebel VB or Siebel eScript.

All version 6.x Siebel CTI methods are exposed and can be called with any 
applicable parameters. All version 6.x data fields (such as ANI, DNIS, and so on) 
are accessible. A Siebel VB or Siebel eScript script can be invoked on any 
communications event for a CTI driver (call incoming, disconnected, and so on).

NOTE: For scripts invoked to handle events: When a CTI parameter is passed to a 
script, the receiving function should include input arguments in the function 
declaration.

The CTI-related objects and interfaces are supported only by Siebel VB or Siebel 
eScript. The main purpose of such interfaces is to allow communications event 
handling (such as screen-pop logic). But the interface can also be used to take 
complete control of the CTI technology. CTI objects can be used to obtain 
information about the current call, to intercept communications events and perform 
the necessary handling, or to control calls (make calls, transfer calls, and so on).

NOTE: Scripts that work with Siebel CTI should be defined in the general section of 
the application object, where they will be compiled into the repository (.srf) file for 
the Siebel Application Object Manager (for the Siebel Web Client) or the repository 
file for the Siebel Dedicated Web Client. Siebel CTI data objects and methods are for 
the active call object.

Also refer to the following:

■ Siebel Server Administration Guide

■ Siebel Web Client Administration Guide

■ Siebel Tools Reference

■ Siebel Tools Online Help
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CTIService Object Type
The methods of the CTIService object type are described in this section.

For descriptions of the CTIData object type, see “CTIData Object Type” on page 675.

Scripting examples using Siebel VB and Siebel eScript follow.

The CTIService object type provides the features of the Siebel CTI integration. This 
object is created when the Siebel application is running with the enabled CTI 
option. This object type has methods that allow call control, CTI event handing, and 
access to CTI information. 

The CTI service provides access to the communications commands by name. The 
communications commands and their names are specific to the particular CTI 
integration and are fully described in the command tables for your supported CTI 
middleware found in Appendix A, “Using Siebel CTI Connect.” Also refer to 
documentation from the middleware vendor.

GetCTIService
Application.GetCTIService -> CTIService

The GetCTIService method returns the CTIService object if the Siebel application is 
running with CTI enabled. If CTI is not enabled, then it returns Nothing.

IsCommandEnabled
CTIService.IsCommandEnabled command_name -> return_value

IsCommandEnabled returns 0 if the specified communications command is 
currently enabled and returns 1 if the command is disabled. For example, the 
AnswerCall command is enabled only when the phone is ringing.

IsCommandChecked
CTIService.IsCommandChecked command_name -> return_value

IsCommandChecked returns 1 if the state of the specified communications 
command is triggered; otherwise it returns 0. For example, when an agent is in the 
Not Ready state, the command ChangeNotReadyState is triggered and 
IsCommandChecked returns 1.
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InvokeCommand
CTIService.InvokeCommand command_name [, parameter]

Invokes the device command (for a communications driver) by name, with an 
optional parameter. 

InvokeCommandWithData
CTIService.InvokeCommandWithData command_name [, ctiDataObject]

Invokes the device command by name, with the optional ctiDataObject parameter. 
The ctiDataObject parameter can be used to attach user-defined data to the current 
call, for instance when you are transferring a call or initiating a call. It can also be 
used to pass multiple parameters to the command when this is required.

GetCurrentCallData
CTIService.GetCurrentCallData -> CTIData

Returns a read-only copy of the CTIData object for the current call. The returned 
object can be used to retrieve information about the current call, such as the CTI 
fields ANI, DNIS and any other switch, middleware, or user-defined data that is 
associated with the call.

CreateData
CTIService.CreateData -> CTIData

Creates and returns the new CTIData object. This object can be used to specify 
parameters for the InvokeCommandWithData method. Use this method if you need 
to change fields on the active call object.

NotifyEventHandlerBlocking
CTIService.NotifyEventHandlerBlocking

This method should be called before beginning a lengthy operation or interaction 
with the user through the user interface of the Siebel application. This will prompt 
Siebel CTI to complete some unfinished operations.
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For example, suppose there is a Siebel VB or Siebel eScript script associated with 
the Answer Call button in the communications toolbar. When the phone rings and 
the agent clicks the Answer Call button, Siebel CTI will call the Siebel VB or Siebel 
eScript handler first and answer the phone only after that. Then a Service Request 
window can be invoked showing the current service request for the caller.

If the Siebel VB or Siebel eScript code internally performs some lengthy operation, 
then the agent may want to pick up the phone before the script ends. Calling the 
NotifyEventHandlerBlocking method accomplishes this and immediately connects 
the agent with the caller.

CTIData Object Type
The methods of the CTIData object type are described in this section. For 
descriptions of the CTIService object type, see “CTIService Object Type” on 
page 673.

Scripting examples using Siebel VB and Siebel eScript follow.

The CTIData object type contains a field/value set and can be used for two 
purposes:

■ To retrieve the information about the current call (ANI, DNIS, and so on)

■ To pass the parameters and user data to the call-control commands

This object is conceptually similar to Dictionaries for Perl, or Maps for MFC. 

Field names are specific to the CTI middleware you are using. The event data fields 
are specific to the particular CTI integration and are fully described in the command 
tables for your supported CTI middleware found in Appendix A, “Using Siebel CTI 
Connect.” Also refer to documentation from the middleware vendor.

Clear
CTIData.Clear

Empties the CTIData object by deleting all fields.

GetFieldValue
CTIData.GetFieldValue field_name -> field_value

Retrieves the value of the specified field.
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SetFieldValue
CTIData.SetFieldValue field_name, field_value

Adds the field/value pair to the read-only copy of the CTIData object. If a field with 
the same name is already present, the previous value is overwritten.

GetCount
CTIData.GetCount -> return_value

Returns the number of the fields in the CTIData object.

GetFieldAt
CTIData.GetFieldAt index -> field_name

Returns the name of a field by its index location. The GetCount and GetFieldAt 
functions can be used to enumerate all fields contained currently in the CTIData 
object.

RemoveField
CTIData.RemoveField field_name

Removes (deletes) the field by name.

Script Example: Making a Call
This section shows example Siebel VB or Siebel eScript scripts that use CTI objects 
to make a call and shows how to attach such a script to a communications 
command.

For more information about defining communications events and commands, see 
Chapter 3, “Configuring Session Communications,” and Chapter 4, “Configuring 
Events and Commands.”

Siebel VB Script Example
The following is an example of a Siebel VB script that uses CTI objects to make a 
call.
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Function NewMakeCall(dim Phonenum as string) as Integer

dim CTI as CTIService
dim Data as CTIData
dim Phonenum as string

set CTI = TheApplication.GetCTIService
set Data = CTI.GetCurrentCallData
Phonenum = Data.GetFieldValue("PhoneNumber")

CTI.InvokeCommand "MakeCall", Phonenum

NewMakeCall = OperationComplete

End Function

Siebel eScript Script Example
The following is an example of a Siebel eScript script that uses CTI objects to make 
a call.

function NewMakeCall()
{

var CTI;
var Data;
var Number;

CTI = TheApplication().GetCTIService();
Data = CTI.GetCurrentCallData();
Number = Data.GetFieldValue("PhoneNumber");

CTI.InvokeCommand("MakeCall", Number);

return ContinueOperation;
}

Defining Communications Command to Invoke the Script
The example NewMakeCall script, whether Siebel VB or Siebel eScript, can be 
invoked when the user clicks the Make Call button in the communications toolbar. 
To specify this behavior, you attach the script to a particular command you define 
in the Communications Administration screen. 
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Define the command and its associated command data definition to be similar to 
the example command MakeCalltoPhone for Siebel CTI Connect, shown in 
Table 138 and Table 139 on page 678.

You specify the script name (NewMakeCall in this example) as the value for the 
parameter called Script in the command entry. Then you define parameters for the 
script in the associated command data entry, using the form ScriptParam followed 
by a period (.) and the parameter name (PhoneNumber in this example).

In this example, when an agent clicks the Make Call button in the communications 
toolbar, the command MakeCalltoPhone is executed, which in turn invokes the 
script NewMakeCall. A value is passed to the script for its PhoneNumber parameter, 
based on the value yielded by macro expansion. Each script parameter is passed to 
the script as a key/value pair.

The example script displays a message box indicating that a script is being invoked 
and that a call is being initiated to a particular number; it then dials the number in 
the edit field in the communications toolbar.

Table 138. Command: MakeCalltoPhone

Parameter Name Parameter Value

Description Make Call to "{@Phone}"

Script NewMakeCall

Table 139. Command Data: MakeCalltoPhone

Parameter Name Parameter Value

AttachContext TRUE

Param.CallNotifyText Call from {@UserName}...

Param.PhoneNumber {@Phone:PhoneTypeLookup}

RequiredField.@Phone ?*

ScriptParam.PhoneNumber {@Phone:PhoneTypeLookup}
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For more information about macro expansion and about the @Phone macro, see 
“Using Macro Expansion for Character Fields” on page 195 and “Macros for 
Parameter Values” on page 196.

NOTE: A script invoked from a communications command overrides and does not 
invoke the device command defined within the command.

Script Example: Handling an Incoming Call
This section shows example Siebel VB or Siebel eScript scripts that use CTI objects 
to handle an incoming call and shows how to attach such a script to a 
communications event.

For more information about defining communications events and commands, see 
Chapter 3, “Configuring Session Communications,” and Chapter 4, “Configuring 
Events and Commands.”

Siebel VB Script Example
The following is an example Siebel VB script that uses CTI objects to handle an 
incoming call.

Function HandleCallUsingANI(arg1 As String, arg2 As String) As 
Integer

TheApplication.TraceOn "c:\trace.log", "Allocation", "All"

Dim CTI As CTIService
Dim Data As CTIData
Dim ANI As String

Set CTI = TheApplication.GetCTIService
Set Data = CTI.GetCurrentCallData

ANI = Data.GetFieldValue("ANI")

CTI.NotifyEventHandlerBlocking

TheApplication.Trace "ANI = " & ANI
TheApplication.Trace "arg1 = " & arg1
TheApplication.Trace "arg2 = " & arg2

TheApplication.TraceOff
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HandleCallUsingANI = ContinueOperation
End Function

Siebel eScript Script Example
The following is an example Siebel eScript script that uses CTI objects to handle an 
incoming call.

function HandleCallUsingANI(arg1, arg2)
{

TheApplication().TraceOn("c:\\trace.log", "Allocation", 
"All");

var CTI = TheApplication().GetCTIService();
var Data = CTI.GetCurrentCallData();
var ANI = Data.GetFieldValue("ANI");

TheApplication().Trace("ANI = " + ANI)
TheApplication().Trace("arg1 = " + arg1)
TheApplication().Trace("arg2 = " + arg2)

TheApplication().TraceOff()

return ContinueOperation;
}

Defining the CTI Event to Invoke the Script
The example HandleCallUsingANI script, whether Siebel VB or Siebel eScript, can 
be invoked when the user clicks the Answer Call button. To specify this behavior, 
you attach the script to a particular event response you define in the 
Communications Administration screen. 
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Define the event response to be similar to the example InvokeVBOnAnswer for 
Siebel CTI Connect, shown in Table 140. The example event handler that invokes 
this event response would have the Device Event field set to the appropriate device 
event for the driver, such as TpAnswered for Siebel CTI Connect.

Using the same techniques, you can write a script that will query the Siebel 
database using the information about the current call and display the data by 
navigating to the corresponding Siebel view.

Table 140. Event Response: InvokeVBOnAnswer

Parameter Name Parameter Value

UseCtxData TRUE

Script HandleCallUsingANI

ScriptParam.arg1 test1

ScriptParam.arg2 test2
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Symbols
$DialingRuleMethod macro 198
$GetCommandStatus macro 198
$GetInboundWorkItemAttr macro 199
$GetWorkItemAttr macro 200
$HotelingPhone macro 200, 218
$RemoteConnectStr macro 202, 227
$RemoteConnectStr2 macro 203, 228
@ACDDNList macro 197
@AgentId macro 197, 471
@AgentPin macro 197, 471
@Associate special command 133
@Configuration macro 197
@CountryCode macro 197
@CreatePopupFrame special 

command 134
@DeselectedWorkItem macro 197
@DNList macro 198
@EditControl macro 198
@HandleNonRealtimeWorkItem special 

event 129
@InvokeSWECommand special 

command 135
@Language macro 201
@Now macro 201
@OpenView special command 135
@Phone macro 201
@PostIndicateNewWorkItemEvent special 

event 129
@PostWorkItemReleasedEvent special 

event 130
@PostWorkItemResumedEvent special 

event 130
@PostWorkItemStartedEvent special 

event 130

@PostWorkItemSuspendedEvent special 
event 130

@PreIndicateNewWorkItemEvent special 
event 129

@PreWorkItemReleasedEvent special 
event 130

@PreWorkItemResumedEvent special 
event 130

@PreWorkItemStartedEvent special 
event 130

@PreWorkItemSuspendedEvent special 
event 130

@PrimaryQueueList macro 202
@QueueId macro 202, 471
@QueueList macro 202
@Random macro 202
@RuntimeEvent special event 131
@SelectedDN macro 203
@SelectedQueue macro 203
@SelectedText macro 203
@SelectedWorkItem macro 204
@UpdateRecord special command 135
@UQAbortWorkItem special 

command 135
@UQAcceptWorkItem special 

command 136
@UQAddWorkItem special command 136
@UQAgentAvailable special 

command 137
@UQAgentChangeReadyState special 

command 138
@UQAgentInitAuxWork special 

command 139
@UQAgentLogon special command 139
@UQAgentLogout special command 139
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@UQAgentSignOnOff special 
command 139

@UQBlindTransferWorkItemToAgent 
special command 140

@UQBlockAgentChannel special 
command 140

@UQCancelTransfer special 
command 140

@UQChangeAgentMediaMode special 
command 140

@UQCompleteTransfer special 
command 141

@UQCompleteWorkItem special 
command 141

@UQHoldWorkItem special command 141
@UQInitTransfer special command 141
@UQRejectWorkItem special 

command 141
@UQTransfer special command 142
@UQTransferWorkItemToRoute special 

command 142
@UQUnBlockAgentChannel special 

command 142
@UQUnHoldWorkItem special 

command 143
@UserId macro 204
@UserName macro 204
@ViewWorkObject special command 143
@WorkDuration macro 204
@WorkObjectID macro 204
@WorkStartTime macro 204

A
Accept Reject Popup Applet 189
Accept Work Item button

described 354
and screen pops 152

Accept Work Item method, 
Communications Session Manager 
business service 602

AcceptEmailWork command (User-
interactive Email) 540

AcceptReject command parameter 176
AcceptWorkitem method (service 

handle) 589, 591
accountInfo event data field 

(Dialogic) 475
ACD DN, specifying for Nortel Meridian 

switch 98
ACD queues

configuring List of Values type 285
specifying for agents 90

ACD switch 45
ACD Transfer Call Applet 189
ACDDNList driver parameter 

(Dialogic) 461
ACDQueue command parameter 

(Dialogic) 471
Active, status for server requests 445
activity records

for outbound communications 386
activity records, for communication 

requests 445
Adaptive Communications

aggregate communications driver 587
API reference 575
architecture 568, 570
and C/C++ 567
constants 576
data types 582
design 568
initialization 572
skill set for developing driver 567
and Unicode 568

AddBusComp event response 
parameter 157

AddBusObj event response parameter 157
AddField event response parameter 157
AddLog event response parameter 157
AddRecordApplet event response 

parameter 157
AddRecordView event response 

parameter 157
address priority 391
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Administrator Email Address parameter 
(Communications Inbound 
Manager) 332

advanced templates
See templates

AfterWork event log parameter 168, 208
Agent General Profile view 89, 633
Agent Queues list 87
Agent Sign Off method, Communications 

Client business service 594
Agent Sign On method, Communications 

Client business service 594
AgentAfterCallWork work mode 

(Dialogic) 469
AgentBusy work mode (Dialogic) 469
agentData event data field (Dialogic) 475
agentGroup event data field (Dialogic) 475
AgentId command parameter 

(Dialogic) 471
agentId event data field (Dialogic) 475
AgentLoggedOff event (Dialogic) 473
AgentLoggedOn event (Dialogic) 473
AgentLogin special command 

parameter 144
AgentMediaMode special command 

parameter 144
agentMode event data field (Dialogic) 475
AgentModeChange event (Dialogic) 473
AgentNotReady work mode (Dialogic) 469
AgentOtherWork work mode 

(Dialogic) 469
AgentPin command parameter 

(Dialogic) 471
AgentReady work mode (Dialogic) 469
agents

adding to configuration 89
adding to configuration by 

responsibilities 91
adding to telesets 94
specifying ACD queues 90
specifying telesets for 90

aggregate communications driver 587
All Active Agent Status view 261, 635

All Channel Items view 88, 261, 635
All Command Data view 634
All Commands view 634
All Configurations view 76, 633
All Event Handlers view 634
All Event Logs view 634
All Event Responses view 634
All Extensions view 99, 634
All Outbound Requests view 432, 636
All Response Groups view 636
All Telesets view 94, 633
All Templates view 399, 635
AllViews command parameter 176
ANI

See Automatic Number Identification
ANI event data field (Dialogic) 475
AnswerCall command (Dialogic) 466
API, Adaptive Communications 575
APIVersion method (driver handle) 586
applet properties

Mail Template 304
applet-level menu 181, 362
AppletMode special command 

parameter 144
Application Object Manager 46, 83
applicationData event data field 

(Dialogic) 475
architecture

Adaptive Communications 568, 570
communications infrastructure 33

arguments
business service methods 593
Communications Client business service 

methods 595
Communications Session Manager 

business service methods 603
Outbound Communications Manager 

business service methods 619
AROnRejectCmd command parameter 177
ARTitle command parameter 177
ARWorkItemID command parameter 177
Assoc Applet property 296
Associate menu command 363
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associatedEvent event data field 
(Dialogic) 476

Attach Bookmark check box, for 
template 335, 418

AttachContext command data 
parameter 187

AttachData command (Dialogic) 466
Attachment Label field, for template 

items 422
Attachment Name field, for template 

items 425
attributes

for work items 208
Auto Login to Call Center at Startup user 

preference 222
Auto Login to Call Center at Startup, 

communications preference 343
AutoAccept driver parameter (User-

interactive Email) 538
AutoLogin configuration parameter 81, 

223, 343
AutoLoginCmd configuration 

parameter 81, 179, 223
AutoLogout driver parameter 

(Dialogic) 223, 461
automatic login to call center 224
Automatic Number Identification 

(ANI) 234
AutoSuspend driver parameter (User-

interactive Email) 538
Available Substitutions list

for template 414, 420
for template items 428

Avaya (Lucent) Definity G3 switch
and agent work modes 469
extensions for 98
specifying for Dialogic 461

B
BackInService event (Dialogic) 473
backslash (\)

in macro expansion 196
in templates 414, 420, 429

Base URL parameter 505
ChangeMe text 505

BeginBatch method (client handle) 583
bitmap object definitions 265
Blind Transfer button 354
.bmp files

upgrading 665
bookmarks, for communication 

requests 335, 418
Boolean field type 70, 125
braces ({ }), in macro expansion 195
brackets ([ ])

in macro expansion 195
in templates 414, 420, 428

Bring Siebel to Front, communications 
preference 341

Bring Siebel to Front: Off, communications 
preference 342

Bring Siebel to Front: On All 
Communications Events, 
communications preference 342

Bring Siebel to Front: On Matching Events, 
communications preference 342

BusComp command data parameter 187
BusComp event log parameter 168
business components

for recipient groups 289
Primary Phone Field user property 

in 202, 208
business objects

for recipient groups 289
business services

described 238
using with Communications Server 238

BusObj command data parameter 187
BusObj event log parameter 168

C
C/C++, and Adaptive 

Communications 567
CacheCommandInformation method (client 

handle) 583
Call - Inbound activity type 235, 238
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Call Center Volume (Inbound) report 258
Call Center Volume (Outbound) report 258
Call Center Volume report 258
call centers, calls between 215, 225
call simulation

inbound 234
keys for 234
outbound predictive dialer 

campaign 237
unknown caller/inbound 236

calledParty event data field (Dialogic) 476
calledPartyDialingPlan event data field 

(Dialogic) 476
calledPartyGroup event data field 

(Dialogic) 476
calledPartyQualifier event data field 

(Dialogic) 476
calledPartyTrunk event data field 

(Dialogic) 476
calledPartyType event data field 

(Dialogic) 476
CallerID

simulated inbound call with 234
simulating 234

CallInformation event (Dialogic) 473
CallNotifyText command parameter 

(Dialogic) 471
callrouteA.def file 117
calls

between call centers 215, 225
simulated 234

callsQueued event data field 
(Dialogic) 476

CancelForwardCall command 
(Dialogic) 466

Cancelled, status for server requests 445
CanInvokeMethod method 173, 243
Captaris RightFax 298, 302

integrating with 521
subject line and fax cover pages 413, 

416
and Unicode 413, 416, 522

CCHENG demo user 313

CDO
See Collaborative Data Object

.cfg file 325
Change Ready State button 355
ChangeBusyState command 

(Dialogic) 467
ChangeNotReadyState command 

(Dialogic) 467
channel manager

and driver files 63
Channel Type field, for templates 411
Channel Type Indicator 65, 353
channel types

configuring List of Values type for 
communication requests 284

configuring List of Values type for 
communications driver 283

configuring List of Values type for 
templates 284

ChannelAddress event attribute 542
ChannelCleanupTimer configuration 

parameter 82, 232
ChannelType work item attribute 209
ChannelTypeLocale work item 

attribute 209
character field type 70, 125
CheckPopupBeforeExecute configuration 

parameter 82
CimCallId event data field (Dialogic) 476
CIMServer driver parameter 

(Dialogic) 458
CIMTimeDelay driver parameter 

(Dialogic) 458
CleanAllWorkItem method (client 

handle) 583, 585, 586
Clear method, for CTIData object type 675
client handle

See ISC_CLIENT_HANDLE
CmdChannelOnFocus command 

parameter 177
CmdData command parameter 178
Collaborative Data Object (CDO)

and Microsoft Outlook 388
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colon, in macro expansion 196
Comm Request business component 296
Comm Request business object 297
Comm Source List Applet applet 295
COMM_CMD_PARAM, List of Values 

type 287
COMM_CMDDATA_PARAM, List of Values 

type 287
COMM_EVTHNDLR_PARAM, List of Values 

type 286
COMM_EVTLOG_PARAM, List of Values 

type 286
COMM_EVTRESP_PARAM, List of Values 

type 286
COMM_MEDIA_TYPE, List of Values 

type 283
COMM_RECIP_SRC, List of Values 

type 294
command data definitions

configuring List of Values type for 
parameters 286

creating 107
described 125
parameters for 187
specifying parameters for 108, 111

Command event response parameter 158
command object definitions 265
command parameters

Dialogic 470
special commands 144
specifying 110
User-interactive Email driver 540

commands
configuring List of Values type for 

parameters 286
creating 106
creating subcommands for 109
described 124
Dialogic 465
parameters for 176
special 131
specifying parameters for 110
User-interactive Email driver 539

commands, special
@Associate 133
@CreatePopupFrame 134
@InvokeSWECommand 135
@OpenView 135
@UpdateRecord 135
@UQAbortWorkItem 135
@UQAcceptWorkItem 136
@UQAddWorkItem 136
@UQAgentAvailable 137
@UQAgentChangeReadyState 138
@UQAgentInitAuxWork 139
@UQAgentLogon 139
@UQAgentLogout 139
@UQAgentSignOnOff 139
@UQBlindTransferWorkItemToAgent 1

40
@UQBlockAgentChannel 140
@UQCancelTransfer 140
@UQChangeAgentMediaMode 140
@UQCompleteTransfer 141
@UQCompleteWorkItem 141
@UQHoldWorkItem 141
@UQInitTransfer 141
@UQRejectWorkItem 141
@UQTransfer 142
@UQTransferWorkItemToRoute 142
@UQUnBlockAgentChannel 142
@UQUnHoldWorkItem 143
@ViewWorkObject 143

CommConfigCache parameter
for Application Object Manager 315

CommConfigManagerName parameter
for Application Object Manager 317

CommConfigManager parameter
for Application Object Manager 316
in .cfg file 316

CommConfigManagerName parameter
in .cfg file 317

CommConfigMgr
See Communications Configuration 

Manager server component
CommEnable parameter
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for Application Object Manager 317, 324
in .cfg file 317, 325

Comments field, for communication 
requests 440

CommInboundMgr
See Communications Inbound Manager 

server component
CommLocalDriver parameter

for Application Object Manager 318
in .cfg file 318

CommLogDebug parameter
for Application Object Manager 318
in .cfg file 318

CommLogFile parameter
for Application Object Manager 319
in .cfg file 319

CommMaxLogKB parameter
for Application Object Manager 319
in .cfg file 319

CommMaxMsgQ parameter
for Application Object Manager 320

CommMgmt
See Communications Management 

component group
CommOutboundMgr

See Communications Outbound Manager 
server component

commoutboundmgr.cfg file 437
CommOutboundMgr.log file 336
CommOutboundMgr_xxx.log file 336
CommOutboundMgrxxx.crf file 441
CommReleaseLogHandle parameter

for Application Object Manager 321
in .cfg file 321

CommReqTimeout parameter
for Application Object Manager 321
in .cfg file 320, 321

CommSessionMgr
See Communications Session Manager 

server component
CommSessionMgr configuration 

parameter 83, 328
CommSimulate parameter

for Application Object Manager 322, 
327

in .cfg file 322, 326
Communication Configuration Cache 

parameter
See CommConfigCache parameter

Communication Configuration Manager 
Name parameter

See CommConfigManagerName 
parameter

Communication Configuration Manager 
parameter

See CommConfigManager parameter
communication requests

activity records for 445
configuring List of Values type for 

channel type 284
creating 433
fields for 438
monitoring 442, 443
status settings for 442
submitting 435
subrequests for 436
views for working with 432

Communication toolbar object 
definition 265

Communications Administration screen
Agent General Profile 633
All Active Agent Status 635
All Channel Items 635
All Command Data 634
All Commands 634
All Configurations 76, 633
All Event Handlers 634
All Event Logs 634
All Event Responses 634
All Extensions 99, 634
All Outbound Requests 432, 636
All Response Groups 636
All Telesets 94, 633
All Templates 399, 635
Communications Drivers and 

Profiles 633
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Configuration Explorer 79, 635
Message Broadcasts 637
Mobile Devices 636
Outbound Request Overview 432, 636
Reports 635

Communications Client business 
service 240, 593

communications configuration
adding agents to 89
copying 79
creating or editing 76
deleting 79
event and command definitions 124
exporting 113
overview 34
specifying parameters 80

Communications Configuration Manager
parameter for 316

Communications Configuration Manager 
server component

administration 329
setting up 46

communications driver parameters
for Dialogic 457
for FTP 565
for Internet SMTP/POP3 Server 524
for Modem-based TAP Paging 563
for Push Keep Alive 562
for User-interactive Email 537
for WAP V1.2 515
for Wireless Messaging 1-Way 490
for Wireless Messaging 2-Way 491

communications drivers
aggregate 587
configuring 68
configuring List of Values type for 

channel type 283
overview 53
specifying parameters for 71
specifying profiles for 71
writing using Adaptive 

Communications 567

Communications Drivers and Profiles 
view 633

Communications Inbound Manager server 
component

administration 331
parameters for 332
setting up 46

Communications Management component 
group 307, 308, 487

Communications Outbound Manager server 
component

administration 333
log files 335
log levels 336
and request status 444
setting up 46

communications port 565
communications profiles

creating 71
specifying parameter overrides 72

Communications screen
My Outbound Request Overview 432
My Outbound Requests 432
My Profiles 366
My Templates 399

Communications Session Manager business 
service 240, 593

Communications Session Manager server 
component

administration 327
setting up 46

Communications Simulator
hot key defined by 185, 194
inbound call from unknown caller 236
inbound call simulation 234
and NetCallPort parameter 460
outbound predictive dialer campaign call 

simulation 237
restriction 233
setting up 233
testing with 122

Communications submenu
configuring 277
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using 362
communications templates

See templates
communications toolbar

buttons 265
configuring 265
and Java 266
ToolTip text for 276
using 352

Component Name field, for communication 
requests 439

Component Requests view 444
Component Requests view tab 443
Conference button 355
ConferenceComplete command 

(Dialogic) 467
ConferenceInit command (Dialogic) 467
Configuration Explorer view 79, 635
configuration parameters

described 81
specifying 80

Configuration, communications 
preference 346

ConnectString configuration parameter 83
constants, Adaptive Communications 576
Consultative Transfer button 354
Contact Method field caption, for 

contacts 440
ContextLog event response parameter 158
context-sensitive menu

See applet-level menu
country code 197
Country, keyword in telephone number 

macro 207
Create Activity field, for templates 417
Create and Submit Request method, 

Outbound Communications Manager 
business service 618

Create Plain Text From HTML driver 
parameter (Internet SMTP/POP3 
Server) 525

Created By field, for communication 
requests 440

Created field, for communication 
requests 440

CreateData method, for CTIService object 
type 674

CreateISCDriverInstance method (driver 
handle) 586

CSSFrameListCommSrc applet class 296
CSTA Phase II switch

See Generic CSTA Phase II switch
ctc.log file 459, 480
CTCServer driver parameter 

(Dialogic) 458
CTI middleware

setting up 45
validated 58

CTI_ACD_QUEUES, List of Values 
type 285

CTIData object type
described 675
handling an incoming call 679
making a call 676

CTIService object type 673
customer dashboard, event responses 

for 256

D
dashboard

See customer dashboard
data set 123
data types, Adaptive Communications 582
DebugLevel parameter in .cfg file 558
.def file 112, 116
Default Administrator Address parameter 

(Communications Inbound 
Manager) 332

Default Bookmark View user property 419
Default Closing Template, communications 

preference 350
Default Email Client component 

parameter 557
Default Greeting Template, communications 

preference 350
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Default Message Format, communications 
preference (for Send Email) 349

Default Message Format, communications 
preference (for Siebel eMail 
Response) 351

Default Preference field, for communication 
requests 440

Default Profile, communications 
preference 348

Default Recipient Class, communications 
preference 348

Default SMTP Profile profile 619
Default URL driver parameter (WAP 

V1.2) 515
DefaultMailClient parameter in .cfg 

file 557
Delete Processed Messages driver parameter 

(Internet SMTP/POP3 Server) 526
Delete Processed Messages driver parameter 

(Wireless Messaging 2-Way) 492
Delivery Profile field, for templates 415
demo database

See Sample Database
demo users

CCHENG 313
SLYBRAND 313

Description command parameter
described 178
toolbar configuration 275

Description field
for communication requests 438
for templates 411

Description work item attribute 209
DestBusy event (Dialogic) 473
DestChanged event (Dialogic) 473
DestInvalid event (Dialogic) 473
DestNotObtainable event (Dialogic) 473
DestSeized event (Dialogic) 473
device address 391
DeviceCommand command 

parameter 178
DeviceEvent event handler parameter 148

Dial Prefix driver parameter (Modem-based 
TAP Paging) 564

DialingFilter.RuleN configuration 
parameters

and $DialingRuleMethod macro 198
described 84
for remote transfers and 

conferences 226
Dialogic CT Connect

command parameters 470
commands 465
event data fields 475
events 472

Dialogic CTI driver, described 55
Digits, keyword in telephone number 

macro 207
Dimension special command 

parameter 144
Display event log parameter 168
Diverted event (Dialogic) 473
DNIS event data field (Dialogic) 476
DNList driver parameter (Dialogic) 461
Done, status for communication 

requests 443
driver handle

See ISC_DRIVER_HANDLE
driver parameters

for Dialogic 457
for FTP 565
for Internet SMTP/POP3 Server 524
for Modem-based TAP Paging 563
overriding default 69
for Push Keep Alive 562
setting default 70
for User-interactive Email 537
for WAP V1.2 515
for Wireless Messaging 1-Way 490
for Wireless Messaging 2-Way 491

Driver:CIMServer driver parameter 
(Dialogic) 458

Driver:CIMTimeDelay driver parameter 
(Dialogic) 458
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Driver:CTCServer driver parameter 
(Dialogic) 458

Driver:DriverLogFile driver parameter 
(Dialogic) 459

Driver:LogicalID driver parameter 
(Dialogic) 459

Driver:MaxServices driver parameter 
(Dialogic) 460

Driver:NetCallPort driver parameter 
(Dialogic) 460

Driver:NetworkType driver parameter 
(Dialogic) 460

Driver:Simulate driver parameter 
(Dialogic) 460

Driver:SwitchType driver parameter 
(Dialogic) 461

DriverLogFile driver parameter 
(Dialogic) 459

drivers
See communications drivers

DriverWorkTrackID work item 
attribute 209

DTMF (Dual-Tone Multi-Frequency) 476
dtmfDigits event data field (Dialogic) 476
DTYPE_PHONE, field data type 206
Dual-Tone Multi-Frequency

See DTMF

E
Elapsed Time Indicator 354
Email Client Debug Level component 

parameter 558
Email Client, communications 

preference 349
eMail Response Agent responsibility 366
email servers, validated 58
Email Temporary Attachment Location 

component parameter 559
email, sending 369
EmbeddedMsgpartspecifier.txt file 333
Enable Communication parameter

See CommEnable parameter
Enable Sound, communications 

preference 343

EnableEmailClientAutomation parameter in 
.cfg file 551, 553

EnableWebClientAutomation parameter in 
.cfg file 551, 553

End Time field, for communication 
requests 440

EndBatch method (client handle) 583
Enterprise Operations view 443
EnterpriseServer configuration 

parameter 84, 328
Error event (Dialogic) 473
error messages 57
Error, status for server requests 445
escape character

See backslash
eScript, Siebel 247, 671
event attributes 574
event event data field (Dialogic) 476
event handlers

configuring List of Values for 
parameters 285

described 124, 146
parameters for 148
specifying parameters for 105

event logs
configuring List of Values type for 

parameters 285
described 124, 168
parameters for 168
specifying parameters for 100

Event Queue Directory parameter 
(Communications Inbound 
Manager) 332

event responses
configuring List of Values type for 

parameters 285
described 124, 154
parameters for 157
specifying parameters for 102, 106

EventAnswerCall event (Dialogic) 473
EventEmailWorkArrived event (User-

interactive Email) 541
EventEmailWorkReleased event (User-

interactive Email) 541
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EventEmailWorkResumed event (User-
interactive Email) 541

EventEmailWorkRevoked event (User-
interactive Email) 541

EventEmailWorkStarted event (User-
interactive Email) 541

EventEmailWorkSuspended event (User-
interactive Email) 541

eventQualifier event data field 
(Dialogic) 477

events
customizing 121
Dialogic 472
special 127
specifying 99
User-interactive Email driver 541

events, special
@HandleNonRealtimeWorkItem 129
@PostIndicateNewWorkItemEvent 129
@PostWorkItemReleasedEvent 130
@PostWorkItemResumedEvent 130
@PostWorkItemStartedEvent 130
@PostWorkItemSuspendedEvent 130
@PreIndicateNewWorkItemEvent 129
@PreWorkItemReleasedEvent 130
@PreWorkItemResumedEvent 130
@PreWorkItemStartedEvent 130
@PreWorkItemSuspendedEvent 130
@RuntimeEvent 131

ExecUntilOK command parameter 179
ExecuteAll command parameter 179
Expert Agent Selection (EAS) 462
exporting communications configuration 

data 113
Extension, keyword in telephone number 

macro 207
extensions, specifying 94

F
Failed Email Directory driver parameter 

(Internet SMTP/POP3 Server) 526
fax server, integrating with 521
fax, sending 377

field types
for driver parameters 70
for event and command parameters 125

fields
Dialogic event data 475
macro expansion in 195

File Size field, for template items 425
File Type field, for template items 425
Filename driver parameter (FTP) 566
files

adding to template item 425
.bmp 665
callrouteA.def 117
.cfg 325
commoutboundmgr.cfg 437
CommOutboundMgr.log 336
CommOutboundMgr_xxx.log 336
CommOutboundMgrxxx.crf 441
ctc.log 459, 480
.def 112, 116
EmbeddedMsgpartspecifier.txt 333
HTML for template item 425
icon, for driver 65
.ini 112
mail.gif 65
multichannelA.def 116
OriginalMsg.txt 332
pictures for HTML 423
receptionA.def 116
ringin.au 344, 584
SComm_username.log 319, 323
SiebelEmaildbg.log 558
SiebelLongEmailBody.htm 333, 387
SiebelLongEmailBody.txt 333, 387
siebelmail.log 558
text for template item 425
texthtmlpartspecifier.htm 333
uagent.cfg 314
voice.gif 65

Filter event handler parameter 148
FilterSpec command parameter 179
FilterSpec event handler parameter 149
FindDialog event response parameter 158
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FindField event response parameter 158
FindLog event response parameter 158
Forward Work Items/Cancel Forward 

button 355
ForwardCall command (Dialogic) 467
FreeSCStrParamList method (driver 

handle) 587
From Address driver parameter (Internet 

SMTP/POP3 Server) 527
FTP driver

described 56
parameters for 565

G
G3 switch

See Avaya Definity G3 switch
Gateway driver parameter (WAP V1.2) 515
GatewayAddress configuration 

parameter 85, 328
Generic CSTA Phase II switch

extensions for 98
generic recipients for Send Email/Fax 299
Get Agent Extension method, 

Communications Session Manager 
business service 602

Get All Work Item ID method, 
Communications Session Manager 
business service 602

Get Bookmark URL command, in applet-
level menu 418

Get Inbound Work Item Attributes method, 
Communications Session Manager 
business service 602

Get Inbound Work Item Info method, 
Communications Session Manager 
business service 602

Get Selected Work Item Info method, 
Communications Client business 
service 594

Get Top Active Work Item ID method, 
Communications Session Manager 
business service 602

Get Top Idle Work Item ID method, 
Communications Session Manager 
business service 602

Get Work Item Attributes method, 
Communications Session Manager 
business service 602

Get Work Item Info method, 
Communications Session Manager 
business service 602

Get Work Item Track Info method, 
Communications Session Manager 
business service 602

GetCount method, for CTIData object 
type 676

GetCTIService method, for CTIService 
object type 673

GetCurrentCallData method, for CTIService 
object type 674

GetFieldAt method, for CTIData object 
type 676

GetFieldValue method, for CTIData object 
type 675

GetImplementationObject method (driver 
handle) 587

.gif files 665
globalRefId event data field (Dialogic) 477

H
Handle Error method, Communications 

Client business service 594
HandleError method (client handle) 584
HandleEvent method (client handle)

described 584
and event attributes 574

HandleQueuedWorkItem method (service 
handle) 589

HandleRouteRequest driver parameter 
(Dialogic) 461

HasKeyName driver parameters 
(Dialogic) 462

HasViewResponsibility step 505
Hicom switch

See Siemens Hicom 300E switch
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Hidden command parameter
described 180
menu configuration 278
toolbar configuration 275

HoldCall command (Dialogic) 467
Hostname driver parameter (FTP) 566
hoteling

described 217
and $HotelingPhone macro 200

HotKey command parameter
described 180
menu configuration 278

HotKeyText command parameter
described 181
menu configuration 279

HTML Command Icons bitmap 
category 268

HTML files
field substitution in tables 397
for template items 425

HTML formatting controls (Send 
Email) 381

HTML Template check box, for 
template 413, 417

I
icon file, for interactive communications 

driver 65
ID command parameter (Dialogic) 472
In Progress, status for communication 

requests 442
inbound call from unknown caller 236
inbound call simulation 234
InboundCall event (Dialogic) 473
Include Original Message in Reply, 

communications preference 351
Incoming Email Directory driver parameter 

(Internet SMTP/POP3 Server) 528
Incoming Message URL driver parameter 

(Wireless Messaging 2-Way) 492
Incomplete, status for communication 

requests 443

IndicateActiveCmd command 
parameter 181

IndicateNewWorkItem method (client 
handle) 584

.ini file 112
initialization, Adaptive 

Communications 572
Initiate Work Item button 354
In-Queue Time Indicator 353
Intel NetMerge

configuration data for 449
support for 58

interactive communications drivers 65
Internet SMTP/POP3 Server driver

compliance with RFCs 58
described 55
parameters for 524

IntlNumber, keyword in telephone number 
macro 207

Invoke Command method, 
Communications Session Manager 
business service 602

Invoke Extended Command method, 
Communications Session Manager 
business service 602

InvokeCommand method (service 
handle) 589

InvokeCommand method, for CTIService 
object type 674

InvokeCommandEx method (service 
handle) 590

InvokeCommandWithData method, for 
CTIService object type 674

IP Address driver parameter (FTP) 566
IPM.Note.Siebel email form, for Microsoft 

Outlook 549
Is Comm Enabled method, Communications 

Client business service 594
Is Comm Simulated method, 

Communications Client business 
service 594

ISC_CLIENT_HANDLE
described 576
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methods 582
ISC_DRIVER_HANDLE

described 576
initialization 572
methods 586

ISC_SERVICE_HANDLE
described 576
initialization 572
methods 589

IsCommandChecked method, for 
CTIService object type 673

IsCommandEnabled method, for CTIService 
object type 673

IsQueueRequired driver parameter 
(Dialogic) 49, 90, 462

IsRevoked work item attribute 210
IsSiemens driver parameter (Dialogic) 463
IsTransferred work item attribute 209
Iteration Child BC field, for template 

items 426

J
Java

and communications toolbar 266, 344

K
keywords

dialing filters for phone numbers 206
Dialogic driver parameters 458
driver parameters 573
for part of phone numbers 206

L
Language field

for templates 411, 414, 420
Language, communications 

preference 352
List of Values types

COMM_CMD_PARAM 287
COMM_CMDDATA_PARAM 287
COMM_EVTHNDLR_PARAM 286
COMM_EVTLOG_PARAM 286

COMM_EVTRESP_PARAM 286
COMM_MEDIA_TYPE 283
COMM_RECIP_SRC 294
CTI_ACD_QUEUES 285
OFFER_MEDIA 284
REASON_CODE 285

List of Values, for Recipient Group drop-
down list 293

Literature Name field, for template 
items 424

Local Area Code driver parameter (Modem-
based TAP Paging) 564

Local Communication Driver parameter
See CommLocalDriver parameter

Locale field
for templates 411, 414, 420

Locale, communications preference 352
LocalMenu command parameter

described 181
menu configuration 279
toolbar configuration 275

Log Debug Message parameter
See CommLogDebug parameter; 

LogDebug parameter
Log event response parameter 159
Log File parameter

See CommLogFile parameter; LogDebug 
parameter

log files
CommOutboundMgr.log 336
CommOutboundMgr_xxx.log 336
SComm_username.log 319, 323

LogDebug driver parameter (Dialogic) 464
LogDebug driver parameter (FTP) 566
LogDebug driver parameter (Internet 

SMTP/POP3 Server) 528
LogDebug driver parameter (Modem-based 

TAP Paging) 564
LogDebug driver parameter (Push Keep 

Alive) 562
LogDebug driver parameter (User-

interactive Email) 538
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LogDebug driver parameter (WAP 
V1.2) 515

LogDebug driver parameter (Wireless 
Messaging 1-Way) 490

LogDebug driver parameter (Wireless 
Messaging 2-Way) 492

LogDebug parameter
for Communications Session 

Manager 323
LogField event log parameter 168
LogFile driver parameter (Push Keep 

Alive) 562
LogFile driver parameter (User-interactive 

Email) 538
LogFile parameter

for Communications Session 
Manager 323

logging into call center
automatic 224
manual 224

logicalAgent event data field 
(Dialogic) 477

LogicalID driver parameter (Dialogic) 459
Login button 355
LogIn command (Dialogic) 467
Logout button 355
LogOut command (Dialogic) 467
LogUseSharedFile parameter, 

CommOutboundMgr server 
component 335

Long Distance Prefix driver parameter 
(Modem-based TAP Paging) 564

LongDescription event attribute 542
Lookup, keyword in telephone number 

macro 206
Loopback Detection Interval driver 

parameter (Internet SMTP/POP3 
Server) 529

Loopback Email Directory driver parameter 
(Internet SMTP/POP3 Server) 530

Lotus Notes
and activity records for Send Email 388
and notes.ini file 548

and Siebel Memo email form 546
and Siebel7Email.nsf file 546
using for Send Email 542

LotusForm parameter in .cfg file 560
Lucent Definity G3 switch

See Avaya Definity G3 switch

M
macro expansion

syntax 195
usage 212

macros, using with parameter values 196
Mail Template applet property 304
mail.gif file 65
Make Call method, Communications Client 

business service 594
MakeCall command (Dialogic) 467
manual login to call center 224
Max Sends Per Session driver parameter 

(Internet SMTP/POP3 Server) 530
MaxCommToolbars configuration 

parameter 86
Maximum Log Size (KB) parameter

See CommMaxLogKB parameter; 
MaxLogKB parameter

Maximum Message Queue parameter
See CommMaxMsgQ parameter

MaxLogKB driver parameter 
(Dialogic) 465

MaxLogKB driver parameter (Push Keep 
Alive) 562

MaxLogKB driver parameter (User-
interactive Email) 538

MaxLogKB parameter
for Communications Session 

Manager 323
MaxServices driver parameter 

(Dialogic) 460
MediaType special command 

parameter 144
MenuPosition command parameter

described 182
menu configuration 279
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MergeCall command (Dialogic) 467
Meridian switch

See Nortel Meridian switch
Message Body field, for template 

items 427
Message Broadcasts view 263, 637
message delivery profile 390
Messaging Recipient business object 303, 

304
Microsoft Outlook

and activity records for Send Email 388
and Collaborative Data Object 

(CDO) 388
and IPM.Note.Siebel email form 549
and Siebel7Outlook.oft file 546
using for Send Email 542

middleware/switch combinations 58
MIME

encoding for saved sent messages 533
multipart/alternative 422, 525

MIME, RFC for 59
mobile alerts view

alert name 392
status 392

mobile device
device name 389
device priority 390
login preference 389

Mobile Device Address business 
component 298, 300

Mobile Device business service 513
mobile devices

address priority 499
addresses 497
administering 494
device priority 497
message delivery profile 498
registering 496

Mobile Devices view 298, 300, 496, 636
Mobile screen 298, 300
mobile screen

views 389
MobileSys MX

installing server 487
MobileSys MX wireless messaging 

engine 31, 481, 484
MobileSys Network 485
modem commands 564
Modem Dial String driver parameter 

(Modem-based TAP Paging) 564
Modem Hangup String driver parameter 

(Modem-based TAP Paging) 564
Modem Init String driver parameter 

(Modem-based TAP Paging) 565
Modem Port driver parameter (Modem-

based TAP Paging) 565
Modem Reset String driver parameter 

(Modem-based TAP Paging) 565
Modem Restore String driver parameter 

(Modem-based TAP Paging) 565
Modem-based TAP Paging driver

described 56
parameters for 563

monitorParty event data field 
(Dialogic) 477

monitorPartyType event (Dialogic) 477
MultiActiveCmdIcon command 

parameter 183
Multichannel configuration A 77
multichannelA.def file 116
MultiLog event response parameter 159
multiple-organization support

See multitenancy
Multipurpose Internet Mail Extension

See MIME
multitenancy 87, 218
MultiTenancy configuration parameter 87, 

222
multi-value field type 125
MultiView event response parameter 159
MX Client Id driver parameter (Wireless 

Messaging 2-Way) 492
MX Client Password driver parameter 

(Wireless Messaging 2-Way) 492
MXGateway driver parameter (Wireless 

Messaging 1-Way) 490
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MXGateway driver parameter (Wireless 
Messaging 2-Way) 492

MXReference driver parameter (Wireless 
Messaging 1-Way) 490

MXReference driver parameter (Wireless 
Messaging 2-Way) 493

My Outbound Request Overview view 432
My Outbound Requests view 432
My Profiles view

described 366
visibility 366

My Templates view 399

N
Name field, for templates 411
nestedMonitorChannel event data field 

(Dialogic) 477
netCallId event data field (Dialogic) 477
NetCallPort driver parameter 

(Dialogic) 460
NetworkType driver parameter 

(Dialogic) 460
New Communication command

configuring 282
using 435

nonreal-time work item 129
Nortel Meridian switch

extensions for 98
specifying for Dialogic 461

Notes
See Lotus Notes

notes.ini file 548
Notify Event Handling Finished method, 

Communications Session Manager 
business service 602

NotifyEventHandlerBlocking method, for 
CTIService object type 674

NotifyEventHandlingFinished method 
(service handle) 590

Number, keyword in telephone number 
macro 207

numeric field type 70, 125
numeric range, for phone numbers 206

O
Obtain UI Focus method, Communications 

Client business service 594
OFFER_MEDIA, List of Values type 284
Offhook event (Dialogic) 473
oldNetCallId event data field 

(Dialogic) 477
oldRefId event data field (Dialogic) 477
On Hold, status for server requests 445
OnEditControl command parameter 183
OnField command data parameter 187
Only Send Preference field, for 

communication requests 440
OpAnswered event (Dialogic) 473
OpConferenced event (Dialogic) 474
OpDisconnected event (Dialogic) 474
OpenView event response parameter 159
OpHeld event (Dialogic) 474
OpRetrieved event (Dialogic) 474
Order event handler parameter 150
organization of guide 21
organization visibility 218
organizations

See multitenancy
OriginalMsg.txt file 332
originatingParty event data field 

(Dialogic) 477
originatingPartyDialingPlan event data field 

(Dialogic) 477
originatingPartyGroup event data field 

(Dialogic) 477
originatingPartyQualifier event data field 

(Dialogic) 477
originatingPartyTrunk event data field 

(Dialogic) 478
originatingPartyType event data field 

(Dialogic) 478
Other event (Dialogic) 474
otherParty event data field (Dialogic) 478
otherPartyDialingPlan event data field 

(Dialogic) 478
otherPartyGroup event data field 

(Dialogic) 478
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otherPartyQualifier event data field 
(Dialogic) 478

otherPartyTrunk event data field 
(Dialogic) 478

otherPartyType event data field 
(Dialogic) 478

Outbound Communications Manager 
business service 240, 593

outbound predictive dialer campaign call 
simulation 237

Outbound Request Overview view 432, 
636

Outlook. See Microsoft Outlook
OutlookForm parameter in .cfg file 560
OutOfService event (Dialogic) 474
overriding driver parameters 69

P
Page Manager 28, 384
page, sending 384
PageURL special command parameter 144
paging, communications driver for 563
Param command data parameter 188
parameter fields

macro expansion in 195
types for drivers 70
types for events and commands 125

parameters
for command data 187
for commands 176
configuration 81
for Dialogic commands 470
for event handlers 148
for event logs 168
for event responses 157
for special commands 144
specifying for command data 108
specifying for commands 102, 110, 111
specifying for event handlers 105
specifying for event logs 100
specifying for event responses 102, 106
for User-interactive Email 

commands 540

ParentWorkItemID work item attribute 210
parseString method, Mobile Device business 

service 513
Password driver parameter (FTP) 566
Pause Work Item button 355
PBX switch 45
personalization 131
phone numbers

Caller ID for incoming 234
keywords for dialing filters 206
keywords for part of number 206

PhoneNumber command parameter 
(Dialogic) 472

PhoneTypeLookup, keyword in telephone 
number macro 206

picture files, and HTML messages 423
PollingInterval driver parameter (Internet 

SMTP/POP3 Server) 531
PollingInterval driver parameter (Wireless 

Messaging 2-Way) 493
POP3 Account Name driver parameter 

(Internet SMTP/POP3 Server) 530
POP3 Account Password driver parameter 

(Internet SMTP/POP3 Server) 530
POP3 Batch Size driver parameter (Internet 

SMTP/POP3 Server) 530
POP3 Reconnection Delay driver parameter 

(Internet SMTP/POP3 Server) 530
POP3 Server driver parameter (Internet 

SMTP/POP3 Server) 531
POP3 Server Port driver parameter (Internet 

SMTP/POP3 Server) 531
POP3 servers

and Internet SMTP/POP3 Server 
driver 55

POP3 Timeout driver parameter (Internet 
SMTP/POP3 Server) 531

POP3, RFC for 59
Port driver parameter (FTP) 566
Position DN, for Nortel Meridian switch

See ACD DN
positions, for users 218
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PreferenceLoginCmd configuration 
parameter 87, 223

PreferenceLogoutCmd configuration 
parameter 87, 223

preferences, for users 339
Preferred Communications field, for 

employees or contacts 440
Primary DN, for Nortel Meridian switch

See standard DN
Primary Phone Field user property 202, 

208
Private event (Dialogic) 474
privateData event data field (Dialogic) 478
Process If Loopback Detected driver 

parameter (Internet SMTP/POP3 
Server) 532

Processed Email Directory driver parameter 
(Internet SMTP/POP3 Server) 531

Processed Message Directory driver 
parameter (Wireless Messaging 2-
Way) 493

Processing, status for communication 
requests 443

Profile command parameter 183
Profile event handler parameter 150
ProfileName work item attribute 210
profiles

creating 71
creating for personal use 366
overview 53
visibility 66, 367

Public check box, for templates 413, 417
Push Keep Alive driver

parameters for 562
usage 232

Push Keep Alive driver, described 55
PushKeepAliveTimer driver parameter 

(Push Keep Alive) 563

Q
QueryAfterAnswer event response 

parameter 160

QueryBusComp event response 
parameter 160

QueryBusComp2 event response 
parameter 160

QueryBusObj event response 
parameter 160

QueryFields event response parameter 161
QueryFields2 event response 

parameter 161
QuerySpec event log parameter 169
QuerySpec event response parameter 162
QuerySpec2 event response parameter 163
Queued, status for server requests 445

R
reason codes

configuring List of Values type 285
Reason special command parameter 144
REASON_COD, List of Values type 285
Receive Screen Pop, communications 

preference 341
Reception configuration A 77
Reception screen 116, 364

and Siebel CTI 29
receptionA.def file 116
Recipient Email Address Field user 

property 297, 302
Recipient Fax Address Field user 

property 298, 302
Recipient First Name Field user 

property 297
Recipient Group field

for communication requests 438
configuring 293
for templates 412, 416

recipient groups
predefined 290
understanding 288

Recipient Id Field user property 303
Recipient Last Name Field user 

property 297
Recipient Pager Address Field user 

property 298
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Recipient Preferred Medium Field user 
property 297, 440

Recipient Sources applet, configuring 294
recipients for Send Email/Fax 299
refId event data field (Dialogic) 478
Release Log Handle parameter

See CommReleaseLogHandle parameter; 
ReleaseLogHandle parameter

Release Work Item button 354
Release Work Item by Activity ID method, 

Communications Session Manager 
business service 603

Release Work Item method, 
Communications Session Manager 
business service 603

ReleaseCall command (Dialogic) 468
ReleaseEmailWork command (User-

interactive Email) 540
ReleaseISCDriverInstance method (driver 

handle) 588
ReleaseISCServiceInstance method (service 

handle) 590
ReleaseLogHandle driver parameter 

(Dialogic) 465
ReleaseLogHandle driver parameter (Push 

Keep Alive) 563
ReleaseLogHandle driver parameter (User-

interactive Email) 539
ReleaseLogHandle parameter

for Communications Session 
Manager 323

ReleaseWorkitem method (service 
handle) 591

Remain on Same View After Send (Cancel), 
communications preference 351

RemoveField method, for CTIData object 
type 676

Reply-To Address driver parameter (Internet 
SMTP/POP3 Server) 532

Reports view 635
reports, generating for call center 258
Request # field, for communication 

requests 438

Request Timeout parameter
See CommReqTimeout parameter

RequestCommandEventList method (driver 
handle) 588

RequestMediaTypeList method (driver 
handle) 588

RequestServer configuration 
parameter 88, 328

RequestService method (driver 
handle) 588

RequiredField command data 
parameter 188

Reset Active Session Count command 86
ResetEmailState command (User-interactive 

Email) 540
ResetState command (Dialogic) 468
Resonate Central Dispatch 309
Response event handler parameter 150
responsibilities

adding agents by 91
and multitenancy 218
and profiles 72

RestoreScreenOnWorkResumed 
configuration parameter 88

Resume Work Item button 355
Resume Work Item method, 

Communications Session Manager 
business service 603

ResumeEmailWork command (User-
interactive Email) 540

Retrieve Call button 355
RetrieveCall command (Dialogic) 468
Return Attachments driver parameter 

(Internet SMTP/POP3 Server) 533
RevokeQueuedWorkItem method (service 

handle) 591
RFC

for MIME 59
for POP3 59
for SMTP 59

RightFax
See Captaris RightFax

ringin.au file 344, 584
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RouteCall command (Dialogic) 468
RouteID special command parameter 144
runtime events 131
Runtime Events Administration screen 131

S
S_COMM_REQ_SRC table 296
S_MBL_ALERT table 514
S_MBL_DVC table 494, 514
S_MBL_DVC_ADDR table 494, 514
S_USER table 200
Sample Database 34
Save Sent Messages driver parameter 

(Internet SMTP/POP3 Server) 533
Save Sent Messages driver parameter 

(Wireless Messaging 1-Way) 491
Save Sent Messages driver parameter 

(Wireless Messaging 2-Way) 494
SCCommandFlag constant 577
SCCommandTypeEx constant 578
SCErrorCode constant 579
SCObjectProperty constant 580
SComm_username.log file 319, 323
Script command parameter 183
Script event response parameter 163
ScriptParam command data 

parameter 188
ScriptParam event response parameter 163
SCWorkItemMode constant 581
secOldRefId event data field 

(Dialogic) 478
SelectApplet command data 

parameter 189
SelectBusComp command data 

parameter 189
SelectBusObj command data 

parameter 189
SelectDN commands (Dialogic) 468
SelectDN driver parameter (Dialogic) 463
SelectParam command data 

parameter 189
SelectQuerySpec command data 

parameter 190

SelectTitle command data parameter 190
Send Communication method, 

Communications Client business 
service 594

Send Email command
configuring 281
configuring default templates for 304
configuring generic recipients for 299
using 369

Send Fax command
configuring 281
configuring generic recipients for 299
using 377

Send Message method, Outbound 
Communications Manager business 
service 618

Send Page command
configuring 281
using 384

Send Screen Pop, communications 
preference 341

Send SMTP Message method, Outbound 
Communications Manager business 
service 619

Send Wireless Message command
configuring 281
configuring generic recipients for 299
using 382

SendIfNoUserPref parameter 503
sending email 369
sending fax 377
sending page 384
sending wireless messages 382, 482
Sent Email Directory driver parameter 

(Internet SMTP/POP3 Server) 533
Sent Message Directory driver parameter 

(Wireless Messaging 1-Way) 491
Sent Message Directory driver parameter 

(Wireless Messaging 2-Way) 494
Sequence field, for template items 421
Server Administration screen 443
Server Request Broker server 

component 46, 329, 331, 334, 444
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Server Request Processor server 
component 46, 444

server requests, status settings for 444
service handle

See ISC_SERVICE_HANDLE
Service:ACDDNList driver parameter 

(Dialogic) 461
Service:AutoLogout driver parameter 

(Dialogic) 223, 461
Service:DNList driver parameter 

(Dialogic) 461
Service:HandleRouteRequest driver 

parameter (Dialogic) 461
Service:HasKeyName driver parameters 

(Dialogic) 462
Service:IsQueueRequired driver parameter 

(Dialogic) 49, 90, 462
Service:IsSiemens driver parameter 

(Dialogic) 463
Service:SelectDN driver parameter 

(Dialogic) 463
Service:ServiceLogFile driver parameter 

(Dialogic) 463
Service:Use1StepTransfer driver parameter 

(Dialogic) 464
ServiceLogFile driver parameter 

(Dialogic) 463
ServiceMethod command parameter 184
ServiceMethod event log parameter 169
ServiceMethod event response 

parameter 151, 163
ServiceParam command data 

parameter 191
ServiceParam event log parameter 169
ServiceParam event response 

parameter 151, 164
services, business

See business services
Set Work Item Attributes method, 

Communications Session Manager 
business service 603

SetAgentWorkMode commands 
(Dialogic) 469

SetFieldValue method, for CTIData object 
type 676

Shell UI Update method, Communications 
Client business service 594

ShortDescription event attribute 542
Show Status Text method, Communications 

Client business service 594
ShowStatusText method (client 

handle) 585
Siebel Business Process Designer

and Communications Server 32
Siebel business services 238
Siebel Communications Server

architecture 33
Siebel CTI

and Communications Server 29
Siebel CTI Connect

configuring 455
and Dialogic CT Connect 58, 449, 450
documentation for 450
installation for server components 451
limitations with Nortel Meridian 

switch 457
running 455
software requirements for 451

Siebel eAuction 32
Siebel eMail Response

and Communications Server 30
and User-interactive Email driver 536

Siebel Enterprise Server 84
Siebel eSales 32
Siebel eScript 247, 671
Siebel File System

and files for template items 425
and literature for template items 424
and template items 394

Siebel Gateway 85
Siebel Marketing

and Communications Server 31
and FTP communications driver 561

Siebel Memo email form, for Lotus 
Notes 546

Siebel Paging 56, 561
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Siebel Personalization 131
Siebel Replication Manager 310
Siebel Sample Database 34
Siebel Server driver parameter (FTP) 566
Siebel Server driver parameter (Internet 

SMTP/POP3 Server) 337, 533
Siebel Server driver parameter (Modem-

based TAP Paging) 565
Siebel SmartScript

displaying communications parameter 
data in 255

invoking from event response 156
parameters for 165
using with Communications Server 254

Siebel Tools
configuring communications 

toolbar 265
configuring fax integration 522
configuring Recipient Sources 

applet 295
Siebel Universal Queuing

and Communications Server 30
and User-interactive Email driver 537

Siebel Visual Basic 247, 671
Siebel Wireless Messaging

administering mobile devices 494
and Business Process Designer 487
communications drivers and profiles 

for 490
and Communications Server 30, 487
installing and configuring 484
and MobileSys Network 485
and Wireless Messaging 1-Way 

driver 489
and Wireless Messaging 2-Way 

driver 489
Siebel/Lotus Form component 

parameter 560
Siebel/Lotus Form, communications 

preference 350
Siebel/Outlook Form component 

parameter 560

Siebel/Outlook Form, communications 
preference 350

Siebel7Email.nsf file 546
Siebel7Outlook.oft file 546
SiebelChannelProfile event attribute 574
SiebelChannelType event attribute 574
SiebelChannelTypeString event 

attribute 574
SiebelDriverEventName event 

attribute 574
SiebelDriverNotifyWhenDone event 

attribute 575
SiebelEmaildbg.log file 558
SiebelExtMailClientAttDir parameter in .cfg 

file 559
SiebelLongEmailBody.htm file 333, 387
SiebelLongEmailBody.txt file 333, 387
siebelmail.log file 558
SiebelWorkItemID event attribute 575
Siemens Hicom 300E switch

extensions for 98
specifying for Dialogic 461

SimNewEmailWork command (User-
interactive Email) 540

simple templates
See templates

Simulate Communication parameter
See CommSimulate parameter

Simulate driver parameter (Dialogic) 460
Simulate driver parameter (User-interactive 

Email) 539
SimulateCall command (Dialogic) 470
SingleField event response parameter 164
SingleLog event response parameter 165
SingleView event response parameter 165
SLYBRAND demo user 313
SmartScript

See Siebel SmartScript
SmartScript event response parameter 165
SMTP Backup Server driver parameter 

(Internet SMTP/POP3 Server) 534
SMTP Server driver parameter (Internet 

SMTP/POP3 Server) 535
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SMTP Server Name parameter 
(Communications Inbound 
Manager) 332

SMTP Server Port driver parameter (Internet 
SMTP/POP3 Server) 535

SMTP servers
and Internet SMTP/POP3 Server 

driver 55
SMTP Subsystem, parameters for 332
SMTP Timeout driver parameter (Internet 

SMTP/POP3 Server) 535
SMTP, RFC for 59
Sound File, communications 

preference 344
special commands

described 131
parameters for 144

special events 127
special fields (macros), using with 

parameter values 196
standard DN, specifying for all 

switches 98
Standard Extension, communications 

preference 345
Start Time field, for communication 

requests 440
state event data field (Dialogic) 478
Status field, for communication 

requests 439
Status Message field, for communication 

requests 439
status settings

for communication requests 442
for server requests 444

Status URL driver parameter (Wireless 
Messaging 2-Way) 494

SubCommand_N command 
parameter 184

subcommands, creating 109
Subject field, for templates 412, 416
Submit Request method, Outbound 

Communications Manager business 
service 619

Submitted, status for communication 
requests 443

submitting communication requests 435
subrequests, for communication 

request 436
Substitute Values field, for template 

items 426
Substitution Field user property 293
Success, status for server requests 445
Suspend Work Item method, 

Communications Session Manager 
business service 603

SuspendEmailWork command (User-
interactive Email) 540

SuspendWorkitem method (service 
handle) 591

SWECommand special command 
parameter 144

SWEView workflow action parameter 505
SwitchType driver parameter 

(Dialogic) 461
System Activity object 417

T
Teleset, communications preference 345
telesets

associating with agents 96
specifying 94
specifying extensions for 97

Telocator Alphanumeric Protocol 
(TAP) 56, 563

template items
adding to template 407
copying 410
deleting 410
fields for 421

Template Text field, for templates 414, 421
Template Type field, for templates 412
templates

adding template items 407
advanced, about 393
advanced, creating 402
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configuring List of Values type for 
channel type 284

copying 410
creating 393
deleting 410
fields for 410
MIME multipart/alternative for template 

items 422, 525
simple, about 393
simple, creating 400
visibility 398

text file, for template item 425
Text Input Field 354
texthtmlpartspecifier.htm file 333
thirdParty event data field (Dialogic) 478
thirdPartyDialingPlan event data field 

(Dialogic) 478
thirdPartyGroup event data field 

(Dialogic) 478
thirdPartyQualifier event data field 

(Dialogic) 479
thirdPartyTrunk event data field 

(Dialogic) 479
thirdPartyType event data field 

(Dialogic) 479
timeStamp event data field (Dialogic) 480
Title command parameter

described 184
menu configuration 279

ToggleForward command (Dialogic) 470
toolbar item object definitions 265
toolbar, communications

See communications toolbar
ToolTips, for communications toolbar 

commands 276
TpAnswered event (Dialogic) 474
TpConferenced event (Dialogic) 474
TpDisconnected event (Dialogic) 474
TpRetrieved event (Dialogic) 474
TpSuspended event (Dialogic) 474
TrackingID command parameter 

(Dialogic) 472
TrackingID command parameter (User-

interactive Email) 541

Transfer Multiple LOV Popup Applet 189, 
285

TransferCmd special command 
parameter 144

TransferComplete command 
(Dialogic) 470

TransferInit command (Dialogic) 470
TransferMute command (Dialogic) 470
Transferred event (Dialogic) 474
Try POP3 Logon driver parameter (Internet 

SMTP/POP3 Server) 536
type event data field (Dialogic) 480

U
uagent.cfg file 314
Unavailable event (Dialogic) 474
UnHoldCall command (Dialogic) 470
Unicode

and Adaptive Communications API 568
and Captaris RightFax 522

Universal Agent responsibility 366
UpdateChannelStatusTable configuration 

parameter
and All Channel Items view 262
described 88

UpdateObjectInformation method (client 
handle) 585

upgrade script, WAP Push 516
Upon Sending Messages Generate, 

communications preference 347
UQConfigurationName configuration 

parameter 89
UQWorkItemID work item attribute 210
URL

creating new window for 134
for starting Siebel application 51
and template item 423
and WAP V1.2 driver 515
and Wireless Messaging 1-Way 

driver 490
and Wireless Messaging 2-Way 

driver 492
Use EHLO driver parameter (Internet 

SMTP/POP3 Server) 536
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Use1StepTransfer driver parameter 
(Dialogic) 464

UseCtxData event response parameter 165
User Preferences screen 339
user properties

Default Bookmark View 419
Primary Phone Field 208
Recipient Email Address Field 297, 302
Recipient Fax Address Field 298, 302
Recipient First Name Field 297
Recipient Id Field 303
Recipient Last Name Field 297
Recipient Pager Address Field 298
Recipient Preferred Medium Field 297, 

440
Substitution Field 293

User-interactive Email driver
command parameters 540
commands 539
described 55
events 541
parameters for 537
and Siebel eMail Response 536
and Siebel Universal Queuing 537

Username driver parameter (FTP) 566

V
View command parameter 184
View special command parameter 145
View Work Item menu command 363
ViewBookmark work item attribute 210
views, for communications administration

See Communications Administration 
screen

visibility
My Profiles view 366
for organization 218
for profiles 66, 367
for templates 398

Visual Basic, Siebel 247, 671
voice.gif file 65

W
WAP Forum, and WAP V1.2 driver 515
WAP Push messaging 513

WAP V1.1 514
WAP V1.2 513

WAP push messaging
push proxy gateway 514
WAP V1.2 514

WAP V1.1 configuration 516
WAP V1.1 driver

described 56
WAP V1.2 driver

described 56
parameters for 515

WebServer parameter, CommOutboundMgr 
server component 335, 418

wildcard characters 126
Wireless Application Protocol 515
wireless messages, sending 382, 482
Wireless Messaging 1-Way driver

described 56, 489
parameters for 490

Wireless Messaging 2-Way driver
described 56, 489
parameters for 491

Work Item Released method, 
Communications Client business 
service 594

Work Item Released method, 
Communications Session Manager 
business service 603

Work Item Resumed method, 
Communications Client business 
service 594

Work Item Resumed method, 
Communications Session Manager 
business service 603

Work Item Started method, 
Communications Client business 
service 595
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Work Item Started method, 
Communications Session Manager 
business service 603

Work Item Suspended method, 
Communications Client business 
service 595

Work Item Suspended method, 
Communications Session Manager 
business service 603

work items
attributes for 208
nonreal-time 129

Work Items list 355
work modes (Dialogic)

AgentAfterCallWork 469
AgentBusy 469
AgentNotReady 469
AgentOtherWork 469
AgentReady 469

WorkDuration work item attribute 210

workflow
predefined 501, 508

Workflow Management component 
group 487

WorkItemID special command 
parameter 145

WorkItemID work item attribute 210
WorkItemReleased method (client 

handle) 585
WorkItemStarted method (client 

handle) 586
WorkObject event response 

parameter 166, 208
WorkObjectID work item attribute 210
WorkStartTime work item attribute 211
WorkState work item attribute 211
WorkTrackingObj command data 

parameter 192, 208
WorkTrackingObj event log 

parameter 170, 208
710 Siebel Communications Server Administration Guide Version 7.5.3


	Contents
	Introduction
	Product Modules and Options
	How This Guide Is Organized
	Additional Resources
	Revision History
	Version 7.5.3
	Additional Changes



	About Siebel Communications Server
	What Is Siebel Communications Server?
	Using Communications Server with Other Siebel Modules
	Communications Server and Siebel CTI
	Communications Server and Siebel eMail Response
	Communications Server and Siebel Universal Queuing
	Communications Server and Siebel Wireless Messaging
	Communications Server and Siebel Marketing
	Communications Server and Siebel Business Process Designer

	About Communications Server Architecture
	About Communications Configuration Data
	Types of Communications Configuration Data
	Communications Configuration Requirements for Siebel Modules
	Modules That Use Communications Configurations
	Modules That May Use Communications Configurations
	Features That Do Not Use Communications Configurations
	Send Email, Send Fax, Send Wireless Message, and Send Page Commands



	Process of Configuring Communications Server
	Determining Your Communications Deployment Needs
	Setting Up Your External Communications System
	Setting Up Your Siebel Server Software
	Defining Communications Server Configuration Data
	Putting Siebel Communications Server into Production


	Configuring Communications Drivers and Profiles
	About Communications Drivers and Profiles
	Communications Drivers Provided by Siebel Systems
	Voice/CTI Driver
	Push Channel Keep-Alive Driver
	User-interactive Email Driver
	Email/Fax Driver
	Wireless Messaging Drivers
	Paging Driver
	FTP Driver

	Communications Drivers and Third-Party Systems
	About Error Messages Related to Communications
	Siebel-Validated CTI Middleware/Switches
	Siebel-Validated Email Servers
	Non-Supported Communications Systems

	Communications Driver Settings
	Communications Driver Files and Database Records
	Driver File Naming on Microsoft Windows and UNIX Platforms
	Driver File Naming on Microsoft Windows Platforms
	Driver File Naming on UNIX Platforms
	Additional Considerations for Driver File Naming

	Communications Drivers and Channels
	Inbound and Outbound Drivers
	Interactive Drivers
	Icon Files for Interactive Communications Drivers
	Communications Drivers and Profiles
	Contexts of Use for Communications Profiles
	Administrator Contexts for Using Profiles
	End Users Contexts for Using Profiles


	Configuring Communications Drivers and Profiles
	Specifying Driver Parameter Values
	Field Types for Driver Parameters
	Setting Driver Parameter Default Values
	Defining Communications Profiles
	Specifying Parameter Override Values for Profiles
	Adding a Custom Communications Driver


	Configuring Session Communications
	Creating or Modifying a Communications Configuration
	Copying or Deleting a Communications Configuration
	Copying a Communications Configuration
	Deleting a Communications Configuration

	Viewing All Communications Configuration Data
	Specifying Parameters for Communications Configurations
	Parameters for Communications Configurations

	Specifying Agents
	Relationship of Agents and Telesets for Siebel CTI
	Agents and ACD Queue Settings
	Specifying Agents for Configurations
	Configuring Agents

	Specifying Telesets
	Teleset Naming and Hoteling Considerations
	Specifying Telesets, Agents, and Extensions
	Specifying Agents for Telesets
	Specifying Extensions for Telesets
	Viewing Extension Data

	Defining Communications Events
	Creating Event Logs
	Specifying Event Log Parameters
	Creating Event Responses
	Specifying Event Response Parameters
	Associating Event Logs to an Event Response
	Creating Event Handlers
	Specifying Event Handler Parameters
	Specifying Event Response Parameters

	Defining Communications Commands
	Creating Command Data Definitions
	Creating Commands
	Specify Subcommands for a Group Command
	Specifying Command Parameters
	Specifying Command Data Parameters

	Exporting and Importing Configuration Data
	Exporting Communications Configuration Data
	Importing Communications Configuration Data
	Communications .def Files
	File Format for .def Files
	Example Section from .def File


	Configuring Events and Commands
	About Events and Commands
	Communications Definition Data in the Database
	Communications Data Sets
	Event and Command Definitions
	Event and Command Types

	Event and Command Parameters
	Field Types for Event and Command Parameters
	Forms of Event and Command Parameters

	Wildcard Characters in Event and Command Parameters

	Special Events for Device Events
	Special Event Attributes
	List of Special Events

	Special Commands for Device Commands
	List of Special Commands
	Special Command Parameters
	Special Command Examples
	@Associate Special Command Example
	@ViewWorkObject Special Command Example


	Event Handlers
	Event Handler Process Overview
	Event Handler Parameters
	Handling an Inbound Call Received by an Agent
	Example of Using Event Handler to Handle Inbound Call


	Event Responses
	Event Response Process Overview
	Event Response Parameters
	Event Response Example

	Event Logs
	Event Log Parameters
	Event Log Examples

	Commands
	Hierarchical Commands
	Command Parameters
	Command Example

	Command Data
	Command Data Parameters
	Command Data Example


	Advanced Communications Configuration
	Using Macro Expansion for Character Fields
	Macro-Expansion Syntax Elements
	Macros for Parameter Values
	@Phone Macro Example

	Macro Expansion with Phone Numbers
	Keywords to Specify Dialing-Filter Behavior
	Keywords to Extract Part of a Phone Number
	Numeric Ranges to Extract
	Primary Phone Field User Property in Business Components

	Work Item Attributes
	Macro-Expansion Examples

	Working with Dialing Filters
	Dialing Filter Examples

	Configuring Telesets for Hoteling
	Hoteling Requirements and Issues

	Supporting Multitenancy
	Organization Visibility and Positions
	Organization Visibility for Business Components
	Organization Visibility for Views
	Changing Position Manually or Automatically
	Scenarios for Generating Screen Pops and Changing Position

	Setting the MultiTenancy Configuration Parameter

	Configuring Communications Login and Logout
	Login and Logout Command Configuration
	Automatic and Manual Login
	Automatic Login
	Manual Login


	Configuring Remote Transfers and Conferences
	Creating Communications Configurations
	Specifying Dialing Filters
	Using Macros to Identify Remote Call Centers
	Example Command Using $RemoteConnectStr


	Using Device Event to Enhance Screen Pop Performance
	Dependency for Multiple Event Handlers
	Event Examples for Agents Answering Call from Communications Toolbar
	Event Examples for Agents Answering Call From Teleset

	Using Push Keep Alive Driver for Session Connections
	Simulating a Communications Environment
	Setting Up and Running the Communications Simulator
	Using the Communications Simulator
	Communications-Simulation Keys

	Inbound Call Simulations
	Simulated Inbound Call with Caller ID
	Simulated Inbound Call from an Unknown Caller

	Inbound Campaign Call Simulation

	Using Business Services with Communications Server
	Invoking Communications Server Business Service Methods
	About Using Business Services with Events and Commands
	Invoking a Command Through the Business Service Model
	Invoking a Business Service Method from a Command
	Invoking a Business Service Method from an Event Handler
	Invoking a Business Service Method from an Event Response

	Integrating with Siebel Scripting Languages
	Integrating Using Server and Browser Scripts
	Command Example
	SWE Command Example
	Server and Browser Script Examples

	Integrating Using Server Scripts
	Event Response Example
	Command Example
	Server Script Examples

	More Information About Scripting

	Integrating with Siebel SmartScript
	Invoking Siebel SmartScript Through Siebel Communications Server
	Example Events to Invoke SmartScript Script

	Displaying Communications Parameter Data in SmartScript

	Integrating with the Customer Dashboard
	Example Events for Updating and Clearing Customer Dashboard

	Generating Communications Reports
	Requirement for Defining Fields in Event Logs

	Viewing Communications Status Data
	Viewing Agent Status Data
	Viewing Channel Status Data
	Modifying How Channel Status Data Is Displayed
	Distributing Status Data to Agents



	Configuring User Interface Elements
	About Communications Toolbar Configuration
	Communications Toolbar Items, Commands, and Methods
	Communications Toolbar Commands and Bitmaps

	Modifying the Communications Toolbar
	Modifying the Function of an Existing Toolbar Button
	Modifying Communications Command for Existing Toolbar Button
	Modifying Device Command for Existing Toolbar Button
	Modifying Business Service Method for Existing Toolbar Button

	Modifying the Appearance of an Existing Toolbar Button
	Changing Image File or Bitmap Object Definition for Existing Toolbar Button
	Changing Icon File for Interactive Communications Driver

	Moving, Adding, or Removing a Toolbar Button

	Communications Toolbar Buttons and Commands
	How Communications Toolbar Buttons Work
	Command Parameters Affecting Communications Toolbar Buttons
	Communications Group Commands in Toolbar
	Communications Toolbar ToolTip Text

	Configuring Communications Menu Commands
	Communications Submenu and Applet-Level Menu
	Command Parameters Affecting Communications Menu Items
	Communications Group Commands in Menus
	Communications Menu Items and Device Commands

	Configuring Commands in the File Menu
	Configuring the Send Commands
	End User Requirements for Using Send Commands
	Send Menu Commands Defined in Siebel Tools
	Send Commands in Communications Toolbar

	Configuring the New Communication Command

	Configuring Communications List of Values Types
	List of Values Types for Channel Type
	List of Values Type for Channel for Communications Drivers and Siebel Universal Queuing
	List of Values Type for Channel for Templates and Requests

	List of Values Type for ACD Queues
	List of Values Type for Reason Code
	List of Values Types for Event Parameters
	List of Values Type for Event Handler Parameters
	List of Values Type for Event Response Parameters
	List of Values Type for Event Log Parameters

	List of Values Types for Command Parameters
	List of Values Type for Command Parameters
	List of Values Type for Command Data Parameters


	Configuring Recipient Groups for Requests and Advanced Templates
	About Recipient Groups for Requests and Advanced Templates
	Predefined Recipient Groups for Requests and Advanced Templates
	Configuring Substitution Fields for Recipient Groups
	Configuring Additional Recipient Groups and Recipient Sources Applets
	Configuring the Recipient Group List of Values
	Configuring Recipient Sources Applets


	Configuring Recipients for Send Commands
	About Generic Recipients
	User Interface Context for the Recipient Field
	Configuring Non-Joined Generic Recipients
	Additional Requirement for Non-Joined Generic Recipients

	Configuring Joined Generic Recipients
	Additional Requirements for Joined Generic Recipients


	Configuring Default Templates for Send Email Command

	Administering Siebel Communications Server
	Siebel Server Requirements for Communications Server
	Server Components for Communications Server
	Running Communications Server in Heterogeneous Server Environments
	Using Resonate Central Dispatch with Communications Server
	Synchronizing Request-Mode Server Components
	Restriction for Siebel Replication Manager

	Enabling Session Communications and Simulation
	About Communications Session Modes
	About Communications Simulator
	Prerequisites for Enabling Session Communications
	Parameters for Application Object Manager and Dedicated Web Client
	Parameters for Communications Session Manager
	Enabling Communications Sessions for Siebel Web Client
	Enabling Communications Sessions for Siebel Dedicated Web Client
	Enabling Communications Using Command-Line Option
	Enabling Communications by Modifying Configuration File

	Enabling Communications Simulation
	Role of the Simulate Parameter
	Simulate Parameter and Custom Drivers

	Enabling Simulation for Siebel Mobile Web Client
	Enabling Using Command-Line Option
	Enabling by Modifying Configuration File

	Enabling Simulation for Siebel Web Client


	Administering Communications Session Manager
	Overview of Communications Session Manager
	When Communications Session Manager Is Unavailable

	Running Communications Session Manager

	Administering Communications Configuration Manager
	Running Communications Configuration Manager

	Administering Communications Inbound Manager
	Running Communications Inbound Manager
	Configuring Parameters for Communications Inbound Manager
	Activity Attachments Stored for Inbound Email

	Administering Communications Outbound Manager
	Running Communications Outbound Manager
	Configuring Communications Outbound Manager
	Configuring Siebel Bookmarks
	Configuring Shared or Separate Logging
	Configuring Log Levels

	Specifying Siebel Server Name Using Driver Parameter
	Specifying Component Name for Outbound Communication Requests
	Outbound Communications for Siebel Mobile Web Client


	Communications Operations for End Users
	Setting Communications User Preferences
	Specifying Communications Preferences
	Preference Settings in the Communications Tab
	General Settings
	Sound Settings
	Teleset and Configuration Settings

	Logging Into or Out of an ACD Queue
	Preference Settings in the Outbound Communications Tab
	Send Email Settings (Also for Some Other Send Commands)
	Email Response Settings
	Advanced Features Settings


	Using the Communications Toolbar
	Communications Toolbar Controls
	Logging Into the Communications System
	Receiving Inbound Work Items
	Initiating Work Items
	Transferring or Conferencing Work Items
	Pausing and Resuming Work Items
	Forwarding Work Items
	Changing Ready State

	Using Communications Menu Commands
	Menu Commands for Displaying Error Messages
	Menu Command for Refreshing the Communications Toolbar

	Using the Reception Screen
	Reception Screen User Interface Elements

	Creating Communications Profiles for Personal Use
	Sending Email, Fax, Page, and Wireless Messages
	Using the Send Email Command
	Using Send Email with Native Siebel Email Client
	Using Send Email with Lotus Notes or Microsoft Outlook
	Using the Send Fax Command
	Editing and Formatting Controls for Send Email and Send Fax
	Using the Send Wireless Message Command
	Using the Send Page Command

	Using Activity Records for Send Commands
	Activity Types for Each Send Command
	Matching Contacts for Activity Records for Send Email

	Specifying Mobile Device Settings
	Configuring Mobile Devices
	Configuring Message Delivery
	Configuring Mobile Alerts


	Configuring Communications Templates
	About Communications Templates
	Template Content and Formatting
	HTML Formatting
	HTML Wrapper Templates for Email

	Substitution Fields in Templates
	Siebel Repository Requirement for Using Substitution Fields

	Template Visibility and Access
	Siebel Views for Working with Templates

	Creating Simple Templates
	Creating Advanced Templates
	Editing and Formatting Controls for Template Text Field
	Managing Line Breaks for HTML and Plain-Text Templates
	Managing Links and HTML Elements from Other Sources
	Editing and Formatting Options

	Specifying Template Items for an Advanced Template
	Modifying a Template Item That Specifies a File
	Copying or Deleting Templates and Template Items
	Copying Templates and Template Items
	Deleting Templates and Template Items

	Fields for Templates
	Templates List
	Simple Form
	Advanced Form

	Fields for Template Items
	Template Items List
	Template Item Form


	Defining Outbound Communication Requests
	About Outbound Communication Requests
	Prerequisite Recipient Addressing Information
	Siebel Views for Working with Outbound Communication Requests

	Creating and Submitting Outbound Requests
	Creating an Outbound Communication Request
	Submitting an Outbound Communication Request
	Using the New Communication Command to Create a Request
	Configuring Subrequests
	Subrequest SQL File Option

	Deleting Outbound Communication Requests

	Fields for Outbound Communication Requests
	Outbound Communication Request Restart Capability
	Monitoring Outbound Communication Request Status
	Status Settings for Outbound Communication Requests
	Monitoring Siebel Server Request Status
	Server Request Status Settings
	Viewing Activity Records for Communication Requests


	Using Siebel CTI Connect
	About Siebel CTI Connect
	Additional Documentation for Siebel CTI Connect
	Installing Siebel CTI Connect Server Components
	Installing Dialogic CT Connect
	Installing Dialogic CT Connect Service Pack
	Installing Dialogic Call Information Manager
	Installing Dialogic Call Information Manager Service Pack

	Configuring and Running Siebel CTI Connect Server Components
	Configuring Dialogic CT Connect
	Configuring Dialogic Call Information Manager
	Running Dialogic CT Connect and Call Information Manager
	Limitations with Nortel Meridian Switch

	Siebel CTI Connect Driver Parameters
	Siebel CTI Connect Commands
	Siebel CTI Connect Command Parameters

	Siebel CTI Connect Events
	Siebel CTI Connect Event Data


	Using Wireless Messaging
	About Wireless Messaging
	Wireless Messaging Usage Scenarios
	Installing and Configuring Siebel Wireless Messaging
	Connecting to the MobileSys Network
	Connecting Directly to Wireless Network Operators
	Installing Siebel Server Components for Siebel Wireless Messaging
	Installing and Configuring MobileSys MX Server
	Configuring Communications Drivers and Profiles
	Wireless Messaging 1-Way Driver Parameters
	Wireless Messaging 2-Way Driver Parameters

	Administering Mobile Devices
	Specifying Mobile Device and Device Addressing Information
	Mobile Device Settings
	Device Address Settings

	Using One-Way Wireless Messaging Workflows
	Setting Up One-Way Wireless Messaging Workflows
	Predefined One-Way Wireless Messaging Workflows
	Configuring Send Behavior for One-Way Wireless Messaging Workflows
	Configuring One-Way Wireless Messaging Workflows for Siebel Wireless
	Specifying a Base URL for Siebel Wireless
	Enabling Recipient Access to Views in Siebel Wireless


	Using Two-Way Wireless Messaging Workflows
	Setting Up Two-Way Wireless Messaging
	Predefined Two-Way Wireless Messaging Workflow for Outbound
	Activities and Two-Way Wireless Messaging
	Dispatch Activity Message Sent to Field Service Representative
	Field Service Representative Response to Outbound Message
	Tracking Activity Record
	Configuring Two-Way Wireless Messaging Workflows
	Using Different Field Data or Labels, or Using Different Operators
	Sending Messages Based on Different Assignment Scenario
	Receiving Inbound Messages with Different Response Content


	Configuring WAP Push Messaging
	WAP V1.2 Driver Parameters
	Enabling WAP V1.1 Push Messaging
	Upgrading from Siebel Wireless 6.x Applications


	Using Email, Fax, and Other Systems
	Interfacing with Email and Fax Servers
	Integrating with Email Systems
	Using HTML Email
	Integrating with Fax Systems
	Configuring Fax Integration Elements in Siebel Tools
	Driver Parameters for Internet SMTP/POP3 Server

	Supporting Email Interactivity
	User-interactive Email Driver
	User-interactive Email Driver Parameters
	User-interactive Email Commands
	User-interactive Email Command Parameters

	User-interactive Email Events
	User-interactive Email Event Data


	Configuring Client-Side Integration for Send Email
	Creating and Configuring the Attachments Directory
	About Installing the Siebel Email Form
	Locations of Source Files for Siebel Email Forms
	Installing the Siebel Email Form for Lotus Notes
	Installing the Siebel Email Form for Microsoft Outlook
	Overview of Completing Email Client Configuration
	Completing Configuration for Lotus Notes
	Completing Configuration for Microsoft Outlook
	Email Client Parameters

	Other Communications Drivers
	Push Keep Alive Driver Parameters
	Modem-based TAP Paging Driver Parameters
	FTP Driver Parameters


	Developing a Communications Driver
	Required Skills for Adaptive Communications Developer
	Driver Issues for Version 7.5
	Adaptive Communications Design
	Communications Drivers
	Adaptive Communications Architecture
	Event and Command Model
	Initialization of Communications Drivers
	Loading Communications Drivers
	ISC_DRIVER_HANDLE
	ISC_SERVICE_HANDLE

	Driver Parameters and Initialization
	Driver Event Attributes

	Siebel Adaptive Communications API Reference
	Handles for Adaptive Communications
	Constants for Communications Drivers
	SCCommandFlag
	SCCommandTypeEx
	SCErrorCode
	SCObjectProperty
	SCWorkItemMode

	Data Types for Communications Drivers
	Methods of ISC_CLIENT_HANDLE
	BeginBatch
	CacheCommandInformation
	CleanAllWorkItem
	EndBatch
	HandleError
	HandleEvent
	IndicateNewWorkItem
	ShowStatusText
	UpdateObjectInformation
	WorkItemReleased
	WorkItemResumed
	WorkItemStarted
	WorkItemSuspended

	Methods of ISC_DRIVER_HANDLE
	APIVersion
	CreateISCDriverInstance
	FreeSCStrParamList
	GetImplementationObject
	ReleaseISCDriverInstance
	RequestCommandEventList
	RequestMediaTypeList
	RequestService

	Methods of ISC_SERVICE_HANDLE
	AcceptWorkItem
	HandleQueuedWorkItem
	InvokeCommand
	InvokeCommandEx
	NotifyEventHandlingFinished
	ReleaseISCServiceInstance
	ReleaseWorkItem
	ResumeWorkItem
	RevokeQueuedWorkItem
	SuspendWorkItem



	Communications Server Business Services
	Communications Client Methods
	Arguments for Communications Client Methods
	Arguments for Agent Sign Off Method
	Arguments for Agent Sign On Method
	Arguments for Get Selected Work Item Info Method
	Arguments for Handle Error Method
	Arguments for Is Comm Enabled Method
	Arguments for Is Comm Simulated Method
	Arguments for Make Call Method
	Arguments for Obtain UI Focus Method
	Arguments for Send Communication Method
	Arguments for Shell UI Update Method
	Arguments for Show Status Text Method
	Arguments for Work Item Released Method
	Arguments for Work Item Resumed Method
	Arguments for Work Item Started Method
	Arguments for Work Item Suspended Method


	Communications Session Manager Methods
	Arguments for Communications Session Manager Methods
	Arguments for Accept Work Item Method
	Arguments for Get Agent Extension Method
	Arguments for Get All Work Item ID Method
	Arguments for Get Inbound Work Item Attributes Method
	Arguments for Get Inbound Work Item Info Method
	Arguments for Get Top Active Work Item ID Method
	Arguments for Get Top Idle Work Item ID Method
	Arguments for Get Work Item Attributes Method
	Arguments for Get Work Item Info Method
	Arguments for Get Work Item Track Info Method
	Arguments for Invoke Command Method
	Arguments for Invoke Extended Command Method
	Arguments for Notify Event Handling Finished Method
	Arguments for Release Work Item Method
	Arguments for Release Work Item by Activity ID Method
	Arguments for Resume Work Item Method
	Arguments for Set Work Item Attributes Method
	Arguments for Suspend Work Item Method
	Arguments for Work Item Released Method
	Arguments for Work Item Resumed Method
	Arguments for Work Item Started Method
	Arguments for Work Item Suspended Method


	Outbound Communications Manager Methods
	Arguments for Outbound Communications Manager Methods
	Arguments for Create and Submit Request Method
	Arguments for Send Message Method
	Arguments for Send SMTP Message Method
	Arguments for Submit Request Method



	Views for Communications Administration
	Views for Defining Configurations, Drivers, Profiles, Agents, and Telesets
	Views for Defining Events
	Views for Defining Commands
	View for Exploring Configurations
	Views for Generating Reports or Reviewing Runtime Status Data
	View for Defining Templates
	Views for Defining Outbound Communication Requests
	View for Specifying Mobile Devices
	View for Defining Inbound Communications
	View for Specifying Message Broadcast Settings

	Upgrading from Version 6.x
	Upgrading Siebel CTI from Version 6.x (and Earlier)
	Upgrade Issues for CTI Drivers
	Upgrade Issues for CTI/Communications Configurations
	Background for Configuration Upgrade
	Configuration Parameters in Version 7.x
	Dialogic CTI Driver Parameters in Version 7.x
	New Dialogic CTI Event in Version 7.x
	New Dialogic CTI Commands in Version 7.x
	Event Handler Parameters in Version 7.x
	Event Response Parameters in Version 7.x
	Event Log Parameters in Version 7.x
	Command Parameters in Version 7.x
	Command Data Parameters in Version 7.x
	Special Events in Version 7.x
	Special Commands in Version 7.x
	Macros in Version 7.x
	Preparing to Upgrade the Configuration
	Device Events Prefixed with “Sys_” No Longer Supported
	Version Identifier in 7.x .def File
	Event and Command Manipulation During Upgrade

	Upgrading the Configuration
	Upgrade Issues for Communications Toolbar and Menu Commands
	CTI/Communications Toolbar Configuration
	General Steps for Upgrading CTI/Communications Toolbar
	CTI/Communications Menu Configuration
	Upgrade Issues for Scripting and Business Service Methods
	Upgrade Issues for Siebel CTI Connect
	Upgrade Issues for Inbound Call Routing

	Upgrading Communications Server from Version 6.x
	Upgrade Issues for Communications Drivers and Profiles
	Upgrade Issues for Communications Templates
	Upgrade Issues for Communications Manager Server Component
	Upgrade Issues for Outbound Communications Manager Business Service

	Upgrading Send Email/Fax/Page from Version 6.x (and Earlier)
	Migration to Siebel Communications Server
	Communications Templates
	Migration to Siebel Web Client and Communications Toolbar

	Using Siebel Scripts from Version 6.x
	CTIService Object Type
	GetCTIService
	IsCommandEnabled
	IsCommandChecked
	InvokeCommand
	InvokeCommandWithData
	GetCurrentCallData
	CreateData
	NotifyEventHandlerBlocking

	CTIData Object Type
	Clear
	GetFieldValue
	SetFieldValue
	GetCount
	GetFieldAt
	RemoveField

	Script Example: Making a Call
	Siebel VB Script Example
	Siebel eScript Script Example

	Defining Communications Command to Invoke the Script
	Script Example: Handling an Incoming Call
	Siebel VB Script Example
	Siebel eScript Script Example

	Defining the CTI Event to Invoke the Script


	Index

